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Welcome to the MAXQDA 24 Manual

Popular topics:

Importing Data

Import Data
Supported Data Types
Import Transcripts
Import PDF Documents

More

Codes

Codes and Code System
Create New Codes
Edit the “Code System”
Create Code Sets

More

Coding

Coding in MAXQDA
Display Coded Segments
Color Coding
Open Coding

More

Transcription

Transcribe automatically
Transcribe Manually
Setting Timestamps
MAXQDA Transcription

More

Making the Switch from MAXQDA 2022 to MAXQDA 24

https://www.maxqda.com/help-mx24/import/import-group-data
https://www.maxqda.com/help-mx24/import/data-types
https://www.maxqda.com/help-mx24/import/transcripts-with-timestamps
https://www.maxqda.com/help-mx24/import/notes-on-pdf-documents
https://www.maxqda.com/help-mx24/import/data-types
https://www.maxqda.com/help-mx24/codes-2/the-code-system
https://www.maxqda.com/help-mx24/codes-2/creating-a-new-code
https://www.maxqda.com/help-mx24/codes-2/moving-and-sorting-codes-in-the-code-system
https://www.maxqda.com/help-mx24/codes-2/creating-code-sets
https://www.maxqda.com/help-mx24/codes-2/the-code-system
https://www.maxqda.com/help-mx24/05-coding/how-to-code
https://www.maxqda.com/help-mx24/05-coding/visualizing-coded-segments-in-the-document-browser
https://www.maxqda.com/help-mx24/05-coding/highlight-coding-color-coding
https://www.maxqda.com/help-mx24/05-coding/open-coding-mode
https://www.maxqda.com/help-mx24/05-coding/how-to-code
https://www.maxqda.com/help-mx24/transcription-audio-video/automatic-transcription
https://www.maxqda.com/help-mx24/transcription-audio-video/transcription-mode
https://www.maxqda.com/help-mx24/transcription-audio-video/timestamps-to-link-transcripts-with-sound
https://www.maxqda.com/automatic-transcription
https://www.maxqda.com/help-mx24/transcription-audio-video/transcription-mode
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Important notes on switching from MAXQDA 2022 to MAXQDA 24 - and on working in teams using a
mix of both versions.

Go to FAQ

https://www.maxqda.com/faq/are-the-maxqda-project-formats-from-the-various-program-versions-compatible-with-each-other
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Switching From Older Versions to
MAXQDA 24
To see all the new features of MAXQDA 24, visit the "New Features" website.

MAXQDA 24 includes features not available in previous MAXQDA versions and several
improvements have been made to the data structure of project files. As a result, MAXQDA 24 uses a
new file format with the extension .mx24.

You can open projects from previous MAXQDA versions in MAXQDA 24, they will be converted
automatically.

How to open projects from older versions in MAXQDA 24

Start MAXQDA 24 and select Open Project in the start window.

Opening an existing project from the start window

Navigate to the location on your computer where the project file that you want to open is saved.
Select the project and click Open.

https://www.maxqda.com/new-maxqda-24
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Select and open a project file that was created with an older version of MAXQDA

MAXQDA 24 will read the data from the old project file and save it into a new MAXQDA 24 project
file (.mx24). A message box is displayed as soon as the conversion is successfully finished.
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Successful conversion message

The new MAXQDA 24 project file (.mx24) is saved in the same folder as the old project. Your old
project file remains untouched.

What to consider when working in a team with Windows and Mac?

If you are working with several people with the same data and you are using Windows and Mac,
projects should not be converted on different computers. It is best to have one team member
convert the projects and then distribute the converted projects to all other members.

The background: because of the improved text processing since version 2020, the length of text
documents may differ depending on whether they were converted on Windows or macOS (the
content of the texts remains the same, of course). If you convert the same projects on different
operating systems in a team, difficulties may arise when using functions such as Intercoder or
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Teamwork Export and Import.

What happens when converting projects from MAXQDA 2020?

The emoticodes will be replaced by new symbols. Since MAXQDA 24 does not contain all the
symbols from MAXQDA versions older than 2022 (but lots of new ones), some emoticodes may be
converted to standard codes. To make these codes recognizable, they will be prefixed with the name
“emoticode”.

What happens when converting projects from MAXQDA 2018?

In addition to the previously described changes for projects from MAXQDA 2020, the following
happens:

In MAXQDA 24 the Focus Group Speaker codes and the Paraphrased Segments codes are moved to
the bottom of the “Code System” window. Both code types are counted separately since version
2020 and their frequencies are no longer included in the total number of regular codes. Therefore,
the total number of codes displayed at the top of the Code System may be smaller than before.
Scroll down the Code System to see Focus Group Speakers and Paraphrased Segments codes.

How to save a MAXQDA 24 project for MAXQDA 2022

MAXQDA 2022 cannot open the .mx24 format of a MAXQDA 24 project, but you can save a MAXQDA
24 project to the .mx22 file format used by MAXQDA 2022.

Open your project file in MAXQDA 24 and select Save Project As from the Home menu ribbon tab.

Save a MAXQDA 2020 project for MAXQDA 2018

In the appearing dialog window, set the file type to “MAXQDA 2022 Projects (*.mx22)”, enter a file
name, select a location to save the project file to, and then click Save.

A few elements of MAXQDA 24 will be changed, because MAXQDA 2022 does not have the
functionality to handle new or changed features:

Maps are saved as images
Comments, code names and document names are shortened to 63 characters.

How to migrate a TeamCloud MAXQDA 2022 project to MAXQDA 24

To migrate a TeamCloud project to MAXQDA 24 that has been created with MAXQDA 2022, please
proceed as follows: 

Open the TeamCloud project in MAXQDA 2022
Save the TeamCloud project as a local project via Export as local project
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Upload the locally exported project as a new TeamCloud project in MAXQDA 24.
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Getting Started: Go for it!
MAXQDA Getting Started Guide

In this free guide you can find helpful tips to get successfully started with MAXQDA.
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The MAXQDA Account
You need a free MAXQDA account in order to use our AI Assist and automated-transcription tool,
MAXQDA Transcription, as well as to collaborate on projects using TeamCloud. If you have created
TeamCloud account in the past, it has automatically been converted into a MAXQDA account, so no
need to worry about this step.

Create a new MAXQDA account

To create your account visit this webpage and follow the prompt to confirm your account by clicking
the link in the confirmation email.

Log into to your MAXQDA account within MAXQDA

You need to log into your MAXQDA Account within MAXQDA to be able collaborate on projects using
TeamCloud and/or to activate AI Assist.

To sign in, navigate to MAXQDA's top right corner and click on the "sign in" icon, pirctured below:

TeamCloud sign-in options within MAXQDA

Log in to your MAXQDA account online

You can also log into your MAXQDA account online. There, you can manage your account settings,
collaborative projects, and TeamCloud license.

Specifically, when loggin in through the web, you can manage your TeamCloud license, TeamCloud
projects and members, and use the MAXQDA Transcription add-on.

https://teamcloud.maxqda.com
https://teamcloud.maxqda.com
https://www.maxqda.com/help-mx24-teamcloud/start/create-activate-teamcloud-account
https://www.maxqda.com/help-mx24-teamcloud/the-teamcloud-website/the-dashboard
https://www.maxqda.com/help-mx24-teamcloud/the-teamcloud-website/the-dashboard
https://www.maxqda.com/automatic-transcription
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01 – The Workspace

How to Start the Program
When you open MAXQDA, a launch screen will open where you can:

choose a username,
start a new project,
open existing projects,
open example projects, and
view your license information.

The window area to the right displays all the latest MAXQDA news and gives access to tutorials and
other ressources.

MAXQDA launch screen

Entering your username

Enter your name or acronym in the User field and your signature will be added to everything you do
in MAXQDA, be it importing documents, coding segments, or creating memos. This becomes
particularly useful when working in teams, as it’s easier to see who has done what.
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Starting a new project

Before you can analyze your data with MAXQDA, you need to create a new MAXQDA project into
which you can import your data. Click on New, enter a project name and choose a location to save
your project (please see the note on file saving locations below). As soon as MAXQDA has created a
new project you can start to import your data.

Opening existing projects

MAXQDA lists the recently opened projects in the lower window area, which you can open with a
double-click. Via right-click on the project, you can open the file location of your project file. If you
want to open a project that doesn’t appear in this list, click on Open and choose a file from the dialog
window that appears.

Important note about saving locations of MAXQDA projects: As MAXQDA is a database program, all
changes are always saved directly in the project file. For this reason, it is very important that the
computer's connection to the project file is not interrupted, otherwise there may be problems with
the project file.

To avoid data loss, we recommend that you do not open the project file from the following locations:

USB drives
network drives
external hard disks
folders synchronized with cloud services (Dropbox, Google Drive, iCloud, etc.).

We strongly recommend to copy your project to a local hard drive (for example, to the desktop) and
open it from there. Of course you can save your MAXQDA projects on USB drives, network drives
etc., but you should not open the file directly from there.

Opening example projects

Click on the Examples button to list the featured example projects, with which you can thoroughly
explore all MAXQDA’s functions. Just click on a project in the list to open it.

Changes to projects are saved automatically 

MAXQDA does not include a save function which you must click when you finish working on a
project.

MAXQDA operates as a database program, which means that all changes you make to a project,
including the import of texts or later coding of data, are automatically saved. Exceptions are edits to
texts, memos and MAXMaps. These are saved automatically every few minutes, as well as
automatically when you close the window and the project.

https://www.maxqda.com/help-mx24/import/import-group-data
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Project File Backups
Project file backups

It is strongly recommended that you regularly create project backups and save them on external
hard drives or flash drives, in order to minimize losses in case of computer problems. Backup files
shouldn’t be stored in the same location as your computer.

MAXQDA 24 project files have the extension MX24 - if the file extensions are hidden in your
computer system, you can recognize the files by the MAXQDA icon and the file type "MAXQDA 2024
Project File".

You can transfer your MAXQDA project files to an external storage drive using Windows Explorer or
Mac Finder. Alternatively, open the file in MAXQDA and choose Home > Save Project As in the top
menu. Then specify a location and file name and click OK.

Automatic backups

MAXQDA allows you to backup projects automatically. If you open a project that has not been
backed up by MAXQDA for more than a day, MAXQDA will save a copy in a selected folder. MAXQDA
automatically provides the backup file with a date and time stamp.

Both the time interval after which a project should be automatically saved and the directory for
backup copies can be specified in the MAXQDA preferences. Open these preference by clicking on
the settings symbol in the lower left corner of the MAXQDA window. There, you can also disable the
function entirely.
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Settings for the automatic project backup

Warning: The automatic backup represents a good safety net, but does not replace the regular
backup of your important project files on the Internet or on an external data carrier, such as a hard
disk!

The Main Menu and the Four Main
Windows
After opening or creating a new project, you will see the MAXQDA interface:

At the very top of the screen, you will see the project's file name including the location where
it is saved.
Underneath the file name, you will see the main menu with several tabs that offer quick
access to MAXQDA functions.
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MAXQDA’s four main windows occupy the main part of the screen.
At the bottom of the screen, a bar is located allowing you to open the general settings, the
help menu and more.

The MAXQDA interface

The menu tabs

Along the top edge of the MAXQDA interface, you will see the main menu, which features several
tabs.

The Main Menu tabs

As soon as you hold the mouse pointer on one of the main functions, a brief description will appear
for most functions.

Please note:

The Tab "Stats" is only visible, if you are using a license for MAXQDA Analytics Pro. MAXQDA
Stats is an add-on which enables you to perform descriptive and inferential statistical
calculations frequently used in research.
This tab is only available if you are running not any of these license types: demo license,
student license, teaching/course license, MAXQDA Reader license. See here how the
TeamCloud feature simplifies your team collaboration.
For Mac, all the functions can be found in identical order in the menu at the top of the screen.

https://www.maxqda.com/products/maxqda-analytics-pro
https://www.maxqda.com/help-mx24/stats/what-does-maxqda-stats-offer
https://www.maxqda.com/help-mx24/teamcloud/start
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Collapsing the ribbon bar

When you double-click on a tab name, the ribbon collapses to provide more space for working in
MAXQDA's four main windows. When the ribbon is collapsed, you must click on the tab title to
access a function of the tab. Double-clicking on a tab name again will expand the ribbon again.

Further functions in the main menu

There are several icons to the right of the menu that provide access to other MAXQDA functions.

Further function icons

Change view

You can switch the arrangement of the four main windows at any time between a three-column view
for wide screens and a two-column view more suitable for narrow screens.

Undo options

Undo – undoes your last action, such as deleting a code or document.

Redo – redoes the last “undone“ action.

When using the undo function in MAXQDA, please note the following:

Turning on Edit mode for a text or spreadsheet document disables MAXQDA's global undo
function. While Edit mode is on, no actions can be undone in MAXQDA. Only the local undo
function in the "Document Browser" is active, which means you can undo text edits using the
formatting bar or context menu. Once you switch off Edit mode all changes within the
document are saved and can no longer be undone.
The same applies to transcription mode, as MAXQDA's Edit mode is automatically turned on
for this.
The "Merge Projects" and "Import Teamwork" actions cannot be undone. Since these
functions can have complex effects on the project structure, a backup copy of the project is
automatically created in the designated folder before the function is started. Actions taken
before using these functions cannot be undone.
Text changes within a memo are also saved when the memo is closed. The undo function
returns the memo to the state before it was opened.
The undo function of MAXQDA has no effect on MAXMaps - there is a local undo function,
which applies to the opened map.

The four main windows

MAXQDA's four main windows occupy the main part of the main interface:
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The four main MAXQDA windows

The four windows have the following functions:

The “Document System” provides an overview of all the texts, PDF files, tables, pictures and
media files of your project. You also have the option of organizing these documents in
document groups, which act as folders.
The “Code System” displays all the codes, subcodes, and code memos created so far.
The “Document Browser” displays one of the documents from the “Document System”, where
it can then be worked on. You can highlight, edit, code, create links, or attach memos in this
window.
The “Retrieved Segments” window is a results window. Here you can display a selection of
coded segments.

Hiding or displaying the main windows

All four main windows have a small toolbar at the top for quick access to frequently used functions.
When you move the mouse over an icon, a tooltip appears with a brief description.

To the right of the toolbar, all main windows offer the same three functions:

The gear symbol opens the settings that apply to that window.
The long dash minimizes the window to the bar at the bottom of the window. Click on the
name of the window in the bar at the bottom to open it again.
The window symbol with the arrow releases the window from its fixed structure, for example
to place it on a second screen.
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Display icons

The "Document System"
The “Document System” window lists all documents available in the respective MAXQDA project.

MAXQDA Documents
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Toolbar

The toolbar at the top of the “Document System” window provides quick access to important
functions in this window, among others:

 Reset activations – resets current activations

 Activate by ... – enables the activation of documents depending on their variable values and
colors as well as random activation

Display only activated documents - reduces the display of documents to currently activated
ones

Import document(s) – allows you to insert text, PDF files, spreadsheets, images and media files
into the project
New text document - creates a new text document and opens it directly for editing in edit mode
New document group – creates a new document group directly above the top document group in
your list

Local settings

After clicking on the gear symbol in the "Document System", the following options dialog box will
appear with locally relevant settings:

"Document System" Settings

Open documents in tabs – Enable this option to display each document you open in a new tab in the
"Document Browser". The previously opened document remains open in a tab.

Display favorite variables in th tooltip – Select which document variables should be displayed at the
mouse pointer when you hold the mouse over a document name.
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Import comments from Word or PDF documents as memos – Enable this option to import existing
comments on Word and PDF document as in-document memos.

Automatically code hihglightd text while importing Word or PDF documents – Enable this option to
import color highlighting that already exists in a Word or PDF document as regular codings.
MAXQDA will create one code for each color.

Ignore images and objects when importing text documents – graphics, especially photos, take up a
lot of space in a text, and there are research situations where only the plain text is of interest, not the
potentially annoying graphics. Therefore, by selecting this option you can ensure MAXQDA does not
import graphics and other objects and cleans up the text.

Insert new documents at the end of the list – By default, new documents are inserted at the top of
the tree or at the top of a document group. Enable this option to insert documents at the bottom of
the hierarchy level instead.

Assign Audio / Video File – Opens a dialog window where you can select an audio or video file to
assign to the text. (The entry is visible only if you click a text document that has not yet been
assigned a media file.)

Transcribe Audio / Video File – Activates transcription mode for an audio or video files. (The entry is
only visible if an audio or video file is assigned to the selected document.)

Coded Segments - Opens the Overview of Coded Segments with the coded segments in the selected
document.

Variables - Opens the Data Editor for Document Variables with the variable values of the selected
document.

Codes - Opens the tabular Overview of Codes with the codes assigned in the selected document.

Memos - Opens the Overview of Memos with the memos of the selected document.

Summaries - Opens the Overview of Summaries with the summaries of the selected document.

Paraphrases - Opens the Overview of Paraphrases with the paraphrases of the selected document.

Links - Opens the Overview of Links with the links of the selected document (documentation links
and external links, geo-links and web links).

Focus Group Participant - Opens the Overview of Focus Group Participants with the participants of
the selected focus group and their variable values. (The entry is only visible if a focus group
transcript has been selected.)

Document Portrait – opens a visualization of the document that uses the code colors of the coded
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segments in the document to create a picture of the document. The size of the coded segment acts
as the weighting factor, meaning that the longer the coded segment, the more space that color takes
up in the visualization.

Codeline – opens a visualization of the coded segments of the document. A matrix is created with
the codes on the y-axis and the paragraph numbers on the x-axis. It is then possible to see which
codes were used in each paragraph of the document.

Word Cloud – creates a visualization of the most frequently-used words in the document (only for
text, pdf and table documents).

Code Cloud – creates a code cloud with the most frequent codes that appear in the document.

Single-Case Model > Single-Case Model (Coded Segments)/(Summaries)/(Paraphrases)/(Code
Hierarchy) - Creates a new single case model in MAXMaps with the selected document at the
center.

(Color Selection) - A color can be assigned to the document.

Teamwork > Teamwork Export: Export Data to Exchange File - Exports the encoded segments,
memos, summaries, paraphrases and variables of the selected document.

Teamwork > Teamwork Import: Import data from Exchange File - Imports the coded segments,
memos, summaries, paraphrases and variables of another project into the selected document.

Teamwork > Export Teamwork – allows for the export of all coded segments, memos, summaries,
and variables for the document. The exported file can be imported in a project on a different
computer. This function enables you to work in a team and divide the work on a single document
among team members.

Teamwork > Import Teamwork – allows for the import of coded segments, memos, summaries, and
variables for the document of an earlier exported file.

MAXDictio: Quantitative Content Analysis – creates a count of the dictionary categories in the
selected document. (This function is only available for "MAXQDA Plus" or "MAXQDA Analytics Pro".)

Properties – opens a window with all the properties of the document, which can then be edited (e.g.
whether or not the document should be opened in read-only mode). You can also link a media file to
the corresponding document (e.g. an audio file with the corresponding transcribed interview) to
either code the transcript or the media file itself.
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The "Document Browser"
The “Document Browser” is MAXQDA's main work window: This is where you can code texts and
images, write memos, link text and/or images together, add external links and more. The majority of
the functions you will carry out in the “Document Browser” are available in the context menu, which
you can access by right-clicking in the window.

"Document Browser" window settings

Toolbar

Several functions are also available in the toolbar at the top of the “Document Browser.” Besides
others, it contains the following functions:

Print document – allows you to print the document displayed in the window, optionally along
with memo symbols and coding stripes.

Export displayed document – saves the open document in a location of your choice.

Spellcheck on/off – highlights misspelled words according to the language selected in the
settings (see below).

Show sidebar – displays the sidebar to the right of the document. Memos, comments and
paraphrases can be displayed in the sidebar.

Local settings

When you click on the gear symbol in the "Document Browser" window, the following options dialog
box will appear with local settings:
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Settings for the “Document Browser“ window

Copy text segments with source information to clipboard – Enable this option to append the
indication of origin (document group, document name, and document position) to all text segments
that you copy to the clipboard.

Display coding stripes on the right – By default, the coding stripes are displayed to the left of the
document. Select this option to place the coding stripes to the right of the document.

Reset coding stripe filters when opening a project – Enable this option to show all coding stripes
after re-opening a project. Disable the option to keep your last setting.

Maximum number of codes in 'Quicklist' – The setting determines the number of the last used
codes in the drop down coding toolbar above the document.

Spellcheck language – Use the drop-down menu to select the language for MAXQDA's spell check.

The "Code System"
In the “Code System” window , you develop and organize your coding framework for analysis.



  26

The "Code System" window

Toolbar

The toolbar at the top of the “Code System” window provides quick access to important functions in
this window, among others:

Reset activations – resets current code activations.

Only activated codes – displays only activated codes.

Display codes from activated documents only – reduces the code system to codes assigned in
at least one of the currently activated documents.

New code – adds a new code to the code system on the currently focused level.

Local Settings

Click on the gear symbol in the “Code System” and the following options dialog will appear with local
settings options:
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"Code System" settings window

Display frequency – here you define what the numbers behind the codes should indicate. The
setting does not refer to the entries "Paraphrased segments" and "Focus group speaker" in the code
system. The selection is reset to the setting "Coded segments of all documents" when opening a
project.

Sum up frequencies of subcodes – if you collapse a code, the frequencies of the code and all its
subcodes will be added if this option is selected.

Click a code to apply a code to a selected segment – if enabled, you can click on a code to apply it
to a selected segment instead of having to use drag-and-drop.

Table view – switches from tree view to tabular view of all entries in the code system. Will be turned
off when opening a project.

Display emoticodes only – if enabled, only emoticodes are displayed in the code system and all
other entries are hidden. Will be switched off when opening a project.

Display 'Paraphrased Segments' at the top – by default, the entry 'Paraphrased Segments' is
displayed below the codes. Enable this option to fix the entry at the top of the code system.
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Display 'Focus Group Speaker' at the top – by default, the 'Focus Group Speaker' entry is displayed
below the codes. Enable this option to fix the entry at the top of the code system.

Show search hits only (during search) – if enabled, only the search hits are displayed during code
searches in the code system.

Insert merging history in code memos – if enabled, a merging history is added to the code memo.

Insert new subcodes below – by default, new subcodes are inserted directly below the clicked
parent code. Enable this option to add new subcodes below the existing subcodes.

"Coding with new code", "Coding in vivo", "Open coding":

Insert new codes at the top – new codes added by the listed coding functions are inserted at
the top of the code system.

Insert new codes at current position – newly added codes are inserted at the current focus
as subcodes.

No duplicate code names on same level – this option prevents codes with the same name from
being generated at the same hierarchy level.

The "Retrieved Segments" Window
In the “Retrieved Segments” window, you can compile text passages, image sections, and video clips
that you have previously coded.

The "Coded Segments" window
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Toolbar

Amon others, the following functions are available in the toolbar at the top of the “Retrieved
Segments” window:

Display origin – displays the document name from which the segment originates for each
segment, supplemented by the position within the document.

Display favorite variables – for all variables marked as favorites in the List of Document
Variables, the variable values for each segment are displayed.

Display comments of coded segments – displays the column with comments on the coded
segments.

Overview of retrieved segments – opens the tabular Overview of Coded Segments containing
all retrieved segments.

Smart Coding Tool – opens the retrieved segments in the Smart Coding Tool, where the
assignments of codes can be analyzed and re-worked.

Code Relations Browser – opens the Code Relations Browser for the displayed retrieved
segments, which visualizes co-occurring codes.

Word cloud – creates a word cloud of the words most often used in the displayed retrieved
segments.

Code retrieved segments with a new code – all coded segments that are currently in the
“Retrieved Segments” can be coded additionally with a new code.

Print retrieved segments – prints segments along with indications of their origins.

Export retrieved segments – the segments can be exported in several formats (for example,
Word and Excel). Memos attached to coded segments, other codes assigned to the segment, as well
as tooltip variables, can be included in the exported material.

Local settings

When you click on the gear symbol in the “Retrieved Segments” window, the following menu will
appear with local settings:
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"Retrieved Segments" settings window

Ordered by 'Document System' – the segments in the “Retrieved Segments” window will be sorted in
order of the “Document System.”

Ordered by 'Code System' – the segments in the “Retrieved Segments” window will be sorted in
order of the “Code System.”

Ordered by weight score (ascending/descending) – sorts retrieved segments according to the
weight assigned to them. 

Include subcodes – automatically includes all subcodes in the retrieval for each code activated in
the “Code System.”

Use weight filter – displays only those retrieved segments that are within a certain weight range.
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Edit weight filter – opens a window where you can change the range of weight scores included in
the “Retrieved Segments” window.

Show weight – displays the weight of the coded segments in the code name. The weight is only
displayed when the origin information is displayed.

List View – this is the default view for the “Retrieved Segments” window.

Classic View – switches to the view of previous versions of MAXQDA.

Table View – switches to a tabular list of coded segments.

Managing Table Overviews
MAXQDA lets you open several table overviews that list project data such as coded segments,
memos or variables:

A project’s document variables pverview

Customize the view of tabular overviews

Sort the table: Click the column header to sort in ascending order. Click again to sort in
descending order.
Reset sorting: To reset the sorting, right-click a column header and choose Reset Sorting.
Change column width: Drag the column dividers in the header while holding down the left
mouse button. Double-clicking a column separator sets the column to the optimal width,
which is the maximum space occupied by a value in that column.
Change the column position: Click on the desired variable name in the table header and drag
the column to the desired position.
Hide and show columns: Right-click a header row and select Hide to hide a column. Right-
clicking on a visible header row and selecting the Select Columns option (or clicking on the
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corresponding icon in the toolbar) opens a dialog for selecting the visible columns.

Changing the contents of tabular overviews

Tables in MAXQDA have editable and non-editable columns. Values can be entered in the editable
areas of the table by double-clicking on the corresponding cell.

Please note: Editable columns have a blue header. Non-editable columns have a black header.

Table overviews with a detailed display

The Overview of Coded Segments differs from other overviews that it is divided into two parts. The
lower part is used as in other tables. The upper part serves as a detailed view. It shows the coded
text or image segment selected in the lower part. The same applies to the “Overview of Memos”:
here, the detailed view of the memo will appear.

Detailed view of the "Overview of Coded Segments"

The toolbar in table overviews

All overviews have a toolbar below the title bar that provides direct access to frequently used
functions. The overviews have different icons in the toolbar depending on their functionality.
However, some icons are available in almost all windows:

Only activated documents – Displays only the rows with activated documents. The icon is
clickable only if at least one document is activated.

Only activated codes – Displays only the rows with activated codes. The icon is clickable only if
at least one document is activated.

Switch on Filter – Turns the filter for all columns on and off. The icon can only be clicked when
a filter has been set for at least one column. Set the filter by right-clicking on the column header (see
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below).

Reset all filters – Deletes the defined filter for all columns of the table.

Search – Turns the search toolbar for the table on and off.

Filtering table overviews

Table overviews can easily be filtered. For example, in the Data Editor you can display only the rows
with documents containing more than 20 codes or whose names begin with “B”:

Right-click on the heading of the column you wish to filter, and select the Set Filter option. (If1.
a filter is already set for the column, this option is called Edit Filter.)

Set filter by column

Set the desired filter options in the window that appears.2.
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Filter options window

In all four input fields, you can define criteria to filter. The following criteria are available:

Contains
Doesn’t contain
Starts with
Greater than or Lesser than (applies to both numbers and the alphabet)
Earlier than and Later than (available only in columns containing a date)

OR/AND – Here you can choose how the four input fields are combined. OR lists the rows where at
least one of the criteria is true. AND lists the rows where all criteria are true.

Case-sensitive – Enable this option to distinguish between uppercase and lowercase text in the text
column. In this case, if "interview" appears in lowercase in the filtered column, "interview" that begins
with an uppercase letter would not be considered.

After clicking OK, MAXQDA filters the table overview according to the defined criteria. At the top
right MAXQDA indicates how many of the originally existing rows are currently displayed.

Please note:

Each time your reopen an overview, the filters are automatically be set to “off”. The filter
settings are saved individually for each overview in the project, so if you have defined a filter
and reopen the project at a later time, you can turn on the filter by simply clicking the Filter
icon.
If you set a filter for multiple columns, they are combined with the AND function.
You can toggle a table view filter on and off at any time using the Switch on filter icon.
If you want to clear all defined filters, click on the Reset all filters icon.
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General Preferences
Click on the gear symbol in the lower left corner of the MAXQDA main window to open the General
Preferences window, in which you can adjust various MAXQDA settings.

Open general preferences window

General preferences window

The following settings can be changed:

“General” settings

Search for updates automatically

If enabled, MAXQDA will check for free updated MAXQDA versions each time you start the program.
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If an update is available, it is recommended that you download it in order to benefit from interesting
new features and enhancements.

Do not embed if larger than [MB]: This value determines the size at which an imported PDF or image
file will not be saved in the MAXQDA project file, but in the folder for externally stored files, with only
a reference to the document created in the project. The default size is 5 MB. If necessary, you can
increase or decrease this value.

Folder for externally stored files

Specify the location where you want all of your externally linked files to be saved. This includes, for
example, audio and video files that are too large to be included in the project file. Image and PDF
files may also be saved here, depending on their size and your settings.

Folder for new project files

Specify the location that MAXQDA suggests for new projects.

Default weight

Each coded segment is assigned a weight. The default weight score for newly coded segments is 0,
but can be changed here.

Autosave documents in Edit Mode and memos

Specify the amount of time (in minutes) after which edited documents and memos are saved
automatically.

Confirm deletion of objects

If you deactivate this option, MAXQDA will no longer ask for confirmation when deleting code
assignments, codes, documents, memos, etc., but will delete these data directly. You can only
restore them using the Undo function.

“User interface” settings

Interface theme

Switch between the light and dark color scheme. If you select the “System” option, MAXQDA will
adapt to the interface design of your operating system.

Interface language

Set the language of the menus, dialogs, and windows of MAXQDA.

Spellcheck language

Set the language for MAXQDA's spellcheck function. MAXQDA offers spell checking in English (UK),
English (US), German, Italian, and Spanish.
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Font size

Select Large to see the program interface labels (menus, title bars, dialog boxes, code and
document system, etc.) in a larger font size.

Reset interface settings

Check this box to reset all your user settings to default values.

“Fonts” settings

Default Fonts

Here you can set a default font for new Documents, memos, QTT insights text, and MAXMaps
labels.

“Word Separation” settings

Characters to be cut off

Clicking onthe button with the three dots

opens a dialog box in which you can enter characters to be cut from the words and ignored in the
analysis. The characters selected in the dialog box apply to all word-based functions in MAXQDA
and MAXDictio.

How does MAXQDA define a “word”?

A word is any sequence of characters between two delimiters. These delimiters are spaces, carriage
returns, and any characters defined as to be cut off.

Some problems can occur with hyphens. If you want compound words to be counted as one word
and not split into separate parts, the hyphen may not be declared as a delimiter. We recommend to
experiment with the charaters to be cut off. For example, you can check the results of a Word
Frequency analysis and look for characters to add to the list of truncated characters.

Ignore hyphens at the end of lines (PDF)

If enabled, MAXQDA will try to ignore all hyphens inserted at the end of lines in PDF documents for
hyphenation purposes, so that the hyphenated words can be analyzed as a single, unseparated
word.

Text language is Japanese

Enable this option if you analyze Japanese texts, since MAXQDA has to use a specific separation of
the words. Only when this option is activated does the next option, Ignore particles (Japanese), take
effect, which ensures that all Japanese particles are excluded from word-based analyses such as
the word cloud. For details, see Analyzing Japanese Texts.

https://www.maxqda.com/help-mx24/maxdictio/language-options
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“Automatic Import” settings

Select the folders on your computer that you want MAXQDA to monitor. All files placed in the
selected folders that do not exist in the currently open MAXQDA project will be imported
automatically.

“Automatic Backups” settings

Back up projects automatically

If the option is activated, MAXQDA checks each time a project is opened, when it was last saved by
MAXQDA and if necessary creates a backup of the project.

Time interval [days]

Set the number of days after which MAXQDA will start the next backup of a project.

Folder for backup files

Specify the folder in which you would like MAXQDA to save backup copies of a project.
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02 – Import Data

Supported Data Types
The following table provides an overview of what data types you can import into MAXQDA:

Data Format Examples and Notes

Texts, transcripts,
Transcripts with time
stamps and
associated media
files,
Focus group
transcripts.

Word (DOC/X)
OpenOffice (ODT)
Rich Text (RTF)
Text (TXT)

Interview transcripts, field notes, observation
logs.
Time stamps allow the synchronization of
transcript and sound.
Speakers in group discussions are
automatically coded

Documents PDF Academic journals, literature, news articles

Tables Excel (XLS/X) Spreadsheet with survey result

Images PNG, TIF, JPG, GIF,
SVG, BMP

Photo diaries, advertisement images

Audio files MP3, WAV etc. Recorded interviews (these can be transcribed
and synchronized with the transcript)

Video files MP4, AVI, MPG, MOV
etc.

Recordings of group interactions, YouTube
videos
Data can be transcribed and synchronized with
the transcript.
Video and audio can be coded directly.

Surveys,
questionnaires

Excel (XLX/S)
SPSS (SAV)
Direct import from
SurveyMonkey

Exported data matrices from the open-source
software LimeSurvey

Pre-structured texts
and tables

Same as for texts and
tables

Exports from the online data collection tool
kernwert.de can be coded automatically during
the import

Websites Downloads from the
MAXQDA Web
Collector (free
extension for Chrome
browser)

Company presentations, news articles

Tweets Direct import of
Tweets

Social media analysis of trending topics

YouTube comments Direct import from
YouTube

Social media analysis of trending topics

Video file subtitles SRT Film analysis
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Bibliographic Data RIS, TXT For literature reviews

 

Please note: In Windows, ODT documents can only be imported in MAXQDA if Microsoft Office
(2003 or later) is installed on your computer. Otherwise, the documents can be saved in DOCX
format and then be imported into MAXQDA.

All text and table documents imported into MAXQDA can be edited in the “Document Browser”. This
means you have the option of fixing typos, deleting or adding text, etc. This is also possible once you
have done some coding and/or creation of memos. This means you don’t have to have a completed
document to start your coding. PDFs, images, and audio/video files cannot be edited in MAXQDA.

You can also create new texts or spreadsheets in an opened project at any time, into which you can
paste content from the clipboard.

Analyzing texts in any language (Unicode supported)

The fact that MAXQDA supports Unicode makes it possible not only to import and analyze
documents in any script, from Japanese to Cyrillic to Arabic, but also to create codes and variables
in these languages. The support for Unicode text is available in every MAXQDA function.

Unicode is an international standard with the goal of standardizing all known languages and
characters. This makes it possible to work with various languages in the same document. One
sentence can be in English, the next in Mandarin, and the next in Arabic. In MAXQDA, even codes and
variable names can be created with “foreign” characters, and searches and in-vivo coding are
possible with any language.

Import and Group your Data
Importing data via the "Import" menu tab 

The Import tab provides numerous functions for importing different data types. When you create a
new project, the tab is automatically opened so that you can start importing data directly:

Importing data via the &quote;Import&quote; tab

How to import standard data such as texts, PDF documents, tables, images, or audio / video files:

Go to the Import tab and click on the appropriate icon for your data type, such as ranscripts1.
to import interview transcripts, and Texts, PDFs, Tables to import Word files, PDF documents,
or Excel files.
A dialog window will appear, in which you can select the files to be imported. Press Ctrl2.

http://unicode.org
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(Windows) or ⌘ key (macOS) to select multiple files at once.

The files will be inserted into the open MAXQDA project and displayed in the "Document System"
window. The following figure shows that several text documents have been added.

Imported documents in the documents window

By default, all inserted texts, PDF documents, tables, and images are saved in the project file. This
means that you can modify or delete the source file without effecting the file in the project.
Conversely, you can make changes to a file in MAXQDA, for example correct typing errors, without
changing the source file. Exceptions are audio and video files, which are not stored in the project due
to their size, but in a special folder for external files. The same is true for PDF documents and
images that exceed a configurable file size. For more information, see External Files.

When inserting a file, MAXQDA takes the file name as the document name, which can be modified
later. Depending on the type of document, different icons are displayed.

Please note: The other icons on the tab can be used to import special data types, such as focus
group transcripts, survey data, or web pages. The specifics of these imports are described in detail
in their own sections.

Ordering the documents in document groups 

Once you’ve imported your documents, you’re ready to begin your analysis. However, most people
don’t start analyzing right away, but prefer to organize the documents in folders. In MAXQDA, these
folders are called "document groups". They work just like folders on your computer – you can name
them and drag documents into them.

https://www.maxqda.com/help-mx20/import/external-files
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Groupped files in the documents window

There are several ways to create a new document group:

Click the green plus icon in the "Document System" toolbar or in the first row and select New
Document Group from the menu.
Right-click on the root folder in the "Document System" and select New Document Group
from the context menu.

MAXQDA then creates a new document group at the current position and automatically assigns a
name and number to it. To give the document group a meaningful name, right-click on it and select
Rename. Alternatively, click the name once to select the line and then click the name again.

Suitable names for document groups are, for example, the types of data (individual interviews, group
discussions, document analyses, etc.) or the differentiation criteria resulting from the sampling (first
survey wave, second survey wave, church organizations, public organizations, etc.).

Please note: You can create document groups at up to two levels. This means that each top-level
document group can contain subgroups. These subgroups cannot contain other subgroups.

You can change the order of the document groups at any time using drag-and-drop.

More import options

You can import documents not only from Import tab but also using several other ways:

Click the green plus icon on the toolbar of the "Document System" and select Import
Documents.
Or use the keyboard shortcut Ctrl+D (Windows) or ⌘+D (macOS).
Or right-click on the root folder in the "Document System" or a document group and select
Import Documents from the context menu.

As described above, a dialog window opens, allowing you to select files for import.
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Please note: The documents are imported into the document group that or whose document is
currently selected. If no document group or root folder is selected in the ”Document System”,
MAXQDA inserts the new documents at the top of the document "tree".
Importing documents via drag and drop

Files can be imported using drag and drop: select one more documents in the Windows Explorer or
Mac Finder and simply drag and drop them into the "Document System" at the desired position. 

Tip:

To import the documents of a whole folder into MAXQDA, drag the folder from the Windows
Explorer or Mac Finder into the "Document System". MAXQDA then creates a new document
group with the same name of the file folder at the top of the document "tree" and imports all
documents that MAXQDA can import. If the folder contains subfolders, these are also created
as separate document groups.
You can use the keyboard shortcuts Ctrl+C + Ctrl+V (Windows) or ⌘+C + ⌘+C (macOS) to
copy and paste documents and document folders into the "Document System". 

Moving and sorting documents

Moving individual documents

You can change the order of a document in the "Document System" by clicking and dragging it to the
desired position.

Moving multiple documents

You can select multiple documents by holding down the Alt key (Windows) or ⌥ key (macOS) and
then dragging the selection. To select a range of documents, first click a document and then click a
second document while holding down the Shift key ⇧. This will select all documents between the
two clicked documents.

Moving multiple documents by activating them

To move multiple documents at once, first activate them by, for example, clicking on the circle
symbol in front of their document symbol (the documents will then be highlighted). Now right-click
on a document group and select Move Activated Documents Here.

Sorting documents

To sort the documents in a document group, select Sort Documents from the context menu of the
document group and then the desired sort order from the drop-down menu. Sort criteria include
Document Name, Last Action, and Text Length (only text, table, and PDF documents are
considered).

To sort document groups by names, right-click the root folder of the "Document System" window,
and select Sort in Ascending Order to sort them from A-Z or Sort in Descending Order for reverse
order.
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Document sets

MAXQDA allows you to create and save temporary sets of documents. While each document can
only be in one document group, it can be in as many document sets as you like, because document
sets consist only of links to the documents. In other words, a document from a document set can be
deleted without affecting the document itself. However, if the same document were deleted from a
document group, it would be deleted from the project along with all of its memos, coded segments,
links, etc.

Document sets are very usefule when you want to analyze a particular selection of documents.
Creating a document set is also an easy way to store the result of a complex activation by variable
process.

How to create a document set

Activate all documents to be included in the set, for example, by clicking on the circle in front1.
of the document symbol.
Right-click on the word Sets at the bottom of the “Document System” window.2.
Select New Set From Activated Documents.3.

MAXQDA will create a new set with the name “Set 1” and adds all activated documents to this set.
You can right-click the name and select Rename to give the set a more appropriate name. Document
sets may be used like document groups, for example, you can activate all the documents in a set by
activating the set.

Modifying document sets at a later stage

Drag and drop additionaly documents or multi-selected documents into the desired set and
MAXQDA will insert them at the top of the set.
Right-click on a document in a set and select Remove Document from Set to delete it from
the set.
Drag and drop documents to move them from one set to another.

Text Documents
Importing texts

You can import texts into a MAXQDA project in various ways:

with the mouse, drag and drop text files from the Windows Explorer or macOS Finder directly
into the “Document System” window,
click the plus icon in the “Document System” window, or
click the Texts, PDFs, Tables icon in the Import tab.
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Importing data via the "Import" tab

Please note: In Windows, ODT documents can only be imported in MAXQDA if Microsoft Office
(2003 or later) is installed on your computer. Otherwise, the documents can be saved in DOCX
format and then be imported into MAXQDA.

For general information on importing files and organizing them, see Import and Group your Data.

Preparing text documents before import

If you want to import text documents into MAXQDA, you should think about how to prepare them.
For example, if you want to analyze specific text passages as single units, it makes sense to put
them together in the same paragraph. This makes it easier to automatically code these paragraphs
in MAXQDA.

Here are some things to remember when importing a text document into a MAXQDA project: 

All formatting (e.g., bold, italics) as well as typefaces and font sizes are kept.
Most of the paragraph formatting (e.g., right-justified, line height) is kept.
The text may contain tables, pictures, graphics, etc.
Whether objects such as graphics are imported or not can be determined in the local
preferences of the “Document System” window. The preferences can be opened by by
clicking on the cogwheel icon in the upper right corner of the window.
Contents of headers and footers are ignored.
Footnotes are added at the end of the text, they are converted to endnotes.

Color highlighting and comments

Color highlighting in a Word document is imported into MAXQDA as codings. A parent code with the
name "Word/PDF highlighting" is created at the top level of the code system. For each color, a
subcode with the color name in English is created and assigned to the corresponding text passage.

Please note: When importing the color highlighting, slight color deviations from the original are
possible, since MAXQDA selects the most suitable color from a list of stored colors.

Comments in Word documents are imported as in-document memos and can be displayed in the
"Document Browser". Several related comments (threads) are combined into one memo.

The option to code highlighted text and import comments as in-document memos during import can
be turned on/off in the settings of the "Document System". The preferences can be opened by by
clicking on the cogwheel icon in the upper right corner of the window.

In-text tables

MAXQDA can import tables included in text documents, and you can code parts or whole cells of
these tables in MAXQDA. The only limitation here is that the size of the table and the column widths
can no longer be changed once it has been imported.

Please note: We recommend that you use tables sparingly in text documents. This not only
increases your analysis options (e.g., automatic coding at the paragraph level), but also increases
the performance of the display. In particular, we do not recommend importing interviews in a table

https://www.maxqda.com/help-mx24/import/import-group-data


  46

structure where each response is in a separate row.

Links to websites embedded in texts

Documents imported into MAXQDA can also contain links to websites. Clicking on the link in
MAXQDA opens the webpage in the default browser.

These links always consists of two parts: the visible text and the address of the link. If you move the
mouse over the link, you can see the link address in the tooltip that appears.

Please note: If you enter an Internet address in a text in MAXQDA, it will automatically be converted
into a clickable link when you close the Edit Mode.

For more information, see Links in MAXQDA.

Create New Text or Table Documents
With MAXQDA, you can not only import and export texts and tables, but also create them, for
example, for ethnographic descriptions of research objects.

Create new text documents

There are several ways to create a new text document, among others:

Click the green plus icon on any level in the "Document System" and select New Text
Document from the menu.
Go to the Import tab and click the Create Document icon.
Use the keyboard shortcut Ctrl+T (Windows) or ⌘+T (macOS). 

Creating a new text document in the Document System

https://www.maxqda.com/help-mx20/links/links-in-maxqda
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MAXQDA will automatically name the document "Document (sequential number)". Of course, you
can rename the document at any time. After you have created a new document, it is automatically
opened in the "Document Browser" and put into "Edit Mode", so that you can start typing or pasting
text from another program into it.

Create new tables

To create a new table, go to the Import tab and click on the text (not the icon) Create Document.
Then click New Table Document in the menu that appears. In the options dialog, you can select the
number of rows and columns.

Please note: No new columns or rows can be added later.

Convert text document into a table 

You can convert a text document into a table document, for example, to paraphrase the text in an
additional column:

Open a text document by double-clicking on its name in the “Document System“.1.
Then go to the Import tab and click on Convert Text to Table Document.2.
A dialog box will appear, in which you can specify the number of columns.3.

Please note: The original text will be preserved in the “Document System“ window, the new table will
be inserted as a copy.

A new table document appears in the “Document System“ with the same name as the source
document. Each paragraph of the source text appears in a separate line of the new table. If you have
selected more than one column for the table, the text appears only in the first column.

The original text appears only in the first column

As this picture shows, this conversion function makes it easy to paraphrase and summarize texts in
MAXQDA. When you activate the Edit Mode, you can paraphrase the texts in the empty columns of
the newly created table.
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External Files
During import, Word texts and Excel tables are imported into the respective MAXQDA project file, i.e.
a copy of the original file is stored in the project. You can edit or delete the file in MAXQDA without
affecting the original file, and vice versa: changes in the original file have no effect on the data in
MAXQDA.

The situation is different for PDF and image files that are larger than the default size of 5 megabytes,
as well as for all audio and video files: these files are never stored in the project file, but are copied
to an external file folder, which MAXQDA then accesses. This prevents MAXQDA project files from
becoming very large and difficult to save or share within a team.

In the global preferences, you can specify the size from which PDF and image files should not be
saved in the MAXQDA project file, but in the folder for external files. You can open the global
preferences by clicking on the preferences icon in the lower left corner of the MAXQDA main
window.

Open settings
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Edit settings for saved files

In the global preferences, you can also set the location where external files are to be saved. The
default locations for external files are:

for Windows installations: [Documents]\MAXQDA_Externals
for Mac installations: [Documents]/MAXQDA/Externals

Please note: All your external documents will be saved in one global external folder. If you wish to
save externals in a project-specific folder, you should create a folder for the designated project.
However, it can be useful to work with a global external folder from which external files can be
accessed by multiple MAXQDA project files. For this reason, when you delete a document, the
associated media file will not be deleted without confirmation, as the file could still be linked to
documents in other project.
What happens if a PDF or image file larger than the specified maximum size is imported into a
MAXQDA project?

You will be informed that the file is stored externally and is not embedded in the project.
The document will be added to the list in the “Document System” and visualized with the
same icons just as it would be if it were a smaller file.
The file is copied to the specified folder for external files. The original document remains in
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its original location.

What happens to a media file (audio/video) if it is linked to a text document in the “Document
System”?

The location of the original audio or video file is saved in the document's properties.
The original media file is never saved as part of the MAXQDA project file, even if it is smaller
than the maximum file size.
The media file is copied to the folder for external files. The original file remains in its original
location.

Which file is used – the original or the copy?

MAXQDA always searches for the original first – it searches for the file based on the path that is
displayed in the document's properties menu. If the original is not found, the copy of the file in the
External Files folder is used instead. And if the file is not available here either, MAXQDA searches in
the folder where the currently open project file is stored. This means, the original file can be moved
or deleted without affecting the proper functioning of MAXQDA.

Be careful when using the same file name for different files!

It is possible to import several documents with the same name into the “Document System” (for
example, three files named “Document 1”). This is only a problem if the file is larger than the
specified maximum size and needs to be saved in the External Files folder. When the last imported
file is saved, it automatically replaces the older file with the same name (on confirmation).

What happens if you change the location of the External Files folder in MAXQDA's global
preferences?

In this case, MAXQDA will ask you if you want to move the documents from the previous location to
the new folder. The documents will only be moved if you confirm this. Since this action changes the
global setting for all projects, all files will be moved from the old External Files folder to the new.

Can you import an externally saved document into the project file at a later time?

Yes, you can. To do this, right-click a document in the “Document System” and select Properties. In
the properties dialog, go to the Storage section and select the option In project.

Can you store a document outside the project file at a later stage, that is, save it in the folder for
external files?

Yes, you can do this, too. To do this, right-click a document in the "Document System" and select
Properties. In the properties dialog, go to Storage and select the option In folder for external files.

/div>
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Save a file in the "Externals" folder

To store several documents outside the project file, go to the Home tab and select External Files >
Store Documents in Folder for External Files. A dialog box will appear listing all documents stored in
the MAXQDA project file. Here you can select all the documents that you want to store externally.

Drop-down menu for storing multiple external files

How do you transfer external files from one computer to another?

To share the project with team members and colleagues, including the external files, follow these
steps on the source computer:
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Send the MAXQDA project file (with file extension ".mx24") to the target computer.1.
Bundle all external files by going to the Home tab and clicking on External Files > Bundle2.
External Data Files. MAXQDA will compress all external files associated with the current
project into a zip archive, which is named after your project (e.g. “Projectname.mx24.zip”) and
will save it in the same place as your project file.
Send this newly created zip file, to the target computer, too.3.

Procedure on the receiving end:

Open the MAXQDA project file.1.
In the Home tab, click External Files > Unpack Bundled Data Files and select the zip archive in2.
the file dialog box that appears. MAXQDA will unpack the archive and will copy the linked files
to your external files folder. If you saved the zip archive in the same folder as the project file,
MAXQDA will automatically access the archive after calling the function, and will unzip the
files on request.

PDF Documents
Importing PDF documents

You can import PDF documents into a MAXQDA project in various ways, for example,

drag and drop PDF files from the Windows Explorer or macOS Finder directly into the
“Document System” window,
click the plus icon in the “Document System”, or
click on the Texts, PDFs, Tables icon on the Import menu tab.

Importing data via the "Import" tab

For general information on importing and organizing files, see Import and Group your Data.

Tip: MAXQDA does not support editable PDF form fields. To display content from PDF forms, save
your PDF document via a PDF printer as a new PDF file that contains the contents of the form fields
as pure text.
Color highlighting and comments

Color highlighting in a PDF document is imported into a MAXQDA project as codings. A parent code
with the name "Word/PDF highlighting" is created at the top level in the code system. For each color,
a subcode with the color name in English is created and assigned to the corresponding text
passage.

Note: When importing the color highlighting, slight color deviations from the original are possible,
since MAXQDA selects the most suitable color from a list of stored colors.

https://www.maxqda.com/help-mx24/import/import-group-data
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Comments in a PDF document are imported as in-document memos and can be displayed in the
"Document Browser". Multiple related comments (threads) are combined into a single memo.

The option to code highlighted text and import comments as in-document memos during import can
be turned on/off in the local preferences of the “Document System” window. The preferences can be
opened by by clicking on the gear icon in the upper right corner of the window.

Working with PDF documents

There are some special considerations when working with PDF documents, because the PDF format
was not designed for text processing, but rather as a layout format for printing, and therefore the
files are much larger than simple text documents.

Saving PDF files outside the MAXQDA project file

By default, all PDF files smaller than 5 MB are saved in the project file upon import. PDF files larger
than 5 MB are not saved in the MAXQDA project itself, but rather in the folder for externally saved
files, and only a reference to the externally saved data is created. You can customize the maximum
file size as well as the location for externally saved files in MAXQDA’s global preferences, which you
can access via the preferences symbol in the lower left corner of MAXQDA's main window.

Tip: If you work with many large PDF files, for example, with a total size of more than 50 MB, it
makes sense to store them externally (regardless of their file size), so that the MAXQDA file remains
small and can be easily backed up.
For detailed information, see External Files.
Coding text and image segments

Text and image segments in PDF documents can be coded with the mouse. Select and create a
frame around the desired segments to subsequently code them. MAXQDA does not distinguish
between text and image codings in regard to code frequency; however, in the Coding Query when
searching for overlap, the query will search independently for text and image segments, that is,
overlap between text and image segments will be ignored. The “Near” function for image segments
always returns a result of 0, both in the Complex Coding Query and in the Code Relations Browser.

If a text is in the form of a scanned PDF file, Optical Character Recognition (OCR) must be performed
with a suitable program before importing the PDF into MAXQDA. This process makes it possible to
highlight and code the text in MAXQDA, otherwise it would only be possible to highlight images.

Paragraphs in PDF files

Unlike text documents, PDF documents do not have a paragraph structure per se. For this reason,
MAXQDA tries to recognize paragraphs in PDF documents based on various criteria, so that, for
example, the functions for finding words within a paragraph or for autocoding paragraphs can be
used.

Paragraph recognition works very well for most PDF documents, but please note the following
limitations:

For MAXQDA, PDF documents do not contain paragraphs across page boundaries. This
means that even if the content of a paragraph continues on the next page, for MAXQDA the

https://www.maxqda.com/help-mx24/import/external-files
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paragraph ends at the end of the page.
Footnote characters in the text may be recognized as the end of a paragraph.
The quality of paragraph recognition depends on how the PDF was created and how it is
structured. For example, in PDF documents created from scanned text using OCR text
recognition, the quality of paragraph recognition will be worse than in PDF documents created
directly from Word.

Extract text from a PDF document and save as text document

After importing a PDF document into a MAXQDA project, you can extract the text from the PDF
document. Images and formatting are ignored, only the plain text is inserted as a new text document
in the “Document System”.

Select one or more PDF documents in the “Document System” and select the function Insert PDF
Text as New Document. The new text will be inserted directly below the selected documents.

Import a PDF as a new document

Tip: With most  PDF texts, the conversion makes it possible to search for co-occurrences of words
within paragraphs when conducting a text search.

Image Documents
Importing images

You can import images into MAXQDA in various ways, for example,

drag and drop files from the Windows Explorer or macOS Finder directly into the “Document
System” window,
click on the plus icon in the "Document System", or
click on the Images icon on the Import tab.

Importing data via the "Import" tab
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For general information on importing and organizing files, see Import and Group your Data.

Working with images

When working with images, there are a few aspects to consider that are described in this section.

Saving image documents outside MAXQDA projects

By default, all image files smaller than 5 MB are saved in the project file upon import. Image files
larger than 5 MB are not saved in the MAXQDA project itself, but rather in the folder for externally
saved files, and only a reference to the externally saved data is created. You can customize the
maximum file size as well as the location for externally saved files in MAXQDA’s global preferences,
which you can access via the preferences symbol in the lower left corner of MAXQDA's main
window.

Tip: If you work with many large image files, for example, with a total size of more than 50 MB, it
makes sense to store them externally (regardless of their file size), so that the MAXQDA file remains
small and can be easily backed up.

For detailed information, see External Files.

Coding image segments

In image documents, borders can be drawn around the selected area with the mouse which can be
subsequently coded like text segments, meaning they can be dragged and dropped into a code. The
“Near” function for image segments always returns no results, for example, in the Complex Coding
Query and in the Code Relations Browser.

Rotating and zooming into images

As soon as an image document is displayed in the “Document Browser“, several icons for viewing
the image will appear in the toolbar. You can zoom in or out of the image as well as rotate it clock-
wise (images imported from digital cameras and mobile phones should automatically be correctly
rotated by MAXQDA, if the correct information has been saved in the image).

Table Documents
Importing table documents

You can import Excel documents into MAXQDA in several ways, for example:

drag and drop text files from the Windows Explorer or macOS Finder directly into the
“Document System” window,
click on the plus icon in the “Document System” window, or
click on the Texts, PDFs, Tables icon in the Import tab. 

https://www.maxqda.com/help-mx24/import/notes-on-image-documents
https://www.maxqda.com/help-mx24/import/external-files
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Importing data via the "Import" tab

For general information on importing and organizing files, see Import and Group your Data.

What happens when an Excel spreadsheet is imported into a MAXQDA project?

The first worksheet in the Excel workbook will be imported.
Hidden columns and filtered rows in Excel will also be imported.
The columns will be numbered according to their order. The number is displayed at the
beginning of each column heading and cannot be changed post-import.
The entries in the first row of the table will be used as headings.
The order of the rows will be preserved.
The font will be standardized.

Please note: Excel spreadsheets that use Object Linking and Embedding (OLE) to integrate
embedded objects such as Word documents, PowerPoint slides, etc., can have a significant impact
on performance, so we advise against using them. Instead, external links are much better suited for
linking tables with objects outside the MAXQDA project.
The table view in the “Document Browser”

For table documents, a standardized font is used and it is not possible to modify the text format.
You can enlarge or reduce the display font by using the zoom icons in the “Document Browser”. The
height of the rows will be automatically set to the height of the largest cell.

Table columns

During the import, the first row of the imported Excel worksheet is copied as the column header. You
can adjust this heading by right-clicking on a column and selecting Edit:

Modify column header

When you import a table, each column will be assigned a type automatically:

Text
Numeric

https://www.maxqda.com/help-mx24/import/import-group-data
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Date/Time

To change a column type, select it from the drop-down menu Type.

Please note: It is not possible to modify the column type if the column contains coded segments.

The column widths and column positions can be modified using drag & drop. Like overview tables,
table documents in MAXQDA can be sorted by clicking the column header. The original order can
always be restored by right-clicking on the column header and selecting Reset Sorting. Alternatively,
you can click on the empty column header just above the row number.

You can access the following options by right-clicking on the column header:

Hide Column – hides the column.

Edit – allows the modification of column name and column type.

Select Columns – opens a window in which the columns to be displayed can be selected.

Reset Sorting – restores original import order.

Table rows

The row numbers are fixed when the table is imported into MAXQDA and cannot be modified.

Please note: For performance reasons, we advise using table documents with a maximum of 1,000
rows. Longer tables should therefore be divided into smaller units if possible.
Coding table documents

Any text segment of any cell can be coded. First, double-click on a cell in order to select the
contents. The cell will then be outlined in yellow, and you can mark a text segment. All of the usual
MAXQDA coding options, including color-coding and coding with emoticons, are now available. It is
not possible to code across multiple cells.
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Code text in a cell

Please note: When you hide a column, the corresponding coding stripes in the “Document Browser”
will also be hidden.
Coding Query function in table documents

The retrieval options for coded segments in table documents are identical to those for text
documents. For example, overlap will be handled in the same way as it is with normal text. The
retrieval functions also include hidden columns and consider the current sorting of the table.

The Near function, for example, in the Code Relations Browser and in Complex Coding Query,
considers single columns in table documents. Only the vertical proximity of two codes, and not the
horizontal or diagonal proximity, will be taken into account, and coded segments in different
columns will never be found, when using the Near function.

Click on the source data in the “Retrieved Segments” to indicate the coded text in the “Document
Browser” and will display the corresponding column.

Memos in table documents

As with all documents in MAXQDA, you can assign memos to table documents. You can assign a
memo to a table document like this:

Right-click a selected text section in a cell and select Insert Memo for Selection to compose
a memo for the text section.
Right-click on a cell and select New Memo.
Double-click in the memo column to the left of the table to create a memo to the first
character of the first cell at the click position height.

When you click on a memo symbol, MAXQDA will indicate to which text or cell this memo is
assigned.

Please note: When a column is hidden, the memos assigned to the cells in this column will also be
hidden.
Table documents and the Visual Tools

In principle, hidden columns in table documents will be taken into account when using Visual Tools.

Code Matrix Browser functions as with any other type of document, as only the number of coded
segments for a particular code will be analyzed.

Code Relations Browser functions as with overlapping in normal text. Overlap can only occur within
a particular cell. The “Near” function will search only for coded segments in the same column.

Codeline Each row represents a paragraph in the Codeline – the column structure is ignored in this
case. Hidden columns will be taken into account. Paragraphs will be sorted in their original order.

Document Comparison Chart As with the Codeline, each row in the table represents a paragraph –
the column structure is ignored. Hidden columns will be taken into account. Paragraphs will be
sorted in their original order.
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Profile comparison chart works the same as for other documents. The code frequencies and
variable values are compared for the entire document.

Document Portrait This tool operates differently than with regular documents. Columns will be more
or less ignored; cells will be processed from left to right, then top to bottom. A one-dimensional
structure is then created, which is displayed as usual in the Document Portrait.

Code trends and Word trends The table is read from top to bottom, each from left to right, row by
row, that is, the rows are lined up.

Exporting table documents

Table documents cannot be printed directly from MAXQDA; they can, however, be exported in Excel
format. Click the Export icon in the "Document Browser" or right-click on a document in the
“Document System” and select Export Document.

Audio and Video
You can import audio and video files into MAXQDA in several ways, for example,

drag the audio or video file from the Windows Explorer or macOS Finder directly into the
“Document System” window,
click on the plus icon in the “Document System” window, or
click on the Audio or Videos icon on the Import tab.

Importing data via the "Import" tab

There are some special considerations for audio and video files.

MAXQDA supports the following formats:

Audio Windows: MP3, WAV, WMA, AAC, M4A
Mac: MP3, WAV, AAC, CAF, M4A

Video MP4, MOV, MPG, M4V, 3GP, 3GGP
Windows: also AVI and WMV
For video, an MP4 file using the H.264/AVC video codec is recommended.

When importing an audio or video file, MAXQDA creates a new text document with the name of the
media file and links the newly added document to the media file. The media file itself is not imported
into the project, but copied to the MAXQDA folder for externally stored files.

You can customize the location for externally saved files in MAXQDA’s global preferences, which
you can access via the preferences icon in the lower left corner of MAXQDA's main window. For
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detailed information, see External Files.

In the "Document System", text documents with an associated media file can be recognized by the
play icon next to the document name, which allows you to open the file in MAXQDA's media player.

Audio and video files in the "Document System"

Assigning an existing transcript to an audio or video file during import

When importing an audio or video file, MAXQDA asks you if you have a transcript for the media file. If
you select Yes, a dialog window pops up where you can select the transcript file.

If the selected transcript does not contain timestamps, MAXQDA will ask you if you want to create
them automatically

MAXQDA will automatically place timestamps in the transcript at the selected intervals, making it
easy to listen to the original sound of a selected text passage.

Please note: The automatic assignment of timestamps to the text is linear to the length of the audio
or video file. This means, clicking on a time stamp will not always play exactyl the clicked text, but
will position the audio or video file near the text passage.
Assigning audio/video files to a text document 

You can also assign a media file to an already imported text document. To do this, right-click on the
document in the "Documents System" and select Link Audio/Video File.

To change the assignment of an audio or video file, right-click on the document in the “Document
System” and select Properties. In the dialog that appears, an alternative file can be selected in the
Media File section.

https://www.maxqda.com/help-mx24/import/external-files
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Assigning a different audio/video file to a text document in the Properties dialog box

Play and analyze audio and video files

Audio and video files can be played and analyzed in MAXQDA's Multimedia Browser. For detailed
information, see Analyzing Videos.

Transcripts
This section explains how to import interview transcripts into MAXQDA.

Tips:

For automatic transcription of your audio and video recordings, we recommend the MAXQDA
Transcription service.
For manual transcription, you can use MAXQDA's Transcription Mode.

You can easily import automatically or manually created transcripts into MAXQDA. MAXQDA
supports the formats of nearly all transcription programs. Most transcription programs allow you to
export the created transcripts to common text formats such as Word (DOCX) or Rich Text (RTF),
which you can then import directly into MAXQDA. MAXQDA also supports special formats such as
VTT, which is generated by Microsoft Teams or Zoom during a video conference, or video captions
in SRT format.

Transcripts usually contain timestamps that refer to the corresponding audio or video file.
Timestamps are automatically read by MAXQDA during import, allowing you to access and listen to
the original audio directly from the transcript. If you create transcripts or have them created outside
of MAXQDA, they should contain timestamps at least at the end of each paragraph and also within a
paragraph in the case of passages that are difficult to understand.

https://www.maxqda.com/help-mx24/analyzing-videos/the-multimedia-browser
https://www.maxqda.com/help-mx24/analyzing-videos/video-analysis-with-maxqda
https://www.maxqda.com/help-mx24/transcription-audio-video/automatic-transcription
https://www.maxqda.com/help-mx24/transcription-audio-video/automatic-transcription
https://www.maxqda.com/help-mx24/transcription-audio-video/transcription-mode
https://www.maxqda.com/help-mx24/import/subtitle-data-srt
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For example, a transcript with timestamps looks like this:

I: So, Robert. Could you please describe your current living situation for me? [0:00:10.5]
B: Sure. Uhm, at the moment I am living with my parents. In my old room in the basement. I did
have a room in the dorms at college, but I am taking a semester off and wasn't sure where I'd end
up going. I am looking for an internship at the coast, so I'll probably find a place with a roommate
there soon. [0:00:30.1]

Example transcript with timestamps at the end of paragraphs

Importing transcripts with timestamps

How to import transcripts along with their corresponding audio or video files:

Make sure that you have the corresponding audio or video recordings for all of the transcripts1.
that you want to import. For example, you can save the transcripts and the media files in the
same folder, using the same names for a transcript its corresponding media file.
In MAXQDA, go to the Import tab and select the function Transcripts.2.

Import transcripts

From the drop-down menu, select the entry for the transcription software used to create the3.
transcript. If you do not know which software was used, select Transcript with Timestamps.
A dialog box appears for you to select the transcript file to import. If you hold Ctrl (Windows)4.
or ⌘ (macOS), you can select multiple transcripts.
Click Open and MAXQDA asks for the associated media files. Select them in the dialog box5.
that opens, and click Open. If you don’t want to link any media files to the transcript, click
Cancel (MAXQDA will then ask if you want to import the transcript without a media file and if
you want to keep the timestamps in the text).

Supported transcription apps and timestamp

If possible, export your transcripts from the transcription program you use to DOCX format for Word,
as this preserves formatting. If available, make sure the Export Timestamps and Export Speakers
options are enabled when exporting. Of course, the options may have different names for different
vendors.

MAXQDA supports transcripts from the following software for automatic transcription:

Software for automatic transcription Timestamp format

MAXQDA Transcription [h:mm:ss.x]

AmberScript hh:mm:ss

https://www.amberscript.com/
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f4x #hh:mm:ss-x#

GoSpeech hh:mm:ss

HappyScribe [hh:mm:ss.xxx]

Otter.ai special format that e.g. shows hour only when needed

SimonSays hh:mm:ss:xx

Sonix [hh:mm:ss.xx]

Temi special format in a link

Trint [h:mm:ss]

Voicedocs special format that e.g. shows hour only when needed

Please note: f4x allows export in RTF format only. This can be read by MAXQDA without any
problems. HappyScribe and SimonSays offer a special "MAXQDA" format for export, however, the
DOCX format is usually sufficient.

MAXQDA supports transcripts from the following software for manual transcription:

Software for automatic transcription Timestamp

easytranscript, f4 & f5transcript #hh:mm:ss-x#

HyperTRANSCRIBE [hh:mm:ss.xxx]

Inqscribe, Transcriva [hh:mm:ss.xx]

Transana (h:mm:ss.xx)

Transcribe [hh:mm:ss]

Rev, HappyScribe [hh:mm:ss]

Transcriber Pro hh:mm:ss

Generell hh:mm:ss.x
hh:mm:ss.xx
[h:mm:ss]

In fact, MAXQDA supports many more transcripts created by manual and automatic transcription
software, namely those that offer export to a common text format and use one of the timestamp
formats listed.

https://www.audiotranskription.de/en/f4x/
https://www.gospeech.com/en/
https://www.happyscribe.com
https://otter.ai/
https://www.simonsays.ai
https://www.sonix.ai
https://www.temi.com
https://trint.com
https://voicedocs.com/
https://www.e-werkzeug.eu/index.php/en/products/easytranscript
https://www.audiotranskription.de/en/f4transkript/
http://www.researchware.com/products/hypertranscribe.html
https://www.inqscribe.com
https://www.bartastechnologies.com/products/transcriva/
https://www.transana.com
https://transcribe.wreally.com
https://www.rev.com
https://www.happyscribe.com
http://transcriber-pro.com/en
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Please note: If you import any text document that contains timestamps in one of the formats listed
above, MAXQDA will automatically detect the timestamps and ask you for the associated media file.
What happens during import?

MAXQDA creates a new text document with the transcript.
The associated audio or video file is copied into the folder for external files and assigned to
the transcript.
Text documents with the associated media file can be recognized by their special symbols in
the "Document System": a musical note  for audio files and a video camera  for video
files.

MAXQDA converts the timestamps in the transcript to internal MAXQDA timestamps and removes
them from the text for better readability. The chronology of the timestamps is checked in the text:
tmestamps that refer to an earlier time than those previous to them are removed.

Tip: If you do not assign an audio or video file during import, you can do this later by right-clicking on
the document name and selecting the Link Audio/Video File option.

After importing the transcript and audio or video file, you can immediately see in MAXQDA’s
“Document Browser” that timestamps are displayed in the column left to the text. Clicking in the
area of the timestamps plays the media file at the corresponding position.

Texts that already contain timestamps when imported can, if necessary, be subdivided more
precisely with further timestamps. For more information, see the Transcription section.

Importing transcript in VTT file format

With some video conferencing tools, such as Zoom, Teams, or WebEx, it's possible to automatically
generate meeting transcripts which are saved in VTT file format.

To import a VTT transcript file in MAXQDA, go to the Import tab and select Transcripts > From VTT
files.

Importing transcripts without timestamps

If your transcripts do not contain timestamps, you can import them via Import > Transcripts >
Transcripts without Timestamps. Alternatively, you can simply drag the transcript from Windows
Explorer or Mac Finder to the "Document System".

Focus Group Transcripts
MAXQDA offers a variety of features for the analysis of focus groups and group interviews. In order
to use these features, it is necessary to import multi-speaker transcripts using the focus group
import function. If you are transcribing a focus group interview in MAXQDA, or if you have already
imported a transcript, you can also convert the text into a focus group transcript at a later time.

https://www.maxqda.com/help-mx24/import/external-files
https://www.maxqda.com/help-mx24/transcription-audio-video/transcription-mode
https://www.maxqda.com/help-mx24/focus-group-analysis
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When you import a focus group transcript or convert a text to a focus group transcript, all speech
contributions are coded with the speaker's name, making it easy to differentiate between speakers
in your analysis.

Importing a focus transcript

To import a focus group transcript into a MAXQDA project, select Focus Group Transcripts from the
Import menu tab and select the transcript format from the drop-down menu. Linking the focus group
transcript to an audio or video file and working with timestamps works just like importing a regular
transcript.

Import focus group transcripts

During import, MAXQDA automatically generates a code in the code system for each participant in
the focus group and automatically codes all of a participant’s contributions with their code for later
analysis and differentiation. To ensure that this automatic import process runs smoothly, MAXQDA
places the following requirements on the structure of the transcript:

Each contribution begins in a new paragraph. The name of the participant must appear at the
beginning of the paragraph, followed by a colon. Using bold type or special fonts for the
names will not affect the import process, however upper and lowercase will be taken into
account. Names like “Lisa B.” or “Gábor” with spaces and special characters are not a
problem during import. The following text is coded with the names of the speakers, up to the
point where the next speaker starts.
MAXQDA tolerates accidentally included spaces in front of or after a name and treats the
correspoding names to be identical.
The names of the speakers can be up to 63 characters long.
Sections of text at the beginning of the transcript (without a colon in the first 63 characters)
will not be coded. This allows you to include a title and general information about the focus
group.
Timestamps within the transcript are handled as usual: MAXQDA will ask if you wish to
associate the corresponding audio/video file with the transcript. The timestamps will be
imported into the MAXQDA project and removed from the text.

A transcript following these rules might look like this:

https://www.maxqda.com/help-mx24/import/transcripts-with-timestamps
https://www.maxqda.com/help-mx24/import/transcripts-with-timestamps
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Focus group 1 (Berlin)
Moderator: Hello everyone, thank you very much for your participation! This study examines how
the balance of work and leisure time affects the general feeling of happiness. I have invited you to
this interview because you all have a part-time job in addition to your studies. I would be very
interested in hearing how you are doing in your studies and in your job. First of all, I would like to
ask you why you decided to work while studying. Maybe we can go around the room; if you have
any comments in the meantime, feel free to chime in.
Olga: Well, I started working because I wanted to gain work experience but by now it’s mainly
because I need money.
Fatima: Yes, I didn’t really have a choice either. I have to work alongside university because
otherwise I can't afford to study. I have to support myself financially.
Andy: It’s the same for me. For financial reasons and also to not be dependent on my parents.
Pranav: Yes, for me that’s also the case. I need money to pay rent and to make ends meet. And at
the same time, in my industry you need a certain amount of work experience or let’s say, it’s not
bad to have some work experience when you graduate.
Moderator: Was it also that professional experience… did that also play a role? You mentioned this
already, Pranav- what do the others think?
Andi: Yes, work experience- I think... in any case internships always look good on your CV,
especially in the social sciences, in political science, internships are incredibly important in those
fields, if you can manage to land some, of course.

Select speakers for autocoding

After selecting Focus group Transcripts from the Import menu tab and choosing a file, an import
dialog opens in MAXQDA. This import dialog shows all identified speakers in your transcript and
allows you to select which of the recognized speakers should be coded and with which name.

Speaker selection window

In the import dialog, you can assign a code color to the speakers. You can also combine different
spellings of the same person into one speaker. This can be useful if a name of one participant in the
transcript contains typing errors. In the column “Target”, select the correct name of a speaker if you
identify a misspelled name in the “Speaker” column.
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Speaker display in MAXQDA

During the import, MAXQDA creates a new document in the “Document System” with the filename of
the transcript. This document has its own symbol so you can immediately recognize that it contains
the data of a focus group. Below the document, the speakers are listed individually, with the number
at the end of the line indicating the number of their contributions. The speakers are attached to their
transcripts. When you move the document, the speakers move with it. Only the order of the speakers
can be changed with the mouse.

In the margin next to the transcript text, you can see that each contribution has been coded with the
speaker's name.

MAXQDA view after importing a focus group transcript

In the “Code System” you will see a very similar listing: at the bottom, a code with the name of the
imported focus group will appear, with the speakers listed as subcodes, and the same symbol as in
the “Document System”. Speaker codes and the speakers in the document are connected: if you
change the order of the speakers or their names in the “Code System”, their order will also change in
the “Document System”, and vice versa. This also applies when a focus group transcript is deleted: if
you remove a transcript from the “Document System”, the corresponding code and its subcodes will
be deleted from the “Code System”.

Tip: You can choose to place focus group speaker codes at the top of your code system, in the
“Code System” window settings. To open the settings, click on the gear wheel in the “Code System”
toolbar.

The fact that the speakers are available both in the "Document System" and in the “Code System”
opens up extensive possibilities for the analysis, as the speakers can be activated as independent
codes and as document subsets. For more information, see Analyzing Focus Group Data.

When you import multiple transcripts, a unique code will be assigned to each focus group along with
subcodes for the respective speakers. The speaker codes are attached to their top-level code, and
their order can be modified only under this top-level code.

Tip: The automatic coding function for speakers may be useful for other types of documents in
which multiple individuals interact, for example forum discussions or comments on blog posts.

https://www.maxqda.com/help-mx24/focus-group-analysis/can-maxqda-support-focus-group-analysis
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Converting an already existing text into a focus group transcript

Convert text to focus group transcript

Sometimes you realize that it would have been better to import a text as a focus group transcript
into MAXQDA after you have already imported and coded it as a normal text document. Or you have
transcribed an interview with several participants in MAXQDA and would like to code all of the
speakers and their contributions automatically.

To automatically code the speakers of a single transcript, open the document and from the Import
menu tab select Convert Text to Focus Group Transcript > Convert Displayed Document.

To convert multiple documents at once, activate all documents you want to convert and from the
Import menu tab select Convert Text to Focus Group Transcript > Convert Activated Documents.

The same dialog as for importing focus group documents appears and MAXQDA will insert a copy of
the text as a focus group document:

The speakers contributions will be coded automatically and corresponding codes for each
speaker will be created in the “Code System” window.
MAXQDA will copy all existing coding information and memos into the newly created
document, also the variable values and the summaries.
A linked media file will be linked to the new document, too.
The links in or on the document will not be transferred.

Survey Data from Excel
Importing survey data and other structured data from Excel
spreadsheets

With MAXQDA you can import structured documents from an Excel spreadsheet in XLS/S format,
whereby individual table cells are automatically coded. In addition, variable values can be assigned
to the individual texts (the cases). This feature is particularly useful when importing survey data with
standardized and open-ended questions.

How should the Excel spreadsheet be structured?

When imported into MAXQDA, each row of the spreadsheet becomes a new document, in which the
contents of the cells form the document content and are coded with the respective column headers.
The structure of the Excel table corresponds to the principle of a data matrix with survey results. The
easiest way to understand the logic is with the following schematic example, where the content in
square brackets is for explanation only:
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Document
Group

ID
[Document
Name]

Positive Feedback
[Open Question 1]

Negative
Feedback
[Open Question
2]

Age
[Variable
1]

Pre-knowledge
[Variable 2]

Group A Person 1 Great conference! The catering
was a bit tight

22 high

Group A Person 2 Best keynote I have
heard in a long time

 25 medium

Group B Person 3 I especially enjoyed
the pre-conference
workshop

none 21 medium

Group B Person 4 Great job - keep
going!

Please make
workshops
longer in the
future

31 low

Each row of the table contains a case, and the columns "Open Question 1" and "Open Question 2"
contain the responses to the respective questions. The two "Variable" columns contain additional
standardized information for each case. Of particular importance are the first two columns
"Document Group" and "ID", which allow to assign the individual rows of the table to documents in
MAXQDA’s “Document System”.

Please note:

It is not necessary to have a column for the “Document Group” as MAXQDA can also create a
new document group, into which all documents are imported, during the import process.
However, one column is required containing the documents' names.
MAXQDA supports one sublevel for document groups. These can be created and addressed
during import using the backslash, e.g. "Survey\New York".
The column headings should be short and concise, as this is much more practical for further
work and MAXQDA only imports the first 63 characters of the headings. Only if the column
headings differ in the first 63 characters, MAXQDA will be able to handle the columns as
different.

Starting the import process

To import survey data from an Excel file, go to the Import menu tab and choose Survey data >
Import Data from Excel Spreadsheet. You'll also find the Documents from Excel Spreadsheet
function on the Import tab. Both features will produce the same import result.

Import survey data from Excel files



  70

Selecting import settings

After calling up function, the desired Excel file must be selected from the file dialog box. This opens
a window where you can select settings for the import.

Settings for importing documents from an Excel spreadsheet

The two top settings determine which columns contain the document group and the document
name. If the names "Document Group" and "Document Name" are used in your table as column
headings, MAXQDA will automatically pre-select them, but this choice can be changed at any time.

If you select [Create new document group] from the “Document Group” drop-down menu, MAXQDA
will import all documents into a new document group. MAXQDA automatically selects this option, if
your table doesn’t contain a column with the heading “Document Group”.

Tip: When importing survey data, it is recommended that you select the ID’s of the respondents as a
column for the document names. In this way, you can avoid any ambiguity in the association of
responses to cases, even during the subsequent export of data into statistical software.

In the middle section, you can select the columns to be imported as coded text or as variables.
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If both “Code” and “Variable” are selected, MAXQDA will import the contents of this column as both
as coded text and as a variable. This may be useful, for example, if you want to view standardized
information within the open-ended texts, for example, how old a respondent is and whether he has
children.

Please note: When the dialog box opens, MAXQDA will have marked all the columns in the Excel
table which contain several different contensts as coded text, since these are most likely to be
responses to open questions.

If neither “Code” nor “Variable” are selected, MAXQDA will ignore the column during the import
process.

In the lower section, further options are available:

Code empty cells - When this option is selected, MAXQDA will import and code cells without content
as empty paragraphs; these cells would otherwise not be coded.

You can also decide how MAXQDA should handle documents that were already included in the
project before the import. MAXQDA considers that a document already exists in the project if the
document name and document group are identical.

Import - When this option is selected, existing documents will be included in the import, and
therefore may appear twice in the respective document group.

Ignore for import - Select this option if documents that already exist in the project should not be
taken into account during the import.

Add text to existing documents - It is also possible to add text to existing documents. For example,
data from different points in time in a longitudinal study can be added to the original document.
Existing variable entries in existing documents will be updated. Empty variable values in the Excel
table are ignored when importing.

Please note: For documents whose name appears repeatedly in a document group, the text will be
added to the first document of the same name.

Selecting settings for importing the variables

If you choose to import variables, a second window will open after you click OK.

Source - By selecting this option, you can again decide which variables will be imported.

Target - If there is already a document variable with the same name in the project, MAXQDA assigns
the variable to it automatically and no other choice is available. If there is no variable with the same
name in the project, you can specify the type of variable. Options include Boolean (true/false),
date/time, decimal, integer, and text.

Preview data type - This column displays a preview of how an entry will appear in the appropriate
column in the data editor.

A final report window confirms the import of documents from the table and lists how many texts,
codes, and variables were imported, as well as how many documents may have been ignored during
the import.
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Imported texts in MAXQDA

After importing the data from an Excel spreadsheet into an empty MAXQDA project, it will appear as
follows:

Imported texts in MAXQDA

When importing, MAXQDA proceeds as follows:

Document groups that do not yet exist will be created.
The headings of the code columns will run from left to right and will be inserted from top to
bottom in the code system as new code names, as long as they do not yet exist.
All text segments from the code columns will be coded with the respective column headings.
The complete heading of each column is recorded in the code memo.
If a variable does not yet exist, it will be created. Each document will be assigned the variable
value from the variable column.

In the section "Categorize Survey Data" you will find information on how to analyze the imported
survey data in MAXQDA.

Survey Data from SurveyMonkey
Which import options does MAXQDA offer for SurveyMonkey data?

With MAXQDA you can import survey data directly from SurveyMonkey into an open MAXQDA
project in order to analyze the data with all MAXQDA tools. The use of another software such as
Excel for export and import is no longer required. While importing the data every case of the online
survey becomes a MAXQDA document. You can code the answers of the open-ended questions
automatically with the question text. Additionally, you can transform the standardized information
into document variables.

Please note: In order to use this MAXQDA tool access to your own SurveyMonkey account is

https://www.maxqda.com/help-mx24/21-analyzing-surveys/categorise-survey-data
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required. Not all SurveyMonkey plans allow access to the data by third-party applications like
MAXQDA. Please check the website of SurveyMonkey, if your plan allows to export data (at present
at least an EXTRA plan is necessary).
Starting the import process

To start the data import, proceed as described below:

Select Import > Survey Data > Import Data from Survey Monkey in the main menu.1.
You will be redirected to the login page from SurveyMonkey in your Internet browser. Fill in2.
your login data and click Login.

Login page for SurveyMonkey in the Internet browser

Please note: If it is the first time you connect with SurveyMonkey a window might appear asking for
free access through your firewall. Please confirm that MAXQDA is allowed to contact the Internet.
Otherwise, the import is not possible.
Importing data

After a successful authorization of SurveyMonkey MAXQDA loads an overview of your3.
surveys and displays the dialog below. In this window you can select the survey you want to
import
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This dialog window allows you to select a survey you want to import

Via the selection at the bottom, you can choose whether you want to import every case or a4.
random sample of the cases. After doing that click Continue.
A new dialog window appears. Here you can choose on the top which question shall be5.
applied as document name. In order to guarantee a unified definition of the documents the
case-ID is selected by default. In general, it is advised to keep this selection.
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Tweaking the settings for the import

In the center of the window, you can choose the columns to import as coded text or as a variable. If
you tick both marks MAXQDA imports the content of this column as both, a coded text and a
variable. This can be useful if you want to read the information of the variable directly in the text (e.g.
how old a person is or whether she has kids). By doing that you can avoid receiving this information
only via the tooltip or the data editor of the document variables.

If you don’t place a tick mark on a column MAXQDA ignores this column for the import.

The selection at the bottom allows you to set the option Code empty answers. If you mark this
option, MAXQDA imports and codes cells without content as empty paragraphs. Otherwise, empty
cells would not be coded.

After clicking OK the data will be imported:

A new document group labelled with the name of the survey will be created.
Every imported case in this document group will be imported into an own document.
For each question that had been ticked in the column to import as a “code” a new code will be
created in the “Code System” window
The imported documents contain answers to those questions that are selected automatically
in the column “Code”. The answers are coded automatically with the particular question code.
This gives you the opportunity to get an overview of every answer of a question just by using
the Coding Query functions in MAXQDA.
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Information about the single question survey types

The question types from SurveyMonkey are imported into the MAXQDA project as described in the
following table. You can determine whether an answer will be imported as an automatically coded
answer to an open-ended question or/and as a document variable in the dialog that is shown before
starting the import (see above).

Question type Standard import in MAXQDA

Multiple Choice 1 variable
‘Other’ answer: automatically coded text

Dropdown 1 variable
‘Other’ answer: automatically coded text

Star Rating 1 variable

Matrix/
Rating Scale

1 variable per item
‘Other’ answer: automatically coded text

Matrix of Dropdown Menus 1 variable per answer cell
‘Other’ answer: automatically coded text

Ranking 1 variable per rank

Net Promoter® Score 1 variable

Slider 1 variable

Single Textbox Automatically coded text

Multiple Textboxes Automatically coded text per textbox

Comment Box Automatically coded text

Contact information 1 variable per box

Date/time 1 variable

Survey Data from SPSS
You can import data sets from a survey that are available in an SPSS file into a MAXQDA project.
During the import, a text document with the answers to open-ended questions is created for each
case, while the standardized answers are saved as document variables. SPSS files have the
following structure: the cases form the rows, and the columns contain the variables.

Data matrix in SPSS with survey data
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Start import

To import survey data from an SPSS file, call Import > Survey Data > Import Data from SPSS File
from the menu:

Importing survey data from an SPSS file via the “Import” tab

Set options for import

After calling the function, the SPSS file must be selected in the file dialog. A window will then open in
which you can specify settings for the import.
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Settings for importing survey data from an SPSS file

The upper two settings determine which SPSS variables are to be used as document group and
document name. MAXQDA automatically selects the first column of the data set as the document
name.

Tip: When importing survey data to open-ended questions, it is advisable to choose the IDs of the
respondents as document names, so that the clear assignment of answers to cases is guaranteed
at all times - even when exporting data to statistical software at a later date.

MAXQDA does not automatically select an SPSS variable as "Document group"; instead, the entry
Create new document group is initially selected in the drop-down menu. If you leave this default
setting, all documents will automatically be imported into a new document group created by
MAXQDA. If you select an SPSS variable instead, MAXQDA creates a document group for each value
of this variable and assigns the data sets to the appropriate groups. In the image above, the variable
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v1 with variable label "Group" is selected.

In the middle area of the window, you can select which columns of the dataset should be imported
as coded text and which as variables.

Note: When opening the dialog, MAXQDA has already marked all columns as coded text for import
that have very different values, as these are most likely the answers to open questions.

If the check mark is set for both "Code" and "Variable", MAXQDA imports the contents of this column
as coded text and as a document variable. If neither "Code" nor "Variable" is checked, MAXQDA will
ignore the data matrix column during import.

The options in the lower area are the same as for importing survey data from an Excel file and are
described there in detail. The same applies to the options for the dialog that appears for importing
the variables after clicking OK.

Imported texts in MAXQDA

After importing the SPSS example data shown above into an empty project, the display in MAXQDA
looks something like this (when opening the Data Editor for Document Variables):

Imported survey data

When importing, MAXQDA proceeds as follows:

Each case gets its own text document.
Document groups that do not yet exist are created.
The variable names from the SPSS file including their labels are inserted as new top-level
codes in the code system – if they do not exist. All text segments of the answers to open-
ended questions are coded with the corresponding code. The complete variable label (which
may be longer than the maximum length of code names) is include in the code memo for
each new code.

https://www.maxqda.com/help-mx24/import/survey-data-and-structured-data-from-excel
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The closed questions are imported as document variables. If a document variable does not
yet exist, it will be created. The variable values of each case are assigned to the
corresponding text document.

How are variables handled during import?

When importing answers to closed questions, MAXQDA takes into account the properties of the
imported variables. Depending on the variable type, decimal places, and scale level, MAXQDA
imports the data into different variable types by default. For example, for the nominal variable
“Country”, it would be not helpful if only the numbers “1”, “2”, “3” were imported. Instead, MAXQDA
imports the country names defined as value labels for these numbers in the SPSS file.

Variable in SPSS Variable type in MAXQDA

Numeric, no decimals, scale level „scale Integer

Numeric, decimals, scale level „scale“ Decimal

Numeric, scale level „ordinal“ Text
to preserve the order of the values, the variable labels
are preceded by the respective numerical value, e.g.
1 – low
2 – medium
3 – high

Numeric, scale level „nominal“ Text
the value label is imported, not the value

String Text

Tip: Before importing, check the scale levels of the individual variables and the number of decimal
places set in the SPSS file. This allows you to control how the individual variable values are
transferred to MAXQDA.

Analysis of the imported data

In the section Categorizing Survey Data, you will find instructions for the analysis of imported survey
data in MAXQDA.

YouTube Data
What YouTube data analysis options does MAXQDA offer?

YouTube videos are often commented on by viewers, and sometimes their comments sections even
turn into forums for extensive debates, for instance in the case of videos on political topics. These
comments can be very interesting to researchers working in diverse disciplines in the social
sciences, as well as in market or opinion research.

MAXQDA allows you to import comments posted on a YouTube video into an open MAXQDA project
and have them coded automatically. Additionally, you can import any transcripts or subtitles
provided with the videos, which means you don't have to transcribe them manually.

https://www.maxqda.com/help-mx24/analyzing-surveys/categorise-survey-data
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You can analyze the imported data using MAXQDA's wide range of tools, including thematic coding,
word frequency analysis, and visualization tools. These tools allow you to answer questions
including, but not limited to, the following:

What is the content of the comments posted on the selected videos?
Which words are used most frequently in these comments?
How have viewers rated the selected video?
Which comments are replied to most frequently and which not at all?
How do users communicate with each other?
What is said in a video or in certain scenes?

Importing YouTube data

To import YouTube data into your MAXQDA project, first open the YouTube video in your browser
(e.g., in Chrome, Firefox, or Safari) and copy the complete link from the URL bar to the clipboard.

Copy the complete YoutTube link

Go to Import > YouTube Data in MAXQDA.

You will then see the following dialog box. If you have saved a link for a YouTube video to the
clipboard, MAXQDA automatically enters it in the first field and retrieves the corresponding video
information. If you already have the dialog box open, you can paste a link from the clipboard into the
field at any time and then click the button Retrieve video information.
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Dialog box for importing YoutTube data

In the upper area of the dialog box, MAXQDA will display how many comments and how many
transcripts or subtitles assigned to the video are available to download.

Please note: YouTube does not allow you to download transcripts/subtitles for all videos, even if
subtitles are displayed on the YouTube page of the video.

In the lower area of the dialog box, select whether you want to import the comments and transcript
or just one of the two. The following options are available for importing comments:

Import only top-level comments – If you choose this option, the replies to comments are ignored.

Autocode comments – If you select this option, each comment is automatically coded with a code.
The code indicates how many replies were made to the comment. You should leave this option
activated to give you easy access to the texts of comments later.

To import the transcripts, you can select or deselect all the available languages listed in the dialog
box. The following options are also available:

Include times in transcript – If you select this option, the corresponding times in the video times are
added at the beginning of each line of the transcript. This is useful if you don't need to match the
video to the transcript (in that case the times are displayed as MAXQDA timestamps at the
beginning of each line).
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Link existing video file to transcript – If you have downloaded the YouTube video, you can link it
directly to the transcript. To do this, simply tick this option and select the video file by clicking on the
three dots.

Please note: You can link video files to their transcript at any time later: MAXQDA saves the
corresponding times during import and displays them later as timestamps. To do so, right-click on
the text document of a transcript in the “Document System” and select Link Audio/Video File.

Imported comments in MAXQDA

What happens when you import comments from YouTube?

Comments are compiled in table documents, 1,000 comments at a time, in the "Document
System". These table documents are labeled with a YouTube icon.
These table documents are stored in a document group whose name contains the video title and
the import time. The corresponding document group memo contains more information about the
video, such as the publication date and the number of likes.
A new code named "Autocode <Video Name and Import Time>" is added to the "Code System".
This code contains the subcode "Comment at top level with...", where as many subcodes are
added to the code as there are different frequencies of replies to a comment. All comments are
coded with the code according to their number of replies.
The second subcode is the code "Reply to comment". All replies are coded with this code.

To later display all the comments at the top level in the "Code System" to aid your analysis, you can
do the following:

Activate all the documents containing the comments of one (or more) videos.1.
Activate the code "Comment at top level with..." including all subcodes.2.

The table document with the imported YouTube comments contains the following columns:

Nr. – Consecutive numbering, where the answers to a comment are numbered starting at 1
for easy identification:

0001 = oldest comment
0001-01 = first reply to oldest comment
0002 = second-oldest comment
0002-35 = 35th reply to second-oldest comment

Comment – The comment text
Author – Name of the comment author
Author URL – Link to the author's profile
Top level – Indicates whether the comment is a top level comment (i.e. not a reply). The cell
will either contain the word "yes" or <empty>.
Replies – Number of responses to a top-level comment. Always 0, if it is not a top-level
comment, that is, a reply.
Likes – Number of likes given to the comment
Published – Date the comment was posted
Updated – Date the comment was updated, if applicable

Please note: The YouTube comments import function is limited to the 10,000 most recent
comments per video.
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Imported YouTube transcripts

The transcript text is displayed in the "Document Browser". In the example, a video file has been
assigned to it such that timestamps can be seen in the column next to the paragraphs. Clicking on a
timestamp plays the video at the corresponding position.

Subtitle Data (SRT)
Videos often come accompanied by text files that contain the spoken words of a video combined
with the corresponding playback times such that the texts can be displayed as subtitles to the video.
Very often the SRT format is used for these text files, which can be generated for YouTube videos,
for example, using various software tools.

You can import these text files in SRT format into MAXQDA. Start the import as usual via Import >
Texts, PDFs, Tables or right-click on a folder in the "Document System" and select Import
Document(s). Then select an SRT file in the file dialog box.

MAXQDA imports the file and asks you for the corresponding video file.

Imported SRT data in MAXQDA's “Document Browser“

The timestamps in the SRT file are converted into MAXQDA timestamps. Clicking on a timestamp
plays the video file at the corresponding playback position.

If you have downloaded an SRT file assigned to a YouTube video, this file may have been created
automatically. YouTube identifies parts in these files that were not easily recognized by the
automatic system in a light gray and gray font. This coloring is adopted by MAXQDA during the
import. Please note that such automatically generated transcripts have no punctuation either, that is,
the text does not contain commas, full stops, or other punctuation.

Web Pages
There are several ways in which you can import a web page into MAXQDA:

Using the MAXQDA Web Collector browser extension, you can save single web pages in the1.
Google Chrome browser for import into MAXQDA.
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To import several web pages at once, you can import an Excel list containing links to web2.
pages. This option is also suitable for hundreds of web pages and more.
HTML files can be dragged directly into the MAXQDA project with the mouse, just like text3.
documents.
A web page can be imported via URL directly in MAXQDA.4.

Option 1) Import web pages via Web Collector

With the MAXQDA Web Collector, you can save web pages, parts of web pages, or PDF files in your
browser and then import them into MAXQDA in different formats as a PDF, image, or text.
Additionally, you can directly import web pages in HTML format as MAXQDA text documents.

Saving web pages with the MAXQDA Web Collector

The MAXQDA Web Collector is an extension for the Internet browser "Google Chrome". It allows you
to save entire web pages and import the files as PDF, image, or text documents into MAXQDA.
Among others, this tool is useful to compare websites from various organizations, or to collect
content from web pages for analysis with MAXQDA.

Installing the MAXQDA Web Collector

In order to work with the MAXQDA Web Collector, the installation of the Internet browser "Google
Chrome" is required. As soon as "Chrome" is installed on your computer you can start the installation
of the "MAXQDA Web Collector":

Open "Google Chrome".1.
Search the Chrome Web Store for "MAXQDA" or use the following link:2.
https://chrome.google.com/webstore/detail/web-collector-for-maxqda/jhnochbooihpgjbgcjlp
ihaefoehlakd
In order to add the extension to your browser click „+ Add“.3.
Click the “puzzle piece” icon in Google Chrome and click the pin icon to display the installed4.
Web Collector in the address bar.

Pin Web Collector extension symbol to Google Chrome’s address bar

https://chrome.google.com/webstore/detail/web-collector-for-maxqda/jhnochbooihpgjbgcjlpihaefoehlakd
https://chrome.google.com/webstore/detail/web-collector-for-maxqda/jhnochbooihpgjbgcjlpihaefoehlakd
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After a successful installation you can see a tiny MAXQDA icon on the top-right in your browser
window:

MAXQDA icon to open the MAXQDA Web Collector in „Google Chrome“

If you want to use the Web Collector, just click on the MAXQDA icon:

MAXQDA Web Collector

The Web Collector offers four modes:

Entire web page: the layout is preserved in the best possible way.
Simplified web page: the web page will be reduced to key text and images as in using a read
mode.
Selections on web pages: only the selected part of the web page is collected.
PDF documents: all PDF files currently open in Chrome are collected.

Collecting entire web pages

If your research is based on the analysis of every visible item of the web page it is recommended to
save the entire web page in order to import it to your MAXQDA project as true to the original as
possible:

Open the web page you want to save in Google Chrome.1.
When the web page is fully loaded, open the Web Collector by clicking the tiny MAXQDA icon.2.
Make sure the tab "Web Page" is open.3.
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If required, change the proposed document name. This name will later be inherited into the4.
MAXQDA project.
If required, enter a text memo in the “Document Memo” box. This text will later be connected5.
to the imported document as a document memo.
Click Collect.6.

The MAXQDA Web Collector saves the web page in the default download folder of your browser. The
web page is saved in MWEB format, which was especially developed for further processing in
MAXQDA.

A web page saved this way can be imported into MAXQDA as a PDF or image document.

Collecting simplified web pages

In case your analysis focuses on the text of a web page you can save it as a "simplified" web page.
The web page will be reduced to main text and images, which can be compared to the read mode of
your smartphone. This is particularly useful for big newspapers and magazines. In order to import a
“simplified” web page, proceed as described below:

Open the web page you want to save in Google Chrome.1.
When the web page is fully loaded open the Web Collector by clicking the tiny MAXQDA icon.2.
Click on the "Simplified Web Page" tab. The web page will then be reduced to its main parts.3.
If required, adjust further options such as font type, font size, and exclusion of images.4.
If required, change the proposed document name. This name will later be inherited into the5.
MAXQDA project.
If required, enter a text memo in the “Document Memo” box. This text will later be connected6.
to the imported document as a document memo.
Click Collect.7.

The MAXQDA Web Collector saves the web page in the default download folder of your browser. The
web page is saved in MWEB format, which was especially developed for a further processing in
MAXQDA.

Please note: Some web pages cannot be simplified for technical reasons. In this case, a message
appears in the Web Collector window.
Collecting parts of a web page

In case you are only interested in a certain part of a web page you can download only the current
selection:

Select the segment you are interested in with your mouse.1.
Right-click the highlighted segment and choose Collect Selection for MAXQDA.2.

The MAXQDA Web Collector saves the selected content in the default download folder of your
browser. The selection is saved in MWEB format which was especially developed for a further
processing in MAXQDA.

Segments that have been saved this way can be imported into MAXQDA as a text or PDF document.
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Collecting PDF documents

To import PDF documents currently opened in Chrome follow these steps:

Open the Web Collector by clicking on the MAXQDA icon.1.
If required, change the proposed document name. This name will later be inherited into the2.
MAXQDA project.
If required, enter a text memo in the “Document Memo” box. This text will later be connected3.
to the imported document as a document memo.
Click Collect.4.

Importing collected web pages into MAXQDA

You can import a collected web page into your MAXQDA project by following these steps:

Open the MAXQDA project into which you want to import the saved web pages.1.
Mark a document group in the "Document System" window by clicking on it in order to import2.
the web page in a selected document group (if no document group is marked, MAXQDA will
import the web pages into a new group).
Select Import > Web Pages > Web Pages from Web Collector Data in the main menu.3.

Import Web Collector data from the Import tab

The following dialog window will appear:

Dialog window for the import of documents that have been saved with the Web Collector



  89

If you open the dialog for the first time MAXQDA selects the standard folder for downloads1.
and displays it at the top of the box. Every collected web page located in this folder will be
listed in the dialog. By clicking the three dots … you can choose any other folder to import
collected web pages from the MAXQDA Web Collector.
Select every web page you want to import with the mouse. Selected pages will be highlighted2.
green. By default, all listed web pages are selected).

Tip: Double click a row to open the downloaded file in the Internet browser. This allows you to check
individual web pages for their content.

Import options are provided at the bottom of the dialog:3.
you can select whether web pages should be imported as PDF or image documents
you can select whether simplified web pages or selections should be imported as PDF
or text documents.
The option Import new data only can be used to import only data that does not yet
exist in the open MAXQDA project. If checked, MAXQDA compares the collect date, the
document name, and the document type (text, PDF, image).

In order to start the import, click Import selected files. The time for import can vary depending on
the scope and format of the selected document. A progress bar informs you about the import
progress of each document.

In case you selected PDF or image format and you want to import large files, MAXQDA asks you
whether you want to import them as externally saved files instead of saving them in the project (see
External Files for more details).

Please note: The main layout will be adopted in the import process. Deviations from the web page’s
original layout might occur, especially as far as complex web pages are concerned.

Option 2) Bulk import of multiple web pages via Excel file containing
links

If you have a collection of links, you can compile them in an Excel spreadsheet. MAXQDA reads the
links from the Excel spreadsheet and imports the web pages as simplified web pages, PDF
documents or images. This way, you can also import a hundred web pages and more at once.

Structure of the Excel table

The Excel table must contain the links to the web pages in one column. The other columns can
contain information about each web page, which MAXQDA will import as document variables and
into the document memo. The order of the columns determines in which order the data is imported.

For example, a table for the import looks like this:

URL Language Note

https://www.maxqda.com EN Information in English

https://www.maxqda.com/maxdays EN Information about the conference

https://www.maxqda.com/de DE Information in German

https://www.maxqda.com/help-mx24/import/external-files
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Importing the Excel file

To start the import, select Import > Web Pages > Web Pages via Links from Excel File. After
selecting an Excel file in the file dialog, the following option dialog appears:

Dialog for importing multiple web pages via Excel list

Make the following settings in the dialog:

At the very top, select which column contains the links to the web pages. If you have named
this column as “URL”, MAXQDA will detect it automatically.
In the center, select which information should be included in the document memo and which
should be included as a document variable. You can also check both options to include the
information both as a document variable and in the document memo.
At the bottom, you select how the web pages should be imported. The options correspond to
those of importing web pages via Web Collector:
Text (simplified web page) – By using this setting, only the main text is taken from the web
page (without images). This option works like a reading mode that you can turn on for
optimized reading of web pages on your cell phone and is recommended for several reasons:
you can focus on the main content of a web page and most pop-up banners like cookie
requests are ignored. The setting is especially suitable for news sites.
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PDF – The web page is converted to a PDF, with most of the layout preserved. If you select
this option, you can specify below that the PDFs should be saved in the external files folder
rather than in the project. You can try importing with the Switch off JavaScript option turned
on to ignore annoying pop-up banners. However, this will result in some web pages not being
displayed at all or not being displayed correctly.
Image – The web page will be converted to an image, keeping most of the layout. It is also
possible to disable JavaScript for this import type.

After clicking OK, another dialog appears in which you can specify the variable types.

MAXQDA creates a new document group for the imported web pages and uses the title of the web
page as the document name.

In the memo of the document group a report is stored, which also lists all web pages, which could
not be imported, because the web page was not accessible or because another error occurred
during import.

Option 3) Direct import of web pages in HTML format

You can also import an HTML file directly into MAXQDA. To do this, select Import > Texts,1.
PDFs, Tables from the main menu. In the dialog box that appears, select the HTML file.
Alternatively, you can drag and drop a HTML file into the "Document System" window with the
mouse.
MAXQDA imports the file as a text document and includes images if they were embedded in2.
the HTML file.

Please note: If you use the direct import of web pages in HTML format they are imported as text
documents (and not as web pages). The layout can change a lot during the import, which is why
using the Web Collector for this task is clearly preferable. Direct HTML import is particularly suitable
for simply structured and designed data.

Option 4) Direct import of a web page via URL

Web pages can be imported directly in MAXQDA via Import > Web pages > Web Pages via URL by
simply inserting the link to a web page. In the import dialog, you can choose to import the web page
as text, PDF, or image.
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Dialog for importing a web page via URL

Bibliographic Data (Endnote, Zotero etc.)
How Does MAXQDA Support Working with Bibliographical Data?

MAXQDA allows you to import bibliographic data from reference management programs such as
Endnote, Mendeley, Citavi, and Zotero in order to conduct literature reviews or to review the state of
the literature. Such programs are mainly used in the scientific field for literature work, that is, they
are primarily used for the management of literature references and the creation of reference lists
and they support the creation of scientific texts. Similar to MAXQDA, the literature management
programs work with projects, which are containers for all collected bibliographic information. The
units of the projects consist of literature references (author, title, etc.), often paired with their full-
texts in PDF format.

MAXQDA is can import bibliographic data from all reference managers that are able to export their
databases in RIS format, which is a standard format for bibliographic information. With the following
programs it is also possible to import the assigned full texts into MAXQDA in addition to the
literature references:

Endnote
Mendeley
Zotero
Citavi

When imported into MAXQDA, each biblographic record turns into a seperate text document. When
full-texts are imported, MAXQDA automatically links the full text to the record using an internal link.
The individual information in the bibliographic record is automatically coded for later analysis so
that, for example, all titles or abstracts can be compiled and searched. Attachments can be
automatically coded during the import with the keywords assigned to them, and notes for a record
can be saved as a document memo to the corresponding attachment.
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Literature import

Remarks on the RIS format

RIS is the short form for "Research Information System Format". RIS files are simple text files in
which all exported literature entries are listed one after the other. RIS files contain so called " tags ",
which consist of two letters and are followed by the corresponding information. Important tags
include for example:

TY – Type of reference, always marks the beginning of a new entry

ID – Unique identification number for each entry

AU – Author

TI – Title

PY – Publication date

ER – Closes entry, always located at end of entry

A detailed description of all RIS format tags can be found on Wikipedia under
http://en.wikipedia.org/wiki/RIS_(file_format). An example of RIS source data is listed below:

TY - BOOK

AU - McLuhan, Marshall

AU - Fiore, Quentin

TI - The medium is the message

PY - 1967

CY - New York

PB - Bantam Books

ER -

http://en.wikipedia.org/wiki/RIS_(file_format)
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Exporting literature data from Citavi, Endnote, Mendeley, or Zotero

Before importing literature data into MAXQDA, you must export the desired data from your refarence
management program in RIS format.

Export from Citavi

Select the literature entries you want to export.1.
Select File > Export > Export... from the main menu.2.
Choose RIS as the export filter. If this option is not displayed, click on Add export filter.3.

Export options Citavi

Click Next.4.
Click Search..., enter a name and select a directory.5.
Click Next and again click Next.6.

Export from Endnote

Select the literature entries you want to export.1.
Select File > Export... from the main menu.2.
Enter a file name and select a directory.3.
Set the file type to "Text Only" and the output style to "RefMan (RIS) Export" as shown in the4.
following picture. If this output style is not available, open the selection list and select "Select
Another Style..." at the top, where you can search for the output style.

Export from Mendeley

Select the literature entries you want to export.1.
Select File > Export... from the main menu.2.
Enter a file name and select a directory.3.
As shown in the following picture, set the file type to "Text File (*.txt)" and the output style to4.
"RefMan (RIS) Export". If this output style is not available, open the selection list and select
"Select Another Style..." at the top, where you can search for the output style.
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Export options Endnote

Export from Zotero

Right-click on a collection and choose Export Collection... Alternatively, choose File > Export1.
Library... from the main menu to export the entire library.
In the appearing dialog select "RIS" as the format.2.
If you want to export the notes and the associated files (especially the full texts), make sure3.
to check the corresponding boxes for Export Notes and Export Files.
After clicking OK, assign a file name and select a directory.4.
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Export options Zotero

Starting the Import in MAXQDA

After you have exported the desired data, select Import > Reference Manager Data > Import from
Citavi/Endnote/Mendeley/Zotero in MAXQDA. The following dialog appears:
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Import literature from Endnote

Click Select File... to select the exported file in RIS format. This file has either the extension RIS
(Citavi/Mendeley / Zotero) or TXT (Endnote).

MAXQDA analyzes the file and shows you various options for importing it. First you can choose if
you want to import the references as well as the attachments (full texts) or only one of them.

Tip: MAXQDA checks by author, year, title, and publication type which bibliographical references and
which attachments already exist in the project file and indicates in brackets how much new data is
added by the import. MAXQDA only imports new entries so that no duplicates are created.

For the import of attachments, the following options are available:

Only PDF files - Select this option to ignore all other file formats such as Word documents when
importing appendices.

Autocode keywords - By setting this option, a small area with all keywords contained in the literature
reference is coded at the beginning of each attachment. This makes it easy to select full texts based
on the keywords assigned to them. Please note that the keywords contained in a literature reference
do not necessarily have to match the keywords actually assigned in the text by the authors.

Add notes as document memos - If this option is enabled, all notes for a literature reference are
added as document memos in the "Document System". The tag N1 of the RIS format is evaluated for
the notes.

Store attachments in folder for external files - If this option is disabled, all PDF and image files will
be copied to the MAXQDA project file. This is usually recommended if there are only a few or small
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attachments. If this option is enabled, PDF and image files will be saved in the External Files folder,
so the project file itself will remain very small. For more information, see: Externally stored files.

If you want to import attachments from Endnote, you have to click on Select file... at the bottom of
the dialog to tell MAXQDA where the Endnote library from which you exported the data is located in
your file system. This is necessary for MAXQDA to know where the attachments are located. The
Endnote library has the file extension ENL.

By clicking OK the import process is started.

Import bibliographic data from other programs

If you neither use Citavi, Endnote, Mendeley nor Zotero, you can still import a RIS file with
bibliographic information. Export all desired references from your program in RIS format.

Tip: You can also export search results in RIS format from an online journal or catalogue, for
example to analyse how the thematic focus of a journal's titles has changed over the years.

Switch to the tab Import in MAXQDA and select the entry Reference Manager Data > Import
Bibliographic Data from RIS File. A short explanation window will appear and then a selection dialog
which lists only files with the endings RIS or TXT. Select the exported file and confirm your selection
with OK.

Please note: When using this import option, no attachments (full texts) are imported.

What happens during the import?

A document group "REFERENCES" is created in the "Document System".
All literature entries are added to the newly created document group as individual text
documents. The entries are sorted alphabetically and marked with their own symbols.
The document name consists of the surnames and first names of the authors as well as the
year. In the case of two authors these are linked with "&", in the case of three or more authors
only the first author is mentioned and "et al." is added. In case of multiple publication of the
same author(s) “a”, “b”, “c”, etc. is added to the year.
In the "Code System" a code "REFERENCES" with the two subcodes "RIS" and "KEYWORDS" is
generated. The code "RIS" contains all RIS tags used in the import file as subcodes, e.g. "Type
of reference" or "Abstract". The code "KEYWORDS" contains all keywords assigned in the
literature references as subcodes.
When importing, all references are automatically coded by coding each text section with the
corresponding RIS code.
Each keyword in the literature reference is coded with the corresponding keyword in the code
system.
DOI links are inserted into the text as hyperlinks, so that you can access the online version of
a publication directly if required.

If attachments are imported, the following will also happen:

A document group "REFERENCES > ATTACHMENTS" is created in the "Document System".
All attachments are imported into this document group as separate documents.
The documents retain their file names and are sorted in alphabetical ascending order of their
references. The sorting of the document names is therefore not necessarily alphabetical and

https://www.maxqda.com/help-mx24/import/external-files
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the same document names may occur several times, e.g. if there are several documents with
"Table of Contents".

And if references and attachments are imported:

Internal links are additionally created, which link the literature reference with the
corresponding attachments, so that you can jump back and forth between literature reference
and full text with a single click. In the literature reference, the internal link can be found in the
"Link to PDF (L1)" section (the name comes from the RIS format and also applies if it is a file
format other than PDF). In the attachment, the internal link is placed at the beginning of the
document.

Adopting selected information as variables

The following variables are automatically assigned to each newly created document when importing
literature data, including attachments if imported.

RIS_Type (Type of reference) – Text variable
RIS_Author (First author) – Text variable
RIS_Title (Title) – Text variable
RIS_Reference-ID (Identification number of the entry in the literature database, is only
exported by a few programs, e.g. Endnote) – Integer
RIS_Year (Year of publication) – Integer

The variables are created as system variables and cannot be changed by the user.

Literature document variables
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Analyzing literature data in MAXQDA

After the import and the automatic pre-coding, the bibliographic data and the corresponding full
texts are available in MAXQDA like normal documents. This means that they can be searched,
coded, linked and assigned memos and are available for further analysis. Of course, the Visual Tools
and all other functions such as the graphics and statistics functions can also be used. By importing
the variable values, for example, only documents of a certain type can be selected for analyses, such
as journal articles or anthology articles, or only publications from a certain year.

Some initial ideas for the analysis:

Right-click on a keyword in the code system and select the function Activate Documents
Containing this Code. MAXQDA will then activate all literature entries and attachments to
which this keyword has been assigned.
Activate code "RIS > Abstract". Via the Codes menu tab, start the Smart Coding Tool and
restrict view to activated codes only to code and systematize the abstracts.
Activate the document group "REFERENCES" and activate the code "RIS > Title" to list all titles
in the "Retrieved Segments" window. Click on the Word Cloud icon to start an analysis of the
(most common) words in the title.

If you would like to learn more about conducting literature reviews with MAXQDA, we recommend
that you watch the video recordings on YouTube, particularly those from the MAXQDA Online User
Conferences MAXDAYS.

Exporting bibliographic data in RIS format

Bibliographic data from a MAXQDA project can be exported in RIS format for import into a reference
management program, for example. The export function can be found in the Reports tab. Click on
the Export icon and select the Bibliographic Data as RIS File entry from the menu.

After you have specified a saving directory, all documents of the project that contain literature
references (indicated with a book symbol) are exported to a RIS file with UTF-8 encoding.

Structured Documents (Preprocessor)
What are structured texts?

Often you may wish to import documents that are structured and pre-coded. Examples for this kind
of document include:

Forms: Here you would like to code each section with its respective heading for the field in
the form.
Questionnaires filled in by the respondents in a structured text file: Here you may wish to
code the answers with their respective questions or instructions.
Asynchronous online discussions: that you have retrieved with online tools and already
tagged.

The problem is similar in each case: before the actual analysis has begun certain text sections have

https://www.youtube.com/results?search_query=maxqda+literature+reviews
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already been allotted to specific form fields or similar. And you would like to save yourself the effort
of manually coding each. To solve this problem, MAXQDA has the preprocessor that allows you to
split a text file into several text documents during its import and to code labeled text areas with one
or more codes.

Import structured data with the preprocessor

The preprocessor lets you enter a large number of documents into a single file and have them
separated out into different documents when imported into MAXQDA. The syntax rules are as
follows:

#TEXT textname this is the content of the 1st text...
#TEXTtextname this is the content of the 2nd text...
#TEXT textname...

Every document must start with the “#TEXT” and “TEXT” must be written in capital letters.

The name that you want to give to the document should come immediately after the “#TEXT”
without a space in between. If you do not enter a name, MAXQDA will automatically assign one when
the document is imported. The first imported document will be called “Document nn,” and the
following documents will be named in sequential order in the “Document System.”

Document names are handled by MAXQDA as follows. You can enter any kind of string (up to 63
characters) as a document name – spaces are also allowed. If you enter a document name with
more than 63 characters, MAXQDA will truncate it automatically. Once the document has been
imported into MAXQDA, you can change the name to include up to 64 characters.

Example

In the example project, various interviewees were asked about their level of satisfaction with various
aspects of their life. Their answers were transcribed and entered into a Word document.

The resulting Word file appears as follows:

#TEXT 1(26,m,kk,led)
I've gained too much weight over the last several years and I don't seem to be doing anything to
get rid of it. I have high cholesterol levels, but I don't attempt to change my eating habits. I'd like to
jolt myself into becoming more physically active, so I can lose the weight and feel more energetic.
I keep saying I'm going to do something about it, soon.
#TEXT 2(34,w,2k,ver)
Overall I am pretty happy with my mental, social and physical health. I would like to improve my
dedication to working out. I am the type of person who will work out 5 times a week for a month
straight and then is slowly turns into less days a week until it is none. I get distracted by school
work, my job or just being tired.

After each #TEXT entry is the name being given to the document. For the purposes of this project, it
made sense to assign a number for each of the interviewees in addition to some basic information
about that person, including age, gender, number of kids, and marriage status.

The Word file was then saved with the name “HealthSatisfaction” in RTF or DOC/X format. It could
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then be imported by going to the Import tab and selecting Structured Text.

Tip: MAXQDA automatically creates a new document group in the „Document System“ during import
and inserts all texts into this document group.

All texts will appear in the “Document System” after being successfully imported. The documents
are named as previously specified followed by #TEXT as an identifying agent. In the above example,
the document name consists only of a text number and the personal data indicated in parentheses.

Pre-coding text segments during import

The document is then imported, separating out each individual document and assigning the given
name for each in the “Document System” from the original RTF document.

In this way, it is possible to very quickly import and separate out many different documents formerly
contained in a single file. The Preprocessor is able to do significantly more than this simple action,
however. In many cases, you will already be able to code aspects of the document, and the
Preprocessor can do that automatically during the import. To do so, you simply need to use
additional syntax words.

For each section of the document that is to be coded, you simply need to type “#CODE” before and
“#ENDCODE” after. In the case of a standardized survey or questionnaire, you could, for example,
code each answer with the question number that it connects to. The answer to the first question,
then, could be coded with the code “Question1” as is shown below.

#TEXTinterviewee1
#CODEquestion1
answer to question 1
#ENDCODE
#CODEquestion2
answer to question 2
#ENDCODE
 
#TEXTinterviewee 2
#CODEquestion1
answer to question 1
#ENDCODE
#CODEquestion2
answer to question 2
#ENDCODE
…

Important: It is important to remember that “CODE” is written in capital letters.

To avoid typos when entering “CODEquestion1,” it is possible to simply use a place holder, such as
“§1” for the first question, “§2” for the second, etc. You can then later do an automatic search and
replace, finding all instances of “§” and automatically replacing it with “CODEquestion.” This can
save you a lot of time in addition to helping you avoid typos.

It is also possible to define and code with a subcode in a document prepared for the Preprocessor.
To do so, use the following syntax:
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#CODE Codename\Subcodename

You are giving the complete information about the subcode, including its name and the code it is a
subcode of. The code and subcode are separated by a “\” symbol, but no spaces. As with any codes
used in a document imported with the Preprocessor, MAXQDA will first check whether the code
already exists, and if it does not, it will be created.

Important: As soon as “#CODE” appears in the text, the new code will be used, automatically ending
the coded segment of the previous code.

Text excerpts, as well as full paragraphs, can be pre-coded with the help of the preprocessor during
import, as shown by the following example:

#TEXTtextname
Here is a text. Encoding begins here with #CODECode 1Subcode#. In the next sentence it ends
with #ENDCODE# in the middle
#CODECode 2
Here is another text. The encoding ends here #ENDCODE# in the middle of the text.…

For a preliminary encoding of keywords from various text excerpts, the following rules apply:

When the keywords #CODE or #ENDCODE appear alone in a row, it is not necessary to insert
# at the end. If these keywords appear within a text, or at the end of a line of text, they must
be enclosed with #.
It is not possible to “layer” encodings. When a new #CODE# command comes before an
#ENDCODE# command, the previous code is automatically closed.

Tip: To assign several codes to a text part you can combine the codes with two “&&” characters, e.g.
#CODEFirst code&&Second code&&Third code
Mark participants of a focus group

If you use the tag #SPEAKER inside a text section, MAXQDA will import the text as a focus group
transcript and will code the text after the tag with a speaker code. The tag #ENDSPEAKER closes the
speaker coding. The tag may be inserted within a sentence, but then a # has to be added after the
name of the speaker.

#TEXTFocus group 1
 
#SPEAKERModerator
A warmly welcome to our session …
#ENDSPEAKER
 
#SPEAKERParticipant 1
#CODETheme 1
I have the following opinion
#ENDCODE
#ENDSPEAKER

This function is very interesting for exporting data that have been collected online with the tool
http://www.kernwert.com.

http://www.kernwert.com
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03 – View and Edit Data

View Documents
To open a document in MAXQDA, you can:

double-click on the document in the “Document System”, or
right-click on the document in the “Document System” and choose Open Document.

The document appears highlighted in bold in the "Document Browser" window and is displayed in the
"Document Browser", where you can analyze the document, for example, by coding text passages
and image sections, attaching memos, or linking parts of the data. The "Document Browser" has the
following structure:

“Document Browser“ window setup

Window title shows the name of the open project and on the right, there are some icons for
controlling the display, for printing, and for exporting.
The coding bar is located directly underneath it, with which you can code the document.
Coded segments in the document are visualized in the gray side area with so-called “coding
stripes”.
In the memo column, attached notes to the data are visualized and accessible.
As shown in the example, texts have a column with consecutive paragraph numbers for each
paragraph that is not empty. You can use these numbers as sources for citing the analyzed
data.
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Opening and viewing multiple documents windows

In MAXQDA’s “Document Browser” you can only open and edit one document. But you can open two
or more documents simultaneously, each in in a separate free-flow window. This is helpful for
conducting literature reviews: open the PDF of a publication in one window and code it thematically;
open and code a text document with notes on the publication in another window.

To open a document in its own window, right-click on the document in the “Document System” and
select the option Open Document in a New Window.

Please note: It is not possible to open the same document in multiple windows.

Opening documents in tabs

Opening documents in tabs allows to switch quickly back and forth between documents. Documents
can be opened in tabs by holding the Shift ⇧ key and double-clicking on the document or by right-
clicking on the document and selecting Open Document in a New Tab.

Tip: To open all documents in a document group in tabs, drag the document group into the
“Document Browser” with the left mouse button, then release.

In the local preferences of the "Document System" window, you can specify that documents are
opened in a new tab by default. To open the preferences, click on the cogwheel icon in the upper
right corner of the Document's window toolbar and select the option Open documents in tabs.

Edit Text Documents and Tables
Text documents and tables can’t be modified after you open them in the ”Document Browser”, to
prevent unintentional changes to the document during your analysis. However, you can activate the
Edit Mode at any time, which allows you to adapt the text, for example, to correct a typo or error. Edit
Mode is also needed when writing a new text in MAXQDA.

To turn on Edit Mode:

Click on the Edit Mode icon in the ”Document Browser” toolbar as in the image below.
Or use the shortcuts Ctrl+E (Windows) or ⌘+⌥+E (macOS).

Turn Edit Mode on/off

For text documents, the usual text formatting functions such as font size and size are available in
Edit Mode. A separate formatting toolbar will appear below the coding toolbar.

For table documents, only the content can be customized, but not the appearance of the text.
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Please note: It is not possible to edit contents of a PDF, an image, an audio file or a video file within
MAXQDA.

Saving text edits

The changes made in Edit Mode are transferred to the MAXQDA project file when the Edit Mode is
closed. The modified text is saved every 5 minutes as you go. You can change this time interval in
the general preferences of MAXQDA.

Undoing text changes

You can undo changes made in Edit Mode - this works in the same way as in Word. For example, if
you delete or reinsert a text passage, you can undo all these steps. You can do this either by right-
clicking the context menu in the "Document Browser" and selecting the Undo Text Changes option.
Alternatively, you can click on the symbol in the toolbar: 

With the Undo All Text Changes option, you can undo all the changes made since you last opened
Edit Mode with one click.

Please note: Deleting a text deletes all code assignments that are completely within the deleted text.
These assignments cannot be restored by the undo function.

Spellchecking

You can check for spelling errors within editable text documents and memos. MAXQDA offers spell
checking in English (UK), English (US), German, and Spanish.

Activate and deactivate spellchecking

To turn on the spellcheck function for a text document, click the Spellcheck on/off icon in the
"Document Browser" as shown in the image below. Click the icon again to deactivate the function.
To turn on the spellcheck function in a memo click the same icon in the "Memo Editor" toolbar or the
"Memo Manager" toolbar.

The spell-checking language can be changed directly in the "Document Browser" Preferences menu
as well as in the General Preferences.

Activate/Deactivate the Spellcheck function

Correct Errors

When Spellcheck is activated, MAXQDA underlines all words that are not found in the default
dictionary for the selected language or in your custom dictionary. Right-click on an underlined word

https://www.maxqda.com/help-mx24/the-workspace/general-preferences
https://www.maxqda.com/help-mx24/screens-and-menus/general-preferences
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to view the spellcheck options. You can decide to:

Click on a suggestion in the upper part of the dialog window to replace the word with this
suggestion.
Click on a suggestion in the lower part of the dialog window to replace all occurrences of the
word in the open document or memo with this suggestion.
Click Add to Dictionary to add this word to your personal dictionary. In future MAXQDA will
then no longer recognize the word as a mistake in any project or document.
Click Ignore to ignore the spelling of the word once.

Edit Custom Dictionary

The user-defined dictionary that contains the list of words you have added to your personal
dictionary can be edited at any time to add or remove any words from the dictionary. The file is
named "(language)_UserDictionary.txt" and can be opened and edited with any text formatting tool.

On a Windows computer, you can find the user-defined dictionary this way: Press the
Windows key and R. Enter this: %appdata%\MAXQDA24
On a Mac computer, you can find the user-defined dictionary here:
Users/(USERNAME)/Library/Preferences/MAXQDA24

Line Numbers in Text Documents
By default, when importing a text into MAXQDA, all paragraphs are sequentially numbered so that
you can use them to cite the analyzed data. This is sufficient in most cases for the accuracy of the
citation. However, sometimes it is desirable to use line numbering instead of paragraph numbering
for the citation.

Therefore, MAXQDA allows you to switch back and forth between paragraph and line numbering:
right-click in the text and select Convert to Line Numbered Text.
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Option for converting paragraph numbered text to line numbered text

In the following dialog box, the desired width of the text can be set in characters, e.g. 80 characters:

Set max. line length

The result is a line-numbered text with a fixed maximum number of characters per line:
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Text with line numbers

You can switch back to a paragraph numbered text at all times. To do this, right-click in the text and
select Convert to Paragraph Numbered Text.

Please note: MAXQDA uses soft returns (Shift+Return) for line numbering. When switching back to
paragraph numbering, these are replaced by regular paragraphs (Returns). If a text contains soft
returns before the conversion to line numbering, the paragraph numbering can be different than
before the line numbering. MAXQDA informs you before converting to line numbering if a text
contains soft line breaks.

Assign a Color to a Document
You have the option of assigning a color to each of your documents. This color is then used in all
tables and visualizations, including in MAXMaps. For example, you can use color attributes to
indicate the processing status of a document or to make other features, such as the interviewer or
the location, visible. Color attributes are also useful for organizing the assignment of documents to
team members.

To assign a color, right-click on the document and select Color from the context menu that appears.
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Choose a color in the context menu

Click on one of the standard colors and it will be displayed on the document symbol. Click on the
icons to the right of the color circles to select your own colors.
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The Document Properties Window
If you right-click on a document in the “Document System” or "Data Editor for Document Variables"
and select Properties, the following window will appear, which lets you view and change certain
settings for that document.

In the window, you can, for example, link a media file to your document or create externals links to
files that are accessible from your computer, and set a text or table document to "read-only" so the
text will no longer be editable.

https://www.maxqda.com/help-mx24/import/inserting-audio-and-video-files-in-a-maxqda-project
https://www.maxqda.com/help-mx24/links/external-links
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Document properties window
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04 – Codes

About Codes and the Code System
About codes

One of the central functions of MAXQDA is the process of coding data material. Coding is a crucial
analytical activity in various qualitative research approaches, involving the assignment of selected
segments of a document to new or existing codes. Coding is part of numerous analytical methods,
such as qualitative content analysis, thematic analysis, grounded theory, and many others, including
ethnography.

So, what exactly is meant by a “code”? A code represents a single word or a combination of words
used for attributing meaning, systematizing, classifying, and interpreting the data material. The
specific nature and significance of a code depend on the analytical objectives, the data material, and
the chosen analytical approach. In very simple approaches, one could use "keyword" or "label" as a
synonmy for "code," but this falls short for many methodological approaches, because in qualitative
research, codes often go beyond mere labels and instead represent profound reflections and
theoretical insights developed with the data.

About the “Code System” window

Codes can be organized in a hierarchical structure, that is, each code can have several subcodes
and also the subcodes can have subcodes. All of your codes are shown in the “Code System”
window.
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The hierarchical "Code System" window

MAXQDA’s “Code System” has the following characteristics:

A code is a text with a maximum of 127 characters consisting of one or more words. A code
can contain empty spaces and special characters.
The number of codes is unlimited.
The hierarchical structure can contain up to ten levels.
Codes can be assigned a color.

There may be some special codes in the “Code System” window:

Color codes are like text markers and change the background color of the marked text. You
can recognize them by their highlighter icons.
For so-called “emoticodes”, an emoji symbol appears in the “Code System” in the place of the
code symbol. Emoticodes do not have a name when first used, this can be added if needed.
In the section “Focus Group Speakers”, all codes appear that are used to assign the
contributions of a speaker. These codes can be identified by this their speaker icon.
The code “Paraphrased Segments” is applied automatically to all data segments for which
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you have written a paraphrase.

You can click on the triangle symbol before the code to reveal or hide its subcodes.

Tip: With the function Collapse all Subcodes, which is accessible by right-click on the the top-level
item of the “Code System”, you can collapse all codes so only the top level codes will be visible.

Using MAXMaps you can build a network structure of codes to be used during the coding process,
meaning you can code selected segments within a document and code them by dragging them onto
a code in the network map.

The “Code System” toolbar

The following frequently-used functions for codes can be selected in the toolbar at the top of the
"Code System" window:

The toolbar at the top of the “Code System” window provides quick access to important functions in
this window, among others:

Reset activations – resets current code activations.

Only activated codes – displays only activated codes.

Display codes in activated documents only – reduces the code system to codes assigned in at
least one of the currently activated documents.

New code – adds a new code to the code system on the currently focused level.

Click on the gear symbol in the “Code System” to open the local settings dialog. All available options
are described here.

Export the Code System

You can export your code system at any time. There are two locations in the menu to start the
export:

Codes > Export Code System
Reports > Exports > Code System

Alternatively, you can right-click on the top entry in the “Code System” window and select Export
Code System from the context menu.

A variety of export formats are available, for example, the code system can be exported as a Word
file or as an image file.

Tip: When exporting as an image file, the entire code system, considering the current status of
collapsed and expanded codes, is exported.

https://www.maxqda.com/help-mx24/maxmaps
https://www.maxqda.com/help-mx24/the-workspace/the-code-system
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Create a New Code
The word “Code System” at the top of the list represents the root of your system of codes (or
hierarchical "Code Tree"). You can gradually build up a system of categories from this point.

In order to add a new code to the code system, click on the green plus sign that appears when you
move the mouse over a line of the code system:

Creating a new subcode using the green plus sign at the parent code

The following dialog box for code definition will appear:
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Dialog to enter a new code

Type the name of the new code into the text field in the upper part of the window (MAXQDA allows a
length of 127 characters for a code name).
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You can select a color attribute for the new code below. If you select the option Use as default color
for new codes, all newly created codes in the project will use this chosen color. Of course, you can
change this default color each time you create a new code using this dialog. If a check mark is
placed in the option Use color of parent code when defining subcodes, the color of the upper code is
assigned to this newly defined subcode.

In the text field Code memo, you can add an explanation or description to the new code. After
closing the dialog, you can recognize the symbol for a code memo next to the newly defined code.

Click OK to create the new code and close the window. If you click on Add Code instead, the window
remains open, and you can define further codes at the top level.

Newly added subcodes with memo symbol

More options to create a code

To create a code, you can also right-click a code and select New Code from the context menu. Or
you can create a new code using the Alt+N (Windows) or ⌘+⌥+N keyboard shortcut (macOS) or the
New code ion in the toolbar. Note, however, that the focus highlight in the code system must be on
the item for which you want to create a subcode.

Add new subcodes at the bottom

Newly defined codes are always inserted at the top of the "Code System" window. This applies to all
levels of the hierarchy. If you prefer to insert subcodes below existing subcodes instead, the option
Insert new subcodes at the bottom can be selected in the local settings for the "Code System". To
access the local setting, click on the gear icon in the "Code System" toolbar.
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Settings for the “Code System” window

Edit Code Properties
Changing a code's color

A color attribute can be assigned to each code or subcode. To do this, right-click on a code and click
on one of the default colors in the context menu. The icons on the right-hand side of the context
menu allow you to define your own colors and list the colors already used in the project.
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Select a code color in the context menu

Tip: If you change the color of a parent code, MAXQDA asks if you want to apply the color to all the
subcodes as well.

In the “Document Browser” the coding stripes are displayed in the corresponding code color. This
makes it easy to identify which segments are assigned to a code.
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Coding stripes of various colors in the “Document System”

The color attribute is also displayed in all MAXQDA tables that contain codes, e.g., in the “Overview
of Coded Segments” table that is available for each document group and each document. There, the
color attribute may be used as a criterion for sorting the table. This is done by clicking on the column
header of the column containing the colored icons. Unless you have changed the order of the table’s
columns, this column will be the first one in the table.

Color attributes in the "Overview of Coded Segments" window

The color attribute plays an important role in all visual tools of MAXQDA. For instance, the Document



  122

Portrait is based completely on the colors of the codes that are assigned to a particular document.
Thus, the selection of colors is an important step: colors should be assigned according to the kind of
analysis that you plan to conduct. For instance, a psychologist could assign red colors to aggressive
statements and green colors to friendly statements. When analyzing documents in regard to the
topics mentioned a meaningful association of topics and codes is recommended. Thus, you are able
to identify topics and combinations of topics with one glance. When working with focus groups, you
should associate the speakers with the different colors, in order to quickly find out when a person is
speaking.

The Code Properties window

You can right-click on the name of any code and choose Properties in the drop-down menu in order
to open the Properties window:

Code properties window

In this Properties window, you can…

Change the name of the code (max. 127 characters available),
Assign or adjust a Code Alias (max. 255 characters),
Modify the code color,
Assign a keyboard shortcut.

Since the number of characters for a code is limited to 127, longer code designations can be
assigned as code aliases. For example, they may be exported instead of the code names when using
the Smart Publisher.

Adding a code alias

Code names in MAXQDA can be 127 characters in length. However, it is sometimes desirable to
note a shorter or longer description in addition to the code name. This allows you to employ an
automatically generated report with selected coded segments, for example, in Smart Publisher.

To create a code alias for a code, right-click on the code in the code system and select Properties.
This will open a window where you can enter a code alias, among other options.

https://www.maxqda.com/help-mx24/reports/smart-publisher
https://www.maxqda.com/help-mx24/reports/smart-publisher
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Alternatively, you can click Code Alias Table in the Codes menu tab, which will generate a table in
which you can conveniently enter multiple code aliases, and view for which codes an alias has
already been assigned.

Code alias table

Edit the Code System
Moving codes

Changing the structure of the category system is not difficult. All codes can be moved with the
mouse and the drag-and-drop function.

In the following example, the “Code System” contains four codes (A, B, C and D).

Moving codes with the mouse

To move Code D to the top of the list, you would need to do the following: click on Code D and drag it
above Code A while holding down the left mouse button, then, when a line appears, drop the code.

It is also easy to make a code a subcode of another code. If you want Code B to become a subcode
of Code A, for example, you would carry out the following actions: click on Code B, drag it to Code A,
and release as soon as Code A has a colored background. Code B is then added as a subcode of
Code A.
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Move multiple codes

You can select multiple separate codes while holding down the Alt (Windows) or option ⌥ key (mac
OS) and then move your selection while holding down the mouse button. To select a range of codes,
first click on a code and then click on a second code while holding down the Shift key ⇧. This will
then also select all codes between the clicked codes.

Sorting subcodes

Subcodes can be sorted in ascending and descending order by name and by frequency, by right-
clicking the parent code and selecting Subcodes... > Sort... from the context menu.

Dividing a code into subcodes

Often when working with a code system, it is desirable to differentiate between elements grouped
under one code. In MAXQDA this corresponds to dividing a code into two or more subcodes. For
example, imagine you have created a code named “Family” and have assigned document segments,
in which an interviewee talks about his family, to this code. Then imagine that it becomes necessary
to differentiate between “Mother”, “Father”, and “Siblings”.

This differentiation of a category does not work automatically, but requires that each segment
previously coded under "Family" is re-read by the researchers and assigned to one of the three new
subcategories. This can be done particularly conveniently in the Smart Coding Tool, which was
specifically designed for this purpose.

Alternatively, codes can be divided as follows:

Activate all documents and the code “Family.”1.
Create three subcodes for “Family”: “Mother,” “Father,” and “Siblings.” Only the code to be2.
differentiated, in this case "Family", should still be activated, but not the three new
subcategories, in order to be able to carry out the reassignment conveniently.

https://www.maxqda.com/help-mx24/05-coding/smart-coding-tool
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Splitting up a code

Start with the first segment in the "Retrieved Segments" window and decide to which of the3.
three subcodes this segment is to be assigned.
Click on the coding stripe to the left of the segment and move it to the selected subcode4.
while holding down the left mouse button. During this process, the segment is moved to the
selected subcode, i.e. the coding with the parent code is deleted immediately.

Tip: If you hold down the Ctrl key (Windows) or the command ⌘ key (macOS) during this operation,
the encoding is copied from the source code to the target code and remains in the parent code.

This is how you can work with all segments, so you continue in the same manner for the second.
When you get to the end of the list, all segments will have been re-classified - they have been
assigned to one of the three codes in question.

Alternatively, you can click on the document name below a segment in the "Retrieved Segments"
window in step 4 to display the segment in the "Document Browser". There you can code as usual,
i.e. by clicking and dragging with the mouse and assigning the desired subcode. With this procedure,
however, the old codings in the upper code are still retained, i.e. all segments still have the
assignments to the code "Family".

However, this is normally not the intention - the old encodings of the parent code must be removed.
You can double-click on the parent code to list its encodings in the "Overview of Coded Segments",
select all encodings and then remove them by clicking on the delete symbol in the toolbar.

Merging Codes

It is often necessary to combine two or more codes that capture something similar in the data
material into a single code.

Merging two codes with the mouse

For two codes, this can be done very easily via drag and drop: click on the code you want to merge
with another code and drag it to the highlighted word "Merge" that appears to the right of the target
code and release the mouse cursor on that word.

Merging codes using the mouse

As soon as you release the mouse button on the word “Merge”, MAXQDA moves all coded segments
of the source code into the target code and deletes the source code. In the example, the 4 coded
segments of Code D are added to the 5 segments already existing in Code C. The Code D is then
deleted.

To indicate that the segments of another code were inserted into a code by fusion, a plus sign in
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brackets “(+)” is added after the target’s code name. This plus sign is used only as an identifier and
can be removed at any time by renaming the code.

Please note: If you merge a code that has subcodes with another code, the subcodes are attached
to the target code. It is not possible to merge a parent code with one of its subcodes.
Merging multiple codes using the context menu

You can also merge several codes at once at any time:

To select all codes you want to merge, hold down the Alt (Windows) or the option ⌥ key1.
(macOS) and click on each code with the mouse button.
After that, right-click on the code into which all other codes are to be merged.2.
Select Merge Codes from the context menu that appears.3.

Merging codes using the drop-down menu

Code memo behavior during mergers

If the box Insert merging history in code memos in the “Code System” preferences is checked and a
code is merged into another code, an audit trail with the merge date and information is added to the
code memo. If no memo exists yet, a new one is created.

In MAXQDA, each code can have only one code memo, so the question arises what happens with the
code memos of the codes that are being merged:

If only one of the merged codes has a memo, it is attached to the remaining target code.
If several codes have a memo, MAXQDA asks whether the memo texts should be combined
at the target code or whether the memos should be converted into free memos. Free memos
are not directly assigned to any element in MAXQDA and can be displayed e.g. via the Memos
tab.

Copying subcodes

In some cases, you will be setting up the same subcodes for various codes. You might, for example,
have the codes “Childhood,” “Teenage Years,” and “Adult Life,” which should each have the
subcodes “Education,” “Family,” “Friends,” and “Memorable Experiences.” So that you don’t have to
create these four subcodes three times, you have the option of setting them up for one of the main
codes, copying its subcodes, and pasting them into the other main codes. To do so, you would
follow these steps:

Right-click on the code and select Subcodes... > Copy from the context menu.1.
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Click on any other code and select Subcodes... > Paste from the context menu.2.

MAXQDA then adds the copied sub-codes in the same order as the original code. The newly inserted
sub-codes keep the Color previously assigned to them.

Delete Codes
Deleting a code from the “Code System” is somewhat like cutting off a branch from a tree. By
deleting that code, you are also deleting any subcodes, which are like smaller branches attached to
the bigger one you cut off. At the same time, all coded segments that had been created with those
codes are deleted.

The easiest way to delete codes is to go directly to the "Code System": click on the red X that
appears as soon as you move the mouse over the line of the code to be deleted.

Delete code using the delete icon in the “Code System”

You can also right-click on the code to be deleted and select Delete Code or Delete Code Incl.
Subcodes from the context menu. Alternatively, you can also select a code with the left mouse
button and then press the Del key (Windows) or the Delete key (macOS).

Deleting several codes at once

Highlight several codes in the code tree by clicking on them while holding down the Alt key1.
(Windows) and the option ⌥ key (macOS). To highlight a range of codes, click on the first
code, hold the shift ⇧ key, and click on the last code.
Then right-click on one of the highlighted codes and choose Delete Codes from the context2.
menu.

Alternatively, you can switch to the table view of the “Code System” window:

To do so, click on the gear wheel icon in the “Code System” toolbar to open the local1.
preferences, select option Table view, and click OK.
Use Ctrl key (Windows) and ⌘ key (macOS) to select single codes. Use shift ⇧ key to select a2.
range of codes.
Then right-click on one of the highlighted codes and choose Delete Codes from the context3.
menu.

Codes can also be deleted in this manner in the “Overview of Codes”, accessible via the Codes menu
tab or the context menu in the “Document System”.
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Create Code Sets
With MAXQDA it is possible to store temporary combinations of codes as code sets. This allows you
to group the same codes in different ways or to make frequently used codes available for coding.
The code sets only contain references to existing codes, so removing a code from a set has no
further consequences.

To create a new code set, right-click on the word Set in the "Code System", then select New Set.

Create a new code set

After you enter a name for the set, you can drag and drop the desired codes into the new set with the
mouse. The codes can also be moved within the set or to another set using the mouse.

Tip: If you activate codes before creating a new code set, MAXQDA places the activated codes
directly into the new code set.

The Overview of Codes
It might be of interest to take a look at how many times each code was assigned to individual,
multiple, or all documents. Alternatively to the visual display of the Code Matrix Browser you can
also open the Overview of Codes, which you can find in several places in the program:

In the Reports tab,
In the context menu at the root of the “Document System”,
In the context menu of a document group or document set, or
In the context menu of an individual document.

A table view of all of the codes that occur in the relevant documents will appear. The table may
contain more or fewer lines depending on the place in the program from which it was called up. In

https://www.maxqda.com/help-mx24/visual-tools/code-matrix-browser-visualizing-codes-per-document
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the title of the overview, you can see which documents the overview applies to and to how many
(different) codes in the document a segment is assigned.

Please note: When the Overview of Codes is opened in the Reports tab, codes with no coded
segments are displayed as well. Otherwise, only codes with at least one coded segment in the
relevant document will be displayed.

Among others, the table consists of these columns:

Code – The name of the code that appears in the “Code System”
Parent code – Contains the parent code for easy identification of a code. If the “Parent code”
column is empty, the code in this row belongs to the top level of the code system.
Cod. seg. (all documents) – The number of segments in the analyzed documents that have
been coded with a particular code or subcode.
Cod. seg. (activated documents) – Takes only activated documents into account. If this
column displays all zeros, then presumably because no documents are activated. Once you
activate documents, you can directly observe how the values in this column change.
% Cod. seg. (all documents) – The percentage of segments that have been coded with the
particular code or subcode, in relation to the total number of coded segments in column “Cod.
seg. (all documents)”. The sum of the column is 100%.
% Cod. seg. (activated documents) – As in the “% Cod. seg. (all documents)” column but
takes only activated documents into account.
Documents – Number of documents in which the code or subcode appears.
Code alias – Alternative name for a code with up to 255 characters, that e.g., may be
exported in the Smart Publisher report instead of the code name itself.

Right-clicking a row opens a context menu with various options, you can open the overview tables of
Coded Segments or Linked Memos, for example. You can also change the color attribute of a code
from this menu.

A toolbar is displayed at the top of the window from which the following special functions can be
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accessed:

Aggregate on 1st level – Only the codes at the top level of the code system will be displayed. Here,
the code frequencies of the subcodes are added, as well as the number of documents in which the
code occurs.

Statistics – Displays the values of the columns “Cod. seg. (all documents)” and “Cod. seg. (activated
documents)” as a frequency table or chart. For more information, see Frequency Tables and Charts
for Subcodes

Transfer the "Code System" to Other
Project
It is possible to export an entire "Code System" and import it into another MAXQDA project file. This
function is especially useful as it allows you to build a “Code System” in one project, then apply it to
another. In this case, importing and exporting the “Code System” eliminates the need to enter new
codes.

To export your "Code System", go to the Codes menu and select Export Code System > MAXQDA
Format.

The “Code System” will be converted into a specific file format with the extension MTR24. You can
then import the “Code System” into a new MAXQDA 24 project with the corresponding procedure
Import Code System.

Please note: MAXQDA can also export and import the cross-software QDC format (REFI QDA
Codebook). You can select this format in the drop-down menu when clicking on Export Code System
in the Codes menu tab.

Import Codes and Code Memos from
Excel
MAXQDA can create a code system from the rows in an Excel spreadsheet. This is useful when you
want to define multiple codes in advance.

The first row of the table must include the keywords Code and Memo. Each additional row
corresponds to a new code and associated memo. In the Code column, you can define subcodes
using the character “>” or using a backslash "\".

Tip: To insert a backslash "\" on a Mac, press ⌥+⇧+7.

To start the import, select the function Import Codes and Memos from Excel Spreadsheet from the
Codes menu tab.

https://www.maxqda.com/help-mx24/statistics-and-graphics-functions/frequency-tables-charts-subcodes
https://www.maxqda.com/help-mx24/statistics-and-graphics-functions/frequency-tables-charts-subcodes


  131

Example

Code Memo

Code 1 Here is a text, e.g., with the code definition

Code 1 > Subcode 1.1 Here is a text, e.g., with the code definition

Code 2 > Subcode 2.1 > Subcode 2.1.1 Here is a text, e.g., with the code definition

When importing a table, MAXQDA proceeds as follows:

Unless they already exist in the MAXQDA project, new codes are created. In the example, five1.
codes are created: "Code 1" and "Code 2" are created at the top level. "Code 1" is assigned the
subcode "Subcode 1.1" and "Code 2" is assigned the subcode "Subcode 2.1", which in turn is
assigned the subcode "Subcode 2.1.1".
In addition, each newly inserted code is assigned the corresponding text from the second2.
column as a code memo.
Code names and subcode names are each shortened to 127 characters.3.

Imported Codes and Memos
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05 – Coding

How to code
Assigning codes to text, image or video segments in MAXQDA is known as “coding”.

You can code a document or document segment with any desired number of codes. The technical
limit for the number of coded segments per document is so high that it usually has no practical
significance. Moreover, coded segments can overlap, intersect, or be completely contained within
other coded segments.

Coding a segment with drag and drop

Coding in MAXQDA follows this simple principle: the segment to be coded is marked and dropped
onto a code with the mouse.

Coding via drag and drop

Alternatively, you can also do the reverse, that is, drag your desired code to the selected segment
and then release the mouse button.

Please note: MAXQDA makes sure that the same code is not assigned to the same segment
multiple times. Segments assigned with the same code will therefore never overlap.

Notes on specific types of documents

Coding texts and image segments in a PDF

You can select text segments in a PDF as usual by highlighting them with the mouse.
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Highlighted text in a PDF

If you want to select an image in a PDF, for example, because you want to analyze a scanned PDF
whose text cannot be converted into a “selectable” text using OCR (character recognition), you can
use the mouse to draw a frame. To do this, you only have to start the selection process in an area
that does not contain any selectable characters. You can adjust the selected area later by clicking
the corners and dragging them to a suitable size.

Highlighted image segment in a PDF

Selecting segments of images

In image files, you can drag a frame with the pressed mouse button in the same way as in PDF
documents. The edges of the frame can be adjusted later by clicking and dragging the corners.
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Selecting texts in tables

To select a text in a table, double-click the cell. As soon as the cell shows an orange frame, you can
select text in this cell with the mouse. You cannot select multiple cells at the same time.

Selecting segments of videos

Videos are analyzed and coded in a separate window, the "Multimedia Browser". In the Code Videos
section, you'll find detailed explanations for how to code videos.

Display of Coded Segments in the
"Document Browser"
As soon as you have coded a document or image segment, a vertical stripe appears in the column at
the left side of the “Document Browser”. Those visualizations are called "coding stripes" or "coding
brackets" and they show where the document has been coded.

As default setting the coding stripes appear on the left side of the document. This setting may be
changed easily. To do this, open the local preferences by clicking on the gear icon in the toolbar of
the "Document Browser" and select the option Display coding stripes on the right.

The coding stripe column can be resized by clicking on the vertical line between the coding stripe
column and the document and by dragging the separator to the right or left.

Visualization of coding stripes on the left side of the “Document Browser” window

https://www.maxqda.com/help-mx24/analyzing-videos/code-videos
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You can also choose whether code names should be permanently shown in the coding stripe
column or not. By clicking on the gray gear icon at the top of the coding stripe column, you can open
a window with various options. One of those options is to Display code names.

You will always be able to see the code name in the tooltip that appears if you hover your mouse
over the “coding stripe”. The tooltip also shows the assigned weight, the creator of the coded
segment, the date that the segment was coded, and the last time it was edited.

Tooltip appearing from the coding stripe

The tooltip always displays the complete code name, with all its possibly existing "parent codes".
The permanent display next to the coding stripe is limited to the lowest code level. In the example
above the whole code name shown in the tooltip is “INTERVIEW CODES/Dissatisfaction/Dissatisfied
with time spent working”. In the coding stripe column it is shown as “..Dissatisfied with time spent
working”. The two preceding dots indicate that the code is a subcode.

If there are many coded segments, that overlap each other, it may at first sight be difficult to see
which coding stripe belongs to which code name. In this case just hover your mouse over a coding
stripe. The color of the coding stripe will turn paler, and the corresponding code name will be
underlined.

Coding stripe column visualization options

By clicking on the three dots in the coding stripe column (or with a right-click anywhere into the
column) you can open a window with various visualization options for coded segments.
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Option window for the visualization of coding stripes

Here you can adjust the following settings:

Only activated codes - You can choose to only display activated codes.
Only user - You can choose to only display coded segments created by a certain user.
Colors - You can choose to only display coded segments of certain colors.
Display coded segments in code color - You can choose to use the code color as background
color of coded text segments in text and PDF documents.
Display frames around coded image segments - You can choose whether frames around
coded image sections should be shown permanently.
Display code names - You can choose to display or hide code names.
Display author and date in tooltip - You can choose whether the tooltips that appears when
hovering over a code name or coding stripe with the mouse should include the information
about the author and date of creation.
Display emoticodes - Display or hide emoticodes.

The option to color the text according to code colors only makes sense if you do not have many
overlapping codes. Overlapping codes cause the color of the text to be a mix of those overlapping
codes, which can make it very difficult to interpret.

Listing codes assigned to a segment

Often, it's useful to determine which codes are assigned to a specific text or image excerpt. To do
this, select a text segment or image section, right-click on it and select List Assigned Codes in the
context menu. This will display a menu in which all assigned codes are listed. Click on an entry in the
list to highlight the code in the “Code System” window.
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List of assigned codes for a segment

Display of Coded Segments in the "Code
System"
Information on how many coded segments are assigned to a specific code can be found in the
“Code System” next to each code:

Information on the number of coded segments

When you collapse the subcodes of a code by clicking on the triangle symbol to the left of the code,
the code frequencies of the subcodes are added to the frequencies of the parent code. In this case,
MAXQDA displays how many segments have been coded with a collapsed code including all its
subcodes. If you prefer seeing only the frequencies of the parent codes (regardless of whether the
code is collapsed or not) you may change the setting by deactivating the option Sum up frequencies
of subcodes in the preferences window of the "Code System".
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Options for displaying the frequencies in the "Code System".

You may set the preferences of the "Code System" by clicking on the gear icon on the toolbar of this
window.

Code system preferences

The topmost option Display frequency allows you to define which frequencies MAXQDA should
show in the "Code System". You may choose between the following options, each of which offers a
different analytical information:

Selected option Analytical relevance

Coded segments in all
documents

How often was a code assigned in all documents?
This is the default option as described above, which is always
used automatically when opening a project.

Coded segments in all
activated documents

How often has a code been assigned in the currently activated
documents?
The numbers are automatically updated when you activate or
deactivate documents.
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Coded segments in opened
document

How often has a code been assigned in the document currently
opened in the "Document Browser"?
Coded segments in audio and video files are not taken into
account here.

Document groups In how many document groups does a code occur?
It does not matter whether a code was assigned once or several
times in a document group.

Document sets In how many document sets does a code occur?
It does not matter whether a code was assigned once or several
times in a document set.

Documents In how many documents does a code occur?
It does not matter whether a code was assigned once or several
times in a document.

 

Further Ways of Coding
Beyond the classic coding technique of drag and drop, MAXQDA offers several other ways to code a
selected segment:

Coding with newly defined codes: A new code is created and directly assigned to the
higlighted segment.
In vivo coding: Select and highlight meaningful terms in a text and automatically add them as
codes in your code system while coding the text segment with the code.
Coding with selected codes from the Quick List: Documents are worked through regarding on
the occurrence of one or more pre-selected codes, and segments coded where applicable.
Simultaneous coding with multiple codes: A segment is coded with the activated codes.
Coding with Code Favorites: Selected codes are displayed in a separate window from which
they can be easily applied to segments to be coded.
Coding with self-defined keyboard shortcuts: Up to nine codes can be assigned a keyboard
shortcut, which can be used to quickly code a highlighted segment.
Coding with MAXMaps: Highlighted segments are dragged onto selected codes, which are
arranged on a concept map, e.g. on a surface.
Coding with the Open Coding Mode: After selecting a segment, a window for creating and
assigning a new (open) code appears automatically.
Color coding: This works like highlighting a text passage in a book with a colored text marker.
In MAXQDA, five different colors can be used for color coding: red, green, yellow, blue, and
magenta.
Coding with symbols and emoticons: Selected segments are coded with emoticodes, that is
an emoticon or a symbol.
Coding in the "Retrieved Segments" window and "Overview of Coded Segments": Coded text
passages can be compiled in a list. In these compiled segments you can then select and code
further text passages. For more information, see the section.

This chapter describes in detail how the first listed techniques are used. Some of the options can be

https://www.maxqda.com/help-mx24/coding/open-coding-mode
https://www.maxqda.com/help-mx24/coding/highlight-coding-color-coding
https://www.maxqda.com/help-mx24/coding/emoticode-coding-emoticons-symbols
https://www.maxqda.com/help-mx24/segment-retrieval/coding-retrieved-segments
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chosen from the context menu that pops up when you right click on a selected segment in the
"Document Browser" window.

Context menu with coding functions for a selected segment.

1. Coding with newly defined codes

An easy way to create and apply a new code in one go is to use the shortcut Alt+W (Windows) or
cmd+W (macOS). Alternatively, right click on the selected segment and choose With New Code or
click the Code with a new code icon in the "Document Browser" toolbar.

Coding toolbar in the “Document Browser“ window

A dialog window opens, in which you can type in the name of the new code. The code will be added
to the “Code System” at the highest level of the hierarchy. If necessary, you can move the code to
another level of the “Code System” later using drag and drop.

Tip: You can also define several new codes and assign them to the same selected segment. To do
this, click the Additional code button in the dialog box instead of just clicking OK.

2. In vivo coding

Another way of coding is the so-called "in vivo coding". If you, for example, select the word “global
village” in your document and then click on the Code in vivo symbol in the toolbar of the “Document
Browser”, the word “global village” is added to the “Code System” as the code for this short text
segment. The shortcut Alt+I (Windows) or ⌘+I (macOS) has the same effect.

If you want to code a whole segment of text with the in vivo coding function, we recommend this
procedure: As the name of the new code will automatically be taken from the selected text passage,
code one or two meaningful words with this function first. Next, select the entire text segment
(including the word) and drag it to the newly created code in the “Code System“ window. MAXQDA
expands the coded segment automatically.

3. Code with selected code in the Quick List

The coding toolbar in the "Document Browser" as shown in the screenshot above provides quick
access to frequently used coding functions. Whenever you click on a code in the "Code System", or
when coding is in progress, the corresponding code appears at the top of the Quick List. Click on the
symbol Code highlighted segment  directly to the right of the Quick List to assign the code shown
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in the list to the selected segment. This way, multiple segments of a document can be coded
without having to select the code each time.

Tip: You can also use the keyboard shortcut Alt+L (Windows) or ⌘+L (macOS) to code a segment
with the last code you have used.

4. Coding with multiple codes simultaneously

As a first step, activate the codes you wish to assign simultaneously in the “Code System”. To
activate a code, you can right-click on the code in the “Code System“ and select Activate. Then
select a segment to be coded, right-click on it and choose With Activated Codes in the section Code.

5. Coding with Code Favorites

If you are working with a large “Code System”, it can be difficult to work efficiently, since you need to
scroll up and down to find the appropriate code. One solution could be to use the "Quick list" to get
access to a certain code quickly, but this option does only work for one code at once. If you need to
have quick access to several codes at a time, you may define "Code favorites":

Right-click on a code and select Add Code To...> Code Favorites. After you have added the first
code, the code favorites window will appear. You can then continue adding more codes to the list
repeating this step.

Tip: You can also drag and drop codes from the “Code System” window into the open “Code
favorites” window.

The Code Favorites window

You can now begin to code your documents. Simply highlight the segment as usual and click on the
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code in the Code Favorites window. In the coding column on the left side of the “Document
Browser”, you can see that the segments have been coded.

Tip: You can also drag and drop a highlighted segment on a code in the code favorites window or
vice versa drag and drop a code onto a highlighted segment.

When you are finished using the Code Favorite window, simply close it. To re-open the window, you
can either add another code (via the context menu) or select Code Favorites from the Codes section
of the main menu.

You may rearrange the sequence of the codes within the code favorites list with drag and drop. If
you wish to move more than one code at once, just press the ctrl key (Windows) or ⌘ key (macOS)
while selecting the codes. Selected codes may be removed from the code favorites list with a click
on the x appearing next to the code name while hovering over it with the mouse.

6. Coding with keyboard shortcuts

For quick coding using your keyboard, you can assign keyboard shortcuts for up to nine codes. To
do so, select the feature Keyboard Shortcuts for Codes in the Codes tab of the main menu:

The Keyboard Shortcuts for Codes window

In the left column, you can see the available keyboard shortcuts Ctrl + 1 to Ctrl + 9 (Windows) or ⌘ +
1 to ⌘ + 9 (macOS). You can drag and drop a code from the “Code System“ window into one of the
nine rows, to assign a keyboard shortcut to the code. If a shortcut has already been assigned, it will
be overwritten by this action. For clarity, the name of the code appears in the right column, along
with the parent code if necessary – not the entire code hierarchy.

To cancel the assignment of a shortcut to a code, click on the appropriate row and click the Remove
shortcut button.

For coding, it may be helpful to leave the keyboard shortcuts window open until you have memorized
the shortcuts. It does not matter if the window is open or not when coding: simply highlight a
segment in the “Document Browser“ and hit the selected shortcut keys. MAXQDA will then code the
selected segment with the associated code.

Tip: When you right-click on a code and select Properties, a window will open in which you can
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assign the code directly to one of the nine available keyboard shortcuts.

Creating shortcuts via the Properties menu of a code

7. Coding with MAXMaps

The “Code System” is organized in a hierarchical tree structure, which does not allow for multiple
cross-relationships between subcodes. In some cases, it may be necessary to create a non-
hierarchical structure to form network relationships and organize codes in a different structure.

This is possible with MAXMaps, the mapping tool that is part of MAXQDA. Open MAXMaps in the
Visual Tools tab to start the tool and create a new map. Use drag and drop or Alt+double-click
(Windows) or option+double-click (macOS) to copy codes from your code system to the map.
Codes can be freely arranged on the map, linked to each other with arrows or lines, and free symbols
or images can be added to the map.

Coding is simple: drag a selected segment from the “Document Browser” to a code in the map.
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Coding with codes in a map

Open Coding Mode
Particularly in research projects that are applying a grounded theory approach, many so-called "open
codes" are created: in a first step, a text is reviewed line by line, and identified aspects are recorded
in numerous new codes. For this case of application the mode "Open Coding" is particularly suitable.
It allows to immediately create a new code for a marked segment, to assign it and if necessary to
write a code memo as well as a comment for the created coded segment.

Activating the Open Coding Mode

Click the Open Coding Mode icon in the coding toolbar of the “Document Browser”.

Open Coding Mode in the 'Document Browser'

Please note: The mode automatically turns off when opening a new document. The mode is not
available for table documents.
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Using the Open Coding mode

Using the Open Coding Mode is easy: as soon as the mouse key is released after selecting a text
segment, the following dialog window appears:

Example for using the open coding mode

The dialog is, in principle, very similar to the dialog for creating new codes:

You can type the name of the new code in the upper dialog field (max. 127 characters) and
select a color attribute for it below.
The text written in the dialog field "Code memo" is used as a memo for the newly created
code (which can be assessed by clicking on the memo icon in the "Code System").
The "Comment on the coded segment" can contain up to 511 characters (about 4 short
sentences) and is directly assigned to the coded segment.

Tip: You can expand and collapse the areas for the code memo and the comment on the coded
segment by clicking on the arrows. You can increase the size of the input fields by dragging one of
the window corners.

Color Coding (Highlighting)
Color coding text is a technique that is especially useful at the beginning of the analysis process. It
is similar to the marking of text in a book with a highlighter. It allows you to color code the passages
you find particularly interesting when reading through the text for the first time. Before you decide
which codes to use and before you start analyzing your text in categories, this technique lets you
keep track of what seems important. You can find five color coding highlighters in the coding toolbar
of the “Document browser”.
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The five available highlighter colors in the "Document Browser" toolbar

To color code a segment of text, select the text with your mouse and click on one of the five colors
in the toolbar. The text segment will now be highlighted in that color and color coded accordingly. A
new coding stripe will be visible in the coding column next to the document.

A section of text coded with "BLUE"

As the section of text is coded with the color code, you can later get a compilation of all text
passages, marked with that color. Retrieving all codes with a specific color coding can be done by
activating all documents in the “Document System” and activating the appropriate color code in the
“Code System”. You can then assign these passages to more specific codes.

If you delete a code from a segment in the “Document browser”, the specific segment will be
removed from the code and the text will not be highlighted any longer. If you completely delete a
color code from the “Code System”, all coded segments are deleted and none of your texts will be
highlighted with that color any longer.

Color codes are displayed with a specific symbol in the "Code System":

Symbol for a color code in the "Code System"

Tip: You can change the name of a color code in the "Code System" at any time, for example, to
"Good quote" or "Attention: needs to be anonymized".

Emoticode: Coding with Emojis and
Symbols
The “Emoticode” function allows you to assign symbols and Emojis to text and image segments, as
well as audio and video clips. It can generally be employed with the same functionality as “normal
coding:” All the functions of conventional coding are supported, meaning Emojis and icons will be
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displayed in the overview tables of coded segments and in visualizations such as the Document
Portrait.

Emojis and symbols

You can access the full Unicode emoticode library of your operating system with more than 3000
symbols in MAXQDA. This means that you can use the same symbols you know and love from
sending messages on your smartphone to code your data in MAXQDA.

Opening the Emoticode window

In order to code using emoticodes, you must first open the emoticode window. You can do so by
clicking the corresponding symbol in the coding toolbar in the "Document Browser".

Emoticode function in the 'Document Browser' toolbar

After being called up, the window containing the collection of Emojis appears and can be moved
anywhere on the screen.

The emoticode window

If more symbols are included in a thematic section than can be displayed in the window, you can
scroll through all symbols in the section using the scrollbar on the right side of the window.

When you click on the clock icon, MAXQDA displays the most recently used symbols and Emojis. In
addition, you can add frequently used symbols to favorites. To do so, right-click the symbol and
select Add to favorites. The symbol is then shown additionally in the 2nd tab from the left, marked
with a star. Symbols can be removed from the favorites list using the same method.
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Coding with Emojis

Coding segments with Emojis is just like color coding or coding with the toolbar. The segment is
selected in the “Document Browser” or “Multimedia Browser,” then you can subsequently click on
the desired symbol or emoticon in the emoticode window. If the Emoji has already been used in the
existing “Code System,” the reverse is also possible – meaning the selected segment can be
dragged into the code, or the code into the segment.

Emoticode display in the “Document Browser”

In the "Document Browser" the selected Emoji appears in the middle of the coding stripe in place of
the normal code icon. By default all new emoticodes get the color blue, the color can be changed as
usual in the "Code System" and is then also used for the coding stripe in the "Document Browser".

Coding stripe with emoticode in the “Document Browser”

In the options window for the displayed coding stripes, you can hide or show coding stripes with
emoticodes in the “Document Browser”. To open the options window, right-click  in the grey areay
with the coding stripes or click on the three dots at the top left in the area.



  149

Select “Display emoticodes” to emoticodes on the coding stripe

Emoticodes in the “Code System”

When the “Code System” is displayed in the normal tree structure, the emoticodes appear in the
place of the usual code symbols. The display of codes in the code system can, if desired, be
restricted to emoticodes. To do so click on the settings icon in the "Code System" window and select
Display emoticodes only. This setting is automatically reset when you open another project.

Emoticodes in the “Retrieved Segments” and “Overview of coded
segments”

Emojis, in most cases, replace code symbols, and are therefore found in the source list in the
“Retrieved Segments.” In the table view, as in the Overview of coded segments Emojis are displayed
instead of the circle containing the code colors, allowing the entire table to be sorted by Emojis.

Emoticodes in MAXMaps and other MAXQDA visual tools

In MAXMaps, the appropriate emoticon will appear in the place of the code symbol. In the Code
Matrix Browser, Code Relations Browser, and Codeline, the Emoji will also be displayed in the place
of the code symbol.

In the Document Comparison Chart each code that is present in the paragraph is represented by a
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colored section of the bar. Code colors, not Emojis, are used.

The Document Portrait is displayed with emoticodes rather than code colors if the “Mix” feature is
turned off. When the “Mix” feature is turned on, it mixes the code colors where codes overlap. In this
case, the code color of the emoticode is used.

Comments for Coded Segments
You have the option to add one short comment to each coded segments. This can be a summary of
the coded segment or a comment about its significance to your analysis. Comments are especially
useful for category development.

The difference between memos and comments is explained in the following blog post:

Read article

To create a comment for a coded segment in the "Document Browser": Double-click on a coding
stripe or on a code name - or right-click on the coding stripe and select Edit Comment.

Tip: This also works in the "Retrieved Segments" window.

A window will appear in which you can enter the comment. The comment can contain up to 511
characters, which corresponds to approximately 4 short sentences. Use Shift + Enter (⇧ + ↵) to
create a line break.

Comment Window

Tip: You can use AI Assist to automatically summarize a coded segment. The summary is saved in
the comment of the segment.

You can easily determine if a comment has been written for a coded segment when you look at its
coding stripe. Normally the inner part of the little circle is white in color, independent of the color of
the code symbol. When a comment is attached, the inner circle appears in the same color as the
outer line of the symbol. If you hold the mouse on the coding stripe, the comment appears in the
tooltip.

https://www.maxqda.com/memos-comments-paraphrases-summaries
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Displaying comments on the sidebar of the “Document Browser“

Click on the sidebar icon in the head of the "Document Browser" window to open a sidebar next to
the text listing all written comments in boxes.

Displaying comments on the sidebar

Right-click into the sidebar to see further display options and to optionally also display memos at the
same time.

Tip: You can also open the sidebar by right-clicking on the document displayed in the "Document
Browser" and selecting Sidebar > Comments.

Edit and search your comments in the “Overview of Coded Segments“

As long as you haven’t changed the standard view, you can search all of your comments in the
“Overview of Coded Segments” table in the second column. Here, you can also insert new comments
and delete/edit existing ones. By right-clicking on the column header, the overview is sorted
according to this header. You can search for comments by right-clicking on the "Comment" column
header and selecting Search.
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Create, edit, and search for comments in the "Overview of Coded Segments"

Weight Scores for Coded Segments
When coding a document, you are attaching a segment of a text or image to a code in the “Code
System”. MAXQDA also allows you to assign a weight score to each of these coded segments to
indicate how important that particular coded segment is. It may be that certain coded segments
represent a typical argument or theoretical concept that you want to be sure and hold on to. In this
case, these segments are a sort of signpost.

MAXQDA allows you to indicate how important or appropriate a segment is for the code it is coded
with by giving it a weight score between 0 and 100. This weight score could be described as a “fuzzy
variable”, because it is not meant to give an exact numerical worth for the segment. Rather, it is
intended to be a guide, so you can later sort your retrievals based on the weight assigned.

The weight score can later be used as a sorting criterion for coded segments. In numerous analysis
functions it can be used as a selection criterion, allowing you to include only coded segments with a
specific weight into your analysis. 

Please note: Each newly coded segment automatically receives the default weight score, which can
be a number from 0 to 100.

When you use MAXQDA for the first time, the default weight will be set to 0. This can be changed in
the global preferences that you can open in the lower left corner of the MAXQDA main window.

Code weight score display

The weight of a coded segment is shown in the source information below each retrieved segment in
the “Retrieved Segments” window. It is displayed behind the code name in brackets.

Weight score in the "Retrieved Segments" window

Please note: The display of weight scores in your "Retrieved Segments" window can be suppressed
in the local window settings, which you can access via the gear symbol in the head of the window.
Uncheck the option Show weight to hide the weight score.

When sorting the coded segments in the “Retrieved Segments” window by weight, they are sorted in
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groups of 10, i.e. 0-10, 11-20, etc.

The “Overview of Coded Segments”, for example, which is available for document groups, each
individual document, and the whole project, also includes the weight scores for each coded
segment.

Adjusting the weight score for coded segments

When coding, the default weight score is always used automatically. A different weight score can
either be assigned in the window “Document Browser“, in the “Retrieved Segments“ window, or in the
“Overview of Coded Segments“.

Please note: How you choose to use different weights is up to you. You could create a ranking list
with the top score of “1“, or use “100“ in the sense of a maximum weight for important segments.
Assigning weight scores in the “Document Browser”

Right-click on the coding stripe for the coded segment that you would like to alter the weight1.
score for.
Select Modify Weight.2.
You can then enter a number between 0 and 100.3.

Changing the weight score in the "Document Browser"

Assigning weight scores in the “Retrieved Segments” window

A weight score can also be assigned and modified in the “Retrieved Segments” window. Right click
anywhere on the coded segment or on the coding stripe displayed next to it to open a context menu,
where you can select Modify Weight and enter a number from 0 to 100.

Assigning weight scores in the “Overview of Coded Segments”

In the “Overview of Coded Segments” table, you will find a column for the weight score of each
coded segment. By double-clicking on a cell in the column, you will be able to enter a new weight
from 0 to 100.
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Change the weight score in the "Overview of Coded Segments"

Tip: You can also adjust the weight for several segments in this overview. To do this, select all the
rows of segments whose weight you want to change, and by right-clicking on the segment to open
the context menu, select the Modify Weight option.

Intercoder Agreement
When assigning codes to qualitative data, it is recommended to specify certain qualitaty criteria. You
assume, for example, that coding is not arbitrary or random, but rather that a certain level of
agreement between coders will be reached. The MAXQDA Intercoder Agreement function makes it
possible to compare the coding of two people who coded the data independently of each other. In
qualitative research, the purpose of comparing independent coders is to discuss the differences,
figure out why they occurred, and learn from the differences in order to improve coding agreement in
the future. In other words, the actual percentage of agreement is not the most important aspect of
the tool. Anyhow, this percentage is provided by MAXQDA.

It is always the goal of qualitative analysts to achieve as high a level of agreement as possible
between independent coders. It is not, however, focused on getting to a fixed statistical coefficient
as is common practice in quantitative research. Rather, the focus is on a practical improvement of
the coding quality. For this reason, one does not stop at the determination of a coefficient. Instead,
qualitative researchers want to address and edit the code assignments that do not match, so that
they can move on with more accurately coded material.

The intercoder agreement procedure

Checking the intercoder agreement involves the following:

Two coders process the identical document independently and code it according to mutually
agreed code definitions. This can be done on the same computer or on separate computers.



  155

Of course, it is important that both coders cannot see what the other person has coded.
The two identical documents coded by different coders must be contained in the same
MAXQDA project. The documents must have the same name, but must be placed in different
document groups or document sets!

The following procedure is recommended:

Make sure that the documents to be coded by a second person are within any1.
document group and not placed in the root of the "Document System".
Activate all documents to be coded by a second person and select Home > Project2.
from Activated Documents to save a copy of the project with the relevant documents
for the second coder.
Pass the copy of the project to the second coder.3.
Both coders write their names behind all document groups.4.
Both coders independently code the data and add new codes if necessary.5.
Use the function Home > Merge Projects to merge both projects into one. The6.
"Document System" will look like this:

Document window using the intercoder function

Now MAXQDA's Intercoder Agreement function can be used to compare the code1.
assignments.
Once the comparison is complete, the added documents coded by person 2 can be deleted.2.

Opening the Intercoder Agreement function

You can start the procedure via Analysis > Intercoder Agreement.

Start using the intercoder function via the "Analysis" tab

The following dialog box will appear, in which you can adjust the settings for checking the
agreement.
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Intercoder agreement testing options

Select the document group or document set with the document assigned to Coder 1 in the
upper drop-down menu and the document assigned to Coder 2 in the lower drop-down menu.
You can limit the analysis to the currently activated documents and/or codes by selecting the
appropriate options.
In the lower area, you can choose between three alternative analysis levels:

Code occurrence in the document – Per document, it is checked whether both persons
have assigned the same codes.
Code frequency in the document – Per document, it is checked whether both persons
have assigned the same codes the same number of times
Min- code overlapping rate of X% at the segment level – Per coded segment, it is
checked whether the other person has assigned the same code to the segment.

In the following, all three variants and the respective presentation of results are explained in detail.

Option 1 (document comparison level): Code occurrence in the document

Per document, it is checked whether both persons have assigned the same codes. Thus, the
criterion of comparison is the occurrence or absence of a code in the document. This option can be
useful, for example, if you are working with relatively short documents, such as free text responses
to a survey, and with a large number of codes.

MAXQDA generates two tables, the code-specific table with the analyzed codes and the document-
specific table with detailed information on each compared document.
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The code-specific results table

The code-specific table lists all evaluated codes and indicates for how many documents the coders
match in their assignment of the code:

Code-specific results table for the option "Code occurence in the document"

The example table indicates on the top right that a total of 5 codes were analyzed. There was
disagreement for the code “Sibling” and the code “Grandparents”, both only within one document
which is indicated by the column “Disagreements” (the numbers in the columns “Agreement”,
“Disagreements”, and “Total” refer to the number of documents).

The “Percent” column indicates how high the percentage agreement is for the respective code of
each line. The "Total" line is used to calculate the average percentage agreement – in the example, it
is 86.67%.

The detailed result table with evaluated documents

The result table lists all evaluated documents and thus provides detailed information on the
agreement of individual documents.
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Results table for the option "Code occurence in the document"

The table has the following structure:

The first column displays a green symbol if Coders 1 and 2 have assigned the same codes to
the document. In this case, there is one disagreement for 3 evaluated documents symbolized
by a red symbol.
The “Agreements” column displays the number of code assignments that match between
Coder 1 and Coder 2 for each document.
The “Percent” column displays the percentage agreement (i.e. the relative number of
matching code assignments). The percentage agreement is calculated as follows:
Agreements / (Agreements + Disagreements). For Interview 2, the example shows a value of
2 / (2+2) codes = 66.67 % – this is the proportion of codes that match in Interview 2.
The last column indicates a Kappa (RK) value that contains a chance correction for the level
of agreement (calculation: see below).
The last line “<Total>” adds up the matches and mismatches. The number in the “Percent”
column corresponds to the average number of matching codes, in the example it is 88.89%.

The header contains further information:

On the left, you can see the number of code assignments made by the two coders, which can
often give a first indication of similar or different coding behavior. In the example, one coder
has coded 22 segments and the other has coded 24 segments.
The number of analyzed documents and the relative number of identically coded documents
are shown on the right: In the example these are 2 of 3 documents, corresponding to 66.67 %.

In addition to the usual MAXQDA functions for opening the function again and for filtering and
exporting the results, the toolbar also contains the following important tools:

Display only disagreements – Hides all matching rows and provides quick access to documents
where the coders do not match.
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Ignore unassigned codes / Count unassigned codes as matches – Here you can decide whether any
given codes that were not assigned by both coders, should be considered as matches or should be
ignored. The difference can be explained using the following table:

 Coder 1 Coder 2 Agreement?

Code A X X yes, always

Code B X  no, never

Code C   depending on selected option

Code C was included in the intercoder agreement check but was neither assigned by Coder 1 nor by
Coder 2 in the document. In this case, if you select the option Ignore unassigned codes, code C will
be ignored and the relative number of matching code assignments is 1 of 2 = 50 %. If the other
option is selected, the match is 2 of 3 = 67 %, because code C is taken into account.

Interactive results table

The results table is interactive. Double clicking on a row opens the Code Matrix Browser for the
relevant document:

Inspecting code occurrence in two documents with the Code Matrix Browser

The title bar shows the compared document, in the example “Interview 2”. The view immediately
shows where the two coders disagreed: Person 1 assigned the code “Siblings” but Person 2 did not,
while Person 2 assigned the code “Grandparents” but Person 1 did not.
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Kappa calculation (Rädiker & Kuckartz)

In the "Kappa (RK)" column, the results table indicates a randomly corrected value for the percentage
agreement. It takes into account the probability of two people randomly selecting and assigning the
same codes in a document (if they simply randomly selected codes without considering the data
material). The calculation only makes sense if you select the option Count unassigned codes as
matches and is therefore only visible if this option is selected.

Kappa (Rädiker & Kuckartz), abbreviated to Kappa (RK), is calculated as follows:

Ac = Agreement by chance = 0.5 to the power of the number of codes selected for analysis
Ao = Agreement observed = percentage agreement
Kappa (RK) = (Ao – Ac) / (1 – Ac)

The random correction is generally very small, because the probability of a random match very
quickly becomes negligible as the number of codes increases. Therefore, it only makes sense to use
this correction if you include a maximum of 3 codes in the intercoder check.

Option 2 (document comparison level): Code frequency in the document

With this analysis option, agreement is deemed to apply when two coders have assigned a code with
the same frequency in the document. The difference between the frequencies is irrelevant: if one
coder assigns a code A once and the other three times, or if the difference is once vs. six times, both
situations are always considered to be a disagreement.

The results for this second analysis option corresponds, in principle, to the first option – with the
following exceptions:

Code-specific results table: : The column “Agreement” informs about the number of
documents for which the frequencies per code between the codesrs matches and the column
“Diagreement” informs about the number of documents in which the code frequencies differ.
Results table with analyzed documents:

The cells indicate how many codes were assigned equally often by both coders in thea.
document.
The "Kappa (RK)" column is never displayed.b.
Double-clicking on a row also displays the Code Matrix Browser. Here, squares ofc.
different sizes now indicate the differences in the coded characteristics of the clicked
document.

Option 3 (segment comparison level): Min. code intersection rate of X% at the
segment level

The system checks whether the two coders match in their coding of individual segments. This
option is the most advanced of the three and is the most commonly used option for qualitative
coding.

Since texts in qualitative analysis processes are not often subdivided into fixed text units, the
system checks the correspondence for each segment coded by the two coders (dialog option
Analysis: Segments of both coders). This means that each coded segment is analyzed for a match.
If, for example, Person 1 has coded 12 segments and Person 2 has coded 14, then 26 test
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operations are performed and the detailed results table includes 26 rows. Alternatively, you can
choose to analyze only the segments of document 1 or the segments of document 2. This can be
helpful, for example, to test the extent to which one coder matches a given reference for code
assignments.

Set tolerance for segment boundaries

Often in qualitative research, coders will apply the same code to a passage, but one will code some
words more or less than the other. This is usually irrelevant in terms of content, but can lead to an
unnecessarily low percentage of agreement when evaluating absolutely identical codings, and can
lead to “false” disagreements.

Therefore, you can specify in advance in the options dialog when two codings should be evaluated
as a match. As a criterion, the percentage of the overlapping area of two codings is used. This
percentage corresponds to the overlapping area of two codings in relation to the total area that the
two codings cover with their outermost segment boundaries:

The entry is made as a percentage and the threshold value can be set in the dialog box. The default
value is 90%, but can be set higher for testing purposes and then reduced step by step if there are
too many "false alarms".

Two results tables are generated: the code-specific results table and the segment-specific table.

The code-specific results table
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The code-specific results table

This table has as many rows as the number of codes included in the intercoder agreement check.
Codes that were not assigned by either of the two coders are not included in the table even they
have been selected for the intercoder check. The table provides an overview of the matches
(agreements) and non-matches (disagreements) in code assignments between the two coders. It
reveals the weak points, i.e., for which codes the desired percentage agreement is not achieved.

For each code, the table indicates the total number of segments coded ("Total" column), the number
of matches (agreements), and the code-specific agreement percentage. In the <Total> row, the
(dis)agreements are added so that an average percentage agreement can be calculated. 

The detailed results table with analyzed segments

The second table allows for an exact inspection of the intercoder agreement, i.e. it is possible to
determine for which coded segments the two coders do not match. Depending on the selected
setting, the table contains the segments of both coders, or only those of one coder, and indicates
whether the second coder has assigned the same code at the segment’s location.
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The segment-specific results table

Agreement in the assignment of a code to a given segment is indicated by the green symbol in the
first column. A red icon in this column indicates that there is a disagreement for this segment.

Tip: Clicking on the first column header sorts the column so that all red rows in the table are listed at
the top and you can inspect and discuss any discrepancies step by step. By clicking on the  icon,
only the problematic segments are displayed.
Interactivity of the Results Table: Compare Segments

The results table is interactively linked to the original data and allows for a targeted inspection of the
analyzed segments:

Clicking on a row highlights both associated documents in the "Document System" and opens
them by default in their own tabs, highlighting the clicked segment. In the toolbar you can
change the setting from Display in two tabs to Display in two document browsers - then the
document coded by "Coder 2" will be displayed in a separate window. This option is especially
useful if you are working with two screens.
Double-clicking on the small square in the "Coder 1" or "Coder 2" columns focuses the
corresponding document in the "Document Browser" at the location of the segment in
question. This makes it easy to jump back and forth between the two documents and judge
which of the two coders applied the code according to the code assignment guidelines.
If you click on a row with your right mouse button, a context menu will appear, allowing you to
transfer the code assignment from one document to the other directly. For example, select
the option Adopt the Solution of Person 1.

Coefficient Kappa for exact segment matches

In qualitative analysis, the analysis of intercoder agreement serves primarily to improve coding
instructions and individual codes. Nevertheless, it is also often desirable to calculate the percentage
of agreement, particularly in view of the research report to be generated later. This percentage of
agreement can be viewed in the code-specific results table above, in which individual codes as well
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as the ensemble of all codes are taken into account.

Researchers often express the desire to indicate not only percentage agreement rates in their
research reports, but also to include chance-corrected coefficients. The basic idea of such a
coefficient is to reduce the percentage of agreement by that value which would be obtained in a
random assignment of codes to segments.

In MAXQDA, the commonly used coefficient Kappa (Brennan & Prediger, 1981) can be used for this
purpose: In the results table, click on the Kappa symbol to begin the calculation for the analysis
currently underway. MAXQDA will display the following results table:

Intercoder coefficient Kappa (Brennan & Prediger, 1981)

The number of codes that match is displayed in the upper left corner of the four-field table. In the
upper right corner and the lower left corner you will find the non-matches, meaning one code, but not
the other, has been assigned in a document. In MAXQDA, the intercoder agreement at the segment
level takes into account only the segments to which at least one code has been assigned; therefore
the cell on the lower right is, by definition, equal to zero (as document sections will be included in the
analysis only if they are coded by both coders).

“P(obersved)” corresponds to the simple percentage of agreement, as it was displayed in the “Total”
line of the code-specific results table.

For the calculation of “P(chance)”, or chance of agreement, MAXQDA employs a proposal made by
Brennan and Prediger (1981), who dealt extensively with optimal uses of Cohen’s Kappa and its

https://journals.sagepub.com/doi/10.1177/001316448104100307
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problems with unequal marginal sum distributions. In this calculation, the random match is
determined by the number of different categories that have been used by both coders. This
corresponds to the number of codes in the code-specific results table.

Please note: If the coders have assigned the same number of codes to a segment and two or more
codes have been analyzed, you should include the first Kappa value listed in the results in your
report of publication. If the coders have assigned a different number of codes to a segment or only
one code has been analyzed, you should include the second Kappa value listed in the results (see
Kuckartz & Rädiker, 2019, S. 280–281).
Prerequisites for the calculation of randomly corrected coefficients such as Kappa

For the calculation of coefficients such as Kappa, segments usually have to be defined in advance,
and are provided with a predetermined set of codes. In qualitative research, however, a common
approach is that not to define segments a priori, but rather to assign the task to both coders of
identifying all document segments that they view as relevant, and to assign one or more appropriate
codes. In this case, the probability that two coders code the same section with the same code would
be lower, and hence Kappa would be greater. One could also argue that the probability of randomly
occurring coding matches in a text with multiple pages and multiple codes is so insignificant that
Kappa corresponds to the simple percentage agreement. In any case, the calculation should be
carefully considered.

https://link.springer.com/book/10.1007/978-3-030-15671-8
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06 – Work with Coded Segments

The Smart Coding Tool
What is the Smart Coding Tool?

The Smart Coding Tool is designed for working with coded text segments and is very well suited to
performing the following tasks:

Getting an overview of the contents coded with a code,
Reviewing and, if necessary, changing relevant codes,
Customizing your code system, particularly differentiating (i.e. breaking down) parent codes
or merging codes.

How to use the Smart Coding Tool

To open the Smart Coding Tool for all coded segments of a project, navigate to the Codes menu tab
and click on the Smart Coding Tool icon.

The Smart Coding Tool icon in the Codes menu tab

The Smart Coding Tool can also be opened for a compiled list of coded segments: click on the
Smart Coding Tool icon 

in the “Retrieved Segments” window or
in the tabular “Overview of Coded Segments“.
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Opening the Smart Coding Tool from the “Overview of Coded Segments“

The Smart Coding Tool environment looks like this:

The Smart Coding Tool
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The window is divided into two display areas. The code system is displayed in the left area. Here,
you can select a code to display its coded segments in a table in the right area. The selected code is
highlighted in the code system tree and is displayed above the table. Here, MAXQDA also displays
how many coded segments (from how many documents) are displayed in the table, that is, how
many rows the table contains.

Please note: When you open the Smart Coding Tool from the “Overview of Coded Segments” or the
“Retrieved Segments” window, only the codes assigned to the compiled coded segments will be
displayed in the code system. To retain the hierarchical structure, non-activated parent codes are
also displayed. The number at the end of a code row in the system indicates how often the code
appeared in the selected documents. When the Smart Coding Tool is opened, only the documents
from which the compiled coded segments originated will be activated. Only their coded segments
are displayed.

The individual columns in the table contain the following information:

Document – The source document from which the coded segment originates.

Coded segments – The coded segments of text, images, and PDFs.

Codes – The list of codes assigned in the area of the displayed coded segment. It doesn't matter
whether the code has only been assigned to one character of the segment, the entire segment, or
even beyond the boundaries of the segment. Only the codes that are visible on the left in the code
system are listed. The selected code in the code system tree and the direct parent code of this code
are never listed in this column to avoid redundant information.

Comments – A text field that can be freely edited (max. 511 characters) to add comments to coded
segments.

Like all MAXQDA table widows, the individual areas can be adjusted: the columns can be adjusted in
width and position with the mouse or hidden with a right-click on a column heading. A click on the
heading sorts the column in ascending order, another click in descending order.

Please note:

All other MAXQDA functions are locked while the Smart Coding Tool is open.
When starting the Smart Coding Tool from the "Retrieved Segments" window, the weight filter
is ignored. Therefore, if segments were not displayed in the "Retrieved Segments" window
due to the weight filter, they will still appear in the Smart Coding Tool.

Options in the ribbon menu

The following options in the ribbon menu allow you to adjust the view:

Only Activated Codes – restricts the display of the code system to the activated codes only. This
option is selected automatically when you open the Smart Coding Tool from the “Overview of Coded
Segments“ or the “Retrieved Segments“ window. When turned off, all your codes and subcodes are
displayed.

Only Activated Documents – restricts the display of coded segments to those in currently activated
documents. The display of frequencies in the code tree is adjusted accordingly.
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Filter – applies the filters you can define by right-clicking on the column heading in the right pane
and selecting Set Filter.

Reset all Filters – removes all filters from all columns.

Display Parent Code – in addition to the code, the “Codes“ column also displays its parent code.

Display Comments – displays the “Comments“ column.

Display Favorite Variables – shows additional columns for each favorite variable. For example, you
can display the age of a person or other background information about a case. You can set favorite
variables by clicking on the button with the three dots.

At the top right of the window there are two icons for the local undo function:

Undo – undoes the last action in the Smart Coding Tool.

Redo – redoes the last action in the Smart Coding Tool.

Create new code

You can always add new codes to use to code selected segments: Click on the green plus symbol
that appears while hovering over an existing code or click on the icon New Code at the top left:

Add a new code by clicking on the green plus symbol

Newly created codes are automatically activated so that these are displayed in the code system if
option Only Activated Codes is switched on.

Please note: All changes to the code system using the Smart Coding Tool, including the creation of
new codes, are added directly to your overall “Code System”.
Assign a code

To assign a code to a coded segment, click and drag the line of the code to one of the displayed
codes in the code system. The newly assigned code is then immediately displayed in the “Codes“
column. To code only part of a coded segment, first double-click on the whole coded segment text,
then select the portion of text you want to code, and drag it to one of the codes in the code system.
Even if you assign the same code to several sections of a coded segment's text, the code name will
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only be listed once in the "Codes" column.

If you hold down the Ctrl key (Windows) or ⌘ key (macOS) while dragging-and-dropping a whole line
with a coded segment onto a code, the complete coded segment is moved to the selected code. It
will thus no longer be displayed in the table.

Assigning a code to a coded segment

Tip: By right-clicking on a row and selecting Create and Assign New Code, you can add a code and
assign it to the entire coded segment in one step.
Search and autocode coded segments

You can search the text segments in the Smart Coding tool for terms and have the results
automatically coded with a code.

Perform a local search

To perform a local search in the segments currently displayed in the right window:

Click on the magnifying glass in the header of the table at the top right, or use the shortcut1.
Ctrl+F (Win) or ⌘+F (macOS) to show the search bar.
Enter a search term.2.
Click on the filter icon in the search bar to display only the answers with hits (this step is not3.
mandatory for autocoding, but it is very helpful for a quick overview of the segments
containing the search hit).

Perform complex searches

The local search bar provides only limited search functionality and is limited to the segments
currently listed in the right pane. If you want to perform more complex searches, click Search and
Autocode in the ribbon menu.

This opens the MAXQDA “Text search” window.

In the window, several search items can be entered that must appear all in a coded segment; in the
example, a search is performed for the words “happiness” AND “psychology” within the same
response. The search for two or more search items using the AND search can also be limited to
paragraphs or sentences.
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The options for the search correspond to those of the text search and are described there in detail.
In addition, there is the option Only in listed segments, which ensures that only the segments
currently listed in the right-hand window are searched. If you switch off the option, MAXQDA will
search all answers that are currently available in the working environment (the number of available
segments is shown in the first line of the code tree in the left pane).

After clicking Search, the segments with hits are listed in the right pane of the window:

List of search hits and starting the Autocode function

Autocode search results

To automatically code the segments with a new code, click on the icon of the same name as shown
in the previous figure. A menu appears where you can set the context for autocoding:

All coded segments containing the search hit
All paragraphs containing the search hit
All sentences containing the search hit
The highlighted search hits only

After selecting the context to be coded, a dialog box for creating a new code appears. After clicking
OK, the code is assigned to the selected context. The code name can be adjusted at any time in the
code system on the left.

Please note: If you have performed a search with an AND operation, only the entire coded segment
or the search hit can be autocoded.
Remove assigned codes

To remove an assigned code, click the "X" that appears when you move the mouse over a code in the
"Codes" column. All assigned codes are then removed from the coded segment.

https://www.maxqda.com/help-mx24/lexical-search/the-lexical-search-options-in-the-dialog-window
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Removing an assigned code from a coded segment.

Customize your code system

Your code system can be customized throughout the entire analysis process. You can change the
order of codes with the mouse and even insert them as sub-subcodes. By right-clicking on a code, all
the functions from the overall "Code System" are available to customize your code system in this
window:

Delete code
Sort subcodes (alphabetically or by category frequency)
Change code color
Create or edit code memo

Click a code in the code system to list all the segments coded with this code. This way you always
have an overview of the contents of your categories. The selected code in the code system is
highlighted. The name of the selected code is also displayed above the listed segments.

Display all codes of a coded segment

Please note: The "Codes" column always shows which codes have been assigned to the segment in
addition to the currently selected code. This column will never show the parent code of the selected
code.
Moving or copying individual coded segments

By default, if you drag a coded segment onto a code, that code will be assigned to the segment in
addition to other previous codes assigned to it. The segment will still be coded with the code whose
other segments are displayed in the right window.

If you hold down the Ctrl key (Windows) or ⌘ key (macOS), however, while dragging a coded
segment to a code, the code will be replaced. That is, the code whose segments are currently listed
in the right window is removed and the segment you dragged to a different code disappears from
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that list.

This function is especially useful if you want to transfer a coded segment from one subcode to
another subcode, because the latter suits better in terms of content.

Moving or copying all coded segments of one code to another

To move or copy all segments of a code to another code, right-click on a code and select the
function Move Coded Segments or Copy Coded Segments in the context menu.

Then right-click on the target code and select the corresponding function: Paste Coded Segments
(from ‘Code xy‘). For more information on this feature, refer to the section Move or copy all coded
segments of a code.

Working with comments on coded segment

In the “Comments“ column, you can write a coding comment on each coded segment. For example,
you can add notes about the coded segment texts, ideas for new categories, and more. Comments
are also suitable for keeping track of your analytical procedure (i.e. "still unclear“ – "come back to
this again later") or to store information for other team members ("please cross-check this!").

To show the “Comments“ column, click on the Display Comments option in the menu tab. Double-
click on a cell in the "Comments" column to enter a new comment or edit an existing one.

AI Assist: Summarize coded segments (into single comments)

Using AI Assist, you can automatically summarize the contents of a coded text segment:

To summarize one listed text segment, right-click on it and choose AI Assist: Summarize
Segment (into Comment).
To summarize all listed text segments at once, click on the icon AI Assist in the ribbon menu
and choose Summarize Listed Text Segments (into Comments).

The summaries are saved as comments on the coded segments and are displayed in the
"Comments" column. Please refer to AI Assist: Coded Segment for details about the summarization
process.

AI Assist: Summarize coded segments (into one Code Summary)

You can also automatically summarize all currently listed coded segments and save the result in the
code memo: Click on the icon AI Assist in the ribbon menu and choose Summarize Listed Text
Segmenst (into Code Summary).

Please refer to AI Assist: Code Summary for more information on the summarization process.

Analyze Sentiments

With MAXQDA you can perform a sentiment analysis in the Smart Coding Tool. This automatically
evaluates wether the content is to be assessed as negative, neutral, or positive. You can read more
about the sentiment analysis in MAXQDA in the chapter Analyze Sentiments of Tweets.

https://www.maxqda.com/help-mx24/05-coding/moving-all-coded-segments-of-a-code
https://www.maxqda.com/help-mx24/05-coding/moving-all-coded-segments-of-a-code
https://www.maxqda.com/help-mx24/coding/comments-for-coded-segments
https://www.maxqda.com/help-mx24/ai-assist/what-is-ai-assist-beta
https://www.maxqda.com/help-mx24/ai-assist/ai-summary-coded-segment
https://www.maxqda.com/help-mx24/ai-assist/ai-code-summaries-in-code-memo
https://www.maxqda.com/help-mx24/20-analyze-tweets-surveys/analyze-sentiments-of-tweets
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Export your display

Your current display can be exported via the usual icons at the top right in the menu bar. All coded
segments currently listed are exported.

Remove Code Assignments
In several locations, MAXQDA offers the option of removing single or multiple codes from a
segment.

Please note: If you delete a code in the “Code System“ window, the code is removed from all coded
segments in all documents.

Remove code assigments in the “Document Browser” window

Move the mouse over the coding stripe or over the code name.1.
Right-click and select Delete.2.

Removing a code assignment in the “Document Browser” window

Remove code assigments in the “Retrieved Segments” window

Right-click anywhere on a coded segment or on the coding strip.1.
Select Delete.2.
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Removing a code assignment in the “Retrieved Segments“ window

Remove code assignments in the “Overview of Coded Segments” or
“Retrieved Segments” windows in table view

Right-click on a row or select multiple rows while holding down the Ctrl key (Windows) or cmd1.
key (macOS) to simultaneously delete multiple coded segments.
Select Delete.2.

Deleting coded segments in the “Overview of Coded Segments”

Modify Coded Segments
There are various ways to modify coded segments:

By assigning an additional code to a coded segment.
By assigning another code in the place of an existing code.
By modifying the segment boundaries, i.e., enlarging or reducing the scope of a coded
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segment while the code remains in place.

All three of these modifications can be easily carried out in MAXQDA.

Coding a segment with an additional code

Sometimes it is necessary to assign an additional code to a coded segment. There are several
different ways of doing that:

"Document Browser" (manually) - After having coded a segment, the segment remains
selected (except for color coding). It is possible to directly attach more codes to the same
segment, for example, using drag-and-drop. If you want to assign additional codes later, the
segment must be selected again. The easiest way to do this is to click on the existing coding
stripe of this segment. The segment will be highlighted again and you can assign an
additional code in the usual way.
"Document Browser" - A faster way is to drag the coding stripe from the “Document Browser”
directly onto another code of the “Code System”. The coded segment will additionally be
coded with the new code.
“Retrieved Segments” window - If the coded segment is shown in the "Retrieved Segments"
window, drag the coding stripe next to the relevant segment to another code while holding
down the Ctrl key (Windows) or ⌘ key (macOS).
“Overview of Coded Segments” - A coded segment can be copied from the table view of the
“Retrieved Segments” windows or the “Overview of Coded Segments” to a different code in
the same manner. Simply drag the row to another code in the "Code System" window while
holding down the Ctrl key (Windows) or ⌘ key (macOS).

Changing the code assigned to a segment

When reviewing your analysis, you may decide that the wrong code was assigned to a segment. Or
you may decide that the “Code System” is not precise enough, so it is necessary to expand the “Code
System” and distinguish between different codes. In both cases, you will need to replace one code
assigned to a text with another:

"Document Browser" (manually) - Assign the new code as additional code, e.g., by first
clicking on the coding stripe to mark the segment and then dragging the segment onto the
new code with the mouse. Then delete the previous coding by right-clicking on the old coding
stripe and selecting Delete.
“Document Browser” - A faster way is to drag the coding stripe directly onto the new code
while holding down the Ctrl key (Windows) or ⌘ key (macOS). This moves the segment to the
new code and deletes it from the old one automatically.
“Retrieved Segments” window - If the coded segment is shown in the "Retrieved Segments"
window, drag the coding stripe next to the relevant segment to another code (without holding
down a key). This moves the segment to the new code and deletes it from the old one
automatically. If the other code is not activated, it may be that the coded segment was
removed from the “Retrieved Segments” window.
“Overview of Coded Segments” - A coded segment can be moved from the table view of the
“Retrieved Segments” windows or the “Overview of Coded Segments” to a different code in
the same manner. Simply drag the row to another code.
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Click and drag to move the coded segment to the desired code

Editing the size of a coded segment

Sometimes a segment may be coded outside of its logical boundaries, meaning it is too short or too
long. The coded segment will, therefore, be difficult to understand because it is out of context.
Segment boundaries can be adjusted in the following way:

Select the segment by clicking on the corresponding coding stripe or code name in the1.
“Document Browser”. The segment is now highlighted in the original document.
The coded segment can now easily be resized with the code grabbers that are displayed at2.
the beginning and end of a segment.
The segment boundaries can also be redefined by selecting the correct text segment and3.
coding it again with the same code. Alternatively, you can select the correct text segment,
right click on the existing coding stripe and select Recode with Highlighted Segment.

MAXQDA automatically adjusts to the newly defined segment boundaries.

Adjusting the length of a coded segment

Please note: Existing coded image segments in image or PDF documents will only be adjusted when
the newly selected area either completely includes the existing segment or when the newly selected
area is completely inside the area of the existing coded segment.

While the "Recode" function always adjusts the segment borders to the current highlighted area, you
can also expand the segment boundaries with an overlapping highlight:

Highlight a passage that overlaps with the beginning or the end of an existing segment.1.
Right-click on the coding stripe and choose the entry Extend with Highlighted Segment.2.
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Move or Copy all Coded Segments of a
Code
The Modify Coded Segments section has already described how you can move or copy individual
coded segments.

Moving all the coded segments of a code into another code

If you move a code from one position in the “Code System” to another, the code references move
automatically together with the code. This is like moving a drawer from one place to another in a
cabinet; the drawer’s contents move together.

To move a complete drawer is something other than to move only its contents. The same is true
with code assignments. If you only want to move these to another code, you cannot use the
procedure described above. There is another procedure that leaves the drawer in its place and
merely shifts its contents:

Right-click on a code in the “Code System”.1.
Select Move Coded Segments from the code context menu. This transfers the code2.
references to an internal clipboard. (Up to this point, nothing has really changed in the “Code
System”. The number of coded segments for this code remain the same.)
Right-click the target code and choose Paste Coded Segments (from ‘first code‘). MAXQDA3.
asks you to confirm the command before executing it.

Moving coded segments

The first code remains in the “Code System” until you delete it, but the number of its coded
segments is now zero. If you no longer need the code, you can simply delete it from the “Code

https://www.maxqda.com/help-mx24/work-with-coded-segments/modifying-coded-segments
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System“. But be careful: its subcodes will be removed as well!

Handling code conflicts

It may happen that some of the segments which you have moved to the target code have already
been coded with this code. Suppose that you move the segments from "Code B" to "Code A",
MAXQDA proceeds as follows in the case of an overlapping code:

The outer segment boundaries of both codings are retained. Thus, if a segment with "Code B"
is from word 1 to 5 and the words 4 to 10 have already been coded with the target code "A",
the new segment ranges from word 1 to 10.
If both coded segments have a comment, the comment on the target code is retained. The
comment on the moved code is deleted.
If only one of the two coded segments has a comment, this comment is preserved.
The coding weights of the target code "A" are retained, regardless of the coding weight of the
moved segment from code "B".
If several existing segments of the target code "A" are combined into one large coded
segment because they all lie in the segment boundaries of a "B" coded segment, then this
large segment receives the weight of the oldest "A" coded segment. Only the comment of the
oldest coded segment of "Code A" will be taken, all other comments of code will be deleted,
even if the oldest coding has no comment. If none of the existing coded segments has a
comment, the comment is taken from "B".

Because of overlapping coded segments, the number of coded segments of the target code after
you shifted codes can, of course, be smaller. If you move 10 coded segments from "Code B" to
"Code A" with 20 coded segments and several segments overlap, you will not see 30 but fewer
segments under "Code A".

Copying all the coded segments of a code

The function “Copy Coded Segments” is similar to the “Move Coded Segments” function. The
important difference is that the original code assignment will be retained; that is to say, the coded
segment will be duplicated and assigned to a new code in addition to the original code.

This action is performed as follows:

Right-click on the selected code in the “Code System”.1.
Select Copy Coded Segments from the context menu that appears.2.
Move the cursor to the target code to which you want to copy the coding added and click on it3.
with the right mouse button.
Select Paste Coded Segments (from ‘old code‘) from the context menu that appears4.

Tip: In the code system, you can also copy a code including all segments assigned to it. To do this,
select the Duplicate Code with Coded Segments option from the context menu of a code. Directly
below the code, the new code is inserted at the same level with the same name, supplemented by a
consecutive number.
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07 – Analyze Coded Segments

Compare Codes
The Compare Codes function allows you to compare the coded segments of two or more codes. For
example, the segments of the code “positive” can be juxtaposed with those coded with “negative”.

Compare codes

How to compare codes

Start the function via the menu item Codes > Compare Codes. 1.
In the dialog that appears, select the codes that you want to compare and confirm your2.
selection with OK.

MAXQDA will then display the results window, with one column for each selected code. On the left
margin, you can select which documents are to be included in the current view.

The following functions are available in the toolbar at the top:

Display comments for coded segments – displays the comments on coded segments (if there
are any).

Display origin – shows the source documents, locations within documents, and the code
weights below the coded segments. Clicking on the displayed source information opens the
corresponding document in the “Document Browser” and highlights the coded segment.

Display memos – displays the titles of in-document memos that are present within the range of
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the coded segments. Clicking on the displayed memo title opens that memo.

Standardize font – with this setting, you can standardize the text font, size, and line spacing to
create a consistent display of your text segments. Font styles such as bold and italics are not
affected by this setting.

x of y columns – adjusts how many columns (x) of the total columns (y) are visible. A maximum of 6
columns can be displayed at the same time.

Refresh – reopens the options window, which lets you customize the displayed codes.

In the upper right corner, more icons are available that allow you to zoom in and out of the displayed
content, as well as to search and export the content.

Interactivity

The displayed segments are interactively connected with their source document and you can adjust
segments properties right in place:

Click on source information to show segment in its surrounding context in the “Document
Browser”.
Right-click on a segment to write or modify the coding comment, to copy it to the clipboard, to
list all linked memos, or to delete the code assignment.
Click on weight to modify it.

Code Frequencies
Using the Code Frequencies feature, you can create a table or chart that shows how many segments
and how many documents have been coded with selected codes. Since the documents often
correspond to specific cases (e.g. interviews or organizations), the following function can be used to
quickly analyze for how many cases a particular topic has been coded.

Follow these steps:

Activate the documents you want to include in your analysis. If you want to include all the
documents, you don’t need to activate anything.
Start your analysis via Analysis > Code frequencies.
The following dialog window will appear, to which you can drag the codes to be analyzed
from the "Code System" using the mouse. To insert more than one code, you can activate it at
any time and then use the Add activated codes button. The Only for activated documents
option is automatically selected if documents were activated when the function was opened.
Deselect this option to analyze all documents
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Select codes for the analysis of code frequencies

After clicking OK the following frequency table will appear, which shows in how many documents
the code occurs.

Documents per code

Frequency table: number of documents containing the respective codes

The bottom three rows contain the following information:

DOCUMENTS with code(s) – refers to the number of documents in which at least one of the
analyzed codes occurs.

DOCUMENTS without codes – refers to the number of documents in which none of the analyzed
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codes occur.

ANALYZED DOCUMENTS – refers to the sum of the two numbers directly above and gives the
number of all analyzed documents.

Segments per code

If you click on the blue arrow in the toolbar, MAXQDA switches the display to "segments with code".
Segments are then counted rather than documents. The results table shows how many segments
the listed codes have been assigned to in the selected documents.

Frequency table: number of segments with the respective codes

In the second line of the table, you can see that the "Parents" code has been assigned to 30
segments within the analyzed data. This corresponds to 22,4% of the analyzed coded segments.

Code frequencies displayed as a chart

By clicking on the chart symbol in the upper left corner, the currently displayed frequency table can
be displayed as a bar, column, or circle chart. Refer to the Frequency Tables and Subcodes section
for further information on charts.

https://www.maxqda.com/help-mx24/statistics-and-graphics-functions/frequency-tables-charts-subcodes
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Code frequencies as a chart

Export and print code frequencies

The current display (table or chart) can be printed and exported via the usual symbols on the top
right corner of the window.

Copy - copies the current view to the clipboard to allow you to then paste it into a report,
presentation or graphics software.

Print – prints the currently displayed window.

Export – exports frequency tables as Excel files or as web pages in HTML format. Exports
charts as image files in PNG or SVG format or in EMF format (Windows only).

Tip: If you export a frequency table in Excel format, all currently created tables will be exported to a
file as one worksheet each.

Code Coverage
With the help of the Code Coverage function, you can analyze to what extent the document has been
coded with a particular code. Code Coverage comparisons can be applied to multiple documents,
document groups, and document sets. The tool compares coded characters (including spaces) in
texts, coded areas in images, and coded time in videos.

Starting the function

Follow these steps to determine Code Coverage:

First, activate the documents and the codes that you want to include in the analysis. If you1.
want to analyze all documents and all codes, you do not need to activate anything.
Click on the Code Coverage function in the Analysis menu and select in the appearing menu2.
whether you want to analyze (a) texts, tables or PDF documents (b) images, or (c) videos.
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Select the “Code coverage“ function in the Analysis tab

Please note: The “Images“ function also includes coded image segments in PDF documents, and
the “Videos” function includes audio files.

The following dialog window will then appear in which you can choose to split the results by3.
document, document group, or document set.

Selecting whether to compare documents, document groups or document sets

The results table for coded documents, for example, could look like this:
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Code Coverage: results table for coded documents

The results table displays the documents, document groups, or document sets in the columns, and
the selected codes in the rows. By default, the cells provide information about how much area in a
document is coded with a code (in percent). In the example above, you can see that 50% of text in
“Class 6a” was coded with the code “Group work”, whereas in “Class 6b” this percentage is only 34%.
The drop-down menu allows you to define what results are displayed in the cells:

Percentages: none – the absolute numbers are displayed, i.e., the coded characters including
spaces (in texts), the coded area (for pictures), or the coded time (for videos).

Percentages of “coded“ – the result cells indicate what percentage of the coded length, area, time
of the document was coded with the given code. The sum of the percentages will exceed 100% if the
analyzed codes overlap each other at one or more points in the document.

Percentages of entire text/image/video – the result cells indicate what percentage of the coded
length, area, time of the document was coded with the given code. The sum of the percentages will
exceed 100% if the analyzed codes overlap each other at one or more points in the document.

Row percentages – the result cells indicate what percentage of all evaluated documents, document
groups, or document sets have been coded with each respective code. Each row then indicates how
the coded segments are distributed as a percentage of the individual documents, groups, or sets.

The three rows on the bottom end of the table are always displayed and contain the following
information:

NOT CODED – provides the length/area/time of the document, group, or set that has been coded
with none of the currently displayed codes.

CODED – provides the length/area/time that has been coded with any of the currently displayed
codes.

TOTAL TEXT/AREA/TIME – provides the total extent of the document, document group, or
document set.
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Functions in the toolbar

A toolbar with the following functions is located at the top of the "Code Coverage" window:

 No color highlight – turns off color highlighting of the result cells.

 Color highlight refers to columns – the cells in each column with the highest value is dark
green, that with the smallest is white. The closer a value is to the highest value, the darker its green
highlight.

 Color highlight refers to rows – the cells in each row with the highest value is dark green, that
with the smallest is white. The closer a value is to the highest value, the darker its green highlight.

 Show decimals – for easier readability of the percentages, decimal places are switched off by
default and can be displayed via this symbol.

 Chart view – creates a frequency table with the calculated values for each column. The
frequency table can be turned into a diagram to visualize these results.

Store Results Table in a QTT Worksheet

In the Questions – Themes – Theories (QTT) workspace of MAXQDA, you can collect and comment
on all the important results of your project. To save the results table in an existing or new worksheet
in the QTT workspace, you can use the  Send to QTT Worksheet icon in the upper right corner in
the toolbar.

Exporting results tables

The current view of the result table can be exported using the usual icons on top right of the window.
When the highlight is switched on, this is also included.

Displaying results tables as a chart

Your results can be displayed as frequency table or as a chart. In the "Percentage" column, the
percentages are displayed relative to the total area, in the column "Percent (Valid)" relative to the
coded area.

Clicking on the diagram symbols above the frequency table show a vertical or horizontal bar chart, or
a pie chart. By activating the missing values, the graphic figures show the percentages related to the
total area.

https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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Code Coverage: chart view of results

Refer to section Frequency Tables and Charts for Subcodes for information on creating and
customizing charts.

Code Patterns
Code Patterns enable you to examine the co-occurrence of codes in a document or segment; They
are particularly suitable for analyzing code combinations. Code patterns can effectively support a
multi-dimensional analysis as well as the formation of types through identifying patterns.

In the case of the Simple Code Patterns, you select individual codes for the analysis. In the case of
Complex Code Patterns, you select parent codes whose subcodes are evaluated. Let us look at an
example of how code patterns may be used in your analysis:

Example

Imagine you have carried out a video analyses in several situations in a kindergarten, to determine
which games are played by which teachers with which children. Each analyzed situation is entered
as a separate document in the “Document System”, and in the “Code System” there are three parent
codes for your three analysis dimensions, each with three subcodes:

Parent code 1:
Teacher

Parent code 2:
Child

Parent code 3:
Game

Mrs. Mathilde
Mr. Wolters
Mrs. Berkempers

Finn
Mareike
Joshua

A ball game
Knight’s castle
Board game

Simple Code Patterns are especially suited to analyzing combinations of subcodes within one

https://www.maxqda.com/help-mx24/analyze-coded-segments/frequency-tables-charts-subcodes
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dimension. The results table has the following structure:

Finn Mareike Joshua Segments

x x  5

 x x 3

x  x 2

Selected codes form the columns, and the combination of these codes are marked with a symbol
(here an “x“). In the last column, you can see in how many segments the combination occurs. For
example, you can see in the first row of the table that Finn and Mareike playing was coded in 5
segments. The remaining rows reveal that it never occurred that all three children played together as
a group, since there is no row with an x for each column.

Instead of the number of segments, the number of documents, document groups, or document can
be analyzed. The table then shows how often a code pattern occurs in the selected unit.

Complex Code Patterns are particularly suited to the analysis of interrelationship between several
dimensions. The results table has the following structure:

Teacher? Child? Game? Segments

Mrs. Mathilde Finn Ball game 10

Mr. Wolters Mareike Knight’s castle 6

Mr. Wolters Joshua Ball game 3

The columns contain the parent codes, i.e. the analyzed dimensions. The cells contain the subcodes,
i.e. the manifestations of each individual dimensions. In the last column, MAXQDA displays in how
many segments of your data the three subcodes of each respective row co-occurred. So, in the first
line, you can see that a ball game between Mrs. Mathilde and Finn was coded in 10 situations.

The number of documents, document groups, or document sets can also be displayed in lieu of the
number of segments.

Analyzing simple code patterns

To perform a simple analysis of code patterns, select the following function: Analysis > Code
Patterns > Simple Code Patterns.

A dialog window will appear into which you can drag-and-drop codes from the "Code System" with
your mouse. Alternatively, the activated codes can be transferred to the selection window by clicking
the Insert activated codes button. The Remove code(s) button can be used to remove selected
codes from the selection window again.
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The Simple Code Patterns preferences window

Below the code selection you have to select which co-occurrence of codes should be analyzed, i.e.,
the counted units:

Segments – Analyzes in how many segments the selected codes co-occur. It is sufficient if
the codes overlap, they do not have to be applied to exactly the same segment.
Documents - Analyzes in how many documents the selected codes co-occur. It doesn’t
matter where the codes occur in your documents; what is important is that all codes have
been assigned in a document at all. With the unit “Documents”, it is irrelevant if the code
occurs multiple times in a given document – one occurrence is sufficient to be counted.
Document groups and sets – Like the previous option "Documents", only that is searched
across multiple documents. This means that the codes do not have to occur in the same
document. It is sufficient if one code was assigned in one document and the other code in
another document of the same document group or set.

Differentiation of results– If you selected to count for segments or documents, you can determine
whether the results table should be additionally divided into documents, document groups, or
document sets. This allows easy comparison of cases or groups of cases. .
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Selecting the option Only activated documents, restricts the analysis to activated documents.

Click OK to start the analysis and MAXQDA will produce the following results table:

Simple Code Patterns output example: Co-occurance of codes within segments

The first columns of the results table are headed with the names of the selected codes and provide
information on the occurrence of the respective codes. If the code occurs on a segment, a blue
square is shown in the column. Each line contains a different combination (the so-called “pattern”)
of the analyzed codes.

In the upper right corner of the window, you will find information on how many combinations actually
occurred in the evaluated documents and - behind them in brackets - how many could maximally
have occurred.

Please note: If a combination of codes does not exist, this row will not be listed in the table. Only the
segments with at least one of the selected codes have been analyzed. So, when the unit "Segments"
is selected, a row that does not contain any of the evaluated codes will not be displayed.

The "Segments" column indicates the number of times a particular combination occurs in the
documents analyzed. The "Percent" column contains the corresponding relative frequency. 

The "Number of codes" column displays how many codes occur in that combination.

If you selected a differentiation for documents, document groups, or document sets, additional
columns are added for each selected unit at the end of the table – in the example above for the two
documents “Day 1” and “Day 2”. The display in the columns can be switched between absolute
numbers and row or column percentages with the three symbols in the toolbar. In the above table,
the column percentages are selected so that the results for the individual documents can be directly
compared with the overall values in the “Percent” column.
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Output when analyzing the co-occurrence of codes within documents, document
groups, or document sets

(1) In the results table, the column headed “Segments” with corresponding to the numbered unit is
instead headed “Documents”, “Document groups”, or “Document sets”. It specifies how many
analyzed units contain the respective combination of codes.

(2) If there are documents, groups, or sets that do not contain any of the analyzed codes, the results
table will contain a row without blue squares.

(3) A “Detailed View” table is also displayed in which you can see which combination of the selected
codes is contained within each document, each group, or each set. The table basically corresponds
to the “Code Matrix Browser” visual tool, with interchanged rows and columns.

Analyzing complex code patterns

To perform a Complex Code Patterns analysis, select the following function: Analysis > Code
Patterns > Complex Code Patterns.

A dialog window will appear, into which you can drag-and-drop parent codes from the “Code System“
with your mouse. MAXQDA then automatically lists their respective subcodes from which you can
exclude individual subcodes from the analysis by unchecking their selection box.
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The Complex Code Patterns preferences window

The settings in this dialog window are the same as described above for the Simple Code Patterns.

Click OK and a MAXQDA will produce the following results table:
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Complex Code Code Patterns output example: Co-occurance of codes within segments

The first columns contain your selected parent codes. Each line contains a combination of the
subcodes, and the “Segments” column indicates how often these combinations occur in your data.

At the right side of the table, MAXQDA will display columns containing frequencies in the individual
documents, document groups, or document sets, if you selected to differentiate by them. The values
in these additional columns can be switched to column percentages or line percentages.

Toolbar

 Filter – applies the filters you can define by right-clicking on the column heading and selecting
Set filter.

Reset all filters – removes filters from all columns.

 Column selection – displays a dialog where you can select the displayed columns of the results
table.

 Count hits only once per document – regardless of how many segments in a document with a
combination of codes exist, it will be counted only once if this option is enabled. The option is
displayed only when evaluating segments.

 Statistics – displays the results as a frequency table. This frequency table can also be switched
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to a chart to visually display the results.

Number – the additional columns with documents, document groups, or document sets will
display their absolute numbers.

Row percentages – the additional columns with documents, document groups, or document
sets will display their row percentages.

 Column percentages – the additional columns with documents, document groups, or
document sets will display their column percentages.

Interactive results tables

The Code Patterns tables are arranged according to combination frequencies – by clicking on a
column header, this arrangement can be adjusted. The order of the table’s columns can be changed
by clicking and dragging the header with the mouse.

Tip: The results tables of the Simple and Complex Code Patterns are interactive. A double-click on a
line with a code combination lists all associated coded segments in your “Retrieved Segments”
window.

Store Results Table in a QTT Worksheet

In the Questions – Themes – Theories (QTT) workspace of MAXQDA, you can collect and comment
on all the important results of your project. To save the currently visible part of the results table of
the code patterns analysis in an existing or new worksheet in the QTT workspace, you can use the

 Send to QTT Worksheet icon in the upper right corner in the toolbar.

Exporting results tables

The current display can be exported using the usual icons at the top right of the window. The
selected rows are exported - if no rows are selected, the entire table is exported.

Displaying results as a chart

A click on the chart symbol on the top left will display the current table as a horizontal or vertical bar
chart or as a pie chart. If you selected “Documents”, “Document groups”, or “Document sets” as your
unit, you will see in the row, the number of analyzed documents in which none of the respective
codes occur. Refer to the section Frequency Tables and Charts for Subcodes for information on
creating and customizing charts.

https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
https://www.maxqda.com/help-mx24/analyze-coded-segments/frequency-tables-charts-subcodes
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Simple Code Patterns output as a bar chart

Displaying pairwise relations of the codes in MAXMaps

The code patterns shown in the table can be displayed visually and examined further by inserting the
results into MAXMaps (MAXMaps is a MAXQDA workspace for creating concept maps). To do this,
click on the icon  Save as a Map in MAXMaps. MAXMaps opens and a new Code Relations Model
is created:
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Code Patterns visualized as a Code Relations Model in MAXMaps

All analyzed codes are arranged in a circle with codes of the same dimensions next to each other.
Connecting lines between each two codes indicate whether these codes co-occur in the analyzed
data. The number on the connecting lines informs about the exact number of co-occurrences and
the more relations, the thicker the line is displayed. When creating the Code Relations Model, the
settings of the code patterns are applied, that is, either it is considered a relation that two codes
were assigned together at the same segment or that two codes were assigned somewhere in the
same document.

While the result tables of the Code Patterns show the co-occurrence of several dimensions, the
Code Relations Model in MAXMaps shows the pairwise relations between two codes. Therefore, the
display in MAXMaps makes it possible to analyze the relationships between two codes in detail.

Please note: If document groups or document sets have been selected as the unit for creating the
code patterns, or if the option for including subcodes is active, it is not possible to display the results
as a Code Relations Model in MAXMaps.
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The Code Explorer
In which documents has the code “positive” assigned frequently, which codes co-occur frequently
with the code “positive”, and which words occur frequently in the text passages coded with this
code? These and many more questions can be answered with the Code Explorer.

The Code Explorer gives you an overview of the use of a code throughout your project:

The Code Explorer

How to use the Code Explorer

Open the Code Explorer via Codes > Code Explorer in the MAXQDA main menu.1.
Drag a code from the “Code System” window to the input box at the top of the Code Explorer2.
window.
If necessary, select options in one of the three menu tabs of the Code Explorer window.3.
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Tip: Alternatively, start the Code Explorer by right-clicking on a code in the "Code System" window
and selecting the function of the same name.

Presentation of results

The results are presented in six interactive sections: click on a result to get more details about the
corresponding search hits.

In documents

This section informs you about the number of segments coded with the selected code and in how
many different documents, document groups, and document sets these are located.

coded segments – total number of segments coded with the selected code in the searched
documents. Click this line to open a listing of the coded segments.

documents – number of documents in which the code has been assigned at least once. Click this
line to activate these documents in the “Document System” window. The percentage refers to all
documents in the project. However, if only activated documents were searched, then the percentage
refers to hits within these activated documents.

document groups / document sets – number of document groups and document sets in which the
code has been assigned at least once. The percentage refers to all groups/sets in the project
regardless of document activation.

Related elements

The first number indicates whether a code memo has been written for the code or not, so it can only
be 0 or 1.

The following numbers indicate how many memos have been linked with the selected code, and how
many coding comments and summaries have been written for the code.

Click on one of the lines to display the corresponding memos, comments, and summaries.

Most frequent in these documents

This section displays the documents in which the selected code has been assigned most often. The
numbers indicate how often the code was assigned in the corresponding document, and documents
are displayed in descending order of frequency according to these numbers. The small horizontal
bar charts visualize the frequencies so that differences between documents can be assessed easily.
The small “dash” charts at the right to the numbers visualize where the coded segments begin in the
document.

Click on a line to get a listing of the coded segments in the corresponding document.

Please note: If multiple documents have the same number of hits, the documents will be listed in the
order defined in the “Document System” window.
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Highest coverage in these documents

This section lists the documents with the highest code coverage, that is, the percentages indicate
how much of the total size of a document was coded with the selected code. For example, 25%
indicate that a total of one quarter of an interview text, an image, or a video has been coded with the
selected code. Sorting follows a descending order according to the percentages. The small
horizontal bar charts visualize the percentages so that differences between codes can be assessed
easily.

Click on a line to get a listing of coded segments in the respective document.

Please note: Since the same code can be assigned to same parts of an image several times, it is
possible that percentages above 100% are displayed.
Most frequent word code co-occurrences

This area shows which codes have been assigned together with the selected code in the material. In
the Code Co-Occurrence menu tab, you can specify which relations between the two codes should
be evaluated:

Intersection of codes in a segment – codes that co-occur with the selected code within a
segment are listed. It is sufficient if the codes overlap, they do not have to cover 100% of the
same area. The numbers indicate how often the two codes overlap at a segment.
Proximity of codes in same document – codes assigned within a defined distance from the
selected code in the same document or media file are listed. For example, if 0 paragraphs are
defined as the distance, both codes must occur in the same paragraph.
Occurrence of codes in same document – codes assigned to the same document as the
selected code are listed. The position of the two codes does not matter, they must both have
been assigned at least once in the same document.

Click on a line to get a listing of coded data segments where the selected code and the clicked code
co-occur.

Most frequent words in coded segments

This section displays the most frequent words text segments coded with the selected code.
Upper/lower case is ignored.

Please note: If several words occur with the same frequency, they are output in alphabetically
ascending order.

In the Word frequencies menu tab, you can set various options for determining the most frequent
words:

Base Form (Lemmatize) – The words found will be lemmatized, for example, "goes", "going",
and “went” will all be listed as the infinitive "go". More information about the lemma lists used
can be found here.
Apply Stop Word List – Select a stop word list here and turn on the option to exclude fewer
interesting matches.
Ignore Numbers – When this option is turned on, numbers are not output.
Ignore Hashtags / Email Addresses / Hyperlinks – If any of these options are enabled, the
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respective elements will not be listed as results.

Switch off sections

If a section is currently not of interest for the analysis, it can be temporarily switched off. This can be
helpful for saving computing time when working with large amounts of data. To deactivate a section,
click the respective on/off symbol at the top right:

Temporarily switch off section

Clicking again turns the section back on.

Choose options in menu tab “Start”

In the Code Explorer Start menu tab, you can set the following options for your search:

Only Activated Documents – limits the search to the currently activated documents. This
option affects all sections.
Most Frequent [3-50] – Select a stop word list here and turn on the option to exclude fewer
interesting matches.

Tip: In the “Start” menu tab, you can also call up subcode statistics for the selected code or create a
code model in MAXMaps to deepen the exploration.

Store results in a QTT worksheet or copy results to clipboard

In the Questions – Themes – Theories window of MAXQDA, you can collect and comment on all the
important results of your project. In the Code Explorer, you will find the Send to QTT Worksheet icon
in the upper right corner of each section to save the current view in a new or existing worksheet.

Next to it you will also find an icon that can be used to copy the respective area to the clipboard. You
can then paste the result into Word, PowerPoint, and other programs, for example, using the
keyboard shortcut Ctrl+V (Windows) or ⌘+V (macOS).

https://www.maxqda.com/help-mx24/statistics-and-graphics-functions/frequency-tables-charts-subcodes
https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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Send section to QTT worksheet

The Overview of Documents for a Code
To answer the question in which documents or document groups a certain code was used, MAXQDA
gives you the option to use the “Overview of Documents“. To show this overview, right-click on a
code and choose Documents in the “Overview“ section of the context menu. It makes no difference
whether the code has collapsed subcodes or not – the “Overview of Documents“ takes into account
only the code in question.



  203

Access the “Overview of Documents“ in the context menu for a code

A tabular list of all documents that have segments coded with the chosen code will open. In the
following example, the code “Siblings” was used in 6 documents and 2 different document groups.
The column “Coded Segments” shows how many coded segments were found in each document.

“Overview of Documents” for a code

In the overview's head, the function Aggregate to document groups  is available. This function
aggregates the shown result from documents to document groups. It shows all document groups in
which the selected code appears. Taking the example above, after clicking the button, the table
consists of two rows with the document groups “Interviews New York” and “Interviews Indiana”. The
number of coded segments is summed up.
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Aggregating to document groups

Frequency Tables and Charts for Top-
Level Codes and Subcodes
MAXQDA can be used to analyze how frequently codes were assigned in selected documents. The
results can be presented as a table or chart. The analyses can refer to the top-level codes or the
subcodes of any parent code. The subcodes of lower levels can be included optionally.

Vertical bar chart view of selected code frequencies

How to analyze the frequencies of subcodes

Start the function Codes > Code Statistics > Subcode Statistics1.
The following dialog appears:2.
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Options window for subcode statistics

On the left side, all the top-level codes from the “Code System” are listed. Select one of the3.
codes by clicking on the arrow or by double-clicking on it. By clicking on the column headers,
the two lists can be sorted alphabetically.
Set the desired options on the right:4.

Unit of analysise
Documents – The number of documents in which the respective subcode was
assigned is output. This can be used, for example, to answer the question: “How many
cases mentioned a particular topic?”
Documents (count most frequent code only) – The number of documents in which the
respective subcode was most frequently assigned is output. This can be used, for
example, to answer the question: “In how many cases does a particular topic
dominate?”
Coded segments – The number of coded segments per subcode is output.

Aggregate subcodes – If this option is selected, not only the direct subcodes of the selected
parent codes will be considered in the analysis, but also of lower-level codes up to the
specified subcode level. All codes on lower levels will be aggregated to the parent code
during the analysis and only this code will be displayed in the results table.

If necessary, limit the analysis to the currently activated documents and codes by selecting5.
the appropriate option..
Start the analysis by clicking OK.6.

Tip: The function can also be called up directly in the “Code System” for each code (that has
subcodes) by right-clicking on a code and selecting Subcode Statistics. Using the context menu, you
can request the statistics functions for codes that are not at the top-level of the code system.
The results table

If one of the two options for “Documents” was selected for “Unit of analysis”, the results table will
contain the following rows:
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Code “A” Number of documents in which code “A” occurs.

Code “B” Number of documents in which code “B” occurs.

Code "C" Number of documents in which code “C” occurs.

not defined Number of documents in which there is no most frequent
code because several codes are most frequent.

DOCUMENTS with code(s) Number of documents in which AT LEAST ONE of the
evaluated subcodes occurs.

DOCUMENTS without code(s) Number of documents in which NONE of the evaluated
subcodes occur.

ANALYZED DOCUMENTS Total number of documents evaluated.

The “not defined” row is visible only if the “Documents (count most frequent code only)” option is
selected.

Frequency table for unit of analysis "Documents "

The “Percent” column considers all the analyzed documents, while the “Percent (valid)” column
considers the “Documents with code(s)” only.

If the option “Coded segments” was selected for “Unit of analysis”, the results table contains the
following rows:

Code “A” Number of coded segments with code “A”.

Code “B” Number of coded segments with code “B”.

Code “C” Number of coded segments with code “C”.

TOTAL Sum of coded segments

Toolbar functions

Chart view – Displays the results of the frequency table as a chart (this function is described in
detail below).
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Next/Previous – Switches to the previous/next results table if multiple parent codes have
been selected for the analysis.

How to analyze the frequencies of top-level codes

Instead of subcodes of a selected parent code, you can also request statistics for the top-level
codes: Codes > Code Statistics > Top-Level Code Statistics.

The options dialog corresponds to the dialog for subcodes explained above, except that no parent
codes can be selected on the left side.

The results table also corresponds to the table for subcodes.

Charts

Once you have switched to the chart view by clicking on the  icon, the results from the frequency
table are visualized as a chart.

Vertical bar chart view of selected code frequencies

Please note: The order of columns, bars, and segments is determined by row order in the frequency
table.

You will see two toolbars at the top of this window. The upper toolbar is the same as for the
frequency table, and you can switch at any time to the table view. On the right side of the lower
toolbar, you will see three buttons, with which you can choose between pie chart, horizontal, and
vertical bar chart. The chart can be customized using the options in the lower toolbar:

Display labels – show categorical labels of bar and pie charts.

Display absolute values – show absolute frequencies.

Display percentages – show relative frequencies.

Display decimals – if percentages are displays, the values are displayed with one decimal.
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Display missing values – show missing values category.

Display legend – show the legend, which is switched “off” by default in bar charts.

Display scale – show the scale axis in bar charts.

Display title – show diagram title.

Display text – show textual description of diagram.

Change color scheme - opens window for color scheme selection.

Set as default design for new diagrams - saves the current design and automatically applies this
design to new charts.

Apply current style to all created diagrams - applies the current style to all currently created charts.

Customizing chart captions, colors, and font sizes

Double-click on a bar or pie segment to overwrite the given color of the color scheme.
Double-click on the title, the description, or the category label to customize the text and its
font.
Double-click the text on axes to customize its font. For the size axis, the height of the axis can
also be determined.

Customize the chart view

Store results in a QTT worksheet

In the Questions – Themes – Theories window of MAXQDA, you can collect and comment on all the
important results of your project. In the upper right corner of the table or chart view, click on the icon

 Send to QTT Worksheet to store the results in a new or existing worksheet. The current display
will be saved as an image.

https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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Printing and exporting results

In the toolbar in the upper right corner there are three icons that can be used to export and print the
frequency tables and charts.

Tip: If you export a frequency table in Excel format, all currently created tables will be exported to a
file as one worksheet each.
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08 – Creative Coding

The Idea behind Creative Coding
During an open coding stage of their analysis process, researchers may create many codes which in
hindsight vary greatly in their scope and level of abstraction. Creative Coding effectively supports
the creative process in which these codes are generated, sorted, and organized, and in which a
hierarchical code structure is created based on the relationships between codes. The function
provides a large workspace on which you can move codes and form meaningful groups. You can
place codes that belong together next to one another, insert parent codes, rename codes, change
their color, and create a logical structure. Usually, however, this logical structure is the result of a
long period of open coding and working with the codes.

The functionality of Creative Coding is carried out in three steps:

First, drag the codes you want to work with from the "Code System" into the Creative Coding
workspace.
Next, group and organize the codes, create parent and subcodes, define new codes if
necessary, and change the color of the codes as desired.
Finally, transfer the changes to your existing "Code System".

Creative Coding is particularly useful for studys following a grounded theory approach.

Start Creative Coding and Select Codes
To start the Creative Coding process, click Creative Coding in the Codes menu tab. MAXMaps will
then activate Creative Coding Mode and the following workspace will appear:

https://www.maxqda-press.com/catalog/guides/doing-grounded-theory-with-maxqda
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Selecting Codes for Creative Coding

Now, single codes can be dragged from the "Code System" onto the blank workspace on the right
with the mouse. If you select a code with subcodes, MAXQDA will insert the subcodes automatically
onto the workspace.

You can select multiple separate codes by holding down the Alt key (Windows) or option key ⌥
(macOS) and then drag the selection onto the Creative Coding workspace while holding down the
mouse button. To select a range of codes, first click on a code and then click on a second code
while holding down the Shift key ⇧. This will also select all codes between the clicked codes.

To search for a code in a potentially very long code system, you can click on the magnifying glass
above the codes. There is also a sort icon to sort the codes within each hierarchy level by alphabet.
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Selected codes for Creative Coding

To remove a code from the workspace, right-click the code and select Remove from Map in the
menu tab Start.

After completing your selection, click the Start Organizing Codes symbol at the top left of the
screen.

Please note: While MAXQDA's Creative Coding Mode is activated, the MAXQDA application is
blocked and no further changes can be made to the open project until Creative Coding is finished.

Organize Codes
Once you have clicked on Start Organizing Codes on the Start menu tab, you can start structuring
and organization your codes. The display will change at this point; the "Code System" on the left will
close and a color panel appears that displays all of the colors currently in use in the project together
with the standard colors of MAXQDA.
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Organizing codes on the Creative Coding workspace

All codes can be freely arranged on the workspace with the mouse. You can move multiple codes at
once by drawing a border around them with the mouse and then positioning them as desired.

The following options are available in Creative Coding Mode:

Creating relationships between codes
Creating new codes
Merging codes
Modifying code colors
Undoing changes
Displaying coded segments and code frequency of a code

Please note: All changes made in Creative Coding Mode are not directly added to the "Code
System". The changes are added when Creative Coding is closed.

Creating connections between codes

As displayed in the image above, connections between codes are shown with an arrow: When an
arrow is pointing at a code, it means that this code is a subcode of the other.

To make Code A a subcode of Code B, proceed as follows:

Go into Link Mode by clicking the Link (Define as Subcode)  symbol on the Start menu tab.1.
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Alternatively, use the shortcut Ctrl+L (Windows) and ⌘+L (macOS) to activate/deactivate the
Link Mode.
Click on the desired top-level code and draw an arrow to the desired subcode.2.

To avoid the occurrence of circular references, existing assignments of the subcode to other codes
are removed.

To delete an arrow, right-click on it and select Remove from Map.

Adding new codes

Users often wish to group multiple codes under an abstract concept. For this purpose, you can
always create new codes by clicking the New code  symbol on the Start menu tab. MAXQDA will
subsequently insert the new code in the top left of the workspace.

You can rename the code by double-clicking on its label.

Merging codes

To merge two codes, proceed as follows:

Drag a code with the mouse button pressed down onto another code until the info box "Merge1.
codes" appears at the mouse cursor.
When you release the mouse button, a confirmation message will appear.2.
After clicking on Yes, the shifted code disappears from the map and its code assignments are3.
assigned to the target code.

If you have activated the display of the code frequencies, you can directly see that the number of
coded segments under the target code has increased. Since some segments may already be coded
with the target code, the frequency displayed may be less than the sum of the code frequencies of
the merged codes. The merge is provisional until you quit Creative Coding, thereby updating the
code system. Then the coded segments are assigned to the target code and the source code is
deleted in the code system.

If you choose Don’t ask again, the inquiry for the merging of codes will no longer appear in the
current Creative Coding session.

Of course, both codes may include a code memo. In this case MAXQDA will ask you how to deal with
the memo content of the moved code.

Changing the color and appearance of codes

The color of codes can be modified as follows:

First, make sure that the Link Mode is off. If necessary, click on the white surface once to turn1.
off Link Mode.
Click the code whose color you wish to change. To select multiple codes at once, draw a2.
border around the codes with the mouse or click on each code while holding the Ctrl key
(Windows) or ⌘ key (macOS).
To assign a color, click on a displayed color in the color panel on the left or click on Choose3.
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new color… to select another one.

If you change the color of a parent code, the color of the subcodes will also be changed following
confirmation.

As soon as you select one or more codes, the Format menu tab appears at the top of the window.
You can use this tab to adjust the way the codes are displayed, for example, to enlarge the caption
and make it bold.

Undoing changes

Recent actions can be undone step-by-step by clicking the Undo Changes  symbol in the top right
corner of the user interface.

Displaying the code frequency and coded segments of a code

In order to organize codes, it can be helpful to visualize the amount of associated coded segments.
By clicking the Code Frequencies symbol on the Start menu tab, the code frequency will be
automatically displayed in brackets after the code name.

When you right-click on a code, a context menu will appear from which you can access the following
options:

Memo – Opens the associated code memo.
Overview of Coded Segments – Opens a tabular overview, in which you can inspect the
coded segments of the code.
Overview of Linked Memos – Opens a tabular overview in which you can browse all memos
of the selected code.

Saving the current state of the process as a MAXMap

Working on the code structure with Creative Coding may take some time and may include different
stages of development. While you start with arranging codes in groups first, you possibly are
merging codes and creating new higher-level codes later on. To track these different stages,
MAXQDA allows you to save the current status of your work as a regular MAXMap: just click on Save
as a Map in MAXMaps on the Start menu tab. The map will be available after quitting Creative
Coding when you start Visual Tools > MAXMaps from the main menu.

Quit Creative Coding and Transfer
Changes to Code System
Changes made in Creative Coding Mode will be applied to the “Code System” window only once you
quit Creative Coding. To do this, click the Quit Creative Coding symbol on the Start menu tab in
the top left of the window. The following message will appear:
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Quit Creative Coding

The following options are available:

Yes – the code structure will be transferred to the existing Code System

All codes from the Creative Coding workspace that do not have a parent code will be sorted
alphabetically and inserted at the top of the Code System. This applies also to newly created
codes.
Subcodes will be inserted according to their hierarchical position.
Any color changes to codes will be applied.
Merged codes will be merged, i.e. the origin code will be deleted and its coded segments will
be moved to the target code.
The Creative Coding map will be converted into a normal MAXMap.

No – Creative Coding will be closed without applying the changes to the "Code System". This means
all changes will be lost!

Cancel – returns to Creative Coding.
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09 – Transcription

Transcribe Automatically
Using MAXQDA, you can automatically transcribe your audio and video recordings of interviews,
focus groups, and conversations. Automatic transcription eliminates the need for tedious typing and
takes significantly less time than manual transcription, as you only need to review the automatically
generated transcript for accuracy. When reviewing the transcript, you can jump right into analysis
and make initial notes in memos and start coding the text.

Privacy Notice: Our automatic transcription process complies entirely with GDPR standards, utilizing
a server located in the Netherlands, EU. Your media files are exclusively used for transcription
purposes and are promptly deleted from the server post-transcription. Generated transcripts are
hosted on a German server and are automatically removed after download.

Preparation

To use automatic transcription, you need a MAXQDA license for which the AI Assist add-on has been
included, a MAXQDA account, and a quota of transcription time:

1. Get AI Assist

If you have a MAXQDA 24 license with AI Assist Free or Premium included, you can skip this step.
(Within MAXQDA, you can check if you have access to AI Assist: right-click on a document in the
Document System or a code in the Code System - if there is an option AI Assist, you have access.)

If you have a MAXQDA 24 license without AI Assist, log into your Subscription Manager to purchase
AI Assist Premium and add it to your MAXQDA license. Alternatively, you can go to this webpage to
add the free version of AI Assist to your license, because for transcription, you don't need the
Premium features of AI Assist.

If you do not have a MAXQDA 24 license yet, you can buy one in the shop. Please ensure to add the
free or premium AI Assist add-on to your shopping cart.

2. Get MAXQDA Account

Create a free MAXQDA account on this website if you do not already have one (if you created a
TeamCloud account in the past, it was automatically converted to a MAXQDA account and you can
skip this step).

Tip: Upon creating your MAXQDA account and visiting the transcription webpage, you will receive a
one-time offer of 60 free minutes for transcription, allowing you to extensively test the automatic
transcription for your data.

3. Purchase Transcription Time

On this website, you can purchase transcription time. You will then receive a code via email, which
you can use to credit the purchased hours directly to your MAXQDA account later within MAXQDA.

https://mya.maxqda.com
https://www.maxqda.com/activation-ai-assist#fndtn-ai-check-sn
https://www.maxqda.com/pricing
https://teamcloud.maxqda.com
https://www.maxqda.com/shop/maxqda-transcriptions-package
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Transcribe automatically within MAXQDA

Note: Please note that the maximum size for media files is 1 GB. If your file exceeds that limit, you
can compress ist externally. In case of large video files, you can extract the audio track for
transcription.

Step 1: Import Media File

To automatically transcribe an audio or video file, first import it into a MAXQDA project. This can be
done most easily by dragging the file into the "Document System" in MAXQDA with the mouse.
Alternatively, you can use the Import > Audio or Import > Video function from the menu. Detailed
information on importing audio and video files can be found here.

As soon as an audio or video file is imported into a MAXQDA project, the following selection dialog
appears:

Selection dialog after imoprting a media file

Click the Transcribe button.

Have you already imported your audio or video file into a MAXQDA project? If so, right-click on the
document name in the "Document System" and select Transcribe Audio/Video File > Transcribe
Automatically with "MAXQDA Transcription" from the context menu.

Step 2: Select Transcription Options

The following dialog will appear, allowing you to configure transcription settings, purchase time
packages and redeem codes for previously acquired time packages:
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Settings for automatic transcription

Under the Language option, select the appropriate language of your media file. Incorrect language
selection can lead to inaccurate automatic transcription. Note that automatic transcription is not
feasible for recordings featuring multiple languages.

In the Add your own vocabulary section, you can enter specific words and phrases that are unique to
your recording but uncommon in general usage. Adding custom vocabulary improves recognition
accuracy for technical terms and guides MAXQDA Transcription on how to transcribe them. For even
greater precision, you can indicate the pronunciation of a word or phrase in brackets, for example,
"NGO (en.ge.o.)".

MAXQDA Transcription can handle these file formats: AAC, FLAC, M4A, MP3, MP4, OGG,
WAV. Convert your file to one of these formats before importing them into MAXQDA.
The media file must be no larger than 1 GB.
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If your file is in an unsupported format or exceeds the size limit, you will see a notification in
the dialog, and you cannot start transcription.

Step 3: Start Transcription

Click on the Transcribe button to initiate automatic transcription. A notification at the bottom right
corner of the MAXQDA window will inform you that the transcription is in progress.

The transcription process takes about one-third of the media file's duration. Therefore, a one-hour
interview will approximately require 20 minutes to transcribe. You can continue using MAXQDA
during transcription, for instance, importing more data, and even start another transcription if
needed. If you have imported multiple media files at once, the settings dialog will appear for each
file.

Step 4: Review the Transcript

Once the transcription of a media file is complete, MAXQDA will notify you, and the transcript will be
automatically saved in the corresponding text document. If the text document already contains text
(for example, because you have started manual transcription or included notes in the document), a
copy of the text document will be created. For differentiation, MAXQDA adds "(Transcript)" to the
name of the copied text document.

You can close a project during automatic transcription, and the process will continue in the
background. Upon reopening the project, all completed transcripts will be automatically imported.

Imported transcript in MAXQDA - click on the pencil icon in the top right corner to start Edit Mode which allows you to edit the
automatically created transcript

To review your transcript for accuracy, you can switch on Edit Mode in the Document Browser by
clicking on the pencil icon at top right (as shown in the image).

To play the audio recording, click on the play icon next to the transcript's name in the Document
System or in the upper toolbar in the Document Browser window. If you click on a timestamp in the
"Document Browser" (one of the watch icons), MAXQDA will play the associated segment.

Speakers are abbreviated with S1, S2, etc. To change their names, switch on Edit Mode, and search
and replace S1 with your preferred name for S1, and so on.

https://www.maxqda.com/help-mx24/viewing-and-editing-data/edit-text-tables
https://www.maxqda.com/help-mx24/viewing-and-editing-data/edit-text-tables


  221

Search and replace speaker names

How are pauses transcribed?

Pauses are transcribed using dots in brackets for short pauses and numbers in brackets for longer
pauses:
1 second pause: (.)
2 seconds pause: (..)
3 seconds pause: (...)
4 seconds pause: (4)

How do you get the best results with automatic transcription?

Ensure high audio quality with minimal background noise.
In group recordings, ensure all speakers are audibly clear.

Which languages are supported?

MAXQDA Transcription supports almost 50 languages:

English (AUS, UK, US) German Polish

Arabic Greek Portuguese
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Basque Hindi Romanian

Belarusian Hungarian Russian

Bulgarian Interlingua Slovakian

Cantonese Italian Slovenian

Catalan Indonesian Spanish

Croatian Japanese Swedish

Czech Korean Tamil

Danish Latvian Thai

Dutch Lithuanian Turkish

Esperanto Malay Uyghur

Estonian Mandarin (simplified,
traditional)

Ukrainian

Finnish Marathi Vietnamese

French Mongolian Welsh

Galician Norwegian Polish

Rather transcribe manually?

Consider using MAXQDA's manual transcription over automatic when:

You want detailed transcripts capturing nuances like emphasis, interactions, interruptions,
emotions, or filler words.
The audio quality is too poor for accurate automatic transcription.
Speakers use challenging dialects, or multiple languages are present in a recording.
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Transcribe automatically using the transcription webpage

We recommend that you perform automatic transcription directly within the MAXQDA interface. This
is the most convenient way to handle the process and ensures that the transcripts are automatically
linked to the corresponding media files. Alternatively, you can use the MAXQDA Transcription
website to transcribe your media files:

Step 1: Start the automatic transcription

Open MAXQDA Transcription Webpage and log in to your MAXQDA account if you are not1.
already signed in.
Upload your audio and/or video files to the transcription page.2.
In the settings dialog, as described above for the dialog in MAXQDA, you can select the3.
language and enter your own vocabulary.
Start the transcription by clicking on the Start transcription button.4.

Step 2: Download transcripts

Once the transcription job is complete, you can download the transcripts by clicking the1.
Download Transcript button.
You will find the transcripts in your Downloads folder under the same name as the media file,2.
but now in Word's DOCX format.
Your transcripts will be deleted automatically 7 days after you downloaded them first. By3.
clicking on the trashbin, you can delete a transcript anytime within the 7 day period manually.

Step 3: Import transcripts into MAXQDA

You can import the downloaded transcripts into an open MAXQDA project as follows:

Drag the Word document with the transcript from the Windows Explorer or Mac Finder directly1.
into the Documents window.
Alternatively, select Import > Transcripts > From MAXQDA Transcription in the tab menu.
MAXQDA will prompt you to import the associated audio or video file into your project. If you2.
agree, select the media file and MAXQDA will synchronize it with the transcript using the
embedded timestamps.

You have already imported an audio or video file and want to attach a downloaded transcript now?
No problem: simply right-click the media file in the "Documents" window and choose Import Existing
Transcript from the context menu.

Transcribe Manually
If you do not want to automatically transcribe your audio or video file using MAXQDA Transcription,
you can transcribe it manually with MAXQDA.

To get started with your transcription in MAXQDA, you must first import the audio or video file into
your project. To do this, simply drag the file into MAXQDA’s “Document System” window with your
mouse. Alternatively, go to the Import menu tab and click on the Audio or Videos icon (for more

https://teamcloud.maxqda.com/transcriptions
https://www.maxqda.com/help-mx24/transcription-audio-video/automatic-transcription
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details on import, see here).

Please note: During import of a media file, you will be asked if you want to transcribe it
automatically. Select Import only in this dialog. After the import, the media player will open - you can
close it since you don't need it now.

When importing a recording, an empty text document is created in the "Document System", to which
the audio or video file is assigned and in which you can write the transcript. In the "Document
System", you can recognize text documents with an associated media file by a play icon that is
displayed next to their name:

Media file in the “Document System” window

Activating Transcription Mode on

To start transcription, right-click on a document name and select the option Transcribe Audio File >
Transcribe Manually or Transcribe Video File > Transcribe Manually.

https://www.maxqda.com/help-mx24/import/inserting-audio-and-video-files-in-a-maxqda-project


  225

Start manual transcription by right-clicking a document

This activates MAXQDA’s Transcription Mode, in which the windows you need for transcription are
optimally arranged:

The "Multimedia Browser" is displayed and placed at the top of the screen.
The "Document Browser" is displayed directly below – here you can write your transcript.
A dialog window is displayed to the left of the "Multimedia Browser" where you can adjust all
your settings for the transcription.

Transcription Mode
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Starting the transcription process

Now you can play the recording and start writing. To play and pause,

press F4 or F5,
or press Ctrl (Windows) or Shift ⇧ (macOS) twice in succession (this way you don't have to
move your fingers very far).

To quickly navigate to a certain spot in your media file, use the slide control in the “Multimedia
Browser” window or use the keyboard combination F12 and ⇧+F12 to forward or rewind 5 seconds.

Tip: How to use the function keys for transcription on a Mac is described in our Frequently Asked
Questions.

The transcript and the recording are linked to each other using time stamps. For detailed
information on using time stamps, see this section.

The transcription text is stored automatically in the project file every 5 minutes. You can change this
time interval in the global settings of MAXQDA. To access the settings, click the settings icon at the
bottom left corner of the MAXQDA main window.

Adjusting the rewind interval, volume, and playback speed

A rewind interval of 2 seconds is set by default, so you can continue your flow when you resume
playback. You can adjust this interval at any time, to a time between 0 and 10 seconds, in the
Transcription Settings.

Tip: You can close the Transcription Settings window if you don't need it. You can open it at any time
by clicking on the Transcription Settings icon on the left side of the “Multimedia Browser”.

Open transcription settings and the control panel

To adjust the volume and playback speed, click the Control Panel icon in the “Multimedia Browser”.
The following dialog window will appear, which allows you to adjust the volume and speed of
playback.

https://www.maxqda.com/faq/b-9-can-use-f4-transcription-maxqda-mac-os-x
https://www.maxqda.com/faq/b-9-can-use-f4-transcription-maxqda-mac-os-x
https://www.maxqda.com/help-mx24/transcription-audio-video/timestamps-to-link-transcripts-with-sound
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Adjust the volume and speed of playback in the Control Panel

Automatic speaker change

When transcribing a recording with two speakers, you can switch on the automatic speaker change
in the Transcription Settings. As a result, each new paragraph begins automatically with a freely
definable name, pseudonym, or abbreviation.

Follow these steps:

Select the option Automatic speaker change in the Transcription Settings dialog window.1.
Enter names for each speaker. It's a good idea to add a space at the end too.2.
Select the Bold option if you want the speaker names to be emphasized.3.
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Transcription Settings

If "Q:" and "R:" are entered for the names of the two speakers, as shown in the figure above, the next
name will be entered automatically for each paragraph change in the transcript, saving you a lot of
typing.
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Automatically entered “I:” and “R:”

Autotext

In the Transcription Settings, you can also define abbreviations that are automatically replaced with
text when two spaces are entered after the abbreviation. This is particularly useful if you are
transcribing a group discussion with several speakers, as the the names of the participants can be
replaced with shortcuts, saving you a lot of typing. Likewise, you can also use frequently recurring
and difficult to type transcription elements with brackets, for example, "(unintelligible)" or "(2)" for 2
seconds pause as autotexts.

The autotexts shown in the following image are defined by default for all new MAXQDA projects. The
abbreviations can be up to three letters long.

Autotexts make transcribing easier

You can use the Bold setting in the last column to control whether the text is inserted in boldface.

The autotexts are stored in your project, so that you can also use different computers with MAXQDA
installed for transcription without having to re-enter your required autotexts.

A total of 15 autotexts can be stored. The entire autotext function can be switched off by
deactivating this option in the Transcription Settings.
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Coding while transcribing

You can code the typed text with new or existing codes as you transcribe. To do this, select a text
segment, for example, and drag it to a code in the "Code System".

All the usual features of the “Multimedia Browser” are also available. This allows you to highlight
and code sections, set memos and internal links directly in the audio or video file. For detailed
explanations on how to use the “Multimedia Browser”, please see the section for coding videos.

Stopping and resuming the transcription

You can start and stop Transcription Mode at any time – just close the “Multimedia Browser”.

To resume working on a transcript, right click on the document and select Transcribe Audio File or
Transcribe Video File.

Transcribing with a foot pedal

For faster and easier transcription, MAXQDA supports the following foot pedals from
Audiotranskription:

The yellow “Science” switch has the same functionality as the F4 or F5 key (depending on the
software setting inside the foot pedal): press once to play, and a second time to stop.
The black “Science II” switch must be held down to play media data and will stop playing
when released.
The "Office" footswitch has three buttons: Press the left button to rewind 5 seconds, the right
button to fast forward 5 seconds. Press and hold the middle button to playback the media file
and release to pause playback

Tip: The "Office" footswitch is the same as Infinity's popular 3-button footswitch.

Link Transcript to Recording with
Timestamps
With timestamps you can link your transcript to the original recording so that you can always access
the original sound and listen to sections that are difficult to understand or that need more attention.

When transcribing manually in transcription mode, MAXQDA automatically inserts a time marker by
default after a paragraph, i.e. usually between two speech contributions. The timestamps appear in
a separate column in the “Document Browser”, left to the transcription text.

https://www.maxqda.com/help-mx24/analyzing-videos/code-videos
https://www.google.com/search?q=infinity+usb+foot+pedal
https://www.maxqda.com/help-mx24/transcription-audio-video/transcription-mode
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Timestamps in the “Document Browser”

Please note: You can hide the display of the timestamps next to the transcript by right-clicking the
text and de-selecting Display Timestamp Column.

Clicking on a timestamp (or the range between two timestamps) opens the associated media file
and starts playback at the stored position. Playback automatically ends at the next timestamp.

Automatic insertion of timestamps during manual transcription can be deactivated in the
Transcription Settings window.

Add timestamps manually

While transcribing manually, you can also manually insert timestamps into a transcript, such as to
mark a difficult to understand section:

To do this, click on the New timestamp icon in the “Document Browser”,
or press F6.

Add timestamps in current position

MAXQDA then inserts a timestamp where your cursor blinks in the text and visualizes it in the time
stamp column at the left margin. You can also create multiple timestamps in a row, but only one
timestamp is displayed in the timestamp column.
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Timestamps can't be inserted arbitrary; instead, MAXQDA checks whether the chronology of the
timestamps is maintained when trying to insetrt a timestamp. For example, if the current playback
position of an audio file is at 3 minutes, but there is already a timestamp at 4 minutes in before the
current text position, you cannot add another timestamp.

Please note: New time stamps can be inserted not only during transcription (i.e., in Transcription
Mode), but also later by switching on the Edit Mode in the "Document Browser". This can be helpful
in the following cases:

After transcription, an important passage of text was identified where access to the original
sound should be possible.
A transcript was imported without timestamps, and the timestamps automatically set during
import need to be added or changed.
An incorrectly set timestamp needs to be moved around.

Delete timestamps

To delete an unnecessary timestamp, click on the symbol in the timestamp column with the right
mouse button and select Delete Timestamp in the context menu.

There is also an "Overview of Timestamps", which lists all timestamps of the currently opened
transcript. You can open the overview by clicking on the icon with the same name at the top of the
“Document Browser”. In the overview, you can delete timestamps by marking one or more rows and
clicking the delete icon.

The “Overview of Timestamps” lists all the timestamps in a transcript

Play Transcript and Recording
Synchronously
MAXQDA allows you to play an audio or video file at the same time as the transcript. You can view
media files synchronized to their transcribed texts, like a teleprompter for a television presenter, or
karaoke, in which you can read the text along to the sound playback.

https://www.maxqda.com/help-mx24/viewing-and-editing-data/edit-text-tables
https://www.maxqda.com/help-mx24/transcription-audio-video/the-overview-of-timestamps
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To start a synchronized playback, follow these steps:

Quit the Transcription Mode if it is still switched on.1.
Open the transcript by double-clicking on the document name in the “Document2.
System”. This will display it in the "Document Browser" window.
Click on the Sync Mode symbol in the “Document Browser” toolbar.3.

Activate Sync Mode in the “Document Browser”

Open the “Multimedia Browser” by clicking on the play icon, also found in the “Document1.
Browser” toolbar.
Start Playback using the Play symbol in the “Multimedia Browser” or the F4 key.2.

If you change the playback position with the slider in the “Multimedia Browser” or if click anywhere in
the media file, the transcript jumps to the corresponding text point.

The Overview of Timestamps
The “Overview of Timestamps” lists all timestamps in the currently opened transcript. To open this
overview, click on the icon of the same name in the "Document Browser" toolbar.
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Open the “Overview of Timestamps”

The “Overview of Timestamps” has as many rows as there are timestamps in the document, and
every row has several columns. The first two columns contain the start and end points of that
segment. In the third column, you have the option of writing in a short comment about that particular
segment. The “Duration” column provides the length of the respective segment.

The “Overview of Timestamps”

This “Overview of Timestamps” table and the “Comment” column both function just like any other
MAXQDA table. You sort the order of comments or search for a comment.

Tip: To search for a comment, right-click on the “Comment” column header and select Search.

The option to write your comments in the list of timestamps also gives you a new way to find
sections of your media file. You can use comments to organize and quickly access certain sections.
Double-clicking on a row takes you to that section of the text in the “Document Browser” and starts
playback of the media file from that point.

Please note: Each transcript to which a media file is assigned contains at least one timestamp at
position 0, the beginning of the document.
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10 – Memos

About Memos
MAXQDA makes it possible to create your own notes and remarks and to attach them like post-it
notes to text passages, texts, document groups, images, audio/video clips and of course codes. In
MAXQDA these remarks are called "memos". Such a memo can contain very different things: While
one memo contains a short summary of an interview or hints for its course, another memo contains
first ideas for theory development or hints for the use of a developed category.

Especially in social science it is common to work with memos and there it is above all the research
style of Grounded Theory developed by Glaser and Strauss in which memos play an important role.
But regardless of the research method chosen, it is important to clarify the difference between the
memos and the qualitative data: The qualitative data are processed and analyzed but are usually not
significantly changed once the evaluation and coding has begun - at best, typos are eliminated.
Memos, on the other hand, are a dynamic type of text, they are products of the users and can be
changed, supplemented, modified, and integrated at any time.

Please note: The difference between memos and coding comments is explained in this research
blog article.

In MAXQDA you can assign memos in numerous places:

„Document System“ • Documents
• Documentgroups
• Documentsets
• Root of the Document System

„Document Browser“ • Segments in texts, spreadsheets and images

„Multimedia Browser“ • Positions in audio and video files

„Code System“ • Codes
• Codesets

https://www.maxqda.com/memos-comments-paraphrases-summaries
https://www.maxqda.com/memos-comments-paraphrases-summaries
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Memos in the MAXQDA User Interface

There is also a memo type, the "free memo", which is not directly assigned to a position in the data,
nor to a document or code. Such memos also exist in the research style of Grounded Theory, they do
not belong to a certain original text, but exist freely floating without concrete assignment.

Opening and Editing Memos
To view and edit an existing memo, double-click the yellow memo icon with the left mouse button
and the following memo window will appear.

In the upper area of the memo, you can assign a meaningful memo title - just click on the bold title
with the mouse. A memo title may contain up to 127 characters. In the upper right corner MAXQDA
shows when and by whom the memo was last edited. Hold the mouse cursor over this information
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to see who originally created the memo.

The actual memo is written into the large text window:

At the top, there is a toolbar for formatting the text, so you can create enumerations and
numbers, for example.
By clicking on the icon, you can prepend the creation date to a new entry.
A table can be inserted by right-clicking in the text window and selecting Insert Table.

Tip: If you want to use parts of a text opened in the “Document Browser” in a memo as a quote, you
can select a text passage and drag it into the memo by holding down the mouse button. By default,
MAXQDA automatically adds the document name and the position of the inserted text as source at
the end of the text.
Saving memo content

MAXQDA is saving all entered information and changes to a memo when closing the window. In
addition, the memo window will be saved regularly, and you can adjust the time interval in
MAXQDA’s global settings. The default setting is 5 minutes.

Memo symbols

You can assign either the yellow standard post-it symbol or one of eleven other symbols to each
memo. This makes it possible to indicate what kind of memo it is.

By clicking on the cogwheel symbol in the memo window, you can record the meaning of each
memo symbol in the current research project. The so-called “memo labels” are saved on a project-
by-project basis, i.e., different memo labels can be defined in different project files.

Define memo labels by clicking on the cogwheel symbol in the memo window

Each user can assign the symbols to specific memo types as desired. For those who work according
to the Grounded Theory method, it is recommended, for example, to use the symbol T for theory
memos, M for method memos, and the question mark for memos that refer to the further collection
of data (theoretical sampling).

Tip: By moving the mouse over a yellow memo symbol in MAXQDA, a small information window
appears with the title of the memo, the last modification date, if defined the assigned label for the
memo type as well as the beginning of the memo text.

Deleting memos

To delete an open memo, click on the red "X" at the top right of the window.

Tip: You can also delete a memo on the spot by right-clicking the memo icon and selecting Delete
Memo.
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Copying memos

You can duplicate a memo by right-clicking the memo icon and selecting Copy Memo. Click again
with the right mouse button on a place in MAXQDA where you can place a memo - e.g., in the memo
column in the "Document System" - and select the option Paste Memo here.

Print and export individual memos

To print an open memo, click the Print  icon in the toolbar at the top of the memo window.

To export an open memo, click the Export  icon at the top of the memo window. In the dialog box
that appears, you can select export format (DOCX, HTML, or PDF) and the contents to be exported.
For example, you can include the codes linked to the memo in the export.

Options for exporting a memo

Opening Multiple Memos at Once
You can double-click several memo symbols one after the other to open each memo in its own tab.
The tab display makes it possible to quickly switch back and forth between different memos. A click
on the symbol "x" in the tab line closes the currently displayed memo.

Multiple open memos in tab display

Tip: Click the Undock window
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symbol to pull individual tabs out of the memo window, so you can view multiple memos at the
same time, each in their own Memo window.

Memos in Documents
Memos can be attached to any text or image position similar to sticky notes in a book or article:

You can create memos in documents like this:

In the document, select an area to which you want to assign a memo, e.g., a text passage that1.
is interesting for theory or contains contradictory content.
Right-click the selected segment and choose Insert Memo for Selection from the context2.
menu.

Create a memo for a selected text segment

The memo window in which you can write your memo appears. MAXQDA automatically assigns the
memo title “Memo x” to new in-document memos, where x stands for a consecutive number. You
can change this title at any time by clicking on it with the mouse.
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In-document memo

After closing the memo, the selected memo symbol appears to the left of the document in the so-
called “Memo column”. If the sidebar is switched on, the memo text is also displayed to the right of
the document.

Memo icon in the memo column (left) and displayed memo in the sidebar (right)

To reopen the memo later, double-click on the memo icon in the left memo column or on the memo
display in the right sidebar.

Please note: If you turn on Edit mode and delete a text passage to which a memo is assigned, the
memo is retained and automatically assigned to the previous text. This feature is designed to
prevent valuable notes from being deleted unintentionally.

Creating memos by double-clicking in the memo column

You can also create a memo directly in the memo column to the left of the text at any time: Double-
click at desired document position to attach the memo.
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Create a memo by double-clicking on the memo column

When creating a memo by double-clicking in the memo column, the memo is automatically attached
to the document position at the click position on the left margin.

The number of memos per document and per document location is not technically restricted, i.e.,
you can create several memos at the same height in the “Document Browser”. MAXQDA then
automatically displays them next to each other, the memo column width is automatically adjusted.

Modifying document position of a memo

You can adjust the assignment of a memo to a text or image section any time:

Select the area to which you wish to assign the memo.1.
Right-click the memo icon in the memo column in the “Document Browser” and select Attach2.
Memo to Current Selection.

Displaying memos in the sidebar

In the sidebar to the right of the document, you can display memos, paraphrases, and comments on
coded segments. To display the sidebar, you can either

right-click in a document and select Sidebar > Memos or
click on the small icon Show Sidebar in the upper right corner of the "Document Browser".

Display memo in sidebar
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The contents of the memos are displayed in the sidebar at the height of the corresponding text or
image segment. Since memos can be very long, only one memo at a time is displayed in the sidebar;
the blue arrow icons within the yellow memo indicator jump back and forth to the next or previous
memo. The memo content displayed is limited to 2,000 characters, corresponding to about three
quarters of a page of text.

Displaying memos in the "Document Browser" is interactive:

Click a memo icon in the left memo column once to highlight the corresponding text or image
segment and display the memo content in the sidebar.
Double-click the memo icon in the left memo column or the sidebar to open it for editing.
When you hover the mouse over a memo in the right sidebar, the corresponding text or image
segment will be highlighted.

In the sidebar, in addition to the memos, the paraphrases of the document or the comments of
coded segments can be displayed, but not both at the same time. If you right-click on the sidebar
(not on a memo, but on the grey background area), a context menu will appear in which you can
specify which content should be displayed in the sidebar.

Manage sidebar's displayed content

Memos in the Document System Window
Memos can be assigned at all levels in the "Document System" window, i.e., the individual
documents, the document groups, the document sets, and also to the root of the document tree.
Unlike positions within a document, only one memo can be assigned to each object.

There are several options for creating a new memo in the “Document System”:

Right-click on a level of the Document System and select the Memo option from the context
menu.
Alternatively, you can create a memo for the currently selected document or level using the
keyboard shortcut Alt+⇧+M (Windows) or ⌥+⇧+M (mac OS).
The fastest way to create a new memo is to double-click in the memo column to the left of
the code frequencies.
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Creating a memo for a document via the context menu

The appearing memo window is exactly the same as for other memos. As title, the new memo
automatically uses the document name, which can be changed at any time by clicking on the title.

Whether a document or a document group has a memo is visualized in the "Document System" by
the selected memo symbol.

Visualization of a memo in the “Document System”

The memo in the first row of the window, the so called “project memo”, can be used to enter a
description of the whole project. The memos of individual documents can be used, for example, to
save a summary of the text that is always immediately accessible. One should also consider that
when moving the mouse over a memo symbol, an information window appears containing the first
lines of the memo text. It is therefore a good idea to start the memo with some important
information

Document summaries

Each document of a MAXQDA project can be assigned a memo in the “Document System” window,
the so-called “document memo”. These memos offer an additional text field at the bottom in which a
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summary for a document can be recorded, called the “document summary”. Here, for example, you
can write down the most important contents of an interview, while the memo text is used for notes
on the interview situation.

Document summary in a document memo

If you have created case overview tables with thematic summaries using the Analysis > Summary
Tables feature, you can use the document summaries in the memos for an integrative case
summary. For this purpose, the summaries of a case are consolidated in condensed form in the
document summary.

For more information on working with summary features in MAXQDA, refer to the chapter
Summarizing.

Code Memos
You can write a memo for each code. Code memos can be used, for example, to retain the definition
of a category, including anchor examples that illustrate the meaning of the category using original
quotations. If you work according to the research style of Grounded Theory, you can record all
thoughts about the concept or category in a code memo.

You also have the capability to create a memo specifically for the code system. This feature enables
you to store crucial information or coding guidelines that apply to all your codes.

There are several options for creating a new memo in the "Code System":

Right-click on a code and select Memo from the context menu.
Alternatively, you can create a memo for the currently selected code using the keyboard
shortcut Alt+⇧+M (Windows) or ⌥ (option)+⇧+M (mac OS).
The fastest way to create a new memo is to double-click in the memo column to the left of
the code frequencies.

https://www.maxqda.com/help-mx24/summary-grid/idea-behind-summary-grid
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Creating a code memo

The appearing memo window is exactly the same as for other memos. As title, the new memo uses
the code name, which can be changed at any time by clicking on the title.

Please note: If you change the name of a code in the “Code System”, MAXQDA will automatically
change the memo title if you have not already entered a different title than the code name.

After closing the memo, you will see a yellow memo symbol next to the code in the “Code System”,
making it easy to recognize that this code has a memo attached to it.

Tip: For code memos, you will often want to insert an example quote from the data to illustrate for
which parts of the data the code should be used. To insert parts of a text opened in the “Document
Browser” in a memo, simply highlight the desired text, then drag and drop it into the memo with the
left mouse button.
Code summaries

Code memos offer an additional text field at the bottom, titled “Code summary”. While the upper
memo text is typically used for a definition and rules for the use of the code, you can record
important contents of the associated coded segments in the lower code summary.
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Write a code summary in a code memo

If you have created case overview tables with thematic summaries using the Analysis > Summary
Tables function, you can use the code summaries in the memos for an integrative summary of the
respective topic or aspect. For this purpose, the summaries of a code are combined across cases
and in condensed form in the code summary.

Example: For 10 interviewees, you have written summaries capturing their typical workday. In the
code summary, you can integrate and consolidate the information in these summaries, into one text
– write a summary of the summaries, so to speak.

For more information on working with summary features in MAXQDA, refer to the chapter
Summarizing.

Free Memos
Free memos are neither directly assigned to a position in the data nor to a document or code. They
are, so to speak, free-floating and are suitable, for example, for recording general notes on the
research project, thoughts on the development of an object-related theory, or ideas for analysis.

It is possible to create a new free memo in different places:

Main window of MAXQDA: click on New Free Memo in the Memos tab.
Memo Manager: click on New Free Memo in the Start tab.
"Overview of Memos": click on the New Free Memo icon in the toolbar.

https://www.maxqda.com/help-mx24/summary-grid/idea-behind-summary-grid
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The memo window for free memos is identical to all other memos in MAXQDA.

To access your free memos later, you also have various options at your disposal:

By clicking on the Free Memos icon in the Memos tab, all free memos of the project are
opened in the Memo Manager, where you can conveniently view, manage, edit, merge, or
differentiate between the free memos.
Alternatively, you can use the Memos tab to call up the “Overview of Memos” table with all
memos of the project, which also contains all free memos.

The Memo Manager
The Memo Manager provides a clearly structured working space for the memos of a project, in
which you can manage numerous tasks around your memos:

The remarks for a selected case (in the form of in-document memos) or all category
definitions (in the form of code memos) can be reviewed, edited, adjusted, and integrated.
The Memo Manager is the ideal place to work with free memos that are neither directly
assigned to a location in the data nor to a document or code.
Various sorting and filtering functions provide easy access to memos, for example memos
written by a specific person or at a specific time.
Memos can be organized into a group, a so-called "set".

The Memo Manager is opened via the Memos tab. After clicking on one of the memo types, the
following view appears:

https://www.maxqda.com/help-mx24/memos/the-memo-manager


  248

The Memo Manager

The Memo Manager is divided into two parts: on the left, the memos are listed in a tree structure, on
the right, the memo currently selected in the tree is opened. In the image above, the item “In-
Document Memos” is selected in the tree, therefore all in-document memos of the project including
a preview are listed on the right side.

Opening Memos

To open a memo in the Memo Manager, click on it in the tree view on the left with the mouse. On the
right side, the memo content will appear; as soon as you click into the memo content with the
mouse, MAXQDA automatically switches to the Format tab, where you have numerous options for
formatting the memo.

Memo opened in the Memo Manager

By checking the Open in Tabs option (in the toolbar on the left side of the window), each additional
memo you click on the left side will be opened in a new tab, while the memos already opened will
remain open in their own tab.

Tip: You can detach individual memos from the window and display them in a separate one.

To open all memos of a document in tabs simultaneously, right-click the document on the left side
of the window and select Open Memos. The option Open Memos in New Window is also available
here, which will open all memos of a document in a separate memo window outside the Memo
Manager.
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Display and hide different types of Memos

On the Start tab, all memo types of MAXQDA are listed, with the number of memos of this type
currently available in the project displayed in brackets. Click on one of these icons to display or hide
the respective memos in the Memo Manager.

Only in-document memos are displayed

You will usually only want to work with one memo type at a time, but in principle it is possible to
display all memo types at the same time. The names of the different memo types are self-
explanatory, but it should be noted that “In-Media Memos” refer to the memos assigned to an audio
or video file in the "Multimedia Browser".

Sorting and filtering Memos

In the left window, you can set how the memos are to be sorted in the tree view at any time in the
toolbar at the top:

Options for sorting memos

You can use the first two icons on the toolbar to reduce the selection to the currently activated
documents and the currently activated codes.

The third icon will open the following filter dialog:
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Set filters for memos

Last edited by allows filtering by users who last worked on the displayed memos.

Last edited allows filtering by the date of the last edit, with MAXQDA automatically setting the most
distant and most recent edit dates.

Memos linked to an activated code reduces the display to all memos linked to an activated code.
The view in the Memo Manager is responsive to changes in activations in the "Code System".

Memo Icon allows the selection of memos with a specific memo icon.

The filter becomes active as soon as you close the filter window by clicking outside of it. If filters are
set, the filter icon is grayed out and a filter bar appears indicating the effects of the filter:
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The filter always refers to the left side of the memo manager and hides memos there. Open memos
on the right side are not affected by this, but after closing you can only open them if they are
displayed on the left side despite filtering.

To turn off the filter, click the "X" icon in the filter bar. All filters are automatically reset when closing
the Memo Manager.

Please note: The numbers of the icon labels in the Start tab are not affected by the filtering.

Search Memos

Search the list of memos

You can search within the entries of the tree view using the magnifying glass in the toolbar on the
left side of the Memo Manager. Here, for example, a code memo is searched for:

Search in the tree view

Search Memo Contents

To search all memos of a project, click on Search in Memos in the Start tab of the Memo Manager.
The memo search is explained in detail here. It can also be accessed via the Memos tab in
MAXQDA's main window when the Memo Manager is closed.

Assembling Memos in sets

You can create sets containing as many memos as you like. For example, it is possible to group
thematically related free memos with code memos and in-document memos.

You can create memo sets like this:

Right-click the word Sets in the left window of the Memo Manager and select New Set.1.
MAXQDA automatically assigns a name to the set, which you can change at any time by right-2.
clicking on the name and selecting Rename Set from the context menu.
Use the mouse to consecutively drag memos into the set.3.

You can add more memos to a set later at any time. To remove a memo from a set, right-click the
memo and select Remove Memo from Set.

https://www.maxqda.com/help-mx24/memos/searching-for-text-in-memos
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Tip: You can select and move multiple memos at the same time to add them into an existing set. To
do so, click on the memos while holding down the ctrl/cmd or shift key and drag them into an
existing set. If you drag several memos to the word "Sets", a new set with the selected memos will
be created.

Export and Print Memos

You can export and print all memos of a project or a selection of memos at any time using the
Memo Manager. At the top right you will find two icons to access the export and print functions:

By clicking on both the Print icon and the Export icon, a context menu with three entries will appear,
allowing you to decide which memos to print or export:

Print/Export Memos in Left Window - all memos listed in the left window of the Memo Manager,
including memos in sets.

Print/Export Memos in Right Window- all currently displayed memos on the right (depending on the
view, a single memo, all memos opened in tabs, or all memos listed in yellow boxes).

Print/Export All Memos in Project

You can export in Word format (DOCX) or PDF format.

The Overview of Memos
Memos aren’t only accessible from their location next to documents, codes, document segments,
etc. They are also available as an Overview of Memos. You can access these overviews in various
ways.

An overview of all memos in the entire project can be displayed via Memos > Overview of
Memos
In the “Document System”, you can compile all the memos in a document, in a document
group or document set. To do this, select the option Memos in a context menu accessed by
right-clicking the document, group or set.

Overview of Memos tab in the Memos menu

No matter from where you access the “Overview of Memos”, a tabular list of the corresponding
memos appears. Each memo represents one row in this table. A click on a row displays the memo in
the upper window of the overview.
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The “Overview of Memos”window

The columns in the table contain all important information about the memo, including:

The name of the document and document group in which the memo is found (or the name of
the code for code memos).
For memos attached to document segments, the paragraph number of that segment is listed.
The author of the memo.
Last edit date.
A preview of the memo text made up of the first 63 characters
The origin of the memo (e.g., the document, document group, document segment, or code the
memo is attached to).

The upper section of the window displays the memo text, so that various memos can be scrolled
through without opening individual memo windows for each. Memos cannot be modified or deleted
in the “Overview of Memos”. Instead, right-click on the memo’s row in the list and select Delete
Memo.

Please note: To modify a memo, double-click on its row. The memo window will open, allowing you
to modify the memo.

The overview can be adapted like all MAXQDA overview tables: The columns can be changed with
the mouse in their width and position, and by right-clicking on a column header. A click on the
header sorts the column in ascending order, another click in descending order.
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Filtering the Overview of Memos

As with all overviews in MAXQDA, the tabular “Overview of Memos” can be filtered according to
diverse criteria. This is particularly helpful, if you want to compile only the code memos of a project
or user, or only the memos that were created after a certain date. Click on a column header with the
right mouse button and select Set filter to set a filter for the selected column.

For more information on filtering overviews, see Filtering Table Overviews.

Predefined filters

In the “Overview of Memos” toolbar, you will find, besides the standard filter possibilities for table
overviews, a pop-up menu with numerous predefined filters. This allows you to filter the currently
listed memos.

Predefined filters in the “Overview of Memos”

The predefined filters work independently from the filter options described for the table overviews
above.

Searching the Overview of Memos

It is also possible to search in the various columns of the overview. To search in a specific column,
right-click on the column header and select Search. The instances where the search term appears
are immediately highlighted, and the up and down arrows allow you to navigate between memos. To
search multiple columns simultaneously, select the Choose search columns symbol. When you use

https://www.maxqda.com/help-mx24/screens-and-menus/managing-table-overview
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the magnifying glass symbol  in the "Overview of Memos" toolbar, the search will automatically be
carried out in all columns.

Please note: When you search the “Preview” column, only the first 63 characters of the memo will be
included in the search. If you want to search the entire memo text, use the feature Memos > Search
in Memos.

Creating a new free memo

In the "Overview of Memos" toolbar you will find the New free memo  icon. You can create a new
free memo, which is not assigned to any particular document, code, or text by clicking on this
symbol. Alternatively, you can create a new free memo by selecting New Free Memo in the Memos
tab.

Please note: Free memos are only visible in the "Overview of Memos" if the overview was opened via
Memos > Overview of Memos, in the Memo Manager or by right-clicking on the top entry in the
"Document System".

Jumping from the Overview of Memos to the memo origin

The “Overview of Memos” is interactively linked to the positions where your memos were created.
Clicking on a row in the table, makes MAXQDA “navigate” to the respective memo:

For in-document memos, the source document is displayed in the “Document Browser”
window positioned at the height where the memo is assigned to.
For in-media memos assigned to an audio or video position, the playback is set to the
appropriate position, but only if the “Multimedia Browser” is visible.
For code memos, the code in question is selected in the "Code System" (highlighted in blue).
For document memos the document in question is highlighted blue in the "Document
System".

Export Memo Texts from the Overview

All memos in your "Overview of Memos" can be exported as a sequential listing of the memo texts in
a text file for Word or other writing programs (DOCX and RTF format) or as a table in Excel, HTML or
TXT format.

The export can be initiated via the symbols at the top right of the “Overview of Memos”:

Open as Excel Table – Creates an Excel file and opens it.

 Open as HTML table – Creates a web page in HTML format and opens it with the default
browser.

 Export – Creates a Word file (DOCX format) with memos formatted as text or table, an Excel file
(XLSX format), a web page (HTML format) or in some other rarely used formats.

The entire table is exported unless individual rows are selected (highlighted in green).

Tip: To export code memos as a codebook with category definitions, MAXQDA provides a special
report feature which can be accessed via Reports > Codebook. See here for details.

https://www.maxqda.com/help-mx24/reports/creating-a-codebook-with-category-definitions
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Search within Memos
To search the contents of memos, select Memos > Search in Memos and enter the word(s) you are
looking for on the left side of the appearing window.

Searching for the word “family” in the project memos

After clicking on Run search, the Memo Manager opens and lists the memos for which one or more
words were found in the memo texts.

https://www.maxqda.com/help-mx24/memos/the-memo-manager
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In-memo search results

A click on a line in the left window or a click on a memo in the right list opens the respective memo,
highlighting the search hits in the memo.

Please note: The search does not consider the memo titles.

Linking Memo Content with Content in
Documents
In MAXQDA, you can link two text, image, or memo segments to each other with internal links. A
click on the link at one position then jumps to the other position. The two linked segments can be in
the same document/memo or in two different documents/memos.

To insert a link into a memo:

Select the text passage in the memo that you want to link.1.
Right-click on the marking and select Insert Internal Link (Anchor/Target) from the context2.
menu. In the Memo Manager, you can alternatively access this function in Format tab.
Select the target segment in a document or memo and repeat the process.3.

https://www.maxqda.com/help-mx24/links/document-links
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Insert an internal link in a memo

Highlight text segment to link document back to the memo

Existing links in a memo are displayed in blue and underlined text. A click on the link will take you to
the linked destination - and vice versa. If you hover the mouse cursor over the link, a preview of the
target is displayed.
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Preview of an internal link in a memo

Link Memos to Code(s) or Coded
Segments
Codes can be assigned to a memo similar as to a text segment. To do this, drag a code directly from
the code system into the open memo window and drop it there.

The bottom part of the memo shows how many and which codes are currently assigned to the
memo. The bottom section can be collapsed and expanded at any time and its height can be
changed so that you can adapt the view to your needs.
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Linking a memo to a code

Click the  symbol to activate all the codes currently associated with the memo.

If you want to remove the link to a specific code later, move the mouse over a code in the memo
window and click on the "X" symbol at the end of the line.

Compile memos linked to a code

How do you find memos that are linked to a certain code? In the "Code System" window, right-click
the code of interest and select the option Linked Memos from the context menu. The result is a list
of memos that are linked to the code displayed in the Memo Manager where you can read and
modify the memos.

Compile memos linked to activated codes

It is also possible to compile memos linked to the currently activated codes:

In the "Code System", activate all codes for which you want to compile memos.1.
Open the "Overview of Memos" via the Memos tab.2.
Select Memos linked to an activated code from the drop-down menu in the toolbar to filter3.
the memos.
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Memos of activated codes in the “Overview of Memos”

If the filter is switched on, you can also activate and deactivate codes later, the “Overview of
Memos” then displays the appropriate memos.

Tip: There is also a filter in Memos > Memo Manager with which the currently displayed memos can
be reduced to memos that are linked to an activated code.

Linking memos and coded segments

You can also link coded segments to a memo. To do this, drag a coded segment from the
“Document Browser”, the “Retrieved Segments”, or the “Overview of Coded Segments” into the open
memo window using the mouse.

The bottom part of the memo shows how many and which segments are currently linked with the
memo.
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Coded segments linked to a memo

To display memos that are linked to a coded segment, right-click the coded segment and select
Linked Memos from the context menu (if option is greyed out, there are no linked memos). MAXQDA
then opens the Memo Manager and displays the linked memos. There are three ways to open the
Memo Manager for linked memos:

Right-click on the coding stripe or code name in the "Document Browser"
Right-click on a row in the "Overview of Coded Segments"
Right-click on a segment in the "Retrieved Segments" window

Convert Memos into Documents
Since memos are used to assist in the development of ideas and hypotheses, it could happen that
they quickly become very important to your analysis. In some cases, these memos may be important
enough that you wish to convert them into documents, so they can be analyzed and coded. It is only
possible to associate an entire memo with codes, while every single character of a document can
theoretically be coded as many times as needed.

To convert a memo into a document, follow these steps:

Click Overview of Memos in the Memos tab1.
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Right-click on the memo to be transformed2.
Select Convert Memo into a Document3.

The newly-created document will now be listed as the first document in the “Document System”. The
first lines of the document are the former memo’s title, author, and creation date.

Tip: The function is also available in the context menu of any memo symbol. Right-click on a memo
icon in MAXQDA and choose Convert into a Document to transform the memo into a document in
the "Document System".

The Logbook
The logbook is a MAXQDA feature that lets you write a journal of sorts to keep track of your analysis
work. The term “logbook” is usually a nautical term, used to record significant events and
observations, and it can be used in a similar way for your project. The Logbook is set up to have the
newest entries at the top.

You can open the Logbook from the Home tab or with the keyboard shortcut Ctrl+Alt+B (Windows)
or cmd+⌥+B (mac OS).

The Logbook tab

The Logbook window is a simple window with a toolbar, which is fairly self-explanatory and lets you
format the text as you want. You can, for example, edit the font style and size; use bold, underline,
and italics; and change the text color. The icons on the far right let you print or export the Logbook.
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Logbook

To create a new entry, click on the New Logbook Entry  symbol on the far left of the toolbar. This
automatically inserts a date and time stamp at the top of the page, and you can enter your text
directly below it.
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11 – Links

Links in MAXQDA
MAXQDA distinguishes between four types of links:

Internal links represent a connection between two text, video, or image segments (e.g. to
show the contrast between two interviewees’ responses to the same question, you could link
them with each other). By using internal links, it is also possible to link a text passage in a
memo to a passage in another memo or any document.
External links create a connection between a text or image segment and an external
document (e.g. a picture, document, audio/video file, etc.) that is not part of the MAXQDA
project.
Web links are connections between a text or image segment and a webpage. By clicking on
this link, you can open the website in your standard browser.
Geolinks create a connection between a text or image segment and a place on the globe. This
place is based on GPS coordinates and is shown in Google Earth or other similar programs.

Links can be set (and if necessary deleted) within the "Document Browser", within a memo, within
the "Multimedia Browser" or in MAXMaps, the modeler of MAXQDA, which can be used to create
interactive visual representations of data, concepts, and context models.

The four types of links are listed in a table view and visualized with various symbols in the “Overview
of Links”.

Internal Links
Internal links are a tool to connect two locations within a MAXDQA project. These locations can be
within documents, video files, audio files as well as memos. Internal links always connect two points
with each other, an anchor point and a target point. As soon as you click on an anchor point of an
existing link, the corresponding target point is opened up. In MAXQDA, these links work as two-way
links. If you click on the target point, you get back to the starting point of the internal link.

You can link two text or image passages like this:

Select a text or image segment in the "Document Browser" with the mouse.1.
Right-click on the marker and select the Insert Internal Link (Anchor/Target) option.2.
Alternatively, you can use the Ctrl+L (Windows) or ⌘+L (macOS) keyboard shortcut, or click
the Insert Internal Link icon icon  in the coding bar of the “Document Browser". The display
of the marked position changes now: in texts it appears blue underlined in PDF and image
files a blue frame is drawn.
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Toolbar button for creating an internal link

You can now select the target point of the link, either in the same document or in another, and3.
repeat step 2.

If, after the first step, the user decides against creating the link or wants to change the text that had
been selected, right-clicking on the link and choosing Remove link removes it.

You can recognize links within a text in the "Document Browser" by their blue color and underlined
text. As soon as you move the mouse over the link, a small pop-up window appears with information
about target document and a preview of the linked location.

Blue underlined internal link with tooltip

These pop-up windows of the text linked to a text passage sometimes suggest anchoring the link
not only to a single word, but to an entire sentence or section. To jump from a link in the "Document
Browser" to the associated location, simply click on the blue link. The document containing the
destination point is loaded immediately and positioned exactly at the point of the link.

Tip: If the second "Document Browser" is open, MAXQDA automatically jumps to a link in the other
"Document Browser" window. This allows you to view both of the two linked document locations at
the same time.
Deleting internal links

To delete an internal link, right-click on the link and choose Remove Link from the context menu.
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Internal links in videos

You can also link a video clip to another video clip or document, e.g. a transcript.

Open the video file in the Multimedia Browser1.
Select a part of the video and click the Insert Internal Link (Anchor/Target) icon from the2.
toolbar.
You can now choose the document or document segment that the anchor should be linked to,3.
as is described above.

Internal links in memos

You can also insert internal links in memos to link a location in a memo to a location in another
memo, document, or video:

Open the memo.1.
Mark the desired text in the memo that is to be linked.2.
Right-click on the selection and select Insert Internal Link (Anchor/Target). . Alternatively,3.
you can click the icon  on the Format tab in the Memo Manager.
In the same way, set the link target in another memo or as described above in the "Document4.
Browser" or in the "Multimedia Browser".

External Links
External links are links between a segment of a text or image in MAXQDA and a document outside of
the project (e.g. to link part of an interview transcript in MAXQDA with a picture of the person saved
elsewhere on your computer).

Insert external links in an open document

To insert an external link, simply highlight a section of text or image, right-click on it, and select
Insert External Link. A window will then appear where you can select the appropriate external
document to be linked. This can be on your internal hard drive, an external medium like a flash drive,
or a network location.

External links, for text documents, are blue and underlined like the internal links, or in a blue frame
for PDF and image documents. When you hover over the link, a tooltip appears with the name and
location of the linked document. Clicking on the link opens the document in the appropriate
program. For example, clicking on a link to an image file in JPG format will open the file in an image
viewer program.

Defining external links for documents

You can not only insert external links for a position in a document, but also define an external link for
the entire document. Such an external link is not created in the "Document Browser", where the
content of the document is displayed, but in the "List of Documents", where all data of a project is
listed.
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To add an external link to a whole document:

Right-click the document name and choose Properties from the context menu.1.
A window will open in which you can assign up to three links to external files in the "External2.
Links" section. Click on one of the three lines with the mouse to select it and then click on the
icon with the three dots to select a file.

The external links appear in the context menu of a document and can be opened from there at any
time:

Please note: This form of external links is not listed in the "Overview of Links".

Web Links
Web links in MAXQDA are links between a text or image segment and a website. A web link can be
created as follows:

Highlight the text or image segment to be linked with the web address.1.
Right-click on the highlighted segment and select Insert Web Link.2.

A window will open in which you can then enter a web address.

Link from MAXQDA to a webpage

Please note: If a link was saved to the Windows clipboard, it will be automatically displayed in the
input field.

As for external links, you can hover over the web link to see the linked website in the tooltip. Double-
clicking on the link will open the website in your standard Internet browser.

Geolinks
With the creation of programs like Google Earth and Google Maps, it has become possible to view
any point on the globe with the appropriate coordinates. Geolinks or Georeferences are links
between elements in MAXQDA and a selected place on the globe. You could, for example, choose to
link each interview transcript in MAXQDA with the place the interviewee lives.

MAXQDA includes a column in the “Document Browser” specifically for these geolinks. To create
one, follow these steps:
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Go to the location in Google Earth that you would like to link to. You can then save the1.
location by right-clicking on it and selecting Save Place As …
Highlight the text or image segment to be linked in MAXQDA, right-click on it, and select2.
Insert Geolink. Simply select the saved KML file in the window that appears, and the geolink
has been created.

The KML file contains the coordinates to the saved place and everything else that Google Earth™
needs to take you directly to that location. When you click on the geolink in MAXQDA, Google Maps
will open in your Internet browser and the location will be marked with a red dot.

Geolinks are visualized similar to other links (blue and underlined), but they also have their own
visualization column next to the opened document. If the column is not shown, right-click
somewhere in the document in the “Document Browser” and select Display Geolink Column. This
bar makes it easy to differentiate between regular internal links and the geolinks.

By hovering your mouse over the geolink visualization, you will see the coordinates that are saved
for that location.

Geolink in the 'Document Browser'

Please note: When you add a geolink, the KML file is imported into the MAXQDA project itself.
Storing it in the project file makes it easier to pass on the entire project with all the associated KML
files to the other members of the research team.

Segments that contain geolinks can be coded just as any other segment can.

Geolinks can be easily viewed in the “Overview of links” table, which you can open in the “Document
System” at multiple levels (project, document group, document set, or document context menu). In
the first column of the chart, geolinks are marked with a locator symbol. If you click on the column
header of this column, the column will be sorted by the symbols, so it is possible to obtain a
successive list of all geolinks.

Overview of links with geolinks indicated with the orange locator symbol
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Inserting geolinks as objects in MAXMaps

Geolinks can also be inserted in MAXMaps by right-clicking in a map and selecting Insert Geolink.
You will then be able to select the appropriate KML file from the window that appears.

The MAXMaps screen then looks as follows:

A geolink inserted in MAXMaps

The name of the location in Google Earth is automatically inserted as the label for the geolink in the
map. This label is usually long and can be easily changed.

The inserted geolink can then be set up, visualized, linked to other objects, and moved around just
like any other object in MAXMaps. You can, for example, insert a picture to replace the blue circle,
change its size, etc.

Geolink along with other elements in a MAXMaps map
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Geolinking for codes, documents, memos and coded segments in
MAXMaps

All MAXQDA objects inserted in MAXMaps can be connected to a geolink. As with the free objects
mentioned above, an orange location symbol appears in the top right of object’s frame when it is
clicked on. Double-clicking on the ball opens Google Earth and takes you to the assigned location.

Using a background image with geolinks in MAXMaps

Google Earth™ allows you to save any view as a JPG file, which can be inserted in MAXMaps as the
background.

Invisible hotspots as well as all aspects of your MAXQDA project can then be inserted and placed on
the newly-imported background.

The Overview of Links
Internal links, the most common form of link, are easily seen in the “Document Browser”, but if you
have created many links, it is difficult to get an overview of them. For this reason, MAXQDA makes it
possible to view all links in an overview table. This overview table is similar to the one used for the
“Overview of Coded Segments”.

To view the “Overview of Links”, right-click on a document, document group, document set, or the
Documents icon (representing the entire project) in the “Document System” and select Links. When
right-clicking on a document or document group, only those links from that document or group will
be shown. Alternatively you can open the Overview of Links from the Reports tab in the main menu.

The overview contains the following information:

Anchor point (Document/Memo 1), paragraph, preview, second location (Document/Memo 2),
paragraph, preview.

In other words, you see the document name, paragraph number, and a preview of each side of a link.
Internal links are not hierarchical, meaning they don’t have a specific direction. A link from Point A to
Point B is also a link from Point B to Point A. You will therefore see each link listed twice: once as
Point A to Point B, and once as Point B to Point A.
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Overview of Links for a project

In the Overview of Links, each type of link can be distinguished by the symbol that appears in the
column on the far left:

 Internal links

 External links and web links

 Geolinks

The “Overview of Links” table works like other MAXQDA tables. You can choose to sort it
alphabetically or reverse alphabetically by clicking on the column headers. Clicking once on an
internal link opens the linked document segment in the “Document Browser”, showing you where the
link is located.

Exporting the “Overview of Links”

You can also access the usual export functions in the toolbar of the overview window:

Open as Excel Table - Creates an Excel file and opens it.

 Open as HTML table - Creates a web page in HTML format and opens it in the default Internet
browser.

 Export – Creates a table as an Excel file (XLSX format), as a web page (HTML format), as a
Word document (DOCX format), or in other formats, which are less common.

If any rows are selected, only these are exported, otherwise all rows are exported.
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12 – Text Search

Local Text Search
A search field  appears in all four of MAXQDA's main windows. Below you can see the search field
in the “Document Browser” window.

Search in the “Document Browser”

As soon as you type in a search string, MAXDA shows you how often that particular search string
has been found in the currently searched window. You can use the arrow icons next to the search
field or the arrow keys on your keyboard to skip through the search results.

By default, all occurrences of the entered text are taken into account, even those that occur in the
middle of a word, such as, for example, “less” in “lessons”. The search can be customized using the
icons in the search bar:

Case-sensitive – The letters in the search term and the term found must be the same, including
whether they are upper or lower case.

Starting letters - The beginning of a word must match the search characters. The search for
"erica" finds the name "Erica", but not "America".

Whole word – The search is checked for word-to-word consistency: if the search term is
"teacher", "teachers" is not registered as a hit. This option always includes the option "Starting
letters".

If you want to autocode the text passages found in the search, click on the code icon in the
search toolbar. In the dialog box that appears, you can define the new code as usual. MAXQDA
automatically enters the search item as the code’s name and the search settings as a code memo.
You can modify both, if required.

Find and replace search terms (e.g., for anonymizing)

Click the "search and replace" icon to open a second toolbar where you can enter a text and replace
your search hits with this text.
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Find and replace

Please note: As long as Edit Mode is active in the “Document Browser”, the replacements can be
undone by clicking the Undo text changes icon in the Edit bar.

Global Text Search
The Text Search function allows you to explore your documents without first coding them. If you
have already coded data, you can also search only the coded segments which are currently listed in
the “Retrieved Segments” window.

The Text Search function can be started by clicking on the magnifying glass icon in the Analysis
menu tab.

Text Search icon in the “Analysis” menu tab

The following window will appear:
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The dialog window for the Text Search

Entering a search item

When the dialog box first comes up, the left pane is empty, and you can just start typing to enter the
word or string (called the “search item”) that you want to find. Use the return key to enter multiple
search items.

To add additional search items later, click on “New entry …”. To edit an existing search item, click on
it once.

Search item may consist of one word, multiple words, or only of a part of a word. For instance, you
can search for “Tom Hanks,” “Hanks,” or only “anks.” Quotation marks are not necessary if a search
string consists of more than one word - it would lead MAXQDA to only search for words that are
placed in quotation marks.

Tip: If you highlight text in the „Document Browser“ then right-click on it and select the option Search
for Selected Text, the highlighted text will be displayed directly in the Text Search window.

Search strings may contain so-called “wildcard” characters. You can use the following wildcard
characters:

? single chracter l?ve finds
"love" and "live"

* multiple chracters h*ks finds
"hanks" and "hawks”, if the option "Whole word" was selected (see
below)
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<(...) word beginning <(inter) finds
"interests" and "internal", but not "winter"

(...)> word end (sh)> finds "slash" and "flash", but not "ashes".

Deleting a search item

To remove search items from the list, click the x symbol next to the word or select the whole line and
click the delete symbol at the top of the dialog window. By holding down the Ctrl key (Windows) or
⌘ key (macOS), you can delete multiple search strings at once.

Text search options

You will find the options for the search procedure in the right pane of the Text Search window.

First, you must specify where you wish to search: In documents, In comments, In paraphrases, or In
memos.

Other options:

Find whole words – Search only for strings that are exactly the same as the search string. For
example, if you search for “teach,” the string “teacher” will not be included in the search
results. If you turn this function off, “teach” would also give you the strings “teacher” or
“teaching” as results.
Case sensitive – Search only for strings in which the same letters are capitalized as in the
search string.
Interpret search items as regular expressions – The entered search terms are interpreted as
"regular expressions". Regular expressions can be used to perform complex searches (see
below for more information).
Find all word forms (lemma list) – Searches are conducted not only for an entered search
term but also for all its word forms. A search for "go" will also find the word "went". The
option affects only single words, not composite words. MAXQDA uses lemmata lists in
different languages for this option, so you also have to set the language of the search items
in the drop-down menu.

Please note: You can view and edit the lemma lists used by MAXQDA. In the Help from MAXDictio
you can find detailed information about the location of these lists. If you use the word-form function
for your search and publish the results, you need to include a license reference in your publication
because the used lists are available under an open license.

You can also choose how the search items are linked with each other:

With the OR combination, a hit is always included in the results list when one of the search
terms is found.
With the AND combination, all the search terms must occur within a defined distance of each
other in an adjustable search range.

As soon as you have selected AND, another option is made available directly below it:

Within xx document/paragraph/sentence.

https://www.maxqda.com/help-mx24-dictio/lemmatization
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With xx you define the maximum distance of the search items.

The following options are available as a search range:

Document – the two search terms must occur somewhere within a document. In this case,
the maximum distance cannot be set.
Paragraph – the two search terms must occur within xx paragraphs.
Sentence – the two search terms must occur within xx sentences. .

Example 1: You search for the terms "public" AND "citizen" within a document. MAXQDA will then
check that both of the two terms occur at least once. A row is displayed in the results table for each
document in which both terms occur at least once.

Example 2: You search for the terms "public" AND "citizen" within 1 paragraph. The list of results
then contains as many rows as there are paragraphs in which both search terms occur.

Example 3: You search for the terms "public" AND "citizen" within 2 paragraphs. For example, if
paragraph 12 contains the term "public", then "citizen" must appear in paragraphs 11, 12, or 13. Only
then will this count as a hit.

As soon as you click the Search button, the search will begin.

Depending on how many documents you search and how complex the search is, it could take some
time to find all of the results.

Searching with regular expressions

If you select the option Interpret search items as regular expressions, MAXQDA interprets the
entered search terms as "regular expressions". These are widely used in information technology and
allow complex searches to be carried out. The following table contains some examples of regular
expression searches:

Search term Explanation Example

d Number from 0 to 9 200d
finds all years from 2000 to 2009

^ Starting letters cap
finds all words beginning with the letters cap

$ Ending letters cap$
finds all words ending with the letters cap

^…$ Whole word ^cap$
finds only "cap", but not "capital"

[…] One of the characters
in brackets

h[oôó]tel
finds hotel, hôtel, hótel
200[0-9]
finds all years from 2000 to 2009
Class [34][a-d]
finds class 3a, class 3b to class 4d
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( | ) One of the character
combinations in
brackets

M(ay|ey|ai|ei)er
finds Mayer, Meyer, Maier, and Meier

? The question mark is
searched for; it is not
interpreted as wildcard
of any single character

Why?
finds all text parts equal to “Why?”

As an example, a helpful tutorial on the use of regular expressions can be found on the following
website:
https://medium.com/factory-mind/regex-tutorial-a-simple-cheatsheet-by-examples-649dc1c3f285

Please note: There are several technical implementations of regular expressions. Perl-compatible
expressions (PCRE) are implemented in MAXQDA.

Saving search terms

Searches can be saved, i.e., you won't have to enter the search terms again. Click Save, enter the
name of the saved scan, and then click Save again. Search files are saved with the extension .SEA
(an abbreviation for search). Saved searches can be loaded at any time.

Search Results
When running a text search within documents, the results will be displayed in a window like the one
pictured below:

Text Search output example

In the upper right corner of the search results window, you'll find the count of hits, along with the
number of documents and document groups in which these hits are located. 

https://medium.com/factory-mind/regex-tutorial-a-simple-cheatsheet-by-examples-649dc1c3f285
http://perldoc.perl.org/perlre.html
http://perldoc.perl.org/perlre.html
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Tip: By clicking on one one of the hits, the relevant document will open, positioned at the
corresponding segment, with the search term highlighted.

In addition to the standard filter functions, the toolbar at the top of the results window offers access
to the following functions:

Save document hit counts as a document variable – This adds a new document variable
containing the count of hits for each document, which can be used for further analysis.

  Autocode selected results – This automatically codes all selected segments from the search
results. You can select between coding them with either a new or an existing code. Excluded
segments, identified by the Stop  symbol in the first column, will not be coded.

Refresh – This reopens the search settings window, allowing you to make further adjustments
to your search parameters.

The search results table can be handled in the same way as other MAXQDA tables. Your can sort the
data by clicking on a column header. Clicking, for example, on the document name column will sort
the search results alphabetically based on their name. If you click on the same column again, the
order will be reversed. In this example, the results will be sorted in reverse alphabetical order. A
triangle indicates the sorting order.

Text Search Results using the 'AND' search function

You can use 'AND' option to combine several search entries in a Text Search. In this case, the search
results table shows the hit count for the co-ocurring search entries in the specified search content
(documents, paragraphs, or sentences).The number of rows corresponds to the hit count. The
following image illustrates this for the search for “family” AND “son”.

Search for “family“ and “son“ in one paragraph

If you have searched using the option Within x sentences or paragraphs, a click on a row, marks the
respective sentence or paragraph in the “Document Browser”.

If you have searched using the Within a document option, clicking on a row will highlight the first
search item in the document.
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To get a list of each individual hit of search items, click on the icon for the Detailed list of search
hits.

Please note: When exporting search hits or autocoding them, MAXQDA uses the detailed list of
search items.

Opening your last search result

As long as your project is still open, you can always go back and review the last search result, thus
saving time in case you need to do the same search again. Go to the Analysis menu tab, click the
label Text Search & Autocode to open the drop-down menu, and select Last Search Result (do not
click on the icon, this will open the simple Text Search).

Autocode Search Results
Like the segments in the “Retrieved Segments” windows, Text Search results can be automatically
coded, meaning all text passages found in the search are assigned to a specific code. This
automatic coding has the advantage of being easy and reliable. The disadvantage, however, in
comparison to manual coding, is of course that you can’t examine the relevance of each respective
text passage during the coding process. The occurrence of a specified string in the text
automatically triggers the coding. For example, if the word “Mother” is automatically coded with the
code “Family”, references to “Mother Earth” would also be included.

To code the search results automatically, click on the “Autocode” icon:

Start autocode procedure

Autocode search results with a new code

Click on the Autocode Results with New Code option in the dropdown menu.1.
In the dialog box that appears, you can define the new code as usual. MAXQDA automatically2.
enters the search item as the code's name and the search settings as a code memo. You can
modify both, if required. Then click OK. The new code will be inserted at the top of the code
system.
In the ensuing options window, you can set the range before and after the search term as well3.
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as the weight, which is established during the coding process.

In the “PDF documents” section, you can set whether only the respective search result should be
coded, or whether additional words or sentences before and after the search results should be
coded as well. Due to the different handling of text layers in PDF documents, using the option
“Sentences before and after” for PDFs can lead to unexpected results in certain cases.

Please note: Read the chapter on Extended Text Search to learn how MAXQDA recognizes
sentences.

In the “Text and table documents” section, you can additionally select to autocode paragraphs
containing the search result.

Setting Paragraph with 0 Paragraphs before and 0 Paragraphs after means that only the paragraph
in which the search item is found will be coded. If the item appears several times in one paragraph, it
will nevertheless be coded only once

The setting 1 Paragraph after means that the paragraph in which the search item is found as well as
the following paragraph will be coded. Again, if the term appears several times in one paragraph, it
will nevertheless be coded only once.

Autocode search results with an existing code

If you do not want to code with a new code, but with an existing code from the "Code System”, you
can use the Autocode Results with Existing Code option from the dropdown enu. Before you start
the process, click on the desired code in the “Code System” window, which will cause the code to
appear in the list of recently used codes in the Autocode options window.

Please note: Text segments that are already coded with the selected code will be ignored during the
autocoding process - even if a text segment contains the search item. This ensures that you do not
accidentally overwrite your manually coded segments during the automatic coding process.

Exclude search results from autocoding

Generally, all search items that appear in the results list will be autocoded. However, before
executing the autocode function, you can review the list of search hits in order to decide whether
each hit should be included or not. Once one or more lines in the results table have been selected,
click on the red icon  Autocode/Export: ignore hit in order to exclude the hit.

The fastest way to exclude a term is to double-click in the first column.

Please note: The selected codes are incorporated into the undo coding list which can be accessed
from the Code toolbar in the Document-Browser window with the  icon. This action can be
reversed with a single command if necessary. This function is also available after reopening the
project and it can be called independently of the global undo function.

Export Search Results
The results table of the Text Search tool offers the possibility to export search results by clicking on

https://www.maxqda.com/help-mx24/lexical-search/the-extended-lexical-search
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the Export  icon in the toolbar of the results window. The following options window will appear,
where the range of the data to be exported in relation to the search items can be defined, for
example, to create a keyword-in-context (KWIC) listing:

Search results export settings

The options window is divided into two parts. Options for the export of search results from a PDF
document can be selected in the upper section, with the corresponding options for search results
from text and table documents in the lower section. Exports of pure search results as a simple list is
generally not useful; therefore you can define the range for the export of search results.

Setting Paragraph with 0 Paragraphs before and 0 Paragraphs after means that only paragraphs in
which the search item is found will be exported. If the item appears several times in the same
paragraph, the paragraph is still listed only once.

Setting 1 Paragraphs after means that the paragraph containing the search item, as well as the
following paragraph, will be exported.

Please note: Read the chapter on Extended Text Search to learn how MAXQDA recognizes
sentences.
The recognition of sentences in PDF documents is optimized for left-to-right languages and may not
work as expected with right-to-left languages.

When you click OK, a window will pop up in which you can select the file name, format, and location
to be saved. The following options are available:

Word – Text (DOCX),
Word – Table (DOCX),
Excel (XLS/X),
Website (HTML),
Rich Text Format (RTF)
Tab Delimited Text (TXT)

Exclude search results from export

Generally, all search hits that appear in the results list will be exported. However, before starting the
export function, you can review the list of search hits in order to decide whether each hit should be
included or not. Once one or more lines in the results table have been selected, click on the icon 

https://www.maxqda.com/help-mx24/text-search/the-extended-lexical-search
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Autocode/Export: ignore hit in order to exclude the hit.

Exclude search terms from export

Tip: The fastest way to exclude a term is to double-click in the first column.

Extended Text Search
The Analysis > Extended Text Search function, as with the simple search option, allows you to
analyze your documents to a certain extent without having to have already done any coding. If you
have already coded data, you can also search only the coded segments which are currently listed in
the “Retrieved Segments” window.

To start an extended Text Search:

Go to the Analysis menu tab and click at the bottom of the Lexical Search entry.1.
Click on the label of the Text Search & Autocode icon (not on the symbol, this will start the2.
simple Text Search).
From the drop down menu select Extended Text Search.3.

The following search dialog will appear:
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Extended Text Search window

The dialog is separated into several parts. At first you can enter search items in the text fields

Include all these search items (AND combination)
One of these search items (OR combination)
None of these search strings (search strings for exclusion)

Please note, that you can separate different search strings with a space. If you want to enter a
combined search string you can use quotation marks like “Mahatma Gandhi” around your search
string. Question mark (“?”) and asterisk (“*”) work as placeholders for a single character or for one or
more charaters. Use <(word) for word begin and (word)> for word end, <(inter) will find “interest” and
“interesting”, but not “winter”, and (ks)> will find “banks” and “thanks”, but not “bankside”.

All three search entries will be combined with AND. In the screen above MAXQDA will present all
sentences in which “climate” and “energy” exist together, but not “politics”.

The options Find whole word etc. are explained in detail in section Text Search.

https://www.maxqda.com/help-mx24/text-search
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In the upper right part of the dialog you can define, in which part of the project MAXQDA will search
an in the options on the right you can define in which context the search items have to exist.

Please note: Sentences are defined by MAXQDA according to the following rules: A sentence always
begins following a period, question mark, exclamation mark, or colon. The following exceptions
apply:
# A number that is not four digits appears before a period (e.g. 1. or 2.).
# A single character appears before a period (to exclude abbreviations).
# Two identical characters appear directly before a period (e.g. ff. or pp.).
# Literal speech in quotation marks belonging to the sentence itself.
# First letter after a sentence is in small letters.
# A number appears directly following the end of a sentence.
# Quotation marks appear immediately after the end of a sentence.
In text or table documents, a new sentence always begins after a paragraph.

The recognition of sentences in PDF documents is optimized for left-to-right languages and may not
work as expected with right-to-left languages.

The Word Explorer
In which documents does the word "friend" occur frequently and in which summaries and
paraphrases? Which words frequently occur together with "friend" in a sentence? These and many
more questions can be answered with the Word Explorer.

The Word Explorer

The Word Explorer gives you an overview of the use of terms throughout your project. Both the
imported text data and your own text input in memos, coding comments, summaries and
paraphrases are searched. The Word Explorer is suitable for different phases of a study:

At the beginning of the analysis, the use of words in the data can be explored.
During the main analysis phase, conjectures about the use of interesting words can be made
and verified.
For report-writing purposes, important quotations from the original data and references in
one’s own written passages can be found that include a particular term.
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The Word Explorer

How to use the Word Explorer

Start the function via Analysis > Word Explorer in the MAXQDA main menu.1.
In the Word Explorer window, enter a search term in the search field. This can be a part of a2.
word ("glob") or a whole word ("change"). Multiple words ("global warming") are also possible.
If necessary, select options from the Start menu, such as applying a stop word list.3.
Click the Explore button.4.

Please note: In the search term, you can use "?" as a wildcard for a single character and "*" as a
wildcard for any number of characters. When using wildcards, the Find Whole Word option is
automatically applied, regardless of whether the option is selected in the Start tab.

Presentation of results

The results are presented in six interactive sections: click on a result to get more details about the
corresponding search hits.

In documents

This section informs you about the number of hits and in how many different documents, document
groups, and document sets they are located.

hits – total number of hits in the searched documents. Click this line to open a listing of all hits.

documents – number of documents in which the search term appears at least once. Click this line to
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activate all documents with at least one search hit in the “Document System” window. The
percentage refers to all documents in the project. However, if only activated documents were
evaluated, then the percentage refers to hits within these activated documents.

document groups / document sets – number of document groups and document sets in which at
least one search hit occurs. The percentage refers to all groups/sets in the project regardless of
document activation.

In my writing

The numbers indicate how many memos, coding comments, summaries, and paraphrases were
found in which the search term occurs at least once.

Click on one of the lines to display the found memos, comments, summaries, and paraphrases.

Most frequent in these documents

This section displays the documents in which the search term occurs most frequently. The numbers
indicate how often the search term occurs in the corresponding document, and documents are
displayed in descending order of frequency according to these numbers. The small horizontal bar
charts visualize the frequencies so that differences between documents can be assessed easily.
The small “dash” charts at the right show where the search hits occur in the document. For example,
the search hits for “Tatjana” are mostly located in the middle of the text, followed by one search hit
in the last quarter.

Click on a line to get a listing of the search hits in the corresponding document.

Please note: If multiple documents have the same number of search hits, the documents will be
listed in the order defined in the “Document System”.
Most frequent codes

This section shows the codes that were most frequently assigned to text passages with search hits.
The numbers indicate how often the search term occurs in segments of the corresponding code;
sorting follows a descending order according to these numbers. The small horizontal bar charts
visualize the frequencies so that differences between codes can be assessed easily.

Example: The line “10 Free time, self-care” in the figure means that the search term “friend” occurs
10 times in text sections that were coded with the code “Free time, self-care”.

Click on a line to get a listing of search hits within that code.

Please note: If several codes contain the same number of search hits, the codes are sorted
according to the “Code System” window. If there are several search hits within a coded segment, the
applied code is counted for each search hit.
Most frequent word combinations

This section shows the most frequent 2- to 4-word combinations that contain the search term. The
most frequent word combinations in the example are “encourage friends” and “meeting friends”.

If the Apply Stop Word List option is selected in the Start tab, all word combinations containing a
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word from the selected list will be excluded. The same applies to the Ignore Numbers option.

Click on a line to open a compilation of the corresponding word combination and explore the search
hits in detail.

Please note: Only combinations of words from partial sentences are presented. This means that no
combinations of words separated by commas, semicolons, parentheses, line breaks, etc. are output.
Users with a “MAXQDA Plus” or “MAXQDA Analytics Pro” license can set the separators for
identifying partial sentences via MAXDictio > Word Combinations.
If several word combinations occur with the same frequency, they are output according to the
number of words per word combination (1st sort criterion) and alphabetically ascending (2nd sort
criterion).
Most frequent context words

This section displays the most frequent words within a definable distance around the search hits.
The distance can be defined in the Advanced Options tab; by default, the 5 words before the search
hit and the 5 words after it are included. Only words within the same sentence are considered. For
the determination of sentences, MAXQDA applies the procedure described here.

Please note: If several words occur with the same frequency, they are output in alphabetically
ascending order.
Switch off sections

If a section is currently not of interest for the analysis, it can be temporarily switched off. This can be
helpful for saving computing time when working with large amounts of data. To deactivate a section,
click the respective on/off symbol at the top right:

Temporarily switch off section

Clicking again turns the section back on.

Choose options

In the Word Explorer Start menu tab, you can set the following options for your search:

Only Activated Documents – limits the search to the currently activated documents. This
option affects all sections.
Only Activated Codes – Restricts the search to the currently activated codes. This option
affects the “In my writing” section (code memos, coding comments, and summaries) as well
as the “Most frequent codes” section.
Most Frequent [3-50] – Define how many entries should be displayed in the four lower

https://www.maxqda.com/de/hilfe-mx22/lexikalische-suche-2/die-erweiterte-lexikalische-suche
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sections.
Case Sensitivity – If this option is enabled, words are analyzed and presented case-
sensitively.
Starting Letters – If this option is enabled, only hits that start with the entered search term
are considered. Searching for “tree” finds “tree”, “trees”, “treehouse” but not "street".
Find Whole Words – If this option is enabled, all hits are ignored where the search term is only
a part of the word, i.e., there must be a space or a separator before and after the hit. This
option overrides the “Starting Letters” option. A search for “teach” will not find “teacher” or
“teaching”.
Base Form (Lemmatize) [language selection] – Other word forms from the lemma list of the
selected language are included in the search if option is switched on. Searching for “go” will
also find “went” and “gone”. This option has no effect if the search term includes several
words. More information about the lemma lists used can be found here.
Apply Stop Word List – Select a stop word list here and use this option to exclude search hits
from the “Most frequent word combinations” and “Most frequent context words” sections.
After clicking on the three dots, a window opens where you can edit the stop word lists.
Ignore Numbers – If this option is enabled, word combinations containing a number and
context words consisting only of a number will not be output. Numbers entered in the search
field are never ignored. If you enter “2021” as a search term, MAXQDA will output all hits with
this number.

The Advanced Options menu tab of the Word Explorer provides more options:

Characters to be Cut Off – Clicking on the button with the three dots opens a small dialog
box in which you can enter characters that are to be separated from the words in the
searched texts and ignored during counting. The selected characters apply to all word-based
functions in MAXQDA and MAXDictio (the dialog can be accessed in several places).
Context Words (before/after) [number 1-15] – here you can set the maximum number of
context words that will be considered before and after the search hit. By default, 5 words
before and after search hit are considered as long as they belong to the same sentence.
Language Options – Here you can specify that the analyzed texts are in Japanese. In this
case, MAXQDA uses a special library to separate the words from each other, since Japanese
does not require spaces. You can also select here that Japanese particles are ignored for
analysis.

Launch Word Explorer from the Document Browser window

Right-click on a selected text passage in the “Document Browser” and select Explore in Word
Explorer to start the Word Explorer directly for the marked text. By default, all documents are
searched; you can of course limit the search in the Word Explorer window.

https://www.maxqda.com/de/hilfe-mx22-dictio/lemmatisierung
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Start Word Explorer via context for a selected text in the “Document Browser” window

Launch Word Explorer from the Word Cloud

Right-click a word in the word cloud and select Explore in Word Explorer to start a search in all
documents with the clicked word.

Launch Word Explorer from the Word Frequency List

You can create a list of word frequencies, by accessing Word Frequencies in the Word Cloud
window or via the MAXDictio > Word Frequencies function. Right-click on a word in the word list and
select Explore in Word Explorer to start an exploration in all documents with the clicked word.

Start Word Explorer via context menu from the word frequency list

Export results

While hovering, a copy symbol appears at the top right of each results section, with which the
respective section can be copied to the clipboard. All entries of the range will be exported as an
image, even entries that may not be visible. You can paste the image into Word, PowerPoint, and
other programs, for example, using the keyboard shortcut Ctrl+V (Windows) or ⌘+V (macOS).
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Copy section to clipboard
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13 – Segment Retrieval

Activation: The Principle of Segment
Retrieval
After you have assigned codes to document segments, you can retrieve all segments that have been
coded with the same code. MAXQDA offers several ways to perform this retrieval, but it is all based
on activation of documents and codes. Activation in MAXQDA means "selected for analysis".

The retrieval principle in MAXQDA is very simple:

All segments from activated documents that have been coded with any of the activated codes are
retrieved and displayed in the “Retrieved Segments” window.

Activating documents

You can see the current state of the activation in the Document System window: activated
documents are highlighted in color and have a filled colored circle in front of the document symbol:

A deactivated document

An activated document

As soon as at least one document is activated in a document group, the document group is also
highlighted in color and has a filled colored circle in front of its symbol, too.:

An ctivated document in the “Document System”

There are several ways to activate documents:

1. Activation with the mouse

The easiest way to activate a document is with the mouse: Click with the left mouse button on the



  293

circular activation symbol left to a document symbol or on the document symbol itself to activate
the document. Alternatively, you can click on the circle in front of the document symbol or on the
displayed number of coded segments at the end of each document row.

All documents in a document group or document set can be activated at once in the same way: click
on the folder icon of the document group or document set.

2. Activation via the context menu

You can also activate a document via the context menu: Right-click the document name or icon and
choose Activate from the context menu.

In the same way, you can also activate all documents of a document group or document set at once
by right-clicking the group or set and selecting Activate All Documents. This menu entry is also
available at the very top level, "Documents", the root of the Document System.

3. Activation with the Ctrl or cmd Key

Similar to selecting files in Windows Explorer or Mac Finder, you can also hold down the Ctrl key
(Windows) or ⌘ key (macOS) and click on the required document, document group, or document set
with the left mouse key.

Activating codes

Activating codes works in the same way as for documents. Either right-click on a code and click
Activate in the context menu or click on all symbols of the codes you want to activate.

Activating a code via the context menu

The activation of the codes is also indicated by a colored circle in front of the code symbol and the
colored highlighting of the code name.

Tip: If you hold down the keys Ctrl+⇧ (Windows) or ⌘+⇧ (macOS) when clicking a parent code, only
the parent code and not its subcodes are activated.

Compiling coded segments in the "Retrieved Segments" window

All of the document segments that were found based on your activations are called retrieved
segments and are displayed in the “Retrieved Segments” window - if it is currently open. All
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segments that have been coded with an activated code and originate from one of the currently
activated documents are listed here:

Retrieved coded segments corresponding to the activated codes and documents

More activation methods

Activation via search in document and code names

Both in the "Document System" and in the "Code System", a local search for document and code
names can be performed. If you enter a word in the search field located in the window title of the
"Code System", the following search bar appears:

Activate search hits

By clicking on the symbol Activate codes with search hits (far right) all codes are activated where
the searched word occurs. This process overwrites the previous activation status of codes.

Activating by variables

Activating documents and codes can be done manually, but also automatically depending on certain
variable values. This type of activation is referred to in MAXQDA as Activation Documents/Codes by
Variables, and is described in detail here.

Activating by color

Documents and codes can be activated by color. In both the "Document System" and "Code System"
windows, right-click on the root entry of the "tree",and select More... > Activate Documents/Codes
by Color from the context menu.

A dialog field will appear with all the colors that have been used for documents/codes so far. You
can then check the box next to the colors to be activated. The two buttons at the top also let you
check or uncheck all of the colors with a single click.

https://www.maxqda.com/help-mx24/mixed-methods-functions/activation-by-document-variable-variables-as-selection-criteria-for-the-coding-query
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Select the colors you would like to activate

Activate documents randomly

You can activate documents randomly. Right-click on the root of the documents and choose More...
> Activate Documents by "Random".

In the dialog that appears, MAXQDA displays how many documents are available in the project and
allows you to enter a number of documents to be activated.

Activation of documents depending on code distribution

To activate all documents in which a selected code or one of its subcodes exists at least once, right-
click the code in the code system and choose Activate Documents Containing This Code from the
context menu. Selecting this function will overwrite the current activation in the "Document System".
If you right-clicked on a code that has no coded segments, its subcodes are automatically taken into
account and the function is named Activate Documents Containing This Code incl. Subcodes.

Clearing activations

The clearing process works similarly. You can clear selected documents or codes either via the
context menu or by clicking on the activation symbol, to the left of the document or code symbol.

If you want to deactivate all documents and codes at once, go the Start menu tab and click on the
Reset Activations icon or use the keyboard shortcut Ctrl+R (Windows) or cmd+R (macOS).

If you want to reset activations for only the documents or only the codes, you can do so with the icon
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available in the “Document System” or “Code System” toolbars:

Clear activated documents

Clear activated codes

The "Retrieved Segments" Window
The “Retrieved Segments” window is a results window – it shows you all of the coded segments that
were coded with any of the activated codes in any of the activated documents. The principle of the
segment retrieval, also called Coding Query in MAXQDA, is as follows:

For all activated documents, the segments to which activated codes are assigned are compiled in
the “Retrieved Segments” window.

The “Retrieved Segments” window

The top line displays how many coded segments from how many different documents and
document groups are currently listed.

Below each segment there is an indication of origin, which informs you about the document and the
position of the segment in the document as well as about the assigned code. To the far left of the
segments, coding stripes are displayed in the color of the assigned code, very similar to the
“Document Browser”, but without the code name.

Tip: If you click with the left mouse button on the line with the source information or on the coding
stripe, the source text is loaded into the “Document Browser” and the coded segment is highlighted.
At the same time, the corresponding code is highlighted in the “Code System” window. If you click
on the origin of an audio or video segment, the “Multimedia Browser” opens and the clip is
highlighted.

To the left of the segments, there is a column for displaying memo symbols. If memos are assigned
in the area of the segment, you will see the same memo symbols here as in the “Document
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Browser”. As usual, the memo symbol is interactive:

A single click with the mouse marks the segment assigned to the memo in the “Document
Browser” and displays it in its sidebar, provided that these are visible, and memos are enabled
for display in the sidebar.
A double click on the symbol opens the memo for editing.

Working with Comments for Coded Segments

As in the “Document Browser”, you can switch on a sidebar to the right of the coded segments in
which the comments on coded segments are displayed. You can display or hide the column with the
comments by clicking on the icon Display comments on coded segments in the toolbar of the
window.

Comment column in the “Retrieved Segments“ window

Double-click a comment in the sidebar to edit it. To create a new comment, right-click the coded
segment and select Edit Comment from the context menu.

Tip: Alternatively, a double-click on the coding stripe opens the comment window at any time to
create new comments or edit existing ones.
Display Favorite Variables

It is often helpful to obtain further background information on the coded segments, for example how
old the person was who expressed a certain opinion in the interview or in which industry a company
operates, whose website texts are analyzed. For this purpose, you can display the so-called favorite
variables of the documents in the “Retrieved Segments” window at any time.

This is how you proceed:

Switch to the Variables tab and open the List of Document Variables.1.
Check the “Favorite variable” column for all variables that are interesting for your analysis and2.
close the window again.
Click the Display Favorite Variables icon at the top of the “Retrieved Segments” window - if it3.
was not already enabled.
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Display favorite variable information

The selected variable information then appears directly below the document name.

Deleting coded segments and adjusting weights

If you right-click on a segment or its coding stripe, a context menu appears, which can also be
accessed via the “Document Browser”:

Here you can delete the coded segment, that is, it is permanently removed from the project and the
coded segment is no longer displayed in the “Retrieved Segments” window.

You can also change the weight of the clicked coded segment, which is displayed in brackets at the
end of the assigned code name. After selecting the menu option Modify Weight, a dialog window
appears in which the new value can be entered.

Adjust a coded segments weight

Please note: You can turn off the display of weights in the “Retrieved Segments” window if required.
To do this, click on the gear icon for the local settings in the window title (as shown in the next
figure) and deactivate the Show weight option.

Sorting segments in the “Retrieved Segments” window

You can adjust the sorting of the coded segments at any time in the local settings of the window. To
do this, click on the gear in the upper right corner of the window title:
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Adjust your preferences for the “Retrieved Segments” window

There are three possible variations:

Ordered by Document System – this means that the segments are listed in the same
sequence as in the “Document System”. The list starts with the segments of the first
activated document in the “Document System”, then those of the second activated document
are given, and so on. Search results in this order would let you compare what one respondent
said to different selected topics. For example, given that the first respondent’s answers were
contained in one document or interview, followed by a second respondent’s answers in a
separate second interview, all of the retrieved segments from the first interview would be
listed before those from the second interview.
Ordered by Code System – this means that the segments are listed in the same sequence as
the codes in the “Code System”, starting with the uppermost activated code.
Ordered by weight score (ascending/descending) – This sorts the segments according to the
weight that has been assigned to them.

The table view in the “Retrieved Segments” window

The “Retrieved Segments” can be displayed in a table view. To do this, open the local settings as
shown in the figure above and select the option Table view. MAXQDA will then display the coded
segments in the same manner as the “Overview of Coded Segments” window. This display is
interactive: click on a row to show the corresponding segment in the “Document Browser” or
“Multimedia-Browser”.
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The “Retrieved Segments” in a table view

The Overview of Coded Segments
The "Overview of Coded Segments" shows a tabular list of coded segments. You can call up the
overview in many places in MAXQDA and you can use it for segment retrievals, among other things:

The Overview of Coded Segments

The overview is divided into two parts: a list representation of the retrieved segments is displayed in
the bottom half of the window, while the upper half displays a detailed view of the segment you have
clicked in the bottom list. Simultaneously, the "Document Browser" (or the “Multimedia Browser” for
video coding) is positioned accordingly, so that you can also see the surrounding context of the
respective segment. The larger the screen, the better this function is.

Tip: The overview table is also a good place to write and edit your comments on your coded
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segments. You read the segment in the upper window and write your comment in each row. Just
double-click the field for comments in the table and type in your annotation.

Opening the “Overview of Coded Segments”

Which segments are included in the overview depends on the context, for which the overview is
requested:

Coded segments that currently appear in the “Retrieved Segments” window:

Click on the Overview of Retrieved Segments symbol in the “Retrieved Segments” toolbar

All coded segments from the project:

Reports > Overview of Coded Segments or
Right-click on the root entry of the “Document System” or “Code System” and select Overview
of Coded Segments or
Double-click on the root entry of the “Code System” window

All coded segments of a code:

Double-click on the expanded code, or
Right-click on the expanded code and select Overview of Coded Segments

All coded segments of a code and its subcodes

Double-click on the collapsed code, or
Right-click on the collapsed code and select Overview of Coded Segments

Coding texts directly in the “Overview of Coded Segments”

You can code text segments, which are displayed in the upper window of the “Overview of Coded
Segments”. To do this, select any text area in the upper window area and drag the selected text onto
any code. In the "Document Browser", the new coded segments will be visible as a coding stripe -
provided no filters are set for the display of the coding stripes.

The toolbar in the “Overview of Coded Segments”

The following functions – alongside the usual icons for filtering, searching, and deleting – can be
accessed from the toolbar:

Codierte retrieved segments – the selected coded segments (row marked in blue) will be
assigned to an existing code. To select a code in the dialog that appears, it must be clicked once in
the "Code System" window before opening the dialog. It is possible to select multiple rows by
holding down the Ctrl key (Windows) or ⌘ key (macOS). If no rows are selected, the entire table will
be coded.

Code retrieved segments with a new code – the selected coded segments (row marked in blue)
will be assigned to a new code. It is possible to select multiple rows by holding down the Ctrl key
(Windows) or ⌘ key (macOS). If no rows are selected, the entire table will be coded.



  302

Activate documents containing segments – activates all documents that contain any of the
displayed segments. Previous activations are overwritten.

Smart Coding Tool – opens the Smart Coding Tool showing the currently displayed coded
segments.

Word cloud – a word cloud is created in which the most frequently occurring words in the coded text
segments are visualized.

Display favorite variables – displays the favorite variables in a separate column. For each segment,
you can see which variable value has been assigned to the document from which the segment
originates.

What information can be found in the columns of the overview?

Regardless of the document type, the following columns of the table have the same meaning:

Document group – document group from which the coded segment originates
Document – document from which the coded segment originates
Weight – weight of the coded segment (can be modified directly in the overview!)
Comment – comment on the coded segment (can be modified directly in the overview!)
Code – the code with which the segment is coded
Created/Modified by – person who originally coded the segment/last changed the coding
Created/Modified – the date on which the segment was originally coded/last changed the
coding

Depending on the document type, the following columns have different significations:

Text Documents

Start – paragraph in which the coded segment begins
End – paragraph in which the coded segment ends
Preview – the first 63 characters of the encoded text (when exporting the output contains the
entire coded segment)
Area – number of characters in the coded segment
Coverage % – number of characters in the coded segment in relation to the number of
characters of the text as a whole

PDF Documents

Start – for text coding, the page at which the coded segment begins. For image coding, the
lower left corner of the segment.
End – for text coding, the page at which the coded segment ends. For image coding, the
upper right corner of the segment.
Preview – the first 63 characters of the coded text. For images, <IMAGE> will be displayed
(upon exportation the entire coded text and image segment will be displayed)
Area – for coded text segment, the number of coded characters; for a coded image segment,
the coded area in square pixels
Coverage % – for text, the number of coded characters in relation to the total number of
characters in the text; for images, the coded area in relation to the total area of the PDF

https://www.maxqda.com/help-mx24/work-with-coded-segments/smart-coding-tool
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Image Documents

Start – the upper left corner, at which the coded segment begins
End – the lower right corner, at which the coded segment ends
Preview – always displayed as <IMAGE> (coded image segment will be displayed upon
exportation)
Area – coded area, in square pixels, where the side lengths are each reduced by 1 pixel
Coverage % – coded area in relation to the total area of the image

Table Documents

Start – cell in which the coded segment is found
End – identical to “Start,” as coded segments are always in the same cell
Preview – displays the first 63 characters of coded text (when exported, will include the entire
coded segment)
Area – Number of characters in the coded segment
Coverage % – for text coding, the position of the character at which the coded segment
begins. For image coding, the lower left corner of the segment.

Audio and Video Files

Start – the time at which the coded segment begins
End – the time at which the coded segment ends
Preview – always displayed as <AUDIO> or <VIDEO> (image of beginning of clip will be
displayed upon exportation)
Area – length of coded media clips
Coverage % – length of coded media clips in relation to total length of the file

Sort, Hide, and Reveal Columns

As with all tables, you can also organize the Overview of Retrieved Segments as you wish:

Drag & Drop columns to change their order.
Sort the table by a column by clicking on the column heading.
Hide or reveal columns by right-clicking on the column heading.

Export and Print Retrieved Segments
Exporting retrieved segments

You can export coded segments from MAXQDA to a Word, Excel or HTML file. You can start the
export for the currently compiled segments in the "Retrieved Segments" window or the tabular
"Overview of Coded Segments". To export the retrieved segments, click the Export icon  in the
toolbar of the window.

Tip: Alternatively, you can start the export for the "Retrieved Segments" window from the ribbon
menu: Reports > Export > Retrieved Segments.

The following option menu will appear:
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Options for the export of retrieved segments

In the left window, specify which supplementary information should be exported in addition to the
coded segments, including:

Memos - If you select this option, all memos assigned to the coded area of the segment, displayed in
the "Retrieved Segments" window, will also be exported. When exported as an Excel document or as
a web page, all memos from one coded segment will be included in a single cell.

Duration (for transcripts with timestamps) - For segments from a transcript, both the time at which
an coded text starts and the time span of the coded text are exported. You can then check when
exactly a statement in an interview was made. The specific points in time and time spans are
determined according to the timestamps in the transcript and the number of characters of a coded
segment and, if necessary, extrapolated if the coded segment does not exactly match the time
stamps.

Other codes assigned to the segments - For each coded segment, the export file writes which codes
were assigned to it. Each overlap with another code is listed, including its weight. With the option
Only activated codes, only the activated codes are taken into account. With the option List in own
columns, each code will be exported into a single column when exporting to Excel or HTML.

Favorite variables – When this option is selected, all variables that are selected as "favorites" in the
"List of document variables“ will be exported. For export in XLS/X or HTML format, each favorite
variable will be assigned to its own column.

Document Variables (x selected) - Click on the button with the three points to select at which point
variables should be exported. With each coded segment, the variable values of the corresponding
documents are then additionally exported. When exporting as an Excel document or as a webpage in
HTML format, each variable has its own column.

In the section to the right, you can specify which source data should be exported with each segment.
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Choose between the three export formats: Word Document (DOCX), Excel Document (XLSX), and
Web page in HTML format. After clicking on OK, you can enter the file name and location, whereupon
the export is started and the exported file is opened with the preset program for the respective file
type.

Copying retrieved segments to the clipboard - including source
information

In a research project, citations (for example, interview passages) are often integrated into the final
report. It is important to note the source information of these citations - the document and
paragraph or line from which they were taken. MAXQDA simplifies this process with the function
Copy Segment (with Source Information). You can access this function by right-clicking on the
source information in the “Retrieved Segments” window.

Copy a retrieved segment to clipbard

Tip: The function can also be activated by right-clicking on
(1) a coding stripe in the "Retrieved Segments" window,
(2) a coding stripe in the "Document Browser", or
(3) a line in the "Overview of Coded Segments".

When you open the function from the context menu, MAXQDA copies the selected segment into the
clipboard. Now you can paste the citation into your word processing program by pressing Ctrl+V
(Windows) or ⌘+V (macOS). At the end of the citation, the document name from the “Document
System,” as well as the paragraph or line number, will automatically be inserted.
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Exported retrieved segment including source information

Printing retrieved segments

To print out the retrieved segments,

Click on the Print retrieved segments icon  in the “Retrieved Segments” window toolbar.
Click in the window to place it in focus (recognizable by the green marker in the window title),
and use the keyboard shortcut Ctrl + P (Windows) or ⌘ + P (macOS) or,
Switch to the Reports tab, click the Print icon and select the Retrieved Segments option.

Please note: If you want to be able to edit aspects of the formatting, it is recommended that you first
export the retrieved segments, open them for edit in a word processor, and then print them out.

Code Retrieved Segments
MAXQDA makes it possible for you to code some or all of your retrieved segments in the “Retrieved
Segments” window. In this way, you can search and code quickly within specific segments that have
been compiled.

Let’s say you've carried out a retrieval of the intersections between the codes “Health” and
“Relationship” for all persons in your interview sample. You can then choose to code all of these
segments with a code called “Health + Relationship”. To do this, click on the  Code retrieved
segments with a new code in the toolbar of the "Retrieved Segments" window and enter the new
code name. After clicking OK, MAXQDA will code all segments in the "Retrieved Segments" window
with the new code.
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Code retrieved segments with a new code

Please note: If the listed coded segments overlap because the same location in the data material
was coded with different currently activated codes, then the outermost segment boundaries of the
overlapping segments are used. The number of newly created coded segments may therefore be
less than the number of listed coded segments.
Coding segments in the “Overview of Coded Segments”

You can also add a code to the segments listed in the “Overview of Retrieved Segments”. Two
symbols are available in the toolbar of the window for this purpose:

Code segments via the overview window

Code retrieved segments - an existing code is assigned to the selected retrieved segments of the
list. Several rows can be selected by holding down the Ctrl key (Windows) or the ⌘ key (macOS). If
no rows are selected, the entire table is coded. Existing codings with the selected code are not
changed.

Code retrieved segments with a new code - the selected retrieved segments of the list are
assigned a code, which can be created by clicking on the icon. Several rows can be selected by
holding down the Ctrl key (Windows) or the ⌘ key (macOS). If no rows are selected, the entire table
is coded.
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If you code the segments with an existing code, a dialog appears in which you can select the code
from the "Quicklist of Codes". The quicklist contains all codes last used or clicked, so you may need
to click on the desired code before starting the function.

Autocode options window

Coding text segments in the "Retrieved Segments" window

As soon as text segments are displayed in the "Retrieved Segments" window, you can select any part
of these segments and drag and drop them onto a code in the "Code System". MAXQDA then
generates a coded segment of the selected text section and assigns it the selected code.

Code text segments via the “Retrieved Segments” window

Please note: You can’t use this function if text passages from different segments is selected.

Coding text passages in the “Overview of Coded Segments”

You can similarly code text passages in the “Overview of Coded Segments”:

Select a text section in the upper window area in the “Overview of Coded Segments”.1.
Use your mouse to drag your selection onto a code in the "Code System".2.
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Code text segments via the “Overview of Coded Segments” window

Simple Coding Query
The Coding Query tool facilitates the retrieval process and the compilation of coded segments. This
tool allows you to control all essential settings from within a dialog window. Before opening the
Coding Query tool, you should activate the selected documents and codes. You can then open the
"Coding Query" dialog window from the Analysis tab: click on the small arrow next to Complex
Coding Query and select Coding Query from the drop-down menu.

The following window will then appear:

You can determine various settings for the query from the dialog window:

Only activated documents – Select whether all documents, or only activated documents, should be
considered in the query. The number in brackets indicates how many documents are currently
activated.
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Only activated codes – Same options as for Documents.

Include subcodes – If selected, subcodes of codes will be included in the query.

Use weight filter – The output of coded segments can here be limited to segments of a specific
weight range.

Only coded segments of users – The output of coded segments can here be limited to segments
that were created by a specific user.

Complex Coding Query
By default, the “Retrieved Segments” window shows all segments that are coded with the activated
codes in the activated documents. If several codes are activated, they are OR-linked, i.e., it does not
matter with which activated code a segment was coded to be listed.

Using the Complex Coding Query instead, you can search for coded segments, while logically
combining several codes, for example, outputting only segments where several of the activated
codes overlap or where another code has been assigned nearby.

How to run a Complex Coding Query

Maximize the "Retrieved Segments" window by clicking on its name at the bottom of the1.
screen (if the window is not already open).
In the menu ribbon, click on Analysis > Complex Coding Query. Alternatively, click on the2.
button Mode: <current query mode>, which is displayed in the "Retrieved Segments" window.

The following dialog window will open:
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Complex Coding Query window

The dialog window has the following aspects:

The "Function" field allows you to choose the analysis function, that is, a combination mode
of the codes, the operation of which is described in each case.
Below that, there are three window sections, labeled A, B, and C.
Section A is needed for every analysis function and holds the selection of codes to be
included in the selection function. To add codes, drag and drop them from the Code System
window or click on the button All activated codes to include the currently activated code
selection in the "Code System" window.
Section B is needed for some retrieval functions. You can drag and dop only one code into the
section. you can do so from the quick list (instead of using drag and drop, you can click on
the button with three dots to open a list with last used codes; to transfer a code to the quick
list, simply click on it in the "Code System" first).
Section C allows you to set certain parameters (for example, the maximum distance between
two coded segments).
The "Results" field underneath offer functions to select what should be listed as a result in the
"Retrieved Segments".

The "Options" section lets you apply the following settings:

Only activated documents [number of currently activated documents] - the query is limited to the
currently activated documents. You can also adjust the activation in the “Document System” when
the dialog window is open.

Include subcodes - when this option is activated, not only the selected codes but also their
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subcodes are taken into account. Think of this option as follows: the codes in the code system are
collapsed and all coded segments of the subcodes are included in the coding query. Details on this
option can be found in the Include Subcodes in Retrieval section. This option can also be activated
in the status toolbar after you have completed your search.

Use weight filter - if the option is activated, only the coded segments whose weight is within the
entered range are retrieved. The weight filter can also be set in the status bar after a successful
search.

Only coded segments of users - if this option is activated, only the coded segments created by the
selected users are taken into account.

At bottom right, you can see how many segments have been found for the current query.

The retrieval begins when you click on the Start button.

The following table gives you an overview of the various analysis functions:

Name Description

Intersection
(”small picture”)

Retrieve only the part segments that have all of the codes listed in "A"
assigned to them.

Intersection (Set) Retrieve only the part segments that have at least X of the codes listed in
"A" assigned to them (the number X is specified in "C").

Overlapping
(”big picture”)

Retrieve the full segments where at least one part has all the codes listed
in "A" assigned to it.

Only one code Search for segments where only one of the codes listed in "A" is assigned
(and none of the other codes listed in "A").

Only this code Search for segments where the code selected in "B" is assigned, but none
of the codes listed in "A" are assigned.

If inside Search for segments assigned to any one of the codes listed in "A" that
are also completely surrounded by a segment assigned to the code
selected in "B".

If outside Search for segments assigned to any one of the codes listed in "A" that
has no overlap or intersection with a segment assigned to the code
selected in "B".

Followed by Search for segments assigned to any one of the codes listed in "A" that is
followed by a segment assigned to the code selected in "B" within no
more than X paragraphs. The number X is specified in "C". (Does not work
in image or PDF documents.)

Near Search for segments assigned to any one of the codes listed in "A" that is
preceded or followed by a segment assigned to the code selected in "B"
within no more than X paragraphs. The number X is specified in "C".
(Does not work in image or PDF documents.)

You can see which retrieval function is currently active in the top right corner of the "Retrieved
Segments" window.

https://www.maxqda.com/help-mx24/segment-retrieval/include-subcodes-in-retrieval
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Complex Coding Query output in the "Retrieved Segments" window

Please note: If there are no segments shown in the “Retrieved Segments” window, it could be
because a complex retrieval function was accidentally activated. You can quickly check for this in
the status bar.

Complex Retrieval Functions
Intersection (“small picture”)

Definition: Retrieve only the part segments that have all of the codes listed in "A" assigned to them.

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated codes in3.
Window A.

Attention: All selected codes in Window A must be assigned to a segment in order for them to be
listed!

Changing the activations in the “Document System” immediately changes your results.

It is often helpful for this function to activate the option Include the subcodes, so that all
combinations of intersections between each code (and its subcodes) are automatically included.
The option is available by clicking on the gear icon for preferences in the "Retrieved Segments"
window.

Example:
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Intersection (Set)

Definition: Retrieve only the part segments that have at least X of the codes listed in "A" assigned to
them (the number X is specified in "C").

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated codes in3.
Window A.
Set the minimum number of codes that must intersect in Window C.4.

You can see in the “Results” window how many retrieved segments would be found based on
intersections.

If, as displayed in the example, the codes “Friends”, “Happy”, and “Leisure” are entered in Window A,
and you have entered in Window C that at least two intersections are required, only the intersection
of “Friends” and “Leisure” fulfills the condition and would be listed in the “Retrieved Segments”
window. Only the section of the coded segments that is coded with two of the codes is displayed.

Example:
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Overlapping (“big picture”)

Definition: Retrieve the full segments where at least one part has all the codes listed in "A" assigned
to it.

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated codes in3.
Window A.

Attention: Segments will only be listed if they are coded with all codes listed in Window A.

The “Overlapping” function works just like the “Intersection” function, except that the results are
displayed differently. The results of “Overlapping” include the entirety of each coded segment that
overlaps, rather than just showing the section that is coded with both codes.

As with the “Intersection” function, it is often helpful to include subcodes in the query. Then all
combinations of subcodes are tested for overlap.

Example:
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Only one code

Definition: Search for segments where only one of the codes listed in "A" is assigned (and none of
the other codes listed in "A").

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated codes in3.
Window A.

If the codes “Friends” and “Happy” are in Window A, the first two examples on the right would be
included in the retrieval, because they don’t overlap each other. The fact that "Happy” and “Nature”
overlap makes no difference, because “Nature” is not in Window A. The last example would not be
included in the retrieval because the codes “Friends” and “Happy” intersect.

Example:
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Only this code

Definition: Search for segments where the code selected in "B" is assigned, but none of the codes
listed in "A" are assigned.

This function is very similar to the “Only One Code” function, but it targets only one selected code.
The target code is selected in Window B. The other codes are selected as usual in Window A.

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated codes in3.
Window A.
Select the relevant code in Window B. The fastest way to do this is to drag it with the mouse4.
from the "Code System" into Window B.

Example: The code “Friends” is the selected code in Window B. “Nature” and “Happy” are the codes
in Window A. When either “Nature” or “Happy” intersect with “Friends”, “Friends” is not listed. This is
the case in the second and third example on the right. Only the first example shows an instance of
“Friends” that isn’t intersected by “Nature” or “Happy”. It would be listed in the “Retrieved Segments”
window.

Example:
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If outside

Definition: Search for segments assigned to any one of the codes listed in "A" that has no overlap or
intersection with a segment assigned to the code selected in "B".

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated codes in3.
Window A.
Select the relevant code in Window B. The fastest way to do this is to drag it with the mouse4.
from the "Code System" into Window B.

Example: This function would be helpful if you were looking for text segments in which people talk
about happiness, but don’t want to include those instances that are in the context of these peoples
friendships.

“Happy” is in Window A, and “Friends” is in Window B. This means you are looking for instances of
“Happy” that are completely outside of “Friends”. In the example on the right, only the third example
would be called up. In the first example, “Happy” isn’t even there, and in the second, “Happy” is not
completely outside of “Friends”.

Example:
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If inside

Definition: Lists segments where the code in Window A is completely surrounded by the code in
Window B. Results can be the segments of the inner code (Window A) or the outer code (Window B).

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated codes in3.
Window A.
Select the relevant code in Window B. The fastest way to do this is to drag it with the mouse4.
from the "Code System" into Window B.

Example: Let’s say you are interested in the things people said about their happiness, but only in the
context of statements about their friends. In the examples on the right, only the first shows a case
where “Happy” (Window A) is found completely inside “Friends” (Window B). That is not the case in
the second or the third example.

Example:
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Followed by

Definition: Search for segments assigned to any one of the codes listed in "A" that is followed by a
segment assigned to the code selected in "B" within no more than X paragraphs. The number X is
specified in "C". (Does not work in image or PDF documents.)

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated codes in3.
Window A.
Select the relevant code in Window B. The fastest way to do this is to drag it with the mouse4.
from the "Code System" into Window B.
Enter a maximum allowed number of paragraphs between the codes in Window C. If zero is5.
entered as a number, B must begin in the same paragraph as A.

You can define what results should be generated as result of this function: The segments of the
code in Window A which are within distance X before Window B's code, the coded segments of
Window B's code, or both. The last option, however, will rarely be necessary.

In the example on the right, we are looking for “Friends” (Window B) following “Happy” (Window A)
within one paragraph. This condition applies to both appearances of “Happy”, because it is directly
followed by “Friends” in both cases.

Example:
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Near

Definition: Search for segments assigned to any one of the codes listed in "A" that is preceded or
followed by a segment assigned to the code selected in "B" within no more than X paragraphs. The
number X is specified in "C". (Does not work in image or PDF documents.)

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated codes in3.
Window A.
Select the relevant code in Window B. The fastest way to do this is to drag it with the mouse4.
from the "Code System" into Window B.
Enter a maximum allowed number of paragraphs between the codes in Window C. If zero is5.
entered as a number, B must begin in the same paragraph as A.

You can define what results should be generated as result of this function: The segments of the
code in Window A which are within distance X before Window B's code, the coded segments of
Window B's code, or both. The last option, however, will rarely be necessary.

Example: We are looking for places where “Happy” (Window A) and “Friends” (Window B) are found
within one paragraph of each other (Window C). “Happy” is found two times in the screenshot, both
times within one paragraphs of “Friends”.

We chose to view the Window A code in the Retrieved Segments, but we could have theoretically
chosen to list the Window B code or even both of them.
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Example:

Include Subcodes in Retrieval
A hierarchical system of codes can be constructed with MAXQDA. The program offers an easy way
to make use of the hierarchical structure.

Example

Imagine you have defined the following codes:

Success criteria [parent code without coded segments]
ecologically
economically
socially

Ideal projection [parent code without coded segments]
ecologically
economically
socially

If you now want to assemble all the coded document locations that have been assigned a subcode
of "success criteria" as well as any subcode of "ideal projection", you could use the Complex Coding
Query to search for all possible overlaps of two subcodes. This approach would, however, be very
cumbersome, especially if you are dealing with still deeper code hierarchies or a large number of

https://www.maxqda.com/help-mx24/segment-retrieval/logical-combinations-codes
https://www.maxqda.com/help-mx24/segment-retrieval/logical-combinations-codes
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subcodes.

Including subcodes in a code search

MAXQDA offers the convenient option including subcodes in a coding query. To do this, select the
Include subcodes option in the local settings of the “Retrieved Segments” window. In the example, it
would be sufficient to only activate the two upper codes and choose the Include subcodes option.
Now all subcodes of the two activated codes are taken into account in the search for overlaps.

 

The “Include subcodes” option in the preferences menu of the “Retrieved Segments” window

Tip: You can also select the option directly in the status bar by clicking on the icon – this acts as a
switch and changes the setting.

Include subcodes in the simple Coding Query

The option for subcodes also applies to the simple coding query: in this case it’s sufficient to
activate a parent code in order to automatically display the coded segments of its non-activated
subcodes in the “Retrieved Segments” window.

But, as described, the search function's full potential can be seen in the Complex Coding Query, in

https://www.maxqda.com/help-mx24/segment-retrieval/logical-combinations-codes
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which several codes are combined with one another.

Use Weight Filter
All segments that appear in the “Retrieved Segments” window have their weight listed next to the
source data (in brackets after the code).

Weight scores “Retrieved Segments” window

These weight scores can be used for the retrieval process. The user can define a range for the
weight scores in order to retrieve only those document segments with scores inside of that range.
To define this area, click on the gear symbol in the upper right corner of the window of the "Retrieved
Segments" window, and select Edit weight filter.

The following window will then appear, in which you can enter any number from 0 to 100.
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Adjust the weight filter's range

To turn the filter on and turn it on, you must switch it on again: Click on the gear symbol in the
"Retrieved Segments" window again and select Use weight filter.

This will cause only those segments to be displayed in the “Retrieved Segments” window that have a
weight score within the defined range. The weight filter affects all retrieval functions, including
“Intersection” and all functions of the Complex Coding Query.
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14 – Visual Tools

Code Matrix Browser (Codes by Cases)
The Code Matrix Browser (CMB) visualizes which codes have been assigned to which documents.
The matrix provides an overview of how many document segments from each document have been
assigned a specific code, and this for each existing code.

The Code Matrix Browser is constructed as follows: Documents are listed in the columns while
codes are listed in the rows. The symbols at the conjunction points represent the number of coded
segments that are coded with a particular code. The larger the symbol, the more coded segments
are assigned to the code in question. Document groups, document sets, or focus group speakers
can also be displayed in the columns of the CMB, for example, to compare individual cases or
groups of cases.

The Code Matrix Browser

The Code Matrix Browser can be opened in the following ways:

Selecting Code Matrix Browser from the Visual Tools menu tab, or
using the keyboard shortcut Ctrl+Alt+M (Windows) or ⌘+⌥+M (macOS)

Code Matrix Browser options

After starting the Code Matrix Browser an options window will appear, which allows you to change
display options.
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Code Matrix Browser options dialog window

First, you have to decide whether the results should be grouped or not:

Documents – No grouping, every document has a column.

Document groups – The columns are made up of document groups. The coded segments of the
documents in each group will be summed up. If the "Top level" option is selected, all document
groups  from the top level in the "Document System" window are displayed in the columns. The
documents from the second level document groups are added to the top level document groups. If
the "Second level" option is selected, only the document groups that are contained in another
document group are displayed as columns.

Document sets – The columns are made up of document sets. The coded segments of the
documents in each document set will be summed up.

Focus group speakers – Focus group participants are displayed in the columns.

Further options allow you to restrict the visualization to selected data:

Only for activated documents – Only the activated documents will be taken into account.

Only for activated focus group speakers – Only the activated speakers are displayed in the columns.
This option is only visible if you selected the focus group participants to be displayed in the
columns.

Only for activated codes – Only the activated codes will be displayed as rows.

Use weight filter – Only coded segments with a weight within the limits of the currently defined
weight filter will be used.
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Code Matrix Browser toolbar

The toolbar is the first thing you will see at the top of the Code Matrix Browser window. Here you
have access to the following functions:

Quote Matrix – Displays the coded segments associated with the cells in an interactive view.

Display codes with hierarchy - If the option is activated, the codes are displayed in the tree
structure of the code system. Even if the “Only activated codes” option is selected, non-activated
upper codes are also included to preserve the tree structure (for these, however, all frequencies will
be set to 0, even if coded segments exist; that is, no symbols or numbers will be displayed on the
nodes for these rows). If the option is deactivated, all codes are displayed on one level. If the “Only
activated codes” option is activated, then only the activated codes are displayed.

  Names, columns: none/short/full – Depending on this setting, the names in the
columns may not be displayed, may be displayed with a standardized short width, or may be
displayed in full. Hover the mouse over a column header to see the full name, including the
document group if applicable.

Calculation of symbol size refers to all coded segments.

Calculation of symbol size refers to the column.

Calculation of symbol size refers to the row.

Visualize code frequencies as squares, circles, values, or heatmap.

Count hits per document only once – Representation in the CMB does not refer to the number
of segments, but to the documents, i.e., it is only considered whether the relevant code is present in
a document or not. With collapsed subcodes, the code frequencies of the subcodes are summed up.

Binarize view – Regardless of how many coded segments are presented in a cell, this function
displays only whether a coding is present or not; the symbol size is therefore unified. Even when a
collapsed subcode with multiple codings is present, only one will be counted.

Sum – Displays the sum of rows and columns.

Sort columns by similarity of code pattern and sum of frequencies – By default, the order of
columns is based on the “Document System”. Clicking this icon, sorts the current display, so that
columns with many codes are placed on the left and columns with few codes on the right. Columns
with identical code patterns and frequencies are placed next to each other. This feature is helpful to
identify patterns and regularities and to find similarities between cases or groups.

Tip: By clicking on a column heading, the rows are sorted according to the frequencies in the clicked
column. However, this is only possible if the option Display codes with hierarchy is switched off.

Refresh – Updates display by recalling the function.
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Information window for a node

The size and color of the symbols in the matrix show how many segments of a code have been
assigned to each document, document group, document set, or focus group speaker. The larger the
symbol, the more segments were assigned for this code.

When you move the mouse cursor on a node, a small info window appears:

Info window in the Code Matrix Browser

If documents are displayed in the columns, the name of the document, the code or subcode, and the
number of coded segments assigned to the code are shown in the box. If the option Count hits only
once per document is selected, the actual number of codes for the node is additionally displayed in
brackets behind the number used for the visualization. In the example, “1(3)” means that 1 coded
segment for “Typical workday” is displayed in the column with the document "Riley", but actually,
there are 3 coded segments with this code in the document.

Tip: If you have written a summary for a node document x code in MAXQDA’s Summary Grid, it will
be displayed in the info window on a Code Matrix Browser’s node (as shown in the previous
screenshot).

Compiling the coded segment for a node

The coded segments “behind” a node, can be called up immediately by double-clicking on the node.
The relevant document and code are then activated and the coded segments appear in the
“Retrieved Segments” window. It is possible to keep the CMB open, allowing one to easily view the
contents of different nodes.

How is the symbol size determined?

MAXQDA determines the smallest and largest code frequency of all displayed nodes and then
divides the distance between these two values into seven equally-sized value ranges. For the
smallest value range, the smallest symbol is used and for the largest value range the largest. In
addition, the maximum distance between the displayed code frequencies is taken into account. For
example, if codes occur only once or twice in the displayed documents, this distance is very small,
and neither the smallest nor the largest squares will be used, but two medium-sized ones, to not
over-emphasize the difference. The following graphic shows which square sizes are used at which
distance between the smallest and largest values (the range). If the smallest displayed value is e.g.
5, and the highest is 8, then the range is 8-5 = 3. The cells with value 5 are then assigned the
smallest square from row “Range = 3”, the cells with value 8, the largest from this row. If all the
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visualized numbers are identical (“Range = 0”), a medium-sized square will be displayed for all
values.

Square sizes in the Code Matrix Browser

Collapsing or expanding codes can change the overall view because this may change the smallest
and/or the greatest value in the display.

If the Calculation of symbol size refers to the column/row option is selected, the described
mechanism is applied individually to each column or row.

Store view in Questions – Themes – Theories

In the Questions – Themes – Theories window, you can collect and comment on all the important
results of your project. Click the Send to QTT Worksheet icon in the upper right corner to save the
current view in a new or existing worksheet.

Exporting the Code Matrix Browser

In the CMB toolbar, there are option on the right that can be used to export the display. You can copy
the visual display to clipboard or export it as an image. Further, you can export the code frequencies
to Excel or HTML. When exporting the code frequencies, the columns and rows are swapped to
allow easy import into SPSS and other statistical software.

https://www.maxqda.com/de/hilfe-mx24/19-questions-themes-theories-q-t-t/die-idee-hinter-questions-themes-theories
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Code Relations Browser (Code Co-
occurrences)
The Code Relations Browser (CRB) visualizes the relationships between codes and displays which
codes co-occur how often within a document. From this graphical representation, it is much easier
to see at a glance which codes are associated with each other than from a number matrix.

The CRB is constructed as follows: Codes form the columns and the rows. The symbols at the
individual nodes indicate how many segments were coded with both the row's code and the
column's code. The larger the symbol, the more segments there are.

An example of the Code Relations Browser visualization

You can open the CRB in different ways:

Click on Code Relations Browser in the Visual tools menu tab,
Use the keyboard shortcut Ctrl+Alt+R (Windows) or ⌘+⌥+R (macOS)
Click the Code Relations Browser icon  in the "Retrieved Segments" window.

Code Relations Browser options

After opening the Code Relations Browser an options window will appear, which allows you to
change display options. Often, only the activated documents might be of interest, for example.
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Code Relations Browser options dialog

First, you have to decide which codes will be shown as rows:

Selected codes – Click the button with three dots to open a window where you can select codes to
be displayed in the Code Relations Browser.

Activated codes – Only the activated codes will be shown as rows.

All codes – All codes will be shown, the order being the same as it is in the “Code System”.

A similar decision has to be made for the columns in the Code Relations Browser, with the
additionally option of Choose top-level code. Selecting this option will open another dialog window
after pressing OK, allowing you to select as many top-level codes as you want. The selected top-level
codes and their subcodes will be shown as columns in the Code Relations Browser.

In the section “Type of analysis” you can select which relations MAXQDA will analyze:

Intersection of codes in a segment – Only “real” overlaps of codes will be analyzed, which means
that a segment has to be coded with both codes and the codes need to overlap.

Proximity of codes in same document – Alternatively the Code Relations Browser can analyze how
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often two codes are present at a defined distance from one another. The distance can be set to a
specific number of paragraphs (text), rows (tables), or seconds (audio/video).

If you search with the “Proximity” function and chose distance “0” you may find more hits than
searching for intersections of codes. The function “Proximity” only evaluates if two codes are
assigned somewhere in the same paragraph – not at the same segment.

Please note: The “Proximity” function does not work for PDF documents and images.

Occurrence of codes in the same document – In this analysis type the Code Relations Browser
shows in how many documents both codes occur. The codes do not have to intersect or be in
specific proximity to each other.

In the lower area of the options window, you can restrict the Code Relations Browser display to
certain documents or parts of documents coded with specific codes.

Only for activated documents - This setting is used to restrict the analysis to the documents
currently activated in the “Document System”.

Only for segments of the following codes - This setting limits the search to segments coded with
specific codes. If you drag a code from the "Code System" into the field with this mouse, MAXQDA
only analyzes code co-occurrences within segments that have been coded with these codes.

Code Relations Browser toolbar

At the top of the screen, you will find the toolbar with the following functions:

 Code Map – Opens a "Code Map" visualization that displays the relations of the codes on a
map. All codes that occur both in the rows and in the columns will be taken into account. The Code
Map is created based on the code frequencies displayed in the Code Relations Browser. However,
whether a code is collapsed in the left list or not will not be considered.

Interactive Quote Matrix – Displays the coded segments in an interactive matrix. When
choosing “Intersection of codes in a segment” as the type of analysis, only the overlapping part of
the segments will be displayed in the output. In “Proximity of codes in same document” mode,
segments that are close to each other will be outputted.

 Display codes with hierarchy - If this option is activated, the codes are displayed in the
hierarchical structure of the code system, even if the option "Only activated codes" is set, non-
activated parent codes are also included to maintain the tree structure. If the option is deactivated,
all codes are displayed on one level. If the "Only activated codes" option is activated, then only the
activated codes are displayed.

   Names, columns: none/short/full – There are three possible options for displaying
the names of documents, document groups, document sets, and focus group participants in the
column headings:

no names: The column headers remain empty.
short names: Display of the first eight characters (usually recommended).
full names: Full name will be displayed.

https://www.maxqda.com/help-mx24/visual-tools/code-map-position-codes-according-to-similarity
https://www.maxqda.com/help-mx24/mixed-methods-functions/quote-matrix
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Display nodes as squares, circles, values, or as heatmap with values.

Count hits per document only once – The Code Relations Browser display will be based not on
the number of code relations but of documents, meaning it will analyze only whether a code relation
occurs in a document and not how often. For collapsed subcodes, the code relation frequencies of
the subcodes will be summed up. When using the analysis mode “Occurrence of codes in same
document” this option is selected automatically and hidden from the display window.

Binarize view – If selected, the Code Relations Browser will show only whether a code relation
is present or not; all symbols are displayed in the same size. For collapsed subcodes, the code
relations frequency of the subcodes will not be aggregated.

Sum – displays the sum of rows and columns.

Sort columns by similarity of code pattern – By default, the order of columns is based on the
“Document System”. Clicking this icon, sorts the current display, so that columns with many codes
are placed on the left and columns with few codes on the right. Columns with identical code
patterns and frequencies are placed next to each other. This feature is helpful to identify patterns
and regularities and to find similarities between cases or groups.

Tip: You can hide columns from the display by right-clicking on the column header and choosing
Remove.

Refresh – updates display via the Refresh function.

Information window for a node

Each symbol in the matrix represents the number of co-occurrences of the two codes. The larger the
symbol, the larger the number of co-occurrences. If you hover over a node with your mouse, a small
window appears informing you about the node codes and the number of their relations.

How are symbol sizes determined?

How MAXQDA determines the symbol sizes is explained in detail in the Code Matrix Browser
section.

Compiling the coded segments for a node

You can jump to the segments with co-occurring codes by double-clicking on the node representing
them. MAXQDA will compile all the segments in question in the “Retrieved Segments” window. The
CRB can remain open, so you can quickly go from one set of co-occurring codes to another.

Please note: If you are in mode "Proximity" and double-click on a node, that has collapsed codes, the
collapsed subcodes will be expanded automatically and only the higher code will be evaluated, not
the previously collapsed codes.
If you are in mode “Occurrence of codes in same document” and double-click on a node, all of the
documents in which the relation occurs are activated.

https://www.maxqda.com/help-mx24/visual-tools/code-matrix-browser-visualizing-codes-per-document
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Export adjacency matrix for network analysis software packages

If you want to perform a network analysis of categories with a program like Gephi, you can export
the results of the Code Relations Browser as an adjacency matrix:

Clicl the Export icon  at the top right of the window.1.
In the file dialog, select "Adjacency Matrix (*.xlsx)" as the file format.2.

MAXQDA exports the frequencies of relations as follows:

The matrix is exported as if all codes were expanded.
Codes, that are displayed only in the columns are added to the rows and vice versa. This
creates a symmetrical matrix.
If the name of a code occurs more than once, the name of the parent code is prefixed to
ensure uniqueness of the code names.

Store view in Questions – Themes – Theories

In the Questions – Themes – Theories window, you can collect and comment on all the important
results of your project. Click the Send to QTT Worksheet icon in the upper right corner to save the
current view in a new or existing worksheet.

Exporting the Code Relations Browser

In the CRB toolbar, there are three icons on the right that can be used to export the display:

Copy current display as an image to clipboard - Copies the visible area to the clipboard so that you
can easily paste the results into reports or presentations by, for example, using Ctrl + V (Windows)
or ⌘+V (macOS).

Open as Excel table – Exports the complete matrix with the frequencies as an Excel file and opens
it. The columns and rows are swapped to allow easy import into SPSS and other statistical software.

Export – Exports the complete matrix with the frequencies in Excel or HTML format. The columns
and rows are swapped to allow easy import into SPSS and other statistical software. Exporting as a
graphics file is also possible.

Code Map (Similarity of Codes)
In the Code Map, selected codes are displayed as on a map. The more two codes co-occur, i.e., the
more similar they are in terms of their use in the data, the closer they are placed together on the
map.

https://gephi.org/
https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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A Code Map

Creating a code map

To create a code map, follow these steps:

Select Visual Tools > Code Map in the ribbon menu. The following dialog box will then appear:1.
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Options for a new Code Map

Use your mouse to drag all the codes from the “Code System” that you want to place on the2.
Code Map into the upper area of the dialog box. You can also activate codes and transfer
them directly to the dialog box via the Paste activated codes button.
3. Select one of the following three options, which determine what type of co-occurrence3.
should be analyzed to determine the similarity between two codes:
Intersection of codes in a segment – Counts the number of times two codes have been
assigned to the same segment. It is sufficient, if codes intersect; they do not have to cover
100% of the same area.
Proximity of codes in same document – Counts the number of times two codes were
assigned at a definable distance in the same document or in the same media file. You can
define the maximum distance in the number field.
Occurrence of codes in same document – Counts the number of documents in which two
codes occur. The location of the two codes is irrelevant; they must both have been assigned
at least once in the document.
If necessary, restrict your analysis to currently activated documents only.4.

Click on OK and MAXQDA will open an accordingly generated code map:
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Code map window

What does a Code Map display?

Each circle symbolizes a code, with the distances between two codes representing how similarly the
codes have been applied in the data. As a further option, the larger the circles the more code
assignments have been made with that code. Colors can be used to highlight groupings (clusters).
In addition, connecting lines between the codes can be activated, which indicate which codes co-
occur. Optionally, the connection lines are displayed thicker the more coincidences there are
between two codes.

Please note: (1) If a code selected in the options dialog box does not occur together with any other
selected code, it will not be placed on the Code Map. (2) Several codes may be placed at the same
position on the map if their similarity to other codes is identical.

Toolbar options

You can use the toolbar at the top to adjust various settings for your Code Map.

The first three symbols allow you to set what type of co-occurrence is analyzed to determine the
similarity between two codes. These are the three options explained for the settings dialog box
above:

 Analyzed relation of codes – Intersection of codes in a segment.

 Analyzed relation of codes – Proximity of codes in same document.
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 Analyzed relation of codes – Occurrence of codes in same document..

Changing these similarity settings recalculates the display of your code map.
Futher options:

 Display code frequencies - Displays the code frequency in the analyzed documents after the
code name.

 Size of code symbols reflects code frequency – The more frequently a code is used, the larger
its symbol will be displayed.

 Font size reflects code frequency – The more frequently a code is used, the larger its name will
be displayed.

 Grid – Turns on and off a grid, as known from a real map, to better estimate the relative
distances between codes. The grid works with a fixed distance of 100 pixels. Distances can
therefore only be compared within a map, not between different maps.

 Font – Select a font for the display, e.g. to adapt it to the font used in your publication.

Increase and decrease font size – Adjusts the font size of the code namessubcode names.

 – Determines the color of the code symbols:

Cluster (map position) – Codes are assigned a color according to their group affiliation. The
positions of the codes on the map are taken into account for the group identification. The
clusters do not take into account the exact calculated distances, but only their projection on
the two-dimensional surface. That is, codes can be grouped together that are further away
from each other in the multidimensional space. You can determine the number of clusters in
the numeric field.
Cluster (distance matrix) – Recommended setting: Codes are assigned a color according to
their group affiliation. The calculated distances between the codes are used for group
determination. Due to the representation on a surface, even codes that are close to each
other can be colored differently (if two codes from different clusters are displayed on the
same map position, a black circle appears instead of the color dot). You can determine the
number of clusters in the numeric field.
Code System – Color is taken from the "Code System".
Uniform – All codes symbols are assigned the same color.

 Zoom out, Zoom in – Zooms in and out of the displayed section of your map.

 Refresh – Reopens the options dialog box to select other codes or documents.

Store view in Questions – Themes – Theories

In the Questions – Themes – Theories window, you can collect and comment on all the important
results of your project. Click the Send to QTT Worksheet icon in the upper right corner to save the
current view in a new or existing worksheet.

https://www.maxqda.com/de/hilfe-mx22/19-questions-themes-theories-q-t-t/die-idee-hinter-questions-themes-theories
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Export code map

Symbols for export and further processing are available at the top right-hand corner:

 Copy current view to clipboard – Inserts a high-resolution image into the clipboard so you can
paste it directly into a report or presentation.

Save clusters as variables – The cluster assignments of the individual codes are saved as
variables in order to be able to access the assignments later. After clicking on the icon, the Data
Editor for the code variables opens, where a new column with the cluster membership has been
added.

 Save as map in MAXMaps - Creates a new map in MAXMaps, the tool for concept maps in
MAXQDA, and inserts the content of your code map here. You can edit the map later via Visual Tools
> MAXMaps.

 Export – Saves the display as an image file in PNG or SVG format. If you select Excel (XLSX) as
the export format, all the calculated values are entered in the export file: (similarity matrix, distance
matrix, and coordinates).

Code Map interactivity

Code Maps are interactive:

Click on a code to select it in the "Code System”.
Right-click a code and select Remove to delete it from the map. The map will then re-generate
itself with the remaining codes.

Opening a code map from the Code Relations Browser

If you use the Code Relations Browser, MAXQDA creates a matrix that displays the co-occurrences
of two codes. Since exactly such an analysis forms the basis for the Code Map, it can also be
opened directly from the Code Relations Browser.

To do this, click on the first icon on the far left:

Open a code map via the Code Relations Browser

MAXQDA will then create a Code Map with all codes that are displayed both in the columns and in
the rows of the Code Relations Browser and that occur together with at least one other of these
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codes.

Please note: (1) In the Code Map that appears, you can’t switch to other analysis modes of the
relationships between codes. The mode will have already been defined in the Code Relations
Browser. (2) Codes collapsed in the Code Relations Browser are not aggregated, instead, all
subcodes are considered individually.

Notes on the analysis process and presentation

The classic multidimensional scaling method is used to position the codes on the map.

For this purpose, a similarity matrix is first calculated according to the display in the Code Relations
Browser and then converted into a distance matrix. For the conversion, the column sums are
calculated first, so for each code it is determined how often it occurs together with any other code.
The maximum of these column sums is defined as the maximum possible similarity. In each cell, the
similarity of two codes is subtracted from this maximum.

Therefore, a distance of 0 means that two codes only ever occur together, i.e., never without the
other. A distance corresponding to the maximum means that these codes never occur together.
Please note that due to the reduction to a maximum of 2 dimensions (i.e. on one map) and this
consequent angle of view, two codes may appear visually closer together than the distance matrix
would suggest.

If the Color: Cluster (map position) option is selected, the codes are clustered and colored using a
hierarchical cluster analysis of the positions on the two-dimensional surface. If the Color: Cluster
(distance matrix) option is selected, clustering is performed using the underlying distance matrix.
Unweighted average linkage is used as the clustering method.

If the option Size of code symbols reflects code frequency is enabled, the determination of symbol
sizes is similar as the calculation of symbol sizes in the Code Matrix Browser and Code Relations
Browser: MAXQDA determines the smallest and largest code frequency of all displayed symbols and
then divides the distance between these two values into seven equally-sized value ranges. The
smallest value range gets the smallest symbol and the largest value range the largest. In addition,
the maximum distance between the displayed code frequencies is taken into account. For example,
if codes occur only once or twice in the displayed documents, this distance is very small, and neither
the smallest nor the largest symbols will be used, but two medium-sized ones, so as not to over-
emphasize the difference.

The following image shows which symbol sizes are used at which distance between the smallest
and largest values (the range). For example, if the smallest displayed value is 5, and the highest is 8,
then the range is 8-5 = 3. The cells with value 5 are then assigned the smallest symbol from row
“Range = 3”, the cells with value 8, the largest from this row. If all the visualized numbers are
identical (“Range = 0”), a medium-sized symbol will be displayed for all values.
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Determination of symbol size as dependent on distances

Document Map (Similarity of Documents)
The Document Map is a visual tool that displays selected documents as though they were arranged
on a map. The greater the similarity between two documents with regard to codes assigned to them,
the closer their circle symbols are located to each other; the less similar they are, the further away
they are from each other. If required, the variable values of the documents can also be taken into
account when determining their similarity. Documents that are similar in terms of their code
assignments and variables can be marked with matching colors. Optionally, the size of the circles
themselves can be set to reflect the number of code assignments made in the respective document.
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The Document Map

The Document Map is an ideal tool for visual grouping of cases (documents) and can serve as a
basis for building typologies or more in-depth explorations of the identified groups.

Generating a Document Map

To generate a Document Map:

Select Visual Tools > Document Map in the MAXQDA main menu. An empty document map1.
will appear with its own menu.
In the Document Map window, under Start > Select Documents, select the documents you2.
want to place on the map.
Via Start > Select Codes, select the codes you want to take into account when determining3.
the similarity between documents.

MAXQDA will now place all the selected documents on the map.

Select the analysis mode

Two different modes can be selected in the Start tab to determine the distances between the
documents:

Frequency of Codes/Variable Values – The frequency with which a code has been assigned in a
document is taken into account. So if the code "Parents" was assigned twice to Document A and
three times to Document B, this is considered a difference.

Occurrence of Codes/Variable Values – Only whether a code has been assigned to a document at
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all is taken into account. In the above example, Documents A and B would count as identical with
regard to the code "Parents", because the code was assigned in both cases – how often the code
was assigned does not matter here.

Depending on the selected calculation mode, different similarity or distance measures can be
selected. These are described in detail in the Similarity Analysis for Documents section.

Please note: When several documents are located in the same place because they were coded
identically with regard to the currently selected analysis mode, the number of documents in this
location is displayed instead of just one document. The corresponding documents are listed in full
when you move your mouse cursor over them.
Taking variable values into account

By clicking on the Start > Select Variables icon, you can select document variables to be taken into
account when determining the similarity between documents, in addition or as an alternative to
codes. If the calculation mode “Frequency of Codes/Variable Values” is selected in the Start tab,
variables of the types “Integer” and “Decimal” can be selected. If the variant “Occurrence of
Codes/Variable Values” is selected, variables of the types “Text”, “Date” and “Boolean” can be
selected.

As there may be missing values for the selected documents in a document variable, you have the
option of choosing between two alternatives as to how to proceed in this case:

Missing values: Set to 0 – The variable value is set to 0. Selecting this option usually only makes
sense in the Frequency of Codes/Variable Values mode.

Missing values: Exclude Documents – Documents with at least one missing value for the selected
variables are not placed on the map. In brackets behind this option, you can see how many
documents are affected and therefore not visible on the map.

Document Map interactivity

The Document Map is interactive:

Click on a document to select it in the "Document System".
Double-click a document to open it.
Hover your cursor over a document name or icon: A tooltip will appear displaying which of the
selected codes have been assigned in this document.
Right-click a document and choose Remove to delete it from the map. The map will then
regenerate itself with the remaining documents.
Right-click on a document and select Activate Documents in this Cluster to select only the
documents of the clicked color in the “Document System”. This allows you to perform
analyses that only take into account the documents in this cluster. Alternatively, select the
Save Documents in this Cluster as a Set option to not only activate the documents, but to
compile them into a new set in the “Document System” window.

https://www.maxqda.com/help-mx24/mixed-methods-functions/similarity-analysis-for-documents
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Context menu for a document displayed on a Document Map

Customizing the display

In the Format menu you will find several options for interactively adjusting the appearance of the
Document Map:

Adjusting the Document Map in the “Format” tab

Number of Codes – Displays in brackets after the document name how many of the selected codes
occur in the document.

Size Reflects Number – The more analyzed codes have been assigned in the document, the larger
the circle will be symbolizing that document.

Font Size Reflects Number – The more analyzed codes have been assigned in the document, the
larger the font of the document’s name.

Grid – Turns on and off a grid, as known from a real map, to better estimate the relative distances
between codes. The grid works with a fixed distance of 100 pixels. Distances can therefore only be
compared within a map, not between different maps./p>

Color: Cluster / Document System / Uniform – Specifies how the documents are to be assigned a
color:

Cluster (map position) – Documents are assigned a color according to their group affiliation.
The positions of the documents on the map are taken into account for the group
identification. The clusters do not take into account the exact calculated distances with
respect to the selected codes and documents, but only their projection on the two-
dimensional surface. That is, documents can be grouped together that are further away from
each other in the multidimensional space. You can determine the number of clusters in the
numeric field.
Cluster (distance matrix) – Recommended setting for cluster display: documents are
assigned a color according to their group affiliation. The calculated distances between the
documents with respect to the selected codes and variables are used for group
determination. Due to the representation on a surface, even documents that are close to each
other can be colored differently (if two documents from different clusters are displayed on
the same map position, no color dot appears there, but a black circle). You can determine the
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number of clusters in the numeric field.
Document System – Color is taken from the "Document System".
Uniform – All document symbols are assigned the same color.

Comparing and investigating clusters

To better assess the similarities of the documents in a cluster and the differences between the
clusters, the function Format > Typology Table: Cluster is available. This opens the following
window:

Typology Table for comparison of individual clusters

The selected codes and variables are listed in the first column. The other columns are made up of
clusters.

In the Occurrence of Codes/Variable Values analysis mode, the number of documents in which the
code or variable value occurs is specified in the Typology Table. In the Frequency of Codes/Variable
Values analysis mode, the mean value and standard deviation of the documents are displayed
instead.

In the example above, the first cluster consists of seven documents, the other two of one and two
documents, respectively. The first row shows that the code “Grandparents” was assigned on
average 0.4 times in Cluster 1, three times in Cluster 2, and not at all in Cluster 3. And from the last
line, it can be seen that the people in Cluster 1 are on average 20.4 years old.

Tip: The table is interactive. If you change the number of clusters in the Document Map while the
window is open, the number of columns in the Typology Table automatically changes.

The allocation of individual documents to clusters can also be saved as variables so that these can
be used later for grouping the data. To do so, select Start > Save Cluster As Variables. The Data
Editor for document variables will open, to which a new column with the cluster allocation will have
been added.
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Store view in Questions – Themes – Theories

In the Questions – Themes – Theories window, you can collect and comment on all the important
results of your project. Click the Send to QTT Worksheet icon in the upper right corner to save the
current view in a new or existing worksheet.

Exporting a Document Map and calculations

The Start tab provides functions for exporting and refining the map as well as its underlying
calculations:

Save As Map in MAXMaps – Creates a new map in MAXMaps – the tool for Concept Maps in
MAXQDA – and inserts the contents of the Document Map here. You can edit the map later in
MAXMaps.

Copy Display – Saves a high-resolution image of the map to the clipboard so you can paste it
directly into a report or presentation.

Export – Saves the display as an image file in PNG or SVG format. If you select Excel (XLSX) as the
export format, the calculations are exported as matrix.

Notes on Document Map calculations and display

The classic multi-dimensional scaling method is used to locate the documents on the map.

For this purpose a distance matrix of the documents is calculated for the selected analysis mode
Frequency of Codes/Variables as described in the section Similarity Analysis for Documents. If the
evaluation mode Occurrence of Codes/Variable Values is selected, the resulting similarity matrix is
first converted into a distance matrix. Since the similarity values can be a minimum of 0 and a
maximum of 1, the conversion is performed by subtracting each similarity value from 1.

A distance of 0 means that two documents are identical with regard to the number or frequency of
the selected codes and the considered variable values.

Please note: Due to the reduction to a maximum of two dimensions (i.e., the mapping of the
document positions onto one plane) and the viewing angle taken, two documents can appear
visually closer together than the distance matrix would suggest.

If the Color: Cluster (map position) option is selected, the documents are clustered and colored
using a hierarchical cluster analysis of the positions on the two-dimensional surface. If the Color:
Cluster (distance matrix) option is selected, clustering is performed using the underlying distance
matrix. Unweighted average linkage is used as the clustering method.

If the option Size Reflects is switched on, the same principle is used to determine symbol sizes as
with a Code Map.

https://www.maxqda.com/de/hilfe-mx24/19-questions-themes-theories-q-t-t/die-idee-hinter-questions-themes-theories
https://www.maxqda.com/help-mx24/mixed-methods-functions/similarity-analysis-for-documents
https://www.maxqda.com/help-mx24/visual-tools/code-map-position-codes-according-to-similarity
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Document Comparison Chart (Sequence
of Codings)
This visualization works for several documents at one time and offers a sort of mix between the
Document Portrait and the Codeline. Simply choose the documents and codes that you wish to
include in the visualization by activating them before calling up the function.

Please note: Only texts, table and PDF documents can be analyzed with the Document Comparison
Chart.

The Document Comparison Chart shows the documents in the rows, making it possible to compare
the sequence of codes in each document. The cells show the codes that exist in each paragraph of
each document with a bar assigned the same color as the code it represents. Each code that is
present in the paragraph is represented by a colored section of the bar. If a code is used more than
once in a paragraph, it is still only visualized once. To give you an idea of how this works, see the
image below. In this example, you can see 10 paragraphs for three different documents. You can
see that there were no coded segments in any of the documents in the first paragraph. In “Doc 1,”
the first coded segments are in paragraph two, where two blue and one red code are visualized.

 1 2 3 4 5 6 7 8 9 10

Text 1  ■ ■ ■ ■ ■   ■ ■ ■ ■ ■  

Text 2    ■ ■ ■ ■ ■   ■

Text 3   ■    ■ ■ ■ ■

If several codes appear in the same paragraph, the colors of both codes are listed in the cell of the
chart provided for that paragraph. By default, each paragraph is the same width, regardless of how
many characters it includes. In the case of several codes, the available space is assigned
proportionally to the coded segments in the paragraph, taking into account how frequently a code
has been assigned in the paragraph - not how extensive the segment is. If a code occurs three times
in the paragraph, another code only once, then the first code gets ¾ of the area, the second only ¼ of
the area.

Like in Document Portrait, codes and colors must correspond in a meaningful way. Otherwise, the
diagram will have no meaning for you.

You can open the Document Comparison Chart by selecting Document Comparison Chart via the
Visual tools menu tab.

The visualization looks like this:
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Document Comparison Chart Example

The Document Comparison Chart is particularly useful for the analysis of structured documents. In
this case, all the documents have the same number of paragraphs and allow for a direct
comparison. You are more or less looking at a Document Portrait for each selected document at the
same time.

Interactive links with to the sources

As in all visualizations, the symbols representing the coded segments are interactive, meaning you
can jump directly to the coded segments in the original document in the “Document Browser” by
double-clicking on the symbol.

Standardize document length

In order to be able to compare texts of different lengths for the sequences of their coded segments,
the Document Comparison Chart offers the Standardize Document Length option , which you can
find as a symbol at the far left of the toolbar. Activating this function means that MAXQDA does not
present the analyzed texts in paragraphs but divides them into 100 sections with equal length and
visualizes the coded segments present in each section.

Adjust window width

Activating the option Fit to window width compresses the display horizontally to fit your
window. This is particularly useful for publications in which the entire coding process of several
documents needs to be displayed on one page.

Usually, you will use this option together with standardized document lengths, so that all documents
in the window can be compared directly with each other, even if they are of different sizes.

The slider in the toolbar can be used to adjust the width of the columns, i.e. the "resolution" of the
subdivision with vertical lines.

Store view in Questions – Themes – Theories

In the Questions – Themes – Theories window, you can collect and comment on all the important
results of your project. Click the Send to QTT Worksheet icon in the upper right corner to save the
current view in a new or existing worksheet.

https://www.maxqda.com/de/hilfe-mx22/19-questions-themes-theories-q-t-t/die-idee-hinter-questions-themes-theories
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Exporting the Document Comparison Chart as an image file

In the toolbar, there are three icons on the right that can be used to export the display:

Copy current display as an image to clipboard – Copies the visible area to the clipboard so that
you can easily paste the results into reports or presentations by, for example, using Ctrl+V
(Windows) or ⌘+V (macOS).

Open as Excel table - Exports the complete matrix with the frequencies as an Excel file and
opens it. The frequencies in the cells correspond to the number of codes assigned in this section.

Export – Exports the complete matrix with the frequencies in Excel or HTML format. The
frequencies in the cells correspond to the number of codes assigned in this section. Exporting as a
graphics file is also possible.

Profile Comparison Chart (Code
Frequencies and Variable Values)
The Visual Tool Profile Comparison Chart allows you to compare cases in terms of their code
frequencies and variable values. Using this tool, you can identify similarities and differences
between cases, as well as patterns regarding code assignments and variable values.

A Profile Comparison Chart Example

The Profile Comparison Chart shows a line for each case—the so-called profile line. Selected codes
and variables are arranged on the horizontal axis, and vertical axes are placed above each code and



  351

variable. The vertical axes are all the same height, but their scaling may differ: it ranges from the
minimum to the maximum value of the displayed profiles. In the figure above, the first vertical axis
above the code "Childcare" ranges from 0 coded segments to 3. The last vertical axis on the far right
for the variable "Age" ranges from 22 to 46 years.

The following units from the "Document System" can be shown as profiles (please note that they
cannot be combined in one chart):

Documents
Focus Group Speakers
Document groups
Document sets

The profile lines are colored differently. When documents or focus group speakers are visualized,
the lines can be colored according to their belonging to document groups or by their variable values
to visualize group membership. For example, in the figure above, the variable "Number of children" is
used to color the lines. All profile lines of persons without children are colored light blue and the
profile line of the only person with three children is shown in dark blue. The coloring by document
groups or variables makes it possible to identify differences between groups of cases. At the same
time, however, the lines of individual cases remain clearly visible.

The profile comparison diagram is suitable, among other things, for the identification of extreme
cases and can be used for creating typologies. Or if you have automatically coded the occurrence of
words with Lexical Search or with MAXDictio's dictionary, you can use the chart to visualize
differences in coding frequencies between cases. The combination of code frequencies and variable
values in one plot also makes the tool particularly interesting for mixed methods studies.

Note: The display is limited to 15 profile lines.

To create a Profile Comparison Chart

Step 1

In the menu ribbon of MAXQDA's main window, select Visual Tools > Document Comparison Chart.
An empty chart window will open with its own menu ribbon at the top.

Step 2

In the chart window, click on Start > Select Documents to choose which cases you want to display
as a profile line in the comparison chart. You can select documents, document groups, document
sets, or focus group speakers.

Step 3

Via Start > Select codes, select the codes to be displayed. In the selection window of the codes,
check the Aggregate subcodes option if the code frequencies of all subcodes are to be summed-up
per case.

Example: The following code has three sub-codes. The numbers in brackets represent how often
each of the codes has been applied to the document “Interview with Joe”:

https://www.maxqda.com/help-mx24/lexical-search/the-lexical-search-options-in-the-dialog-window
https://www.maxqda.com/help-mx24-dictio/autocode-documents-with-dictionary-categories
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If the parent code “Satisfied with leisure time” is included in the chart with the option switched on,
for document “Joe” not only 1, but 1+3+1+0 = 5 coded segments are taken into account.

Step 4

Alternatively, or in addition to the codes, select variables to be included in the chart via Start > Select
variables.

Select variables (left) and sort variable values (right)

Note: When document groups or document sets are displayed, only numeric variables (integer and
decimal) are available for selection.

If you select a variable in the left part of the window, all associated variable values are listed in the
right part of the window. By default, numeric variables are sorted in descending order and text
variables are sorted alphabetically in ascending order. The order set for a variable in the right part of
the window is adopted in the chart. By clicking on the AZ and ZA icons, you can reverse the sort
order for individual variables. In addition, for text variables, the order of their values can be adjusted
as desired by clicking and dragging with the mouse, so that, for example, the values

high
medium
low

are not displayed alphabetically, but in a meaningful order in the diagram.

Select the Exclude documents with missing values option to ignore all documents in the display
where no value or a value defined as missing is entered for the selected variables.

Example: There is no information about a person’s income in a study and therefore a -99 was
entered in the data editor under the variable "Income". In the "List of Document Variables", the
number -99 was defined as a missing value. If the exclusion option is enabled, no profile line will be
drawn for this person.

If this option is switched off, all documents with a missing value for a variable are assigned the
value "missing". This is always output as the lowest value of the variable axis.

Note: The Exclude documents with missing values option is automatically switched on when
document groups or document sets are displayed.
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Customize the display

In the Start tab of the Profile Comparison Chart, various options are available for customizing the
display:

Display Options

Color By – Use this drop-down menu to specify how colors are assigned to profile lines. The
following choices are available:

All profiles different: Each line is given a different color.
Variable ‹variable name›: This setting is visible when variables are displayed. All documents
sharing the same value for the selected variable are assigned the same color. The profile
lines in the figure at the top are colored according to this option, namely according to the
variable "Number of children". For example, all persons with 1 child are shown in green.

The following choices are additionally available if the lines represent documents or focus group
speakers:

Document System: The line colors correspond to the assigned colors to each document in
the "Document System".
Document group (top level): All documents in a document group have the same color. This
selection is analytically very valuable to compare groups of cases.

Display – this option is available only when you display document groups or document sets. Here
you define the unit of the vertical axes

Sum / Mean / Median: The sum, mean, or median of the code frequencies and variable values
are displayed.
Number (documents): The number of documents in the respective document group or set in
which the code has been assigned at least once is used for the display.
Percent (documents): The "Number (documents)" (explained above) is presented relative to
the number of all documents in the document group or document set. Activations in the
document group or set are not taken into account.

Note: If the option "Number (documents)" or "Percent (documents)" is selected for the display, no
variables can be selected.

Sort Legend by 'Document System' – By default, legend entries are sorted to match the order of the
profile lines on the first vertical axis. Select this option to arrange the entries according to the tree
structure in the "List of documents" instead.

Set 0 as Minimum for Codes – By default, the lowest code frequency of a displayed profile is taken
as the minimum for the vertical code axes. If you select this option, all code axes will always start at
0, regardless of whether there is a profile with this code frequency.
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Color Scheme – Select one of several color schemes for the profile lines here.

Save charts in "Questions – Themes – Theories"

Questions – Themes – Theories (QTT) offers a workspace in your MAXQDA project where you can
compile your findings. To save the Profile Comparison Chart in a QTT worksheet, click Send to QTT
Worksheet in the menu ribbon and select the desired worksheet from the drop-down menu.

Export charts

The Export  icon allows you to export the current display of the Profile Comparison Chart as a file.
This file can then be inserted into a PowerPoint presentation or a Word text, for example.

By clicking the  Copy to Clipboard icon, the current display is copied to the clipboard and can be
pasted, e.g., by using Ctrl+V (Windows) or cmd+V (Mac), into Word, PowerPoint, and other
programs.

Word Trends (Frequencies of Words)
Using Code Trends, you can analyze where and how often codes have been applied in texts. When
analyzing a single document, the text is divided into sections of equal length, and the frequency of
selected words in each section is visualized in a line chart:

Word Trends for a single text

If you call Word Trends for multiple text documents, you can analyze how the use of words changes

https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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across the texts. Word Trends for multiple texts is particularly useful for time series analysis where
each document represents a point in time.

Word Trends for multiple texts

Create Word Trends for a single document

Open the text document for which you want to analyze Word Trends.1.
Select Visual Tools > Word Trends > Single Document from the main menu. The Word Trends2.
window will open.

Tip: Alternatively, you can call up Word Trends by right-clicking on a document in the “Document
System” (using the Trends menu item). If you have created a word cloud for a single document, an
icon will appear in its menu bar that allows you to call up Word Trends directly for the document for
which you created the word cloud.

Create Word Trends for multiple documents

Select Visual Tools > Word Trends > Multiple Documents from the main menu.1.
Click the Select Document icon or button and specify which text document to include.2.

Tip: Alternatively, you can call up Word Trends by right-clicking on a multi-selection of documents in
the “Document System” (using the Trends menu item). 

Add and remove words

On the left side of the Word Trends window, the most frequent words in the document are listed. To
add more words to the analysis, enter the word in the text field above the list of words. If you enter
only single letters, all words from the text that start with these letters will be listed for selection.

To remove a listed word, click the red X that appears when you hold the mouse over the word.
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Word frequencies

Click on Word Frequencies in the Start menu tab to get a list of all words found in the text and their
frequencies.

Options for analysis and presentation

The Start menu tab provides numerous options to customize the analysis and the results display:

Case Sensitivity – When enabled, Word Trends differentiates single words additonally based
on their letter capitalization.
Ignore Numbers – When this option is enabled, numbers are ignored when listing the most
frequent words after opening Word Trends window. Furthermore, numbers cannot be
selected for display by entering them in the text field.
Base Form (Lemmatize) – If enabled, all analyzed words are reduced to their base form, i.e.,
“go”, “went”, and “gone” are considered as the same word (“go”). More information about the
lemma lists used can be found here.
Apply Stop Word List – If enabled, the words from the currently selected stop word list will be
ignored when listing the most frequent words after opening Word Trends window.
Furthermore, the excluded words cannot be selected for display by entering them in the text
field.
Scale – Switch between absolute and relative frequencies. Both the absolute and relative
frequencies refer to the respective section.
Sections [only for single document] – Select the number of sections to be visualized.
Display Document Names as Labels [only for multiple documents] – If enabled, the document
names are displayed instead of consecutive numbers.
Colors – Choose between different color schemes for the display. 

Please note: The division of a single document into sections is done with the original text,
regardless of the selected options “Ignore Numbers” and “Apply Stop Word List”.

List search hits

Click on a node in the chart to get a listing of search hits in that section or document:

https://www.maxqda.com/help-mx24-dictio/lemmatization
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Interactive display for a section

Listing of search hits

Tip: Click on a line in the listing to display the word in the “Document Browser”.

Store results in a QTT worksheet

In the Questions – Themes – Theories window of MAXQDA, you can collect and comment on all the
important results of your project. In the upper right corner of the Start menu tab of Word Trends,
click on the icon  Send to QTT Worksheet, to store the results in a new or existing worksheet. The
current display will be saved as an image.

Export and print results

On the top right of the Word Trends window, you will find various options to export the current view,

https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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for example, to insert it into your results report:

Copy Display – Copies the current view to the clipboard so that you can paste Word Trends
into a software of your choice, for example, by using Ctrl-/cmd+V.
Export – Exports the current view as a graphic file.

By clicking on the printer symbol, also at the top right, the current view can be printed directly.

Document Portrait (Sequence of Codings)
This visualization is for a specific document, making it a case-oriented function. The document is
shown as a picture of all the coded segments based on the order and colors of the codes.

You can access the Document Portrait...

by selecting Visual Tools > Document Portrait from the menu ribbon (for the displayed
document in the “Document Browser”),
by right-clicking on a document and selecting Document Portrait in the context menu that
appears(for the clicked document).
by right-clicking on a document (or multiple selected documents) and selecting Document
Portrait in the context menu that appears (for the clicked document(s)).

The results of this function are only meaningful if you have made use of the opportunity to assign
colors to codes. The visualization of a document can only be fruitful if this association of colors
makes sense to you. Here are a few examples:

Imagine a psychologist has coded an in-depth interview in a way that categories related to
aggression have red colors and categories for quiet and friendly behavior have green colors.
A Document Portrait would show you at a glance how often the interview shows aggressive
behavior and when during the interview this happened.
In biographical research, the color red can be chosen for critical life events, thus making it
easy to get an idea of the life course of a person and the concentration of critical events.
For thematic analysis, it may be useful to associate different colors to different topics. Now,
you can easily see which topics dominate the discussion and which topics are closely related.

What does a Document Portrait show?

A Document Portrait shows the sequence of codes for a selected document. To better understand
what happens, it is useful to take a look at the “Overview of Coded Segments” for a selected
document. All coded segments are listed in this overview. The first column displays the color
associated with the code. This is the material that is used to “paint” the Document Portrait. Only
those colors displayed in the first column of the overview table will appear in the visualization. In the
overview table, all segments are equal regardless of their size. The Document Portrait, however,
takes the size of the segments into account and “weights” the color according to the segment’s size.

The color attributes of the codes associated with the document are displayed in a matrix with lots of
little squares (by default arranged in 30 rows, each one with 40 squares). The representation starts
with the first square on the left in the first line and ends with the last square on the right of the last
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line. The picture is set up in the same way as a classic television screen, where an electronic stripe
goes along the screen from left to right. All 1,200 squares are divided up according to the share of
the coded segments. If a document only had segment coded with a blue code, then the Document
Portrait would be totally blue. If this segment were coded with two codes, red and blue, the
Document Portrait would consist of 600 blue and 600 red squares. If two segments were coded
(again with red and blue codes) and the first segment was twice as extensive as the second, the
picture would start with 800 hundred red squares followed by 400 blue squares.

Thus, Document Portrait displays the structure of documents in terms of codes as a colorful picture.
This helps to immediately identify the basic tone of a document, for instance, if emotions have been
coded with meaningful colors (aggressive= red, tolerant= green, and so on).

Try out the Document Portrait – right-click on a document of your choice in the “Document System”
and choose Document Portrait. Of course, meaningful results can only be obtained if you have
assigned colors that make sense for your codes.

Document Portrait visualization options

Visualize entire document - If you choose this option, the visualization will include white
squares for sections of the document that have no code assigned to them. If option is turned off, the
Document Portrait only visualizes segments of the document that were coded.

Mixed colors for overlapping codes (yes/no) - This setting decides how segments should be
visualized that are coded with more than one code. If the above option is off, each of the colors of
the codes used to code the same segment will be listed sequentially, one after the other, similar to
how it works in the “Overview of Coded Segments”. If the option is turned on, the colors of each
assigned code are mixed together.

Display nodes as circles (on/off) - This icon lets you switch the symbols in the visualization
from squares to circles.

Display legend – If this option is enabled, a legend will be displayed next to the portrait showing
which colors represent which codes. Since the same color can be assigned to different codes,
several code names may be listed below each other for one color.

Using the three icons below you can toggle between different sorting of the tiles:

Sorted by document - The sorting of the coded segments visualized in the Document Portrait is
determined by their occurrence in the document.

Sorted by color - The coded segments are sorted by colors, same colors are grouped.

Sorted by color frequency - In this special display option, the portrait will be “tidied up”: all
symbols with the same colors are stacked like in a bar chart and the bar with the most tiles is placed
left. Only the most frequent 20 colors will be visualized.

The size of the document portrait can be adjusted using the drop-down menu in the toolbar. By
default a rectangular visualization of 30 x 40 tiles is displyed.

Click on the title to edit it.
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Interactive link with the source material

The square or circle symbols in the Document Portrait are also directly connected to the original
data, which means you can click on any symbol to call up that coded segment in the “Document
Browser.” (This is not possible if you have chosen to mix colors for overlaps.) If you right-click on a
symbol you will find the option Retrieve Coded Segmentswith this Color which will list all coded
segments with the chosen color in the “Retrieved Segments” window.

Store view in Questions – Themes – Theories

In the Questions – Themes – Theories window, you can collect and comment on all the important
results of your project. Click the Send to QTT Worksheet icon in the upper right corner to save the
current view in a new or existing worksheet.

Exporting the Document Portrait as an image file

In the toolbar, there are two icons on the right that can be used to export the display:

Copy current display as an image to clipboard - to copy the actual view into the clipboard. Now
you can open Word, PowerPoint, or other programs and paste the image into it by choosing Ctrl+V
(Windows) or cmd+V (Mac).

Export - Exports the Document Portrait as a graphics file.

Codeline (Score of Codings)
The Codeline is a case-based visual function that displays a sequential view of a document’s coded
segments. The Codeline visualization is available for texts, PDF documents, tables and also for
videos. The picture is quite similar to that of a score of a piece of music. For a text, the columns
display its paragraphs, starting with paragraph 1 and ending with the last paragraph of the particular
text. The rows display the codes. The cells of the Codeline are filled with a color if the code has been
assigned to the paragraph.

The basic idea behind the visualization can be seen below. There are 12 paragraphs and three codes
shown. You can see that nothing was coded in the first paragraph of any of the documents. In the
second, eleventh, and twelfth paragraph, Code1 is used. In paragraph five, both Code2 and Code3
were used. This shows you already how you can use this visualization. It gives you a visual overview
of a document, so for the phases of an interview, you can quickly identify which codes appear and
co-occur.

 Paragraph

 1 2 3 4 5 6 7 8 9 10 11 12

Code1  ■         ■ ■

Code2     ■ ■ ■ ■   ■  

https://www.maxqda.com/de/hilfe-mx22/19-questions-themes-theories-q-t-t/die-idee-hinter-questions-themes-theories
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Code3    ■ ■     ■  ■

You can open MAXQDA's Codeline either

via the main ribbon menu: Visual Tools > Codeline or
by selecting Codeline in the context menu for a text, table, or PDF document

Codeline options

When you call up the Codeline, MAXQDA offers the following options:

Only for activated codes – this limits the codes to be included in the visualization to those that you
have already activated in the “Code System”. If you have activated a subcode, also its parents will be
integrated into the visualization.

Aggregate on the 1st level – this option means that only top-level/parent codes will be visualized.
The subcodes of each parent code will be handled as if they were instances of the parent code.

Use weight filter – if you select this option, MAXQDA will open another dialog after clicking OK, in
which you can set a range for the coding weight. Only those segments, that fit into this range will be
displayed in the Codeline.

Options for the Codeline visualization

Codeline display

Unlike the Document Portrait, the Codeline tool can be used even if you have not associated
meaningful colors to your codes. The Codeline graphics display the color, but if you have not
selected colors, only green symbols will be displayed. The function of Codeline is to show where in a
document the different codes have been applied, and this diagram also makes sense and can be
interpreted without color differentiation.

What can the Codeline be used for?

Codeline gives a good overview of the coding and can therefore be used universally.
The diagram may be of use for exploration – just follow a particular code, see when it
appears and which other codes appear near it.
The opportunity to display only selected codes enables comparing two or more codes in the
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course of an interview.
When analyzing focus groups, you can see at a glance which speakers react to each other
and what the topics are in relation to the speakers.

Example of a Codeline visualization

What does MAXQDA's Codeline display?

MAXQDA's Codeline creates a "codes x paragraphs" table for texts.
The codes are listed in the sequence of the text's paragraphs, starting with the first
paragraph, i.e. the beginning of the text. The paragraphs form the X-axis, i.e., the diagram has
exactly as many columns as the text has paragraphs.
If a code has been assigned within the paragraph, you will see its code color depicted as a
rectangle in the corresponding column. If codes have been assigned to several paragraphs
consecutively, you will see a continuous bar.
When a parent code is collapsed, the subcodes are added to this parent code and displayed in
the color of the parent code.

The Codeline function is available for all document types that MAXQDA supports, except for images.
Depending on the document type, different units will be used for the columns:

Text paragraphs
lines, if line numbering has been set for a text in the "Document Browser"

Table rows

PDF pages

Audio and Video file seconds or minutes for files not longer than 10 minutes
minutes for files longer than 10 minutes

Display options

Above the Codeline you will see a toolbar, which offers several options for the display:

Codeline for linked media file – This option is displayed only when the Codeline is opened for a
text document that has an audio or video file associated with it. Turn this option on to create the
Codeline for the associated media file.
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Standardize width of units and color them completely – If you select this option, all paragraphs
(resp. lines) of a text document will be displayed with the same width, independent from their length.
Furthermore, the whole paragraph width will be filled with the color of the code, no matter how large
or small the coded segments within this paragraph are.

For the other document types, the behavior is as follows when the option is enabled:

For tables, the table rows are displayed with the same width and each table row containing a
code is visualized as if it were fully coded with the code.
For PDF documents, the pages are displayed with the same width and each page containing a
code is visualized as if it were fully coded with the code.
Audio and video files already have standardized units (seconds and minutes), so there is no
standardization. However, each second or minute is visualized as if it were fully coded with
the code.

Display codes with hierarchy – If the option is activated, the codes are displayed in the tree
structure of the code system. Even if the “Only activated codes” option is selected, non-activated
upper codes are also included to preserve the tree structure. If the option is deactivated, all codes
are displayed on one level. If the “Only activated codes” option is activated, then only the activated
codes are displayed.

Fit to window width - Selecting this option will “compress” the Codeline into the horizontal space
of the window. This is very helpful for any publication in which you want to include an image of the
whole Codeline, but in which the space is usually limited to a single page. The proportions of the
visualized coded segments will stay the same, only very short coded segments get a special
treatment: they will be reduced to a minimum of a thin vertical line only, but will not be excluded
from the view.

You can use the slider next to the icons to adjust the column width.

Interactive link with source files

The display of the coded segments is interactive. If you hover the mouse over a symbol, a short
information window appears with the code or subcode name and the position. Double-clicking on in
the Codeline highlights the corresponding segment(s) in the “Document Browser” or “Multimedia
Browser”.

Store view in Questions – Themes – Theories

In the Questions – Themes – Theories window, you can collect and comment on all the important
results of your project. Click the Send to QTT Worksheet icon in the upper right corner to save the
current view in a new or existing worksheet.

Exporting Codeline

In the toolbar, there are two icons on the right that can be used to export the display:

Copy current display as an image to clipboard - Copies the current view to the clipboard so that
you can easily paste the display into reports or presentations by, for example, using Ctrl+V

https://www.maxqda.com/de/hilfe-mx22/19-questions-themes-theories-q-t-t/die-idee-hinter-questions-themes-theories
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(Windows) or ⌘+V (macOS).

Export - Exports the whole Codeline as a graphics file.

Word Cloud (Frequencies of Words)
Word clouds are used to visualize the most common words in a text. They are ideal for exploring
large amounts of text and creating informative visualizations for presentations.

Word Cloud

Generating a word cloud

Word Clouds can be generated for individual documents, document groups, document sets, or for all
the documents in a project. Right-click on the level in the “Document Browser” for which you want to
generate the word cloud and select the entry Word Cloud. You can also open the Word Cloud from
the "List of Retrieved Segments", the Overview of Coded Segments and Overview of Paraphrases.

Alternatively, you can also open the Word Cloud function via the icon with the same name in the
Visual Tools tab. A dialog box will then open in which you can select the relevant documents.

Tip: You can create a word cloud of the currently listed text segments in the “Retrieved Segments”
window. To do so, click on the word cloud icon in the toolbar of the “Retrieved Segments” window.
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Stop word list: Excluding words in the Word Cloud

To prevent the word cloud from containing non-interesting words, you can apply a list of stop words
to exclude. Therefore, you should activate the option Apply Stop Word List in the Start tab and select
a stop word list. Every new project in MAXQDA already contains stop word lists for several
languages from which you can choose.

Add words from the word cloud to stop word lists

You can add words from the word cloud to the currently selected stop word list at any time.

To do this, call Start > Word Frequencies in the word cloud. The table that appears shows all the
words that occur in the text in the order of their frequency.

Double-clicking on the green icon icon in front of a specific word will add it to the stop word list,
which means it won’t be considered for the word cloud anymore. You can also select several words
in the list (using Ctrl+ or ⌘+the left mouse button or ⇧+the left mouse button for an area in the list)
and then right-click and select Add to Stop Word List. An icon with the same name is also available
in the toolbar.

Word frequency list

When you click the Refresh and apply stop word list, the Word Cloud is regenerated excluding
words from the stop word list.

Tip: You can always right-click a single word in the Word Cloud and select Add to Stop Word List to
exclude it from the Word Cloud. To re-create the Word Cloud without the excluded words, click the
Rearrange icon in the “Start” tab.

Editing the stop word list

The option Edit Stop Word List displays the complete stop word list used for word clouds in the
current project. You can remove words from this list or add new words, although the way of doing
this described above, by clicking in the frequency list, is actually much easier. Here you can also
save and load already defined stop word lists to exchange them between projects.
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Tip: “MAXQDA Plus” and “MAXQDA Analytics Pro” users can also edit the stop list via MAXDictio >
Stop Word Lists and easily exchange items between different lists.

Working with the word frequency list

Via Start > Word Frequencies you can open a list of all the words contained in the analyzed texts.
This list shows, amongst other things, how often each individual word occurs. It is also possible to
combine several words into one. To do this, click and drag one or more words onto another word
with your mouse.

Adjusting the display

You can use the numerous options in the Start and Format tabs to customize the appearance of the
word cloud, including the number of words displayed, their font, their shape, and color.

The Start tab

Functions in the Start tab

Word Frequencies – Opens a list of all words contained in the analyzed texts (without the stop
words) and shows their frequencies. Words can easily be transferred from the word frequency list to
the stop list.

Case Sensitivity – If this option is activated, a distinction is made between capitalized and non-
capitalized words. For example, the words "earth", "Earth" and "EARTH" are treated as three different
words.

Ignore Numbers – Excludes all "words" consisting only of numbers.

Lemmatize Words – When this option is activated, the inflected forms of a word are grouped
together, for example, “go”, “went”, “gone” are all treated as “go” and “houses”, “housed”, “housing”
are all treated as “house”.

Apply Stop Word List – Opens the list of all available stop word lists and the option to manage the
stop word lists.

Filter – Select text elements to be excluded from the word cloud, e.g. hyperlinks, email addresses.
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Minimum Frequency – Defines the minimum number of times a word must occur order to be
displayed.

Words – Specifies how many words are visualized. You can use the slider to incrementally remove
rarer words. If several words occur with the same frequency, words starting with letters earlier in the
alphabet are selected first.

Rearrange – Regenerates the word cloud, placing words in different random locations.

The 'Format' tab

Functions in the Format tab

Shape – Allows to define the outer borders of the Word Cloud. There are various variations to
choose from:

predefined forms (circle, ellipse, square, triangle)
most frequent word
a word you have entered
a custom-selected image (is converted into a black and white image with the black area filled in,
hence black and white images are best)

Example of a custom-selected image as a Word Cloud contour

Please note: For some selected shapes you need to increase the number of words to fill in the shape
completely. It is also helpful to use the Smallest Word slider to adjust the size differences of the
words (and thus the required space) to fill the shapes evenly.

Alignment – Lets you define the alignment of words. The following options are available:
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Horizontal: All words are displayed horizontally
Vertical: All words are displayed vertically
Horizontal and vertical: Words are randomly aligned horizontally and vertically, the most common
word is always displayed horizontally
30/45 degrees: Some words are additionally displayed at the selected angle diagonally upwards
or downwards.

Colors – Lets you choose from a range of different color schemes.

Font / Bold – Lets you specify the font.

Word Distance – Defines the minimum distance between words

Smallest Word – Defines the size of the smallest word. The smaller this size is, the greater the
difference in size compared to the most common words will be.

Size by – Defines the size of the words. Here you can choose from the following:

Frequency: The more frequently a word occurs, the larger it is.
Rank: The higher the rank of a word in the word frequency list, the larger the word. If you choose
this option, the absolute difference between the word frequencies is irrelevant.
Number of documents: The larger the word, the more documents it appears in. The number of
documents can be seen in the list of word frequencies. This option only makes sense if you are
analyzing several documents, as otherwise there will be no size difference between the words.

Scale – Influences the differences in size between common and rare words. The following options
are available, which refer to the dimensions set under "Size by":

Linear: The font size is linearly proportional to the word frequency.
Most frequent greater: The font size is proportional to the square of the word frequencies. This
makes the common words appear larger compared to the “Linear” option.
Most frequent smaller: The font size is proportional to the root of the word frequencies. As a
result, the common words appear smaller in relation to the "Linear" option.

Largest word – Lets you set the placement of the largest word: centered, somewhere near the edge,
or at random.

Rearrange – Regenerates the word cloud, placing words in different random locations.

Display the occurrence of a word in the texts

The word cloud is interactively linked to the original texts:

Clicking on a word lists all occurrences of the word in the analyzed texts.
If you hover the mouse over a word, the frequency of the word appears as a small indicator on
the mouse pointer (regardless of the selection made in "Size by: ...").

Autocode hits of a word

You can autocode all occurrences of a displayed word with a new code. This makes it possible, for
example, to code all sentences in which an interesting word occurs in order to analyze these
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sentences further:

Right-click on a word in the Word Cloud and select Autocode '‹word›' with a New Code.1.
In the dialog that appears, you can enter the name for the new code or accept MAXQDA’s2.
suggestion.
In the subsequent dialog, you can specify the context that is to be coded: only the word or3.
also the surrounding words, sentences, or paragraphs (paragraphs cannot be selected for
PDF documents).

Start autocoding function in the context menu of a word

Tip By selecting the Explore in Word Explorer option in the context menu of a word, you can get
more information about the usage of the clicked word in the entire text corpus.

Save chart in "Questions – Themes – Theories"

In the Questions – Themes – Theories (QTT) you can collect and comment on all the important
results of your project. Click the Send to QTT Worksheet icon in the Start menu ribbon to save
the current view in a new or existing worksheet.

Exporting the Word Cloud

In the Start tab, there are options to the right to copy the word to the clipboard or to export it as a
graphics file.

Code Cloud (Frequencies of Codes)
Code Clouds visualize the most frequently used codes as word clouds. They are particularly suitable
for exploring and illustrating the use of codes in a project. The code cloud can represent the codes
used across all the documents in a project or only a selection of documents.

https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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Code Cloud

Opening the code cloud

You can generate a Code Cloud for a single document, a document group, a document set, or all
documents in a project. Right-click on the appropriate level in the "Document System" and select the
entry Code Cloud.

Alternatively, you can also access this function via Codes > Code Cloud in the main ribbon menu. A
dialog box will appear in which you can select documents and codes to be considered in the
visualization.

Code Cloud settings

The settings for Code Clouds are very similar to those of word clouds and are described in detail
there. The differences are minimal:

The entire code name is always displayed and can therefore consist of several words, as in
the example in "unpaid work".
The Minimum Frequency option in the Start tab refers to the number of codes assigned in the
selected documents.
Some functions of the word cloud, such as "Word Frequencies", the "Stop Word List" and
"Ignore Numbers" are not available, since these do not make sense for a code cloud.

https://www.maxqda.com/help-mx24/visual-tools/word-clouds
https://www.maxqda.com/help-mx24/visual-tools/word-clouds
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Code Trends (Frequencies of Codes)
Using Code Trends, you can analyze where and how often a code has been applied in texts. When
analyzing a single document, the text is divided into sections of equal length, and the frequency of
selected codes in each section is visualized in a line chart:

Code Trends for multiple texts

If you call Code Trends for multiple text documents, you can analyze how the assignment of codes
changes across the texts. Code Trends for multiple texts is particularly useful for time series
analysis where each document represents a point in time.
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Code Trends for single text

Create Code Trends for a single document

Open the text document for which you want to analyze Code Trends.1.
Select Visual Tools > Code Trends > Single Document from the main menu. The Code Trends2.
window will open.
In the menu tab Start of the Code Trends window, click on the icon Select Codes to specify3.
which codes to include.

Tip: Alternatively, you can call up Code Trends by right-clicking on a document in the “Document
System” (using the Trends menu item).

Create Code Trends for multiple documents

Select Visual Tools > Code Trends > Multiple Documents from the main menu. The Code1.
Trends window will open.
Click the Select Document icon or button and specify which text document to include.2.
In the menu tab Start of the Code Trends window, click on the icon Select Codes to specify3.
which codes to include.

Tip: Alternatively, you can call up Code Trends by right-clicking on a multi-selection of documents in
the “Document System” (using the Trends menu item).

Options for analysis and presentation

The Start menu tab provides numerous options to customize the analysis and the results display:

Scale – Switch between Absolute frequencies (How often has a code been applied in a
section/document?) and Code coverage % (How much of the data is been coded with a code
in a section/document?). 
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Sections [only for single document] – Select the number of sections to be visualized.
Display Document Names as Labels [only for multiple documents] – If enabled, the document
names are displayed instead of consecutive numbers.
Colors – Choose between different color schemes for the display. Here, you can also select
the Code colors suboption to apply the colors of the code system.

List coded segments

Click on a node in the chart to get a listing of coded segments in that section or document:

Interactive display for a section

Listing of coded segments
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Tip: Click on a line in the listing to display the coded segment in the “Document Browser”.

Store results in a QTT worksheet

In the Questions – Themes – Theories window of MAXQDA, you can collect and comment on all the
important results of your project. In the upper right corner of the Start menu tab of Code Trends,
click on the icon  Send to QTT Worksheet, to store the results in a new or existing worksheet. The
current display will be saved as an image.

Export and print results

On the top right of the Code Trends window, you will find various options to export the current view,
for example, to insert it into your results report:

Copy Display – Copies the current view to the clipboard so that you can paste Code Trends
into a software of your choice, for example, by using Ctrl-/cmd+V.
Export – Exports the current view as a graphic file.

By clicking on the printer symbol, also at the top right, the current view can be printed directly.

https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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15 – Visual Tools (Concept Maps)

What Does MAXMaps Do?
MAXMaps allows you to visualize connections and relations. MAXMaps is primarily intended to
graphically represent the different elements of MAXQDA (codes, documents, memos, coded
segments) visually on a workspace, a so-called map, and to put them in relation to one another. It is
also possible to create maps that are not related to the MAXQDA project.

MAXMaps can be used for different purposes:

Maps can help to explore and organize data. They allow you to develop your ideas and to
communicate them to your research team.
Maps can also be a valuable tool for scientific explanation and can help to visualize complex
relationships and theories. For instance, you can create tables and worksheets to gain a
better perspective of the different elements within a project.
MAXMaps can also be used for presentations and lectures. The different layers of a map may
be displayed in arbitrary order; thus, a variety of different options for designing presentations
are available.

With MAXMaps, it is possible to display:

The relationships between different codes and categories.
An overview of different facts and phenomena within the research field.
The different memos belonging to a document or a group of documents.
The results of a Grounded Theory study.
The context or important facts of the research, e.g. photographs of locations or persons.
A graphical overview of the research methods used.
A research timeline.
The research design and characteristics of the sample.

MAXMaps can also have different functions for researchers. You can, for instance, use MAXMaps to
organize and manage your code system. Or you can link codes, text, and memos in a hypothetical
order to then further test the relationships in a second step.

MAXMaps offers multiple automatic templates to support the creation of maps for different
scenarios, e.g. to visualize the relationship of different cases.

MAXMaps is not merely a graphics tool that works with icons and symbols, though. All the elements
used in a map are interactive, meaning they are connected to the MAXQDA project. This makes an
icon that symbolizes a text document not only a passive icon but allows you to double-click on the
icon to open the document in MAXQDA’s “Document Browser.” Then you can read and browse
through the document. The same is true for memos. As soon as you click on the memo symbol, the
memo appears and can be read or even modified. In the case of symbols for coded segments, one
click displays the segment, which allows you to examine and compare different segments of your
map.

https://www.maxqda.com/help-mx24/maxmaps/model-templates-in-maxmaps
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MAXMaps not only allows you to define links and relationships, it also offers a way to make links
and relationships that have already been implemented in your project visible. Examples are memos
that have been assigned to a document: MAXMaps can import all the connected memos
automatically. These memos are displayed as symbols and you can open and check them. The
same is true for codes: If you have imported a code in your map, all the memos linked to this
particular code can also be imported automatically. Moreover, you can search and insert all of the
codes overlapping with a code on your map and automatically connect them to the code.

This visual method of data display is supported by the variety and flexibility that characterizes
MAXMaps. All elements used in a map may be designed individually. Codes, memos, and texts are
not always displayed with the same symbols and colors. You can select different symbols, colors,
fonts, and sizes, or even import your own symbols unique to each element of your map. All labels,
images, and symbols can be managed individually. You can also import your own photographs,
icons, or clip art.

The MAXMaps Interface
A project's maps are created and managed in their own workspace called "MAXMaps". MAXMaps is
accessed via the first icon on the left side of the Visual Tools tab. The following interface will appear
in a separate window:

The MAXMaps Interface

The MAXMaps interface is divided into several areas. On the left you'll see the "List of Maps", which
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will contain a single entry called "New Map" when MAXMaps is opened for the first time. Later, as
shown in the figure, all your created maps will be listed. The space on the right displays your map,
the space in which you can model it, insert objects, position and link them etc.

At the top you will see a menu with several tabs. In the Start tab, you'll find everything you need to
create and edit a map. Use the Insert tab to insert new codes, texts, images, and shapes into the
map. The Format tab and Line Format tab appear as soon as you select an element or a line to
display all available formatting options.

Tip: You can reduce the ribbon menu by double-clicking the ribbon title "Start" to make more space
available for your map. The "List of Maps" can also be hidden by clicking on the small cross at its
window edge to further widen the working area.

Undocking your "List of Maps"

You can undock the "List of Maps" window to move it somewhere else on your screen. To do this,
click on the small double-window icon in the header of the list to release it from its fixed position at
the window edge. You can place the undocked window wherever you like, dragging and dropping it,
even to a second monitor. To re-dock it, drag the window to the left edge of the MAXMaps window.

Undocking the List of Maps

Undoing actions

In the top right corner of the MAXMaps window, there are two arrow icons for undoing and restoring
your last action.

The Undo feature only applies to the map currently open. If you open a new map or close the
MAXMaps window, the "back-up memory" is erased. The global undo function of MAXQDA doesn't
word with maps in MAXMaps.

Create a Map and Add Objects
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Creating a map

To create a new map, click the New Map icon on the Start tab. A new map is immediately inserted
into the "List of Maps" with the default name "New Map" and an empty workspace is provided. The
default name can be changed at any time by right-clicking and selecting the Rename option in the
context menu.

Any number of maps can be created. They are saved in MAXQDA but can also be exported in the
form of JPG or SVG files and then inserted into text files. The storage of maps in the MAXQDA
project file is done automatically every minute, as well as when the MAXMaps window is closed. No
separate command is required to save.

Tip: You can add a comment to each map, for example to note the status of a map ("first sketch",
"finished") or important hints for a checked assumption. Click on the comment symbol in the header
of the "List of Maps" and enter a comment in the window that appears. The comment is displayed as
a symbol next to the name of the map and can be opened by double-clicking on it.

You can create folders in the "List of Maps" where you can arrange your maps for a better overview.
To create a new folder, click the icon at the top of the page window.

Create new folder

Types of objects in MAXMaps

The following distinction is made between elements on a map:

Standard objects originate from MAXQDA, e.g. a code, a text, or a memo. They can only be
inserted into a drawing pad once. So a document can be contained within a map once only.
Modifications on standard objects have no effects on the MAXQDA project. For instance, if
you modify the name of a text imported from MAXQDA, the name in MAXQDA’s “Document
System” nevertheless remains the same. Objects removed from the drawing pad are not
simultaneously removed from the MAXQDA project. No matter how you arrange an object,
connections to the MAXQDA database will always be preserved. This also means that a text
that is represented only as a picture will open via double-click in MAXQDA’s “Document
Browser.”
Free objects are not connected with items of the current MAXQDA project. In this sense, they
are independent of the analyzed data.
Connecting objects are lines, which interconnect two objects.

Both standard and free objects consist of an object label and an object picture. Standard objects
receive the appropriate icon from MAXQDA as a picture and the appropriate name from MAXQDA as
a label. For example, as with a MAXQDA document, the document name will be taken from the
“Document System”.
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Connecting objects can also be labeled and the type and characteristics of the connecting line can
be customized.

Inserting objects into your map

Each object that is imported into the workspace – be it a code, a memo, a text, a coded segment, or
a so-called free object – consists of two elements:

A symbol, and
a label.

When importing a MAXQDA object, the MAXQDA default icon (or "symbol") is carried over as the
picture and the MAXQDA name as the label. For example, when importing a code, the code icon from
the list of codes and the code name are carried over.

Code, memo, and document after import

Both the label and the icon can be changed, or an image, a diagram, symbol, or photo can be
imported. The label can also be changed along with the font type, font size, and other properties.

How to import standard objects from MAXQDA

There are three ways to import an element from MAXQDA:

hold down the Alt key (Windows) or the ⌥ key (macOS) and double-click on the selected
object while in MAXQDA,
click on the element with the right mouse button and select the Insert into Map option from
the context menu, or
drag and drop the element into the map with the left mouse button.

The selected element is inserted into the drawing area at the next free point as viewed from the top
left.
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Inserting an element via the context menu

The following MAXQDA elements can be inserted. The brackets state where the elements are
located in MAXQDA:

Documents (“Document System”).
Document groups (“Document System”).
Document sets (“Document System”).
Codes and subcodes (“Code System”).
Code memos and Memos on code sets(“Code System”).
Memos attached to parts of documents (“Document Browser”).
Memos attached to documents, document groups or document sets (“Document System”).
Free Memos (Memo Manager, “Overview of Memos”).
Coded segments (“Retrieved Segments”, “Overview of Coded Segments”, “Document
Browser”, “Multimedia Browser”).

All these functions are only available with the MAXMaps window open. The object is always
imported into the currently open map.
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For documents, codes, subcodes and coded segments, the assigned color is always adopted. The
assigned memo icon is always used for memos.

Tip: The fastest way to import objects is by holding down the Alt key (Windows) or ⌥ key (macOS)
and double-clicking on the selected item.
Importing multiple documents or codes at once

You can import all documents or codes currently activated in the MAXQDA project into an open map
at once:

Select the desired codes or documents in the MAXQDA window. For example, you can use the1.
Mixed Methods > Activate Documents by Variables function to select all documents with a
specific property.
Then right-click on the white space in MAXMaps and select Insert Activated Documents or2.
Insert Activated Codes.

Inserting a new code

From the Insert tab in the MAXMaps window, you can create a code and paste it into a map by
clicking on the New Code icon. The dialog for creating new codes appears, where you can specify
the name, color, and description of the new code. The code is inserted into the MAXQDA project at
the top of the "Code System" and then its symbol with the codename as a label is inserted in the
opened map.

Add new code via the Insert tab

Alternatively, this can be done by right-clicking on the white area of MAXMaps and selecting the
Insert New Code option.

Inserting a background image

You can insert a background image for each map, which is displayed behind all objects. Right-click
on the white workspace and select Insert Background Image. Background images are always
inserted in their original resolution and can be changed as desired in their displayed size.

To change the image later, either right-click it and select Change Image... or insert a different
background image, this will replace the existing one.

Inserting free objects

The term "free objects" refers to objects that are not part of MAXQDA. Go to the MAXMaps Insert
tab to add one of the following free objects to your map:
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New texts (a label without a visible icon is added)
New images from a file, e.g. a photo, a map or chart
Standard shapes such as squares, circles, and arrows

By clicking on New Code, New Text or New Image in the Insert tab, the new object is inserted into
the map at the next free position seen from the top left. For images you have to select a graphic file.
This file will then be saved in the MAXQDA project. In the MAXMaps options, which can be accessed
via the gear symbol at the top right of the window, you can determine the quality with which images
are saved in the map.

This is how you can insert one of the standard shapes (rectangles, circles, and arrows):

Click on the desired shape. The mouse pointer changes to a large cross.1.
Drag the shape to the desired position on the map by holding down the mouse button and2.
dragging the cross.

Inserting free objects in a Map

Tip: Hold down the Shift key ⇧ to retain the proportions when dragging the mouse. As a result, a
square will remain a square and a circle will remain a circle.

Similarly, "free objects" also consist of an image and a label, except that no image is displayed when
a new text is inserted, and no label is displayed when images or standard shapes are inserted. Image
and label can be shown or hidden at any time.

Importing related MAXQDA objects

In MAXMaps, it is possible to import analytically related objects to an already imported object, for
example the coded segments of a code or the text of a memo.

To import related objects, right-click a MAXQDA element on a map. Depending on the object
selected, the context menu contains different options for importing.
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Context menu for the document icon in a map

The following list provides an overview of the import options for different objects:

Document icon

Import Memos - All memos that are contained in the selected document are inserted into the
workspace and linked to the document icon. The document memo from the "Document System" is
also inserted (if available).

Import Codes - Depending on the selection, all or the activated codes assigned in the clicked
document are inserted into the workspace and linked to the document icon.

Import Summaries - Depending on the choice of all or of activated codes, the summaries that were
written in the clicked document are inserted into the workspace alongside the corresponding codes.
The document is connected to the codes by lines, which are also connected to the summaries by a
line.
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Import document memos

Document group or document set icon

Import Summaries - Depending on the choice of all or activated codes, the summaries that were
written in the clicked document group or document set are inserted into the workspace alongside
the corresponding codes. The document is connected to the codes by lines, which are also
connected to the summaries by a line.

Import Paraphrases - All paraphrases that were written in a document of the clicked document
group or document set are inserted into the workspace and connected to the icon by lines.

Code icon

Import...> Code Memo - If a code memo exists, it is inserted into the workspace and connected with
the clicked code symbol by a line.

Import...> Linked Memos - All memos that are linked with the clicked code are inserted into the
workspace and connected with the clicked code symbol by lines.

Import...> Co-occurring Codes - All codes associated with the selectedcode on the same segment
are inserted into the map. The inserted codes are connected with dashed lines to the selected code
icon. Optionally, the line strength can represent the frequency: the thicker the line is represented, the
more overlaps with the associated code exist.

Import...> Subcodes - All subcodes up to the selected level are inserted into the workspace and



  385

connected with the clicked code symbol. Subcodes on lower levels are ignored. Optionally the line
thickness can represent the frequency: The thicker the line, the more encodings were made with the
subcode.

Import..> Coded Segments - Symbols (coding strips) for the coded segments of the clicked code are
inserted and connected to the code. The following dialog appears before the import, in which you
can select which segments and how they are to be imported:

Import options for coded segments

At the top, select how many segments you want to import. If less than existing segments are
imported, it is also possible to prioritize according to highest weight or largest segment. Change
label to coded text or comment causes the text of the coded segment or the comment on the coded
segment to be automatically adopted as label instead of the mere indication of origin.
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Imported segments of a code

Coded segment icon

Insert the text of the coded segment as a label - If the coded segment consists of a text, a PDF or a
table, the entire coded text is accepted as a label.

Insert the text of the associated summary as a label - If a summary exists for the code and source
document in the summary grid, the entire text of the summary is accepted as a label.

Inserting a coded image segment as an "icon" - If the image segment is coded in a PDF or an image,
the coded section is taken to symbolize for the segment.

Memo icon

Insert memo text as a label - The text of the memo is adopted as a label for the activated memo
icon.

Deleting objects

Each object can be deleted from the map:

The object is first selected with the mouse. You can also select multiple objects by1.
highlighting them with the mouse.
Press the Delete key or click the Remove from Map icon on the Start tab. Alternatively, you2.
can also right-click on the object and choose Remove from Map from the context menu.

The object and its connections to other objects are then removed from the map.
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Please note: Removing objects from a map has no impact on your MAXQDA project data. If you
remove a code from a map, it will remain in the code system.

Customize Objects in MAXMaps
You can easily customize the look and position of objects to create a map that suits your analysis.

Selecting and moving objects

To do this, you must first select the objects you want to customize. Click an object with the mouse
or drag a frame that covers multiple objects to select several objects at the same time. Selected
objects are indicated by their additional blue frame.

If several objects are already selected, you can add additional objects for selection or remove
individual objects from the selection by clicking the objects while holding down the Shift key.

Use the key combination Ctrl+A (Windows) or ⌘+A (macOS) to select all objects on a map.

Selected objects can be moved anywhere on the workspace by holding down the mouse button.

The "Format" menu tab

The properties of selected objects are adjusted in tab Format and Line Format. The menu items
appear in the upper part of the window as soon as you select an object.

The Format menu tab

The Format tab is divided into different areas:

"Label" Area

Here you define the appearance of the label of an object. You can adjust the font and font size as
well as the font color. The text width is specified in relative units: A width of 10 means that the label
is a maximum of 10 times as wide as the symbol.

By default, labels are displayed below a symbol. Click on the icon highlighted in the next image to
display the label above or not at all:



  388

Options for label position

"Symbol" Area

Depending on the object type, there are different forms for the symbol, for example, the different
document symbols for a document from the "Document System".

You can also use a different image than the standard MAXMaps icons:

First click on the large Symbol icon and then select Add own icon... from the drop-down1.
menu...
A file dialog appears in which you can select any image from your computer.2.

Add own image as symbol

You can use the Display icon option to hide an icon so that only the label text remains visible.

Tip: In order to hide all code symbols, for example to only operate with the code names on the map,
it is not necessary to switch the symbol to invisible for each individual code. In the tab Start you will
find the option Display Symbols > Codes, which works like a switch: Click the option to hide all code
symbols at once and click the option again to show all symbols that are visible. Here you can also
show or hide the symbols of the Coded Segments.
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"Object" Area

Here you can define the following properties for the entire object:

The layer on which the object is located.
The addition of a frame to the entire object in any color.

"Link" Area

In this area, you can assign two different links to an object after you have clicked the Geo-
Link/External Link icon:

External Link - Click on the three dots to select a file.

Geolink - Click on the three points to select a KML file.

Add geo link to an object

To access the link later, right-click the object and select Open External Link or Open Geolink.

Copying object properties

MAXMaps makes it possible to transfer properties from one object to other objects. This of course
makes it easier to give objects a uniform appearance. The function is available for all objects,
including link objects. In this case it is possible to transfer the color and the line type from one link
line to another.

Symbol for copying object properties

Here's how you do it:

Select the object whose properties are to be transferred to others.1.
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Click on the Copy Format icon in the Format tab or the Line Format tab.2.
Select the object to which you want to apply the format.3.

Tip: If you double-click on the icon in the toolbar, the "Copy Format" mode remains activated. Each
object that you then click on is given the format originally selected. To exit the mode, press the Esc
key or click the Copy Format icon again.

Copying objects

Single or multiple selected objects can be copied to an internal clipboard of MAXMaps using the
function Start > Copy Object (or the keyboard shortcut Ctrl+C (Windows) or ⌘+C (macOS)). Start >
Paste Object (or Ctrl+V (Windows) or ⌘+V (macOS)) inserts the objects into the next free space in
the top left corner of the map, while of course preserving their design.

You can also right-click directly to the destination and choose Paste from the context menu. The
objects will then be inserted into the map in place.

Please note: Keep in mind that MAXQDA objects such as documents, codes and memos can only be
present once on the same map and may be ignored during insertion.

Increasing and decreasing the size of objects

The following options are available for changing the size of selected objects:

Click on the blue dot at the lower right selection frame and pull the object larger or smaller
while holding down the mouse button.
On the Format tab, set the desired size in the number fields.
On the Format tab, click Increase Size or Decrease Size.

Change the size of an object in the format tab

The size ratio of symbol and label to each other can be adjusted by selecting the font size in the
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object properties.

Adding and editing labels

Double-click a text in the workspace to edit the text in place. Hold down the Shift key ⇧ and press
the Enter key to insert a line break.

If an object does not yet have a label, you can add it by right-clicking on the object and selecting the
Add Label function.

Add a text to the symbol of a free object

Sometimes you may want to write a text in a free object such as a rectangle or a circle. This can be
done, of course, by creating another object via Insert > New Text and placing it on top of the other
object.

However, it is also possible to write a text that is linked to the object directly in the free object: To do
this, right-click on a free object and select Add Text from the context menu.

Add text to an object

Tip: Double-clicking on the symbol of a free object directly opens the edit field for entering and
editing a text. The Format tab can be used to adjust the formatting of the text. Selected formatting
always applies to the entire text.

Grouping objects

Objects can be grouped so that their distances remain constant.

To do this you first have to drag a frame around the objects with the mouse. As an alternative,1.
you can also select individual objects to be grouped by clicking them one by one while
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pressing the Shift ⇧ key. In the same way, the selection can also be undone for individual
objects.
In the Start tab, click Group Objects, your selection will become a fixed group. Alternatively,2.
the option is also available after right-clicking on one of the selected objects in the context
menu.

The objects of a group can't be selected individually but are always selected together. A change of
object properties in the Properties window has the same effect on all objects in the group, including
changes in the size.

The group can be split up by clicking on the group and then clicking Ungroup objects in the Start tab.
Alternatively, the option is also available in the context menu for the group.

You can group and ungroup objects with the icons framed in red.

Image exchange - importing images

The icons displayed in MAXMaps for MAXQDA object such as codes or documents, are the standard
MAXQDA icons - however, these can be exchanged against another imported image, as follows:

Click the object with your right mouse button and select Change Image ... from the context1.
menu.
Instead of the default icon, you can now use any other image. The image formats JPG, PNG2.
and TIF are allowed.

Alternatively, you can use the Format tab to change the icon to a custom image by first clicking the
Icon button and then selecting Add own icon... from the pop-up menu that appears.

Move objects to the front or back

To design a map in such a way that it reflects your ideas, you need to be able to determine which
objects should be placed in the foreground.

The procedure is quite intuitive:

Click the object you want to move. You can also select several objects at the same time with1.
the mouse.
Click the Bring Level Forward or  Send Level Back icons in the Start tab to arrange the2.
sequence of your objects in the map. By clicking on the arrow below these icons, the options
Bring to Front and Send to Back are also visible, which place an object all the way forward or
back.

Alternatively, click on an object with the right mouse button and select one of the positioning options
in the Arrange menu. This menu also displays the key-shortcuts, for example ⇧ + PgDown for "Send
to back".
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Aligning objects

To align several objects to each other, first select them. Then select the Align option in the Start tab,
which will give you several options: The objects can be aligned horizontally, vertically or at the same
distance from each other. It is also possible to align the objects in a semicircle or circle. The
alignment of the objects always refers to the symbol of the object. Only if this symbol is hidden and
only the label is visible does the option refer to the text.

Layers
Objects can be assigned to different layers. If you ignore this option, all newly inserted objects will
be assigned to the same standard “Base” layer. The Layer option makes it possible to display or to
remove parts of the drawing, so you can, for example, design a presentation that gradually increases
in complexity. You can start building a model with only a few elements and gradually increase the
number of elements that are displayed, thus creating a structure that continually gains complexity.

The Layer function can be activated by clicking the layer icon in the Start tab. This will open a
window in which the existing layers are listed. At first, this includes only the “Base” layer. You can
define a new layer by selecting New.

Layer window

Any object on the drawing pad can be assigned to a certain layer. Just choose the option Layer after
selecting the object with the right mouse button and assign the object to the desired level in the
menu.
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Assigning an object to a layer

To display a level, select its name in the Layer options window.

Tip: You can also assign a selected object in the Format or Line Format tab using the Select Layer
function.

The Object Library
The object library is a helpful tool for simplifying the organization of your objects. You can fill the
library with any formatted object, so that you have quick access to the same shape in the future. To
add an element to the library right-click on the object and select Add to Library.
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Add object to the library.

The selected object will be saved to your library and the "Library" window is opened automatically on
the left of the MAXMaps window.

The Library window on the left side of the MAXMaps window.

The Library window can be opened or closed via the Library button in the Start tab at any time.

Double-click on an object in the library to insert it into your map. All formatting is the same as in the
original.
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At the top of the Library window are two icons that allow you to insert objects from the library onto
the map and delete objects from the library.

Linking Objects
To link two objects, click the Link icon in the Start tab to activate MAXMaps' Link Mode.
Alternatively, use the shortcut CTRL+L / ⌘+L to activate/deactivate the Link Mode. In this mode, you
can't select or move objects, but only create directional or non-directional linking lines between two
objects.

Activating Link Mode in the “Start” tab.

Objects are linked to one another by clicking on one object and dragging the connection line to the
target object while holding down the mouse button.

If you later move objects on the desktop, the connections are preserved and move with the objects.

Formatting lines

Connecting lines can be adjusted regarding line thickness, line color, line type, label, and arrow
direction.

If you click on a line, the Link Mode is deactivated, the line is selected, and the tab Line Format
opens to display options to adjust the line appearance.

To select multiple lines at once hold down the Shift key ⇧ while clicking on the lines and adjust their
properties all at once.

ormatting linking lines

Tip: You can also format connecting lines as curved connections. To do this, click the  icon in the
Format tab.
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Print, Export, and Organize Maps
Printing a map

Any map created in the MAXMaps module can be printed in high quality. To start the print procedure,
click the Print icon at the top right of the MAXMaps window.

Adding maps to the "Document System" as new image documents

You can add a map as a new image document to the "Document System" at any time, which allows
you to analyze it further as an image. To do this, right-click on the name of the map in your List of
Maps and select Insert as Document.

Once you have added the map to your "Document System" you can analyze the map like any image
in MAXQDA, e.g. you can code parts of the image and add memos.

Copying maps to the clipboard

You can copy the current display of your map to the clipboard at any time, from where you can then
paste it into a report, presentation, or graphics program. In the Start tab, click the Copy View icon.

Exporting a map as a graphic file

Maps can be exported in different formats. Thus, you can use them with other software programs,
such as Microsoft Word or PowerPoint. To start the export procedure, click the Export Map icon in
the Start tab.

The options dialog window for exporting a map.

The following file formats are available: SVG, JPG, PNG, and EMF for windows.

How to export and import a map

All maps are stored in the MAXQDA project file along with the rest of the files. Maps can be
transferred from one MAXQDA project to another project:

Right-click a map in the "List of Maps" and select Export Map.1.
In the export dialog that appears, set the File format to "MAXMaps file (*.mod)"2.
Assign a file name and location for the exported file created with the extension MOD.3.
In the target project, which can also be on another computer, open MAXMaps, click on New4.
Map (not on the symbol) in the Start tab so that the associated menu opens and there you
select the Import Map entry. 

The connection between MAXQDA objects (such as codes and documents) on a map and the
MAXQDA project will, of course, be lost when importing a map. This is because completely different
codes and documents can exist in the target project.
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Handling of images during export and import

If you import an image to a map or use it as a symbol and it's larger than the set file size limit in the
general preferences, the image will not be stored in the MAXQDA project. However, it will be stored
in MAXQDA's folder for external files. The same applies to coded image sections used as symbols.

When you export a map as a MOD file, MAXQDA will additionally create a compressed ZIP file with
the images in the map in the same folder.

If you want to open the map on a different computer, you have to extract the images from the ZIP
file in the MAXQDA folder for external files on that computer. MAXQDA does this work for you:

Open any MAXQDA project, in the Home tab, click on the arrow next to External Files and1.
select Unpack Bundled Data Files from the menu that appears.
In the file dialog window, select the ZIP file created on the other computer. MAXQDA then2.
unpacks all the files from the ZIP file to the external files folder.

Synchronize Map With Project Data
The interesting thing about working with MAXMaps is that it always has a connection to the
MAXQDA project data. In the case of a code symbol this means, for example, that when moving the
mouse over the symbol in the map, the memo assigned to the code appears at the mouse pointer
and that a double-click opens the “Overview of Coded Segments” associated with the code.

The following connections exist between the MAXQDA elements of a map and the project data:

Document group and document set icon

mouse-over: display a preview of the memo of the document group or document set at the
mouse pointer (if available)
single click: focus the document group or the document set in the “Document System”.

Document icon

mouse-over: display the document memo at the mouse pointer (if available)
single click: focus the document in the "Document System"
double-click: document is opened in the "Document Browser"

Memo icon

mouse-over: display the memo preview at the mouse pointer
single click: focus the memo (depending on the memo type in "Document System", in "Code
System", in the "Document Browser", in the "Multimedia Browser")
double-click: open the memo

Code icon

mouse-over: display of the code memo preview at the mouse pointer
single click: focus the code in the "Code System"

https://www.maxqda.com/help-mx24/the-workspace/general-preferences
https://www.maxqda.com/help-mx24/import/external-files
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double-click: open the "Overview of Coded Segments" for this code (for codes that have been
inserted into a map by creating a model, only the segments that were taken into account
when creating the model are displayed in the overview)

Symbol of a coded segment

mouse-over: preview of the segment at the mouse pointer
single click: focus the code in the "Code System", document is opened in the "Document
Browser" or "Media Browser" and moved to the position of the coded segment

Activating documents and codes

It is also possible to activate a document or a code from MAXMaps. To do this, select one or more
documents, right-click on a selection and choose Activate Document / Code from the context menu.
The selected documents are activated in the "Document System" in addition to any already activated
documents.

Tip: You can also add one or more selected codes to an existing or new code set in the “Code
System” by using the context menu. Select the Add to Code Set function.

Opening code frequencies

In the Start tab, there is the Code Frequencies option, which allows you to show how often the
respective code was used in the data for MAXQDA codes in your map. The code frequencies are
displayed in brackets after the code name.
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Code frequencies are displayed after the code name.

The code frequencies are dynamically linked to the original data. So if you delete or complete a
coded segment, the numbers brackets for each corresponding code in MAXMaps are adjusted
accordingly. Exceptions are codes that have been inserted into a map by creating a model. For
these, the number in brackets indicates how many codes were included in this code at the time the
model was created. The number is not updated with these codes, but the models always provide a
snapshot of the code frequencies at the time it was created.

Model Templates in MAXMaps
MAXQDA's model templates provide a unique tool for visualizing specific perspectives on the data
material. Very often, the research process focuses attention on parts of the data, such as a specific
document, a specific code, a common occurrence of codes, or specific hypotheses and theoretical
aspects described in memos. For such situations the models in MAXMaps offer quickly accessible
solutions, which can be adapted to the respective circumstances and wishes by appropriate options
well. MAXQDA then produces a corresponding diagram and makes it available in the MAXMaps
workspace. This map can be further edited and supplemented in MAXMaps.
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Models with focus on documents

Single-Case Model

All relevant data attached to a document is illustrated in the map. This includes all appropriate
memos, codes, and coded segments. Instead of the coded segments, the summaries or
paraphrases of the document can be output. The Single-Case Model can be created for documents,
document groups, document sets and focus group participants. There is also a version with
hierarchical code placements available.

Example of a Single-Case Model

Two-Cases Model

This model visualizes which codes occur in both of the selected documents, document groups or
document sets, and also which codes only occur in one of the cases.
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Example of a Two-Cases Model

Models with focus on codes

Single-Code Model

Displays a selected code in the map and the associated coded segments or summaries, as well as
the code memo and the memos associated with the code.

Example of a Single-Code Model
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Code Theory Model

This model is especially helpful for the development of theory. It automatically displays all memos
(with their ideas and hypotheses) attached to a specific code.

Example of a Code Theory Model (with integration of subcodes on 1st level)

Code-Subcodes-Segments Model

A code and its subcodes are placed on the map. Each code or subcode is connected to their coded
segments. This model is also available in a hierarchical version.

Example of a Code-Subcodes-Segments model

Hierarchical Codes-Subcodes Model

A code and its subcodes are placed on the map. The hierarchical levels of the subcode are displayed
like the levels of a building.



  404

Example of a Hierarchical Code-Subcodes Model

Code Co-Occurrence Model

This model illustrates the associations and intersections between selected codes. The model can be
made more complex by including the subcodes in the visualization. As an alternative to directly co-
occurring codes on a segment, the proximity or occurrence of codes in a document can also be
analyzed.

Example of a Code Co-Occurrence Model
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Creating a new model

To create a new model, follow these steps:

Click on New Document Model or New Code Model in the Start tab of MAXMaps and selected1.
a model from the dropdown menu.
MAXQDA creates a new blank map with the name of the model as a title and will display a2.
short tutorial on how to insert MAXQDA objects: Depending on whether you are creating a
case-oriented or a code-oriented model, you will now need to drag objects from your
"Document System" or "Code System" onto your map (these are displayed directly in
MAXMaps).
As soon as the documents or codes have been selected, a preview of the finished model3.
appears on the map. On the left side you will find all the options available for creating the
model. You can try any option - the preview of the map automatically adjusts with each option
change.
To finish creating the map, click the Use Model button at the top of the options area.4.

Interactive model building

These models allow you to explore the data in a unique way. All elements of the map are
synchronized with the data of the MAXQDA project, i.e. a mere movement of the mouse over certain
elements of the drawing layer displays a preview of the contents of the symbolized memos or coded
segments. A double-click on the symbol of a coded segment takes you directly to the corresponding
position in the document.
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Options in MAXMaps
By clicking on the gear symbol in the top right corner of the MAXMaps window, a dialog will open
where you can view and change standard settings.

The MAXMaps preferences window

Apply grid – this option “snaps” your objects to a grid, which is visualized in the background. This
allows you to line up objects more easily in straight lines, and the grid will not be shown in exported
pictures.

Reduce imported images to this size – this setting determines how imported images are handled.
You can select "300px", "600px" (= standard), "1,200px" or “Original size”. The longest side of an
imported picture is then reduced to the maximum pixel size. Background pictures are always
imported in their original size.

Visualize internal links – when this box is checked, internal links are visualized by a blue line
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between documents, as soon as documents are inserted into a map.

Display comment in tooltip of coded segment - when this box is checked, comments to a coded
segment are displayed as tooltips, when you hover the mouse cursor on the coded segment while
having the synchro mode activated.

Auto-save maps in cache [minutes] - when this box is checked, a temporary copy of the map is
saved to cache at the set interval.

Use code and document color as border - check this option to display code and document symbols
with colored borders in their respective code/document color. If this option is unchecked all symbols
are displayed with black borders and a small color symbol.
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16 – Paraphrasing

About Paraphrasing in MAXQDA
Paraphrases are summaries of individual sections of your data, written in your own words. MAXQDA
makes it easy to write paraphrases for sections of text, image segments, and video and audio clips
and then categorize these paraphrases in order to systematize and group them. These paraphrase
functions can be used to work systematically with summaries of text sections and the formation of
categories. Paraphrasing is often carried out within the framework of qualitative content analysis: it
is used especially in the exploration of data and as the basis for inductive category development
(Kuckartz, 2014, Mayring, 2015, Schreier, 2012). But paraphrasing is useful in general whenever you
need only to summarize the important contents of a text, e.g. when a journalist paraphrases the key
statements of an interview.

Both, paraphrases and summaries, can be used to summarize content, but they have very different
applications and requirements. The following research blog article gives an extensive overview of
the difference between paraphrases and summaries:

Read article

Paraphrasing and Teamwork

If you’re working in a team and have split the documents to be paraphrased between your team
members, you can use MAXQDA's Teamwork functions (in the "Home" tab) to either merge two
projects (with different documents that contain paraphrases) or to transfer paraphrases between
projects (that already contain the same documents).

Paraphrase Text Passages and Image
Segments
Activating Paraphrase Mode

You can create paraphrases for text, PDF, and image documents using three different ways.

Variant 1:

Open the document or image you want to paraphrase in the "Document Browser" window.1.
Turn on "Paraphrase Mode" by clicking the Paraphrase icon (not the label of the icon) on the2.
Analysis tab, or by pressing Ctrl+⇧+P (Windows) or cmd+⇧+P (Mac). The icon will be
highlighted in blue, indicating that Paraphrase Mode is active.

https://uk.sagepub.com/en-gb/eur/qualitative-text-analysis/book240393
https://www.ssoar.info/ssoar/handle/document/39517
https://uk.sagepub.com/en-gb/eur/book/qualitative-content-analysis-practice
https://www.maxqda.com/memos-comments-paraphrases-summaries
https://www.maxqda.com/help-mx24/teamwork/merging-two-maxqda-projects
https://www.maxqda.com/help-mx24/teamwork/merging-two-maxqda-projects
https://www.maxqda.com/help-mx24/teamwork/transferring-coded-segments-memos-variables-etc-from-one-project-to-another
https://www.maxqda.com/help-mx24/teamwork/transferring-coded-segments-memos-variables-etc-from-one-project-to-another
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Activated Paraphrase Mode

Writing New Paraphrases

While "Paraphrase Mode" is active, highlight the section of the document or image you want1.
to paraphrase.
Immediately after you let go with your mouse, MAXQDA will display a window in which you2.
can write a paraphrase. A paraphrase has a maximum of 255 characters including spaces.

Paraphrasing window

Pressing the Enter Key (↩) or clicking on OK closes this window.3.

Tip: To include a line break in your paraphrase, press ⇧ + Enter.

The newly-created paraphrase is then displayed to the right of the document or image in the sidebar
of the "Document Browser". The paraphrased segments are highlighted in orange, so you can
immediately see which segments have already been paraphrased.
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Paraphrases displayed in the sidebar of the Document Browser

Paraphrases in text documents cannot overlap with existing ones. So, when you highlight a section
that is already (partially) paraphrased, the paraphrase window will not open up. Paraphrases in
images can partially overlap with existing ones. It is not possible however to paraphrase an image
segment that is completely enclosed by an existing paraphrase or that encloses an existing one.

Variant 2:

Open the document or image you want to paraphrase in the "Document Browser" window.1.
Highlight the section of the document or image you want to paraphrase.2.
Open the context menu and choose Paraphrase segment.3.
MAXQDA will display a window in which you can write a paraphrase.4.
The paraphrase mode will not be activated.5.

Variant 3:

Open the document or image you want to paraphrase in the "Document Browser" window.1.
Turn on "Paraphrase Mode" by clicking the Paraphrase icon (not the label of the icon) on the2.
toobar of the "Document Browser".

Editing or Deleting Paraphrases

To edit a paraphrase, double-click the paraphrase text in the "Paraphrase Column" next to the text.
The window with the paraphrase opens again in which it can be edited.

To modify the paraphrased segment, select the paraphrase in the sidebar. You can now use the
grabbers to adjust the size of the paraphrased segment. Please note that two different paraphrases
can not overlap.
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To delete a paraphrase, click on the 'x' in the top right corner of the paraphrase bubble.

elete your paraphrases by clicling on the 'x' symbol

Deactivating Paraphrase Mode

Paraphrase Mode is deactivated in the same way it is opened by clicking on the Paraphrase button
in the Analysis tab. The sidebar of the "Document Browser" remains visible to shows the
paraphrases next to the documents.

"Paraphrase Mode" is automatically deactivated when you open another document or select another
tab in the menu.

Writing paraphrases with deactivated Paraphrase Mode

You can also paraphrase a text or image segment in the "Document Browser" at any time without
activating the Paraphrase Mode:

Select the segment to be paraphrased with the mouse.1.
Right-click on the selected segment and choose Paraphrase Selection from the context2.
menu.

The window for writing paraphrases appears. If the sidebar in the "Document Browser" is displayed,
the paraphrase will appear in the sidebar after the window for writing is closed.

Displaying Paraphrases in the Sidebar of the “Document Browser”

You can display or hide the "Document Browser" sidebar independently of Paraphrase Mode when
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you want to display your paraphrases at any time. Right-click in a document and select Sidebar >
Paraphrases.

Displaying paraphrases in the sidebar

Tip: Adjust the width of the sidebar by clicking and dragging the vertical separator with the mouse.

Print Document with Paraphrases in the Margin

It is possible to print the document currently displayed in the "Document Browser" and output the
created paraphrases in the margin of the page. To do this, choose Paraphrase > Print Document
with Paraphrases. from the Analysis tab.

MAXQDA will then display the following print preview:
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Options for printing documents with paraphrases

Adjust your printing settings on the left.

Paraphrase column width - define how much wide the paraphrases space should be.

Highlight paraphrased Segments - displays paraphrased segments with a colored background.

Paraphrase Video and Audio Segments
You can use MAXQDA to paraphrase scenes of a video or audio file. This is explained in detail in the
chapter Paraphrase Videos.

The “Paraphrased Segments” Code in
Your “Code System”
The process of paraphrasing is independent of coding, i.e., the process neither requires coding of
the data (from a methodological point of view) nor does it generate codes. However, an entry
“Paraphrased Segments” appears in the “Code System” window as soon as the first paraphrase in a
project is created. This entry is very similar to a code and gives you access to all paraphrases in the
current project. You can use the entry similarly to a code to call up all paraphrases for selected

https://www.maxqda.com/help-mx24/analyzing-videos/paraphrase-videos
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documents in the “Retrieved Segments” window:

In the “Document System” window, activate a document that includes paraphrases.
Activate the “Paraphrased Segments” code in the “Code System” window.

Paraphrased texts of an interview in the “Retrieved Segments” window

The “Paraphrased Segments” entry in your “Code System” has some special features:

You can’t delete it, rename it or use it for coding.
By default, it is displayed at the bottom of the code system. In the local settings (accessible
by clicking on the cogwheel icon in the “Code System” header title), you can choose to display
it at the top of the code system instead.
Coded segments cannot be added to or copied from it.
Paraphrases are not indicated by a coding stripe in the “Document Browser”.
Paraphrases are ignored in the visual tool Document Portrait and also when creating
document models in MAXMaps.
Paraphrases are displayed in the visual tool Codeline.

Categorize Paraphrases
To systematize and group paraphrases, you can categorize them using codes. This function
supports, among other things, the inductive and data-driven development of categories.

To start the categorization of paraphrases, proceed as follows:

Activate the individual documents which include the paraphrases you would like to work with.1.
Select Analysis > Paraphrase > Categorize Paraphrases (you have to click on the label2.
"Paraphrase", not on the symbol above it).

The following interactive table window will then appear:
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Interactive table window for categorizing paraphrases

A code tree is displayed in the left field. When you open the function for the first time, it will still be
empty. You can enter new categories here and then assigned them to individual paraphrases. The
number at the end of the code line tells you how often the category occurs in your paraphrases. If
you activate the function again later, all codes which have already been assigned to a paraphrase
will be displayed in the code tree. So, you can easily pause your work on paraphrases and pick it up
again later.

Above the code system there is a toolbar offering the following functions:

Display only paraphrases from the selected category – if this option is enabled and you click on a
category in the Code System, only the paraphrases of the selected category will be displayed.

New code – creates a new category in the code system, which can be used to categorize your
paraphrases.

In the right field, all the paraphrases in your project will be displayed – each listed in a separate row.
The number of currently listed paraphrases is displayed in the upper right corner of the window.

The individual columns contain the following information:

Document – Indication of origin, in which document and at which position the paraphrase was
created

Paraphrases – Contains the paraphrase that has been written for the paraphrased text

Codes – The list of codes applied to the paraphrases

Paraphrased text – Contains the text that was paraphrased (this column is automatically hidden
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when the interactive table window is opened); <IMAGE> is displayed for paraphrased image
segments, not the paraphrased image segment itself.

The table can be adjusted like all MAXQDA tables: The width and position of columns can be
changed with the mouse, or by right-clicking on a column header. A click on the heading sorts the
column in ascending order, another click in descending order.

The lines with the paraphrases can be sorted by drag and drop with the mouse so that similar
paraphrases can be arranged one below the other, which is very helpful for categorization. Sorting
remains as long as the project is open. When new paraphrases are added, they are appended at the
bottom.

Please note: All other MAXQDA functions are locked, while the paraphrases function is open.

Functions in the Menu Ribbon “Start”

At the top of the “Categorizing Paraphrases” window there is a toolbar with the following functions:

Display all codes – if this option is activated, not only the codes that have been newly created in the
opened window or already assigned to a paraphrase as code are displayed in the "Code System", but
all codes in this project.

Only activated documents – only the paraphrases of activated documents are displayed. The
display of frequencies in the code tree is adjusted accordingly. If the documents were activated
when this function was opened, this option is automatically activated.

Filter – applies the filters you can define by right-clicking on the column heading and selecting Set
Filter.

Reset all Filters – removes filters from all columns.

Display search toolbar – lets you to enter a search term to search for text in all or specific columns.

Display Parent Code – in addition to the code, the "Codes" column also displays the parent code.

Display Paraphrased Segments – shows another column containing the paraphrased texts.

At the top right of the window there are also two icons for the local undo function:

Undo – undoes the last action in the window.

Redo – redoes the last action in the window.

Creating and Assigning New Categories

Paraphrases can be categorized using codes. You can always create a new code and assign it
directly to a paraphrase:

Right-click on the paraphrase and select Create and Assign New Code.1.
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Selecting a function from the context menu of a paraphrase

In the dialog window that appears, you can enter a code name and assign a code color. You2.
can also enter a description of the new code in the "Code memo" text box.
After clicking OK the new code is added, displayed in the code tree on the left side, and3.
assigned to the paraphrase.

This categorization is immediately made clear by the display of the code in the “Codes” column.

To assign a pre-existing category to a paraphrase, click and drag the row with the paraphrase to one
of the displayed codes in the code tree.

You can also create categories without assigning them directly to a paraphrase: click on the green
plus sign that appears when you hover with the mouse pointer over the word “Code System” or
an existing code.

To do this, click the New code icon in the toolbar,
Use the key combination alt+N (Windows) or ⌘+⌥+N (macOS) or
right-click on the top entry of the code tree and select New code.

Please note: All changes made to the code system in this window, including the addition of new
codes, are automatically incorporated into your overall “Code System”.

Removing Assigned Categories

To remove a category assigned to a response, click the cross that appears when you move the
mouse over a code in the "Codes" column.

Customizing Your Category System

Your category system can be customized throughout the entire analysis process. You can change
the order of codes with the mouse and even insert them as sub-subcodes. By right-clicking on a
code, all the functions from the overall "Code System" are available to customize your code system
here:

Delete code
Sort subcodes (alphabetically or by category frequency)
Change code color
Create or edit code-memo
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Copy, move, paste coded segments

Exporting Paraphrases

Your current display can be exported via the usual icons at the top right of the window. All the rows
(paraphrases) in the right field are always exported.

Paraphrases Matrix
In the Paraphrases Matrix, paraphrases you have written for cases or groups can be displayed
together and compared in a table view. The table columns are formed by either documents, focus
group speakers, document groups, or document sets, and their respective paraphrases are listed in
each column.

In the Paraphrases Matrix, paraphrases you have written for cases or groups can be displayed
together and compared in a table view. The table columns are formed by either documents,
document groups, or document sets, and their respective paraphrases are listed in each column.

The Paraphrases Matrix

Creating a Paraphrases Matrix

To open the Paraphrases Matrix:

Select the function Analysis > Paraphrases > Paraphrases Matrix in MAXQDA's main menu1.
(you need to click on the label “Paraphrases” not on the icon).
A dialog window will appear in which you can drag and drop documents, document groups, or2.
document sets from the "Documents System". Each row in the selection window will later
form a column in the Paraphrases Matrix.
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Column selection window

Click OK and MAXQDA will display the Paraphrases Matrix.

Functions in the toolbar

In the Paraphrases Matrix itself, you can access the following functions in the toolbar at the top left
of the window:

 Display origin – displays the source documents below your paraphrases. Clicking on this
source selects the relevant paraphrased segment in the "Document Browser".

 Zoom out/in – minimizes/maximizes the display of the paraphrases in the columns.

x of y columns – Lets you specify how many columns are to be displayed next to each other in the
window at the same time.

 Refresh – opens the options dialog window to let you regenerate the paraphrase matrix again
to adopt new matrix specifications.

Exporting the Paraphrases Matrix

The contents of the Paraphrases Matrix can be exported using the usual symbols at the top right of
the window.

 Open as Word document – Creates a Word document and opens it.

 Open as Excel table – Creates an Excel document and opens it.

 Export – Creates a Word file (DOCX format), an Excel file (XLSX format), or a web page (HTML
format).
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The Overview of Paraphrases
The Overview of Paraphrases is available in the "Document System" on all levels (document,
document group, document set) and lists all existing paraphrases for the selected level in an
overview table typical to MAXQDA. The text of the paraphrase is always completely visible; in other
words, long paraphrases are displayed across several rows.

The Overview of Paraphrases

Accessing the “Overview of Paraphrases”

To open the “Overview of Paraphrases”, right-click on a document, document group, or document set
in the “Document System”. Then select Paraphrases in the menu that appears.

The Overview of Paraphrases will then appear with all the paraphrases from the documents at the
selected level. The overview is interactive:

Click a row to display the paraphrased segment in the “Document Browser”, for example, to
compare your paraphrased text with the original segment.
Double-click into the cell with the paraphrase itself to edit the paraphrase directly in this table.

Like all overviews in MAXQDA, you can sort, filter, search, and export the content of this table.

The Overview of Paraphrased Segments
The "Overview of Paraphrased Segments" can be accessed via the "Code System" and is very similar
to the "Overview of Coded Segments". This overview contains all the paraphrases in your project and
displays the paraphrased text of the selected paraphrase in the preview area. In contrast to the
“Overview of Paraphrases”, it also displays the original paraphrased segments and contains
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additional columns with information such as the size of the paraphrased segment. The paraphrases
themselves are only displayed in one row.

The “Overview of Paraphrased Segments”

The "Overview of Paraphrased Segments" is very useful for seeing an overview of the paraphrases in
your project together with your paraphrased segments in a single window.

Accessing the “Overview of Paraphrased Segments”

To access the Overview of Paraphrased Segments double-click Paraphrased Segments in the "Code
System". Alternatively, right-click on Paraphrased Segments and select the corresponding option in
the context menu.

Tip: By default, the Paraphrased Segments entry is displayed in the bottom row of the "Code
System". Alternatively, you can display this entry at the top. To do this, click on the gear symbol in
the "Code System" to open the local settings and check the option with the same name.

The “Overview of Paraphrased Segments” is interactive:

Click on a row to display the paraphrased segment in the “Document Browser”.
Double-click on the paraphrase text to edit it directly in the overview.

The individual columns of the overview have the following meanings:

Document group, Document name, Beginning, End – Specifies the source of the paraphrased
segment.

Weight – A weight can also be assigned to a paraphrase (as with codes). The weight can be used,
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for example, to identify paraphrases that you are unsure about and that you would like to look at
again later, either yourself or as a team.

Created / Created by – These columns indicate when and by whom the paraphrase was created.

Area – Size of the paraphrased segment (text segments in characters, image segments in square
pixels).

Coverage – Size of the paraphrased segment as a percentage of the total size of the document.

Like all overviews in MAXQDA, you can sort the table by clicking on a column header and arrange the
columns in any order by clicking and dragging the column headers with your mouse. You can also
filter, browse, and export the overview (see Managing Table Overviews).

Coding Paraphrased Segments

You can code the listed paraphrased segments with a new code or with an existing code. To do this,
click on the corresponding icons in the toolbar:

 Code paraphrased segments – Codes the paraphrased segments with an existing code from
your code system. To select an existing code, you must first click on it once in the “Code System”.

 Code paraphrased segments with new code – Codes the paraphrased segments with a newly
created code.

If individual rows are selected, only these are coded, otherwise, all currently listed segments are
coded with the code.

https://www.maxqda.com/help-mx24/screens-and-menus/managing-table-overview
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17 – Summarizing

Summary Grid (Create and Edit
Summaries)
The idea behind the Summary Grid

The systematic analysis of texts, but also of other data, is often about systematically organizing the
data within a structuring framework and summarizing them in a focused way on individual themes
(categories).

The idea is to look for theoretical explanations for certain phenomena as well as for similarities and
differences between cases. In this process, it is important to focus on what the research
participants precisely said. But on the other hand, the researcher should also detach from the
participants’ own words. The aim is to sum up and express what was said abstractly, and to
eventually present it in a way that is understandable for the recipients. During this analytical
procedure, the “raw data”, that is for example interview transcripts, records, field notes, etc., should
be accessible at all times. MAXQDA’s summary functions are designed for this purpose.

Please note: Another MAXQDA feature that is used to summarize content is the paraphrase
function, but summaries and paraphrases have very different applications and requirements. This
research blog article explains which function can be used for what.

MAXQDA's Summary function distinguishes two work stages and offers two individual working
environments for these stages:

First, the phase of summary creation in MAXQDA’s Summary Grid, explained in this section.
Second, the phase of summary analysis and summary presentation using MAXQDA’s
Summary Tables or Summary Explorer.

The summary functions can be accessed in the menu tab Analysis:

Summary functions in the Analysis Tab

To create summaries, the segments that you want to analyze must already be coded thematically.
This might have been done with the use of a structured interview guide, thematic coding, or
automatic coding. If the text is already coded with a code system, a structure “texts x codes” already
exists; you can view it using MAXQDA’s visual tool Code Matrix Browser.

You can picture the summary level as a thematic grid,that is, a matrix “documents x categories
(codes)”. MAXQDA offers a matrix like this called the Code Matrix Browser. It displays the
documents in the columns and the categories in the rows.

https://www.maxqda.com/memos-comments-paraphrases-summaries
https://www.maxqda.com/help-mx24/summarizing/summary-tables
https://www.maxqda.com/help-mx24/summarizing/summary-explorer
https://www.maxqda.com/help-mx24/visual-tools/code-matrix-browser-visualizing-codes-per-document
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The Summary Grid is a second analytical level that contains the summaries written by researchers
for every node of the Code Matrix Browser. The researchers write individual summaries and can edit
them later, i.e., by adding or altering the information. The idea is to present the summaries in
overview tables or compare summaries for subgroups at a later stage of the analysis. This grid
allows every summary to stay linked to the original segment of the raw data.

The Summary Grid workspace

To create and edit summaries, click on the Summary Grid symbol in the Analysis tab.

MAXQDA opens a new window called “Summary Grid.”

Window “Summary Grid”

The window itself is divided into three areas:

Left area: The thematic grid with the documents in the columns and the codes in the rows (as1.
in Code Matrix Browser). Here, you can select a node document x code.
Right area (top): All segments that belong to the currently selected node, that is, all segments2.
from the selected document that have been coded with the selected code.
Right area (bottom): The summary, this is where the summary for the coded segments is3.
displayed, written, and edited.

Thus, in the lower right area, you can write or change a summary for the selected cell of the left
window area. The selection is made by simply clicking on a cell with the mouse.

Tip: You can also use AI Assist to automatically create and edit summaries.

A blue square indicates that there are coded segments for a cell. If you click on a cell that does not
have a blue square, no coded segments will be displayed in the right pane. However, you can still
write a summary for this node.

https://www.maxqda.com/help-mx24/ai-assist/ai-summarys-in-the-summary-grid
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The summary is automatically saved when you switch to another node in the first column or close
the window. The green cell highlights in the left window indicate for which nodes of the grid
summaries have already been written.

Tip: Selected text passages in the “Coded Segments” area can be dragged into the summary text
box by holding down the left mouse button. This makes it easy to add original quotations to the
summary.

You can adjust the columns and rows of the grid on the left with two symbols in Start menu tab:

Only activated documents -only documents that have been activated in the “Document System”
will appear as columns.

Only activated codes -only codes that have been activated in the “Code System” will appear as
rows.

Additional symbols in the menu tab offer the following functions to adjust the view in the left
window area.

Names, columns: none/short/full -the document names in the column headers will be hidden,
shortened, or displayed in full.

Display codings as squares/circles/numbers – existing coded segments will be symbolized as
squares, circles, or with their frequency.

The following options in the menu tab allow you to adjust the view of the coded segments in the
right window area:

 Standardize font – with this setting, you can standardize the text font, size, and line spacing to
create a consistent display of your text segments. Font styles such as bold and italics are not
affected by this setting.

 Display origin -displays each coded segment’s position in the document and the weight
assigned to it. The source data are interactive: click on the entry and MAXQDA loads the
corresponding document into the “Document Browser” and highlights the segment.

 Display comments -hows the corresponding comment in the middle column "Coded Segments"
below the coded segments (if you have written one for the segment).

 Display memos -displays the titles of all in document memos that are in the range of the
segment. Click on the memo title to open the corresponding memo.

With the two icons on the right side of the menu tab you have direct access to the Summary Tables
and the Summary Explorer:

Summary Tables –opens the “Summary Tables” window where you can tabulate, analyze, and
present your summaries.

Summary Explorer –starts the “Summary Explorer” window where you can compare summaries on a
case or group basis.

https://www.maxqda.com/help-mx24/summary-grid/summary-tables
https://www.maxqda.com/help-mx24/summary-grid/summary-explorer


  426

Summary Tables (Compile and Present
Summaries)
A Summary Table is an overview table of summaries and document variables for selected
documents and codes. It serves as a compilation of the summaries for selected topics. Summary
Tables are a useful tool for case-based and cross-case analyses, as well for presentations and
publications.

Summary Table

To create Summary Tables and to view already created iones, click the Summary Tables tab in either

the Analysis menu tab of the main MAXQDA window or
the Start menu tab of the Summary Grid window.

This will open the Summary Tables window:
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Create a new Summary Table

To create your first Summary Table, click the button in the middle of the window. If you already have
created a Summary Table, you can click the New Summary Table button in the toolbar. A dialog
window will appear:

Choose documents, codes, or variables to create a new summary table

Using the tab “Choose documents and codes”, you must decide whether to include all
documents or only activated documents. Usually, before creating a new table, you will
activate the documents for which you have written summaries.
On the same tab, you must codes to be included in the Summary Table. Usually, you will only
select codes for which you have written summaries.
Using the tab “Choose variables”, you can optionally choose which document variables
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should be output as supplementary information. All variables that are placed in the “Variables
for first column” pane will appear in the first column with the document name. All variables
that are placed in the “Variables in own column” pane will appear in additional columns next
to the codes.

By clicking OK, the table with the selected documents, codes, and variables will be created:

Summary Table

The selected documents form the rows of the Summary Table and the selected codes form the
columns. In the code columns, the summaries for the selected codes are listed for each document.
The first column indicates the respective document by presenting its document group and
document name.

If you have selected document variables for the first column, their variable values are displayed
underneath each document name. If you have selected variables to be displayed in own columns,
additional columns will be added to the table using the variable name as the column header. You
can click on such a column head to easily sort the table by the variable values.

Additionally to sorting the table by clicking on a column header, you can use the following functions
to adjust the view of the table:

You can change the order of columns by clicking and dragging with the mouse.
You can hide or display columns (right-click on the column header and choose Select
columns).
You can order columns alphabetically by clicking on a column header.

The table is in plain text format, so the entire table is formatted with the same font.

Please note: You can edit any cell of the Summary Table, which means you can modify the
summaries displayed. Changing the content of a summary in the Summary Table will change the
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corresponding summary in the Summary Grid (and vice versa). Variable values cannot be changed in
the Summary Table.

Retrieving the Coded Segments Associated with a Summary

Each cell of the Summary Table is connected to the summarized coded segments. These can be
retrieved as a list by right-clicking in the cell of the Summary Table and choosing Display
Summarized Coded Segments.

Interactive cells in the Summary Table

Display coded segments instead of summaries

You can display the underlying summarized coded segments for a code instead of the self-written
summaries, for example, because the coded segments are very short and they should be integrated
in the table directly. To do this, right-click on the column header and select the Display Coded
Segments option. Please note that it is not necessary that you have written summaries for a code to
use this option. That is, when creating the table, you can also select codes for which no summaries
exist and then switch the corresponding column in the Summary table to show the coded segment
instead of empty cells.

You can switch back to view the summaries at any time by clicking the column header again and this
time selecting Display Summaries.

The next time you open the MAXQDA project, the summaries (not the coded segments) will be
displayed for all code columns.

Highlight documents according to their color

If you select the Highlight Rows in Document Color option in the Start menu tab, the rows will be
highlighted according to the assigned document color. This function is very useful for grouping
cases, for example, in the context of creating typologies: you read the content of each row, compare
it with the other rows, and give the row a corresponding color to assign it to a newly formed or
existing group. The colored background then makes it easy to recognize cases that belong together.
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In the simplest case, two colors are used, for example, red for ‘negative’ or ‘low’ and green for
‘positive’ or ‘high’.

To change the color of a document, that is, the background color of a row, right-click in the first
column on the respective document icon:

Changing the color of a document in the Summary Table

If you change the color of a document in a Summary Table, the document color in the "Document
System" will also be changed – and vice versa.

Please note: Blue is the default color of documents and if this is selected for a document, no blue
circle will appear on the document icon.

Saving the Summaries in a Column as a New Document Variable

Let’s say one column of your Summary Table contains short and similar summaries for a topic in an
interview study. This analytic work can be used as a document variable in MAXQDA, for example, to
activate interviewees for whom you have written the same summary: right-click on the column
heading and choose Transform into Document Variable. MAXQDA will create a new document
variable that contains the summaries as values and that will be named as the column. If the variable
already exists, MAXQDA will add a number to the name. Please note that the values will be
shortened to 63 characters. The column in the Summary Table remains.

Adding an Empty Column for Additional Summaries

Let’s assume when working with an existing Summary Table you would like to add a new column in
which you would like to write integrative summaries (as described, for example, in Kuckartz &
Rädiker, 2019, pp. 147). For this purpose, it is necessary to add another code to the "Code System",
which will then serve as a "container" for the integrating summaries. Click on New Code in the Start
menu tab to create a new code and add it directly to the currently displayed summary table as a new
column for additional summaries.

Swap Rows and Columns of a Summary Table

You can use the icon Swap Rows and Column in the menu tab of the Summary Table to rotate the
view by 90°, which means you swap the rows and the columns for display. The documents will be
displayed in the columns then and the codes (and the variables with their own column) in the rows.

https://link.springer.com/book/10.1007/978-3-030-15671-8
https://link.springer.com/book/10.1007/978-3-030-15671-8
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Open a Summary Table

To open an existing Summary Table, click on My Summary Tables on the menu tab and select a
table.

Opening a Summary Table

Please note: The Summary Table is dynamically linked to the project data. As soon as you open a
Summary Table, MAXQDA scans your project for deleted documents, codes, or variables, and they
are removed from the Summary Table if necessary. Furthermore, variable values that have been
changed in the Data Editor for Document Variables will be updated.

Rename a Summary Table

To rename the displayed Summary Table, click on the name displayed above the table on the left:

Renaming a Summary Table

Delete a Summary Table

To delete the displayed summary table, click Delete Summary in the menu tab. This operation
cannot be undone. Deleting a table does not affect its contents, that is, the summaries and variable
values are still present in the project and the table can be recreated if required.

Store Summary Table in a QTT Worksheet

To delete the displayed summary table, click Delete Summary in the menu tab. This operation
cannot be undone. Deleting a table does not affect its contents, that is, the summaries and variable
values are still present in the project and the table can be recreated if required.
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Insert Summary Table as a Table Document in the “Document System”

The displayed Summary Table can be stored as a table document so that you can then analyze its
contents with all the available MAXQDA functions. To do this, click on Export in the menu tab at the
top right and select the option Insert Summary Table as Table Document into Document System.

Export Summary Table

The displayed summary table can be exported as a Word document or Excel table. To do this, click
on Export in the menu tab at the top right and then select the corresponding entry.

Summary Explorer (Compare Summaries
for Cases or Groups)
The Summary Explorer allows you to compare the summaries of different cases or groups in a table.
The Explorer’s columns are formed by documents, document groups, or document sets, each
column containing the respective summaries of the currently selected code (theme).

The Summary Explorer

The Summary Explorer can be used to answer questions such as “What are the differences between
Indiana and New York students in terms of career aspirations and concerns? The Summary Explorer
shown above compares summaries (written by researchers) of the statements made by students in
Indiana with summaries of the statements made by students in New York. The Indiana group
consists of 3 documents, and for each of these 3 documents a summary was written for the code
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“Career”. All 3 summaries are displayed in the corresponding column.

Opening the Summary Explorer

To start the Summary Explorer:

Select Analysis > Summary Explorer in the MAXQDA main menu.1.
A dialog window will appear into which you can drag and drop documents, document groups,2.
or document sets from the “Document System” and codes from the “Code System”. Each row
in the upper area of the dialog window will later form its own column in the Summary
Explorer.

Dialog window for selecting columns
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Click OK, and MAXQDA will open the Summary Explorer.

The Summary Explorer columns always display the summaries associated with the code selected on
the left.

Functions in the Toolbar

In the Summary Explorer, the following functions are available in the toolbar at the top left of the
window:

 Display codes with hierarchy – If this option is activated, the codes are displayed in a
hierarchical tree structure. The non-activated parent codes may be displayed to retain the
hierarchical structure. When the option is deactivated, the codes are displayed in a linear list.

 Display origin – Displays the source documents, locations within these documents, and the
code weights in brackets below the coded segments. Clicking on the displayed source document
shows the corresponding document in the “Document Browser” and highlights the coded segment.

x of y columns – Allows you to specify how many columns should be displayed next to each other in
the window at the same time.

 Refresh – Reopens the options window for the Summary Explorer, which lets you customize the
columns and included documents and codes.

Exporting the Summary Explorer

The contents of Summary Explorer can be exported using the usual icons at the top right of the
window. All the codes selected in the Explorer's dialog window are taken into account for the export.

Code and Document Summaries
Often there is a need to integrate the summaries of a topic or a case into a single text; a need to
write a summary of the summaries, so to speak. You can think of it as consolidating the summaries
of the Summary Table line by line or column by column:
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Schematic explanation of Code and Document summaries

A case-based Document Summary is created for the rows, and a theme-based Code Summary is
created for the summary columns.

What are Code and Document Summaries for?

In Code Summaries, the analytical results with regard to a code’s segments are recorded. For
example, in a study with 15 interviews, all text passages in which interviewees provide information
about their personal environmental behavior were coded with the code “environmental behavior.” For
the analysis of the coded segments, a summary of the text passages was written in the Summary
Grid for each person. In a Summary Table, these case-based summaries were compiled for all or
selected respondents in one column of the table. The purpose of a Code Summary is to write an
overarching summary for this code: What environmental behaviors do our interviewees report? What
do they do? What do they find difficult? What do they reject? Do we find differences in behavior
between, say, younger and older interviewees, those with children or those without?

Document Summaries are similar to Code Summaries in their function, but here a summary is
written for each person, therefore one can also speak of Case Summaries. Again, the basis is a
Summary Table, in which the case-related summaries of several codes are displayed. Thus, I see for
a particular interviewee, for example, what environmental behavior he or she shows in everyday life,
how he or she feels about the climate crisis, what problems he or she currently considers to be the
biggest world problems, and whether he or she believes that influence is possible.

In MAXQDA, the Document Summary is stored in the document memo of the case and the Code
Summary is stored in the code memo of a code.

How to Write a Code Summary in MAXQDA

Ensure that the option to swap columns and rows in Summary Table is switched off, so that1.
the documents are displayed in the rows as shown in the previous schematic figure.
Double-click on the memo symbol in the header of the code column for which you want to2.
write a summary.
The code memo (this is the memo that appears next to the code name in the “Code System”3.
window) associated with the code will open. If no code memo exists yet, it will be created.
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Expand the “Code Summary” area in the memo window, if it is collapsed, and write your4.
summary in the text field. You can format the text using the symbols at the top.

Writing Code Summaries in the code memo

The Code Summary is always available in the “Document System” window, so you don’t need to
open a Summary Table to access it: double-clicking the memo icon next to the code name opens the
memo window, where you can view, edit, and export the Code Summary.

Double click on memo icon in the “Code System” window opens the memo with the Code Summary

How to Write a Document Summary in MAXQDA

In the Summary Table window, activate the option Swap Rows and Columns in the menu bar.1.
Double-click on the memo icon in the header of the document for which you want to write a2.
summary.
The document memo associated with the document will open (the memo that appears next3.
to the document name in the “Document System” window). If no document memo exists yet,
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it will be created.
Expand the “Document Summary” area in the memo window, if it is collapsed, and write your4.
summary in the text field. You can format the text using the icons at the top.

Overview of Summaries
The “Overview of Summaries” allows quick access to the summaries of selected documents. You
can request it from the context menu at all levels of the “Document System” window: Right-click on a
document, document group, document set, or the root labelled “Documents” and select Summaries.
A listing in table form will appear which contains all existing summaries of the documents in
question, displayed in the upper pane. As usual, the context of the listing is displayed in the upper
left corner (“All” in the following figure).

Overview of Summaries

The “Document name” and “Code” columns contain information on the “node” from which the
summary is derived, the “Preview” column contains a preview of the summary, and the “Position”
column lists all the positions from which the underlying coded segments originate.

In the Reports tab, you can open an “Overview of Summaries” containing all the summaries of your
open project.
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18 – Comparing Cases & Groups
MAXQDA allows you to compare different groups on a qualitative and quantitative basis. In the case
of qualitative analysis, coded contents and, where appropriate, supplementary comments are
compared. In the case of quantitative analysis, variant code frequencies are compared. The groups
are formed by document groups, document sets or individual documents.
You can use this feature for many forms of comparison, because the functionality is so flexible that
it allows for not only group comparisons, but also comparisons of individual cases, and combined
comparisons of groups with individual cases.

Qualitative Comparison (Coded
Segments)
The comparative analysis of cases and groups is one of the most important techniques of
qualitative research. In MAXQDA there are numerous possibilities to compare the data, for example
to display only the statements of certain groups of persons in the "Retrieved Segments" window or
to compare visualizations, such as Document Portraits, for different cases.

The MAXQDA function Compare Cases & Groups allows you to easily compare coded data
(qualitative data) and code frequencies (qualitative data transformed into quantitative data) for
cases and groups. From the “Document System”, you can include documents and focus group
speaker as cases and document groups as well as document sets as groups in the comparison.

Perform a qualitative comparison

A comparison of coded segments can be performed as follows:

Select the function Analysis > Compare Cases & Groups > Qualitative. An options dialog1.
window will appear with two sections:

https://www.maxqda.com/help-mx24/visual-tools/document-portrait-visualizing-a-document
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Case comparison parameter selection dialog

Drag at least two document groups, document sets, individual documents, or focus group2.
speaker from the "Document System" window into the upper "Cases/Groups" area with the
mouse button pressed down. You can combine document groups, document sets, and
documents. Entries can be deleted at any time by clicking on the X at the end of a line.
Drag several codes from the "Code System" into the lower "Codes" area by holding down the3.
mouse button. Click on the Insert activated codes button to add all activated and not yet
selected codes below. You can adjust the sequence of the codes later by holding down the
mouse button.

After clicking OK, MAXQDA creates a segment matrix: The selected groups form the columns and
the selected codes the rows of the matrix. The cells contain the coded segments so that the coded
contents for the selected groups can be compared with each other.
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A case comparison segment matrix output example

The functionality of the Segment Matrix is described in detail here.

Quantitative Comparison (Code
Frequencies)
The comparative analysis of cases and groups is one of the most important techniques of
qualitative research. In MAXQDA there are numerous possibilities to compare the data material, for
example to display only the statements of certain groups of persons in the "Retrieved Segments"
window or to compare visualizations, such as Document Portraits, for different cases.

The MAXQDA function Compare Cases & Groups allows you to easily compare coded data
(qualitative data) and code frequencies (qualitative data transformed into quantitative data) for
cases and groups. From the “Document System”, you can include documents or focus group
speakers as cases and document groups as well as document sets as groups in the comparison.

Perform quantitative comparison

A group comparison for code frequencies is performed as follows:

Open the function Analysis > Compare Cases & Groups > Quantitative. An options dialog1.
window will appear with two sections:

https://www.maxqda.com/help-mx24/mixed-methods-functions/interactive-quote-matrix
https://www.maxqda.com/help-mx24/visual-tools/document-portrait-visualizing-a-document
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Case comparison parameter selection dialog

Drag at least two document groups, document sets, individual documents or focus group2.
speakers from the "Document System" window into the upper "Cases/Groups" area. You can
combine document groups, document sets, documents, and focus group speakers. Entries
can be deleted at any time by clicking on the X at the end of a line.
Drag several codes from the "Codes" into the bottom "Codes" area. Click on the Insert3.
activated codes button to add all activated and not yet selected codes below. You can adjust
the sequence of the codes later by holding down the mouse button.

Click on OK and MAXQDA creates a crosstab. The selected cases and groups form the columns and
the selected codes the rows of the crosstab:

https://www.maxqda.com/help-mx24/mixed-methods-functions/crosstab
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A case comparison crosstab output example

 



  443

19 – Variables

Document and Code Variables in
MAXQDA
In MAXQDA you can store information in variables both for documents and at code level. For the
speakers of a group interview there are additional speaker variables which are explained in detail in
the chapter analysis of focus groups.

Document variables

Document variables are associated with an entire document (e.g. the person interviewed in an
interview transcript). In these cases, you can assign socio-demographic information like gender, age,
education level, etc. that can then be analyzed in conjunction with the actual text.

In the following example, the age, educational level, and state of the respondents was noted, in
addition to whether they were single or in a partnership:

Example of application of Document Variables

Code variables

Code variables in MAXQDA make it possible for you to apply variable values to coded segments and
use them as selection criteria during the analysis process. In this way, you can, for example, activate
codes by defined criteria.

Managing variables

Two views are available in MAXQDA for handling variables: the variable list and the data editor. In
the variable list, all variables defined in the project are listed in tabular form. The data editor displays

https://www.maxqda.com/help-mx24/focus-group-analysis/can-maxqda-support-focus-group-analysis
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the data table as a rectangular matrix “rows times columns” in a similar way to statistics programs.
The columns contain the variables, the rows contain the documents for the document variables and
the rows contain the codes for the code variables.

The List of Document Variables

The List of Document Variables can be opened via Variables > List of Document Variables.

When you open the List of Document Variables in a newly created project, the system variables
displayed in the image are already defined:

Document group – contains the name of the document group that a particular document is a
part of
Document name – contains the name of the document
Created by – contains the name of the user who was logged in when the document was
imported or created
Created – contains the date the document was imported or created
Modified by – contains the name of the user who last edited the document or applied codes,
added memos or links to it
Modified – contains the date, when the document was last edited or codes, memos, or links
were added to it
Coded segments – contains the number of coded segments in the document
Memos – contains the number of memos in the document
PDF Pages – contains the number of pages in PDF documents
Paragraphs – contains the number of paragraphs in text and table documents
Sentences/Words/Characters – contains the number of sentences/words/characters in text
and table documents and in PDF documents

System Variables in the “List of document variables”

The system variables are indicated with a red symbol in the first column of the list of variables.
System-defined variables cannot be modified or deleted. User-defined variables are indicated with a
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blue symbol in the first column - these variables can be modified or deleted as desired.

Please note: The values for characters, words, sentences, and paragraphs may differ slightly from
those obtained through MAXDictio analysis and Microsoft Word counting. Decimal numbers (1.23)
count as two words.

The List of Code Variables

The List of Code Variables can be opened via Variables > List of Code Variables.

When you open the List of Code Variables in a newly created project, the following system variables
are displayed, as they can also be found in the “Overview of Codes”:

Parent code – Names of superior codes at the next higher level (if applicable)
Code – Code name
Cod. seg. (all documents) – Number of segments coded with this code
Cod. seg. (active. documents) – Number of segments coded with this code in current
activated documents (code needs to be activated)
% Cod. seg. (all documents) – relative frequency of "Coded segments (all documents)"
% Cod. seg. (active. documents) – relative frequency of "Coded segments (activated
documents)"
Created by – User who created the code
Created – Date and time at which the code was created
Code alias – Alias name of the code if defined (up to 255 characters)
Modified by – User name of person who last edited or used the code
Modified – Date of last editing or usage of the code
Documents – Number of documents in which the code appears

System variables in the List of Code Variables
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Sorting the List of Variables

The list of variables can be sorted in alphabetical or reverse alphabetical order just like any other
table in MAXQDA. Simply click once or twice on the column header you would like to sort by.

Tip: To restore the original sorting, right-click on a column header and choose Reset Sorting..

Toolbar

Both the List of Document Variables and the List of Code Variables can be managed from the
toolbar, which contains similar symbols for both lists.

Import data – allows import of a data table in Excel format (XLS/X).

New variable – creates a new variable.

Delete selected items – deletes selected variables.

Convert to boolean variable – converts selected variables into dichotomous boolean variables
(works only for codes that have been transformed into document variables).

Convert to text variable – converts selected variables into text variables.

Document / Code Variable Statistics – generates a frequency table or chart for the indicated
variable.

Create and Edit Variables
You can add new variables to both the List of Document Variables and List of Code Variables::

Select List of Document Variables or Code Variables from the Variables tab.
Click on the New variable  icon in the toolbar.



  447

Creating a new variable with the icon in the toolbar

The following window will appear:

Defining a new variable

You can now insert a name for the variable and choose its type. The name can contain up to 63
characters including There are five different types of variables to be chosen from:

Text
Integer
Decimal
Date/time
Boolean (true/false)

When creating an integer or an decimal variable, you also have the option of defining whether it is a
metric or a categorical variable. The variable for age, for example, can be handled in various ways: if
you want to enter the age in years, you are dealing with a metric variable, for which you may want to
establish a mean. If you have defined ages into categories (e.g. 1 = under 18, 2 = 18-30, 3 = 31-50, 4
= 51+), then you are dealing with a categorical variable, for which you would not want to find a mean
value.
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You can also select what value should be inserted automatically for those cases where there is a
missing value. This is especially important if you are planning to do a statistical analysis later.

Note: Document variables are created for the entire project, which means you cannot create
different variables for each document group.

For better readability of variable values in MAXQDA, it can often be more convenient to use text
variables instead of number variables. In a table column with the variable "familial status", the
variable "married" will be more readable than a numeric code (like "2").

The number of variables is not limited in principle, that is, variables can be removed from the list or
added to the list at any time. By clicking on the New variable button, you can mae new definitions. In
the event that you want to define a large number of variables and, if necessary, the values for the
cases already exist in a table-like structure or even as an SPSS record, you can save time by
importing the file.

Rename and Delete Variables

Variables can be given a new name at any time. Double-click on the variable, and enter the new
name.

Renaming a variable is possible at any time and does not affect the variable’s stored values.

To delete a variable, click on its row with the mouse to select it. Then click the Delete variable 
button in the toolbar. When you delete a variable, the whole column including all its values will be
removed from the Data Editor.

Change Variable Type

MAXQDA allows for changes in variable types for existing variables:

Document variables, which display how often a code exists (their source is acknowledged as
“code”) can be transformed into a binary variable by clicking on the  Convert to boolean
variable symbol in the toolbar. After it is transformed, the variable will not show how often a
code has been assigned in the document but if it has been assigned in this document or not.
User defined variables Integer, Decimal, Date/Time and Boolean can be transformed into text
variables by clicking the symbol in the toolbar.

The Data Editor
When working with variables, two views are available in MAXQDA: the variables view and the data
view in the Data Editor. The Data Editor is similar to statistics programs in that the data is displayed
as a rectangular matrix with a “rows x columns” structure. The variables are displayed in the
columns; while the rows display the document variables for documents or the code variables for
codes. For document variables the table will contain as many rows as there are documents in the
“Document System”; for example, in an interview study, the number of rows will correspond to the
number of interviewees. For the code variables, the codes represent the cases.

https://www.maxqda.com/help-mx24/variables/importing-data-excel-spss
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Opening the Data Editor for Document Variables

The Data Editor for Document Variables can be opened in three ways:

via Variables > Data Editor for Document Variables,
from the List of Document Variables by clicking on the  Data Editor icon
in the “Document System” window, by selecting Variables in the context menu. When called
up at the top level, the table contains all the documents; at the document group level, the data
table contains only corresponding documents, and at the document level, only data.

A table will appear, in which the selected documents and their corresponding variable values are
listed. System variables can be recognized by the black column heading; this cannot be modified in
the table. User-defined variables are indicated with a blue heading; their values can be adjusted by
double-clicking the appropriate cell.

Data Editor for Document Variables

In the Data Editor for Document Variables it is possible to access a document by right-clicking the
appropriate row. A context menu will appear which lists the same options for opening the document
as in the "Document System".

Opening the Data Editor for Code Variables

The Data Editor for Code Variables can be opened in three ways:

via Variables > Data Editor for Code Variables,
from the List of Code Variables by clicking on the Data Editor button, or,
in the “Code System” window, by selecting Variables in the context menu of a code. If you
click on a code, which does not contain subcodes, only the variable values for this code will
be listed in the table. If the code contains subcodes, the variables of the subcodes will also be
listed.

A table will appear which lists the selected codes and their corresponding variable values.
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An extensive context menu, the same as in the “Code System”, is also available for individual codes.

Entering variable values in the Data Editor

To insert variable values into the Data Editor:

Double-click on the cell of the table where you would like to insert a value. Use the Enter key to jump
to the next line to enter the variable values for your variables. Use the Tab key to jump to the next
column to enter the values case by case.

The values that have already been given to any of the cases in the column are in the drop-down list,
sorted alphabetically. You can view this list and select a value from it by clicking on the triangle to
the right of the cell you double-clicked on.

Options for the variable value in the Quick List

If the value isn’t available in the drop-down list, you can simply type in the value after double-clicking
in the cell.

Tip: Drop-down lists are less useful when a variable has many different values (e.g. the exact income
of every interviewee). Even if the value was in the drop-down list, it would be faster to type it in than
to search for it. You can stop the program from displaying a column’s drop-down list by right-clicking
on the column header and selecting (to uncheck) List of values.

Managing tables

If you have created a large number of variables, it quickly becomes difficult to see the entire table at
one time. You can view more columns at one time by making the columns thinner (click and drag the
separator between column headers), but eventually even this does not suffice.

Of course there is the possibility to scroll through the table to the right and it is also possible to
change the order of the variables in the table by grabbing a variable column with the left mouse
button pressed and moving it to any other place in the table. However, it is simpler to click the Select
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Columns icon in the toolbar. There are a number of possibilities to influence the display in the
variable table.

Variable selection of columns to be viewed

Besides (un)checking the boxes one by one, you also have the following options:

select all fields
deselect all fields
only system fields (those automatically created by MAXQDA)
hide or show variables by checking or un-checking the box in front of the variable name

Statistical analysis of a variable

You can start a statistical analysis of the variable values of a column at any time. Right-click on the
column header and choose Document Variable Statistics or Code Variable Statistics.

MAXQDA then creates a frequency table for the selected variable, which can also be displayed as a
chart. Further information on the handling and design of frequency tables and charts can be found
here.

https://www.maxqda.com/help-mx24/statistics-and-graphics-functions/frequency-tables-and-diagrams-for-variables
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Frequency table for a document variable

Importing Data from Excel and SPSS
There are several situations in which you might want to import document variables into MAXQDA,
such as:

If a standardized questionnaire was used to augment interviews.
If you did statistical analysis on data that you exported from MAXQDA and now want to
reimport the results of your statistical analysis into MAXQDA. You could, for example, have
done a cluster analysis for 40 interviews and now want to import the cluster assignments
from each individual interview.

Importing document variables from Excel

MAXQDA can import data from XLS/X files. The data must be organized as follows:

Document group Document name Variable 1 ... Variable N

Group 1 Text 1 Variable value for
Text 1

 Variable value for
Text 1

Group 1 Picture 1 Variable value for
Picture 1

 Variable value for
Picture 1

The first two column headers serve as markers for assigning variable values to the documents and
are required for successful import. Every row must have an entry for the document group and
document name columns. Only if these exact group and document names are found in the
“Document System” of the MAXQDA project, will the variables and variable values be imported. You
can then include as many different variable columns as you wish.

Please note: The variable values for documents that do not belong to a document group can also be
imported. In order to do so, the appropriate cell in the “Document Group” column must be left empty.

After preparing and saving the document, you can start the import procedure by going to Variables >
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Import Document Variables. Alternatively, you can click on the Import data (document variables) 
symbol in the List of Document Variables.

A dialog field appears in which you can specify the source and target variables along with the type of
variables to be imported.

MAXQDA does the following during the import:

All variables in the import file that did not yet exist in the MAXQDA project are created.
Variables that already existed will be updated with the new values in the import file.
Empty values (“system missings”) for variable types integer and decimal will be imported as
-999.

Tip: An easy way to set up an Excel file for importing new values is to first export the variable data
matrix as an Excel file by clicking on the Excel icon in the toolbar of the variable list. An Excel file
with all of the current variables will open up, and you can then add new columns for new variables
and update variable values that you want changed. All you have to do after that is save the Excel file
and import it into MAXQDA.

Importing document variables from SPSS

You can also import a data matrix for the document variables from a SPSS data file (extension SAV).
For the import, MAXQDA needs to match the cases of the SPSS data file with the document names
in the opened MAXQDA project. Therefore it is necessary, that the data file contains a variable (a
column) for the document group as well as a variable for the document name.

Start the import procedure via Variables > Import Document Variables. Alternatively, you can1.
click on the Import data (document variables)  symbol in the List of Document Variables.
Then choose a SPSS data file in the appearing file dialog.2.
A new dialog will appear, that allows you to set several options:3.

Options for importing a SPSS data file

In the upper part you can select which variables (= columns) contain the information about the
document group and the document name to match the cases with the appropriate document name.
MAXQDA will choose the first two columns of the SPSS data file if the data file doesn’t contain
variables with the names “DocGroup” and “DocName.” You will find the variable labels in brackets
behind the variable names for better navigation in the list of variables.

Furthermore, you can switch on two additional options:

Import variable label instead of variable name – If you choose this option, MAXQDA won’t import
the variable names, but their labels, which are usually longer and easier to read and to understand.
You should use this option, if you want to import a SPSS data file that has been created by exporting
the document variables from MAXQDA. Then it will be easy to update a variable which values have
been changed in SPSS. Please note that the length of variable names in MAXQDA is limited to 63
characters, so a longer label may be truncated.

Import value labels instead of values – usually, standardized answers will be represented in SPSS
by numbers, e.g. a 1 may be used for “female” and a 2 for “male”. If you see these numbers only in
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MAXQDA without knowing what a “1” and “2” means, it won’t be very useful, so this option should
only be deactivated if you are sure you want to import the values instead.

A dialog field appears in which you can specify the source and target variables along with the type of
variables to be imported.

MAXQDA does the following during the import:

All variables in the import file that did not yet exist in the MAXQDA project are created.
Variables that already existed will be updated with the new values in the import file.
If you have defined missing values in SPSS only the first missing value (defined in section
“Discrete missing values” in the SPSS dialog) will be imported (only for variable types integer
and floating).
System variables of MAXQDA won’t be changed.
If the import file contains identical document names in the same document group, the last
case will overwrite the previous ones.
Empty values (“system missings”) for variable types integer and decimal will be imported as
-999.

Importing code variables from Excel

MAXQDA can import data from XLS/X files. The data must be organized as follows:

Code Variable 1 ... Variable N

Parent code 1Code 1 Variable value for code 1  Variable value for code 1

Parent code 1Code 2 Variable value for code 2  Variable value for subcode 2

The first column heading is the unambiguous assignment of variable values to a code, so this
column and its heading are mandatory. Each line must designate a code in the corresponding
column. For subcodes, the entire path must be specified in the code system, in which the codes are
separated by a backslash “”.

Tip: To insert a backslash “” on macOS, use the keyboard command ⌥+⇧+7.

Only when a code, which matches this information exactly, is found in the “Code System” will the
variable be imported. You can add as many variables as required in the subsequent columns.

After preparing and saving the import data, you can then start the import procedure by going to
Variables > Import Code Variables. Alternatively, you can click on the  Import data (code
variables) button in the List of Code Variables.

A dialog field appears in which you can specify the source and target variables along with the type of
variables to be imported.

MAXQDA does the following during the import:

All variables in the import file that did not yet exist in the MAXQDA project are created.
Variables that already existed will be updated with the new values in the import file.
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Tip: An easy way to set up an Excel file for importing new values is to first export the variable data
matrix as an Excel file by clicking on the Excel icon in the toolbar of the variable list. An Excel file
with all of the current variables will open up, and you can then add new columns for new variables
and update variable values that you want changed. All you have to do after that is save the Excel file
and import it into MAXQDA.

Exporting Data to Excel and SPSS
MAXQDA provides basic functions for the statistical analysis of variables and makes it possible to
create frequency tables and diagrams for individual variable values. For further analysis, such as
cluster or factor analysis, it is necessary to export the data table of document or code variables in
order to perform the statistical analysis in the appropriate program.

To export the variables:

Click on the  Export button in the toolbar of the Data Editor or select Variables > Export1.
Document Variables or Export Code Variables.
Give the exported file a name. You can also select exactly where you want to save the file.2.
The following formats are suitable as file format for further processing in statistics programs:3.

Excel (XLS/X)
SPSS Data File (SAV), which is only available for the document variables and works
fine in most statistics programs,
SPSS Syntax File (SPS), which is only available for the document variables,
Text (TXT, tab delimited)
Rich Text Format (RTF)
Website (HTML).

Select OK.4.

Exported data matrix in Excel

Tip: The data matrix can also be transferred via the clipboard. You can either select the entire matrix
using the keyboard shortcut Ctrl+A (Windows) or ⌘+A (macOS), or select individual rows by clicking
on them while holding down the Ctrl (Windows) or ⌘ (macOS) button. Use the keyboard shortcut
Ctrl+C (Windows) or ⌘+C (macOS) to copy the selected data into the clipboard.

Displaying Document Variables for
Documents and Coded Segments
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Displaying Document Variables as Background Information for
Documents

Often there is a desire to quickly find background information to a document in the “Document
System”, such as the age or the level of education of an interviewee. For this purpose, you can select
document variables whose respective values are displayed as quick info at the mouse pointer in the
“Document System”:

Open the local settings in the “Document System” window by clicking on the gear icon in the1.
toolbar of the window.

Local settings in the “Document System”

Then check the Display favorite variables in the tooltip option and click the Select variables.2.
The following selection window appears:
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Window for choosing document variables as favorite variables

If you now hold the mouse pointer on a document in the “Document System”, the values of the
selected variables appear in the quick info text. The following figure shows that the interviewee
“Riley” is 19 years old.
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Quick info display of variable value in a document

Displaying Document Variables as Background Information for Coded
Segments

Some background information about the case can also be very helpful for coded segments, since
these are often viewed separately from their document. Therefore, you can also display variable
values in the “Retrieved Segments” window and in the tabular “Overview of Coded Segments”.

As it is rarely helpful for the analysis to see all variable values of a document, it is first necessary to
select some document variables:

Open Variables > List of Document Variables.1.
Activate the check mark in the Favorite variable column with a mouse click to select the2.
document variable for display.

Select document variable as favorite variable
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Display in the "Retrieved Segments".

After you have marked document variables as favorites, you can output these selected variable
details in the "Retrieved Segments". To do this, make sure that the Display favorite variables option
is selected in the window toolbar. The selected variable information then appears directly below
each document name as shown in the following figure (when sorting the segments by document):

Display favorite variable in the “Retrieved Segments” window

Display in the "Overview of Coded Segments"

In the “Overview of Coded Segments”, you can display the favorite variables as separate columns, so
that you can view the variable values of the corresponding document for each segment. To do this,
click on the Display favorite variables icon in the toolbar of the “Overview of Coded Segments”.

Display variable information on export

If you export the coded segments from the “Retrieved Segments” window or the “Overview of Coded
Segments” table, you can also export the associated variable values of the document for each
segment. For more information, see Print and Export Retrieved Segments.

Frequency Tables and Charts for
Variables
MAXQDA lets you create frequency tables and corresponding charts for document variables, code
variables, and focus group speaker variables. You can open this function from the ribbon menu:

Variables > Document Variable Statistics
Variables > Code Variable Statistics
Variables > Speaker Variable Statistics

After you click on one of the variable statistics options a split “Choice of Variables” window is
displayed: Existing variables are listed on the left side; already selected variables are moved to the
right. The arrow buttons in the middle allow you to transfer variables from one window to the other.

https://www.maxqda.com/help-mx24/segment-retrieval/print-export-retrieved-segments
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You can also do this by double-clicking on the variable name.

Selection of variables

Please note: The colored squares in front of the variable names symbolize the origin of each
variable. System variables that are created and managed by MAXQDA are marked in red; variables
created by you have a blue square; codes that have been transformed into variables are marked in
green.

Both lists can be alphabetized by clicking on the column headers. By selecting Only activated
documents you can limit the analysis to currently activated documents, for example the transcripts
of selected interviewees. The corresponding options Only activated codes and Only for activated
focus group speakers are also available for code variables and focus group speakers variables.

Tip: The statistics functions for variables can also be accessed directly with the   icon in the “List
of Document Variables“, the “List of Code Variables“ and the “List of Focus Group Speaker
Variables“. MAXQDA then begins the statistical analysis for the selected variables, taking all
documents, codes, and speakers into account that are currently visible in the Data Editor.

When you click OK MAXQDA will begin the statistical evaluation and display the results as frequency
tables and charts.

The results window displays the results of the first selection of variables in a table. The “Frequency”
column shows how many of the analyzed documents contain the variable value in question.
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Frequency Table

Tip: Click on the column headers of the first two columns in order to modify the order of the table
rows. For example, you can sort the frequency of categories in ascending or descending order.

The first column lists the various categories of the variable; the second column lists the absolute
frequency; and the third lists the corresponding percentages. The fourth column shows percentages
based on valid values, meaning missing values are excluded. If there are no missing values among
the variables in question, the percentages of the third and fourth columns will be identical.

You can sort the rows by clicking on the column header of the first or second column.

Charts

When you switch to the chart view by clicking the chart icon in the toolbar, a bar chart of the
variables in question appears in the place of the table view.
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Vertical bar chart of the document variable “Age”

Please note: The order of chart segments is determined by the order of the rows in the table and can
be modified accordingly.

You can customize the chart regarding colors, fonts, etc. in several ways and you can export it in
different formats or copy it to the clipboard. For more information on customizing the chart, see
section Frequency Tables and Charts for Top-Level Codes and Subcodes.

Missing values in frequency tables and charts

MAXQDA will treat the following as missing variable values:

For numerical and text variables, values set as “Missing values” in the “List of Variables” will
be treated as missing.
For text variables, blank fields will also be treated as missing.

Descriptive statistics

When evaluating numerical variables, the Descriptive statistics symbol appears in the top toolbar.
Clicking on the icon produces an output of the usual parameters such as including mean value and
variance.

https://www.maxqda.com/help-mx24/analyze-coded-segments/frequency-tables-charts-subcodes
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20 – Mixed Methods

About Mixed Methods in MAXQDA
MAXQDA is one of the pioneers in the field of method integration. Functions for combining
qualitative and quantitative data are already found in the very first versions of the program in the late
1980s and early 1990s. With the option to manage a data set of standardized, quantitative data
parallel to the texts, the foundation was laid. Since version 10 there is a further tool in the form of
code variables, which allows the definition of variables below the case level of a document and since
version 12.2 there is a fully integrated statistics package "Stats" for carrying out descriptive and
inferential statistical calculations, the results of which can be used directly for the integrative
analysis of qualitative data.

Most of the mixed methods functions can be found in the Mixed Methods menu tab. On the one
hand, there are functions that link documents and document variables, for example, the topics from
qualitative interviews with the variables of standardized interviews. With these functions, you can
create so-called Joint Displays (Guetterman, Creswell, and Kuckartz, 2015), in which qualitative and
quantitative data and/or results and conclusions are presented and analyzed together. On the other
hand, MAXQDA offers functions that enable the transformation of code frequencies into document
variables in order to subsequently use these for analysis, whether for the selection of qualitative
data or for use in statistical procedures such as similarity analysis.

MAXQDA's mixed-methods functions support all typical basic designs in mixed methods studies
(Creswell and Plano Clark, 2018):

convergent Designs (qual. and quan. study parallel)
explanatory Designs (qual. study after quan.)
exploratory Designs (qual. study before quan.)

Further information about the mixed methods functions in MAXQDA and its methodology can be
found here:

Kuckartz, U., & Rädiker, S. (2021). Using MAXQDA for mixed methods research. In R. B.
Johnson & A. J. Onwuegbuzie (Hrsg.), The Routledge reviewer’s guide to mixed methods
analysis (S. 305–318). Routledge. https://doi.org/10.4324/9780203729434-26
Rädiker, S. & Kuckartz, U. (2019). Analyse qualitativer Daten mit MAXQDA. Text, Audio, Video.
Springer VS – speziell das Kapitel 13: https://doi.org/10.1007/978-3-658-22095-2_13
Guetterman, T. C., Creswell, J. W., & Kuckartz, U. (2015). Using joint displays and MAXQDA
software to represent the results of mixed methods research. In M. T. McCrudden, G. J.
Schraw, & C. W. Buckendahl (Hrsg.), Use of visual displays in research and testing: Coding,
interpreting, and reporting data (S. 145–176). Information Age Publishing.

https://doi.org/10.4324/9780203729434-26
https://doi.org/10.1007/978-3-658-22095-2_13


  464

The “Mixed Methods menu tab

Overview of the Functions in the Mixed Methods Menu Tab

Activate Documents by Variables - Lets you activate documents to be included in further
analysis such as Coding Query or Visual Tools based on document variable values. You could,
for example, use this function to identify what men between the ages of 40 and 50 said about
migration issues.
Interactive Quote Matrix - Creates an interactive table, “codes x groups”, that allows you to
compare coded segments for groups. These groups are formed by documents with selected
variable values. You could, for example, choose to see how those with various levels of
education differ on their approach to combating homelessness.
Crosstab - Works parallel to the Code Matrix Browser, except that this function doesn’t work
on the document level. Instead, you can create groups based on your variable values and
compare how often each of these groups talks about each theme. You could, for example,
compare how often men talk about relationships in your life satisfaction interviews in
comparison to women.
Quantitizing - This is the transformation of qualitative coding information into quantitative
variables. Quantitizing allows you to store the code frequencies as document variables, such
that for each document you have information about how often a code appears in that
document. This information can then be analyzed statistically or used for the selection of
cases.
Typology Table - Shows an overview of variable values for qualitative typologies that you
have created (e.g. for people with various views on combating their own homelessness). You
could see, for example, what the mean age, gender breakdown, and average time already
homeless is for the “apathetic pessimists” in comparison to the “proactive optimists.”
Similarity Analysis for Documents – Selected documents are analyzed on the basis of
existing coded segments and document variables for their similarity, and the results are
presented in a similarity or distance matrix.
Side-by-side Display of Results – This joint display compares the results of a qualitative
study with those of a quantitative study.
QUAL Themes by QUAN Groups – This joint display is used to compile coded segments or
summaries in a table for groups formed on the basis of variable values.
Statistics by QUAL Groups – The result of this function corresponds to the typology table and
divides documents into groups according to codes assigned to them. This joint display allows
you to compare average values, standard deviations, and absolute and relative frequencies of
selected variables for these groups.

In the “Code System” window, there are functions available, that allow you to use the code
frequencies for each document as document variables:

Transform code into document variable or categorical document variable – Codes can be
added as document variables that specify how often the code occurs in the document
("Quantitizing" as described above) or which subcode occurs most frequently in a document.
The latter is particularly useful for evaluative qualitative content analyses.
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Activate Documents by Variables
The selection of documents for the analysis, such as searches for coded segments, can be done
easily by hand: You can activate all the documents of the project, the documents of a particular
document group, or even a single document. But more complex selective coding searches are
difficult to do by hand.

For this reason there are also automatic activation options. With the Activate Documents by Variable
function, you can choose to activate documents based on the variable values that have been
assigned to them. If you have defined variables for gender, age, and education level, for example,
you could choose to select only those documents that represent women over the age of 40 that
have at least a high school education. These activations can be made by entering the appropriate
conditions.

The Activate by Document Variables function always processes the entire project. You can access
the function by

selecting Activate Documents by Variables in the Mixed Methods tab or,
by right-clicking on the first row in the “Document System” and choosing Activate Documents
by Variables from the context menu that appears, or
clicking the icon with the same name in the "Document System"

Accessing the function from the context menu or the icon in the “Document System”

A dialog window will appear where you can enter the logical conditions for activation. The dialog
window is made up of the following sections:

A section for the logical formulas and the buttons to create a new formula, delete the
currently selected formula, or delete all formulas.
Checkboxes for selecting operators.
Icons for opening or saving formulas.
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Dialog field for activation by variable

All logical conditions must have the following components:

variable name / operator / value

If you have created a variable called “Education” and defined the education levels as "low",
"intermediate" and "high", you can use the following formula in order to activate those documents
that are interviews with participants with a rather low educational level:

Education = low

To create such an condition in MAXQDA, proceed as follows:

Double-click on the variable "Education" from the list of variables on the left side of the1.
window. You will see the following text in the condition window:

Education = <empty>

On the right side of the screen you will see a field where you can enter the variable value. Here2.
you could enter “low,” or simply click on the arrow to open the drop-down menu and select a
value from the list of all the values that have been entered for a document up to that point. In
our example above, “low”, “intermediate” and “high” would be in the menu. Using this menu
helps you to avoid any typos.
For numeric variables, MAXQDA inserts the value 0 in each newly inserted condition. For
Boolean variables, you can use "0" for "false" and "1" for "true".
Since the “=” operator is used most often, it is automatically selected when you start a new3.
formula. If you want to use a different logical operator, simply choose it from the right side of
the window and MAXQDA automatically replaces the "=" operator.
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The operators have the following meanings:

= (equal to) Selects variable values that are the same as the selected value.

< (smaller than) Selects variables values that are smaller than the selected value.

≤ (smaller or equal to) Selects variables values that are smaller or eqaul to the selected value.

> (larger than) Selects variable values that are larger than the selected value.

≥ (larger or equal to) Selects variable values that are larger or equal to the selected value.

≠ (unequal) Selects variable values that are not the same as the selected value.

⊃ (contains) This operator is only offered for text variables. Selects variable values that contain the
entered value within their text. The evaluation is not case sensitive.

Tip: It is possible to specify the condition that a non-numerical variable value should be <empty>.
Then all documents to which no variable value was assigned will be selected.

Results of activations by document variables

Once you have entered the correct logical formulas, you can start the automatic activation. Click on
the Activate button.

MAXQDA then checks the variable values assigned to each document whether it matches the
formulated criteria. The documents that matched the criteria are now activated (marked red) in the
“Document System.”

Tip: The status bar at the bottom of the MAXQDA window shows you how many documents have
been activated.

If you want to activate documents frequently based on the same criteria, it is recommended that you
save the activation model as a document set. To do so, select the option New set from the dialog
window. MAXQDA will then create a document set containing the activated documents. This new
document set can be activated at any time in the “Document System,” without having to call up the
function for automatic activation via document variables.

Complex logical conditions

It is also possible to combine various logical conditions. The basic units of these combinations are
still the conditions in their basic form:

variable name / operator / value

Combining formulas just means that you are connecting two or more of these basic formulas with
an operator.

In the above example, we used the condition "Education=low" to activate all documents of
participants with a rather low level of education.

If you want to further limit the results, so that you only see what participants over 40 years with a low
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level of education had to say, you need to define a second condition, namely "Age > 40". In addition,
you need to combine these conditions by a logical AND. The second condition, would be created just
like the first condition:

Double-click on the variable Age from the list of variables. The new condition will look like1.
this:

[Age] = <empty>

Type in "40" for the value and choose the operator >(larger than).2.
MAXQDA automatically inserts the OR operator. To use the AND operator instead, select the3.
appropriate option in the right-hand pane. According to the schema, any number of other
logical combinations can be added. Click the Activate button to begin.

In this way, you can add as many combinations of logical formulas as you want. You can then click
Activate to start the activations.

The combination operators OR and AND have the following ffect on the results of your activation
process: If you choose the OR option, MAXQDA looks for documents that meet at least one of the
various formulas’ criteria. If you entered the formulas “Education = low” OR “Age > 40,” you will get
all the documents of participants with a low level of education as well as participants older than 40
years. For our example, then, the OR option would not be appropriate. We want both formulas to be
met, so we would need to use the AND operator, so that it looks as follows:

A complex logical condition (AND-combination)

Deleting conditions

It is possible to go back and delete a formula at any time:

Click on the row you wish to delete.
Click on the  Delete button.

Changing and saving formulas

After starting the automatic activation process, the dialog window is no longer seen. The formulas,
however, will still be in that window the next time you open it.

You can change the logical formulas (operators and values) at any time:

Click on the Formula in the dialog window and select another operator.
If you want to change the value, simply enter the new value or select it from the drop-down
menu.

After you have changed the formula, click on the Activate button to restart the activation.
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You can also save a formula, so that you can have quick access to it at a later time. Just click on the
Save  symbol at the bottom of the dialog window. You can then give it a name and choose where
you want to save it.

Files for saved logical formulas are saved by MAXQDA as .LOA (logical activation) files. To open a
saved formula, choose Open and navigate to the place you saved the .LOA file. It makes sense to set
up a folder for all of your LOA files, so they are easy to find.

Using code variables for Activation by code variables

It is not only possible to activate documents based on their document variables; you can also
activate codes based on their assigned code variables. The Activate by Code Variable function can
be accessed by right-clicking on the top level entry (Code System) in the "Code System" and
choosing the Activate Codes via Variables option in the context menu.

Crosstab
The Crosstab function has some similarities to the Code Matrix Browser, except that documents are
analyzed grouped by document variable. Social groups, such as men and women, or people with
different personal background, etc. can be compared based on variable values. All of the variables
that are in your project can be used to set up a group.

Crosstab is a visualization of the relationship between document variables and codes.

Crosstab example

Creating a Crosstab

1. Choosing your codes

As usual in MAXQDA, the selection of codes is done via activation. The selection should be
completed before using the Crosstabs function, otherwise all codes will be displayed in the
Crosstab.

Tip: You can open the crosstab function by right-clicking on a code from the context menu. In this
case, only that specific code is shown in the cross table.
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2. Define columns

The definition of the columns is done by defining appropriate variable conditions (formulas) in the
dialog window, which is similar to the Activate Documents by Variables dialog window.

To do this, open the Crosstab function in the Mixed Methods tab.

After activating codes and selecting Crosstab, you will have the option to create logical conditions
that will be used to assign documents to each column. The window is broken up into the following
sections:

A list of all the document variables in the project.
A section for the definition of logical conditions.
Buttons for selecting operators and values.
Buttons for opening and saving logical conditions.

The Crosstab dialog window

All logical conditions in the middle column “Columns” must have the following components:

variable name / operator / value

If you have created a variable called “Region” and used the value “urban” for urban regions and
“rural” for rual regions, we would use the following formula in order to create a crosstab that
compares the code frequencies for the two types of regions:

>[Region] = urban
[Region] = rural
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Tip: If you want to create columns by all values of a variable, follow these steps:

Select the option Insert all variable values as conditions.

Double-click the desired variable in the left pane of the window.

MAXQDA then lists the formulas for all variable values in the middle pane of the window. If you
double-click on the variable Region, MAXQDA will automatically insert two rows, one with “urban”
and one with “rural”, as in the example above.

The Crosstabs created in this way would look as follows:

Crosstabs comparing the number of coded segments for each relationship status

You can also save formulas, so that you can have quick access to them at a later time and don’t
have to reenter them one by one. Just click on the Save button at the bottom of the dialog window.
You can then give it a name and choose where you want to save it.

Files for saved formulas are saved by MAXQDA as .LOA files. To open a saved set of formulas,
choose Open and navigate to the place you saved the .LOA file.

Functions in the toolbar

The Crosstab toolbar at the top of the window offers the following in addition to the usual export
functions:

Interactive Quote Matrix – Displays the coded segments from the table in an interactive window.

Display codes with hierarchy – If the option is activated, the codes are displayed in the tree
structure of the code system. Even if the “Only activated codes” option is selected, non-activated
upper codes are also included to preserve the tree structure (for these, however, all frequencies will
be set to 0, even if coded segments exist; that is, no symbols or numbers will be displayed on the
nodes for these rows). If the option is deactivated, all codes are displayed on one level. If the “Only
activated codes” option is activated, then only the activated codes are displayed.

Number of segments – Displays absolute frequencies, meaning the number of segments of the
selected codes in the documents of the respective column.

Row percentage – The percentage share of the cell calculated across the row (horizontal
percentage calculation).
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Column percentage based on the sum of coded segments (row “SUM”) – The percentage share of
the cell calculated across the column (vertical percentage calculation).

Column percentages based on the number of documents “N (documents)” – The column
percentage in terms of the number of documents in the column (the option Count hits per document
only once will be selected automatically).

Count hits per document only once – The unit of analysis is set to Document. Each document is
analyzed based only on whether the code has been assigned or not; the frequency with which a code
occurs within a document is not taken into account.

Sum – displays the sum of rows and columns.

Highlight highest values – For better interpretation of the results higher values are highlighted in
green (depending on the evaluation function, the color intensity refers to all cells, each row, or each
column).

Refresh – Reopens the dialog window to recreate the table with different settings.

Interactive connection to source data

The cells in the crosstab are interactively linked to the data in your project:

Double-click on a cell to list its segments in the "Retrieved Segments" window. This action
automatically activates both the documents and codes connected with the cell.
Right-click on a cell and choose Activate Documents from the context menu. This activates
the connected documents without changing your current code activation selection.

Crosstab suitability

Crosstabs are well suited for the analysis of sub-categories and their distribution in sub-groups of
the sample. Imagine you have asked how students prepare for examinations, and the different
options (e.g. reading books, working together with colleagues, etc.) are defined as codes. With the
Crosstab function, you can compare various groups with each other. Are female students
participating more in training groups? Do male students read more text? The options to view the
values as row or column percentages make the interpretation of the data even easier.

Segment Matrix
The Segment Matrix can be used to compare the coded segments for different cases and groups in
an interactive workspace. Codes are listed in the rows of the matrix and cases or groups in the
columns. In the following schematic figure, for example, the coded segments for the code "Satisfied
with flexibility" are compared between respondents with and without children:

Code Number of children = 0 Number of children ≥ 1
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Satisfied
with
flexibility

Nah, I think that it is good the way it is right
now. I am very satisfied that this flextime
exists. For example, if there's something on
the agenda which requires it, I could even
spend a day working in the home office. Or,
I don't know, when the letter carrier comes,
whatever. I think it's very good that that if
you have a dentist appointment, for
example, or something that, you can do it
before work and then go there afterwards,
instead of having to take a whole day off or
something like that and not being able to
use it for leisure time at all, but rather
wasting it with private appointments that
are important anyway, but rather health
appointments.
InterviewsRiley : 9 - 9 (50) Mostly satisfied
with flexible hours and home office.

Yeah, right. The best thing, of course, would
be to work even less and have more free
time. Then you would also have less money,
which is of course a back and forth. And in
general, I would say that universities are
usually halfway flexible. For example, if you
have children or are pregnant, it's not really
a problem to take some time off and then
possibly shorten your working hours. But I
am not affected by that yet.
InterviewsRiley : 25 - 25 (50)

Actually it is flexible enough. Which
means that I currently wake up at
around the same time, but it doesn't
have to be the exact time. It can be like
fifteen minutes or half an hour
difference. And then sometimes if I'm
too lazy to cook, I eat out, but the set of
routines stays. So I'm working very hard
to keep the important part of the day
the same, like every morning and go for
a run and then eat breakfast because
that's just me maintaining my health.
And I think it's a good start for the
morning.
InterviewsThanh: 9 - 9 (50)

Very satisfied. The things I do at work
don’t usually happen behind a desk, so
it wouldn’t make sense if I had to check
in and out at a certain time. So I need
to be flexible to be successful.
InterviewsDavid: 9 - 9 (50)  

Follow these steps to open an Segment Matrix:

Activate the documents and codes you wish to include in the matrix. If none are1.
activated, all documents and codes will be included.
Open the function via Mixed Methods > Segment Matrix.2.
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Segment Matrix

Use variable conditions to determine which documents are to be displayed in the1.
columns (a separate column is created for each variable condition). You can find a
detailed introduction to defining columns in the section on Crosstabs.
If necessary, select the options Only for activated documents and/or Only for2.
activated codes.
Click OK – MAXQDA will open a new window with the interactive display:3.

https://www.maxqda.com/help-mx24/mixed-methods-functions/crosstab
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Segment Matrix

The first column displays a list with the codes you selected. MAXQDA automatically adds the parent
codes of the activated codes in order to retain the code system's hierarchical structure.

Tip: If you selected the option Only for activated codes, you can change this later in your “Code
System” to adjust the selection of displayed codes in the Segment Matrix.

The other columns are the results of your selected variable conditions: for each defined condition, a
column is displayed. These columns contain the coded segments of the documents which meet the
respective variable condition. The number of documents per column is indicated in the column
headings.

Click on a code in the code tree to list its coded segments in the columns. The column headers
indicate how many coded segments are displayed in the column.

Tip: The Segment Matrix function can also be opened directly from the Code Matrix Browser or from
a Crosstab. When working with the Code Matrix Browser or a Crosstab, click the first icon on the
very left. The Segment Matrix can also be opened by selecting: Analysis > Compare groups >
Qualitative.
Toolbar

Along the top edge you will see a symbol toolbar with the following functions:

Display codes with hierarchy – if this option is activated, the codes are displayed in a
hierarchical tree structure. The non-activated parent codes may be displayed to retain its
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hierarchical structure. When the option is deactivated, the codes are displayed in a linear list. Should
you have selected the option "Only activated codes" when creating the matrix, only the activated
codes will be displayed.

Display origin – shows the source documents, locations within documents, and the code
weights in brackets below the coded segments. Clicking on the displayed source information loads
the corresponding document into the “Document Browser” and highlights the coded segment.

Display comments for coded segments – displays all the comments on coded segments (if
there are any).

Display memos – displays below the coded segments the titles of memos that are present at
the level of the coded segments. Clicking on the displayed memo title opens that memo.

 Standardize font – with this setting, you can standardize the text font, size, and line spacing to
create a consistent display of your text segments. Font styles such as bold and italics are not
affected by this setting.

 Zoom out – minimizes the display of the segments in the columns.

 Zoom in – magnifies the display of the segments in the columns.

x of y columns – adjusts how many columns (x) of the total columns (y) are visible.

Display search toolbar - allows you to search within the Segment Matrix.

Refresh – reopens the options window for the Quote Matrix, which lets you customize the
columns and included documents and codes.

Interactivity

The displayed segments are interactively connected with their source document, and you can adjust
segments properties right in place:

Click on source information to show segment in its surrounding context in the “Document
Browser”.
Right-click on a segment to write or modify the coding comment, to copy the segment to the
clipboard, to list all linked memos to the segment, or to delete the code assignment.
Click on the weight to modify it.

Exporting the Segment Matrix

The Quote Matrix can be exported using the usual icons at the top right of the window. The
segments of all displayed codes are always exported. If you limited the quote matrix to activated
codes, only these activated codes are exported.

Open as Word document – Creates a Word document and opens it.

Open as Excel table – Creates an Excel spreadsheet and opens it.
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Export – Creates a table as a Word file (DOCX format), an Excel file (XLS/X format), or a web
page (HTML format).

Typology Table
This function offers yet another way to combine quantitative data and your codes or categorical
variables. It is called a Typology Table, because it is able to calculate various variables and their
percentages (means, standard deviations, etc.) for qualitative typologies.

The table is set up similarly to the following example from Creswell and Plano Clark’s textbook
“Designing and Conducting Mixed Methods Research” (2011: 292):

Example of a Typology Table

This table shows a comparison between two types of patients, “Depressed” patients (27 persons)
and “Not Depressed” patients (21 persons). The last column p-Value shows the statistic significance
of the mathematical means. The first row "Age" shows the average age of both groups and the
standard deviation in brackets.

The row “Women” contains the number of women and their percentage. This means that of the 27
depressed persons 21 are women, which is 79% (there is a mistake in the table, correct would be
78%).

As we can see, the rows consist of variables, metric variables to be exact, and specific values of
categorical variables – either text or numerical variables. The columns follow the pattern of
Crosstabs, meaning the values of any categorical variables can be selected.
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Create a Typology Table

To create a Typology Table, proceed as follows:

Select  Typology Table from the Mixed Methods menu tab.1.
For categorical variables, all respective variable values are listed in the dialog window. For2.
non-categorical (metric) variables, the variables themselves are listed. For easy
differentiation, non-categorical variables appear in red. Check the variable values and
variables you would like to include in the Typology Table and to compare between groups.
Select the Exclude missing values option when the missing values of non-categorical3.
variables should be ignored. This will usually be the case.
When you click Continue a second dialog window will appear in which you can define the4.
columns of the Typology table, and where you can specify the elements that should be
compared with one another.
Create a variable condition (formula) for each desired column, for example “Location = Berlin”5.
and “Location = Hamburg”. The quickest way to do so is by double-clicking the variable in the
variable column. When you click OK, MAXQDA will display the Typology table.

Example of a Typology Table

The Typology Table toolbar

At the top of the Typology Table you will find a toolbar that – besides the usual export options –
offers the following functions:

Highlight lowest value per row – for better interpretation of the results the value highest in row is
highlighted in red.

Highlight highest value per row – for better interpretation of the results the value lowest in row is
highlighted in green.

Refresh – updates display via recalling the function.

Interactive connection to source data

The Typology Table is linked to the data in your MAXQDA project interactively:

Double-click on a cell, that shows the number of documents (and no mean value), to activate
these documents in the "Document System".
Double-click on a cell of of the first column, where the cell shows a variable value, to activate
all documents that fit the clicked variable criteria.
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Similarity Analysis for Documents
The Similarity Analysis for Documents can be used to check the similarity or dissimilarity of various
documents in terms of code occurrence and code frequency. The values of document variables can
also be included.

Starting the Similarity Analysis

Activate all documents you would like to include in the Similarity Analysis.1.
It is also helpful to activate all codes you wish to use for determining similarity.2.

From the Mixed Methods menu tab, click  Similarity Analysis for Documents. A window3.
will appear that contains all previously created similarity and distance matrices.
Click on the  New Similarity/Distance matrix symbol to begin the similarity analysis.4.

Setting the parameters for the analysis

A dialog window will appear in which you can select the codes and variables and specify the type of
analysis.

Setting options for the analysis
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In the upper section, you can add the codes you wish to include in the analysis. You can add all
activated codes directly via the Paste activated codes button.

Next, select the type of analysis:

Existence of code – Generates a similarity matrix that considers only whether the selected codes
occur in the document or not.

Code frequency – Generates a distance matrix that takes the distance of individual codes into
consideration.

Similarity measures with the option “Existence of code”

To calculate similarity, various options are available. All of the calculations are based on a four-field
table of the following type that is generated for each paired combination of documents (in the
background, not displayed):

 Document A

 Code/Variable value
exists

Code/Variable value
does not exist

Document B Code/Variable value
exists

a b

Code/Variable value
does not exist

c d

a = Number of codes or variable values that are identical in both documents.

d = Number of codes or variable values that do not exist in both documents.

b and c = Number of codes or variable values that exist in only one document.

The calculation options differ in, among other things, the extent to which field "d", the non-existence
in both documents, is considered a match.

Simple match = (a + d) / (a + b + c + d) – Both existence and non-existence are counted as a match.
The result is the percentage match.

Jaccard = a / (a + b + c) – Non-existence is completely ignored.

Kuckartz & Rädiker zeta = (2a + d) / (2a + b + c + d) – Existence is counted twice, non-existence
once.

Russel & Rao = a / (a + b + c + d) – Only existence is considered a match, but non-existence reduces
the similarity.

Please note: If you include more than one code into the analysis that does not exist in multiple
documents, it may be better to use a coefficient who ignores non-existing codes (Jaccard) or values
them less (Kuckartz & Rädiker zeta, Russel & Rao). Otherwise you may receive a high similarity
score, even if the codes are not assigned very differently. The non-existing codes will dominate the
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existing codes in this case.

Distance measures with the option “Code frequency”

To calculate the distance between two documents based on “Code frequency”, the following options
are available in which the code frequencies of two documents will be compared:

Squared euclidean distance = The sum of squared deviations (higher deviations will be rated higher
as lower ones because of squaring the deviations).

Block distance = The sum of absolute deviations.

Please note: Since it is also possible to include variable values in the analysis, all code frequencies
and variable values are z- standardized previously beforehand.

Including variables

If you want to include variables in addition to codes in the similarity analysis, click the Integrate
variables button. If you selected “Existence of code” as the type of analysis, you can then select
which variable values MAXQDA should evaluate in the dialog window. If the selected variable value
exists in both documents, this is evaluated as a match (type “a” in the table above). In the dialog
window, only variables of type “Text”, “Boolean (true/false)”, “Date” as well as categorical “Integer”
and categorical “Decimal” are listed.

Selecting variable values in the “Existence of code” analysis

If you selected "Code frequency" as the type of analysis, another dialog window will appear that
contains only integer or floating-point variables, that are not marked as "categorical".

Dealing with missing variable values

You can choose how missing values are handled:

Set missing values to 0 – IIf a variable value does not exist, it is set to 0 (which equals the average
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due to the z- standardization). Using this option, documents with missing values are included in the
analysis.

Ignore documents with missing values – If in a document one value of the selected variables is
missing, the entire document will be ignored in the analysis.

The final similarity or distance matrix

The following figure shows a similarity matrix for five interviews. The selected documents are listed
both in the rows and in the columns:

Similarity matrix for interviews

The default shadowed color helps to interpret the cells, which in a similarity matrix can have a value
of 0 (no similarity) to 1 (identical): The darker the green, the more similar the two documents are in
terms of the selected code and variable values. In the figure, for example, you can see that "Sam"
completely coincides with "Jamie" both in their codes and their variable values.

The matrix is sortable: click on a column header to sort the documents in the rows according to their
similarity to the clicked document.

The Similarity Analysis toolbar

In addition to the usual export options, the following functions can be accessed from the toolbar:

New similarity/distance matrix – Calls up the dialog window where you can create a new matrix.

Delete – Deletes the selected matrix.

Names, columns: none, short, full – Controls column width.

No color highlight – Turns off green highlighting.

Color highlight refers to whole matrix – The highlight color takes into account the values of all cells.
The same values will have the same highlight color in the table.

Color highlight refers to columns – In each column, the colors are graduated from white to green. In
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this way, you can see at a glance which documents are particularly similar to the document in the
column. The same values in the matrix may be colored differently.

Color highlight refers to rows – In each row, the colors are graduated from white to green. In this
way, you can see at a glance which documents are particularly similar to the document in the row.
The same values in the matrix may be colored differently.

Distance matrices look identical to similarity matrices, however their interpretation is the reverse:
The lower the value in a cell, the more similar the two documents are. The minimum distance is 0,
the maximum distance depends on the codes and variables selected in each case and can be
greater than 1.

The list of existing similarity and distance matrices

In the left pane of the window, you can see the similarity and distance matrices created earlier in the
project. They can be renamed with a double-click or deleted by clicking the Delete icon in the toolbar.

Tip: In order to ensure the transparency of the analysis process, the matrix name and selected
settings will be displayed in the tooltip if you hover over a matrix name.

Side-by-side Display of Results
Definition: The purpose of the Side-by-side Display is to array quantitative and qualitative data of a
Mixed Methods project together.

Side-by-side Displays are used to display the results of a qualitative and a quantitative study
together by sorted themes. The display is structured like this:

 Qualitative Results
(Document A)

Quantitative Results
(Document B)

Theme 1
(Code 1)

Coded segments / Summaries Coded segments / Summaries

Theme 2
(Code 2)

Coded segments / Summaries Coded segments / Summaries

Theme 3
(Code 3)

Coded segments / Summaries Coded segments / Summaries

The Side-by-side Display has two columns. Each column displays coded segments or summaries for
each of the two studies. The rows of the table are made up of themes, in this case your codes.

Creating a new Side-by-side Display

Navigate to the Mixed Methods menu tab and click the Side-by-side Display entry. From the
dropdown select to create a new display for either coded segments or summaries. MAXQDA will
open the following dialog:
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Creating a side-by-side display

Drag and drop a document from the “Document System” into each of the fields for1.
“Qualitative study” and “Quantitative study” with your mouse. Drag another document into a
field to replace a document you already selected.
Drag and drop any number of codes from the “Code System” into the “Themes” box on the2.
left. Codes can be rearranged with the mouse. Codes can be removed from the “Themes” box
by dragging the code out of the box or selecting the code and pressing Del key (Windows) or
⌘+Backspace (macOS).
Check the box next to Include comments of coded segments to include comments. If a3.
comment exists, it will be displayed below the coded segment in the final display. This option
is not available for side-by-side displays created for summaries.
After clicking OK, a dialog window will appear where you enter a file name and select the4.
location on your computer to save the display to.

MAXQDA generates an Interactive Quote Matrix with two columns for a Side-by-side Display, so that
you can explore this display interactively. You can find further information on how to work with this
results window in the following section of the manual: Interactive Quote Matrix.

Qualitative Themes by Quantitative
Groups
Definition: This joint display integrates data by arraying the qualitative data (segments or
summaries) as one dimension and the groups formed by the quantitative data as another
dimension.

This joint display is used to compare coded segments or summaries for groups of documents.

https://www.maxqda.com/help-mx24/mixed-methods-functions/interactive-quote-matrix
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Documents are grouped based on variable values. The following table is a schematic representation
of a joint display for the document variable “Occupation”. Document groups are created based on
their occupational status:

 Document variable: Occupation

 unemployed
(N = x documents)

employed
(N = y documents)

self-employed
(N = z documents)

Theme 1
(Code 1)

Coded segments /
Summaries

Coded segments /
Summaries

Coded segments /
Summaries

Theme 2
(Code 2)

Coded segments /
Summaries

Coded segments /
Summaries

Coded segments /
Summaries

Theme 3
(Code 3)

Coded segments /
Summaries

Coded segments /
Summaries

Coded segments /
Summaries

Each column displays coded segments or summaries from those documents with the corresponding
variable value, separated into rows by themes (= codes).

Creating a new display

Navigate to the Mixed Methods menu tab and click on the QUAL Themes for QUAN Groups option
either for coded segments or summaries. MAXQDA will open the following dialog:

Creating a joint display “Qualitative themes by quantitative groups”

Select which groups to compare by selecting a document variable and up to four variable1.
values from the drop-down menus. MAXQDA will include all documents with the
corresponding variable value in the final columns of the display.
You can limit the display to only include currently activated documents by checking the box2.
next to Only for activated documents.
Drag and drop any number of codes from the “Code System” into the “Themes” box on the3.
left. Codes can be rearranged with the mouse. Codes can be removed from the “Themes” box
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by dragging the code out of the box or selecting the code and pressing Del key (Windows) or
cmd-Backspace (Mac).
After clicking OK, MAXQDA will open a new window with the joint display. The joint display4.
can be explored intractively. You can find a detailed description on how to operate the results
window in the Segment Matrix chapter.

Statistics by Qualitative Groups
Definition: This joint display integrates a qualitative typology as one dimension with the quantitative
data as another dimension.

This joint display is used to compare types that have been constructed from the qualitative data by
statistical values such as mean, standard deviation, etc. The types are created based on the
existence of codes in each document. The following table is a schematic representation of this kind
of joint display:

 Coded with …

 subcode A subcode B subcode C

Variable 1
(numerical)

Mean (Standard deviation) Mean (Standard deviation) Mean (Standard deviation)

Variable 2
(categorical)

Total (%) Total (%) Total (%)

Documents N (%) N (%) N (%)

Each column holds all documents, in which the selected subcode occurs. It is therefore important
that only one of the subcodes is assigned to each document. An example could be an evaluative
qualitative text analysis where the code “self-assurance” has the subcodes “low,” “medium,” and
“high”. If one of the subcodes is assigned to each document, they can now be used to create this
joint display.

Creating a new display

Navigate to the Mixed Methods menu tab and click the Statistics for QUAL Groups entry. MAXQDA
will open the following window:

https://www.maxqda.com/help-mx24/mixed-methods-functions/segment-matrix
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Creating a joint display “Statistics by qualitative groups“

Create groups by dragging a code that has subcodes (but no sub-subcodes) from the “Code1.
System” window to the “Groups” field at the top of this window. Select up to 4 subcodes from
the drop-down menus below.
You can limit the display to only include currently activated documents by checking the box2.
next to Only for activated documents.
Click the “Choose document variables…” button to call up the variable selection window.3.
Select which variable values to include for categorical variables.

Choose document variables for the Joint Display “Statistics by qualitative groups“
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Click OK to include your selection and click OK again to create the joint display.4.

The result of this display is equal to that of a Typology Table.

Transform a Code into a Document
Variable (Quantitizing)
A code in the “Code System” can be transformed into a document variable, indicating how often the
selected code appears in each document. The document variable is dynamic. MAXQDA will
automatically update the document variable, i.e. increasing the variable value if a new segment is
coded with the code. This feature is particularly useful as it allows the user to export code
frequencies along with variables, or activate documents based on certain code frequencies for
analysis.

To transform a code into a document variable, right-click the code and select Transform into
Document Variable.

Transform a code into a document variable

https://www.maxqda.com/help-mx24/mixed-methods-functions/typology-table
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MAXQDA will generate a document variable, with the same name as the code, as a numeric variable.
The program will automatically insert the code frequency of each document into the appropriate cell
of the column. It opens along with the “Data editor” of the document variable and positions it in the
appropriate column. The content of this variable can’t be edited manually. MAXQDA updates the
variable dynamically: if you assign the transformed code to a document, the corresponding variable
value is automatically updated.

Code ”Friends and Family” converted to a document variable

Please note: To transform multiple codes into document variables at once, activate all of the codes
first, then click the Quantitizing option in the Mixed Methods menu tab.

You can recognize variables transformed from codes in the "List of Document Variables" by the
green square icon in the first column and the "Code" entry in the "Source" column.

The transformed code can be binarized by clicking the Convert to Boolean variable icon in the "List
of Document Variables". The variable then no longer indicates how often the corresponding code
occurs in the respective document, but whether it occurs (1) at all in the document or not (0).

Transform a Code into a Categorical
Document Variable
Evaluative categories in (qualitative) content analyses

In many research projects, forms of evaluative qualitative content analysis are used. The standard
steps are to: (1) define evaluative categories, usually with ordinal variables, (2) code text segments,
and (3) analyze the data descriptively and statistically. A good example of this form of analysis
process is found in Philipp Mayring’s chapter on qualitative content analysis found in “A Companion
to Qualitative Research” (Flick, et al., 2004), which describes scaled variations of structure content
analysis.

In one of Mayring’s detailed examples from a study on student teachers, a category called “self-
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confidence” is created with three options: “high,” “medium,” and “low” (see below). These categories
were developed from the data. The following figure shows that the categories are not only precisely
defined, but also empirically supported with the help of the anchor examples in the data.

The coding process, which is standard procedure for content analysis, has the researcher working
through the entire data set and assigning evaluative codes to appropriate text segments that have to
do with “self-esteem.” This means that every single text segment that connects to self-esteem will
be assigned the code “high,” “medium” or “low” based on the coding guidelines established.

In the end, each case (in the case of interviews, a case would be an interviewed person) can be
analyzed as a whole and given a summary characterization as having “high,” “medium,” or “low” self-
esteem. Cases characterized as having high self-esteem can then be compared with those with low
self-esteem. Code frequencies can also be compared and used in combination with other categories
in crosstabs.

Principles of application in MAXQDA

The method for evaluative content analysis can be done in MAXQDA in the following way. First, the
category “self-esteem” is created as a code with the subcodes “high,” “medium,” and “low.” The
definitions of these codes along with anchor examples can be created as code memos..
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Now the data will be analyzed, meaning that each document is read line by line. The text segments
that have to do with self-esteem are identified and then coded with the appropriate code (e.g. “high”
self-esteem). After an entire text has been worked through in this way, the researcher will have one
of the following situations:

Text segments about self-esteem in this document were all coded with the same subcode
(e.g. “medium” self-esteem). In this situation, the entire case can be said to have a medium
level of self-esteem.
Text segments about self-esteem in this document were coded with various subcodes, but
one of those subcodes obviously occurs more often (e.g. three with “high” self-esteem and
one with “medium”). In this situation, it makes sense to give the whole case that level of self-
esteem that is coded most often.
Text segments about self-esteem in this document were coded with various subcodes, and
none of them clearly occur more often than the others (e.g. two with “medium” self-esteem
and two with “high”). In this situation, a quick categorization cannot be made, so the coded
segments should be compared to one another by the coders, who then make a decision about
which categorization is more appropriate.
No text segments were coded with self-esteem subcodes, meaning the document does not
contain any information about this theme. None of the subcodes can be used to categorize
this document and will need to be treated as a “missing” value.

The “Transform into a Categorical Variable” function

After coding the appropriate text segments, the “Self-esteem” code can be transformed into a
categorical variable by right-clicking on the code and selecting the appropriate option in the menu
that appears.
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Transform a code into a categorical document variable via a code's context menu

After this option is selected, MAXQDA performs the following actions:

A new categorical variable is created in the List of Document Variables with the name of the1.
code that it was created from (in this case, “Self-esteem”).
All cases (documents) in the “Document System” are evaluated according to the rules2.
explained above.
a) Each case is assigned the value of the subcode that occurs the most often.
b) If there are two or more subcodes used the same number of times, it is labeled
“undefined.”
c) If none of the subcodes are used at all, no value is assigned. If the table is exported to
statistical software, empty values are usually treated as “missing.”
MAXQDA opens the "Data Editor for Document Variables".3.
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The new categorial variable

Please note: If a subcode has further subcodes, then these subcodes and their segments are not
included in the evaluation for the categorical variable. Only the direct subcodes are taken into
account.

Dynamic properties of categorical variables

In MAXQDA‘s List of Document Variables, the categorical variables have a special status. One
recognizes them in the list because they have a green square in the first column and are created
from a “Code” as seen in the “Source” column; categorical variables are defined as text variables,
and the texts are taken from the “Code System” (in this case “high,” “medium,” or “low”).

The newly-created categorical variable “Self-esteem” in the List of Document Variables

Categorical variables are dynamic, which means they are updated automatically when new
segments are coded in the documents. This is also the case for documents that are imported after
the categorical variable has already been created; when one codes this new document, the variable
label changes accordingly.
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Tip: If a subcode has further subcodes, they will not be included for the evaluation of categorical
variable values. Only direct subcodes of the codes that were transformed into a categorical variable
are evaluated.

Categorical variables in the context of MAXQDA's mixed methods
functions

Categorical variables lend themselves very well to use with MAXQDA’s mixed methods functions,
found in the Mixed Methods menu tab. With the Activate Document by Variables function, for
example, one can choose to activate only those documents with a certain variable value. This is
helpful for answering research questions such as “How do student teachers with low self-esteem
experience their situation in the school system? How do they approach disciplinary issues?”

The Crosstabs function offers an aggregated overview of the number of coded segments in certain
categories in the “Code System” for each of the three self-esteem variables. The self-esteem
characterizations are shown in the columns on the x-axis, and the selected codes are shown in the
rows on the y-axis. Using the self-esteem example, the Crosstabs function could count the number
of times that student teachers with low self-esteem talk about disciplinary issues in comparison to
the number of times student teachers with high self-esteem talk about the issue. One can then easily
call up the document segments counted in each cell in the “Retrieved Segments” window.

One can also use the Interactive Quote Matrix to see a detailed table of the document segments,
each column holding those segments that occur in documents with a specific categorical value. In
our self-esteem example, one column could hold those statements about a certain topic that come
from student teachers with high self-esteem, and the other column could display those statements
from teachers with low self-esteem.

The Typology Table uses categorical variables similar to the way the Crosstabs function does; a
table is created with the categorical variable values in the columns. In this case, however, the
variables are analyzed rather than the categories. One could look, for example, what percentage of
people with high self-esteem are older than 30 years and what percentage are younger, or whether
good grades in teacher certification exams seem to connect in any way to self-esteem, etc.
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21 – Stats

What Does MAXQDA Stats offer?
Tip: Stats is a MAXQDA Analytics Pro module and cannot be purchased separately. Therefore, it can
only be used via an existing MAXQDA Analytics Pro license and activated through its corresponding
serial number. If you already have a MAXQDA Analytics Pro license, Stats is a tab on the main ribbon
menu.

MAXQDA Stats is a stand-alone statistics module that accompanies MAXQDA Analytics Pro,
providing frequently used descriptive, inferential, and multivariate statistical methods. MAXQDA
Stats has two major special features:

1. Link and interact with data from a MAXQDA project

MAXQDA Stats can be launched with the data of a MAXQDA project, so the document variables and
code frequencies per document can be transferred to Stats. The documents that are in the
statistical results tables behind individual cells can be stored as document sets for further
qualitative analysis. When MAXQDA Stats is closed, variables which may have been added or
modified can be transferred back into the MAXQDA project with the qualitative data.

2. Interactive results table

MAXQDA Stats results tables are dynamic, meaning they can be adapted and interactively edited.
Rows and columns can be deleted or merged, and the results table will be automatically
recalculated. Columns can be moved, hidden, or sorted, and changes in the results table can be
undone. Cells that contain high, significant, or sharply outlying values can be highlighted in color.

With MAXQDA Stats you can:

Analyze data from MAXQDA projects
Analyze external data from SPSS or Excel, for example online surveys
Enter and analyze new data, for example from “Paper and pencil” surveys

In detail MAXQDA Stats offers the following functions:

Statistical analysis of document variables and code frequencies for MAXQDA projects
Statistical analysis for external data in SPSS or Excel format
Export data to SPSS or Excel
Interactive results table in which rows and columns can be moved, deleted, or merged
Exclude cases listwise for individual calculations
Calculate new variables from existing variables and codes
Calculate and store z-standardized values for a variable
Recode variables into new or existing variables
Filter and search datasets
Navigable output viewer, from which content can be exported, copied, or printed
Export editable result tables to Word via the clipboard

https://www.maxqda.com/products/maxqda-analytics-pro
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MAXQDA Stats can perform the following procedures and calculations:

Frequency tables
Descriptive statistics: mean, standard deviation, variance, median, quartiles, minimum,
maximum, range, sum, standard error, 95% confidence interval for the mean
Crosstabs: absolute and relative frequencies, row and column percentages, expected
frequencies, residuals, standardized residuals, adjusted standardized residuals; Chi-square,
Phi, Cramer’s V, contingency coefficient C
t-Test (for independent samples): with output of descriptive statistics, Shapiro Wilk test of
normality distribution, and effect sizes Cohen’s and Hedges g
Mann-Whitney U-Test: with output of descriptive statistics
One-way analysis of variance: with output descriptive statistics and Levene test of
homogeneity of variance, Sheffe post-hoc test, including Cohen’s d and Hedges g
Correlation: Pearson and Spearman correlation
Scale: Cronbach’s Alpha

Note: These instructions are not intended as a statistics tutorial and explain computed values only
to highlight specific features. To better understand the statistical calculations, we recommend you
refer to your available statistical literature.

Using MAXQDA Stats
Tip: Stats is a MAXQDA Analytics Pro module and cannot be purchased separately. Therefore, it can
only be used via an existing MAXQDA Analytics Pro license and activated through its corresponding
serial number. If you already have a MAXQDA Analytics Pro license, Stats is a tab on the main ribbon
menu.

The MAXQDA Stats interface

The tab “Stats” in MAXQDA's main ribbon menu

MAXQDA Stats can be initiated with both the data of a MAXQDA project (document variables and
code frequencies per document) as well as with external data (SPSS or Excel files). Upon clicking on
the Stats tab, which can be found in the main ribbon bar menu as shown above, the MAXQDA Stats
interface appears. Its layout can be seen below:

https://www.maxqda.com/products/maxqda-analytics-pro
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The MAXQDA Stats interface

Hint: When MAXQDA Stats is activated, the normal MAXQDA interface is no longer visible. It will
automatically appear again once you close MAXQDA Stats.

MAXQDA Stats has its own main menu which contains the following options:

File – this menu item serves to open files, create new files, and store external data

View – this menu item allows the user to switch between the Data Editor, Variable List and output
viewer

Transform – contains all the functions for calculating and recoding variables

Descriptive Statistic – contains the functions for the creation of frequency tables and calculating
descriptive statistics such as median, mean and standard deviation

Compare Groups – allows the creation of crosstabs and the implementation of one-way analysis of
variance

Correlation – begins the calculation of correlation tables

Scale – provides access to the functions for creating scales

The user can easily switch between views using the tabs located in the lower left of the screen.

The Data Editor contains the cases in the rows and the variables in the columns. This is where the
individual cases (analysis units) are entered and edited. If MAXQDA Stats is started for a MAXQDA
project, the Data Editor for MAXQDA Stats will contain the same data as the Data Editor for
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document variables as the MAXQDA project, meaning each row corresponds to one document.

In the Variable List variable labels, missing values and other options for variables can be created.

The Output Viewer contains all the results tables and charts that were inserted in the Viewer in the
course of the MAXQDA Stats session.

The Data Editor
Tip: Stats is a MAXQDA Analytics Pro module and cannot be purchased separately. Therefore, it can
only be used via an existing MAXQDA Analytics Pro license and activated through its corresponding
serial number. If you already have a MAXQDA Analytics Pro license, Stats is a tab on the main ribbon
menu.

The MAXQDA Stats Data Editor displays the cases in the rows and the variables in the columns.
Each case is therefore in a separate line. The following figure shows the Data Editor for a MAXQDA
project, which essentially corresponds to the Data Editor for the MAXQDA document variables. The
third row provides information on the document “RESP02” which contains 7 coded segments and 1
memo. It refers to a survey respondent that is in a partnership or married and has 2 children.

The MAXQDA Stats Data Editor

The first columns in the example figure contain the MAXQDA system variables, such as “Document
group”, “Document name”, “Coded segments”, and “Memos”. They are immutable in MAXQDA Stats
and column headings are therefore displayed as in MAXQDA in black. The modifiable user variables
are displayed in blue.

https://www.maxqda.com/products/maxqda-analytics-pro
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Individual columns can be hidden by right-clicking on the column header and choosing Hide Column
from the context menu. Using the Select columns function, also in the context menu, individual or all
columns can be hidden or displayed, just like in MAXQDA.

Hint: The order of the columns from left to right cannot be changed, as this order always
corresponds to the order of the variables in the Variable List from top to bottom.

System-defined missing values

MAXQDA Stats considers any blank fields in the Data Editor as system-defined missing. Unlike in the
MAXQDA Data Editor, integer or decimal-type variable fields can also be empty.

Show value labels

The toolbar is located above the Data Editor on the left side.

Toolbar on the left side of the Data Editor

Using the icon Show value labels  the entered value of the value label will be displayed. This value
can be individually defined for each variable in the Variable List. If no label is defined for a value, the
value will still be displayed.

Sort and search cases

Clicking on a column header in the Data Editor sorts the data in this column; clicking a second time
sorts the same column in the reverse order.

Hint: On the left side of the Data Editor a sequential numbering of the rows is displayed. The
numbering is fixed in order to provide orientation in the dataset; it will not be sorted. For external
files, it is always advisable to provide a variable with a unique case ID.

The Data Editor in MAXQDA Stats can be searched and filtered, exactly as in MAXQDA. Clicking on
the Search  icon in the toolbar above the Data Editor opens a search list in which a search query
can be entered, the occurrence of which will be searched in all columns. To search in a single
column, right-click on the column header and select Search.

Filter cases

The filter function can similarly be called up for a column as follows:

Right-click on a column header.1.
Select Set Filter.2.
In the dialog box, define filter criteria and click OK.3.
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Enter filter criteria

The number of cases currently in the Data Editor can be seen in the bottom right of the status bar.
Only these cases are included in the calculations.

To switch the currently set filter on and off, click on the Filter  icon in the toolbar above the Data
Editor. To delete all filters, click on the  icon.

Go to case

To jump to a particular case in a row, click on the  icon in the toolbar above the Data Editor. A
small dialog box will appear where you can enter the target row.

Insert new cases

When MAXQDA Stats is called up for a MAXQDA project, it is not possible to insert new cases, as
this would be synonymous with the insertion of further documents in the MAXQDA project itself. The
situation is different when you create or open a new external file. In this instance, it is of course
possible to add additional cases to the data set, which can be done as follows:

Scroll to the bottom of the data set1.
A blank row is located in the last row of the Data Editor. As soon as any content is entered in2.
any column, this row will be assigned a consecutive number and another blank row for the
next record will appear underneath the previous row.

Delete cases

When you work with an external file in MAXQDA Stats, you can delete individual or multiple cases as
follows:

In the Data Editor, highlight a single case with the mouse, or highlight multiple cases by1.
pressing the Ctrl/cmd key.
Right-click the highlighted area and select Delete selected cases. Alternatively, you can click2.
on the Delete icon  in the toolbar above the Data Editor.



  501

Export Data Editor

At the top right of the Data Editor a typical MAXQDA toolbar is located, which contains the following
icons for exporting data.

  Open as Excel table – When you click on this icon, the current view will be exported and
displayed as an Excel file.

Open as HTML table – When you click on this icon, the current view will be exported and
displayed as a HTML file in the default browser.

Export – When this function is selected, a file dialog will appear in which you can select from
Excel or HTML export formats and specify a file name and location. Value labels that are displayed
in MAXQDA will also be exported.

The currently displayed data can be saved as an SPSS file by selecting File > Save As from the main
menu.

The Variable List
Tip: Stats is a MAXQDA Analytics Pro module and cannot be purchased separately. Therefore, it can
only be used via an existing MAXQDA Analytics Pro license and activated through its corresponding
serial number. If you already have a MAXQDA Analytics Pro license, Stats is a tab on the main ribbon
menu.

The MAXQDA Stats Variable List allows you to manage all the variables of a data set. This is the
place to define the variable names and value labels, and also to set missing values for a variable.
New variables can also be created in the Variable List.

https://www.maxqda.com/products/maxqda-analytics-pro
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The Variable List in MAXQDA Stats

In the first column there is a consecutive numbering of the variables. The variables in the Data Editor
are displayed from left to right, corresponding to this numbering. The number of variables in the
current data set are displayed on the bottom right in the status bar.

The other columns include the following features:

Variable – This column is a mandatory column, meaning each variable requires a variable name. To
create, for example, a frequency table or a crosstab, you can select the name of individual variables.

Tip: In MAXQDA Stats variable names can be composed of any character strings up to 63 characters
in length. Unlike in many statistics programs, spaces and any special characters are permitted.
When working with external statistics files (.xlsx or .sav files from SPSS, STATA, etc.). it is advisable
to choose simple variable names to ensure compatibility. When saving a data set in SPSS format,
the variable names are automatically adjusted to be SPSS-compliant.

Variable label – In addition to the variable name, it is possible to assign a label to a variable. In
MAXQDA this label can be up to 255 characters in length and include any character. The variable
label will appear in selection dialogs and results tables in the place of the variable name for easier
interpretation.

Variable type – The same types of variables can be used in MAXQDA and MAXQDA Stats: text,
integer, decimal, date/time, and Boolean (true/false).

Value labels – In statistical data sets, answers are often coded with numbers, for example 1 for
“low” and 4 for “high”. Assignment of texts to the encoded numbers is done via value label and will
appear in this column.



  503

Missing values – In this column, the values are displayed which are to be counted as missing for the
respective variable and therefore not to be included in the analysis.

Tip: Please note that for the variable type "Boolean" no missing values can be defined.

Measure – Here you can set the measurement level of a variable. You can choose between three
levels: “Interval”, “Ordinal” and “Nominal”.

Source – This column provides information about the origin of a variable. Variables automatically
generated in MAXQDA carry the identifier “System”, user-defined variables carry the identifier “User”.
Variables with the origin “Code” are codes to which the function “Transform into document variable”
was applied in a MAXQDA project. Variables carrying the identifier “Dictio” are the result of a
dictionary-based enumeration of category frequencies using MAXDictio.

Hint: The colors of the squares in the leftmost column of the Variable List reflect the origins of the
variables (User = blue; System = red; Code = green; Dictio = yellow). When working with external files,
only blue squares are displayed, as all variables were created as freely editable User variables.

To be displayed – From this column, you can control the display of variables in the Data Editor. To
hide a column, remove the check mark by clicking a cell.

Sorting the variable list

Click on a column header to sort the list of variables corresponding to the clicked column. To restore
the original order, click on the first column with the numbering.

If list is ordered by first column with numbering, can move individual variables by clicking in any row
with the mouse and moving the row to the desired location. To move multiple rows at the same time,
hold down the Ctrl or Cmd key as you click on the desired rows, then drag the multi-row highlighted
area with the left mouse button.

Adding new variables

You can add new variables by entering data in the blank bottom row of the Variable List:

Double click in the last blank row of the “Variable” column. MAXQDA Stats will automatically1.
generate a new generic variable name: “var001”, “var002” etc.
Enter a new variable name in the “Variable” column and provide a variable label as required.2.
In the “Variable Type” column, select one of the five variable types supported by MAXQDA3.
Stats, which are the same as those supported by MAXQDA:

Text
Integer
Decimal
Date/Time
Boolean (true/false)

The new variable will be created once you have clicked on a location outside the row and this row is
no longer highlighted. Data can now be entered in the Data Editor.

Hint: The variable type of a previously created variable can be changed under certain conditions (see
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below).

If required, enter data in the columns “Value Labels,” “Missing Values,” and “Measure.”

A toolbar is located above the Variable List on the left:

Toolbar on the top left above the Variable List

Click on the icon New variable  to automatically jump to the last row of the Variable List, where
you can immediately start typing a variable name.

Copying variables

Copying variables can be very helpful, particularly when defining multiple nearly identical variables in
an item set or matrix question:

Highlight one or more variables by clicking on the appropriate row or clicking and holding the1.
Ctrl/cmd key to select multiple rows.
Right-click on the highlighted area and select Copy variable or press Ctrl+C (Windows) or2.
cmd+C (Mac).
Right-click on the target line and select the function Insert variable above.3.

When the variable is copied, the variable label, variable type, value label, missing values, and
measure will be copied, however the values will not.

Defining value labels

Value labels are used to match a text to a numerical variable value. For example, if the endpoints of
a response scale to the question “Satisfaction with flexibility of working arrangement” are coded
with 1=”low” and 5=”high”, these responses can be switched between their numerical and text
representations in the Data Editor.

By clicking a cell in the Value Label column, the following dialog box will appear.

Dialog box for creation of a Value Label
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In the left-hand column, enter the value to be associated with the label on the right. Normally the
value is a number, but you can also use any text string, for example “f” for “female” or “Man” for
“Manager.” When you click OK the value label will appear in the appropriate cell in the Variable List.

Using the two Delete icons at the top of the window, you can delete single or all entries.

Defining missing values

There are many reasons why missing values may be present in a data set: A respondent did not
answer a question or refused to answer a question, or their response is not clear, for example in a
handwritten questionnaire an X was placed exactly between two responses. To denote missing
values, there are two main options:

a) The data field is left blank, in which case the missing value will be considered “System defined
missing” and ignored in the analysis, or

b) A specific value can be provided to interpret the missing value.

To define a missing value, click in the cell of the missing value to call up the following window:

Window for entering a missing value

In this window, single missing values or a range of missing values can be entered. All entries in the
window are always considered; for example, in the above window, the -99th values as well as the
values from -3 to 0, inclusive, will be ignored in the evaluation.

Hint: Missing values cannot be defined for “Boolean (True/False)” variable types.

Searching and filtering variables

The Variable List in MAXQDA Stats can be searched and filtered exactly as in MAXQDA. Clicking on
the Search  icon in the toolbar at the top of the window opens a search list in which a search
query can be entered, whose occurrence will be evaluated in all columns. To search in a specific
column, right-click the column header and select Search.

Likewise, the filter function can be applied to a specific column:

Right-click on the column header.1.
Select Filter.2.
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Enter the filter criteria and click OK.3.

Enter filter criteria

The status bar at the bottom right of the window displays the number of variables that fulfill the
selected criteria.

To turn the filter off and on as required, click the Filter  icon in the toolbar above the Data Editor.
By clicking the  icon, all filters will be deleted.

Changing the variable type

You can change the variable type at a later stage. To do this, select one or more rows with your
mouse, and then click one of the icons at the top left corner of the toolbar (which conversion icons
you can click will differ depending on the type of the selected variable).

Toolbar at the left edge of the List of Variables

Convert to binary variable – All of the selected variable values that differ from 0 are set to
"true", all others to "false" (including missing values and values defined as missing).

Convert text variable – All of the selected variable values are retained and saved as text.

Convert to integer variable – All of the selected variable values with integers are stored as
numbers. Other values are set to 0!

Convert to decimal number variable – All of the selected variable values with numbers are
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stored as decimal numbers with 2 decimal places. Other values are set to 0!

Convert to date/time variable – All of the selected variable values that correspond to a date
format in the Data Editor are saved as a date. Other values are set to "empty"!

Please note: Be aware that variable values which do not correspond to the newly applied type will be
lost in the conversion process. If you opened MAXQDA Stats to edit the document variables of a
MAXQDA project, the variables whose type has been converted will be added as new variables to
your MAXQDA project once you close Stats.

The Output Viewer
Tip: Stats is a MAXQDA Analytics Pro module and cannot be purchased separately. Therefore, it can
only be used via an existing MAXQDA Analytics Pro license and activated through its corresponding
serial number. If you already have a MAXQDA Analytics Pro license, Stats is a tab on the main ribbon
menu.

In the Output Viewer, all calculated and customized results tables and charts can be stored. The
Output Viewer is divided into two sections: on the left is a tree directory where you can jump directly
to the contents; on the right the results tables and charts are displayed.

The Output Viewer

Clicking on an entry in the directory tree, jumps to the corresponding location and highlights the
appropriate table or chart as well as the corresponding heading.

Export Output Viewer

Single or multiple contents of the Output Viewer can be exported or copied to the clipboard.

https://www.maxqda.com/products/maxqda-analytics-pro
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Copy Highlighted Tables and Charts

You may wish to copy tables and charts into word processing software such as Word, or
presentation programs such as PowerPoint. There are several ways to do so.

Right-click on an object you wish you export in the directory tree of the Output Viewer and
select Copy. When you select a heading, all corresponding objects will be automatically
selected and copied.
Click on an object in the directory tree, then click Copy  in the top left of the window.
Highlight the desired selection in the Output Viewer with the mouse, then right-click the
highlighted area and select Copy.

Copy objects from the Output Viewer to the clipboard

Export complete contents

Using the symbol in the top right of the window, you can export the Output Viewer in HTML format:

Open as HTML table – Clicking on this icon displays the contents of the Output Viewer in a
temporary HTML file in the default browser. To store the file, you must save it from the browser.

Export – When you select this function, a dialog box will appear in which you can select the
filename and location in which you wish the file to be saved. The file will open automatically
following the export process.

Print Output Viewer

Click the Print icon or use the keyboard combination Ctrl+P (Windows) or cmd+P (Mac) to print
the contents of the Output Viewer. In the dialog box that appears you can select from multiple page
settings and select the printer.
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Print window

Please note: Very large tables may be cut on the right side when printed.

Delete content from Output Viewer

To delete content from the Output Viewer, right-click an entry in the directory tree and select Delete
or use the Delete key (Windows) or ⌘+Backspace (macOS).

Clicking the Clear Output Viewer  icon at the top left of the window empties the entire Output
Viewer.

Hint: When you close MAXQDA Stats the contents of the Output Viewer will be saved as part of the
opened MAXQDA project. If MAXQDA Stats is opened the next time, the contents will be available.

Analyze Variables and Codes from a
MAXQDA Project - Start MAXQDA Stats
Tip: Stats is a MAXQDA Analytics Pro module and cannot be purchased separately. Therefore, it can
only be used via an existing MAXQDA Analytics Pro license and activated through its corresponding
serial number. If you already have a MAXQDA Analytics Pro license, Stats is a tab on the main ribbon
menu.

MAXQDA Stats offers a convenient and innovative way to statistically analyze the document
variables of a MAXQDA project as well as the code frequencies per document. With MAXQDA Stats,
you can eliminate the cumbersome process of exporting data to a statistical program and then
transferring it back to MAXQDA for further analysis; instead, your statistical analyses can be
performed directly within the Stats module.

Upon starting MAXQDA Stats, the document variables and code frequencies per document are
automatically transferred in the following manner:

https://www.maxqda.com/products/maxqda-analytics-pro
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The documents form the cases in the Data Editor, exactly as in MAXQDA. Each document is
in a separate row and can be identified by its document name and document group.
The document variables from MAXQDA form the columns in the Data Editor and can be
adapted and supplemented in the Variable List.
A code frequency matrix, in which documents form the rows and codes form the columns, is
transferred to the background and is available for analysis. MAXQDA Stats shows how often
a selected code was assigned in a document for each case (therefore in each document).
You can envision that in the Data Editor, further (invisible) columns are present whose cells
contain the code frequency per document.

The Data Editor: rows represent documents, columns represent variables

Hint: When working in MAXQDA Stats, the document variables and code frequencies of the
MAXQDA project will not be affected. Upon exiting MAXQDA Stats, newly created variables and
modified variable values can be transferred back into the MAXQDA project.

To start MAXQDA Stats for a MAXQDA project, several options are available in the main menu under
the entry Stats:

Starting MAXQDA Stats from MAXQDA's main ribbon menu

Start with All Documents – When this option is selected, all documents will be available as
cases for statistical evaluation in Stats.
Start with Activated Documents – This option is useful when evaluations should not be
carried out for all documents, for example, when only documents with the transcripts of
respondents in MAXQDA Stats are to be evaluated, and documents with their own notes or
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Twitter imports should be left out. Before calling up this function, activate the documents to
be analyzed.
Start with Activated Documents and Codes – This option is designed especially for the event
that you have a very large code system, but are only interested in selected code frequencies
per document. To use this feature, first activate the desired codes and documents that are to
be analyzed in Stats.

Hint: MAXQDA Stats is limited to 1,000 different variables and codes. If a MAXQDA project contains
more variables and codes, only the first 1,000 variables and the first codes in the code tree will be
transferred to MAXQDA Stats.

The transfer of document variables from MAXQDA when starting MAXQDA Stats occurs in the
following manner:

If a label, value label, missing value or measurement level for a variable has already been
created in MAXQDA Stats, this information will be available the next time you start MAXQDA
Stats. The specifications are written into the project file and remain there even if MAXQDA
Stats is closed and reopened at a later time.
If a missing value is defined for a variable in MAXQDA, it will be transferred as the first
missing value in the top left of the “Missing Values” window in MAXQDA Stats, so long as this
position is empty. If the first value is already defined in Stats, no value will be transferred from
MAXQDA.
Missing values for Boolean variables are not accepted, because no missing values for these
variables can be defined in MAXQDA Stats.
Depending on the type of variable in the case that the “categorical” option has been set for a
variable in MAXQDA, the measurement level in MAXQDA Stats is set for the variable. Text and
Boolean variables get the measurement level in nominal terms, as categorical integer and
decimal variables. Other numerical variables and date variables are associated with the level
of “interval”. If the measurement level has been changed in Stats, it will remain unmodified
the next time MAXQDA is launched.

When data from a MAXQDA project is transferred to MAXQDA Stats, all Stats analysis functions
remain available.

Transfer MAXQDA Stats data to a MAXQDA project

After completing the analysis in MAXQDA Stats, modified variable values can be transferred back to
the MAXQDA project to update the existing variables and add new ones. Likewise, document sets
created during the analysis can be transferred.

In principle, the transfer of variables from MAXQDA Stats to the MAXQDA project occurs in exactly
the same manner as when data is read in MAXQDA using the Import data (document variables)
function.

To transfer MAXQDA Stats data to the MAXQDA project, close the MAXQDA Stats window using the
X symbol (Windows) or red X symbol (Mac) at the top of the window or by selecting File > Quit
MAXQDA Stats from the Stats main menu. If data or variables have been changed within MAXQDA
Stats, the following option window will appear:
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Options window before closing MAXQDA Stats

Update and insert document variables in the MAXQDA project

In the upper panel, two options are available, which are selected by default and allow you to control
the transfer of variables from Stats for the document variables of the MAXQDA project when exiting
Stats.

Update document variables of MAXQDA project – If this option is selected, the values of all
variables whose names already exist in the MAXQDA project (and which are also the same variable
type) will be updated. The definition of missing values and the “categorical” property of a variable
cannot be changed during transfer. Existing document variables that were created from a code
using the “Transform into variable” function will not be modified, because they always reflect the
current code frequencies and are dynamically updated in MAXQDA.

Insert new document variables in MAXQDA project – If this option is selected, variables whose
names do not yet exist in the MAXQDA project will be inserted, and the variable values of the
individual documents will be transferred.

Hint: If a variable from Stats has the same name as a document variable that already exists in the
MAXQDA project but is a different variable type, it will be inserted into the MAXQDA project as a new
variable with a suffix. For example, if a numerical variable with the name “Education” is transferred
to the MAXQDA project, in which a text variable also entitled “Education” already exists, a new
variable with the name “Education (2)” will be inserted.
Transfer document sets to a MAXQDA project

In the MAXQDA Stats interactive results tables, it is possible to create a document set that contains
exactly the documents represented by a cell or a row. MAXQDA Stats remembers all of the
document sets created over the course of the analysis and lists them in the lower pane of the dialog
box displayed above when you close MAXQDA Stats. You can individually select whether each
document set should be inserted into the MAXQDA project.
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For example, in the image below the set “Marital Status * Age Group (married * 20-29)” was created
in a crosstab and contains exactly 8 documents that come from married respondents aged between
20-29 years. After the transfer of the Stats data to the MAXQDA project, all selected document sets
will appear in the “Document System” window.

Inserted document sets in the “Document System” window of a MAXQDA project

Save variables and code frequencies as SPSS data

Even when MAXQDA Stats is launched with the data from a MAXQDA project, the data matrix
including the variable definitions can be saved in SPSS format, which can be read by many statistical
packages:

Select the menu function File > Save as and choose a filename and location in the dialog box1.
that appears.
MAXQDA Stats will ask if you also wish to export the codes to SPSS. If you answer yes, each2.
code that is available for analysis in the selection windows in MAXQDA Stats will be exported
as its own variable. The values of these variables correspond to the occurrence of the codes
in the relevant documents.

Hint: Existing SPSS files cannot be overwritten, only saved under a new filename.

When exporting data to SPSS the following should be taken into consideration:

Spaces and certain characters are permitted in MAXQDA but not in SPSS. In order to be SPSS
compliant, variable names will be processed as follows:

Variable Name Adaptation

Blank space Will be replaced with underscore_

Begins with # # will be replaced with HASH

Begins with $ $ will be replaced with DOLLAR

Is too long Will be shortened

Is a reserved word _MQ will be attached as suffix

Begins with an invalid character Character will be replaced with an x

Forbidden character Will be replaced with a full stop, blank spaces with an
underscore; if at end will be cut off

In order for the variable name to remain identifiable following the adaptation, a number may
be added at the end.
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For text variables, missing values will be exported only if none of the variable values is longer
than 8 bytes, otherwise SPSS will not accept any missing values for text variables.

Work with External Data in SPSS or Excel
Format - Open SPSS data
Tip: Stats is a MAXQDA Analytics Pro module and cannot be purchased separately. Therefore, it can
only be used via an existing MAXQDA Analytics Pro license and activated through its corresponding
serial number. If you already have a MAXQDA Analytics Pro license, Stats is a tab on the main ribbon
menu.

To open and analyze an SPSS file with MAXQDA Stats, proceed as follows:

If MAXQDA Stats has not yet been launched, select the entry Stats > Start with External File in
MAXQDA's main ribbon menu. Then, select the appropriate file in the window that appears.
If MAXQDA Stats has already been launched, the external file can be selected directly from
the main menu using the function File > Open External File. In MAXQDA Stats, only one
dataset can be open at a time, so Stats will ask if you would like to save the file that is already
open or transfer it to MAXQDA, as the data matrix will no longer be available once the external
file is open.

When the external file is open, all Stats analysis functions are available.

Hint: “Text” type variables in MAXQDA Stats can only contain 63 characters. The content of string
variables longer than 63 characters will be truncated upon import.

Open an Excel file

MAXQDA Stats can read Excel files of the following structure, which corresponds to that of the Data
Editor: the column headers contain the variable names, and the cases form the rows:

ID Level of education Years of age Profession

1 low 26 Seamstress

2 high 33 Hairdresser

3 medium 32 Mechatronics engineer

4 medium 25 Graphic designer

… … … …

The first column (ID) is not required, but it is recommended to include a unique identification in the
dataset in order to be able to definitively match the cases, especially if the data will later be analyzed
in another program.

Opening an Excel file is done in the same way as described above for SPSS files, via the MAXQDA
main menu function Stats or directly in MAXQDA Stats using the File function. As no information on
the variable type is contained in the Excel file, a dialog box will appear in Stats following the

“https://www.maxqda.com/products/maxqda-analytics-pro”
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selection of the Excel file, in which the variable type can be defined.

Dialog box for specifying variable types upon import of an Excel file

Indicate which of the detected variables you wish to import by checking the boxes in the first
column. In the “Variable type” column, define the variable types. The data pattern can be used as a
helpful indication.

Hint: Columns with an empty heading will be ignored and are not listed in the dialog window.

After clicking Import the Excel file will be read and all Stats analysis functions will be available.

Hint: Upon import, variable names will be truncated to a maximum of 63 characters. Columns with
variable names that already exist will be ignored upon import.

Naturally, no information on missing values or value labels will be imported, because this type of
information is not included in the Excel file. The measurement level will be set according to the
variable type: integer, decimal and date variables will be set at “interval”, whereas text and Boolean
variables will be set at “nominal”.

Create new external file

In MAXQDA Stats, you can create new external data and store it in SPSS format, for example, results
from a survey can be inputted and evaluated directly in MAXQDA Stats.

If MAXQDA Stats has not yet been launched, select Stats > Start with New External File from
MAXQDA's main ribbon menu.
If MAXQDA Stats has already been launched, create a new file directly from the main menu by
selecting File > New External File. In MAXQDA Stats only one dataset can be open at a time,
so Stats will ask if you would like to save the file that is already open or transfer it to
MAXQDA, as the data matrix will no longer be available once the external file is open.

MAXQDA Stats will open directly with an empty Variable List, in which you can insert new variables
and subsequently enter values in the Data Editor.
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Save external data in SPSS format

To save a currently open file as an SPSS file (which can be read by several statistical packages),
proceed as follows:

Select the menu function File > Save As then, in the window that appears, specify a filename1.
and location for the SPSS file.
MAXQDA Stats will ask if you also wish to export the codes to SPSS. If you answer yes, each2.
code that is available for analysis in the selection window in MAXQDA Stats will be exported
as its own variable. The values of these variables correspond to the occurrence of the codes
in the relevant documents.

Hint: Existing files cannot be overwritten, only saved with a new filename. This means each time you
save your data a new file will be created.

When exporting data to SPSS, the following should be taken into consideration:

Spaces and certain characters are permitted in MAXQDA but not in SPSS. In order to be SPSS
compliant, variable names will be processed as follows:

Variable Name Adaptation

Blank space Will be replaced with underscore_

Begins with # # will be replaced with HASH

Begins with $ $ will be replaced with DOLLAR

Is too long Will be shortened

Is a reserved word _MQ will be attached as suffix

Begins with an invalid character Character will be replaced with an x

Forbidden character Will be replaced with a full stop, blank spaces with an
underscore; if at end will be cut off

In order for the variable name to remain identifiable following the adaptation, a number may
be added at the end.
For text variables, missing values will be exported only if none of the variable values is longer
than 8 bytes, otherwise SPSS will not accept any missing values for text variables.

Transform Data
Tip: Stats is a MAXQDA Analytics Pro module and cannot be purchased separately. Therefore, it can
only be used via an existing MAXQDA Analytics Pro license and activated through its corresponding
serial number. If you already have a MAXQDA Analytics Pro license, Stats is a tab on the main ribbon
menu.

https://www.maxqda.com/products/maxqda-analytics-pro
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Compute Variables

With MAXQDA Stats you can perform calculations with selected variables and codes and store the
result in a new variable. To begin the calculation, select the function Transform > Compute Variable
from the Stats main menu. The following window will appear:

Window for calculation of new variables

When calculating variables, proceed as follows:

In the upper pane of the window, assign a new variable name and a label if required. If the1.
variable name already exists, MAXQDA will indicate it in red. The newly created variable will
automatically be assigned the type “Floating”.
In the lower pane “Numerical expression”, assign an evaluation instruction. If the input cannot2.
be evaluated, for example because a bracket or a summand is missing, MAXQDA will indicate
so in blue as displayed in the screenshot.

In the “Variable” section, all “Integer” and “Decimal” type variables are listed. All variables are
numbered consecutively from “V1” to “Vn”, with the variable name (or the label if present) enclosed
in square brackets. When proceeding with the calculation, the identifier must be inputted as
displayed in the screenshot above.
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If you are working with a MAXQDA project in Stats, a “Codes” tab is also displayed. All codes are
numbered consecutively with “C1” to “Cn” and can also be integrated into the calculations.

Tip: Double-clicking a variable or code will insert it into the current cursor position, so they do not
need to be entered manually.

In the right-hand pane, “Functions”, frequently used functions including the applied syntax are listed.
Click the function buttons to insert the function in the calculation pane.

Function Meaning

+  -  *  / Add, subtract, multiply, divide

^ Exponent, for example “V1^2” is the variable “V1” squared

avg(a, b, …) Arithmetic mean of all variables or arithmetic expressions enclosed in the
parentheses (separated by commas). Any number of variables or arithmetic
expressions can be enclosed in the parentheses.

sum(a, b, …) Sum of all variables or arithmetic expressions enclosed in the parentheses
(separated by commas). Any number of variables or arithmetic expressions
can be enclosed in the parentheses.

sqrt(a) Root of the expression in parentheses

round(a) The arithmetic expression in parentheses will be rounded to the next whole
number

roundn(a,
decimals)

The arithmetic expression in parentheses will be rounded to the specified
number of decimal places

When you click OK, the new variable will be calculated and displayed in the Data Editor.

Hint: If one of the variable values in the calculation instruction is empty or defined as missing, a
system-defined missing value will be entered for the result, and the cell will remain empty.

You can also include if-then conditions in the calculation. The following examples illustrate the
syntax to be used:

if (V1 > V2) {

V1

}

else {

V2

}

Alternative syntax:

if (V1 > V2)
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V1;

else

V2

Recode variables

Often when working with datasets there is the desire to recode variables; for example, to reverse the
polarity of an item or group multiple variables as a single variable, summarized as, for example,
differentiated collected information on schooling for three levels of education. MAXQDA Stats
allows recoding of multiple variables or variable values at a time.

Recode into new variable

Normally variable values are recoded as new variables so that the original value will not be affected.
Proceed as follows:

Begin the recoding process from the menu function Transform > Recode into new variable.1.

The following window will appear:2.

In the left hand pane, select the variables that you wish to recode. Double-click the desired3.
variable to transfer it to the right-hand pane. Multiple variables can be transferred at a time by
holding the Ctrl/cmd key as the variables are selected, then moving them to the right pane
with the mouse or by using the blue arrow in the center of the window.
For the new variable name, MAXQDA Stats automatically suggests the original name4.
supplemented with a number after a hashtag #. You can modify the name by editing it in the
cell.
When you click OK, a dialog box will appear for the input of the modified values:5.
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Dialog box for input of values to be recoded

In the “Old value” column, enter the original value and in the “New value” column, enter the
target value to be recoded. The image above shows a classic example: the value of the items
is reversed, so that the lowest value of 1 becomes the highest value of 4, and vice versa.

Using the selection list in the first column, you can specify a range of values to which a single
new value will be assigned. In the selection list, the operators greater than (>); less than (<);
greater than or equal to (≥); or lesser than or equal to (≤) are available. Using the following
rows, a variable with a value of 3 can for example be dichotomized, so that in the new variable
0 is displayed for values under 3, and 1 is displayed for values over 3:

The button Insert all existing values lists the occurring values for all selected variables, which
is especially practical when all values of a variable will be recoded and you wish to
immediately begin entering the new values.

The

 and

 symbols allow you to delete individual or all rows.

When you click OK the new variable will be inserted and displayed in the Data Editor. The6.
variable label will appear as the original supplemented with the suffix “recoded” so the
recoded variable can be easily recognized. If no label is present, the variable name is used as
a label to which “recoded” is added.

MAXQDA Stats proceeds specifically as follows when recoding:

In case of conflict of the attribution, the lower listed attribution will be applied. For example, if
the first row states “1 to 4” and the second row states “>0 to 3”, 1 will be recoded as 3 and not
4.
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If no new value is specified for an existing value, the old value will be retained.
Value labels will not be transferred to the new variable, but the definitions for missing values.

Recode code frequencies per document as new variables

With MAXQDA Stats, you can not only recode variables, but also the code frequencies that were
transferred from a MAXQDA project to MAXQDA Stats. If you launched MAXQDA Stats with the data
from a MAXQDA project, click the “Code” tab in the dialog box to select individual codes from the
familiar code tree.

To recode a code as a new variable, double-click the code or drag it into the right pane of the window
using the mouse. You can also use the blue arrow to transfer codes to the right pane.

Select codes that you want to recode as new variables

Assuming that you are only interested in whether or not a code has been assigned in a document,
the exact number of code frequencies is not relevant, but only whether 0 or a higher number is
displayed. In this case the code can be recoded in a single row and stored as a new variable:

Recoding into the same variable

Recoding into the same variable is performed in the same way as recoding into a new variable, from
the menu Transform > Recode into Same Variable. However, for this procedure only variables, not
codes, can be selected, and naturally the definition of a new variable name is omitted.

Frequency Tables
Tip: Stats is a MAXQDA Analytics Pro module and cannot be purchased separately. Therefore, it can
only be used via an existing MAXQDA Analytics Pro license and activated through its corresponding
serial number. If you already have a MAXQDA Analytics Pro license, Stats is a tab on the main ribbon
menu.

To create a new frequency table, proceed as follows:

“https://www.maxqda.com/products/maxqda-analytics-pro”
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1. Select the menu function Descriptive Statistics > Frequencies.

2. In the window that appears, select the variables for which you would like to create frequency
tables:
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Select variables for frequency analysis

Variables can be selected in several ways:

Double-click on a variable.
Drag and drop the variable into the right window pane.
Select one or multiple variables with the mouse by holding the Ctrl/⌘ key then drag the
selection into the right window pane with the mouse, or click the blue arrow in the middle of
the window.

3. Switch to the “Codes” tab and select the codes for which you would like to create frequency
tables. (This function is available only when MAXQDA Stats is launched from a MAXQDA project).
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Select codes for frequency analysis

If you have selected at least one code, you can specify further options below:

Binarize all codes – All code frequencies greater than 1 are set to 1, i.e. the code frequency per
document is not evaluated, but only whether a code occurs in a document or not.

Sum up frequencies of subcodes – For parent codes, the frequencies of all subcodes available in
the Stats dialogue are added to the code frequency. If the option Binarize subcodes is also selected,
the summation only takes into account whether the code was assigned to a document (the
frequency of a subcode is set to “1”) or not (the frequency of a subcode is set to “0”). When
combining both options, the sum of the subcodes indicates how many subcodes were coded for a
document.

When you click OK, MAXQDA Stats creates a frequency table and displays it in a results view.

Please note: If you have selected option Exclude cases listwise, cases with valid values in all
selected variables are analyzed only.
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Opening frequency tables from the Data Editor

You can also open a frequency table for individual variables directly from the Data Editor. To do this,
right-click on a column heading and select the entry Frequency Table.

Opening frequency tables from the Data Editor

Results table
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Results table for frequency

The frequency table displays how many times the individual variables occur. For the variable “Job
Security Scale”, the value “low” was assigned in 22 cases, and the value “high” in 20 cases. The
lower section of the table shows system-defined missing values (blank cells) as well as defined
missing values; in the example above, the value “-9” is assigned to 3 cases.

Hint: If a value is defined in the individual missing values as well as in a range of missing values, it
will be calculated only as an individual missing value. For example, if “99” is defined as missing and
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also “50 to 100”, “99” will be included in its own row and excluded from the range “50 to 100.“

Overview of toolbar functions

In the upper section of the results window two toolbars are located, which contain the following
important functions:

 Table view / Chart view – switches between table and chart view.

 Previous/Next – using the blue arrow or the selection
list, switch between the results for the analyzed selected variables or codes.

 Refresh – Calls up again the dialog for creation of frequency tables.

 Insert into output viewer – inserts the currently displayed table or chart in the Output Viewer.

 Send to QTT worksheet – inserts the current view into a new or an existing QTT worksheet.

 Insert all into output viewer – inserts all created tables or charts in the Output Viewer.

 Copy – copies the current table, highlighted area in the table, or chart, for example for insertion
into Word.

 Print – prints the currently displayed table or chart.

 Export – exports the currently displayed table in Excel format, website (HTML) format or RTF
format for Word and other word processing programs; exports the currently displayed chart in PNG,
SVG or EMF (only Windows) format.

 Show value labels – this option is selected by default and causes the defined value label of a
variable to be displayed in the place of the value of the variable.

 Descriptive statistics – this option is available only for integer and decimal type variables as
well as for codes and displays a window with descriptive statistics for the displayed frequency
tables.

 Undo changes – step-by-step resetting of changes to a table (deletion of rows, merging and
moving of rows).

 Redo – step-by-step restoring of changes to a table.

Sort tables and customize columns

Tables can be sorted by clicking a column header, in ascending order with the first click and
descending order with the second. Clicking again will restore the original order.

Tip: You can also move the rows of the results table. Click a row, then drag and drop with the mouse
to the desired location. This function is also available for multiple highlighted rows. Lines containing
totals or missing values cannot be moved.
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Column widths can be adjusted with the mouse, and their position can be changed by clicking the
column header then dragging them to the desired location with the mouse.

Delete rows

The results table is interactive and one or more rows can be removed, for example to restrict the
evaluation to selected variables. Right-click a row and select Delete. You can also select multiple
rows to delete by holding down the Ctrl/cmd key.

In this way, you can also remove the missing values from the display:

Delete rows from the results table using the context menu

The table will be automatically updated.

Tip: A column can be hidden from the table by right-clicking within the column header and selecting
Hide column. When the frequency function is called up the next time, the column will be
automatically displayed again.

Merge values

The interactive results table also allows you to merge multiple values:

Highlight at least two rows by holding down the Ctrl/cmd key as you click on the desired rows1.
with the mouse.
Right-click the selection and select Merge values.2.

Merge multiple values using the context menu

The table will be automatically updated.

Save documents as document set

If MAXQDA Stats is launched with the data from a MAXQDA project, the frequency of individual
variable values corresponds to the number of documents in which these variable values occurred. In
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this case, a compilation of documents is present behind each frequency count. This compilation of
documents can be saved as a document set in MAXQDA: Right-click on a row and select Save as
document set.

Store documents that are attached to a variable value as a document set in MAXQDA

Initially, MAXQDA stores such sets in the background. When you exit Stats, all document sets
created during the analysis will be displayed, so you can select which document sets you wish to
transfer to the MAXQDA project.
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Select document sets upon exiting MAXQDA Stats

Tip: The number of saved document sets in MAXQDA Stats is always displayed in Stats status bar.
Simply click on the information in the status bar to open a new window, in which you can view or
delete the saved document sets.

Use results table to filter cases in the Data Editor

You can use the results in a frequency table to filter cases in the Data Editor. To do this, right-click
on a row and select Use as Filter in Data Editor in the menu that appears:
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Calling the filter function via right click

As a result, only the cases that have the value of the selected row are displayed in the Data Editor.
For this purpose, MAXQDA creates a new variable "StatsFilter", sets the value 1 for all associated
cases and switches on the filter in the Data Editor for this variable.

Tip: This function is particularly helpful for mixed methods analysis in order to perform in-depth
analysis of cases with particularly high, low, or eye-catching values. If you call up analysis functions
while the filter is applied to the Data Editor, only the currently displayed cases, i.e. only the filtered
cases, will be taken into account.

To switch the currently set filter on and off, click on the Filter  icon in the toolbar above the Data
Editor. To delete all filters, click on the  icon.

Calculate descriptive statistics for frequency tables

In all frequency tables for integer or decimal variables as well as for codes, the mean and standard
deviation is displayed at the top of the results window. When you click the

 Descriptive Statisticssymbol, the following window will appear, which contains additional measures
for descriptive statistics.
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Descriptive Statistics for a variable

When you click the Copy button, the table will be transferred to the clipboard for insertion into
programs such as Word.

Transfer results table to Output Viewer

After the tables have been created and adapted according to your needs, they can be transferred to
the Output Viewer from which they can later be exported together:

Click the Insert into output viewer  icon to transfer the currently displayed results table to
the Output Viewer.
Click the Insert all result tables into output viewer  icon to transfer all frequency tables to
the Output Viewer.

If at least one of the tables was created for an integer or decimal variable or a code, MAXQDA Stats
will ask if you also wish to insert the descriptive statistics into the Output Viewer. If you agree, a
table containing the descriptive statistics will be displayed below the results table.

Tip: When the table is transferred, the adjusted column widths will be maintained.
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Frequency table in the Output Viewer following transfer

Transfer results to Questions – Themes – Theories

In the Questions – Themes – Theories window, you can collect and comment on all the important
results of your project. Click the Send to QTT Worksheet icon in the upper right corner to save the
current view in a new or existing worksheet.

Once you close MAXQDA Stats, you can access all your QTT worksheets via Analysis > Questions –
Themes – Theories.

Export and print results table

Several options for exporting and printing the currently displayed results table are available using the
following symbols:

 Copy – copies the entire table or selection to the clipboard, for example in order to paste it
directly into Word.

 Print – starts the print process and displays a print preview, in which the settings such as
margins, orientation, headers and footers can be applied.

 Export – exports the table in Excel format, website (HTML) format or RTF format for Word and

https://www.maxqda.com/de/hilfe-mx22/19-questions-themes-theories-q-t-t/die-idee-hinter-questions-themes-theories
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other word processing programs.

Display frequencies as charts

Frequency tables can be displayed as column, bar, or pie charts. You can switch between chart and
table views using the

 and

 icons.

Frequency chart

You can customize the chart design and display by using the icons in the toolbar above the chart, as
well as double-clicking and right-clicking on the elements of the chart. The size of the chart
automatically adjusts to the window size. Enlarge the window to get a larger chart.

Hint: At maximum, the first 20 entries of the frequency table will be displayed in the chart.

Frequency charts can be transferred to the Output Viewer for storage and later export, or they can be
transferred to a QTT worksheet. To do this, click on the corresponding icons in the top right corner
of the toolbar:

 Insert into Output Viewer and Send to QTT Worksheet.

Hint: Charts will be inserted into the Output Viewer in the size that they are displayed, to a maximum
width of 650 pixels.

To export or print a chart directly, you can use the usual icons in the top right of the window:

 Copy,  Print and  Export.
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Analyze Multiple Responses
Many surveys contain questions of the following type: 

How did you find out about MAXQDA? (Multiple answers possible)

▢ Conference

▢ Colleagues

▢ Web search

▢ Other

Usually, a separate variable is created for each answer option, that is, in this example there are four
variables, each indicating whether the respondent has ticked the answer option or not. The individual
variables can be evaluated using the Stats function Descriptive Statistics > Frequencies, but it is
usually better to analyze the questions as a whole and display them in a diagram.

To do this, you must first “tell” MAXQDA Stats which answers belong together by defining multiple
response sets.

Defining Multiple Response Sets

Call Descriptive Statistics > Define Multiple Response Sets. 1.
Click the icon with the green plus sign to create a new set.2.
Assign a name for the set in the "Multiple response set" column.3.
Drag all the variables belonging to the set into the row with the mouse.4.
At the bottom, enter the value that should be counted for each variable, i.e. the value that5.
indicates whether a check mark has been set for a question. In most cases, this is the value
“1”, “True”, or “Yes”. Please note that the value applies to all created sets.

Define multiple response sets



  536

If you are working with data from a MAXQDA project, the sets will be saved in the project and you
can also create a set that consists of codes rather than variables (variables and codes cannot be
mixed).

If you work with external data, for example, from SPSS, you can also create multiple response sets,
but these are not saved and are only available while the file is open.

Create Frequency Tables

Once you have created a multiple response set, you can request a frequency analysis for them
via Descriptive Statistics > Frequencies</strong >. In the options dialog, the sets are available on a
separate tab and can be selected for analysis:

Select multiple response sets for frequency table

The Exclude cases listwise option ensures that only cases are analyzed that have a valid value for
all analyzed variables (from all selected sets).

The results table has the following structure:

 Frequency Percent responses Percent cases

Conference 57 32,4 63,3

Colleagues 49 27,8 54,4

Web search 64 36,4 71,1

Other 6 3,4 6,7
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TOTAL 176 100,0 195,6

TOTAL CASES 90   

MISSING CASES 1   

 

Three numbers are presented for each answer (that is, each variable in the set):

Frequency – How many times the answer was selected (number of counted value in variable).
Percent Responses – Frequency relative to all analyzed responses
Percent Cases – Frequency relative to cases

Please note: The table is automatically sorted according to the order of the variables in the set. By
clicking on the column headers, the sorting can be adjusted, usually a descending sorting by
frequency is suitable.

As in frequency tables for single variables or codes, several rows with responses can be selected
and combined by right-clicking; the filter function for the Data Editor and saving the documents as a
document set are also available by right-clicking (see sections “Combining values” and “Saving
documents as a document set” in the chapter Frequency Tables).

However, individual rows cannot be deleted.

By clicking on the diagram symbol, the answers can be displayed as a horizontal or vertical bar
chart. The percentages of the cases are visualized.

Create crosstabs

Once you have created multiple response sets, you can request a breakdown by variable or code for
them via Compare Groups > Crosstabs</strong >. In the options dialog, the sets are available on
their own tab and can be selected for display in the rows.

The crosstab looks like this:

Crosstab for multiple response set

https://www.maxqda.com/help-mx24-stats/frequency-tables
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In the two drop-down menus, you can select which values to show in the table.

For the grouped bar chart, which can be called up by switching to the chart view, the “Column
percentages (cases)” are used.

Find out more about working with crosstabs in MAXQDA Stats.

Analyze Matrix Questions
In many surveys there are questions of the following type, in which respondents are asked to rate
statements in a matrix-like representation:

How often do you use the following MAXQDA functions?

 never
0 1 2

often
3

Transcription ◯ ◯ ◯ ◯

Memos ◯ ◯ ◯ ◯

Variables ◯ ◯ ◯ ◯

QTT ◯ ◯ ◯ ◯

MAXMaps ◯ ◯ ◯ ◯

MAXDictio ◯ ◯ ◯ ◯

Stats ◯ ◯ ◯ ◯

Usually, each item is represented by a separate variable that indicates which answer option the
respondent chose. The individual variables can be analyzed using the Stats function Descriptive
Statistics > Frequencies, but it is usually better to present the results in a combined table or chart.

To do this, you must first “tell” MAXQDA Stats which items belong together by defining matrix
question sets.

Define Matrix Question Sets

Call Descriptive Statistics > Define Matrix Question Sets.1.
Click on the icon with the green plus sign to create a new set.2.
Assign a name for the set in the “Matrix question set” column.3.
Drag all variables belonging to the set into the new row on the right side.4.

https://www.maxqda.com/help-mx24/stats/crosstabs
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Define matrix question sets

If you are working with data from a MAXQDA project, the sets will be saved in the project and you
can also create a set that consists of codes rather than variables (variables and codes cannot be
mixed).

If you work with external data, for example, from SPSS, you can also create multiple response sets,
but these are not saved and are only available while the file is open.

Create Frequency Tables

Once you have created a matrix question set, you can request a frequency analysis for them
via Descriptive Statistics > Frequencies. In the options dialog, the sets are available on a separate
tab and can be selected for analysis:

Select matrix question sets for frequency table

The Exclude cases listwise option ensures that only cases are analyzed that have a valid value for
all analyzed variables (from all selected sets).
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The results table looks as follows:

Frequency table for a matrix question set

For each variable of the set, the frequencies per response option are presented, supplemented by
the mean, the standard deviation, and the number of valid and missing cases.

Using the drop-down menu at the top, you can set whether the absolute, relative or both frequencies
should be presented.

Note: The table is automatically sorted according to the order of the variables in the set. By clicking
on the column headers, the sorting can be adjusted, usually a descending sorting by mean is
suitable.

By right-clicking on a row, it can be removed from the view. Multiple rows cannot be merged (this
would make no sense in this context).

By right-clicking in a cell with document frequencies, the filter function for the data editor and saving
as a document set are available (see section “Saving documents as a document set” in
chapter Frequency tables).

By clicking on the chart icon, the responses can be displayed as a stacked bar chart.

Descriptive Statistics
Tip: Stats is a MAXQDA Analytics Pro module and cannot be purchased separately. Therefore, it can
only be used via an existing MAXQDA Analytics Pro license and activated through its corresponding
serial number. If you already have a MAXQDA Analytics Pro license, Stats is a tab on the main ribbon
menu.

With MAXQDA Stats you can calculate various measures of descriptive statistics for several
variables and codes simultaneously, and you can compare results in an easy-to-read table. Begin the
evaluation using the Descriptive Statistic > Descriptive Statistics menu. The following window will
appear, where you can select all the desired variables and codes. In the window, only integer or
decimal variables will be displayed:

https://www.maxqda.com/products/maxqda-analytics-pro
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Select codes, variables and options for Descriptive Statistics

Variables can be selected in several ways:

Double-click on a variable.
Drag and drop the variable into the right window pane.
Select one or multiple variables with the mouse by holding the Ctrl/Cmd key then drag the
selection into the right window pane with the mouse, or click the blue arrow in the middle of
the window.

To generate descriptive statistics for code frequencies per document, switch to the “Codes” tab and
select the desired codes. (This option is available only if MAXQDA Stats was launched with the data
of a MAXQDA project).

If you want the output to be separated by groups, you can drag a variable or a code into the Split by
variable/code field. MAXQDA will then calculate the descriptive statistics for the entire group as well
as for each individual subgroup.

In the right pane of the window you can select typical metrics and values for the descriptive
statistics, some of which require further explanation:

1st and 3rd Quartile – The first quartile corresponds to the 25th percentile and indicates the value
below which 25 % of all values fall. Accordingly, 25% of all values are greater than the value of the
third quartile, that is the 75th percentile. There are various methods to determine the percentile of a
distribution of measured values. A review of nine different methods can be found in Hyndman & Fan
(1996): “Sample quantiles in statistical packages”. In MAXQDA Stats method no. 7 is implemented,
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which is also the default method used by “r”.

Standard deviation (sample) vs. (population) – for the standard deviation of population the
unbiased estimator is calculated by dividing the sum of squares by (n - 1), while selecting “sample”
the sum is divided by n. The same applies to the calculation of the variance.

Mean error – the standard error of the mean value is output, which is estimated from the random
sample. When several samples are taken from a population, the means of these samples scatter
around the true mean of the population. This scattering is called mean error.

95% confidence interval for mean – Using the mean error, the limits of the interval are calculated
and displayed, which represent a 95% probability of the population mean.

In the lower section of the window, the following options are available:

Exclude cases listwise – select this option to include only cases for which all selected variables
have a valid value.

Save standardized z-values in new variables – Check this option to perform a z-standardization of
values for all selected variables and codes, and store the results in the new variables. The original
variable name is used, supplemented by the suffix "_zvalues”. Existing variable labels are also used
and supplemented by the suffix (z-standardized). If no variable label was present, the variable name
is entered as a label.

Hint: For calculation of z-values the standard deviation (population) with denominator (n–1) is used.

If you have selected at least one code, you can specify additional options below:

Binarize split code – The splitting of the results is done in two groups; on the one hand for the
documents where the splitting code was assigned at least once and on the other hand for the
documents where the code does not occur.

Sum up frequencies of subcodes – For parent codes, the frequencies of all subcodes available in
the Stats dialogue are added to the code frequency. If the option Binarize subcodes is also selected,
the summation only takes into account whether the code was assigned to a document (the
frequency of a subcode is set to “1”) or not (the frequency of a subcode is set to “0”). When
combining both options, the sum of the subcodes indicates how many subcodes were coded for a
document.

Results table

After beginning the evaluation by clicking OK the following results table appears, in which the
selected variables and codes form the rows and the selected measures form the columns:
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Results table for Descriptive Statistics

The results table always contains the column “N” with the number of valid cases (far left) and the
column “Missing” and “Missing (%)” (far right), which provide information on the absolute and
relative proportion of missing values for each variable.

Sort tables and customize columns

Tables can be sorted by clicking a column header, in ascending order with the first click and
descending order with the second. Clicking again will restore the original order.

Tip: You can also move individual results rows. To do this, click on a row and move the row up or
down while holding down the mouse button. This technique also works for multiple rows selected at
the same time.

Column widths can be adjusted with the mouse, and their position can be changed by clicking the
column header then dragging them to the desired location with the mouse.

Delete rows (variables or codes)

The results table is interactive and one or more rows (variables) can be removed. Right-click a row
and select Delete. You can also select multiple rows to delete by holding down the Ctrl/⌘ key. When
a variable is deleted from the table the table will not be recalculated, even if the Exclude cases
listwise option was selected and the number of the valid values would change.

Tip: Columns can be hidden from the table, by right-clicking on the column header and selecting the
Hide Column option. The next time the function is called up, the column will automatically be
displayed.

Transfer results table to the Output Viewer

Once the tables have been created and adapted according to your needs, they can be transferred to
the Output Viewer by clicking the Insert into Output Viewer

 icon, which allows the tables to later be exported along with other results.
Tip: Upon transfer, modifications to column width will be maintained.
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Results table following transfer to the Output Viewer

Transfer results to Questions – Themes – Theories

In the Questions – Themes – Theories window, you can collect and comment on all the important
results of your project. Click the Send to QTT Worksheet icon in the upper right corner to save the
current view in a new or existing worksheet.

Once you close MAXQDA Stats, you can access all your QTT worksheets via Analysis > Questions –
Themes – Theories.

Export and print results table

Several options for exporting and printing the currently displayed results table are available using the
following symbols:

Copy – copies the entire table or selection to the clipboard, for example in order to paste it
directly into Word.

Print – starts the print process and displays a print preview, in which the settings such as
margins, orientation, headers and footers can be applied.

Export – exports the table in Excel format, website (HTML) format or RTF format for Word and
other word processing programs.

Display results as a box plot or histogram

You can display the distribution of an evaluated variable or code as a box plot or histogram. Using
the symbols

and

you can switch between the chart view and the table view. As soon as the chart is visible, you can
choose between box plot and histogram.

In the boxplot as well as in the histogram, the result of a Shapiro-Wilk test for normal distribution is

https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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displayed in the upper right corner.

Box plot of an analyzed variable

The box plot is generated according to the following rules:

The vertical line in the box indicates the median.
The boundaries of the box correspond to the 1st and 3rd quartiles.
The arms ("whiskers") reach up to the highest or lowest data value, which is a maximum of
1.5 interquartile distances from the edges of the box.
All data outside the whiskers are marked with a circle as an outlier.

The boxplot is interactive:

If you hold the mouse pointer over an outlier (that is, a circle), the case number and the case’s
value for the variable or code are displayed.
If you right-click on an outlier, a context menu appears with the following options: (1) remove
the case from the graph and the calculation, (2) filter the Data Editor so that only this case is
displayed, and – if you are working with a MAXQDA project – save the case in a document set
for MAXQDA.

Tip: If a variable or code has been selected to split the results, MAXQDA displays several vertical
boxplots side by side to compare the distributions; one boxplot for the total group and one boxplot
for each subgroup.

You can change the display from a  box plot to a  histogram by clicking on the corresponding
icons in the upper right-hand corner:
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Histogram of an analyzed variable

MAXQDA calculates the initial number of classes used according to the Rice Rule: Round up
(2n^(1/3)). For integer variables, empty classes may not be displayed at the end of the distribution.
You can adjust the number of classes for the currently displayed histogram at any time in the
number field above the chart.

You can use the icons in the toolbar above the chart to display or hide titles and subtitles and to set
the color. With histograms, the data label above the columns can also be switched on and changed
from absolute to relative values.

The size of the diagram automatically adjusts to the window size. Enlarge the window to obtain a
larger diagram.

Exporting charts

Box plots and histograms can be transferred to the Output Viewer for storage and later export, or
they can be transferred to a QTT worksheet. To do this, click on the corresponding icons in the top
right corner of the toolbar:

 Insert into Output Viewer and Send to QTT Worksheet.

Please note: The chart is inserted into the output viewer as it is displayed, but not wider than 650
pixels.

To export or print a chart directly, the usual symbols are available in the upper right-hand corner of
the window:

Copy,

Print,
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Export.

Crosstabs
Tip: Stats is a MAXQDA Analytics Pro module and cannot be purchased separately. Therefore, it can
only be used via an existing MAXQDA Analytics Pro license and activated through its corresponding
serial number. If you already have a MAXQDA Analytics Pro license, Stats is a tab on the main ribbon
menu.

In order to create a new crosstab select Compare Groups > Crosstabs in the main menu of MAXQDA
Stats. A window appears that allows you to determine rows and columns for the crosstab.

https://www.maxqda.com/products/maxqda-analytics-pro
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Variable selection for cross tabulation

Variables can be selected in several ways:

Double-click on a variable.
Drag and drop the variable into the right window pane.
Select one or multiple variables with the mouse by holding the Ctrl/Cmd key then drag the
selection into the right window pane with the mouse, or click the blue arrow in the middle of
the window.

To integrate code frequencies per document in the crosstab, switch to the “Codes” tab and select
the desired codes. (This option is available only if MAXQDA Stats was launched with the data of a
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MAXQDA project).

In the lower section of the window, the following options are available:

Exclude cases listwise – Select this option to include only cases for which all selected variables
have a valid value.

Binarize column/row code (only available if at least one code has been selected in the
corresponding field) – All code frequencies greater than 1 are set to 1, i.e. the code frequency per
document is not evaluated, but only whether a code occurs in a document or not.

Sum up frequencies of subcodes (only available if at least one code has been selected in the
corresponding field) – For parent codes, the frequencies of all subcodes available in the Stats
dialogue are added to the code frequency. If the option Binarize subcodes is also selected, the
summation only takes into account whether the code was assigned to a document (the frequency of
a subcode is set to “1”) or not (the frequency of a subcode is set to “0”). When combining both
options, the sum of the subcodes indicates how many subcodes were coded for a document.

Results table

After starting the calculation by clicking OK a crosstab will be computed for each combination of
rows and columns variables/codes. The figure above shows a selection for which four crosstabs will
be created. A results table then appears that allows you to switch between the single crosstabs by
using the blue arrows and the drop-down menu at the top of the window.

Crosstab output example

The number of valid and missing values for the displayed variable combination is shown in the upper
right corner.

Selecting displayed values

If you start the function “crosstabs” the numbers in the cells display the absolute frequencies, thus
the number of cases for each combination of variable values. You can switch the display for the
cells to the following values:

Relative frequencies – percentage based on all valid values
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Row percentage – percentage based on the sum of a row
Column percentages – percentage based on the sum of a column
Expected frequencies – expected frequencies in case of independence of both variables
Residuals – differences between observed absolute frequencies and the expected. In case
of positive residuals more cases occurred than would be expected considering the marginal
distributions.

Standardized residuals – in order to gain a better comparability the residuals are divided by the root
of the expected frequencies. The standardized residuals’ magnitude corresponds to the root of the
particular cell’s Chi-square.

Corrected standardized residuals – the standardized residuals are adjusted on the basis of the
marginal frequencies.

The cells of the crosstab display either one or two of the presented values. Use the drop-down menu
on the top of the chart to select the values you want to display.

Table cell display options dropdown menu

Highlighting cells with high standardized residuals

You can use standardized residuals for the exploratory interpretation of the table. This is possible
because based on the assumption of the independency of the two tabulated variables the
standardized residuals are asymptotically normally distributed. Accordingly, a standardized residual
greater than 2 or less than -2 indicates an unexpected high or low number of observations in the cell.
Values that exceed the magnitude of 2.6 are even less expected.

Click on the icon Highlight cells with high standardized residuals

. Now MAXQDA Stats highlights all cells with a standardized residual greater than 2 in blue and all
cells with values smaller than 2 in red. If there are values whose magnitude is greater than 2.6 the
cells are additionally displayed in a darker colour.
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Crosstab table with highlighted cells for easier interpretations

Overview of toolbar functions

In the upper section of the results window two toolbars are located, which contain the following
important functions:

Previous/Next – using the blue arrow or the selection
list, switch between the created crosstabs table.

Refresh – Recalls the dialog window for creation of crosstabs.

Insert into output viewer – inserts the currently displayed table in the Output Viewer.

Insert all into output viewer – inserts all created tables in the Output Viewer.

Send to QTT Worksheet

Copy – copies the current table or the highlighted area in the table, for example for insertion into
Word.

Print – prints the currently displayed table.

Export – exports the currently displayed table in Excel format, website (HTML) format or RTF
format for Word and other word processing programs; exports the currently displayed chart in PNG,
SVG or EMF (only Windows) format.

Show value labels – this option is selected by default and causes the defined value label of a
variable to be displayed in the place of the value of the variable.

Highlight cells with high standardized residuals – switch on this option to highlight cells, whose
magnitudes of standardized residuals are greater than 2 for easy interpretation of the results.

Association measures – opens a window with association measures for the two variables
displayed in the actual crosstab.
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Undo changes – step-by-step resetting of changes to a table (deletion of rows, merging and
moving of rows).

Redo – step-by-step restoring of changes to a table.

Sort tables and customize columns

Tables can be sorted by clicking a column header, in ascending order with the first click and
descending order with the second. Clicking again will restore the original order.

Tip: You can also move the rows of the results table. Click a row, then drag and drop with the mouse
to the desired location. This function is also available for multiple highlighted rows. Lines containing
totals or missing values cannot be moved.

Column widths can be adjusted with the mouse, and their positions can be changed by clicking the
column header then dragging them to the desired location with the mouse.

Delete rows or columns

The results table is interactive and one or more rows can be removed, for example to restrict the
evaluation to selected variables. Right-click a row and select Delete. You can also select multiple
rows to delete by holding down the Ctrl/cmd key.

Delete a row

To delete a column from the results table, right click on its heading and select Delete.

The table will be automatically updated after deletion of rows or columns.

Merge values

The interactive results table also allows you to merge multiple values:

Highlight at least two rows by holding down the Ctrl/cmd key as you click on the desired rows1.
with the mouse.
Right-click the selection and select Merge values.2.

In the following example, the two values “married” and “partner” are merged:
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Merge values

Columns can be merged, too:

Right-click on a column heading and select Merge values.1.
A popup menu appears containing all other columns of the crosstab. Click on one of the2.
displayed columns to merge it with the right-clicked column.

The table will be automatically updated after merging columns or rows.

Save compilations of documents as document sets

If MAXQDA Stats was started with the data of a MAXQDA project, the frequencies for the individual
variable values correspond to the number of documents for which this variable value was assigned.
Thus, each frequency number represents a collection of documents. This collection can be saved as
a document set for the MAXQDA project: Right-click on a cell and select Save as document set.

Save documents with a specific combination of variable values as a document set

MAXQDA Stats saves such new sets temporarily in the background. When you quit Stats, all
document sets formed during the analysis are displayed so that you can select which document
sets are to be transferred to the MAXQDA project.
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Save document sets when quitting MAXQDA Stats

Tip: In the MAXQDA Stats status bar, you can see the number of document sets currently saved in
Stats at any time. Clicking on the information in the status bar opens a window in which you can
view and delete the saved document sets.

Use results to filter cases in Data Editor

You can use the results in a frequency table to filter cases in the Data Editor. To do this, right-click
on a cell and select Use as Filter in Data Editor in the menu that appears:

Use as filter in data editor

As a result, only the cases that have the value of the selected row and column are displayed in the
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Data Editor. For this purpose, MAXQDA creates a new variable "StatsFilter", sets the value 1 for all
associated cases and switches on the filter in the Data Editor for this variable.

Filtered cases in the Data Editor

Tip: This function is particularly helpful for mixed methods analysis in order to perform in-depth
analysis of cases with particularly high, low, or eye-catching values. If you call up analysis functions
while the filter is applied to the Data Editor, only the currently displayed cases, i.e. only the filtered
cases, will be taken into account.

To switch the currently set filter on and off, click on the Filter  icon in the toolbar above the Data
Editor. To delete all filters, click on the  icon.

Calculating measures of association for crosstabs

In order to calculate measures of association and Chi-square values for a crosstab, click the icon
Association measures

 in the toolbar above the crosstab.
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Association measures

The following measures are computed (see textbooks on statistics for interpretation):

Pearson’s Chi-square with degrees of freedom for the crosstab and the asymptotic two-sided
significance level.
Number of cells with expected frequencies smaller than 5 as well as the minimum expected
frequency.
Coefficient of contingency
Cramer’s V
As you can see in the example above, additional measures are calculated in fourfold tables:
Pearson’s Chi-square with continuity correction
Phi

If you click Copy the table will be transferred to the clipboard so you can paste the table easily into
other programs such as Word.

Transfer results table to the Output Viewer

After the tables have been created and adapted according to your needs, they can be transferred to
the Output Viewer from which they can later be exported together:

Click the Insert into output viewer  icon to transfer the currently displayed results table to
the Output Viewer.
Click the Insert all result tables into output viewer icon to transfer all created tables to the
Output Viewer at once.

MAXQDA Stats will ask if you also wish to include the measures of association. If you agree, a table
containing the measures will be displayed below the results table.

Tip: When the table is transferred, the adjusted column widths will be maintained.
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Crosstabs transfered to the Output Viewer

Transfer results to Questions – Themes – Theories

In the Questions – Themes – Theories window, you can collect and comment on all the important
results of your project. Click the Send to QTT Worksheet icon in the upper right corner to save the
current view in a new or existing worksheet.

Once you close MAXQDA Stats, you can access all your QTT worksheets via Analysis > Questions –
Themes – Theories.

Export and print results table

Several options for exporting and printing the currently displayed results table are available using the
following symbols:

Copy – copies the entire table or selection, for example in order to paste it directly into Word.

Print – starts the print process and displays a print preview, in which the settings such as
margins, orientation, headers and footers can be applied.

Export – exports the table in Excel format, website (HTML) format or RTF format for Word and

https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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other word processing programs.

Display results as a grouped vertical or horizontal bar chart

You can display the contents of the crosstab as a grouped vertical or horizontal bar chart. Via the

and

icons you can switch between the chart view and the table view.

Grouped bar chart

You can change the display from a

vertical bar chart to a

horizontal bar chart by clicking on the corresponding icons in the upper right-hand corner of the
toolbar.

Via the icons on the left side above the diagram, you can show or hide the data labels, titles and
subtitles, as well as specify the color.

The size of the chart automatically adjusts to the window size. Maxmize the window to display a
larger chart.

Hint: The chart always displays the column percentages, regardless of which percentages are
currently displayed in the results table.
Exporting charts

The charts can be transferred to the Output Viewer for storage and later export, or they can be
transferred to a QTT worksheet. To do this, click on the corresponding icons in the top right corner
of the toolbar:
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 Insert into Output Viewer and Send to QTT Worksheet.

Please note: The chart is inserted into the output viewer as it is displayed, but not wider than 650
pixels.

To export or print a chart directly, the usual icons are available in the upper right-hand corner of the
window:

Copy,

Print and

Export.

t-Test and U-Test
Tip: Stats is a MAXQDA Analytics Pro module and cannot be purchased separately. Therefore, it can
only be used via an existing MAXQDA Analytics Pro license and activated through its corresponding
serial number. If you already have a MAXQDA Analytics Pro license, Stats is a tab on the main ribbon
menu.

In order to conduct a t-test or U-test for independent samples with MAXQDA Stats, select Compare
Groups > t-Test for Independent Samples or Compare Groups > Mann-Whitney U-Test for
Independent Samples in the main menu. A window will appear which will allow you to select several
dependent variables, as well as one comparison factor for the two groups.

https://www.maxqda.com/products/maxqda-analytics-pro
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Dialog for selecting the dependent variable and the grouping factor for t-test or U-test

Variables can be selected in several ways:

Double-click on a variable.
Drag and drop the variable into the right window pane.
Select one or multiple variables with the mouse by holding the Ctrl/Cmd key then dragging the
selection into the right window pane with the mouse, or click the blue arrow in the middle of
the window.

To integrate code frequencies per document as dependent variables or as a factor, switch to the
“Codes” tab and select the desired codes. (This option is available only if MAXQDA Stats was
launched with the data in the MAXQDA project).

Hint: You can only select variables of the type integer or decimal as dependent variable.

Once you have selected a variable or code for defining the groups, you can select a value for defining
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the groups in each of the Group 1 and Group 2 drop-down menus.

In order to integrate only those cases that contain variables with a valid value select Exclude cases
listwise.

After starting the calculation by clicking OK a t-test or U-test is performed for each selected
dependent variable.

Results table of the t-test

For the t-test, the following results table appears for the first dependent variable. By using the blue
arrows and the drop-down list at the top of the window, you can switch to the results for the other
dependent variables.

Results table for the t-test

The results table contains the following information:

The number of valid and missing cases for each calculated test is shown in the upper right
corner.
The first row shows the results for the assumption of homogeneous variances in the two
groups. The second row contains the results assuming heterogeneous variances (Welch
correction).
The effect sizes Cohen’s d and Hedge’s g* help to assess the size of the difference in means.
Levene’s test, the results of which are presented in the middle panel, can be used to assess
the variance homogeneity of the two groups.
In the lower area, the number of cases (N) as well as the mean, standard deviation, and
standard error are displayed separately for both groups.
Shapiro-Wilk value and the corresponding p-values can be used to check the assumption of a
normal distribution in the individual groups.

Note: For the calculation of Cohen’s d, the pooled standard deviation of both groups is used.
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Hedges g* applies an additional correction to Cohens d:

Results table of the U-test

For the U-test, the following results table appears for the first dependent variable. Using the blue
arrows and the drop-down list at the top of the window, you can switch to the results for the other
dependent variables.

Results table for the U-test

In the upper area of the results table, descriptive statistics are presented separately for the two
groups, in addition to the number of cases, the median and the mean.

In the lower area, the calculated p-values are displayed.

Note: P-values for small group sizes from 5 to 15 are determined using tabulated values. For larger
groups, an approximation is performed. Further notes can be found here:
https://www.alglib.net/hypothesistesting/mannwhitneyu.php

Overview of toolbar functions

The toolbar in the upper section of the results window offers important functions:

 Table view/Chart view – switches between the result table and scatter plots.

https://www.alglib.net/hypothesistesting/mannwhitneyu.php
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   Previous/Next – using the blue arrow or the selection
list, switch between the results table for the dependent variables.

 Refresh – recalls the dialog for selection of variables for the correlation table.

 Insert into output viewer – inserts the currently displayed table or chart in the Output Viewer.

 Insert all into output viewer – inserts all created tables or charts in the Output Viewer.

 Send to QTT worksheet - inserts the current view into a new or an existing QTT worksheet.

 Copy – copies the current table, highlighted area in the table, or chart, for example for insertion
into Word.

 Print – prints the currently displayed table or chart.

 Export – exports the currently displayed table in Excel format, website (HTML) format or RTF
format for Word and other word processing programs; exports the currently displayed chart in PNG,
SVG or EMF (only Windows) format.

Transfer results table to the Output Viewer

After the tables have been created, they can be transferred to the Output Viewer from which they can
later be exported together:

Click the Insert into output viewer  icon to transfer the currently displayed results table to
the Output Viewer.
Click the Insert all result tables into output viewer  icon to transfer all created tables to the
Output Viewer at once.

Tip: When the table is transferred, the adjusted column widths will be maintained.
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Results table in the Output Viewer

Transfer results to Questions – Themes – Theories

In the Questions – Themes – Theories window, you can collect and comment on all the important
results of your project. Click the Send to QTT Worksheet icon in the upper right corner to save the
current view in a new or existing worksheet.

Export and print results table

Several options for exporting and printing the currently displayed results table are available using the
following symbols:

Copy – copies the entire table or selection to the clipboard, for example in order to paste it
directly into Word.

Print – starts the print process and displays a print preview, in which the settings such as
margins, orientation, headers and footers can be applied.

Export – exports the table in Excel format, website (HTML) format or RTF format for Word and
other word processing programs.

Display means/medians as chart

In order to display a chart of the means or medians of the compared groups click the icon 
Chart view in the results table.

Chart view

You can customize the design and view of the chart by using the icons in the toolbar above the chart

https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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as well as double-clicking and right-clicking the elements of the chart. The chart’s size automatically
adjusts to the window size. Enlarge the window in order to receive a larger chart.

Hint: In case of the occurrence of negative means or medians no chart is displayed.

The charts can be transferred to the Output Viewer for storage and later export, or they can be
transferred to a QTT worksheet. To do this, click on the corresponding icons in the top right corner
of the toolbar:

 Insert into Output Viewer and Send to QTT Worksheet.

Hint: Charts will be inserted into the Output Viewer in the size that they are displayed, to a maximum
width of 650 pixels.

To export or print a chart directly, you can use the usual icons in the top right of the window:

 Copy,  Print and  Export.

Scale
Tip: Stats is a MAXQDA Analytics Pro module and cannot be purchased separately. Therefore, it can
only be used via an existing MAXQDA Analytics Pro license and activated through its corresponding
serial number. If you already have a MAXQDA Analytics Pro license, Stats is a tab on the main ribbon
menu.

MAXQDA Stats supports the creation of a scale, consisting of several items. Before you start
building a scale, it may be helpful to check the items for consistent polarity, otherwise the
computation may give incorrect results. You can use the function Transform > Recode into other
variable to standardize the item polarity.

To build a scale in MAXQDA Stats, select the function Scale > Reliability (Cronbach’s Alpha) from
the main menu. A dialog will appear in which you can select all the variables you want to include in
the initial scale.

Please note: The dialog contains all variables of type integer or decimal, independent from their
measure.

https://www.maxqda.com/products/maxqda-analytics-pro
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Dialog box for selection of variables for building a scale

Variables can be selected in several ways:

Double-click on a variable.
Drag and drop the variable into the right window pane.
Select one or multiple variables with the mouse by holding the Ctrl/Cmd key then dragging the
selection into the right window pane with the mouse, or click the blue arrow in the middle of
the window.

To integrate code frequencies per document into the calculations, switch to the “Codes” tab and
select the desired codes. (This option is available only if MAXQDA Stats was launched with the data
of a MAXQDA project).

Please note: Only cases in which all variables have a valid value will be taken into account.

Results table

After clicking OK MAXQDA Stats will compute a results table with the following structure:
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Results table for function “Scale”

The results table contains the following information:

Cronbach’s Alpha and the number of Valid and Missing cases are displayed at the top right.
Item – This column contains the variable label, or if this does not exist, the variable name.
Mean scale w/o item – The “Mean value of the scale without the item” equates the mean
value of the additive scale if the item were removed from the scale.
Std.dev. scale w/o item – The “Standard deviation of the scale without the item” equates the
standard deviation (population) of the additive scale, if the item were removed from the scale.
Corrected item scale corr. – The “Corrected item scale correlation” measures, how strongly
the respective item correlates with the total scale. Usually, items with a very low correlation
are not suitable for the final scale and should be removed from the item pool. MAXQDA Stats
highlights the item(s) with the lowest correlation always.
Alpha w/o item – “Cronbach’s Alpha without item” provides information about the height of
Alpha if you were to remove the respective item from the scale. For example, for the twelve
items above, Cronbach’s Alpha is 0.773. If you removed item no. 9 with the lowest item scale
correlation, Alpha would be slightly increased to 0.782.

Please note: Items with a negative item scale correlation usually have the incorrect polarity which
conflicts with the model assumptions for calculation of Cronbach’s Alpha.

Overview of toolbar functions

  Refresh – recalls the dialog for selection of variables.

  Insert into output viewer – inserts the currently displayed table in the Output Viewer.

Send to QTT worksheet - inserts the current view into a new or an existing QTT worksheet.
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  Copy – copies the current table or highlighted area in the table in the clipboard, for example for
insertion into Word.

  Print – prints the currently displayed table.

 Export – exports the currently displayed table in Excel format, website (HTML) format or RTF format
for Word and other word processing programs.

  Remove item from scale – the selected items will be removed from the scale and the values of the
results table are updated.

 Build scale and save as new variable – shows a dialog in which you can set a variable name and a
label for a new variable that contains either the sum or the mean of the item values for each case.

  Descriptive statistics – opens a window containing descriptive values for each item and the total
scale build by item summation or item means.

  Undo changes – step-by-step resetting of changes to a table (deletion and moving of rows).

  Redo – step-by-step restoring of changes to a table.

Interactive optimization of scale by deleting items

In MAXQDA Stats you can remove items from the scale, which leads to an immediate recalculation
of all values:

Click on an item (or several items by holding down Ctrl/⌘-key) you wish to remove.1.
Then click on the symbol2.

 Remove item from scale or right click on the highlighted rows and select Remove from the
context menu.

MAXQDA Stats updates the values in the table instantly.

To reintegrate a deleted item into the scale, you can click the Undo symbol

.
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Results table for scaling: the item with lowest item-scale correlation is marked red

Please note: For calculating the results for the remaining items MAXQDA Stats applies list wise
deletion for cases with missing values. Therefore, the number of missing values may decrease and
more cases might be integrated into the calculation. As a consequence, the new value for
Cronbach’s Alpha might be slightly lower than the original value displayed in the column “Alpha w/o
item”.

Show descriptive statistics for items and total scale

For evaluation purpose of the frequency distributions, you can get an overview of descriptive
statistics for the single items and the total scale build by addition and by mean: click on the symbol
Descriptive Statistics

 to start a calculation of typical statistical values. A window like the following will appear:

Descriptive values for the single items of a scale and the total scale

The last two rows contain the values for the total scale. For the row “TOTAL SCALE (summation)” at
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first a variable will be computed in the background, which contains the sum of each item value for
each case. Then the statistical values for this variable will be calculated. For the row “TOTAL SCALE
(mean)” a variable is first calculated which contains the mean for each case.

Build scale and save as new variable

MAXQDA Stats offers an easy possibility to combine the items shown in the result table in a scale
and save it as a new variable. Click on the symbol Build scale and save as new variable

 to start the calculation. A dialog will appear, in which you can enter a variable name and a variable
label, and set the kind of calculation.

Define variable name, variable label, and the kind of calculation for the new variable

Summation – The sum of all single item values will be calculated for a case.

Mean – The arithmetic mean of all single item values will be calculated for a case.

If a value is missing for an item or the value is defined as a missing value, the newly created variable
contains a (system defined) missing value for the respective case.

Transfer results table to the Output Viewer

To transfer the results table containing the computed values for the scale to the Output Viewer, click
the Insert into Output Viewer

 icon in the toolbar.
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MAXQDA Stats will ask if you also wish to include descriptive statistics in the Output Viewer. If you
agree, an additional table will be displayed below the results table.

Tip: When the results table is transferred, the adjusted column widths will be maintained.

Results table for “Scale” following transfer to the Output Viewer

Transfer results to Questions – Themes – Theories

In the Questions – Themes – Theories window, you can collect and comment on all the important
results of your project. Click the Send to QTT Worksheet icon in the upper right corner to save the
current view in a new or existing worksheet.

Export and print results table

Several options for exporting and printing the results table are available using the following symbols:

  Copy to clipboard – copies the entire table or selection to the clipboard, for example in order to
paste it directly into Word.

  Print – starts the print process and displays a print preview, in which the settings such as margins,
orientation, headers and footers can be applied.

  Export – exports the table in Excel format, website (HTML) format or RTF format for Word and
other word processing programs.

https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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Hierarchical Cluster Analysis
Using a cluster analysis, cases can be grouped according to their similarity. The basis for the
calculation is a distance matrix, which indicates for each two documents how similar (more
precisely: how dissimilar) they are with regard to their variable assignments and, if applicable, code
assignments.

Cluster analysis for interval data

A cluster analysis for interval data is useful if the calculation of the arithmetic mean for the analyzed
variables makes sense, for example, for age or for a scale from “0 = never” to “10 = very often”.
In a cluster analysis for interval data, all variables of the integer and decimal type are available
(regardless of the scale level defined for the variables in the Variable List). If codes from a MAXQDA
project are included in the analysis, code frequencies per case are analyzed, that is, how often a
code was assigned to a document.

How to perform a cluster analysis for interval data

Call Function Compare Groups > Hierarchical Cluster Analysis (Interval Data).1.
In the dialog, select the desired variables and codes.2.
the following options are available at the bottom of the dialog:3.

z-standardize values- Performs z-standardization of the selected variables and codes.
The option should always be set if the selected variables have different scale ranges or
if variables and codes are mixed, otherwise the calculations will not make sense.
Binarize all codes – All code frequencies greater than 1 are set to 1, that is, the code
frequency per document is not evaluated, but only whether a code occurs in a
document or not.
Sum up frequencies of subcodes – For parent codes, the frequencies of all subcodes
available in the Stats dialogue are added to the code frequency. If the option Binarize
subcodes is also selected, the summation only takes into account whether the code
was assigned to a document (the frequency of a subcode is set to “1”) or not (the
frequency of a subcode is set to “0”). When combining both options, the sum of the
subcodes indicates how many subcodes were coded for a document.

Start the calculation with OK.4.

Result: Merge table

MAXQDA displays a table that informs which clusters are merged in each step of the analysis:
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Merge table

The columns of the table have the following meaning:

Step– Current merging step.
Min. distance– Distance between the two clusters that are merged in the current step. For
Average, Complete and Single linkage the raw values are output, for Ward the weighted intra-
cluster variance.
Change of min. distance– Difference from current “Min. distance” to previous step; this value
is useful for deciding on the number of clusters.
Number of clusters– Number of clusters remaining after merge.

Using the first pop-up menu at the top, you can set various distance measures:

Euclidean distance
Squared Euclidean distance
Block distance

Using the second pop-up menu at the top, you can choose a merge criterion:

Criterion Meaning SPSS Name

Unweighted average linkage Average distance of all case pairs from both
clusters

between groups

Weighted average linkage Average distance of all case pairs from the
union of both clusters

nicht vorhanden

Complete linkage Maximum distance of all case pairs from
both clusters

furthest neighbour

Single linkage Minimum distance of all cases from both
clusters

nearest neighbour

Ward Increase of variance when merging two
clusters

Ward
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Details on the fusion criteria can be found here: https://en.wikipedia.org/wiki/Hierarchical_clustering

To analyze the differences between the clusters, you can switch to the chart view using the icon in
the upper left corner. Boxplots per cluster are created for all analyzed variables and codes:

Diagram view with boxplots per cluster

Result: Typology table

In addition to the results window, MAXQDA automatically opens the following typology table, which
can also be opened at any time using the corresponding icon in the toolbar of the results window.
The table allows you to compare the mean and standard deviation per cluster for all selected
variables and codes.

Typology table with information on the individual clusters

As an aid to interpretation, the highest mean values per row are shown in green and the lowest
values in red. The highlighting can be switched on and off using the icons at the top left.

The number of clusters can also be set in the toolbar at the top left, allowing to compare different
solutions easily.

Using the icon , the cluster membership is saved as a document variable, so that the cluster
membership is available for other calculations and qualitative analyses.

https://en.wikipedia.org/wiki/Hierarchical_clustering
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Result: Line chart of the minimum cluster distances

To help you decide on the appropriate number of clusters, you can use the icon  in the merge table to
call up a line chart of the minimum distances.

Line chart of minimum cluster distances in each merge step

Save and export results

All created tables and charts can be saved using the icons in the upper right corner, for example,

into the Output Viewer of MAXQDA Stats
or into a MAXQDA QTT worksheet.

The tables and diagrams can also be exported to the clipboard, saved as a file, or printed.

Cluster analysis for dichotomous data

In a cluster analysis for dichotomous data, all variables can be included regardless of their type. If
codes from a MAXQDA project are included in the analysis, the analysis checks whether a code has
been assigned to a case or not - the frequency of assignment per case is irrelevant.

The cluster analysis for dichotomous data is called via Compare Groups > Hierarchical Cluster
Analysis (Dichotomous Data).

The procedure and the result are identical to the cluster analysis for interval data described above
with the following exceptions:

In the options dialog, the value to be counted must be specified for each variable and code.
No z-standardization is performed.
The chart view shows bar charts with the frequencies of the counted value per cluster instead
of boxplots.

https://www.maxqda.com/help-mx24-stats/the-output-viewer
https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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The typology table contains absolute and percentage frequencies of the counted value per
cluster instead of means and standard deviations.
The following similarity measures are available instead of distance measures: Simple
agreement, Jaccard, Kuckartz & Rädikers’ zeta, Russel & Rao. More information on the
coefficients: https://www.maxqda.com/help-mx24/mixed-methods-functions/similarity-analy
sis-for-documents.
To determine the distances of two documents, 1 - calculated similarityis used

One-Way Analysis of Variance
Tip: Stats is a MAXQDA Analytics Pro module and cannot be purchased separately. Therefore, it can
only be used via an existing MAXQDA Analytics Pro license and activated through its corresponding
serial number. If you already have a MAXQDA Analytics Pro license, Stats is a tab on the main ribbon
menu.

In order to compute a one-way analysis of variance with MAXQDA Stats, select Compare Groups >
Analysis of Variance in the main menu. A window appears that allows you to select several
dependent variables and one factor as an independent variable.

https://www.maxqda.com/help-mx24/mixed-methods-functions/similarity-analysis-for-documents
https://www.maxqda.com/help-mx24/mixed-methods-functions/similarity-analysis-for-documents
https://www.maxqda.com/products/maxqda-analytics-pro
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Dialog box for the selection of the dependent variables and the factor for the variance analysis

Variables can be selected in several ways:

Double-click on a variable.
Drag and drop the variable into the right window pane.
Select one or multiple variables with the mouse by holding the Ctrl/Cmd key then dragging the
selection into the right window pane with the mouse, or click the blue arrow in the middle of
the window.

To integrate code frequencies per document as dependent variables or as a factor, switch to the
“Codes” tab and select the desired codes. (This option is available only if MAXQDA Stats was
launched with the data of a MAXQDA project).

Hint: You can only select variables of the type integer or decimal as dependent variable.

The following options are available in the lower part of the window:
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Exclude cases listwise – select this option to include only those cases that have a valid value for all
selected variables.

Sum up frequencies of subcodes (only selectable if at least one code has been selected) – for upper
codes, the frequencies of all subcodes available in the Stats dialog are also added to its code
frequency.

Results table

After starting the calculation by clicking OK an analysis of variance is performed for each selected
dependent variable. The following results table appears for the first dependent variable. Use the blue
arrows and drop down menu on the top of the window to switch to results tables for the other
dependent variables.

Results table for the function “analysis of variance”

The number of valid and missing cases for each calculated variance analysis is displayed in the
upper right corner. The results table includes all the major results of the variance analysis.

The column “sum of squares” contains the sum of squares between groups and within
groups.
The column “df” provides information on the number of degrees of freedom and allows
conclusions on the number of groups that are defined by the factor. The example shows 3 +1
= 4 groups.
The “mean squares” can be calculated by dividing the sum of squares by the degrees of
freedom. The ratio of mean squares in turn results in the “F-value” whose probability of
occurrence can be computed by using the F-distribution and finds expression in the “p-value”.
“Eta-squared” is a measure of effect size and signifies the variance explained by the factor.
The value is between 0 and 1 and can be interpreted as a percentage.
Levene’s test, the results of which are presented in the middle panel, can be used to assess
the variance homogeneity of the two groups.



  580

To assess pairwise mean differences, the results of a post hoc test (Scheffe) and effect sizes
for mean differences, Cohen’s d and Hedge’s g*, are presented in the lower part of the
window.

Overview of toolbar functions

In the upper section of the results window two toolbars are located, which contain the following
important functions:

 Table view / Chart view – switches between table and chart view.

 Previous/Next – using the blue arrow or the selection
list, switch between the results table for the dependent variables.

 Refresh – Recalls the dialog window for selecting variables for analysis of variance.

 Insert into output viewer – inserts the currently displayed table or chart in the Output Viewer.

 Insert all into output viewer – inserts all created tables or charts in the Output Viewer.

Send to QTT Worksheet - inserts the current view into a new or an existing QTT worksheet.

 Copy – copies the current table, highlighted area in the table, or chart, for example for insertion
into Word.

Print – prints the currently displayed table or chart.

Export – exports the currently displayed table in Excel format, website (HTML) format or RTF
format for Word and other word processing programs; exports the currently displayed chart in PNG,
SVG or EMF (only Windows) format.

Descriptive statistics – opens a window containing descriptive values for the groups build by
the factor.

 Undo changes – step-by-step resetting of changes to a table (deletion of rows, merging and
moving of rows).

 Redo – step-by-step restoring of changes to a table.

Display descriptive statistics

If you want to display important characteristic values for each factor level, click on the icon
Descriptive statistics

.  A table appears containing information for each factor level and the total number of cases.
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Column “N” shows the number of valid values for each factor level.
Column “Mean lower bound (95%)” contains the lower value of the confidence interval on the
mean.

Transfer results table to the Output Viewer

After the tables have been created, they can be transferred to the Output Viewer from which they can
later be exported together:

Click the Insert into output viewer  icon to transfer the currently displayed results table to
the Output Viewer.
Click the Insert all result tables into output viewer icon to transfer all created tables to the
Output Viewer at once.

MAXQDA Stats will ask if you also wish to include descriptive statistics for the factor groups. If you
agree, an additional table will be displayed below the results table.

Tip: When the table is transferred, the adjusted column widths will be maintained.
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Results table following transfer to the Output Viewer

Transfer results to Questions – Themes – Theories

In the Questions – Themes – Theories window, you can collect and comment on all the important
results of your project. Click the Send to QTT Worksheet icon in the upper right corner to save the
current view in a new or existing worksheet.

Once you close MAXQDA Stats, you can access all your QTT worksheets via Analysis > Questions –
Themes – Theories.

Export and print results table

Several options for exporting and printing the currently displayed results table are available using the
following symbols:

Copy – copies the entire table or selection, for example in order to paste it directly into Word.

Print – starts the print process and displays a print preview, in which the settings such as
margins, orientation, headers and footers can be applied.

Export – exports the table in Excel format, website (HTML) format or RTF format for Word and
other word processing programs.

Display means as chart

In order to display a chart of the means of the single factor groups click the icon

 Chart view in the results table.

Chart view of the means

https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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You can customize the design and view of the chart by using the icons in the toolbar above the chart
as well as double-clicking and right-clicking the elements of the chart. The chart’s size automatically
adjusts to the window size. Enlarge the window in order to receive a larger chart.

Hint: In case of the occurrence of negative means no chart is displayed.

The charts can be transferred to the Output Viewer for storage and later export, or they can be
transferred to a QTT worksheet. To do this, click on the corresponding icons in the top right corner
of the toolbar:

 Insert into Output Viewer and Send to QTT Worksheet.

Hint: Charts will be inserted into the Output Viewer in the size that they are displayed, to a maximum
width of 650 pixels.

To export or print a chart directly, you can use the usual icons in the top right of the window:

Copy,

Print and

Export.

Correlation
Tip: Stats is a MAXQDA Analytics Pro module and cannot be purchased separately. Therefore, it can
only be used via an existing MAXQDA Analytics Pro license and activated through its corresponding
serial number. If you already have a MAXQDA Analytics Pro license, Stats is a tab on the main ribbon
menu.

Correlation analysis is used to examine relationships between variables, in particular the analysis of
“the more, the more”- and “the more, the less”-correlations. MAXQDA Stats supports the calculation
of bivariate correlations, thus the correlation between two variables.

In order to calculate a correlation with MAXQDA Stats, select one of the following items in the main
menu:

Correlation > Pearson, usually used for interval scale variables or
Correlation > Spearman, usually used for ordinal scale variables

A dialog box appears that allows you to select each variable for which you wish to calculate bivariate
correlations.

Hint: All variables of the type float and integer are throughout available, regardless of the   level of
measurement of single variables.

https://www.maxqda.com/products/maxqda-analytics-pro
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Dialog box for selecting variables to calculate correlation (pictured here: Pearson’s r)

Variables can be selected in several ways:

Double-click on a variable.
Drag and drop the variable into the right window pane.
Select one or multiple variables with the mouse by holding the Ctrl/Cmd key then dragging the
selection into the right window pane with the mouse, or click the blue arrow in the middle of
the window.

To integrate code frequencies per document into the computation of correlations, switch to the
“Codes” tab and select the desired codes. (This option is available only if MAXQDA Stats was
launched with the data of a MAXQDA project).

Results table

After clicking OK a results table appears containing the pairwise correlations. Since all selected
variables are listed in rows and in columns all the calculated correlations are displayed twice.
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Results table with pairwise correlations (here: Pearson’s r)

Three kinds of data can be displayed in each cell:

The calculated correlation coefficient, either Pearson’s r or Spearman’s Rho, depending on the
selected function,
the p-value for the correlation coefficient’s significance, as well as
the number of valid cases for each combination of both variables.

The one-sided p-value is displayed by default. Using the drop down menu in the toolbar it is possible
to switch to two-sided p-values. The p-value is calculated if more than 4 cases have been analyzed.
If there are less cases the p-value is always 1.
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Highlighting of high correlation coefficients and significant correlations

In the drop-down list in the toolbar, you can set whether high correlation coefficients, significant
correlations, or no cells should be highlighted.

The higher the correlation coefficient the darker the background colors:

larger than 0.1: light green
larger than 0.3: green
larger than 0.5: dark green

The smaller the p-value the darker the background colors:

smaller than 5%: light green
smaller than 1%: green
smaller than 0,1%: dark green

Overview of toolbar functions

The toolbar in the upper section of the results window allows access to other important functions:

Table view/Chart view – switches between the result table and scatter plots.

Refresh – Recalls the dialog for selection of variables for the correlation table.

Insert into output viewer – inserts the currently displayed table or chart in the Output Viewer.

Send to QTT Worksheet - inserts the current view into a new or an existing QTT worksheet.

Copy – copies the current table, highlighted area in the table, or chart, for example for insertion
into Word.

Print – prints the currently displayed table or chart.

Export – exports the currently displayed table in Excel format, website (HTML) format or RTF
format for Word and other word processing programs; exports the currently displayed chart in PNG,
SVG or EMF (only Windows) format.

Undo changes – step-by-step resetting of changes to a table (deletion of rows).

Redo – step-by-step restoring of changes to a table.

Sort tables and customize columns

Tables can be sorted by clicking a column header, in ascending order with the first click and
descending order with the second. Clicking again will restore the original order.

Tip: You can also move the rows of the results table. Click a row, then drag and drop with the mouse
to the desired location. This function is also available for multiple highlighted rows. Lines containing
totals or missing values cannot be moved.
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Column widths can be adjusted with the mouse, and their position can be changed by clicking the
column header then dragging them to the desired location with the mouse.

Delete rows and columns

The results table is interactive and one or more rows can be removed. Right-click a row and select
Delete. You can also select multiple rows to delete by holding down the Ctrl/cmd key. Right-click a
column heading and select Delete to remove it from the results table.

Deleting a column or row in a correlation table only affects the display. The values are not
recalculated even if selecting the option Delete cases listwise would change the number of valid
values for variables taken into account.

Tip: A column can be hidden from the table by right-clicking within the column header and selecting
Hide column. When the function is called up the next time, the column will be automatically
displayed again.

Transfer results table to the Output Viewer

After the tables have been created, they can be transferred to the Output Viewer from which they can
later be exported together:

Click the Insert into output viewer  icon to transfer the currently displayed results table to
the Output Viewer.

MAXQDA Stats will ask if you also wish to include a descriptive statistic for the factor groups. If you
agree, an additional table will be displayed below the results table.

Tip: When the table is transferred, the adjusted column widths will be maintained.

Results table for correlations following transfer to the Output Viewer

Transfer results to Questions – Themes – Theories

In the Questions – Themes – Theories window, you can collect and comment on all the important
results of your project. Click the Send to QTT Worksheet icon in the upper right corner to save the
current view in a new or existing worksheet.

Once you close MAXQDA Stats, you can access all your QTT worksheets via Analysis > Questions –

https://www.maxqda.com/de/hilfe-mx22/19-questions-themes-theories-q-t-t/die-idee-hinter-questions-themes-theories
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Themes – Theories.

Export and print results table

Several options for exporting and printing the results table are available using the following symbols:

Copy – copies the entire table or selection to the clipboard, for example in order to paste it
directly into Word.

Print – starts the print process and displays a print preview, in which the settings such as
margins, orientation, headers and footers can be applied.

Export – exports the table in Excel format, website (HTML) format or RTF format for Word and
other word processing programs.

Displaying scatter plots

In order to display a scatter plot for every pairwise combination of variables click on the  Chart
view symbol in the results table.
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Scatter plot for two variables

Using the two drop down menus in the top toolbar you can determine the variables for the X-axis and
the Y-axis. The drop down menus contain all the variables that are selected for the calculation of
correlation.

Determine variables for the X-axis and Y-axis

It is not possible to customize the display of the chart. The chart’s size automatically adjusts to the
window size. Enlarge the window in order to display a larger chart.

The charts can be transferred to the Output Viewer for storage and later export, or they can be
transferred to a QTT worksheet. To do this, click on the corresponding icons in the top right corner
of the toolbar:

 Insert into Output Viewer and Send to QTT Worksheet.

Hint: Charts will be inserted into the Output Viewer in the size that they are displayed, to a maximum
width of 650 pixels.

To export or print a chart directly, you can use the usual icons in the top right of the window:

Copy,

Print and

Export.

Interactivity in scatter plots

The plotted points in the scatter plot are interactively connected to the data, which is especially
useful for mixed-methods analyses: Place the mouse pointer over a dot to see the associated
document names when analyzing data from MAXQDA projects. Behind the document name, you will
see the values that belong to this point, i.e. the coordinates in the plot:
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Document name and coordinates are displayed below the mouse pointer

Right-click on a dot to open the following context menu:

Context menu for a data point

Three functions are available in the context menu:

Delete – the selected dot will be removed from the scatter plot.
Save as Document Set – a document set with the selected dot is saved, which is transferred
to the "Document System" of the MAXQDA project when you quit MAXQDA Stats (the function
is only visible if you are working with the data of a MAXQDA project in Stats).
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For more information on the principle of the Save as Document Set function, please refer to
the chapter Analyze Variables and Codes from a MAXQDA Project.
Use as Filter in Data Editor – a new variable "StatsFilter" is created and the filter in the data
editor is switched on for this variable, so that only the values of this case are visible in the
data editor.For more information about the filter function in the Data Editor, see the chapter
The Data Editor

Tip: To select multiple data dots at once, click on them while holding down the Ctrl (Windows) or
cmd (macOS) key. You can also drag a range with the mouse to select all data points in that range.

Limits and Technical Notes
Tip: Stats is a MAXQDA Analytics Pro module and cannot be purchased separately. Therefore, it can
only be used via an existing MAXQDA Analytics Pro license and activated through its corresponding
serial number. If you already have a MAXQDA Analytics Pro license, Stats is a tab on the main ribbon
menu.

Number of variables max. 1,000
If you start Stats from within a MAXQDA project file, only the first
1,000 variables and codes will be transferred to Stats. If you open an
external file a maximum of 1,000 variables will be imported.

Number of cases There is no functional limit for the number of cases. Please keep in
mind that importing a large number of variables and cases will take
some time.

Variables of type „text“ max. 63 characters

Rounding of
decimal numbers

The “Round half to even” method is used for displaying decimal in
Data Editor and Result Views, while the “Round half up” method is
used when choosing method round() for calculating new variables
via the Transform menu (see
https://en.wikipedia.org/wiki/Rounding

Computation of quartiles There are different procedures to compute quartiles, as described in
Hyndman & Fan (1996) “Sample quantiles in statistical packages”. In
MAXQDA Stats procedure no. 7 is implemented, which is also used
by default in the statistical package “r”.

SPSS: export and import Stats supports the import of SPSS files created with version 18, in
single cases files created with older version can be imported.
The files exported in SPSS format can be opened with SPSS 18 or
newer, and depending on the content in single cases, also with older
versions.

Excel: export When exporting to the older Excel format XLS a maximum of 256
variables will be exported, because the format does not support
more than 256 columns.

https://www.maxqda.com/help-mx24/stats/the-data-editor
https://www.maxqda.com/products/maxqda-analytics-pro
https://en.wikipedia.org/wiki/Rounding
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22 – MAXDictio

What Does MAXDictio Offer?
MAXDictio offers three essential functions:

Using the word frequency function, you can perform vocabulary analyses, for example to1.
explore which vocabulary is present, which words occur in a text or text segment, and the
differences between the vocabularies of two different texts within a project.
Using the tools for text exploration function, you can examine the occurrence of words and2.
combinations of words in their respective contexts.
Using the dictionary, quantitative content analyses can be carried out, in which the search3.
terms from a dictionary are counted and the results are graphically displayed.

All functionalities can be understood and applied as independent methods, each with its own
independent methodology. However, these functionalities are particularly suitable for
complementing qualitative data analysis. The integration of these different methodological
approaches is supported by the integration and interaction of MAXDictio and MAXQDA.

The tab 'MAXDictio' in MAXQDA's main ribbon menu

More precisely, MAXDictio provides following functions:

Word frequencies and word combinations

Counting, filtering and searching of word frequencies
Output of word combinations of 1-5 words
Differentiation of results by documents, document groups, document sets or codes - ideal for
comparative analysis
Results tables which display the rank frequencies and number of texts in which words occur
List of sources for selected words with the possibility to jump from each list entry to the
location of the word in the original text

Stop and go lists

Restriction of evaluations using Go Lists (containing a list of the only words to be analyzed)
and Stop Lists (containing a list of words to be ignored during the analysis)
Saving of Stop and Go Lists within a specific project as global, cross-project lists
Population of Stop Lists directly from the results table

Keyword-in-Context

Searching of any desired words or words from the dictionary or Go Lists
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Presentation of keywords with a definable number of surrounding words
Output of standardized properties, which are assigned to the original texts as variable values
Jumping to the original location in the text with a single click

Interactive Word Tree

Presentation and analysis of the most common phrases (word combinations) in an
interactive tree structure
Definition of any word as a “Root”
Placement of desired words at the beginning, middle, or end of a phrase
Presentation of phrases in the text with ability to jump directly to the location in the original
text

Dictionary-based functions (for content analyses)

Construction of words-based dictionaries as simple or hierarchical dictionaries containing
subcategories
Simple transfer of words from word frequency tables to the dictionary
Enabling and disabling of categories and search terms in the dictionary
Export and import of dictionaries to and from Microsoft Excel
Unconstrained definition of analysis units (with the possibility to overlap): documents,
document groups, document sets
Quantitative content analysis based on dictionary: determination of frequencies of the
dictionary categories
Interactive results tables, in which text segments included in the results can be jumped to
directly
Creation of validation file to verify text segments included in the results can be jumped to
directly
Easy processing of results using the MAXQDA statistics module “Stats,” SPSS or Excel
Visual display of results of the quantitative content analysis in the Category Matrix Browser
Automatic coding of multiple search terms in a single run using the dictionary

General

Analysis of text and PDF documents
Exportability of results of frequency analysis to Microsoft Office programs (e.g. Excel, Word)
and SPSS via the clipboard
Lemmatization of words in results tables (in multiple languages)
Definition of characters to be cut off

Basic Terms
In the following section, some important and frequently used terms will be explained:

Text

Refers to text, PDF, or table documents in the MAXQDA Document System.
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Please note: MAXDictio only analyzes the text itself, therefore it is irrelevant which font is being
used, or if words appear in bold or italic.

Text section/text unit

Similar to a book, texts can be subdivided into chapters and subchapters. Chapters may not overlap,
just as chapters 3 and 4 may not overlap in a book. During import, a text can already be subdivided
into sections (text units) with the text pre-processor. But it is also possible to make the text units in
MAXQDA simply by coding text passages. The MAXDictio function “Frequencies for dictionary
categories” can analyze text passages separately. Each text unit will appear individually in a line of
the table of results.

Word

A word is any string of characters which are situated between two blanks or cut-off punctuation
characters (such as , ; . :).

Word combinations

A string of words which follow one another directly.

Stop word list

A stop word list contains collections of words a user wants to ignore in the word frequency analysis.
Typically, these are indefinite and definite articles, numerals, and so on.

Go word list

A go word list functions pretty much conversely to a stop word list. It contains words to which the
frequency analysis should be confined, i.e. only words that are on the list will be considered in the
analysis.

Index

A list of words that includes their references, i.e. the passages where they can be found in the
text(s).

Dictionary

A dictionary is composed of categories and words or character strings which are assigned to the
categories. For instance, the category "Europe" could contain the words “Italy,” “Great Britain,”
“Germany,” “Belgium,” “Netherlands,” and “Spain”.

In principle, dictionaries are not project-dependent. They can be used again for other projects. For
quantitative content analysis, the dictionary presents a classification scheme on the basis of which
the frequency of the categories is determined.

Search item

A string of characters, one or more words, which are attached to a category in a dictionary.
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Word Frequencies

Lemmatization
MAXDictio permits lemmatization of words in various languages for word frequency and word
combination functions.  When this option is activated, words are returned to their respective basic
forms, so that words with the same meaning are combined regardless of declination or case. For
example, only the word “give” will be counted for the various forms “give”, “gave”, and “given”.

In MAXDictio, lemmatization is performed using lemma lists which are available in the following
languages:

Bulgarian
German
English
Estonian
French
Italian
Catalan
Polish
Portuguese
Swedish
Spanish
Czech
Ukrainian
Hungarian

The lists are in TXT format (UTF-8) and can be edited and expanded as required. It is recommended
to create backup copies, because files may be overwritten during a new installation. You can find the
lists in the installation folder of MAXQDA:

Windows: local installation

C:\Program Files\MAXQDA24\Resources\Lemmatization

Mac

First: Applications > Right-click on MAXQDA24 > Show package contents

Then navigate to: Contents > Resources > Lemmatization

Important license note: MAXDictio uses lemmatize lists for this function that have been published
under the Creative Commons and the Open Database License. If you use this function for a
publication you have to give appropriate credit in a short note like the following:

Lemma list for German: “A lemma list has been used that is based on "Deutsche Morphologie-Daten"
by Daniel Naber (http://www.danielnaber.de/morphologie/), which is made available under the
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Creative Commons Attribution-ShareAlike 4.0 license
(http://creativecommons.org/licenses/by-sa/4.0/).”

Lemma list for other languages: “A lemma list has been used that was originally provided by Michal
Boleslav Měchura (http://www.lexiconista.com/datasets/lemmatization/), which is made available
under the Open Database License (ODbL) (http://opendatacommons.org/licenses/odbl/1.0/).”

Stop Word Lists
Stop word lists are collections of commonly used words, such as definite and indefinite articles,
conjunctions, or numerals. Such words are usually redundant elements when analyzing a text, since
they do not carry much meaning. For that reason, it is advisable to exclude them from the analysis.
MAXQDA allows you to create as many stop word lists as you’d like, as well as to edit and manage
them.

By default, each newly created MAXQDA project contains predefined stop word lists for different
languages, e.g., English, German, and Spanish.

The stop word list window

To manage the stop word lists open MAXDictio > Stop Word Lists.

The following window will appear:

The Stop word list contains an overview of the excluded words

The window is divided into three sections:
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1. Stop word lists for projects

This section lists all stop word lists that are stored in the project file. If you open the project file on
another computer in MAXQDA or send it to another person on a team by email, the lists displayed in
this section will be available.

2. Global stop word lists

This section contains all stop word lists that are not stored in the project file, but in the MAXQDA
installation itself. These stop word lists are available for each project opened with this MAXQDA
installation.

If you open a MAXQDA project on another computer, the global lists may not be available.

3. Excluded words

Here, all search terms that are included in the currently selected stop word list are displayed. The list
is always sorted in alphabetical order for user convenience.

Create a new stop word list

To add a new stop word list to the currently opened MAXQDA, click the  icon.

Icon for adding a new stop word list to a project

A new list will be added to the project and opened. By default, this list is given the name “New list”,
and may include a sequential number to avoid duplicate names. The name of the list can be edited
directly.

Add new words to a stop word list

New words can be added to the stop word list in different ways:

Firstly, you can enter new words by hand, by clicking the New   button above the Excluded words
pane and typing the word. Multiple words can be added by hitting the Enter key after each entry. 

Secondly, you can add words directly from a word frequency list by double-clicking the green symbol
  in the first column, thus sparing the effort of typing in the word. Multiple words from a word
frequency list can be transferred at once by highlighting them first, then clicking the Add to stop
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word list   icon on the toolbar.

Thirdly, in many word-based analyses, there is an option to right-click on a word to transfer it to the
currently selected stop word list, e.g., in a word cloud.

When using stop word lists, the following must be observed:

The words of a stop word list are automatically sorted in alphabetical order. This order is
predetermined and cannot be modified.
If a word already exists in the stop word list, it will not be inserted.
Stop word lists can include word combinations separated by spaces, such as “George W.
Bush” or “Walt Disney”.
Stop word lists are case-sensitive. This distinction is only applied if the corresponding option
is selected in the options dialog for a function.

Duplicate, rename, and delete stop word lists

Stop word lists can be duplicated, for example if you wish to modify the list while retaining the
original version. ight click on the stop word list and select Duplicate. Thereupon the list will be
duplicated and inserted. The duplicate list will have the same name as the original list supplemented
with a sequential number.

To rename a stop word list, click on the list to highlight it, then click again to change the name.
Alternatively, right-click the name of the list and select Rename.

The option for deleting a list can also be found in the context menu.

Stop word list functions in the context menu
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Applying stop word lists to other projects

To save a project-internal stop word list as a global list for use in other projects, right-click the stop
word list and select Save as Global List. The list will be duplicated and inserted with the same name
in the lower window pane. If the list name already exists, a sequential number will be added.

The Global stop word lists can be transferred to any project:

Right-click the list in the “Global stop word list” window pane.1.
Select Copy into project from the context menu.2.

Tip: Stop word lists can also be dragged and dropped from the “Project lists” to the “Global lists”
pane.

Merge Stop Word Lists

Many stop word lists can be effectively used across projects. Modularization is recommended,
meaning that specific types of stop word lists (for example, definite and indefinite articles) are
created, which can be universally applied. These stop word lists can be combined into common stop
word lists as required.

Right-click on a stop word list.1.
Select Copy to Other List from the context menu.2.
Select the target stop word list from the context menu.3.

Copy words from one stop word list to another

After selecting the target list, a confirmation message appears to confirm whether you want to
continue. If you confirm the request, the two stop word lists are merged, that is, all excluded words
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from the source list are inserted into the target list, skipping already existing entries.

Export and Print Stop Word Lists

Stop word lists can be exported as files to be edited, printed, or for documentation and archiving in
other programs:

Right-click on a stop word list and select Export, or click the Export icon in the top toolbar,1.
to export the currently displayed stop word list.
Provide a file name and location in the dialog window.2.

The list will be exported in TXT Format (UTF-8) and can be edited and printed using a text editing or
word processing program, or Excel.

Importing and augmenting stop word lists

MAXQDA allows you to load a stop word list from TXT files (UTF-8) and save it as new list or to
integrate the words into an existing list.

Click the Import list icon to add a new list from a TXT file.

Click the Add to current list icon to combine the words from the imported stop word list and the
words of the currently displayed stop word list.

Download pre-configured stop word lists

As a free service we provide pre-configured stop word lists including the following subcategories:
auxiliaries, prepositions, interjections, numerals, pronouns, determiners, conjunctions, particles (only
available in German), 100 most common words in the respective language.

You can either download a combined list containing all subcategories (excluding the 100 most
common words) here:

Download stop word list (English) Download stop word list (German)

Download stop word list (Spanish) Download stop word list (Italian)

Download stop word list (Portuguese)

Tip: Every newly created MAXQDA project already contains these combined lists.

Or you can download a zip file including single files for each subcategory here:

Download zip file (English) Download zip file (German)

Download zip file (Spanish) Download zip file (Italian)

Download zip file (Portuguese)

https://www.maxqda.com/download/en_complete.zip
https://www.maxqda.com/download/de_complete.zip
https://www.maxqda.com/download/es_complete.zip
https://www.maxqda.com/download/it_complete.zip
https://www.maxqda.com/download/pt_complete.zip
https://www.maxqda.com/download/english_stoplists.zip
https://www.maxqda.com/download/german_stoplists.zip
https://www.maxqda.com/download/spanish_stoplists.zip
https://www.maxqda.com/download/italian_stoplists.zip
https://www.maxqda.com/download/portuguese_stoplists.zip
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Location of global stop word lists

The global stop word lists are stored by MAXDictio as files in TXT format (UTF-8) in the following file
folder. They can also be edited here using external programs:

Windows: local installation

Documents > MAXQDA24 > Dictio > Stoplist

Mac: local installation

Documents > MAXQDA > MAXQDA24 > Dictio > Stoplist

All TXT files in these folders are displayed as stop word lists in MAXDictio.

Go Word Lists
What are Go Word Lists?

Go Word Lists are essentially the opposite of Stop Word Lists. While Stop Word Lists contain a list of
words which are disabled for the analysis and are intended to be excluded from the counting, Go
Word Lists consist of words to which the analysis should be limited. This means that only these
words will be counted.

Manage Go Word Lists

To create a list or customize existing Go Word Lists, select MAXDictio > Go Word List. The window
that appears contains the same functionalities as the window for Stop Word Lists, the only
difference being that there is no designated Go Word List for word clouds.

An explanation of all functions can be found in the Stop Word Lists section.

Use Go Word Lists for analyses

MAXDictio allows the use of Go Word Lists in the following analyses:

MAXDictio > Word Frequencies > Word Frequencies (Only Go Words) – Only the word frequencies
of the currently selected Go Word List are included in the results table (see Word Frequencies for
Words in the Go List).

MAXDictio > Keyword-In-Context – If the option "Search for... > Search items of go word list" is
selected, MAXQDA searches for words of the currently selected go word list in all texts and displays
them in their respective contexts (see Keyword-in-Context).

https://www.maxqda.com/help-mx24/maxdictio/stop-lists
https://www.maxqda.com/help-mx20-dictio/word-frequencies/word-frequencies-for-words-in-the-go-list
https://www.maxqda.com/help-mx20-dictio/word-frequencies/word-frequencies-for-words-in-the-go-list
https://www.maxqda.com/help-mx24/maxdictio/keyword-in-context


  603

Keyword-in-Context
What is the “Keyword-in-Context” feature?

The keyword-in-context feature allows you search for any number of terms relevant to the analysis
(the “keywords”), and view them in a tabular overview along with the words that appear before and
after  (their respective contexts). The keywords are interactively linked to the original data, allowing
you to jump directly to them in the original text.

Opening the function and selecting options

Begin the keyword search by selecting the function MAXDictio > Keyword-In-Context in the ribbon
menu. The following dialog window will appear:

Set options for the keyword search

In the left window pane, select the keywords you would like to search for. Three options are
available: 

Search items of dictionary – All words in the currently selected dictionary will be searched for. The
search options set in the dictionary are searched per keyword (case-sensitive, only whole word,
beginning of the word). The corresponding options in the dialog window will be ignored.

Search items of go word list – All words contained in the currently selected go word list will be
searched for.

These search items: – Enter the desired search terms in the list. The entries can contain spaces. Hit
the Enter key to move to the next line.
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In the right pane of the window you define the text to be included in the search. You can choose to
search in all documents, in activated documents only, or in text segments that are currently
displayed in the “Retrieved segments” window only.

The following further options are available:

Find whole words – If the option is enabled, the search for “or” will not find, for example, “Inventor”
or "Elevator". This option is available only if searching for words in the go list or if you enter specific
search items.   

Case sensitive – If this option is enabled, the search for "You" will not find the lowercase form "you".
This option is available only if searching for words in the go list or if you enter specific search
items.  

Context x Words – Specify how many words to include before and after the keyword. The default
setting is 5 words.

Include favorite variables – Set this option to display document variables that are marked as
favorite variables under Variables > List of Document Variables in their own columns. In the results
table, right-hand columns are displayed with the variable values of their respective documents, so
that when you look at the results, in addition to the verbal context in the form of the surrounding
words, the content context can also be included in the form of variable information of the document
in which the keyword appears.

When you click OK the following results table appears:

Results table

Results table for “Keyword-in-context”

The upper section of the table displays which keywords were searched for, and how many
occurrences were found in how many documents and document groups. The table contains one
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occurrence in each row and shows which document the respective keyword was found in along with
its position.

Tip: The results table is interactive. Click on a row to highlight the search term in the original text in
the Document Browser.

The table is sorted by keyword in ascending order each time it is opened.

Results table toolbar

On the left side of the toolbar you will find the usual icons for tables to filter, search and select the
displayed columns. Next to them are icons and functions specific to keyword-in-context:

Autocode search results – Autocodes search results with an existing code. All search hits that
are not excluded from autocoding and marked with a stop symbol  in the first column will be
autocoded.

Autocode search results with a new code – Encodes the results list with a new code. All search
hits that are not excluded from autocoding and marked with a stop symbol  in the first column will
be autocoded.

Autocode/Export: Ignore hit – Select one or more rows in the list and click this button to
exclude these search hits during autocoding or export. Alternatively, you can double-click the green
symbol at the beginning of a row to exclude the search hit.

Refresh – Recalls the dialog box with the options settings.

 Send to QTT Worksheet – In the Questions – Themes – Theories (QTT) workspace of
MAXQDA, you can collect and comment on all the important results of your project. Click on this
icon to save the results table in an existing or new worksheet in the QTT workspace. The currently
visible area of the table is sent to the QTT.

In the right margin, the toolbar also provides various export options. All rows excluding those with
stop symbols will be exported (independent of row highlighting).

Word Combinations
What is the “Word Combinations” function?

The word combinations function provides an overview of the most frequent combinations of up to 5
words, and word combinations which occur more rarely in selected texts. The function operates
similarly to the Word Frequency feature, in that not only individual words but combinations of up to 5
words can be listed.

Opening the function and selecting settings

Begin the search for word combinations via the function MAXDictio > Word Combinations in the

https://www.maxqda.com/help-mx24/word-frequencies/word-frequencies-analyze-word-frequencies
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ribbon menu. The following dialog window will appear:

Set options for defining word combinations

Number of words

At the top of the dialog window, define how many words to include in the word combination. You can
search for combinations of up to 5 words. The setting “Search for word combinations with 3 to 3
words” will search for all word combinations with exactly 3 words. The setting “Search for word
combinations with 2 to 4 words” will list all 2,3, and 4 word combinations.

Selection of texts to be analyzed

Only for activated documents: This option restricts the analysis to currently activated documents.

Only in "Retrieved Segments" window: This option restricts the analysis to text segments that are
currently displayed in the “Retrieved segments” window.

If neither option is selected, all text and table documents in the MAXQDA project will be analyzed.

Differentiation of results

None: The results table will not contain any differentiation of results, but only the totals across all
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analyzed texts.

By documents, document groups, document sets: The results table will contain additional columns
that can be used to compare the frequencies of word combinations of the individual documents,
document groups or document sets. With the option Only activated documents, only the activated
documents are taken into account within the document groups or document sets, and only the
groups and sets with documents that are activated are included.

By Codes: This option is only available if the analysis is restricted to the segments in the “Retrieved
segments” and a “Simple Coding Query” has been performed. The results table contains additional
columns of frequencies for each code that appears in the “Code System”. This option is particularly
useful if you have divided texts into text segments using codes for analysis in MAXDictio, as it
allows you to compare the frequencies of word combinations within different codes.

Ignore

If you want to ignore certain word combinations from the analysis, such as Email adresses or
hashtags, select the corresponding entries.

Further options

Min. number of characters: Words containing fewer characters than specified here will not be
included in the analysis. The default option is set to 1 character. If this option is increased to 2
characters, words such as “he” and “it” will be excluded from the analysis and treated as words on
the stop list.

Apply stop word list: Check this box to apply a stop list. Clicking on the button with 3 dots (...) will
open the stop list window where stop lists can be selected and edited.

Case sensitivity: When this setting is activated, the word combination “Go home” will be treated as a
different word combination than “go home”. When the setting is not activated, all words will be
displayed in lowercase in the results table.

Only word combinations within sentences: The definition of the word combinations in MAXDictio is
such that all words of a text are written successively into a series. Up to 5 consecutive words then
form the word combinations, ignoring paragraphs, points, exclamation marks etc. between words.
Therefore, it is usually useful to turn this option on to ignore all word combinations that go beyond
the end of a sentence.

Example: “It is warm. I am going home.” If the above option is not activated, the two-word
combination “warm I”, which are unrelated, would be counted.

Hint: Sentences are defined by MAXQDA according to the following rules: A sentence always begins
following a period, question mark, exclamation mark, or colon. The following exceptions apply:

A number that is not four digits appears before a period (e.g. 1. or 2.).
A single character appears before a period (to exclude abbreviations).
Two identical characters appear directly before a period (e.g. ff. or pp.).
Literal speech in quotation marks belonging to the sentence itself.
First letter after a sentence is in small letters.
A number appears directly following the end of a sentence.
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Quotation marks appear immediately after the end of a sentence.
After a paragraph, a new sentence begins, without exception.

Only word combinations within parts of sentences. Separators …: Often, it is not logical to count
combinations of words that are separated by, for example, a comma. It is therefore advisable to
activate this option in order to obtain a breakdown of sentences into parts of sentences. Separators
are defined by clicking the button with 3 points (...). By default, the following characters are defined
as separators:

; , – ( ) … [ ]

Example: “I’m tired, so I’m going home.” If the above option is selected, the sentence will be
separated into two parts by the comma, so the 2-word combination “tired so” would not be counted.

Lemmatize words: If this option is activated, each word is returned to its basic form using a lemma
lexicon in the selected language. For example, the words “give”, “gave”, and “given”, would be
counted only as “give”.

When you click OK, the analysis of word combinations will begin. Depending on the length of the
text, this process may take a few moments. A display will inform you about the progress of the
analysis.

Results table

Results table for “Word combinations”

The table above displays the number of documents included in the analysis and the number of word
combinations found. The table is automatically sorted by frequency each time it is reopened, with
the most frequent word combination appearing in the first row.
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The columns and information displayed (including toolbars) are the same as those described here:
Word Frequencies: Table of Results, the only difference being that word combinations, rather than
individual words, are displayed.

Lemmatization and stop word lists

How do lemmatizaion and application of a stop word list affect the results?

Stop Word Lists

If a word within a word combination, or a word combination itself appears on the selected
stop word list, the word combination will be ignored.
If part of a word combination appears on the stop word list, the entire word combination will
be ignored.
All words will be lemmatized. The combinations of lemmatized words will be output.

Interaction of lemmatization and stop word lists

If a lemmatized word appears on the stop word list, the combination will also be ignored.
If a lemmatized combination appears on the stop word list, the combination will be ignored.
If a lemmatized part of a combination appears on the stop word list, the entire word
combination will be ignored.

Word Tree
What is the Word Tree function?

The word tree allows you to visually explore and analyze words and word combinations in their
respective contexts. The more frequently a word or phrase occurs, the more prominent it appears in
the tree. The word tree is interactive in two ways: First, it can be navigated through its individual
"branches" to visualize words in their contexts. Second, the data is interactively linked to the original
texts, so that you can view words and phrases in MAXQDA's Document Browser. These features
make the Word Tree a visually supported form of keyword-in-context (KWIC) analysis.

Word trees were originally developed by Wattenberg and Viégas (2008) ("The Word Tree, an
Interactive Visual Concordance") and have since become part of the standard repertoire of text
exploration tools.

Opening the function and select texts

To create a Word Tree, go to MAXDictio in the ribbon menu, and select Word Tree . The following
window will appear, in which you can use the mouse to import text or PDF documents from the
“Document System” window.

https://www.maxqda.com/help-mx24/word-frequencies/word-frequencies-analyze-word-frequencies
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Selection of texts for the Word Tree

Alternatively, click the All activated documents button to add the currently activated text and PDF
documents to the existing selection.

Click OK to begin creating your Word Tree. Progress of this operation is indicated in the display. 

The Interactive Word Tree function

The following figure shows a Word Tree for the UN Declaration of Human Rights created in
MAXDictio.

Word Tree for the UN Declaration of Human Rights

The Word Tree window is structured as follows:

The actual Word Tree is displayed in the left pane.
The right pane contains the original text without formatting. If several texts have been
selected, they are displayed one after the other.
In the upper window area, a toolbar allows you to adjust the view and to export the tree.
The Word Tree is created according to the following logic:
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The most frequent word is shown on the far left, in the example "the". This word forms the
root of the Word Tree. The next most frequent word following the root word is displayed on
the top branch, in the example, "right". The word "United" is the next most frequent word and
is positioned at the second branch from the top. According to this logic, each branch of the
tree grows longer, until only one phrase remains in the form of one branch per line.
Stop words are not applied to avoid breaking the reading flow.
Punctuation marks such as periods are considered single words.
The visible portion of the word tree is displayed in the display pane. The number of currently
displayed branches with different text lines is displayed in the upper toolbar. If there are more
branches than space, the number of currently visible branches is displayed, followed by the
total number of branches in parentheses. In the example above, 34 of a total of 120 branches
are visible.
The tooltip that appears when you hover over a word with the mouse shows how often this
word appears in the analyzed texts. The following figure shows that the word "right" appears
33 times in the Declaration.

The tooltip shows the frequency of the highlighted word

Selecting sentences and extending the root

Click on a word in the tree with the mouse to define all words from the previous root to the selected
word as the new root of the tree. One can imagine observing a braThe nch with binoculars and
ignoring the other parts of the tree. The following screenshot displays the view of the tree after
clicking the word "to" in the upper part of the tree:
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Display of the updated Word Tree:  The root of the tree is now “the right to”.

Between the three words “the right to”, horizontal lines are displayed to show that “the” and “right”
are followed by other words and phrases, but this word combination has been selected as the
current root. As shown in the upper toolbar, the word combination "the right to" appears a total of 26
times in the text.

Please note: If there is no horizontal line displayed between two words (such as “freedom of” in the
example), there are no further branches after the displayed branch. In this case, the first word in the
text is always followed only by the second.

To shorten the root, click on one of the preceding words in the root. In the example above, clicking
the word “the” shortens the root to this word.

Tip: Click the Undo changes icon  to restore the previous views of the tree step by step.

Using words or word combinations as the root

You can make any word or phrase in the tree the new root by holding down the Alt key and clicking
the word. The clicked word immediately becomes the new root.

The words in the right pane containing the analyzed text are also interactive: click a word to make it
the new root.

Search for words and phrases

One of the main functions of the Word Tree is to search for interesting words within a text and to
explore them in their respective contexts. To this end, a search field is located at the top of the
window. Hit Enter key to begin the search process; if there is a hit, it will go directly to the new root
of the tree:

Searching words within the text

Jumping to the original text

The right pane contains the complete analyzed text; if several text documents are selected, these
are displayed one behind the other. The yellow-highlighted text corresponds to the phrases shown in
the tree. The yellow highlighting on the scroll bar shows the positions of the phrases in the text to
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provide better orientation.

Right-click a yellow highlight in the text and select View in Document Browser to display the
associated document in the “Document Browser” and highlight the corresponding text for further
exploration.

Tip: Hover over the right pane of the display window to display the document name in the tooltip that
appears.

Placement of the root: start, center, end

By default, the word of interest is displayed on the left, so you can examine which words follow. If,
however, you want to analyze which words appear in the text before the word of interest, you can
adjust the placement of the root using the three icons on the upper left of the screen:

Root: start – The root, that is the selected phrase, is left-justified in the window so you can
examine which words follow.

Root: center – The selected phrase is displayed in the center of the window, so you can
examine which words appear before and after. Clicking a word on the right half of the tree extends
the root to the right; clicking a word on the left extends the root to the left.

Root: end – The selected phrase is right-justified in the window so you can examine which
words appear before it.

The root “freedom” in the center position

Store Results Table in a QTT Worksheet

In the Questions – Themes – Theories (QTT) workspace of MAXQDA, you can collect and comment
on all the important results of your project. To save the the Word Tree in an existing or new

https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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worksheet in the QTT workspace, you can use the  Send to QTT Worksheet icon in the upper right
corner in the toolbar.

Exporting your Word Tree

For documentation and presentation, you can copy the currently displayed Word Tree to the
clipboard by clicking the Copy current display as an image to clipboard icon  to insert a graphic of
the tree into a word processor such as Word or a presentation software such as PowerPoint. For
better quality, the number of pixels is doubled relative to the view.

Word Matrix Browser
The Word Matrix Browser visualizes how frequently words occur in documents. In the rows, selected
search words or categories of the dictionary are presented, the columns are formed by documents,
document groups, or document sets.

The Word Matrix Browser

Starting the Function

Call this feature via MAXDictio > Word Matrix Browser in the main menu tab. The following dialog
box appears:
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Set options for Word Matrix Browser

In the left window pane, select the keywords you would like to search for. Three options are
available:

Search items of dictionary – All words in the currently selected dictionary will be searched for. The
search options set in the dictionary are applied (case-sensitive, only whole word, beginning of the
word). The corresponding options in the Word Matrix Browser dialog window will be ignored.

Search items of go word list – All words contained in the currently selected go word list will be
searched for.

These search items: – Enter the desired search terms in the list. The items can contain spaces. Hit
the Enter key to move to the next line.

In the right pane of the window, you define the texts to be included in the search. You can choose to
search in all documents, in activated documents only, or in text segments that are currently
displayed in the “Retrieved segments” window.

The following further options are available:

Find whole words – If the option is enabled, the search for “or” will not find, for example, “Inventor”
or “Elevator”. This option is available only if searching for words of the go word list or if you enter
specific search items.

Case sensitive – If this option is enabled, the search for “You” will not find the lowercase form “you”.
This option is available only if searching for words in the go word list or if you enter specific search
items.

In addition, you define which units should be shown in the columns, i.e., how much the documents
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are aggregated:

Documents – Each document is displayed in a single column.

Document groups – Each document group gets its own column. The selection top level means that
the document subgroups are not output separately, but all documents contained in them belong to
the top group. The second level selection means that all subgroups get their own column,
documents from the upper groups are ignored. If the In activated documents option is enabled, only
groups with activated documents are included.

Document sets – Each document set gets its own column. If the In activated documents option is
enabled, only sets with activated documents are included.

When you click OK, the Word Matrix Browser appears.

Customize Display

The operation and the display options of the Word Matrix Browser correspond to those of the Code
Matrix Browser and are described there in detail. The export options are described there, too.

Interactivity

The display is interactive: double-click on a node to list the search words found in the respective
documents, document groups, or document sets.

Store View in Questions – Themes – Theories

In the Questions – Themes – Theories window, you can collect and comment on all the important
results of your project. Click the Send to QTT Worksheet icon in the upper right corner to save the
current view in a new or existing worksheet.

Managing Dictionaries
The Dictionary function

MAXDictio allows you to create and manage dictionaries. A dictionary consists of one or more
categories in which search terms can be defined. You can manage dictionaries by opening
MAXDictio > Dictionary.

The following predominantly blank window will appear:

https://www.maxqda.com/help-mx24/visual-tools/code-matrix-browser-visualizing-codes-per-document
https://www.maxqda.com/help-mx24/visual-tools/code-matrix-browser-visualizing-codes-per-document
https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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Window for managing dictionaries

The window is divided into several sections:

1. Dictionaries of project

This section lists all the dictionaries that are stored in the project file. If you open the project file on
another computer in MAXQDA or send it to another person from a team by email, the dictionaries
listed here will be available.

A new project contains a dictionary entitled <Standard>, which is initially empty and can be renamed
as you please. 

Each project contains at least one dictionary; all dictionaries cannot be deleted.

2. Global dictionaries

This section lists all the dictionaries that are not stored in the project file, but in the current MAXQDA
installation itself. These dictionaries are available for each project opened with this MAXQDA
installation.

If you open a project on another computer with MAXQDA, these dictionaries may not be available.

3. Categories and search items

In these sections, the currently selected dictionary can be edited. The “Categories” section contains
categories in the form of a tree or linear list. The “Search terms” area contains the terms of the
respective category and allows you to define the search options for the respective term.

Select active dictionary

Click on the name of a dictionary to select it and make it the active dictionary. The corresponding
categories and search terms will be displayed in the right pane. The currently selected dictionary can
be identified by its blue or grey background.

Hint: If you have selected a global dictionary and open the project on a computer where this
dictionary is not available, MAXDictio will automatically select the next dictionary on the list.
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Create a new dictionary

To add a new dictionary to the project, click the  icon.

Icon for adding a new dictionary to the project

A new dictionary will be added to the project and opened. By default, this dictionary will be named
“New dictionary” with a sequential number as required in order to avoid duplicate names. The
dictionary name can be modified directly.

Create categories and sub-categories

In MAXDictio basic and hierarchical types of dictionaries can be created. Hierarchical dictionaries
are similar to the “Code System” of MAXQDA, as subordinated levels can be switched on or off as
desired. There is no limit to the number of levels, but a dictionary normally doesn’t have more than
three levels.

A dictionary consists of categories and sub-categories as well as a list of the search items that are
allocated to each category.

Please note: A dictionary in MAXDictio can contain any number of categories. Exactly one list of
search items belongs to each category. The number of search items is unlimited as well.

To add a new category, click on the New category button on the left side of the toolbar. Then a
new category title can be entered.

Please note: The title is not restricted to a certain length or form. It can also consist of several
words, such as “old-age pension.” The title of a category can be modified later without effecting the
dictionary itself.

After clicking on New category, MAXDictio will add a category named “Category #.” Here the
character # stands for the sequential number of the category in the existing category system.
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The illustration above shows that there are already three defined categories, namely:

apostles
persons
places

After clicking on New category , MAXDictio will add a new category named “Category 4” at the
bottom of the list.

In most cases, you will want to change the title into a more meaningful title. To do so, double-click
on “Category 4” and enter the new title.

Transfer category names from the “Code System”

The hierarchy and code names can be transferred directly from the “Code System” to the currently
selected dictionary:

First, activate the desired codes in “Code System”.1.
Next, click the Insert codes from “Code System” window as categories  icon.2.

MAXDictio will ask if only the activated codes should be accepted and then inserts the new
categories into the tree. Existing categories names on the same level will not be inserted twice, but
rather their subcategories will be integrated.
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Insert categories from the “Code System” window

Tip: You can also drag and drop a code from the “Code System” into the category window. The code
name and related subcode names will be inserted in the dictionary.

Sort and organize the category system

The category system can be displayed as a list or as a hierarchical tree.

When using the hierarchical view, the category system may be organized in the same way as the
“Code System” in MAXQDA: by dragging the mouse, categories can be placed at the desired
position.

The hierarchical view of the category system

When working in list view (see the following figure) you may sort the whole category system by
clicking on the column’s header.
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The list view of the category system

Please note: The “Number” column contains an identification number that is created in the
sequence the categories were created. Thus, the category defined first, is associated with the
number 1.
Turn categories on and off

Categories may be switched on and off so that you can decide which categories will be counted by
MAXDictio. How to switch off a category:

double-click on the folder symbol left to the category name
or right-click on the category and select Deactivate Category.

The icon in front of the category name will change to a stop sign. This shows that the category will
not be included in the analysis.

The stop sign in the first column indicates that the category “places” is turned off

Add search items

To add category search items, select the desired category by clicking on it with the left mouse
button. Then click the New search item button in the toolbar . Now it is possible to enter a new
search item. However, it is much easier to take a search item directly from a word frequency list and
add it to the appropriate category (see description below).

An easier way to add terms it to simply drag them in from a word frequency list or right-click on
them there and choose to add them to the dictionary.
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A new search item is added to the category system

You can also use the wildcars ? for any character and * for one or more characters in the search
items. These wildcards are considered in the dictionary-based content analysis. For example, if you
enter i*tion as the search term and apply the "Whole word" option, all words that begin with "i" and
end with the syllable "tion" will be counted, that is, both "indication" and "innovation" would be
counted.

However, in the "Word frequencies (dictionary words only)" function, words are analyzed for exact
match with the entered search items and wildcards are ignored, that is, the occurrence of the string
i*tion is counted.

Please note: Only one wildcard can be used per search term. Additional wildcards in the search term
are treated as normal characters.

Delete search items

Individual or multiple search items can be deleted from the list by selecting them and then clicking
on Delete search item.

Tip: Several words can be selected by using the combinations Ctrl (Win) or cmd (Mac) + left mouse
button or Shift + left mouse button (to select all of the words between an already selected word and
another).

Turn search items on and off

Each search item of a category can be turned on or off individually for the analysis. The procedure is
the same as with the categories. The symbol next to each word indicates its state: green point = on,
stop sign = off.

Set options for the search items

Options can be set for each search item. Search items are strings of characters whose occurrences
are supposed to be investigated in the text. These can be individual words, parts of words (such as
the stem of a word), or terms consisting of several words or strings of characters.

The following options are available:
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Whole word – only words that match completely with the search item will be counted

Case sensitivity – case will be taken into consideration

Starting letters – the search item must appear at the beginning of a word

Examples:

Whole word “president“ will code President, but not presidential

Whole word and
Case sensitivity

“president“ will not code President

Starting letters activated “tree“ will code trees and treehouse

Starting letters deactivated “tree“ not only codes tree, but also street

Transfer words from the word frequencies list into a dictionary

Each word that is contained in a word frequency list can be sent directly to the dictionary:

The best way to do this is to open both lists and arrange the windows on the screen so that1.
they are next to each other and can be seen at the same time.

Click on that category in the dictionary window in which you would like to add words.2.
To transfer a word from the word frequency into the chosen category, you can either3.

double-click on the desired word in the frequency list, ora.
drag the desired word with the mouse on a category name or in the list of searchb.
items, or
use the button Add to dictionary or select the equally called entry in the contextc.
menu.
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Transfer search items from one category to another

Using drag-and-drop you can easily transfer search items from one category to another. The search
item will be removed from the old category immediately. The setting options for the given search
item (such as “whole word”) accompany the word to the new category.

Duplicate, rename and delete dictionaries

Dictionaries can be duplicated, for example if you wish to modify a dictionary while retaining the
original version. Right-click the name of a dictionary and select Duplicate. Thereupon the dictionary
will be duplicated and inserted. The duplicate will have the same name as the original dictionary,
supplemented with a sequential number.

To rename a dictionary, highlight it with the mouse, then click again to enter a new name.
Alternatively, you can right-click the name of the dictionary and select Rename.

The option for deleting a dictionary is also located in the context menu.

Functions for dictionaries in the context menu

Use a dictionary in other projects

To save a project-specific dictionary as a global dictionary for use in other projects, right-click the
name of the dictionary and select Save as Global Dictionary. The dictionary will be duplicated and
inserted under the same name in the lower pane. If the name already exists, a sequential number will
be added.

In turn, the global dictionaries can be transferred to any project:

Right-click an entry in the lower pane, “Global dictionaries”.1.
From the context menu, select Copy Into Project.2.

Tip: Dictionaries can be conveniently dragged and dropped between the “Dictionaries of project” in
the upper pane and “Global dictionaries” in the lower pane.
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Merge dictionaries

MAXDictio allows multiple dictionaries to be merged

Right-click on a dictionary.1.
Select Copy to other dictionary from the context menu.2.
Select the target dictionary from the menu that appears.3.

Copy search items from one dictionary to another

After selecting the target, a request appears to confirm whether you want to continue. If you agree,
the two dictionaries will be merged, that is, all categories and search terms from the source list will
be inserted into the target dictionary, ignoring already existing entries.

Export and print dictionaries

Dictionaries can be exported into other programs, for example, for editing, printing, or for
documentation or archiving purposes.

Right-click the dictionary and select Export, or click the Export  icon in the toolbar to1.
export the currently displayed dictionary.
In the dialog window that appears, enter a file name and location.2.

The exported file will be saved in TXT format (UTF-8) and can be opened, edited and printed in text
editing programs, Excel, or word processing programs.
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Exported dictionary in Excel

Add and supplement dictionaries

MAXDictio allows you to import dictionaries from TXT or Excel files as well as from the previous
MAXDictio format, MXD, as new dictionaries. In addition, existing dictionaries can be supplemented
with files in TXT or Excel format.

Click the Import dictionary icon to create a new dictionary from a file.

Click the Add Dictionary icon to add the words of the imported dictionary to the categories and
search terms of the currently displayed dictionary.

Since the introduction of MAXQDA 11 for Mac, MAXDictio has created a new, simple import format
for importing and exporting dictionaries from files. If you wish to import a dictionary from Excel,
create an Excel file that contains the following columns:

Category Search item Whole
word

Case
sensitivity

Starting
letters

Category
activated

Search item
activated

Category 1 Search
Item 1

0 0 0 1 1

Category 1 Search
Item 2

0 0 0 1 1

Category 1/Subcat.
1.1

Search
Item 2

1 1 0 1 1

Category 1/Subcat.
1.2

 1 1 1 0  

Category 1/Subcat.
1.1/Subcat. 1.1.1

 1 0 0 0 1

Tip: The easiest method is to next export an empty dictionary, because MAXQDA automatically
creates an Excel file with the necessary column headings.

Each search term of the dictionary has its own row. In the “Category” column, specify the category
where subcategories can be created using the slash “/”. The search string must be entered in the
“Search item” column. The other columns can be used to switch the available dictionary options on
and off.  A “1” stands for “yes” and a “0” stands for “no”.

Tip: To create a backslash on a Mac, use the keyboard combination Alt + Shift + 7.

When importing, MAXDictio adheres to the following rules:

Column order is irrelevant.
The order of rows determines the sorting of categories in tree view.
If a category is set to “on” somewhere in the file, it is switched on.
If the “Category activated” or “Search item activated” columns are missing, the search terms
and categories are all set to “on”.
All values different than “1”, or missing values, will be interpreted as “0”.
If a word a category already exists, it will be ignored.
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Rows in which categories but no search terms have been defined will be inserted as empty
categories.
Rows in which categories but no search terms have been defined will not have entries for any
of the three options.

Save location of global dictionaries

Global dictionaries are stored by MAXDictio as files in TXT format (UTF-8) in the following file folder,
and can also be edited there using external programs:

Windows

Documents > MAXQDA24 > Dictio > Dictionary

Mac

Documents > MAXQDA > MAXQDA24 > Dictio > Dictionary

All TXT files in these folders will be displayed as dictionaries in MAXDictio.

Dictionary Based Content Analysis

The Category Matrix Browser
The Category Matrix Browser graphically displays the frequencies of the dictionary categories per
unit of analysis. The categories of the dictionary form the rows while the evaluated texts form the
columns:

The Category Matrix Browser

Call up the function via MAXDictio > Category Matrix Browser in the ribbon menu. The following
dialog window will appear, in which you can set whether the documents, document groups or
document sets will be displayed in the columns:
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Setting options for the Category Matrix Browser

If you select the option Only for activated documents, only the documents activated in the
“Document System” will be included in the display. Document groups and document sets without
activated documents will not be displayed.

The nodes of the Category Matrix Browser contain the results of the count of the category
frequencies. The larger a square, the more occurrences of the search terms of the respective
dictionary category were found in the analyzed document, document group or document set.

Tip: The display is interactive. Double-click a node to display the search hits in the original text. 

Customize display

The operation and the display options of the Word Matrix Browser correspond to those of the Code
Matrix Browser and are described there in detail. The export options are described there, too.

Export results

The icons on the right can be used to export the current view as an image or to insert it into a QTT
worksheet. The frequency matrix used for the display can also be exported in Excel, HTML, or TXT
format.

Hint: When exporting as a table, rows and columns are swapped to allow for easy analysis with
statistical programs. The rows will therefore contain the units of analysis (cases) and the columns

https://www.maxqda.com/help-mx24/visual-tools/code-matrix-browser-visualizing-codes-per-document
https://www.maxqda.com/help-mx24/visual-tools/code-matrix-browser-visualizing-codes-per-document
https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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will contain the categories (as variables).

Category Trends
Using Category Trends, you can analyze where and how often a code has been applied in texts.
When analyzing a single document, the text is divided into sections of equal length, and the
frequencies of search items of the dictionary categories in each section are visualized in a line chart:

Category Trends for a single document

If you call Category Trends for multiple text documents, you can analyze how the usage of category
search items changes across the texts. Category Trends for multiple texts is particularly useful for
time series analysis where each document represents a point in time.



  630

Category Trends for multiple documents

Create Category Trends for a single document

Open the text document for which you want to analyze Category Trends.1.
Select Visual Tools > Category Trends > Single Document from the main menu. The Category2.
Trends window will open.
In the left pane, select the dictionary whose entries you want to analyze. If you do not want to3.
include all the categories of the dictionary, you can click the button with the three dots to
deselect individual categories.

Tip: Alternatively, you can call up Category Trends by right-clicking on a document in the “Document
System” (using the Trends menu item).

Create Category Trends for multiple documents

Select Visual Tools > Category Trends > Multiple Documents from the main menu. The1.
Category Trends window will open.
Click the Select Document icon or button and specify which text document to include.2.
In the left pane, select the dictionary whose entries you want to analyze. If you do not want to3.
include all the categories of the dictionary, you can click the button with the three dots to
deselect individual categories.

Tip: Alternatively, you can call up Category Trends by right-clicking on a multi-selection of
documents in the “Document System” (using the Trends menu item).

Options for analysis and presentation

The Start menu tab provides numerous options to customize the analysis and the results display:

Scale – Switch between three variants:
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Absolute frequencies (How often does a hit of a category appear?)
Category % (What percentage of all hits are from one category relative to the other
categories?)
Coverage % (What percentage of the section/document does a hit occur in? If a word is found
multiple times with different search terms, it is counted each time, which can lead to higher
values for a category.). 
Sections [only for single document] – Select the number of sections to be visualized.
Display Document Names as Labels [only for multiple documents] – If enabled, the document
names are displayed instead of consecutive numbers.
Colors – Choose between different color schemes for the display.

List hits

Click on a node in the chart to get a listing of hits in that section or document:

Interactive display for a section
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Listing of search hits for a dictionary category

Tip: Click on a line in the listing to display the search hit in the “Document Browser”.

Test for uniform distribution

Hover over a category in the legend to get the results of a Chi-Square test for uniform distribution.
The displayed Chi-Square value and the p-value allow you to assess to what extent the observed
category frequencies match the hypothesis of a uniform distribution across all sections or
documents. A p-value below 0.05 is generally considered an indicator of statistical significance,
meaning that the observed category frequencies do not align well with an assumed uniform
distribution.

Store results in a QTT worksheet
In the Questions – Themes – Theories window of MAXQDA, you can collect and comment on all the
important results of your project. In the upper right corner of the Start menu tab of the Trends
window, click on the icon  Send to QTT Worksheet, to store the results in a new or existing
worksheet. The current display will be saved as an image.

Export and print results

On the top right of the Trends window, you will find various options to export the current view, for
example, to insert it into your results report:

Copy Display – Copies the current view to the clipboard so that you can paste the results into
a software of your choice, for example, by using Ctrl-/cmd+V.
Export – Exports the current view as a graphic file.

By clicking on the printer symbol, also at the top right, the current view can be printed directly.

https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories


  633

Autocode Documents with Dictionary
Categories
The lexical search in MAXQDA allows you to search for words within text, PDF and table documents,
and to encode the search results automatically with a code. MAXDictio extends this possibility
enormously by making it possible to automatically encode the search terms of a dictionary category
with the name of the category.

To automatically encode texts using the search terms of a dictionary start the function MAXDictio >
Autocode with Dictionary. In the dialog window that appears, select the appropriate settings and
choose one of the dictionaries from the list.

If the project doesn't include a dictionary yet go to MAXDictio > Dictionary to create a new
dictionary. Visit Managing dictionaries for more information on creating and editing dictionaries.

Autocoding options

Select dictionary - Here you can select the dictionary you want to use for the autocoding process.

Ignore inactive categories – If a category in the dictionary has been switched off by with a double-
click and displays a stop symbol , its search terms will be ignored and no code with the category
name will be created in the “Code System”.

Only in activated documents – Autocoding is only performed in activated documents.

Only in ‘Retrieved Segments’ – Autocoding is restricted to text segments displayed in the “Code
System”.

When you click OK, the codes for the dictionary categories will be created in the “Code System” and
the following dialog box will appear, where you can define the usual options for the weight of the
coded segments and the scope of the texts to be coded.

https://www.maxqda.com/help-mx24/managing-dictionaries
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Options for autocoding: set weight and text range

Click Autocode. A display will appear which indicates the progress of the operation until all hits are
coded.

Tip: If you have used the function MAXDictio > Dictionary-Based Content Analysis, you can also
start autocoding directly from the results window using the icon

 Autocode documents with dictionary categories.

Topic Modeling
Please note: Topic Modeling is only available in TeamCloud projects.

Topic Modeling is a method from the world of Natural Language Processing (NLP). With the help of
unsupervised machine learning, text documents are statistically analyzed for word patterns in order
to compile words into groups (the so-called "topics"):
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The first three topics of a topic model

Topic Modeling in MAXQDA

Topic Modeling in MAXQDA is primarily used for the exploration of data. Topic Modeling helps you
to identify topics in your documents or survey responses and to include the identified topics in your
analysis:

The identified topics can be saved as dictionary categories containing the corresponding
words. You can then use the dictionary for autocoding and dictionary-based content analysis.
The dominant topic in each analyzed document can be recorded in a document variable.
The documents can be assigned to document sets according to the dominant topics.

Recommended procedure for Topic Modeling in MAXQDA

In general, you should follow these steps when using Topic Modeling in MAXQDA: 

1. Preparation: Create a stop word list for the data

Get an overview of the words that occur in the texts to be analyzed using the MAXDictio > Word
Frequenciesfunction. Transfer all words that do not carry meaning to a stop word list to ignore them
in the later analysis.

2. Create the first model

Consider in advance whether you expect many different topics or only a few. The more different and
diverse the documents are in their words, the larger the number of topics should be chosen.
MAXQDA defaults to 6 topics, which is rather a small number.
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Create the first topic model as described below.

3. Check the model and create alternative models if necessary

Check the coherence of the words of the individual topics and, if necessary, try out alternative
models with more or fewer topics. To evaluate the model, you can also use the Topic Document
Matrix, which shows the probability that a topic occurs in a document. If there are many different
dominant topics in the documents, even if they are not very diverse thematically, then a model with
more topics is probably more appropriate.

If necessary, exclude more words from the analysis by adding them to the stop word list.

In general, it is helpful for the interpretation to use MAXDictio > Keyword in Context or MAXDictio >
Word Frequencies in parallel to the Topic Modeling window to check in which contexts words are
used and how often they occur.

4. Name the topics

Name the topics with an abstract term that summarizes the words they contain.

5. Use and save the topics

Save the dominant topic per document automatically as a document variable or create
corresponding document sets with the respective documents. Create a dictionary with the words per
topic.

Save the topics in the Questions - Themes - Theories (QTT) workspace or export them to Excel.

Prerequisite for performing Topic Modeling in MAXQDA

In order to obtain meaningful results with Topic Modeling, it is necessary that not only a few
documents with very similar most frequent words are analyzed. With less than 30 documents,
meaningful results can hardly be expected; using survey data with 100 cases or more, the chances
to get meaningful results are greater.

Please note: The analyzed texts must stem from different documents. It is therefore (currently) not
possible to analyze tweets or YouTube comments if several tweets or comments are located in one
table document.

How to start Topic Modeling

Activate all documents that you want to include in the analysis.1.
Start MAXDictio > Topic Modelingfunction.2.
Choose desired settings in the dialog:3.

Number of topics1.
Restriction to certain documents or segments2.
Ignoring certain content and stop words3.
Lemmatization (reduction of words to their base form)4.

After clicking OK the calculation starts. Topic Modeling is a very computationally intensive process
and can therefore take several minutes, even with smaller amounts of data.

https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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Tips: (1) You can continue working with other MAXQDA functions during the calculation. The
calculation will continue if you leave the window open. (2) If you closed the window after the
calculation, you can open it again via MAXDictio > Topic Modeling > Last Result Topic Modeling.

The results window

In the result window, the identified words per topic are presented:

Naming Topics in the Results Window

The more important a word is for a topic, the larger and more colored it is displayed in the word
cloud and the higher up it will be presented in the list view.

The following options are available in the Results window:

Using the icons above the topics, you can switch the view from list to word cloud.
To name or rename the individual topics, click on the current name.
To ignore a topic for further analysis, click the crossed-out eye icon. Disabled topics are
ignored in the following functions: “Topic Document Matrix” and “Save Topics as
Dictionaries/Variables/Document Set”.
At the top left of the ribbon, you can change the number of topics and the number of words
displayed per topic. If you change the number of topics, the calculation will be restarted, and
the set topic labels will be reset.
On the top right you can save the current view in QTT, copy it to the clipboard, or export it.

https://www.maxqda.com/help-mx24/questions-themes-theories/the-idea-behind-questions-themes-theories
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Topic-Document-Matrix

Via Start > Topic Document Matrix in the result window you can call up a visualization that shows
which topics dominate in which document.

Topic Modeling Document Matrix

The calculated probabilities that a topic occurs in a document serve as the basis for the
visualization. The probability value between 0 and 1 is multiplied by 100 for the display.

Using the icons above the display, you can adjust the display, for example, you can switch to a
heatmap view as shown in the image above. The functions in the toolbar are described in detail in
the Code Matrix Browser section of the manual.

Saving results

The assignments of words to topics and the probabilities of topics per document can be saved as
follows:

Save Topics as Dictionaries – A new dictionary is created in MAXDictio. The topic names are used
as category names and the top words per topic are entered as search items. You should check the
dictionary for duplicate words, because it is possible that the same word is significant for different
topics (usually with different weighting).

Save Topics as Document Variable – A new document variable is created and for each analyzed
document the topic name with the highest probability is entered. If several topics are equally likely,
“not defined” is entered.

Save Topics as Document Sets – One document set is created per topic in the “Document System”
window. Each document is assigned to the topic set with the highest membership probability.

Topic Modeling for Survey Responses

If you use the Analysis > Categorize Survey Responses</strong > feature to code your survey
responses, you can invoke Topic Modeling directly from the analysis window in the Start menu.

Only the currently displayed responses are considered in the analysis.

https://www.maxqda.com/help-mx24/visual-tools/code-matrix-browser-visualizing-codes-per-document
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Concluding remarks

Topic Modeling is a statistical modeling technique that does not consider the meaning of
words. Accordingly, results may differ from subjective expectations.
MAXQDA uses Gensimwith the Latent Dirichlet Allocation (LDA) algorithm to determine the
topics. To reproduce the results in Gensim: MAXQDA uses 50 iterations and sets 1 as the
random state to always obtain the same results for the same input.

 

Analyzing Japanese texts
The functions of MAXDictio are based on algorithms which are used to separate words by spaces or
other separators. In syllable-based languages, e.g. Japanese, there are no spaces between words,
therefore this way of differentiation is not possible.

MAXQDA can utilize the module MeCab: Yet Another Part-of-Speech and Morphological
AnalyzerMeCab for Japanese word separation and for optionally ignoring Japanese particles.
Particles do not have meaning themselves but are used to order a sentence and mark the
relationships of the words in a sentence

To analyze a Japanese text with MAXQDA, go to Preferences > Word Separation and activate the
options Text language is Japanese and optionally Ignore particles (Japanese)

It is recommended to use these options only if Japanese texts are currently being analyzed, because
you might get wrong results for texts in other languages.

Tip: You should add the following characters to be cut off for functions such as word frequency, so
these will not be counted as words. Please note that these characters are technically different from
their latin equivalents although they look very similar:
＠ ！ ＄ ％ ＆ ／ （ ） ＝ ？ ＾ ‘ ’ “ ” 「」 『 』 ［ ］〔 〕〈 〉 ＜ ＞ 《 》 ≪ ≫ ｛ ｝
【 】 ￥ ＃ ＋ ― ー ＊ ＿ ： ；～ 。 ． 、 ，

All functions of MAXDictio can be used for Japanese texts, except for the Whole word options
available in the dictionary and in the dialog of Keyword-in-context function.

https://radimrehurek.com/gensim/
https://taku910.github.io/mecab/
https://taku910.github.io/mecab/


  640

Limits to MAXDictio
Neither the number or size of documents, nor the number of text units or words per text unit are
technically so restricted as to be significant for a typical project in qualitative and mixed-method
research.

Only the length of words is limited. Here, a maximum of 64 characters are permitted; longer words in
a text are ignored. The representation in the results tables, e.g. for word combinations, is limited to
64 characters, and longer word combinations may truncated, indicated by three points (...) at the end
of the row.

To a high degree, working with MAXDictio depends on how fast the computer is and how many
resources it has. If the number of texts to be counted at the same time reaches a certain quantum,
the computer becomes noticeably slower. Projects of up to a million words are manageable for
today’s average computers. This should be sufficient for usual projects of qualitative social science.

The more text to be processed simultaneously, the more time the computer needs. All functions also
have a bar that indicates the progress. Hence, it is visible how much text MAXDictio has already
processed and, thus, possible to calculate how much time will still be needed to complete the entire
analysis.
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23 – Questions - Themes -Theories (QTT)

The Idea behind "Questions - Themes -
Theories"
The "Questions – Themes – Theories" (QTT) workspace provides a bridge between your MAXQDA
project and your research report.

QTT helps you focus on, or perhaps even begin to develop, your research questions. QTT can be
compared to a scrapbook in which you collect everything related to a particular topic or research
question, record questions, focus on themes and key categories, and formulate answers to the
research questions.
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The Questions – Themes – Theories window

The QTT is the ideal place to collect everything you come up with for a topic and make it easily
accessible. It is like a super memo where  you can enter and synthesize findings, record conclusions,
and develop theories.

In the QTT workspace, you can create a separate worksheet for each of your different topics or
research questions and then fill it with associated analysis elements from MAXQDA, including:

related codes,
important coded segments,
related memos,
visualizations and concept maps,
Summary Tables.

Of course, you can export individual or all parts of a worksheet to the clipboard or the entire
worksheet as a Word document.

Start the “Questions – Themes – Theories” workspace

Switch to the Analysis menu tab of MAXQDA.1.
Click on QTT: Questions – Themes – Theories.2.

Open Questions – Themes – Theories in the Analysis tab

The QTT workspace will then open in a separate window while the main MAXQDA window stays
accessible in the background. In the workspace, you can create new worksheets and edit and export
your existing worksheets.

Create a Worksheet
Create new worksheet

To create a new worksheet in QTT, proceed as follows:

Open the QTT workspace via Analysis > QTT: Questions – Themes – Theories in MAXQDA’s1.
main menu.
Click New Worksheet in the QTT window.2.
In the form that appears, enter a name for the worksheet at the top and record the topic and3.
research questions to which the worksheet should relate:
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Fill in name, topic, and research question for new worksheet

After clicking OK, the worksheet is created, and you can start inserting elements from your MAXQDA
project into the worksheet:

Newly created worksheet in QTT with typical sections for a qualitative study.

Create, sort, customize sections

As the previous image shows, worksheets in QTT can be divided into individual parts. The following
sections are available:

Related Codes & Themes
Important Segments
Summary Tables
Related Memos
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Visuals & Statistics
Concept Maps
Integration of Insights

When you create a new worksheet, all these sections are automatically inserted. The tab bar with the
sections of the worksheet is interactive:

Click on a tab to switch to that section.
Drag-and-drop a section tab with the mouse to adjust the order of the sections.
To remove a section from the worksheet, right-click on the name of a tab and select the
corresponding option. By clicking the + Add Section button, you can insert the sections again
if you need it.

Remove section via context menu

Please note: Each section can exist only once per worksheet. Therefore, already existing sections
are grayed out in the menu and are not clickable.

Rename or delete worksheet

To change the name of a worksheet, just click on the title and you will be able to edit it.

In the QTT menu you will find an option to delete the worksheet:

Switch between worksheets

Once you have created multiple worksheets, you can switch between them by clicking My
Worksheets. The currently selected worksheet is always visible in the title bar at the top of the QTT
window.

Add Elements to a QTT Worksheet
The most important task when working with "Questions – Themes – Theories" (QTT) is, of course, to
compile the results and findings of the analysis and to insert them into a worksheet. In QTT, you can
then comment on individual elements, draw conclusions, and develop hypotheses and theories.

In order to insert elements into a worksheet, sections must be created beforehand. The following
image shows all sections that are automatically added when a new worksheet is created:

Different sections of a worksheet in QTT

In the following, we will explain how to add elements for each section.
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Please Note: In QTT, a copy of the element is saved at the time of insertion. You can no longer
change elements in QTT, only comment on them. For example, if you insert a memo into a
worksheet, the memo text is saved in QTT and can be viewed there. If you change the memo in the
MAXQDA project, the changes are not transferred to the QTT worksheet.

Related codes & themes

Click the Add Element(s) button to get a selection dialog with the current code system.1.
Select individual codes or click Activated Codes to insert the currently activated codes.2.
After clicking OK, the selected codes will be inserted into the worksheet:3.

Select codes to add to QTT
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Codes added to QTT

In QTT, each code is displayed in an interactive tile:

Hold the mouse over the code memo icon to preview the memo text. Double-click the icon to
display the memo (the memo cannot be modified in QTT).
Click Coded Segments to access a compilation of all segments coded with the code. This
compilation always refers to the current state of the project, not to the time when the code
was inserted into the QTT.
Drag-and-drop a tile with the mouse to adjust the order of the codes.
Right-click the tile to remove the code from the worksheet.

Below the codes you can record your insights in the text box.

Important segments

There are several ways to insert one coded segment (or several at once) into the QTT.

"Document Browser" and "Retrieved Segments" window

If you want to insert a relevant coded segment directly from the "Document Browser", right-click on
the associated coding stripe (the "coding bracket") next to the document, select the option Send to
QTT Worksheet and then the desired worksheet:
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Send coded segment from “Document Browser” to QTT

Alternatively, drag the coding stripe directly into the QTT window with the mouse.

The context menu and drag-and-drop feature are also available for the coding stripe in the "Retrieved
Segments" window.

Tabular overview "Coded Segments”

In the tabular listing of coded segments, click the small Send to QTT Worksheet icon in the upper
right corner and select the desired sheet:

Send coded segment from the Coded segments tabular overview to QTT

Alternatively, a selected segment (or multiple segments) can be dragged directly into QTT with the
mouse.

Display of the coded segments
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Coded segments inserted in QTT

In QTT, each coded segment is displayed on an interactive tile:

Click and drag a tile to adjust the order.
Right-click the tile to copy the contents of the coded segment to the clipboard or to remove
the segment from the worksheet.

Below the segments you can record your insights in the text box.

Summary tables

Click the Add Element(s) button to get a listing of all summary tables in the project.
Select a table and click OK.

Insert a summary table



  649

Summary table inserted in QTT

Below each summary table you can record your insights.

Right-click on a table to copy it to the clipboard or remove it from the worksheet.

Related memos

Click the Add element(s) button to get a listing of all memos in the project.1.
Select memos and click OK to insert them into the worksheet:2.
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Insert memos

Memos inserted in QTT

Each memo is presented on an interactive tile:

Double-click the tile of a memo to display all of its content.
Drag-and-drop the tile to adjust the order.
Right-click the tile to remove the memo from the worksheet.
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Below the memo tiles you can record your insights in the text box.

Tip: You can also directly send memos to QTT from the Memo Editor or the Memo Manager by
clicking on the small icon Send to QTT Worksheet.

Visualizations

To insert a visualization created with MAXQDA into QTT, click on the small Send to QTT Worksheet
icon in the top right corner of the visualization and select the desired sheet:

Send visualization to QTT

All visualizations that you create via the Visual Tools menu of MAXQDA can be transferred to QTT
using the Send to QTT Worksheet icon. Concept maps from MAXMaps are inserted into their own
section in QTT (see below).

Below each visualization you can record your insights in the text box.
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Concept maps from MAXMaps

 

In QTT, click the Add element(s) button in the Concept Maps section to get a listing of all1.
maps in the project.
Select a map and click OK.2.

Select concept maps to insert into QTT

Concept map added to QTT

Below each concept map you can record your insights in the text box.

It is also possible to insert a concept map by clicking on the corresponding icon directly in the
"MAXMaps" window.
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Tables and Diagrams

To send tables and diagrams to the QTT workspace, click on the small icon Send to QTT Worksheet.

Send Table to QTT

Send Diagram to QTT

Integration

The "Integration" section is a special section in the QTT workspace. This is the place where it all
comes together: View all your insights from the other sections and integrate them into overall
conclusions, and develop hypotheses and theories:
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The Integration section

Tip: You can hide the insights of individual sections by right-clicking and selecting the corresponding
menu action. To view all insight, click the Show all insights button or use the context menu again.

Export Worksheet
When working with the QTT, many findings and conclusions arise that can become important parts
of the final report. Therefore, you can export an entire worksheet as a Word file, as well as you can
copy individual elements and individual areas to any program via the clipboard.

Export entire worksheet

To export the entire worksheet, click the Export icon in the menu tab of the QTT window. MAXQDA
exports the worksheet as a Word file in DOCX format, with each section starting on a new page:

Exported worksheet in Word

Export a single area

To export all the contents of a single section, right-click its tab name and select Copy Content. Now
you can paste the contents of the clipboard directly into Word or another program, for example, by
using the keyboard shortcut Ctrl+V (Windows) or ⌘+V (macOS).
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Copy the contents of the Visualizations section to the clipboard

Export a single element

To export individual elements, such as a visualization or a memo, right-click on them and select
Copy. Now you can paste the contents of the clipboard directly into Word or another program, for
example, by using the keyboard shortcut Ctrl+V (Windows) or ⌘+V (macOS).
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24 – Analyzing Videos

Video Analysis with MAXQDA
With MAXQDA, you can import, play, transcribe, paraphrase, and directly code video footage for
video analysis. The “Multimedia Browser” lets you play and code videos using the same approach
you would use for text analyses. The standard tools for coding texts are also available for video
analysis, including:

Adding to comments to coded segments in videos
Adding weight scores to coded segments in videos
Displaying and hiding coding stripes
Attaching memos to specific time positions in videos, , e.g., to make notes or add
interpretations, hypotheses, or ideas for analysis
Linking video clips to other video clips or text segments, e.g., sections in your transcript

The following tools are also available especially for video analysis:

Exporting still images for publications
Saving still images as image documents in MAXQDA for further analysis
Exporting short video clips, e.g. for presentations or analysis sessions
Transcribing short sections or entire videos
Linking videos and transcripts via timestamps

Import Videos
Before you import video files into MAXQDA, you should briefly check their format and size.

Supported video formats

MAXQDA supports the following standard video formats:

MP4
MOV
MPG
AVI
M4V
3GP, 3GGP
and on Windows: WMV

In general, we recommend the MP4 format with the H.264/AVC video codec.
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Recommended resolution

These days you can record videos in very high resolution, which in turn leads to extremely large files.
When analyzing videos with MAXQDA, your video will be displayed in its own window, which usually
doesn’t fill the entire screen. An HD resolution (720p) will therefore be sufficient for working with
videos in MAXQDA. If you are using a retina or 4K monitor, a Full HD resolution (1080p) may also be
appropriate.

The size of a video file depends on its resolution, frame rate, and data rate. A frame rate of 25-30
frames/second and a data rate of approx. 1,500 kilobits/second are usually sufficient.

To check the format, resolution, frame rate and data rate of a video file, follow these steps:

Windows:

Right-click on the file and select Properties.1.
In the window that opens, select the Details tab. Here you can find the relevant information in2.
the "Video" section.

macOS:

Open the video file in the QuickTime Player.1.
Press the keyboard shortcut ⌘+I. A window with the relevant information will open.2.

Converting videos

You can use the following programs to convert videos into a supported format and reduce the
resolution if necessary.

Windows: XMedia Recode

This program is available free of charge online and has a small file size itself (10 MB):

Drag your video file into the upper window area of XMedia Recode, and then click the row1.
containing the video to select it for editing.
Select the output format in the lower window area, e.g. the profile "HTML 5" with "HTML 52.
1280×720 HD (mp4)", corresponding to a resolution of 720p.
At the bottom of the window, select where you want the converted video to be saved.3.
Click the "Add to queue" button at the top and then the "Encode" button.4.

macOS: Quicktime Player

QuickTime, which is installed by default on Mac computers, allows you to save videos in MOV
format:

Open your video in the QuickTime Player.1.
In the File menu, select Export as > 720p ... (or 1080p...).2.

Adding a video file to a MAXQDA project

To import a video into an open MAXQDA project, click on the Video icon on the Import tab or drag

https://www.xmedia-recode.de/
https://support.apple.com/en-us/HT201066
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and drop the file directly into the “Document System” window..

Importing video files via the “Import” menu tab

Audio and video files are generally not imported directly into a MAXQDA project. Instead, they are
stored in the MAXQDA Externals folder and linked to a text document in which you can, if necessary,
save a transcript. For more information about external files, see Managing External Files.

When importing an audio or video file, MAXQDA creates a new text document with the name of the
media file and assigns the inserted media file to the newly added document. The media file itself is
copied to the “MAXQDA_Externals” folder so that it remains available for MAXQDA later if you move
the file from its original location or delete it. If a file with the same name already exists in the
Externals folder, MAXQDA asks if the existing file should be overwritten.

In the “Document System”, you will recognize a text document with the associated media file by their
special symbols, a play icon.

Audio and video files in the “Document System“

Notes for handling your video files

To avoid slower processing speeds, video files should ideally be stored on the local hard disk.
If your set of files is very large, you can also store it on an external hard disk connected to
your computer via a fast USB 3 port.
Only save video files to network folders if you have a very fast cable network.
To protect confidential video files, you can store them in an encrypted folder. Such folders
can be created with the open source software Veracrypt and integrated into your computer as
a virtual drive. However, encryption can lead to a loss of performance when accessing the
videos.
To prevent potentially very large amounts of data from being copied to the
MAXQDA_Externals folder when importing, you can specify the original storage location of
your videos as the "Folder for external files" in MAXQDA's main preferences.
When you open a media file for the first time, MAXQDA creates a file with the extension .dat in
the folder for external files. This file has the same name as the media file. MAXQDA needs
this .dat file to be able to display the media file quickly, so it should not be deleted.

https://www.maxqda.com/help-mx24/import/external-files
https://www.veracrypt.fr/en/Home.html
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Assigning audio/video files to a text document

You can also assign a media file to an existing text document. To do so, right-click on the document
and select Link Audio/Video File in the context menu.

Alternatively, open the Properties window from the context menu. Here you can add or modify links
to media files at any time. For more information, see general section on importing Audio and Video
Files.

Tip: In this dialog window, you can also easily check which media files are linked to your text
documents.

The Multimedia Browser
You can play and analyze audio and video files in MAXQDA’s “Multimedia Browser”.

To open an audio or video file in the “Multimedia Browser”, right-click the document in the
"Document System" and select Open Audio File or Open Video File.

Alternatively, you can also open a media file directly from the "Document Browser":

Open the text document to which the audio or video has been assigned (e.g. by double-1.
clicking on its name in the "Document System").
Click on the icon Open video file (file name) or Open audio file (file name) in the2.
"Document Browser" toolbar.

Open the “Multimedia Browser” by clicking on the icon in the “Document Browser”

If the text document is empty, i.e. there is no transcript, MAXQDA automatically opens the video in
the “Multimedia Browser” as soon as you open the corresponding text document.

The “Multimedia Browser” looks like this:

https://www.maxqda.com/help-mx24/import/inserting-audio-and-video-files-in-a-maxqda-project
https://www.maxqda.com/help-mx24/import/inserting-audio-and-video-files-in-a-maxqda-project
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The “Multimedia Browser” window

The “Multimedia Browser” is composed of the following areas:

The upper panel shows the video.
Underneath, there is a toolbar containing the functions to adjust the view and playback and
the functions for coding. Here, you can also see the current playback position and the total
time of the media file.
Beneath the toolbar, thumbnail pictures can be displayed for fast navigating.
Underneath, you can see the waveform of sound of the media file, and below this, there is a
time line where you can see the current playback position.
Under the time line there is a bar for the timestamps of the transcripts.
At the very bottom is an area where the coded segments are visualized by bars.

For audio files, the video window and preview pictures are not shown.

The blue vertical line and the blue bar underneath the time line indicate the current playback
position.

The following functions are available on the toolbar:

 Control Panel – opens the window with playback options

 Display preview thumbnails – displays previews beneath the toolbar

Please note: The previews are loaded the first time you display a preview - this can take a few
minutes with large files.
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Insert Internal Link (Anchor/Target)– sets the start and end point of a reciprocal internal link

 New memo (Alt/⌥+⇧+M) – creates a new memo in the current playback position

 Previous memo (⇧+F3) – jumps to the memo to the left of the current clip position

 Next memo (F3) – jumps to the memo to the right of the current clip position

 Paraphrase Audio/Video – opens the paraphrase mode

 Set clip start (F7) – sets the beginning of a clip segment at the current playback position

 Set clip end (F8) – sets the end of a clip segment at the current playback position

 Play clip (F9) – plays the segment selected on the waveform

 Remove clip (F10) – removes current clip marks from the waveform

5 seconds back (⇧+F12)

Play/Pause (F4 or F5)

5 seconds forward (F12)

Slider – helps you jump to a certain position

Copy video image to clipboard - copies the currently visible video image to the clipboard, e.g. for
inserting it into a Word document

Insert video picture as image document in ‘Document System’ - inserts the currently visible video
image as an image document in the "Docuemtn System", e.g. to be able to code segments of the
image.

Export coded video clips - in the dialog window that opens, specify the quality and resolution of the
clips and select the codes whose coded video segments you would like exported.

On the far right of the waveform, there are other icons that you can use to adjust the zoom for the
waveform.

 zooms out of the waveform, reduces the number of preview pictures for videos.

 zooms the view to 100%. This view is configured by default and is usually ideal for coding.

 shows the complete media file in the “Multimedia Browser”; this gives you an overview of the
waveform of the complete file (unless it's very long). This view is usually not suitable for coding.

 zooms into the waveform, increases the number of preview pictures for videos. This makes it
easier to navigate to single pictures and words and code more specifically.
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Control media files with your keyboard

Media files can be controlled via function keys, e.g. you can jump forward 5 seconds with F12.

Please note: For information on how to use the function keys F1 .. F12 with a Mac computer, please
see the Frequently Asked Questions.

To start and stop playback, you can use the F4 or F5 or:

Pressing Ctrl (Windows) or the Shift button ⇧ (macOS) twice, or
if the “Multimedia Browser” window is open, by clicking in within the video window, the
playback can also be started and stopped with the Space key.

Code Videos
Coding in the Multimedia Browser

Video files (as well as audio files) can be coded in the same way as texts in MAXQDA. To do so,
open the video file in the Multimedia Browser as described in the previous section.

You start by marking a segment in the waveform (a so-called “clip”). Typically, you will want to set
the beginning and end of a segment in a media file precisely, as the scene and content can change
completely from one moment to the other. For this reason, MAXQDA offers numerous functions that
allow you to mark an audio or video clip:

To roughly mark a segment, keep the left mouse button pressed and select the segment by
dragging the cursor over the waveform. The time limits are displayed underneath the
beginning and end marks.
You can easily alter the time limits of the clip by moving the blue-marked time display or by
clicking and dragging the outer borders of the segment in the waveform.
By using the right and left arrow keys on your keyboard, playback is moved by one-tenth of a
second. If the playback precisely matches the beginning or end of a clip, the clip is enlarged
or reduced accordingly.
To play the marked clip, click the icon Play clip or press the F9 key.

Marking a segment

Please note: For information on how to use the function keys F1 .. F12 with a Mac computer, please
see the Frequently Asked Questions.

You will usually play a media file and then pause exactly at a position where you want to set a new

https://www.maxqda.com/help-support/faq#fndtn-panel11645
https://www.maxqda.com/help-mx24/analyzing-videos/the-multimedia-browser
https://www.maxqda.com/help-support/faq#fndtn-panel11645
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coding. To do this:

Press the button Play/Pause  or the F4 key.1.
When the playhead is at the designated position, click the button Set clip start  or press the2.
F9 key. If necessary, use the arrow keys on the keyboard or click and drag the clip borders to
fine-tune the start of the clip.
Resume playback and pause at the position where you want to end the coding. Click the3.
button Set clip end  or press the F10 key. If necessary, make a fine-adjust of the clip end.

Setting the starting and ending points at the current playback position

You can now code the selected segments as usual, for example by (a) dragging and dropping the
marks on to a code, (b) clicking on an emoticode, or (c) by clicking a color code. Right-clicking on a
marked segment opens a context menu that contains three options that are relevant for coding:

A selected video segment's context menu

Selecting long passages in a video

To selct a segment in a video, you can click and drag the mouse in the waveform. This can be
impractical if the passage you want to mark is very long. You can save time by doing the following:

Place the playback position at the beginning of the passage.1.
Use the scroll bar to scroll to the approximate end of the passage. Then click the waveform2.
while holding down the Ctrl key (Windows) or cmd key (Mac).

MAXQDA will then mark the entire area between the two positions. The clip boundaries can be
adjusted as usual with the small sliders.

Displaying coded segments in the Multimedia Browser

The coding is indicated by a horizontal coding strip in the “Multimedia Browser”, the code name
appears on the left below the coding stripe. In addition, the waveform is colored with the color of the
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code in the corresponding time range. If several codings are superimposed, the color is mixed in the
waveform. For coded segments with an emoticode, the symbol is visualized on the coding stripe.

Clicking on a coding stripe selects the coded segment on the waveform. Double-clicking plays the
clip.

Visualization of coded segments in the “Multimedia Browser”

Right-clicking on a coding stripe opens a context menu containing the usual options:

Modify weight
Edit comment
Delete

Please note: Coded video segments that have a comment are marked with a white square on the
left-hand side of the coding stripe.

The display of the coding stripes can be adjusted. To do this, right-click in the grey area where the
coding stripes are displayed; it is important not to click on a coding strip but next to it. The following
dialog appears:
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Options for displaying the coding stripes in the “Multimedia Browser”

You can select to display only coded segments of selected people or codes with a specific color.
Particularly important for video analysis is the bottom option Display code favorites at the top. It
ensures that all codes that you have defined as favorites under Codes > Code Favorites are always
displayed at the top of the "Multimedia Browser". A separate line is reserved for each of the favorite
codes, creating a kind of score view. This view is ideal, for example, for structuring the video or
identifying the key players in the video.

Tip: By clicking on the asterisk, you directly open the window with the code favorites and can add
further codes from the "List of codes".

Transcribe Video Clips
This manual contains a separate chapter on "Transcription", which provides a detailed explanation
of how to use MAXQDA's Transcription Mode to transcribe video or audio files and of how to use

https://www.maxqda.com/help-mx24/transcription-audio-video/transcription-mode
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timestamps to link transcripts with media files. In addition to the functions described there,
MAXQDA provides an additional tool for transcribing short sections of videos:

Often only specific scenes from videos need to be transcribed, for example in order to perform a
more detailed analysis on these scenes. In these cases you have the option of transcribing individual
passages in the “Multimedia Browser”.

Follow these steps:

Open the video file in the “Multimedia Browser”.1.
Right-click on a point in the waveform from which you want to start transcribing.2.
Select the Transcribe item from the context menu that appears when you right-click the3.
waveform.

Starting a transcription of a selected video clip

MAXQDA will then open Transcription Mode so that you can start transcribing straight away. The
starting time of your selected video sequence is automatically added to the transcript. Additionally, a
timestamp is set to link the transcript with the video. Clicking on the timestamp will play the video
from the corresponding time position in the “Multimedia Browser”.

The beginning of a partial transcript with the start time added to the text

Paraphrase Videos
You can use MAXQDA to paraphrase scenes of a video or audio file:

Open the video or audio file in the „Multimedia Browser“.1.
Activate the Paraphrase mode by clicking on the symbol Paraphrase audio/video  in the2.
toolbar or by using the keyboard shortcut Ctrl+⇧+P (Windows) und ⌘+⇧+P (macOS).
In the waveform, select the clip for which you want to write a paraphrase.3.

https://www.maxqda.com/help-mx24/analyzing-videos/the-multimedia-browser


  667

Right-click in the selected clip and choose New Paraphrase. Alternatively, you can use the4.
keyboard shortcut Ctrl+P (Windows) und ⌘+P (macOS) or click on the symbol .

Activate Paraphrase Mode in the „Multimedia Browser“

Write paraphrase for highlighted clip

Edit and delete Paraphrases

To edit the content of a paraphrase, double-click the orange paraphrase icon to the left of the green
paraphrase bar.

To delete a paraphrase, right-click on its green bar. A context menu opens, in which you can also call
up the window with the paraphrase for editing.

Edit or delete paraphrase with the context menu of a green paraphrase bar

Deactivate Paraphrase Mode

Click the icon again to exit the Paraphrase Mode or use the corresponding keyboard shortcut.

As soon as you exit the Paraphrase Mode, the paraphrases are hidden in the “Multimedia Browser”
window. The following sections describe how you can continue working with the paraphrases: for
example, they can be categorized or contrasted in the Paraphrase Matrix for different cases or
groups.
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Add Memos and Links to Videos
Attaching memos to time positions in videos

As well as coding them, you can also add memos to media files to make notes or record your
thoughts, hypotheses, interpretations, and much more about particular time positions. The memos
can also be used to subdivide a video file so that you can quickly “navigate” through the video by
jumping to the next memo.

To attach a memo to a playback position, there are several options:

Right-click a position of the waveform
Or click the button New memo  in the Multimedia Browser toolbar
Or use the keyboard shortcut Alt+⇧+M (Windows) / ⌥+⇧+M (macOS)

Creating memos

You can jump back and forth between the memos of a media file at any time by using the Previous /
Next Memo icons in the “Multimedia Browser” toolbar or the associated keyboard shortcuts ⇧ + F3
and F3 in Multimedia Browser toolbar.

Please note: For information on how to use the function keys F1 .. F12 with a Mac computer, please
see the Frequently Asked Questions.

Setting internal links in video clips

Internal links in MAXQDA are used to connect two parts of the project, for example a video scene
with an interview section. This creates a hyperlink, which you can click to jump back and forth
between the linked sections.

Follow these steps to set an internal link in a video file:

Select part of a video in the “Multimedia Browser”.1.
Right-click on the marked section and select Insert Internal Link (Anchor/Target).2.
Alternatively, you can use the keyboard shortcut Ctrl+L (Windows) or ⌘+L (macOS). This sets
the start of the link.
Select another sequence in the video and repeat step 2. This sets your link target.3.

https://www.maxqda.com/help-support/faq#fndtn-panel11645
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Insert Internal Link

In the “Multimedia Browser”, a link icon will now appear in the waveform, which you can click to jump
to the linked section.

Link icon in the “Multimedia Browser“

You can connect a video clip to another video clip or connect a video clip to a text section in a
document or memo. For example, a passage of text that talks about a particular video scene can be
linked to that video scene via an internal link.

Export Video Clips
You may find it useful to export only short extracts of your video data for presentations or analysis
sessions. You can export selected clips as distinct video files using the “Multimedia Browser”. These
clips can also be inserted as new video files into your MAXQDA project. Additionally, you can also
export already coded video clips as video files.

Exporting selected video clips using the Multimedia Browser

You can export a selected clip from the “Multimedia Browser” or insert it into your MAXQDA project
as a new document:

Select a section in your video material in the “Multimedia Browser”.1.
Right-click on this section and select Export Video Clip in the context menu.2.
In the dialog window that opens, specify the quality and resolution of the clip you would like to3.
export.
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Exporting a selected video clip from the “Multimedia Browser”

Video clip export options

To insert a selected video clip as a new document into your "Document System” - in other words, to
add it as a new document to your open MAXQDA project - select Insert as New Document in the
context menu for the selected clip.

Exporting coded video clips

To export a single coded segment of a video, select Export Video Clip for that coded segment. This
function is available in the context menu when you right-click on the following:

In the “Multimedia Browser”: coding stripes
In the “Retrieved Segments“ window: source information or rows in the displayed table
In the “Overview of Coded Segments”: rows in the displayed table
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Exporting a video clip from the “Retrieved Segments“ window

Please note: Even if several rows are selected in the table view of the "Retrieved Segments" window
or that of the “Overview of Coded Segments”, only the video segment you have specifically clicked
on will be exported.

From the “Multimedia Browser”, you can also export all the coded video segments of one or more
codes:

In the toolbar, click on the Export coded video clips icon.1.
In the dialog window that opens, specify the quality and resolution of the clips and select the2.
codes whose coded video segments you would like exported.
Click OK and a window will open in which you can specify a location to export these clips.3.

Export a coded video clip via the export icon in the “Multimedia Browser” toolbar
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Dialog window for exporting coded video clips

Analyze Coded Videos
Once you have finished coding a video, you have a wide range of analysis options at your disposal,
using the full range of MAXQDA tools:

Visual Tools > Code Matrix Browser: Compare distribution of coded segments for individual
videos or groups of videos
Visual Tools > Code Relations Browser and Analysis > Code configurations: Detect
simultaneous occurrences of codes
Visual Tools > MAXMaps: Create concept maps, if necessary with MAXQDA’s model
templates like the Single-case Model
and much more …

In the following sections, some analysis functions that are particularly relevant for video analysis are
described in more detail.
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Retrieve coded videos in the "Retrieved Segments" window

Coded video segments can be retrieved and compiled in the same way you would retrieve any other
coded segments in the "Retrieved Segments" window, through activation and the Complex Coding
Query function. When working with videos, the "Retrieved Segments" window will display the first
image of the video clip as a preview. For audio clips, a (standardized) image of a waveform is
displayed.

The source information includes the start time of your audio and video clips.

Tip: Click on the source information to play the video segment in the “Multimedia Browser”.

Audio and video clips in the “Retrieved Segments” window

Displaying sequences of codes in the Codeline visual tool

The Codeline is an excellent tool for visualizing the chronological sequence of coded segments in a
video file. Like in a musical score, selected codes are displayed in their respective colors, one below
the other. For example, you can display structural codes (i.e. "opening stage", "discussion stage",
"closing stage") parallel to topic codes.

The Codeline for video files

Follow these steps:

Activate the codes you want to display in the Codeline. If you would like all your codes to be1.
displayed, you don’t need to activate any.
Right-click on the text document with the video file in the "Document System" and select2.
Codeline in the context menu.
In the dialog window that opens, select your preferred options, e.g. Only for activated codes.3.
In the top left corner of the Codeline window, click the icon Codeline for linked media file.4.
Otherwise, a codeline for the transcript will be displayed.

https://www.maxqda.com/help-mx24/segment-retrieval/logical-combinations-codes
https://www.maxqda.com/help-mx24/segment-retrieval/logical-combinations-codes
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You can use the Fit to window width option to expand and compress the entire progression to5.
suit the Codeline window.
The option Standardize unit width and color whole unit completely should be switched off,6.
otherwise the times will always be "rounded" to the nearest full second/minute.

You can find further information about the Codeline tool here.

Define and compare code coverage

You can use the Code Coverage tool to add up the time covered by certain coded video segments
and compare these aggregate times between different videos. This tool could be particularly useful
if you want to, for example, analyze whether groupwork phases were coded for longer periods of
time in a “lesson” video than in other videos.

Code Coverage: results table for coded videos

Follow these steps:

Activate the videos in the "Document System" that you would like to include in your analysis.1.
Activate the codes you want to display in your results table. If you would like all the codes to2.
be displayed, you don't need to activate any.
Select Analysis > Code Coverage in MAXQDA's main ribbon menu and select Video in the3.
drop-down menu.
In the dialog widow that opens, specify whether you want to compare the documents4.
individually or in document groups or document sets.

You can find further information about the Code Coverage tool here.

https://www.maxqda.com/help-mx24/visual-tools/codeline-the-sequential-visualization-of-a-document
https://www.maxqda.com/help-mx24/statistics-and-graphics-functions/code-coverage
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25 – Analyzing Focus Group Data

How Does MAXQDA Support Focus
Group Data Analysis?
Conducting focus groups and group interviews occupies an important role in social and market
research. Focus groups offer a high potential for diverse analyses, therefore there are many specific
features available in MAXQDA that allow for the simple and effective analysis of focus group
transcripts (besides all the standard tools that, of course, can also be applied to focus group data).
For simplicity we use only the term “focus groups” in MAXQDA and in this manual, although the
functions are all suitable for the analysis of group interviews as well.

Important: In order to use the analysis functions described in this chapter, it is necessary that your
transcripts have been imported into the MAXQDA project as focus group transcripts, so that the
participants’ contributions were automatically coded with the speaker’s names. How exactly the
import works and how you can convert transcripts that have already been imported or were created
in MAXQDA into a focus group transcript is described in this section.

In this chapter, we will present the following features:

Search for words and phrases within contributions of selected speakers.
The “Overview of Focus Group Speakers” that allows to answer questions such as: Who has
spoken at what frequency? How extensive are the contributions of each speaker, in words or
characters?
Individual participants can be activated directly in the “Document System”, so you can easily
compile the statements of individuals on selected topics. Background information on the
participants, such as age and professional experience, can be stored as variables for focus
group participants and used for the specific and comparative analysis of groups.
Use the Code Matrix Browser and the Crosstab for Focus Groups to create visualizations
such as “Themes x Speakers”, with which participants or groups of participants can be
compared by diverse themes, arguments, positions, and viewpoints in the allocation of codes.

Text Search in Speaker’s Contributions
MAXQDA’s text search can be limited to individual contributions from Focus Group speakers:

Activate the participants whose contributions you would like to search in the “Document1.
System”.
Access the function via the Text Search & Autocode function in the Analysis tab.2.
In the window that appears, enter the desired search terms and select Only in activated3.
documents/activated focus group contributions.

https://www.maxqda.com/help-mx24/import/importing-focus-group-transcripts


  676

Search the contributions of focus group participants

Coding Query for Coded Segments
The central principle for the compilation of coded segments in MAXQDA is the activation of codes
and documents. This principle also applies to the analysis of focus groups, however in this case you
have the possibility to activate not only the focus group transcript as a whole, but also all or certain
participants in the Document System. In this case, only the contributions of activated participants
will be taken into account in the analysis.

Selecting participants for analysis through activation

To activate a participant in the “Document System” for analysis, proceed exactly as when activating
a document. You can right-click on the participant’s name and select Activate from the menu, or
simply click on icon of the participant. To activate or deactivate all the participants in a focus group,
you can use the commands Activate all Speakers or Deactivate all Speakers in the context menu of
the focus group.
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Activate all focus group speakers

MAXQDA analysis of focus groups applies either to the entire document or to individual participants
of the selected focus group, but never a mix of these two levels. For this reason, the transcript and
the participants can never be activated together.

During the search for participant statements, MAXQDA can help you by performing the following
standard tasks:

Retrieve everything that Olga said in a focus group

Activate the corresponding focus group in the “Document System”.1.
Activate “Olga” in the “Code System”.2.

MAXQDA will list all of the contributions from Lucas in the “Retrieved Segments” window.

Retrieve everything that Olga said in multiple focus groups

Activate all focus groups in the “Document System”.1.
Activate all codes for “Olga” in the “Code System”.2.

MAXQDA will list all of the contributions from Lucas from all focus groups in the “Retrieved
Segments”.

Retrieve everything that Olga said regarding a particular theme:

Activate “Olga” in the “Document System” in all of the transcripts you wish to include.1.
Activate the codes in the “Code System”.2.

MAXQDA will list all of the contributions from Olga related to this theme in the “Retrieved Segments”
window. The participant is also indicated in the indication of origin, so you can easily associate the
contribution with the participant.
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A participant's statemetns in the “Retrieved Segments” window

Retrieve everything that multiple participants said in a focus group

You can always activate multiple participants simultaneously. MAXQDA takes all activated
participants into account during the Coding Query.

Activate focus group speakers based on their variable values

You can also activate individual participants based on their variable values. To do this, right-click on
root document in the "Document System" and select the entry Activate focus group speakers by
variable values from the context menu. Alternatively, you can click on the icon Activate via ... in
the toolbar of the "Document System" window:

Activate Focus Group Speakers by Variables

The same window which is used to activate documents based on their variable values will then
appear. You can then select any of the values listed in the Overview of Focus Group Participants.
This also makes it possible to select participants with many or few contributions and speeches.

https://www.maxqda.com/help-mx24/mixed-methods-functions/activation-by-document-variable-variables-as-selection-criteria-for-the-coding-query
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Complex Coding Query

The Complex Coding Query function also allows you to limit the search to the statements of a
particular speaker as coded segments. This function follows the same logic as the simple Coding
Query: When you activate the focus group transcript, the search takes the whole document into
account, whereas when you activate an individual participant, this participant’s contributions are
treated as a document.

Suppose you have assigned thematic codes in a transcript, and also coded the communication
sequence so that there is a code system of the following type:

Themes

Financial issues
Motivations for getting a student job
...

Communication sequence

Objections
Support for the statement
...

If you want to find all the statements in which Olga supports an earlier statement about the
“Motivations for getting a student job”, you can do so using the Complex Coding Query:

Activate the participant “Olga” in the “Document System”.1.
Activate the codes “Motivations for getting a student job” and “Support for the statement”.2.
Call up the Analysis > Complex Coding Query function.3.
Select the “Intersection” function, which searches for instances in which two codes, namely4.
“Motivations for getting a student job” and “Support for the statement” occur simultaneously.
Ensure that the Only in activated documents / activated focus group contributions function is5.
selected.
When you click on Home, MAXQDA will list the results in the “Retrieved Segments” window.6.

View Coded Segments per Speaker
MAXQDA’s Code Matrix Browser is the ideal tool with which to illustrate and analyze the distribution
of coded segments in different documents. This tool is in the form of a table, in which the
documents make up the columns and the codes make up the rows. In the analysis of focus groups,
often it is not the transcript as an individual document that is the central focus, but rather the
analysis of the contributions in multiple documents, to be considered separately from each other.

The MAXQDA Code Matrix Browser therefore offers the opportunity to automatically perform exactly
this analysis and visualize the distribution of codes per speaker:

Open the Code Matrix Browser via the Visual Tools tab.
In the window that appears, select the option Focus Group Speakers. If you would like to

https://www.maxqda.com/help-mx24/visual-tools/code-matrix-browser-visualizing-codes-per-document
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visualize the codes of an individual participant (or to exclude the moderator from the
visualization), you can activate these elements in advance, and additionally select the option
Only for activated focus group speakers.

Code Matrix Browser options

When you click OK, MAXQDA will open the Code Matrix Browser, whose columns are made up of the
participants.

Codes per speaker

The size of the squares provides information about how many coded segments from the four
thematic codes are present in the contributions of each speaker. The image above demonstrates the
frequency of encodings on the four issues made by Lucas, Miles, Lisa, Casey, and Parker. The larger
the square, the more encodings have been made with the code in question. It is evident from the
image that Lucas a high amount of coding occurred regarding "Stress due to the financial crisis",
whereas Parker made no contribution to this theme.

In the presentation of focus groups, The Code Matrix Browser operates in the same manner as
usual: Double-clicking on a cell will display the corresponding coded segments in the “Retrieved
Segments” window and clicking on the Display nodes as values  presents the information as code
frequencies rather than square. The functions of the other buttons in the Code Matrix Browser are
described here .

Please note: If a project has multiple focus groups, all or all activated participants from all focus
groups will be displayed in the Code Matrix Browser. The order of participants from left to right
corresponds to their order in the "Document System" from top to bottom.

https://www.maxqda.com/help-mx24/visual-tools/code-matrix-browser-visualizing-codes-per-document
https://www.maxqda.com/help-mx24/visual-tools/code-matrix-browser-visualizing-codes-per-document
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The Interactive Quote Matrix for focus group participants

Using MAXQDA’s Interactive Quote Matrix, you can synoptically compile coded segments. This can
be illustrated as follows: Behind every square in the image above is a certain number of coded text
segments, which can be easily compiled by, for example, double-clicking on the square. A Quote
Matrix contains not only the text segments that lie behind a square, but also compiles the text
segments of all the squares together in a table.

To create an Interactive Quote Matrix, click the Interactive Quote Matrix button in the Code Matrix
Browser toolbar. MAXQDA will open the Interactive Quote Matrix in a new window.

The interactive segment matrix

An indication of origin appears below each segment: The contribution in the upper left is from a
statement by the Moderator from paragraph 13-25 of the transcript, and encoded with a weight of
50. You can export the Interactive Quote Matrix as a Word file, an Excel table, or a website (HTML
format) via the usual icons at the top right.

The Overview of Focus Group Speakers
The “Overview of Focus Group Speakers” provides important information about the individual
speaker, such as the number and scope of their respective contributions, and also allows you to
store additional information about each speaker in the form of variables. To access the overview,
right-click on a focus group in the “Document System” and choose Overviews > Focus Group
Speakers.

The following window will open:

https://www.maxqda.com/help-mx24/mixed-methods-functions/interactive-quote-matrix


  682

The Overview of Focus Group Speakers provides important information

The first three columns are used to identify the participants and their respective focus group
transcript, including the color assigned to each speaker. The table shows the amount of
contributions of the individual persons. For example, you can see from the table above that Andy
made the most contributions to the focus group, with the exception of “Moderator”, and with about
28% spoke the most words.

In top of the window there are several icons. Besides the typical functions for export and filtering
there are some specific ones for focus group analysis:

Only activated focus group speaker - Reduces rows to those of participants activated in the
“Document System”. This is especially handy if you want to exclude moderators from the overview:
Activate only the other participants in the “Document System” window and click the icon. The
percentages in the table will be calculated for the filtered persons only.

Statistics - Presents the values of all the columns displayed in a frequency table or chart,
excluding the “speaker” and “focus group” columns. More information on frequency tables and
charts can be found here.

Data Editor - Turns on the Variable View, in which the variable values are visible.

List of Variables - Switches to Variable View, where you can define new variables and adjust and
edit existing variables. More information on the use of variables in focus group analysis is provided
below.

Tip: You can call up the summary table not only for individual focus groups transcripts, but also for
the participants of all the focus groups in the MAXQDA project. To do this, right-click at the top level
in the “Document System ” with the mouse and select the appropriate entry. A corresponding
overview is also available in the context menu of an individual participant, referred to here as
“Overview of Speaker’s Variables”.

https://www.maxqda.com/help-mx24/statistics-and-graphics-functions/frequency-tables-and-diagrams-for-variables
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Editing Variables for Focus Group Speaker

You can store background information for each participant in a focus group for selective analyses
and comparisons; for example, comparing the statements of older and younger participants. First
open the “Overview of Focus Group Speakers” from the context menu in the “Document System”
(either at the top level for all focus groups in the project, or at the level of a document group
containing several focus group transcripts, or at the level of a single focus group).

Tip: You have direct access to the speaker variables via the Variables tab. Click on List of Speaker
Variables to open the "Overview of Focus Group Speakers" table which contains every speakers
from all focus group documents in your project.

As seen above, the default overview contains multiple columns of information that MAXQDA
compiles for the participants. You can add more columns for information such as, for example, age,
profession, or professional rank.

Creating new variables

Adding new variables is done in the same way as in other overviews of variables in MAXQDA:

Click on the List of Variables icon to switch to Variable View.1.
Next, click on the New Variable icon.2.

A new window will appear, in which you can define the name and type of the new variable.

Creating a new variable

After clicking OK, you will see that a line has been added with the newly added variable in Variable
View.
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Newly added variable in Variable View

Entering values for the participants

Click on   Data Editor to return to the normal view. On the far right you will see a newly added
column, in which you can enter values for each participant. The editable column can be easily
recognized by its blue column heading, unlike the black headings of the columns automatically
generated by MAXQDA.

The variable values for participants can be used:

To activate only selected participants with specific values for further analysis or
in a Crosstab for focus groups to compare groups of participants.

Importing speaker variables from Excel

MAXQDA can import speaker variables from XLS/X files. The data must be organized as follows:

Speaker Focus Group Variable 1 ... Variable N

Speaker A Document name Value of Variable 1 for
Speaker A

... Value of Variable N for
Speaker A

Speaker B Document name Value of Variable 1 for
Speaker B

... Value of Variable N for
Speaker B

The first and second column serve the unambiguous assignment of variable values to a speaker, so
these columns and their headings are mandatory. Each line must designate a speaker and the
corresponding focus group in the corresponding column.

Only when a speaker, who matches this information exactly, is found in the MAXQDA project will the
data will be imported. You can add as many variables as required in the subsequent columns.

https://www.maxqda.com/help-mx24/focus-group-analysis/crosstab-for-focus-groups
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After preparing and saving the import data, you can then start the import procedure by going to
Variables > Import Speaker Variables. Alternatively, you can click on the Import data button in the
the “Overview of Focus Group Speakers”.

A dialog field appears in which you can specify the source and target variables along with the type of
variables to be imported.

MAXQDA does the following during the import:

All variables in the import file that did not yet exist in the MAXQDA project are created.
Variables that already existed will be updated with the new values in the import file.

Tip: An easy way to set up an Excel file for importing new values is to first export the variable data
matrix as an Excel file by clicking on the Excel icon in the toolbar of the variable list. An Excel file
with all of the current variables will open up, and you can then add new columns for new variables
and update variable values that you want changed. All you have to do after that is save the Excel file
and import it into MAXQDA.

Crosstab for Focus Groups
MAXQDA offers the feature to save background information on each focus group speaker in the
form of variables. Suppose you have divided participants into two age groups: With the Crosstab for
Focus Groups, you can easily compare the thematic coding for these two groups. The Crosstab for
Focus Group works essentially the same way as the “normal” Crosstab: The codes form the rows
and the groups of focus group speakers form the columns, while the respective code frequencies
are presented in the cells.

You can find the Crosstab for Focus Groups feature in the Crosstab menu of the Mixed Methods
tab. The following window appears, in which you can define the speaker groups.

https://www.maxqda.com/help-mx24/focus-group-analysis/the-overview-of-focus-group-participants
https://www.maxqda.com/help-mx24/focus-group-analysis/the-overview-of-focus-group-participants
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Define group (column) parameters

Each line in the middle column of the window forms a column in the final crosstab.

Please note: In the crosstab, MAXQDA evaluates all participants that meet the conditions in the
second column of the window - regardless of whether they come from one or more focus groups.
You can restrict the evaluation to include only currently activated participants using the Only for
activated focus group speakers option.

The final crosstab appears as follows:

Crosstab for focus groups
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26 – Analyzing Surveys

Categorize Survey Data
Guide: Analyzing Open-Ended Survey Questions with MAXQDA

This guide describes a procedure for analyzing responses to open survey questions with MAXQDA.
The procedure does not consider the open-ended questions in isolation from the other data

collected, but rather interlinks this qualitative data with the standardized, quantitative data in the
sense of a mixed methods approach.

How does MAXQDA help you categorize survey responses?

MAXQDA helps you analyze responses to open questions in surveys efficiently and effectively with
its interactive table window. The responses are listed in a table and can be categorized with existing
or newly developed codes.

https://www.maxqda-press.com/catalog/guides/analyzing-open-ended-survey-questions-with-maxqda
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A prerequisite for using this function is that all the responses to one question have been coded with
one code. This should be the case if you used the Survey Data Import function to import your survey
responses. The name of the code will normally correspond to the text or a shortened version of the
survey question.

All survey question responses should be coded with one code

Starting the Function

MAXQDA’s interactive interface lets you analyze each of your survey questions, one after the other:

In case you want to analyze only a selection of responses of individual interviewees, activate1.
these documents.
Click on the following function in the ribbon menu bar: Analysis > Categorize Survey Data2.
Drag the code that contains the responses to your survey question from the “Code System”3.
window to the following dialog box that appears:

https://www.maxqda.com/help-mx24/import/importing-text-from-a-tablespreadsheet-e-g-answers-to-open-questions
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Choose a code containing coded survey question responses

If you activated a selection of documents, you can use the Only activated documents option4.
to restrict the analysis view to these documents (you can turn the filter of activated
documents on or off at any time later).

Click on OK and the interactive table window will appear, divided into two sections:

The interactive workspace for survey response categorization

In the leftmost field of the window, you will see a reduced code system that displays the selected
question code. New categories can be inserted here as subcodes and then assigned to the
individual answers. The number at the end of the code line tells you how often the code was
assigned to the documents you are currently analyzing.

In the table to the right, you see a list of the responses – each in a separate line. The number of
currently displayed lines, i.e. the responses to be categorized, is indicated in the header above the
table.

The individual columns contain the following information:

Document – The source of the response.

Responses – The texts of responses of people who answered your survey.

Codes – A list of the codes assigned to the response or part of the response; only the codes that are
currently visible in the code system on the far left are listed here. The question codes, whose
answers are currently being analyzed, are never shown here.

Comments (initially hidden) – Freely editable text field (up to 511 characters) for notes: useful for
the developing suitable categories.
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Like all MAXQDA table widows, the individual fields can be adjusted: The columns can be adjusted in
width and position with the mouse or hidden with a right-click on a column heading. A click on the
heading sorts the column in ascending order, another click in descending order.

Please note: All other MAXQDA functions are locked while the window for categorizing survey
responses is open.
Display Options

At the top, you will see a ribbon menu with the following functions:

Display all Codes – displays all your project’s codes. When turned off, only the selected codes and
subcodes are displayed.

Only Activated Documents– Only the answers of the currently activated documents are displayed.
The frequencies displayed in the code tree are adjusted accordingly.

Filter – applies filters, which are defined by right-clicking on a column heading and selecting the Set
Filter, to all columns.

Reset all Filters – removes all filters from all columns.

Display Parent Code – in addition to the code, the "Codes" column also displays its parent code.

Display Comments – displays comments field.

Display Favorite Variables – shows another column for each favorite variable. For example, you can
display the age of a person or other background information about a case. You can set favorite
variables by clicking on the button with the three dots.

At the top right of the window there are two icons for the local undo function:

Undo – undoes the last action in the window.

Redo – redoes the last action in the window.

Creating New Categories

In order to categorize individual responses, you first need some categories, of course! If you have
already defined some or all of these categories before you begin your analysis, you can define them
as new subcodes of your question code.

Click on the green plus symbol that appears while hovering over an existing code.1.
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Add a new code by clicking on the green plus symbol

In the dialog window that appears, enter the code name. To better distinguish between2.
different sub-codes, you can use different colors. You can also enter the description of the
new code (i.e., which responses they are applied to) into the “Code memo” field..
Click Additional code to create a second and third code, and so on. Click OK to finish creating3.
new codes.

Please note: All changes made to the code system in this window, including the addition of new
codes, are automatically incorporated into your overall “Code System” window.

If at the beginning of the analysis, you haven’t defined any categories and you would rather develop
these from the data, you can start by reading some of the responses and then create suitable
subcodes.

Tip: You can also use the comment column to collect ideas for categories for the first few
responses, and define appropriate categories after working through several of them.

Assigning Categories

To assign a response to a code, click and drag the row with that response to one of the displayed
codes in the hierarchical code tree. This allocation is immediately displayed in the “Codes” column.
To assign a code to only part of a response, double-click on the text of the response, select the
desired portion of text, and drag it to one of the codes in the code system. Even if you add the same
code to multiple sections of a response, the code name is listed only once in the “Codes” column.

Assigning a code to part of a response

Tip: By right-clicking on a row and selecting the function Create and Assign New Code, you can
directly add a code and assign it to the entire response.
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Removing Assigned Categories

To remove a code assigned to a response, click the cross that appears when you move the mouse
over a code in the “Codes” column. All assignments of the code will then be removed from the
response.

Delete a code assigned to a response

Customizing Your Category System

You can adapt your category system throughout the entire analysis process. You can change the
order of codes with the mouse as well as add subcodes. By right-clicking on a code, all the features
from your “Code System” are available to customize your code system in this window:

Delete code
Sort subcodes (alphabetically or by category frequency)
Change code color
Create or edit code-memo
Copy, move, paste coded segments

Click on a code in the code tree to list all your coded segments under this category (the categorized
answers to the survey question or parts of it). This way, you have an overview of the contents of
individual categories. The highlighted row in the left code system indicates which code is currently
selected. The name of the selected code is also displayed in the heading of the listed responses.

Select a code/category to display its contents

Please note: The “Codes“ column only contains the names of codes that were additionally assigned
to the selected code.
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Working with Comments

In the comments column, you can write a comment regarding each response. During the process of
category development, comments can be used to summarize long responses and to record ideas for
new categories for appropriate categories for a specific response. They are also suitable for notes
such as “still unclear” or “come back to this later” for responses that are hard to categorize.

Double-click a cell in the "Comments" column to enter a new comment or edit an existing one.

Comments are stored for the code selected in the “Code System”.

You can add comments to survey question responses

Pausing and Restarting the Categorization Process

You can pause your current categorization at any time by closing the window. All your
categorizations will be stored as codes in your MAXQDA project.

To pick up where you left off, restart the function via Analysis > Categorize Survey Responses and
select the code that contains the responses to your survey question.

Exporting Responses

The current view can be exported using the typical icons in the ribbon menu. All responses of the
right pane will be exported.

Further Features for Analyzing Your Survey Data

In the following chapters you will find further information on analyzing survey data:

Searching, filtering, and autocoding survey responses
Autocoding survey responses with dictionary
Analyzing survey data statistically
Analyzing and autocoding sentiments in survey responses

https://www.maxqda.com/help-mx24/analyzing-surveys/search-and-autocode-survey-responses
https://www.maxqda.com/help-mx24/analyzing-surveys/autocode-survey-responses-with-dictionary
https://www.maxqda.com/help-mx24/analyzing-surveys/analyze-survey-data-with-maxqda-stats
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Search and Autocode Survey Responses
You can use the Categorize Survey Data window to search responses to open-ended questions by
search items and have the results automatically coded with a category. To do this, start the Analysis
> Categorize Survey Data feature and drag a code containing the open-ended answers to a question
from the “Code System” window into the dialog box that appears:

Choose a code containing coded survey question responses

After clicking OK, the following interactive working environment appears:

The interactive workspace for survey response categorization

Create Word Cloud for Survey Responses

Click on the word cloud icon in the ribbon to visualize the most frequent words of the currently listed
answers. Clicking on a word in the cloud, filters the current view and lists only the answers in which
the clicked word occurs.

Filter answers that contain a search term from the word cloud
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After closing the word cloud, the listed answers can be autocoded by clicking on the icon  above
the answers.

Autocode Hits from Local Search

To perform a local search in the answers currently displayed in the right window:

Click on the magnifying glass in the header of the table at the top right or use the shortcut1.
ctrl+F (Win) or ⌘+F (macOS) to show the search bar.
Enter a search term.2.
Click on the filter icon in the search bar to display only the answers with hits (this step is not3.
mandatory for autocoding, but it is very helpful for a quick overview of the responses
containing the search hit).

To code the answers that contain a search hit, click the Autocode search results with a new code
icon in the search bar:

Autocode local search hits

A menu opens in which you can set whether only the hit should be coded with a new code or
whether the surrounding sentences or paragraphs should be coded. For short answers, the first
option is usually the best choice, because then the entire response in which the search item was
found is coded.

After selecting the context to be coded, a dialog box for creating a new code appears. After clicking
OK, the code is assigned to the selected context:
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Automatically coded responses

The code name can be adjusted at any time in the code system on the left.

Perform Complex Searches and Autocode Results

The local search bar provides only limited search functionality and is limited to the answers currently
listed in the right pane. If you want to perform more complex searches, click Search & Autocode in
the ribbon menu:

Start text search

This opens the MAXQDA “Text search” window:
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The Text search window

In the window, several search items can be entered that must appear all in a response. The search
for two or more search items using the AND search can also be limited to paragraphs or sentences.

The options for the search correspond to those of the global text search and are described there in
detail. In addition, there is the option Only in listed responses, which ensures that only the
responses currently listed in the right-hand window are searched. If you switch off the option,
MAXQDA will search all answers that are currently available in the working environment (the number
of available answers is shown in the first line of the code tree in the left pane).

After clicking Search, the answers with hits are listed in the right pane of the window:

List of search hits and autocode options

https://www.maxqda.com/help-mx24/text-search/global-text-search
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To automatically code the answers with a new code, click on the icon of the same name as shown in
the previous figure. A menu appears where you can set the context for autocoding:

All responses containing the search hit
All paragraphs containing the search hit
All sentences containing the search hit
The highlighted search hits only

Please note: If you have performed a search with an AND operation (as in the example above), only
the entire response or the search hit can be autocoded.

After selecting the context to be coded, a dialog box for creating a new code appears. After clicking
OK, the code is assigned to the selected context. The code name can be adjusted at any time in the
code system on the left.

Autocode Survey Responses with a
Dictionary
In the “Categorize Survey Answers” window, you can automatically code the responses to open-
ended questions using a dictionary. This feature is especially helpful if you are analyzing a lot of
data or repeatedly ask the same questions that should be coded using the same category system.

To autocode responses with a dictionary, start the Analysis > Categorize Survey Responses feature
and drag a code containing the answers to a question from the “Code System” window into the
dialog box that appears.

Choose a code containing coded survey question responses

After clicking OK, the following interactive working environment appears:
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The interactive workspace for survey response categorization

Autocoding is then performed in two steps:

Step 1: Create Dictionary

Click Dictionary in the ribbon menu to open the administration environment for dictionaries in
MAXQDA:

Create a dictionary

A dictionary contains categories with search items; in the example above, in the dictionary with the
name “<Standard>”, the category “Relationships” was underpinned with the search items “child” and
“friend”. Following this logic, create a dictionary with categories and search items for your study in
the Dictionary window and close the window.

For more information on creating, importing, and customizing dictionaries, see this section.

https://www.maxqda.com/help-mx24/maxdictio/managing-dictionaries
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Step 2: Apply Dictionary

Click the Autocode with Dictionary icon in the Ribbon menu:

Starting autocoding

A menu opens where you can select which scope should be coded: the whole answer, the paragraph
or sentence in which the search hit occurs, or only the search hit itself. In case of short answers, you
will usually choose the option to code the entire answers.

After selecting an option, the following dialog appears:

Autocode with Dictionary options window

At the top, select the dictionary to be used for autocoding.

Only in listed responses (<number of responses>) – This option ensures that only the responses
currently listed in the right-hand window are searched. If you switch off the option, MAXQDA will
search all answers that are currently available in the working environment (the number of available
answers is shown in the first line of the code tree in the left pane).

Ignore inactive categories – It is possible to temporarily disable a category in a dictionary, to turn it
off. Select this option to not include these categories in autocoding.

After clicking OK MAXQDA will autocode the responses:
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Results of autocoding procedure

A new category is added to the code system, whose subcategories correspond to the
category names from the dictionary.
Depending on the selected context, the entire responses or only parts of them are coded with
these categories. For example, in the figure, all responses containing the search item
“daughter,” “son,” "child," as defined in the dictionary category, were coded with
“Relationships”.

Analyze Survey Data with MAXQDA Stats
After you have coded the answers to open-ended questions using the Categorize Survey Data
feature, you can perform statistical analyses in MAXQDA Stats using the resulting code frequencies.
For example, you can compare whether a category was coded more often for certain groups of
people than for others. The following grouped bar chart displays the frequency for the code "Jobs
lost" (0 or 1) divided according to the document variable region ("rural" vs. "urban"):

Grouped bar chart created in MAXQDA Stats

https://www.maxqda.com/help-mx24/analyzing-surveys/categorise-survey-data
https://www.maxqda.com/help-mx24/stats/what-does-maxqda-stats-offer
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Please note: This function is only available if you are using a license of “MAXQDA Analytics Pro”.
This is the case when a menu tab named Stats is visible in the main MAXQDA window.

Start MAXQDA Stats directly from the “Categorize Survey Responses”
window

When coding is complete, click the Analyze in Stats icon on the ribbon menu.

Working environment “Categorize Survey Responses” after coding

This will start MAXQDA Stats and provide the code frequencies for statistical analysis. If the option
Only Activated Documents was selected when starting the Categorize Survey Responses feature,
only the activated documents will also be available in Stats. All document variables of the project are
always available in Stats.

Analyze Sentiments in Survey Responses
You can use the Categorize Survey Data window to analyze and autocode the sentiment of each
response. To do this, start the Analysis > Categorize Survey Data feature and drag a code
containing the open-ended answers to a question from the “Code System” window into the dialog
box that appears:

All survey question responses should be coded with one code

After clicking OK, the following interactive working environment appears:

Analyze Sentiments of Survey Responses

With MAXQDA you can perform a sentiment analysis of the responses listed in the Survey Analysis
window. This automatically evaluates whether the content is to be assessed as negative, neutral, or
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positive. The survey responses can then be autocoded according to their sentiments. Sentiment
analysis is accessed from the ribbon of the Survey Analysis window (in the top right):

 

Click Analyze Sentiments to start the process.1.
In the dialog that appears, you can select various options:2.

Options for sentiment analysis

Select language – this selection ensures, that MAXQDA will use the appropriate resource for
sentiment evaluation.

Ignore hashtags – if this option is enabled, hashtags, such as #bestever, are not taken into
account when evaluating sentiment.

Apply stop word list – if this option is enabled, all words from the selected stop word list will
be ignored when evaluating the sentiment. Also hashtags that correspond to a stop word are
ignored.

After clicking OK, the sentiment analysis is performed and four columns are added to the3.
table view:

Sentiment: Contains the rating of the sentiment in five levels from "negative" to
"positive". Responses that do not contain words with a sentiment value are marked
with "No sentiment".
(Positive) Words: Number of words that were evaluated as positive.
(Negative) Words: Number of words that were evaluated as negative.
Difference: Difference between positive and negative words. If the number is negative,
the negative words predominate. Emojis and Symbols count as a word.
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Sentiment Analysis output example

Please note: The sentiment ratings are only temporarily visible in the analysis window and are not
saved. If you close and reopen the analysis window, you can run the sentiment analysis again with
the same or different options.

Autocode survey responses with sentiments

You can save the assignment of the sentiments to the individual responses as codes in MAXQDA’s
code system:

Call the function Start > Autocode Responses with Sentiment in the menu tab.1.
In the dialog that appears, select the sentiment levels you want to autocode.2.

After clicking OK, the selected sentiments are created as codes. If they already exist in the code
system, the existing codes will be used for coding. The text of the reponses will be autocoded with
the selected codes.

How does MAXQDA evaluate the sentiments?

MAXQDA uses a lexicon to evaluate sentiments, which contains a sentiment score for each word in
the lexicon. This value is negative for words with negative connotations, close to zero for neutral
words, and positive for words with positive connotations.

When analyzing a response, MAXQDA checks each word whether it is contained in the lexicon and
assigns the sentiment score to this word (hashtags and stop word list words are ignored if desired).
If the word is not in the lexicon, MAXQDA looks up the word in a lemma list. If a lemma is found for
the word and this lemma is contained in the sentiment lexicon, the sentiment score of the lemma is
used for the word.

In addition, two rules are applied to optimize the evaluation of sentiment:

In case of negation, the scores of the following 3 words are reversed, for example, the1.
statement "I was not very happy" is classified as negative.
In case of modal verbs, such as "can", "should", etc., the sentiment scores of the following2.
words are reduced.

https://www.maxqda.com/help-mx24-dictio/lemmatization
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The mean value is calculated from the sentiment scores of the evaluated words in a response. If the
mean value is negative, the response is evaluated as "negative" or "slightly negative", if the mean
value is positive, the response is evaluated as "positive" or "slightly positive". If the mean value is
equal or close to zero, the response text is classified as "neutral". Responses that don’t contain any
word with a sentiment score are classified as "no sentiment".

Please note: Sorting in the "Sentiment" column is based on the calculated sentiment value, not on
the difference between positive and negative words.

In the literature on automatic sentiment analysis, values of 60 to 70% agreement compared to a
human control assignment are usually reported. It has to be taken into account that human
assessments of the same text can also differ. The quality of a sentiment analysis depends on
several factors, especially the fit of the lexicon for a given topic. Please also note that a sentiment
analysis has little meaning for responses in which little to no evaluations are expressed.

English lexicon

The lexicon for English is based on the resource SentiWordNet 3.0, which is licensed under an
Attribution-ShareAlike 4.0 Unported (CC BY-SA 4.0) license (for more info on SentiWordNet, see
Baccianella, Esuli & Sebastiani, 2010). The SentiWordNet 3.0 lexicon has been optimized for use in
MAXQDA, including

removal of special characters and duplicates
addition of typical social media abbreviations (e.g. LOL - laughing out loud), emojis, and
superlatives
manual adjustment of scores for individual words to scores of their synonyms

Please note: You can view and customize the lexicons used by MAXQDA for sentiment analysis. The
lexicons are located in the "Resources > SentimentScore" subfolder of the MAXQDA installation
folder:

Windows: 

C:\Programs\MAXQDA24\Resources\SentimentScore

Mac: local installation

Program directory > Right mouse click on MAXQDA24 > Show package contents:
Contents > Resources > SentimentScore

Bibliography

Baccianella, S.; Esuli, A.; Sebastiani, F. (2010). SentiWordNet 3.0: An Enhanced Lexical Resource for
Sentiment Analysis and Opinion Mining. Proceedings of LREC. 10.
http://nmis.isti.cnr.it/sebastiani/Publications/LREC10.pdf

https://github.com/aesuli/SentiWordNet
http://creativecommons.org/licenses/by-sa/4.0/
http://nmis.isti.cnr.it/sebastiani/Publications/LREC10.pdf
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27 – Analyzing Tweets

Analyze Tweets
IMPORTANT: Following changes in the Twitter API regulations made by Twitter in April 2023,
MAXQDA no longer supports the „Twitter import“ function. Nonetheless, any Tweets already
imported into a MAXQDA project can still be analyzed using the “Analyse Tweets” workspace.

In July 2023, the platform previously known as "Twitter" underwent a renaming to "X". Please note
that the content within this manual refers solely to data acquired during the period when the service
was still named "Twitter." As a result, we have chosen to maintain the original terminology
throughout.

The analysis of tweets based on coded segments can reach its limits if you want to analyze
thousands of tweets. It's hard to keep an overview of the whole picture, simple automatic coding
reaches its limits and manual codings are practically impossible. Analysis functions are needed that
enable you to keep track of larger amounts of data and to make targeted comparisons between
authors, etc.

For this purpose, MAXQDA offers a special analysis view for imported twitter data, with which you
can evaluate tweets according to numerous criteria, such as: frequent words, hashtags, authors,
countries and/or sentiments.

A prerequisite: Your project includes Twitter data

A prerequisite for using the Twitter analysis functions in MAXQDA is that you have already imported
Twitter data into your MAXQDA project. You can recognize imported Twitter data in the "Document
System" by their Twitter symbol.

Twitter data in the “Document System”

Follow these steps to begin a Twitter analysis:

https://www.maxqda.com/help-mx24/import/importing-twitter-data
https://www.maxqda.com/help-mx24/import/importing-twitter-data
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Select the function Analysis > Analyze Tweets1.
In the dialog window that appears select all Twitter documents that you would like to include2.
in your analysis.
Click on OK and the following analysis will appear:3.

Window for Twitter analysis

When opening the window, all analyzed tweets are listed in descending order by release date in a
table. The table is structured as follows:

The first column contains the profile picture, the second the Twitter name and real name of the
author. When you first open the window, no profile pictures will be displayed - you can display them
via clicking on the Load Profile Pictures icon. The pictures are loaded and gradually displayed. If an
image has already been loaded for an author, it will be used; the image loaded will not be updated if
it has changed in the meantime. Some authors have not posted an image on Twitter.

Type – indicates whether it is a tweet, a retweet, or a reply.

Tweet – contains the text of the tweet. Hashtags and mentioned Twitter accounts are highlighted in
color. Click View Tweet to show the Titter card.

Retweets - how often the Tweet has been retweeted. This number is an indicator of the tweet’s
popularity.

Likes – the number of likes a Tweet received. This number is an indicator of the tweet's popularity
as well.

Followers – how many followers the author had at the time they published the tweet. This number is
an indicator of the author’s popularity.

Tip: This table can be arranged by clicking on each respective column’s header.
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Filter tweets

Using the filter panel on the left, you can filter the tweets according to several criteria. You can also
expand and collapse the filter area by clicking on the filter header.

The number in brackets behind the filter refers to the total number of all analyzed tweets on the
basis of that filter. This means that it will remain constant, even if you turn on several filters. The
current number of listed tweets is displayed at the top of the menu tab. 150 (2,000) means, that 150
of 2,000 tweets in total are displayed.

Please note: Within a filter range, an OR function is applied: If you set a "Tweet" and "Retweet" in the
"Type" area, both tweets and retweets are displayed. The individual filter areas are connected with
AND: If you put a check mark in the "Retweet" area and a check mark in the area "Most frequently
used hashtags" for "#Berlin", only retweets with the hashtag #Berlin will be listed.

These filter areas are always available:

Types – always contains the three filter options "Tweet", "Retweet" and "Reply".

Sentiment allows filtering by the sentiment (negative, neutral, positive) expressed in a tweet. This
section will appear automatically once you have determined the sentiment of each tweet by clicking
Sentiment Analysis in the menu tab.

Most frequently used words – Lists the most common words in descending order. Internet links and
mentioned accounts will be ignored. All the words currently contained in the stop word list for the
word cloud will also be filtered out.

Most frequently used words – Lists the most common words in descending order. Internet links and
mentioned accounts will be ignored. A Stop Word List can be applied, so that all the words currently
contained in the stop word list for the word cloud will also be filtered out.

Most frequently used hashtags – lists the most common hashtags in descending order.

Authors by number of tweets – lists the most active authors in descending order. Only the analyzed
tweets are considered.

Authors by number of followers – lists the authors with the largest reach in descending order. Their
number of followers is used as an indicator of reach.

Mentioned accounts – lists the most frequently mentioned accounts in descending order.

Languages – lists the most frequently used languages in descending order. (The language is
identified by Twitter automatically).

Sources – lists the most frequently used devices and programs from which the tweets were sent in
descending order.

Create word clouds and word frequency lists

You can create word clouds with the most frequently used words in the currently displayed tweets
as well as a list of all the words contained in them:
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If needed, filter tweets according to selected criteria.1.
Click on the Word Cloud icon to create a word cloud like the following:2.

Word cloud for tweets

To make your word cloud display only the most relevant words, you can transfer less3.
important words into a stop word list to exclude them. The easiest way to do this is to click
on the Word Frequencies icon it the menu tab Start to display the list of all the words that
appear.

Transferring words from the word frequency list to the stop word list

The word frequency list is sorted in descending order. To transfer a word to the stop word list,4.
double-click the green icon in the first column. The green icon then changes to a stop symbol.
Alternatively, select one or more lines with the mouse, and then click the Add to stop word list
symbol in the toolbar.
Click the circular arrow in the toolbar to Refresh and apply stop word list. The word cloud and5.
word frequency list will then be regenerated, taking into account your new stop word list.

The filters for the tweets allow you to create and compare word clouds between different groups of
authors.
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Tip: In MAXDictio, the add-on module for word-based analysis, you can manage various stop word
list and always transfer these words to your "stop word list for word clouds".

Frequency analyses and charts

You can also create frequency tables and charts from the tweets under specific filters. Information
on the reach of tweets (their followers) as well as their publication times and weekdays are added:

Filter your tweets according to specified criteria.1.
Click Statistics in the manu tab to request a frequency analysis.2.

Frequency table displaying the frequency of tweets per day of the week.

You can use the arrows at the top of the window to toggle between individual frequency3.
tables.
Click on the chart symbol in the upper left corner to display the table as a horizontal or4.
vertical bar chart or pie chart. For more information refer to the Frequency tables and charts
for subcodes

https://www.maxqda.com/help-mx24/statistics-and-graphics-functions/frequency-tables-charts-subcodes
https://www.maxqda.com/help-mx24/statistics-and-graphics-functions/frequency-tables-charts-subcodes
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Chart displaying the frequency of tweets per day of the week.

MAXQDA generates the following charts with associated frequency tables in the twitter analysis:

Chart Bars represent Categories

Weekday Number of tweets Days

Time Number of tweets Hours

Type Number of tweets Tweet, retweet, reply

Most frequent words Number of tweets 15 most frequently used words (options for
making this analysis case-sensitive and/or
taking word cloud stop-lists into account). The
category "Other" can also be displayed.

Most frequent
hashtags

Number of tweets 15 most used hash tags. The category "Other"
can also be displayed.

Author by number of
tweets (real name) /
Author by number of
tweets (Twitter name)

Number of tweets 15 authors with the highest amount of tweets.
The category "Other" can also be displayed.

Authors followers Number of followers 15 authors with the most followers. The
category "Other" can also be displayed.

Source Number of tweets 15 most common sources. The category
"Other" can also be displayed.

Retweets Number of retweets Specified categories from 0 to a 100+

Likes Number of likes Specified categories from 0 to a 1,000+

Followers Number of followers Specified categories from 0 to a 1,000,000+
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Sentiment
(only available after
using the function
Sentiment Analysis)

Number of sentiment
assessments

Specified categories from "negative" via
"neutral" to "positive"

Export tweets

The current listed tweets can be exported using the usual icons in the Home tab. The sorting of the
table will be adopted.

Export – Creates a table as an Excel file (XLS/X format), a Word file (DOCX format), a web page
(HTML format) or in other (less common) formats.

Open as Excel table – Creates an Excel spreadsheet and opens it.

Open as Word document – Creates a Word document and opens it.

Autocode Tweets with Hashtags and
Authors
IMPORTANT: Following changes in the Twitter API regulations made by Twitter in April 2023,
MAXQDA no longer supports the „Twitter import“ function. Nonetheless, any Tweets already
imported into a MAXQDA project can still be analyzed using the “Analyse Tweets” workspace.

In July 2023, the platform previously known as "Twitter" underwent a renaming to "X". Please note
that the content within this manual refers solely to data acquired during the period when the service
was still named "Twitter." As a result, we have chosen to maintain the original terminology
throughout.

MAXQDA can automatically code the text of up to 100 authors and 100 hashtags from imported
Twitter data.

Open the analysis view for tweets via Analysis > Analyze Tweets.1.
In the dialog that appears, select all the Twitter documents you want to include in the2.
analysis.
After clicking Analyze Tweets, the following analysis view appears:3.
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MAXQDA workspace for analyzing tweets

Start the autocode process by clicking on Autocode Tweets with Hashtags/Authors and a4.
dialog window will appear in which you can enter the author names and hashtags you wish to
autocode. (When you import Twitter data, this dialog window appears automatically following
the import.)

Autocode Twitter data dialog window

Before you can start the autocoding process, you must first select the hashtags or author5.
names you wish to encode. To do so, use the Select hashtags and Select authors buttons. A
new dialog window will appear, in which the selected hashtags and author names are listed:

https://www.maxqda.com/help-mx24/import/importing-twitter-data
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Selecting hashtags for autocoding

In the "Hashtag" column, the different hashtags are listed, and in the "Tweet" column you can
see the number of tweets in which the hashtag appears. In the upper left corner you can see
how many different hashtags were found in total; the top right shows how many of these
hashtags are currently selected.
Select the entries with the hashtags that are relevant to your analysis:6.

Select the desired row. As usual, you can select multiple rows by holding down the Ctrl
key (Windows) or cmd key (Mac). Your selection will be highlighted.
Click the green checkmark  symbol in the upper toolbar. A green checkmark will
appear in front of the the selected hashtags.

This procedure can be repeated as desired, or reversed by selecting a row and clicking on the
Stop icon to deselect an entry. Note that a maximum of 100 entries can be selected.

When you click OK, you will return to the Autocode dialog window, where you can proceed in7.
the same manner with author names.
When at least one hastag or author name is selected, the Autocode button becomes available8.
and can be clicked.

MAXQDA then begins the autocoding process, which may take a moment depending on the number
of entries.

Later, when you close the Analyze Tweets window, you can see the result of the autocoding process
in the "Code System": The resulting new code “Autocode Twitter data” with the date will be inserted
at the top.
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The automatically inserted code in the Code System

In the automatically generated codes “Tweet hashtag” and “Tweet author”, the selected hashtags
and author names are used as subcodes. All these codes can be managed like any other code – for
example, you can change the color or arrangement, depending on what makes the most sense for
your analysis.

Please note: Via Analysis > Analyze Tweets > Autocode Tweets with Hashtags/Authors you can
open the autocode function as often as needed. It is therefore not necessary to perform the
autocoding process immediately after import.

Analyzing Coded Tweets

Once you have autocoded your tweets, all the usual MAXQDA twitter analysis tools are available. For
example, you can use the Coding Query to determine which tweets were written by specific authors:

Activate one or more documents with Twitter data in the Document System.1.
Activate the codes with the relevant author names in the Code System.2.

The result will be a compilation of all relevant tweets, which will appear in the “Retrieved Segments”
window. When clicking on the Word Cloud icon in the "Retrieved Segments" toolbar, you can
visualize the frequently used words in the compilation of tweets.

Further analysis options, especially when delaing with several thousand tweets that have not been
autocoded, MAXQDA offers further analysis options including filters, word-based functions and
statistics.

Analyze Sentiments of Tweets
IMPORTANT: Following changes in the Twitter API regulations made by Twitter in April 2023,
MAXQDA no longer supports the „Twitter import“ function. Nonetheless, any Tweets already
imported into a MAXQDA project can still be analyzed using the “Analyse Tweets” workspace.

In July 2023, the platform previously known as "Twitter" underwent a renaming to "X". Please note
that the content within this manual refers solely to data acquired during the period when the service
was still named "Twitter." As a result, we have chosen to maintain the original terminology

https://www.maxqda.com/help-mx24/segment-retrieval/activation-principle-segment-retrieval
https://www.maxqda.com/help-mx24/visual-tools/word-clouds
https://www.maxqda.com/help-mx24/statistics-and-graphics-functions/frequency-tables-and-diagrams-for-variables
https://www.maxqda.com/help-mx24/statistics-and-graphics-functions/frequency-tables-and-diagrams-for-variables
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throughout.

With MAXQDA you can perform a sentiment analysis of tweets. This automatically evaluates
whether tweet content is to be assessed as negative, neutral, or positive. The tweets can be sorted
and filtered according to their sentiments, and the tweets can also be automatically coded with their
sentiments for further analysis.

Perform sentiment analysis

A prerequisite for performing the sentiment analysis is that you have already imported tweets into
the currently opened MAXQDA project.

Open the analysis view for tweets via Analysis > Analyze Tweets.1.
In the dialog that appears, select all the Twitter documents you want to include in the2.
analysis.
After clicking Analyze Tweets, the following analysis view appears:3.

MAXQDA workspace for analyzing tweets

Start the Sentiment Analysis by clicking on the Sentiment Analysis icon in the Start tab.4.
In the dialog that appears, you can select various options:5.

Options for sentiment analysis of tweets

https://www.maxqda.com/help-mx24/import/importing-twitter-data
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At the top, set the language of the tweets so that MAXQDA will use the appropriate resource
for sentiment evaluation (currently: English and German).

Ignore hashtags – if this option is enabled, hashtags, such as #bestever, are not taken into
account when evaluating sentiment.

Apply stop word list – if this option is enabled, all words from the selected stop word list will
be ignored when evaluating the sentiment. Also hashtags that correspond to a stop word are
ignored.

After clicking OK, the sentiment analysis is performed and four columns are added to the6.
tweet table:

Sentiment: Contains the rating of the tweet in five levels from "negative" to "positive".
tweets that do not contain words with a sentiment value are marked with "No
sentiment".
(Positive) Words: Number of words that were evaluated as positive.
(Negative) Words: Number of words that were evaluated as negative.
Difference: Difference between positive and negative words. If the number is negative,
the negative words predominate. Emojis and Symbols count as a word.

Columns for sentiment analysis

You can sort the table by the newly added columns by clicking the column header with the mouse.

Please note: The sentiment ratings of the tweets are only temporarily visible in the analysis window
and are not saved. If you close and reopen the analysis window, you can run the sentiment analysis
again with the same or different options.

Filter tweets by sentiment

Once you have determined the sentiments of the tweets, another filter area will appear in the left
pane of the analysis view:
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Sentiment filter

Here you can see how many tweets were evaluated positive, neutral, or negative. By selecting oen of
the sentiments, you can filter the tweets, for example, only the "positive" and "Slightly positive"
tweets can be displayed.

Create a diagram of the sentiments

Click on Statistics in the Start tab to access the chart function.1.
In the chart view that appears, open the drop-down menu at the top and select "Sentiment".2.

Diagram for the frequency distribution of sentiments

Autocode tweets with sentiments

You can save the assignment of the sentiments to the individual tweets as codes in MAXQDA’s code
system:

Call the function Start > Autocode Tweets with Sentiment in the menu tab. The following1.
dialog appears:
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Options for coding the tweets with their sentiment

In the upper area you select the sentiments to be coded. For example, you can choose to2.
code only the positive and slightly positive tweets. Select the Code filtered tweets only option
to limit the coding to the currently listed tweets. For example, it is possible to code only
tweets containing a specific hashtag with their sentiments.

After clicking OK, the selected sentiments are created as codes in the "Code System" window. If they
already exist in the code system, the existing codes will be used for coding. The text of the selected
tweets will be autocoded with the selected codes.

If you close the Analyze tweets window, you can continue working with the coded tweets. For
example, activate Twitter documents and the code "Positive" to compile all positively evaluated
tweets in the "Retrieved Segments" window.

Sentiment codes in the 'Code System' (left); Coded tweet in the 'Retrieved Segments' window (right)

How does MAXQDA evaluate the sentiments?

MAXQDA uses a lexicon to evaluate sentiments, which contains a sentiment score for each word in
the lexicon. This value is negative for words with negative connotations, close to zero for neutral
words, and positive for words with positive connotations.

When analyzing a tweet, MAXQDA checks each word whether it is contained in the lexicon and
assigns the sentiment score to this word (hashtags and stop word list words are ignored if desired).
If the word is not in the lexicon, MAXQDA looks up the word in a lemma list. If a lemma is found for
the word and this lemma is contained in the sentiment lexicon, the sentiment score of the lemma is

https://www.maxqda.com/help-mx24-dictio/lemmatization
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used for the word.

In addition, two rules are applied to optimize the evaluation of sentiment:

In case of negation, the scores of the following 3 words are reversed, for example, the1.
statement "I was not very happy" is classified as negative.
In case of modal verbs, such as "can", "should", etc., the sentiment scores of the following2.
words are reduced.

The mean value is calculated from the sentiment scores of the evaluated words in a tweet. If the
mean value is negative, the tweet is evaluated as "negative" or "slightly negative", if the mean value is
positive, the tweet is evaluated as "positive" or "slightly positive". If the mean value is equal or close
to zero, the tweet text is classified as "neutral". Tweets that don’t contain any word with a sentiment
score are classified as "no sentiment".

Please note: Sorting in the "Sentiment" column is based on the calculated sentiment value, not on
the difference between positive and negative words.

In the literature on automatic sentiment analysis, values of 60 to 70% agreement compared to a
human control assignment are usually reported. It has to be taken into account that human
assessments of the same text can also differ. The quality of a sentiment analysis depends on
several factors, especially the fit of the lexicon for a given topic. Please also note that a sentiment
analysis has little meaning for tweets in which little to no evaluations are expressed.

English lexicon

The lexicon for English is based on the resource SentiWordNet 3.0, which is licensed under an
Attribution-ShareAlike 4.0 Unported (CC BY-SA 4.0) license (for more info on SentiWordNet, see
Baccianella, Esuli & Sebastiani, 2010). The SentiWordNet 3.0 lexicon has been optimized for use in
MAXQDA, including

removal of special characters and duplicates
addition of typical social media abbreviations (e.g. LOL - laughing out loud), emojis, and
superlatives
manual adjustment of scores for individual words to scores of their synonyms

Please note: You can view and customize the lexicons used by MAXQDA for sentiment analysis. The
lexicons are located in the "Resources > SentimentScore" subfolder of the MAXQDA installation
folder:

Windows: 

C:\Programs\MAXQDA24\Resources\SentimentScore

Mac: local installation

Program directory > Right mouse click on MAXQDA24 > Show package contents:
Contents > Resources > SentimentScore

https://github.com/aesuli/SentiWordNet
http://creativecommons.org/licenses/by-sa/4.0/
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28 – Report & Export

Smart Publisher for Coded Segments
Smart Publisher is a convenient report generator. It exports selected coded segments in a formatted
Word document report, including title page and table of contents. The structure of the report is
determined by the “Code System:”

An individual chapter will be created for each top-level code.
A subchapter will be created for each subcode.
Coded segments of each code form the content of each (sub)chapter.
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Excerpt of an example report

Starting the Smart Publisher

Smart Publisher can be accessed via the main ribbon menu: Reports > Smart Publisher.

A dialog window will appear in which you can select the codes to be included in the report. You can
also choose to include coded segments only from activated documents, to ignore codes without
coded segments, and include code memos.

Select codes
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Smart Publisher code selection window

Customize included elements an layout

In the next step, you can select various report options:

Title – The title, which will appear on the first page of the report.

Subtitle – The subtitle, which will appear on the first page of the report.

Image files 1 and 2 – Selection of up to 2 image files, which will appear on the first page of the
report. If the field is left blank, no image will appear.
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Header – Header text. If the field is left blank, no image will appear.

Footer – Footer text. If the field is left blank, no image will appear.

Quotation marks – Displays the segments in quotation marks.

Include list of documents – Includes a list of all considered documents at the beginning of the
report.

Additional information for the coded segments

"Further Information"

In the left window, specify which supplementary information should be exported in addition to the
coded segments, including memos, comments, area and coverage, other codes assigned to the
segments and variabels.

"Source information"

In the section to the right, you can specify which source data should be exported with each segment.

"Coded Segments sorted by" settings

In this part you can set how the coded segments within each chapter of the report are sorted. You
can sort segments by their documents position in the ”Document Sysetm” or by their assigned
weight scores.

The report

The finished report is in the form of a Word document (in DOCX format), which includes a title page,
table of contents, a page that lists of all the documents included in the report, and the main section
including all of the exported segments. If a header/footer was included, it will appear on all pages
aside from the title page.

Alias names for codes

Smart Publisher uses the code names from the “Code System” as headings for the individual
subchapters of the report. However, you may wish to assign an alternate name to some or all of the
subchapters in the report. This may be the case if the 127 characters per heading allowed by the
system are not enough, and you wish to create a longer name, or if, in other cases, a shorter heading
would be more appropriate. For this reason, MAXQDA allows you to create a code alias of up to 225
characters.

In order to assign a code alias, right-click on the code in the “Code System” and select Properties. A
dialog window will appear, in which you can enter the code alias.

Adjusting the Smart Publisher layout

It is possible to customize the layout of Smart Publisher reports. To do this, you will find a settings
file named as “SP_Formats.ini”, the contents of which you can customize. You can find the file in the

https://www.maxqda.com/help-mx24/codes-2/the-properties-window-for-codes
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following folder, depending on your operating system:

Note: You must have used Smart Publisher at least once to customize the following files.

Windows

Open Windows Explorer.1.
In the address bar, type in the following and press Enter: %appdata%2.
Navigate to folder “MAXDQA24” and open it.3.

Mac

Open the Finder and press the keyboard shortcut Shift + cmd + G1.
Copy the following path into the address bar and select OK:2.
~/Library/Preferences/MAXQDA24

The structure of “SP_Format.ini” is as follows:

[Default_Format]

StyleName = "MQ_Header1"
FontName="Calibri"
FontSize = 11
LineSpacing = 1.2
SpaceAfter = 6
Indent = 12.5

For example, to use your the font that is used in your corporate design, change the entry next to
FontName from "Calibri" to the appropriate text font.

Codebook with Category Definitions
The “Export Codebook” function allows you to automatically generate a Codebook that lists all or
selected codes in the order of the Code System and also outputs the associated code memo for
each code. The codebook therefore contains the category definition of each individual code,
provided that this was recorded in the code memo. This saves a lot of work in the creation of the
annex for a research report, especially since it provides the opportunity to unify the font for all memo
text.

The Codebook is created in Word document format and can therefore easily be opened with word
processing programs. It includes a cover page with the title "Codebook", the project name and the
creation date. On the following page, the Code System is listed in a table. In the main section, the
respective codes with their associated memos are listed in the order of the Code System.

The Codebook function is accessed through the menu Reports > Codebook. A window will appear in
which you can specify the Codebook options in more detail.
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Setting options for the Codebook

In the top section of the window, you can specify which codes should be included in the Codebook.

Only codes with code memos - Set this option to exclude codes that have no memo in the
Codebook.

Only top level codes - If you select this option, only the codes in the top level of the Code System,
with their associated code memos, will be included. Subcodes will not be included.

Only activated codes - In this case, only activated codes will be included in the Codebook. You can
decide whether (inactivated) subcodes should also be included: Include subcodes. This option is not
available if you have selected Only top level codes.

Other options can be set in the lower section:

Standardize memo fonts - If the font, font size, etc. varies between memos, they can be uniformly
displayed in the Codebook using this option.

Number codes - If this option is selected, the listed codes will be numbered according to their
hierarchy in the Code System.

Include parent code in code name - If this option is selected, the code path will be specified as a
heading for the subcodes.

Export code system with frequencies - If this option is selected, a column containing the code
frequency will be added in the table overview of the code system.

After confirmation, select a name and location for the file before the Codebook is created and
opened.

Summaries with Coded Segments
You can create a report in Word-format (DOCX), which will display your compiled summaries
together with the corresponding coded segments in a table overview.

Follow these steps to create the report:

Click on the Summaries symbol in the Reports tab and select the menu option Summaries1.
with Coded Segments.
A dialog window will appear with several options.2.
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Options for creating a report of your summaries with coded segments

Only for activated documents – only summaries from activated documents are included.

Only for activated codes – only summaries for activated codes are included.

Include comments – under the coded segments, the corresponding comments (if any) are also
included.

Standardize text formatting – given that coded segments can be formatted very differently, you can
use this option to standardize the font format.

Click OK and enter a name and location for the report. MAXQDA opens the exported document
immediately.
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Report: “Summaries with Coded Segments“

For each selected code, your report will display the coded segments of the selected documents in
one column and the summaries in another column. You can use this examine these summaries and
review each of them with reference to their underlying coded segment. The report presents your
summaries in a transparent and comprehensible way.

Reports: Summaries – without coded segments

You can also create reports that only present your summaries: Reports > Summaries. The “Coded
segments“ column is not displayed – only the codes and their respective summaries.

Report Summaries
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Project Information
The function Reports > Project Information collects information about the current project and shows
the completed report in a separate window. Specifically, Project information contains the following
data :

Report date
Name of the MAXQDA project file
Project Memo (from the root of the Document System)
Number of document groups, document sets, and the individual document types
Number of codes, coded segments, and code sets
Number of memos
Number of document and code variables
Number of internal links

Project information can be copied to the clipboard with the Copy button, and from there transferred
into another program such as Word.

Project information

Document Profiles
The function "Document Profiles" allows you to export a table with important information about
selected documents. For each document, the table includes the document memo, a selection of
variables, and code frequencies.

Document Profiles Table

The Document Profiles function is accessed via the menu Reports > Documen Profiles. A window
will appear in which you can specify the exported information in more detail.
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Set options for Document Profiles

Only for activated documents - If enabled, only activated documents will be included in the exported
table.

Only for activated codes - If enabled, only activated codes will be included in the exported table.

Display Favorite Variables - If enabled, the projects favorite variables and their values are exported.
Click on the button Select variables to choose those to be exported.

Export and Print Documents
You can export your documents in various ways, for example, for documentation purposes. There
are three places in MAXQDA where you can start the export process:

Every opened document can be exported directly from the "Document Browser" by clicking on
the export icon top right.
If you right-click on a document name in the "Document System", you will find the entry Export
Document in the context menu. The same applies to a document group, where you can use
Export Documents to initiate the export process for all the grouped documents.
In the Reports menu you can find an Export option, which contains an extensive menu for
exporting individual data from MAXQDA, including the options to export the currently
dispayed, all, or the activated documents:
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Export options in the „Reports“ menu

If you select All Documents or All Activated Documents, you have to select a folder in your file
system where you want MAXQDA to save the documents. Document groups are saved as
subfolders.

Export interview transcripts with paragraph numbers, coding stripes,
and memos

For the documentation of an interview study, it is often necessary to include selected or all interview
transcripts in the report. For this purpose, MAXQDA offers you the option not only of exporting the
pure transcripts as text files, but also of exporting the paragraph numbering, the code assignments
made, and any attached memos with the transcripts and saving these as PDF files:

To export individual transcripts, right-click them in the "Document System" and select Export
Document from the context menu.
To export several transcripts simultaneously, select Export Documents from the context
menu of a document group.

The following dialog box will appear:
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Transcript export options

The following settings are available for exporting text documents:

Export as PDF document / Text document / Excel document - Sets the export format. Depending on
the selected export format there are different further export options.

As table with paragraph/line numbers - Your document is displayed as a table equivalent to the
current view in the “Document Browser” (with paragraph or line numbering). This option can only be
selected when exporting as a text document. It cannot be combined with the visualization of codes
and memos.

Display timestamps - If the transcript contains timestamps, you can include these timestamps in the
exported text.

Display coded segments - The coding stripes are placed to the left of the text. Only those code
assignments are exported that are currently selected in the "Document Browser" via the display
menu for the coding stripes. The colored background of texts is also included. This option can only
be selected when exporting as a PDF document.

Tip: In the "Document Browser", switch on the option Display coded segments in color to highlight
the coded segments in the transcript in the respective color of the assigned codes. You can access
the option by clicking on the three drots in the upper left corner of the "Document Browser".

Display memos - If enabled, the memo symbols are displayed to the left of the text. The memo text
itself is not exported. This option can only be selected when exporting as a PDF document.

Include memo content - Inserts the content of your in-document memos at the appropriate place in
the exported document. This option can only be selected when exporting as a text document.

Width of the coded segments' column - Defines how much space should be used for the display of
the coding stripes and memos.
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The listed export options are not available for PDF, image, and table documents - these are saved as
they are stored in the MAXQDA project file.

Print documents

By clicking on the small printer icon in the upper right corner of the “Document Browser” you can
print individual documents (except table documents). If you have installed a PDF printer, this
provides an alternative way to export a transcript with the codes in the page margin.

When printing, the following print preview appears, in which you can adjust page margin and enter
header and footer texts. Set the appropriate options in section More settings if you want to visualize
the coding stripes and memo icons to the left of the document:

Document printing options

Tip: To print multiple documents, you can first activate them and then choose Reports > Print >
Activated Documents from the menu tab.

Export Adjacency Matrix for Network
Analysis
Export adjacency matrix for network analysis software packages

If you want to perform a network analysis of categories with a program like Gephi, you can export
the results of the Code Relations Browser as an adjacency matrix:

https://gephi.org/
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Clicl the Export icon  at the top right of the window.1.
In the file dialog, select "Excel Document (*.xls/x)" as the file format.2.

Export your network analysis as an Excel file

MAXQDA exports the frequencies of relations as follows:

The matrix is exported as if all codes were expanded.
Codes, that are displayed only in the columns are added to the rows and vice versa. This
creates a symmetrical matrix.
If the name of a code occurs more than once, the name of the parent code is prefixed to
ensure uniqueness of the code names.

Exporting Project Components as Excel
file
One possibility for exporting is worth noting in particular. If you select the following option in the
ribbon menu, Reports > Export > Project Components as Excel File, MAXQDA will generate an Excel
file that lists the following contents in the individual tables of an Excel file:

"Document System" with code frequencies
"Code System" with code frequencies
Memos
Coded segments
Document Variables and their values
Code Variables and their values
Links
Summaries

Anonymize Projects
If you have sensitive data in the text documents of a project, you can save it anonymously as a
project copy. A prerequisite is that the sensitive text areas have been coded with a specific code.
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When saving, all texts that have been coded with this code are replaced by XXX and rendered
anonymous. If different codes have been used for different types of information, these code
namessubcode names can all be added to the anonymous text list, e.g. "People", "Places" and
"Jobs".

Follow these steps:

Start the function by going to Home > Save anonymized project as. MAXQDA will then display1.
the following dialog window:

Options dialog window for the selection of codes, the texts of which should be anonymized

Drag all the codes, the texts of which should be anonymized, from the Code System“ into the2.
dialog window.
Select the option Include code name to show the codename in brackets at the beginning of3.
each anonymized text area. This is useful, for example, if you have used several specific
codes for the anonymized texts ("person", "place", etc.). If more than one of the selected
codes has been assigned to one text, only the name of the parent code is displayed.

The project copy can then be passed on to others. The anonymized text locations in the project file
look like this:

Anonymized project with the selected “Display code name“ option

Please note: This function only works for text documents, not for PDF files or other document types.

Save Project in MAXQDA 2022 Format
How to save a MAXQDA 24 project for MAXQDA 22

MAXQDA 2022 cannot open the .mx24 format of a MAXQDA 24 project, but you can save a MAXQDA
24 project to the .mx22 file format used by MAXQDA 2022.

Open your project file in MAXQDA 24 and select Save Project As from the Home menu ribbon tab.

Save a MAXQDA 2020 project for MAXQDA 2018

In the following dialog windows set the file type to “MAXQDA 2022 Projects (*.mx22)”, enter a file
name, select a location to save the project file to, and then click Save.
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A few elements of MAXQDA 24 will be changed, because MAXQDA 2022 does not have the
functionality to handle new or changed features:

Maps are saved as images.
Coding comment and paraphrases will be shortened to 255 characters.
Code names and document names are shortened to 63 characters.
If you have selected "no color" as document color in the properties of a document, the color
will be changed to the default blue of MAXQDA 2022.

Export and Import REFI-QDA Projects
“The REFI-QDA Standard enables interoperability between Qualitative Data Analysis Software (QDAS
or CAQDAS) programs. Its purpose is to enable users to exchange processed data between
programs. It is an open standard and any program can implement it, thus increasing the number of
software programs that can ‘talk’ to one another.” (www.qdasoftware.org).

The REFI-QDA Standard makes it possible to exchange projects between all software packages that
support the XML exchange format. Software vendors include Atlas.ti, f4Analyse, NVivo, QDA-Miner,
and other. MAXQDA supports both exporting a MAXQDA project in the XML exchange format and
importing a project from such an XML file.

The REFI-QDA Project file contains specifications for the following MAXQDA components:

Documents and document groups
Codes
Internal links
Memos (and log book)
Coded segments
Comments assigned to coded segments
Document variables (or more precisely: document group variables, which do not exist in
MAXQDA)

The REFI-QDA Project file does not contain specifications for the following MAXQDA components:

Document sets
Table documents
Summaries
Paraphrases
Complex concept maps
Code variables
Speaker variables
Stop lists (word clouds and MAXDictio)
Dictionaries (MAXDictio)

The exchange possibilities are therefore limited, because the REFI-QDA Project does not support all
elements from all software packages. Even if it would support all elements, it should also be noted
that, the project logics of the individual software packages differ and therefore complex projects can
never be transferred one-to-one. Additionally, not all QDA programs support all elements, for

https://www.qdasoftware.org/
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example not all programs support working with PDF files.

The format is therefore not suitable for a teamwork situation where multiple researchers work on the
same project data with different software packages.

Please note: The same initiative also developed the "REFI-QDA Codebook" standard for the
exchange of codebooks (with code tree incl. memos). This standard has been supported since
MAXQDA version 2018.1 and is available via the menu functions Codes > Export/Import Code
System.

Import a „REFI-QDA Project“

How to import a REFI-QDA Project into MAXQDA:

Click on Open Project - either in the Start dialog that appears immediately after MAXQDA1.
starts, or in the Home tab if you have already opened a project in MAXQDA.
In the appearing file dialog, select an REFI-QDA Project file and click2.

Important notes for importing:

Text documents are imported as plain text.
Annotations of coded segments (comments) are shortened to 511 characters.
Memos which are assigned to the whole project are imported as free memos.
Coded text segments in PDF files are imported as coded image segments.
Document groupings are only imported with restrictions: The REFI format does not support
document groups, but works only with sets. A document can belong to several sets. MAXQDA
adopts the sets as document groups and assigns each document to only one document
group.
Document group classifcations are not imported
NVivo case variables are not imported
Audio and video files are copied to the external files folder and have an empty transcript. Any
existing associated transcripts are imported as separate document.
REFI-QDA Project files exported from Dedoose must not be password protected.

Export a „REFI-QDA Project“

To save the opened MAXQDA project in the REFI-QDA-Project format with the file extension .qdpx,
click on Save Project As in the Home menu and select "REFI-QDA Project" as the file format.

Important notes for exporting:

The export includes text documents, PDF documents, images, audio, and video.
Text documents are exported as plain text.
PDF text codings are not exported
Transcripts with linked media files are not exported (remove linked media before exporting
and manually transfer and re-link media files)
Focus group speaker codes and their segments are not exported. Paraphrase codes and their
segments are not exported. Emoticode codes and their segments are not exported.
The project memo, all code set and document set memos are exported as „free“ notes.
Document variables are exported as case variables.
Document subgroups are exported as top-level document groups of equal rank as their parent
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groups.

The QDPX file that is created during the export contains all documents of the project including
externally saved files as well as linked audio and video files. The export process may therefore take
a while and the resulting file can be quite large.

 

Archiving for Data Reuse
To enable the reuse and sharing of research data, MAXQDA allows you to easily generate a back-up
of the data of a project with one click, via the Archive Data function. A clear and easy to understand
folder and file structure is created containing all collected data, optionally as a compressed ZIP file.
The intention behind the Archive Data function is to make the data collected in research projects and
the related metadata available to the scientific community and other interested members of the
public in a simple data format that can be easily viewed and does not require training or the
purchase of specialized software. The data is therefore available in standard formats such as DOCX
(Word), PDF, XLSX (Excel) and MP4 (video).

When archiving the data associated with a MAXQDA project, the data is always exported in the form
of documents (interview transcripts, field notes, PDF documents, focus group transcripts, etc.), the
structure of the project's document groups being adopted as the folder structure. Optionally, the
following data can also be exported:

Statistical data (document variables with standardized information)
Media data (audio and video files attached to documents)
Metadata (memos from the "Document System", which usually contain information and
documentation on the project and the data collected)
Overview of themes (the code system including code memos)

Starting the data archival process

To archive the data of your open project, choose the Archive Data entry in the Home tab. The
following option dialog window will appear:
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Archiving project data for reuse: Options dialog window

At the top, select which data (in addition to documents) you want to export:

Statistical data (variables) – Integrates document variables into the exported archive.

Media data (audio and video files) – Integrates not only the transcripts, but also the associated
audio and video files in the exported archive.

Meta data (memos in “Document System“) – Integrates memos assigned to documents and
document groups as well as document sets into the exported archive. The project memo, at the top
of the "Document System", is also exported.

Themes (code system) – Integrates your code system into the exported archive.

There are two more options in the lower section:

Only activated documents – Restricts the export to the currently activated documents.

Compress to single file (ZIP) – If this option is selected, the archive is not stored in a single folder,
but in a single compressed ZIP file, using the folder structure described below.

Click OK and you will be given the option to select a folder in which the archive should be stored.

MAXQDA then exports all selected data according to the following system:

In the Documents folder, all or only the activated documents (if so selected) are saved in their
respective format. The structure of the subfolders corresponds to the project's document
groups. Text documents are exported in DOCX format, table documents in XLSX format and
image documents in their respective original format.
The Statistical data folder stores the data table and the "List of Variables", both in Excel and
SPSS format. Of the system variables, only the document group and the document name are
exported.
Audio and video files associated with the documents are stored in the Media data folder, also
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in their "Document System" structure. The media file is given the name of the document to
which it is attached.
Information on the collected data is stored in the Meta data folder. These are the following
memos from MAXQDA: the project memo that is attached to the root folder in the "Document
System" and the memos attached to document groups and documents. Only the memo texts
and memo titles are exported, but no further information about the memos. The memos are
also stored in the structure given by the "Document System": the project memo and the
document group memos at the top level, then the document memos in their respective
folders. If there are no memos in a document group, a subfolder is not created.
The code system is saved as an Excel file named as “Themes.xlsx”, including the text of the
code memos, at the top folder level.
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29 – Teamwork

How Does MAXQDA Support Teamwork?
Please note: Are you using MAXQDA TeamCloud? In this case, the features described in this chapter
are not relevant to you (or the features are not available to you when using TeamCloud). For more
information on using TeamCloud and its requirements, please refer to this chapter.

In the context of scientific research, data analysis is often a collective, rather than individual
endeavor. This raises the question how MAXQDA allows for teamwork.

Please note: Please make sure to use the same MAXQDA version for successful teamwork.

Basically, the following must be considered:

Only one person at a time can work with a MAXQDA project file. This means that several
people cannot work on the same project file at the same time.
However, several people can work on their own project files simultaneously, and the files can
be integrated into a single MAXQDA project file at any time.

In order to integrate the work and data from different MAXQDA project files into one project file, the
following two MAXQDA functions are available, depending on the initial situation and the goal:

Function 1: Export/Import Teamwork

Typical scenario: Different team members have worked on the same documents in their projects.
Now, they want to copy the codings, memos, and other analytical components on a document-by-
document basis from one project into the other. This could be necessary, because the members
have applied different codes to the same documents. In this scenario, the documents already exist
in the target project.

The "Export/Import Teamwork" function operates at the document level, meaning that only elements
directly related to a document (codings, assigned codes, memos, paraphrases, summaries, etc.) are
transferred. Elements that are not specific to individual documents (free memos, concept maps in
MAXMaps, summary tables, QTT worksheets, etc.) are ignored when using this function.

Learn more about Export/Import Teamwork

Function 2: Merge Projects

Typical scenario: Documents, free memos, concept maps, QTT worksheets, and Summary Tables
are only available in one project and need to be added to another project.

https://www.maxqda.com/help-mx24/teamcloud/welcome
https://www.maxqda.com/help-mx24/teamcloud/welcome
https://www.maxqda.com/help-mx24/teamwork/transferring-coded-segments-memos-variables-etc-from-one-project-to-another
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The Merge Projects function copies all elements from one project to another. The function works
document-independent, that is, even if the same document exists in both projects, the codings,
memos, etc. in this document will not be merged. If you want to add the codings, memos, etc. to an
already existing document, please use the previously described function 1: Teamwork
Export/Import.

Learn more about Merge Projects

 

Guide: Working in Teams with MAXQDA

This guide combines the organizational, technical and - as far as necessary for understanding -
methodological aspects of teamwork in qualitative research projects into a practical manual. In this

https://www.maxqda.com/help-mx24/teamwork/merging-two-maxqda-projects
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guide, teamwork is understood not only as the joint analysis of data but as analysis based on the
division of labor.

In addition to the two functions for integrating data from multiple projects into one MAXQDA project,
there are other teamwork options and functions available to you:
Handing over a complete MAXQDA project to another team member

Different people work with the same master version of a project file. They perform coding, writing
memos, text retrievals, and other kinds of analysis with this master project. But, they do not work
simultaneously on the master version. The MAXQDA project is therefore passed from team member
to team member, each time for further processing.

Learn more about Handing Over a MAXQDA Project

User Access Management

MAXQDA allows you to assign rights for individual users. For example, you can set it up such that
others cannot make changes to text documents to ensure that everyone is always working with the

Learn more about User Access Management

Copy Codings, Memos, Variables, etc.
Into Another Project
Are you using MAXQDA TeamCloud? This function is already integrated into the TeamCloud
workflow and is therefore not available while working with team projects.

Quite often, teamwork starts as follows: researchers work on the same data parallel to one another -
each on their own project file on their own computer. One person only assigns selected codes to the
data, for example, the other only processes selected documents. Both use already-existing codes
and add new codes, create variables, and write new memos or summaries. In these cases, MAXQDA
allows you to transfer the codes, coded segments, memos, paraphrases, summaries, and variables
from one project file to another.

Of course, this teamwork presupposes that everyone is working with the same data. To make sure
this is the case, it is best to import the existing data (e.g. documents, variables, interview notes as
memos etc.) into a MAXQDA project file on one computer and then distribute the project file to all
team members. Of course, it often makes sense to define already fixed categories as codes in the
“Code System”.

Let's look at a simple example: Two people divide their work, with one person applying code A and
the second person applying code B. Both persons have also added their own code C and D. Then, in
principle, we are dealing with the following situation (the procedure is basically identical when
working with several people or dividing the work by document):

https://www.maxqda.com/help-mx24/teamwork/transferring-a-maxqda-project-to-other-team-members
https://www.maxqda.com/help-mx24/teamwork/user-access-management
https://www.maxqda.com/help-mx24/teamcloud/welcome
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MAXQDA Project of Person 1
Documents
• Interview 1
• Interview 2
• Interview 3
Codes
• Code A (codings of person 1)
• Code B
• Code C (added and used by person 1)

MAXQDA Project of Person 2
Documents
• Interview 1 
• Interview 2
• Interview 3
Codes
• Code A
• Code B (codings of person 2)
• Code D (added and used by person 2)

How does the transfer process work?

Suppose colleague 1 works on computer 1 and has coded “Interview 1” and also added some
memos. How can you now make the results of this work accessible to colleague 2 on computer 2,
especially if colleague 1 on computer 1 redefined some codes during their work and colleague 2 also
continued working on the project file separately?

This it how it works in MAXQDA: colleague 1 exports all the relevant information to be transferred
from their project file into a MAXQDA exchange file with the extension “MEX22” and sends this file
to colleague 2. Colleague 2 then imports that information into their own project file. The abbreviation
MEX stands for MAXQDA EXchange format.

Teamwork export and import procedure

What elements does the MEX file contain?

The MEX file contains only document-related elements from the source project. For all selected
documents during export, the following elements are included:

Codings,
Document memos as well as memos in documents and media files,
document variables and variable values, also for focus group documents and focus group
participants,
paraphrases,
summaries,
as well as additionally all codes selected during export.

The MEX file does not contain any of the following items from the source project:

Free memos, memos to document groups and document sets, project memo, logbook,
code variables, code sets,
document sets,
QTT worksheets,
Summary tables,
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concept maps from MAXMaps,
internal links between documents or memos, geolinks, external links.

Please note: It does not work to copy data from a MAXQDA 24 project to a MAXQDA 2022 project
using the procedure described on this page. If you work in a team, all team members need to work
with the same program version and first convert all projects from 2022 to 24 on one computer.
Export Teamwork: Saving data to an exchange file

To start the export process, select Teamwork > Teamwork Export: Export Data to Exchange File in
the Home tab.

Start Teamwork Export

A dialog box will then appear in which you can select the following options a step at a time.

First select the documents whose data you want to export. After clicking on Next >>, a dialog box for
the code selection will appear. At the bottom, you will see how many codes are currently selected
and how many coded segments occur in the previously selected documents.

Select documents (left), select codes (right)

https://www.maxqda.com/help-mx24/how-to-upgrade-to-maxqda24
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Clicking Next >> will allow you to assign a file name and to select a storage location. MAXQDA will
then export all the data (codes, code assignments, memos, variables, summaries, paraphrases etc.)
of the selected documents into the export file.

Import Teamwork: Reading the the exchange file into the target project

You can import the data from the Exchange file into any MAXQDA project, typically one that already
contains the same documents.

Select Teamwork > Teamwork Import: Import Data from Exchange File in the Home tab. A dialog
box will appear that guides you through the import process a step at a time:

First select a MEX file. MAXQDA will analyze the file and then display the following:1.

Teamwork: Import data

In this dialog box, you have to check the correspondence between the source and target
documents. If the documents in the MAXQDA projects have the same name, all you have to
do is double check the automatic allocations made by MAXQDA. Otherwise, you have to
allocate each text to the appropriate matching text yourself. If the document does not yet
exist in the project, you can select the option to import the document from the exchange file.
You can deselect a document in the first column if necessary – it will then be ignored during
the import process.
If the document does not yet exist in the project, you can select the <New Document> option
to import the document from the exchange file.
You can deselect a document in the first column if necessary - it will then be ignored during
the import process.
When you click Next >>, the following dialog box will appear for the code selection. You can2.
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recognize new codes that do not yet exist in the target project by the green font in the
displayed list of codes.

Select codes

In the third step, select the data you want to import. MAXQDA only displays the data types in3.
the dialog box that are contained in the MEX file. You can deselect individual elements, such
as variables or paraphrases, to ignore them during the import process. The other options
determine how conflicts during import are to be dealt with - these are described in more detail
below.

Options for the teamwork import
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Click Import to start the import process.4.

Please note: Before MAXQDA starts the teamwork import process, a backup of your opened
project's status is automatically saved to your backup folder.
Handling of conflicting code assignments

When importing the coded segments, it may happen that the same code has already been assigned
to the corresponding segment in the target project. This segment may also have other segment
boundaries than the coded segment you want to import. Since the rule in MAXQDA is that a segment
in a document can only be coded once with the same code, you can use the drop-down menu to
specify which segment boundaries should “win” during import process:

Overwrite existing segment boundaries with imported ones – This is the default selection: in
the case of a conflicting code assignment, the segment boundaries of the imported coded
assignment override those in the opened project file.
Preserve existing segment boundaries – In the event of a conflict, the existing coded
assignment "wins", i.e. no changes are made to the segment boundaries.
Use outer segment boundaries of the code assignments – In cases of conflict, the outermost
segment boundaries of the two code assignments are used.
Use inner overlapping area of code assignments – In cases of conflict, only the overlapping
area of the two code assignments is taken as the coded segment.

Each code assignment in MAXQDA also includes a comment and a weight. In the event of a conflict,
you can instruct MAXQDA whether the existing comments and weights should be retained or
overwritten by the imported ones:

Overwrite existing comments with imported comments – When this option is activated, the
comment of the imported coded segment always "wins", that is, it overrides the comment in
the opened project file. If the imported coded segment has no comment, this is ignored, i.e.
an existing comment is never overwritten by an empty comment.
Overwrite existing weights with imported weights – If this option is enabled, the weight of
the imported coded segment always "wins".

When importing summaries, you can also control how MAXQDA should proceed if a summary
already exists for a document in a code:

Do not change existing summaries – With this setting, only those summaries are imported
that were empty in the project file. In case of a conflict, the imported summaries are ignored
and not imported.
Overwrite existing summaries with imported summaries – With this setting, in the event of a
conflict, the summaries already existing in the project are deleted and overwritten by the
imported ones.
Add imported summaries to existing ones – In case of a conflict, the imported summaries
are added to the existing summaries.

What exactly happens during the import process?

Code assignments:

All code assignments already present in the document are retained or adapted depending on
the option selected.

https://www.maxqda.com/help-mx24/summary-grid/idea-behind-summary-grid
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Previously non-existing code assignments are inserted into the opened project.
If a coded segment with a code not yet contained in the “Code System” is found in the
exchange file, this code is inserted into the “Code System” at the corresponding position.
Codes with the same name at the same hierarchy position are considered identical, but their
color is irrelevant.

Memos:

All in-document memos are imported (exception: memos at the same location with the same
title).
Document memos in the "Document System" are only imported if there is no memo in the
document yet. Existing document memos remain unaffected.
Code memos are dealt with in the same way.

Paraphrases:

A paraphrase to be imported is ignored if a paraphrase already exists at the same location in
the current project.

Variables:

Variables that do not yet exist in the list of variables are added and their values are imported.
Existing variables are overwritten with the value from the import file.

Start teamwork export/import in the "Document System" window

You can also start the export for a document, document group, or document set directly in the
"Document System" window. To do this, right-click an entry and select Teamwork > Teamwork
Export: Export Data to Exchange File from the context menu.

In the image, you can see that you can open the complementary function Import Teamwork for a
document, a document group, or a document set directly in the "Document System" context menu,
too.

Hand over a MAXQDA Project to Other
Team Members
If you do not need to make changes to a MAXQDA project at the same time, you can of course take
turns working on the project in a team by passing the MAXQDA project file from person to person. In
this form of collaborative teamwork, the entire study is transferred as a MAXQDA project from one
computer to another, ensuring that all team members are always working from the same database.
Two people can never simultaneously code different documents of the study or create memos on
different computers. However, all evaluation work in which no new codings are made, no new
memos are written and no variable values are changed, are of course possible without any problems
simultaneously.



  752

The transfer of MAXQDA projects is very easy: MAXQDA saves all aspects of the project in a MX24
file. If you name a project “Interview Study” it will be saved on your computer as “Interview
Study.mx24.”

The project file contains all … The project file does not contain …

• Documents
• Codes
• Memos
• Variables
• Coded segments
• Summaries and Summary Tables
• QTT worksheets
• Internal links
• Text links
• External links
• Geo links
• Concept maps created in MAXMaps
(without externally saved images)
• Similarity and Distance matrices
• Project-based dicitonaries and
stop/go word lists of MAXDictio

• External documents (e.g. PDF files, images, audio and
video files)
• Externally saved geographical references (KML files)
• Saved search formulas (SEA files = search files)
• Saved selections for logical activations and other  mixed
methods functions (LOA files = LOgical Activation files)
• Saved Code Systems in MTR format

The project file can be transferred to other team members in the form of a single file. It can also be
sent by email. It can also be saved in the shared folder of a cloud system, such as Dropbox or
OneDrive.

If you open the MX24 project file on any other computer on which MAXQDA 24 is installed, you will
see the entire project with all of its components.

If you want to set up the project, so that various members of the team can work on it at the same
time, it is recommended that you start by importing all documents into a MAXQDA project on one
computer, and then sending a copy of that file to everyone in the team. This saves you the work of
importing the files on each individual’s computer and guarantees that everyone will have the exact
same data set.

Sharing projects that include external files

If you have assigned audio or video files to documents in your project, or if image or PDF documents
were not imported into the project, they are stored in the MAXQDA folder for external files (you can
customize this folder in MAXQDA's preferences via the gear symbol at the top right edge of the
window).

How to exchange all files of a project between teammates including the externally stored files is
described in detail in the section External Files on the subheading "How to transfer external files
from one computer to another?".

https://www.maxqda.com/help-mx24/import/external-files
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Merge Two MAXQDA Projects
Are you using MAXQDA TeamCloud? This function is already integrated into the TeamCloud
workflow and is therefore not available while working with team projects.

The “Merge projects” function causes all elements of a second project to be added to a project you
currently have open.

This is useful, for example, when several people import different data into their MAXQDA project
files or transcribe different interviews and then the projects are to be merged into one that contains
all documents from all projects. The function can also be used if one project contains document-
independent elements such as free memos, concept maps, QTT worksheets, and Summary Tables
that are to be copied into another project.

Please note: If the same document exists in the two projects, the codings, memos, etc. in that
document will not be merged. If you want to add the code assignments, memos, etc. to a document
that already exists in the target project, please use the Teamwork Export/Import function.

Merge projects:

1. Open one of the two projects you want to merge.

2. In the Home tab, choose Merge Projects.

3. Select the second project from the file dialog window, which will be in the form of an MX24 file.

The following dialog window will appear:

Options for merging projects

Because a MAXQDA project can contain only one project memo, one memo per code, and one
Logbook, you can choose, in the top section, what content should be kept and what should be
overwritten. When the default settings are left as is, the existing data in the already opened project
will remain unchanged.

In the bottom section, two options are available that allow you to determine how MAXQDA should

https://www.maxqda.com/help-mx24-teamcloud/start
https://www.maxqda.com/help-mx24/teamwork/transferring-coded-segments-memos-variables-etc-from-one-project-to-another
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handle documents whose identical name already exists in the project:

Don’t import already existing documents – When this option is deselected, all documents
from the imported project are inserted into the open project, regardless of whether they
already exist in the project. When you select this option, already existing documents will be
ignored, thus not imported.
Merge document groups / document sets with same name – Choosing this option, no further
document groups and sets with the same name will be created, and the imported documents
will be integrated into already existing document groups and sets.

When you click OK, MAXQDA then starts the merging process, which may take some time,
depending on the size of the two projects.

Please note: Before merging the projects, MAXQDA automatically creates a backup of the current
project in the selected backup folder. The merge process cannot be undone using the global undo
feature.

What happens during merge process?

Document groups of the imported project will be added with their documents, possibly
generating duplicates. If a document group entitled “Interviews” exists in both projects, the
resulting merged project will have two groups of this name. The options above can be set so
that already existing documents are ignored and so that no duplicate document groups and
sets are created.
Document sets are added. If the above mentioned option is selected, sets with the same
name will be merged and only sets whose name does not yet exist will be added.
Memos will be inserted. A code memo from the import project is ignored if a memo already
exists for the code – unless you select in the options dialog that the imported code memo
should overwrite the existing one. The same applies to the project memo attached to the root
of the “Document System”.
Code assignments will be added.
If a code or subcode of the imported project does not exist, it will be created. Codes with the
same name and same hierarchy position will be considered identical; their color and their
order on the same hierarchy level is not relevant.
Code sets will be added, no matter if a set with the same name exists.
Summaries will be added.
Summary Tables will be added. If a Summary Table with the same name exists, the imported
table will be ignored.
Internal and external links within documents will be imported, as long as their start and
target is located within one of the imported documents. Internal links within memos are
ignored.
Maps in MAXMaps will be added. If a map with the same name exists, the imported map will
be ignored.
Worksheets from Questions, Themes & Theories are added. If a QTT worksheet with the
same name exists, its name is appended with a sequential number.
Each variable will be analyzed to determine if it already exists in the project.
- If the variable does not exist, a variable of that name will be created. The variable values of
the documents in the open project will be set to 0 or to the preset missing value for numerical
variables, or set to empty for text variables.
- If a variable exists with another type declaration, it will be created. Suppose the open file
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contains the text variable “marital status” and the file to be added contains a numerical
variable with the same name. After the merge process, two variables entitled “marital status”
will exist.

User Access Management
Are you using MAXQDA TeamCloud? Please note that this feature is not available while working with
team projects.

MAXQDA supports teams working on projects with an optional user management system, in which
you can set different rights for different groups of users.

Please note: The admin system is not designed for data security, but for team collaboration with
different user roles. It will not encrypt the data.

To activate the user management system, select Home > Teamwork > Activate User Management
from the ribbon menu.

Activating user management

You will automatically become administrator of the project with your username and MAXQDA will
prompt you to set a password for this username.

Set admin password

https://www.maxqda.com/help-mx24/teamcloud/welcome
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Caution: Note your password carefully! Without this password, the MAXQDA project can no longer
be opened.

The next time the project is opened, a login window will appear and you'll be prompted for a valid
username and password.

In the default configuration, only administrators are able to open the user management, add users,
or change rights.

The User Management window

In the main user management window, you can create new users, remove existing users, and define
the rights of individual user groups.

Main user management window

On the left side of the user management window, the various levels (Admin and Levels 1-3) are
displayed. The right side of the window contains information about each user, which can be created
or edited here; it is also here that users can be assigned to one of four user groups.

Adding a new user

Click on the Add user  button to add a new user. The new user settings can subsequently be
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edited:

User: Here you can set the username (= Login name), with which the user can log into the project.

Group: Here you can set the level within the hierarchy to which the user is assigned.

Name: Here you can enter the user's real name.

Comments: In this field, you can post comments regarding the user.

The properties of a user can be modified at any time by clicking on the username in the left side of
the window.

Deleting users

To delete a user, select the username in the left side of the window and click the Delete user
button. You will be required to confirm your selection.

User passwords

User passwords can be managed in two ways. If no password has been set by an admin, each user
must first log in and set his own password. Alternatively, the administrator can set an initial
password and communicate it to the other users. In order to set the initial password, click the Set
initial password button. The users can then access the MAXQDA project with this password, and set
their own passwords upon first use. Only the user will know this new password. If a user forgets his
password, the administrator can reset it by clicking the Reset user password button. The
administrator can also reset the initial password in this way.

Initial password

The purpose of the initial password is to act as a barrier to entry into the project. New users must
enter this password the first time they log into a locked MAXQDA project, before setting their
personal passwords.

Hierarchical levels

When you click on a particular level in the left side of the window, the rights of the users at this level
will be displayed on the right side of the window. Aside from the Admin Level, users can be placed in
three different groups, from Level 1 to Level 3. In a research project, the levels can be established,
for example, in the following way:

Level 1: Project leaders
Level 2: Research associates, who can import and delete texts, work with the “Code System,”
and write, edit and delete memos
Level 3: Student associates, who work primarily on the coding of material

The following image displays the default Level 1 functions. For example, the top three functions are
reserved by default for the Admin Level. User rights can be modified at any time by clicking on the
red or green icon in front each program function. Any number of users can be assigned to each level,
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including the Admin Level. At least one administrator must be defined in any case, meaning the last
entry in this list cannot be deleted.

Define user rights for various levels of the hierarchy

Modifying user settings

Click on a username in the left side of the window in order to modify settings in the right side.

Importing and Exporting the Entire Admin System

It is possible to export the entire Admin System of a MAXQDA project, including usernames,
passwords and user rights. Click on the Export icon on the lower edge of the main window. The data
will be saved in MXUSR format, which is, of course, encrypted. This file can be imported into another
MAXQDA project by clicking on the Import icon, thus saving the administrator a lot of time.

Deactivating the User Management system

It is possible to deactivate user management at any tim by opening the User Management window
via Home > User Management > Deactivate User Management and checking the corresponding box
at the lower edge of the window, then closing the window.
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Option “Deactivate user management”

All usernames and passwords will be saved in the project, so it is possible to reactivate the user
management at any time.
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30 – TeamCloud

What is MAXQDA TeamCloud?
The MAXQDA TeamCloud enables you to work as a team on the same data using cycle-based team
collaboration.

The workflow is quite simple: The team lead starts a project cycle and uploads the team project to
the TeamCloud. All team members join the TeamCloud project, download the project file from within
MAXQDA, work on it (online or offline), and upload their work once they are finished. The team lead
is notified of any new uploads and can import the team members’ projects into the main project. The
work on a team project may last one cycle, or it can go through several cycles.

Cycle-based team collaboration

The following illustration shows a typical TeamCloud workflow from start to finish. The red boxes
represent the steps that may be repeated as often as needed.

The project cycle process at a glance

Learn more
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Quick start: TeamCloud Getting Started Guide

This getting started guide offers a short step by step explanation on how you can use MAXQDA
TeamCloud for your teamwork.

Guide: Collaborative Data Analysis using MAXQDA TeamCloud

This MAXQDA Press guide combines the organizational, technical and - as far as necessary for
understanding - methodological aspects of teamwork in qualitative research projects into a practical

https://www.maxqda.com/wp/wp-content/uploads/sites/2/TeamCloud_Getting_Started_EN_MQ24.pdf
https://www.maxqda-press.com/catalog/guides/collaborative-data-analysis-using-maxqda-teamcloud
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manual. In this guide, teamwork is understood not only as the joint analysis of data but as analysis
based on the division of labor.

Requirements & License Management
TeamCloud License

A TeamCloud license is required to become a Team Lead. Team Members do not need a
TeamCloud license. They only need a MAXQDA license and a free MAXQDA account.
New customers can purchase a TeamCloud license as an add-on in combination with a
MAXQDA subscription license in the MAXQDA Online Shop.
Existing customers with a MAXQDA subscription license can add a TeamCloud license to
their subscription in the Subscription Manager.
TeamCloud is supported by MAXQDA 24 single-user and network licenses:

TeamCloud is supported TeamCloud is not supported

• Single user license
• Network license

• Demo license
• Student license
• Teaching/Course license
• MAXQDA Reader license

TeamCloud License

In order to become a TeamLead who can create TeamCloud projects and invite other users, please
activate your TeamCloud license in the "License" section of the MAXQDA Account webpage. You
can find your TeamCloud license in your delivery email.

Activating the TeamCloud license in the settings on the MAXQDA TeamCloud website

After the license is activated, you will see your license details: license duration, serial number,
currently used storage space, and team seats. All projects created by the Team Lead account

https://teamcloud.maxqda.com/register
https://www.maxqda.com/shop/order
https://mya.maxqda.com/
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conneted to this license adds up to the occupied storage space and seats.

Details about the MAXQDA TeamCloud license in the team lead's settings

Transfer TeamCloud License

A team lead can transfer their TeamCloud license to another MAXQDA account via the Transfer
License link. This account will then become the new owner of the license and the team lead of all
projects associated with the TeamCloud license.The role of the previous team lead switches to team
member.

Before transfering your TeamCloud license to another user, we suggest preparing the project in the
following way:

Import all pending teamwork data into the project1.
Start a new cycle and upload the project for your team2.
Now transfer your TeamCloud license to another user. This account becomes the new team3.
lead for all projects.
Your role switches to team member. You are free to continue as a team member or leave the4.
project.
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Log into TeamCloud from within
MAXQDA
To work with TeamCloud projects in MAXQDA, you need to log in to MAXQDA with your MAXQDA
account.

Log into your MAXQDA account in MAXQDA

In order to download or upload data to the TeamCloud, you need to log into your MAXQDA account
in MAXQDA. You can work on a TeamCloud project while being offline.

You can find the sign in options in these locations within MAXQDA:

in the MAXQDA welcome screen in the Team Projects tab
in the TeamCloud ribbon menu

Sign in dialog in the MAXQDA welcome screen for logging in into MAXQDA TeamCloud

Online status always visible

In the MAXQDA start window as well as in the open TeamCloud project in the TeamCloud tab, your
current online status appears in the lower right corner of your avatar:

Green circle with check mark: You are logged in to TeamCloud and online.
Red circle with cross: You are working offline.

https://www.maxqda.com/help-mx24/teamcloud/the-teamcloud-license
https://www.maxqda.com/help-mx24/teamcloud/the-teamcloud-license
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Log into MAXQDA account online

Log into your MAXQDA account online in order to interact with your TeamCloud settings, account,
and license: https://teamcloud.maxqda.com.

Account Settings

You can access the settings by clicking on your avatar in the upper right corner and selecting the
Settings menu item.

Contact Information

In this section you can change your name or email address, and modify your avatar image

TeamCloud E-Mail Preferences

If you are a Team Lead you can activate this option if you want to receive project-related emails for
your TeamCloud projects. You will be notified if a member joins or leaves a project, and each time a
team member uploads data that can be imported.

Password Management

Click Change Password to replace your current password with a new one. You will receive an email
with a confirmation code in your inbox. Enter the confirmation code and the new password in the
corresponding fields and click Change Password.

Delete Account

If you no longer want to use your MAXQDA account, you can delete it in this section.

 

Project Roles & Permissions
MAXQDA TeamCloud distinguishes between two predefined roles: team lead and team member.
Each project has 1 team lead and 1-4 team members.

The roles are project-related in each case: The team leader of a project can also be a team member
in other projects; conversely, a team member of one project can simultaneously be the team leader
of another project.

The roles and their permissions at a glance

Team lead

this role requires an active TeamCloud license,
can create a new TeamCloud project,
can invite team members to a project,

https://teamcloud.maxqda.com
https://www.maxqda.com/help-mx24/teamcloud/the-teamcloud-license
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can edit all documents,
can import the work of the team members into the main project,
can start a new project cycle,
can end a project.

Team member

this role does not require a TeamCloud license,
can join projects they are invited to,
can download projects and open them in MAXQDA,
cannot edit existing documents,
can add new documents and edit them until the next upload,
can upload their work so that the team lead my import their work into the main project.

The project cycle in detail

TeamCloud Storage
To share your project files, you use the secure MAXQDA TeamCloud environment. However, you
perform the work and analysis within your project locally. This ensures that you can continue
working with MAXQDA in your TeamCloud project offline at any time.

Local copies of your TeamCloud projects are stored in a separate storage location. By default, it is
located in the following directory:

Windows: %appdata%\MAXQDA2024\TeamCloudWorkspace
Mac: /Users/Username/Library/Application Support/MAXQDA2024/TeamCloudWorkspace

You have the option to change the location for your TeamCloud projects and select a different local
folder for the TeamCloud storage (you can read below in the notes box why it has to be a local
folder).

To do so, proceed as follows:

In MAXQDA, switch to the TeamCloud tab.1.
Select Account > Preferences.2.
In the Folder for TeamCloud projects field, define a local folder for your TeamCloud storage.3.

After you have confirmed the new location, MAXQDA moves the TeamCloud workspace to the new
folder and copies all existing TeamCloud projects to the new location.

Important note about saving MAXQDA projects: As MAXQDA is a database program, all changes are
always saved directly in the project file. For this reason, it is very important that the computer's
connection to the project file is not interrupted, otherwise there may be problems with the project
file.
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To avoid data loss, we therefore strongly recommend that you do not select one of the following
locations for the TeamCloud storage folder:

USB drives
network drives
external hard disks
folders synchronized with cloud services (Dropbox, Google Drive, iCloud, etc.).

Best Practice – Things to know for
optimal teamwork
MAXQDA's TeamCloud makes collaboration much easier for you. To ensure that your work with
TeamCloud runs smoothly, we have provided a few tips for you here:

Teamwork requires rules for collaboration: Who may, should, and can perform which
analyses? How should uncertain codings be marked? Which memo symbols should be used
for which kinds of memos? What color do newly added codes get? etc.
Split documents and/or codes among the team members to avoid conflicts when importing
the team members' projects into the main project.
Coordinate well within the project team:

Team members: After having uploaded their data for the team lead, team members
wait until the team lead has started a new cycle before they continue working on the
project.
Team lead: Before starting a new cycle, the team lead makes sure that all team
members have uploaded their pending data and that everything has been imported into
the main project.

To prevent data loss, make sure that your TeamCloud workspace is located in a local folder.
Work from one computer only during a teamwork cycle.
If a team member wants to change computers, the team lead should first start a new
teamwork cycle for everyone. Then the team member can start working on the new cycle on
the new computer.
If you are the team lead and want to change computers, start the teamwork cycle on the old
computer and then go directly to the new computer without making any changes to the
TeamCloud project on the old computer.
Assign meaningful names to your Free Memos, QTT Worksheets, Summary Tables, Concept
Maps in MAXMaps, etc. to avoid naming conflicts.

The TeamCloud website

https://www.maxqda.com/help-mx24-teamcloud/start/teamcloud-workspace-and-storage
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Backup
Whether you are working on a project in a team or alone: Copies of the project files should be
created and archived regularly.

On the one hand, the copies serve the purpose of transparency, as they represent snapshots at
different points in time, via which the progress of the project can be traced. On the other hand, the
copies serve as data backups. They can be reverted to, for example, if an unintentional change can
no longer be automatically undone, e.g. because MAXQDA has been closed in the meantime.

Automatic backup of project data

Automatic backups in defined time interval

If you have activated automatic project backups in the global MAXQDA preferences, these settings
also apply to your TeamCloud projects. This means that MAXQDA creates a backup in the local
TeamCloud workspace in the defined time interval when opening a TeamCloud project.

Action based automatic backups

In addition to the periodic backups, other additional backups are created for TeamCloud projects as
soon as you perform certain actions. The backups are stored in the TeamCloud Workspace backup
folder for the current project cycle.

The following actions trigger the automatic creation of a backup, with the current state of the project
being saved before the selected action is performed:

Team lead: Start of a new project cycle
Team member: Downloading the new project file after a new project cycle was started
(applies to download from the MAXQDA welcome screen, from the TeamCloud ribbon, or
from the notification about the start of a new cycle within the open project)
All: Before opening a backup from the current project cycle

Manual backup of project data

We recommend creating a backup immediately before or after major changes in the project - e.g. a
far-reaching revision of the code system.

To create manual backups of your TeamCloud project, you need to be logged into TeamCloud.

Backup of the TeamCloud project

In the TeamCloud ribbon click Backups > Create Backup.1.
Specify a meaningful name for your backup and click OK.2.

Export as local project

To save a manual backup of your TeamCloud project outside the cloud, export it as a local project.
This will create a "standard" MAXQDA2022 project file with the file extension .mx22, which can be
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opened with any MAXQDA2022 installation. You can find the option to do this either in the MAXQDA
welcome screen or in the open project in the TeamCloud ribbon.

MAXQDA welcome screen:

Select the Team Projects tab.1.
Hover with your mouse over the name of the desired project and then click on the More menu2.
(three dots).
Click Export as Local Project.3.
Select a saving location for the project you want to export and click OK.4.

Open TeamCloud project:

In the TeamCloud ribbon click Export as Local Project.1.
Select a saving location for the project you want to export and click OK.2.

Open backups

If necessary, you can open an automatically or manually created backup file of your TeamCloud
project to return to a previous version. Note, however, that this is only possible for backups created
during the current project cycle.

In the TeamCloud ribbon, click Backups > Open Backup.1.
Select the backup file you want to open from the list.2.
Click Open backup.3.

MAXQDA automatically creates an additional backup of the current project status before the
selected backup file is opened.

Manual backup of the logbook

The project logbook of a TeamCloud project is stored online on the cloud server (in contrast to local
projects where the logbook is stored locally). Therefore, it can only be viewed on the MAXQDA
TeamCloud website and can only be exported and saved from there.

On the TeamCloud website, from the dashboard, navigate to the desired project and open the1.
Project Logbook tab.
Use the Print function of your browser by right-clicking on the page or by selecting the2.
particular print command in the browser's application menu.
Save the web page as PDF.3.

This way, along with the logbook, you also save the Recent Activity history of your TeamCloud
project.

Hint: If you use Google Chrome with the browser extension MAXQDA Web Collector, you can save
the logbook as entire web page.

https://www.maxqda.com/help-mx24/import/save-web-page-web-collector
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Glossary
Cloud
space/storage

Storage space in the MAXQDA TeamCloud

Cycle Working loop of a TeamCloud project. One cycle = team lead shares the
project - members download it, work locally in MAXQDA and upload their
project copy back to the cloud - team lead imports teamwork files into the
main project. Afterwards, the team lead decides whether to end the project or
start another cycle.

Dashboard Overview of all TeamCloud projects for which you are a team lead or team
member (landing page after logging in to the MAXQDA TeamCloud website)

Import log Is automatically created as a free memo when team lead imports team
members' project data into the main project.

Local cloud
storage

The location for local project copies of TeamCloud projects. Default folder:
Windows: %appdata%\MAXQDA2024\TeamCloudWorkspace
Mac: /Users/Username/Library/Application
Support/MAXQDA2024/TeamCloudWorkspace

Main project The locally stored project file of the team lead. Into this the import of the
uploaded project files of the individual team members takes place.

MAXQDA
account

Required to use MAXQDA TeamCloud and share projects with the team.
Registration is done via the email address. (Formerly called TeamCloud
account)

MAXQDA
TeamCloud

Module for team collaboration and interaction. Project files are shared from
within MAXQDA via a secure cloud space.

MAXQDA
TeamCloud
website

Website for managing MAXQDA account, TeamCloud projects, team
members and the project logbook.

Project invitation Email notification to team members who are invited to a TeamCloud project.
With a mouse click, they can join the project.

Project logbook Online logbook for team projects on the MAXQDA TeamCloud website for
collecting and sharing important notes, project information, ideas, or
questions.

Roles In the TeamCloud there are two defined roles: Team lead (1 person per
TeamCloud project) and team member (1-4 people).

Seats Each person in the team (team lead and team member) occupies a seat within
the TeamCloud license.

Team lead Fixed role. Team leads store the serial number of the TeamCloud license in
their MAXQDA account. They can then create and share projects in the cloud.

Team member Fixed role. Team members are invited by the team lead to the TeamCloud
project and can join it.

TeamCloud
license

License for the MAXQDA TeamCloud module (entitles to use for the specified
term, scope of purchased cloud space, and number of seats). Is bound to the
MAXQDA account of the team lead.
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TeamCloud
project

A MAXQDA project which is shared via the TeamCloud (file format *.mc24)

Upload comment
lead

The team lead can optionally add a comment for the team when starting a
new project cycle. The comment appears in the e-mail notification sent to the
team members, can be displayed from the opened MAXQDA project at any
time, and can also be viewed on the MAXQDA TeamCloud website (Project >
Files page).

Upload comment
member

Team members also have the option to add a comment when uploading the
project for the team lead. The comment appears in the email notification sent
to the team lead and can also be viewed on the MAXQDA TeamCloud website
(Project > Files page).

Switching from MAXQDA 2022 to
MAXQDA 24
If you have worked with a TeamCloud project in MAXQDA 2022 as a Team Lead and want to
continue working with it in MAXQDA 24, you can export it as a local project in MAXQDA 2022 and
start a new TeamCloud project in MAXQDA 24.

Below you'll find a detailed descriptoin of the migration process.

How to migrate a TeamCloud project from MAXQDA 2022 to MAXQDA 24

Make sure that all team members have uploaded their work from the current cycle.1.
Open the TeamCloud project in MAXQDA 2022 and import all pending files from team2.
members.
Save the TeamCloud project as a local project by selecting Export as Local Project from the3.
TeamCloud menu tab. This will create a MAXQDA 2022 project file with the extension .mx22.
Close MAXQDA 2022 and open MAXQDA 24.4.
Click Open in the welcome screen and select the previously exported file. MAXQDA will5.
convert it to a MAXQDA 24 project and create a .mx24 project file.
Navigate to the TeamCloud menu tab and select Upload Project for Team (Start Cycle 1).6.
This will create a new TeamCloud project and you can invite your team members again.

After your team members have accepted the invitation, they can open MAXQDA 24 and - after
logging in with their MAXQDA account - access the project from the MAXQDA welcome screen.

Please note:
All team members must use MAXQDA 24 in order to open the new project. It will not work that some
team members use MAXQDA 2022 and the others use MAXQDA 24.
On your MAXQDA 24 welcome screen you will only see MAXQDA 24 TeamCloud projects. This also
applies to the list of TeamCloud projects, available via the menu item TeamCloud > Open
TeamCloud Project. 
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31 – AI Assist

What is AI Assist?
AI Assist is an incredibly useful tool that offers a range of functions in MAXQDA which leverage
artificial intelligence to support your analysis work. By utilizing a sophisticated generative
large language model, AI Assist can help you to enhance your analysis process. AI Assist
automatically creates summaries of selected text or coded segments and provides suggestions for
appropriate new codes subcodes.

Currently, AI Assist offers the following features:

Summarizing uncoded data

AI Summary: Document Summary – Automatically summarizes entire documents and saves
the summary in the document memo.
AI Summary: Highlighted Text – Automatically summarizes a selected text passage and
saves the summary in an in-document memo.
AI Paraphrase – Automatically paraphrases a selected text passage and saves it as a
MAXQDA paraphrase.

Summarizing coded data

AI Summary: Coded Segment – Automatically summarizes the contents of a coded text
segment and saves the summary in the coding comment. In the Smart Coding Tool, this can
also be done for a large number of coded segments at once.
AI Summary: Code Summary – Automatically summarizes the contents of all or selected
segments that have been coded with a code. The summary is saved in the code memo.
AI Summary: Summary Grid – Automatically summarizes the text segments of a document
that have been assigned to a selected code. The result is saved as a MAXQDA summary in
the Summary Grid.

Suggesting codes and subcodes

AI New Codes Suggestions – Get an inspiring list of new codes that can be assigned directly
to a selected text passage.
AI Subcode Suggestions – Get suggestions for suitable subcodes based on the contents
captured with a code. The suggestions are saved in the associated code memo.

Automatic transcription

Automatic transcription – Automatically convert your audio or video files into a transcript with
timestamps.

Additional features

Explain this – Creates a short explanation of an unfamiliar term or paraphrase in your data.
The explanation is saved as an in-document memo.

https://www.maxqda.com/help-mx24/ai-assist/ai-summary-document-summary
https://www.maxqda.com/help-mx24/ai-assist/ai-summary-coded-segment
https://www.maxqda.com/help-mx24/ai-assist/ai-paraphrase
https://www.maxqda.com/help-mx24/ai-assist/ai-summary-coded-segment
https://www.maxqda.com/help-mx24/ai-assist/ai-summary-coded-segment
https://www.maxqda.com/help-mx24/ai-assist/ai-summarys-in-the-summary-grid
https://www.maxqda.com/help-mx24/ai-assist/ai-new-codes-suggestions
https://www.maxqda.com/help-mx24/ai-assist/ai-subcode-suggestions
https://www.maxqda.com/help-mx24/transcription-audio-video/automatic-transcription
https://www.maxqda.com/help-mx24/ai-assist/ai-explain-this
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It is important to note that AI Assist is not intended to replace manual research, but rather to
complement it. This intelligent system is designed to support and enhance human analysis work. AI
Assist does not take decisions away from you but provides a collection of tools that (like many other
tools in MAXQDA) can help improve your analysis.

Prerequisites for using AI Assist

For information about what is required to use AI Assist, please see the product page.

The technology behind AI Assist

MAXQDA uses the well-known large language model GPT 3.5, which is offered by OpenAI and has
become popular through the chatbot “ChatGPT”.

AI Summary: Document Summary
Please note: To use this feature, you need the AI Assist add-on.

Using AI Assist’s Summarize Document function, you can summarize entire documents, be it
transcripts or articles. MAXQDA allows you to adjust the output’s format depending on your needs.
For example, you can request document summaries in a language different from the one in which
the document is written.

An example of an AI-generated document summary

Here’s how to access AI Assist to summarize documents:

In the Document System, right-click on the document you’d like summarized and navigate to1.
AI Assist: Summarize Document.

https://www.maxqda.com/products/ai-assist
https://www.maxqda.com/products/ai-assist
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Summarize a document via a document's contect menu in the document system window

In the Document Browser, ensuring you’re viewing the document you’d like to summarize,2.
click on the AI Assist icon in the toolbar. Select Summarize Document from the dropdown
menu.

Summarize a document via the AI Assist icon found in the document browser toolbar

Additionally, you can access the function via the AI Assist icon within document memos.3.

Once you run the function, a dialog box will appear, where you’ll need to:

Specify the summary’s language.
Choose between three different lengths: short, standard, and long.
pt-in for a summary in bullet points.

Then, hit OK. Once AI Assist summarizes your document, it’ll save it in the document summary
section of the document’s memo. This way, MAXQDA ensures that your summaries are securely
attached to the original document, making them readily available until you delete them.

What type of summary does AI Assist generate?

It’s important to note that AI Assist creates a descriptive, sequential summary of your document,
meaning that it recaps information in the order in which it appears on the document.

Please note:

https://www.maxqda.com/help-mx24/memos/creating-document-memos-in-the-document-system
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AI Assist provides reliable results in most cases. Nevertheless, it is still essential to check the
output..
AI Assist may not generate content if you analyze texts with critical content (violence, hate
speech, bullying, etc.).
If you run the function for the same document more than once, you may get slightly varying
results.

AI Summary: Highlighted Text
Please note: To use this feature, you need the AI Assist add-on.

AI Assist lets you automatically summarize a selected passage of text in the “Document Browser.”
The summary is saved in a new in-document memo assigned to the selected text passage.

Summarizing a segment with AI Aissit

To create a summary of a selected text passage: 

Right-click the selection and select AI Assist: Summarize Text Selection from the context1.
menu.
In the dialog that appears, select the desired language, length and type for the summary. 2.

After clicking OK, the summary is automatically created and presented in a new in-document memo.
In the memo, you can customize the summary as needed.

Please note:

AI Assist provides very good results for very many use cases. Nevertheless, it is important

https://www.maxqda.com/products/ai-assist
https://www.maxqda.com/help-mx24/27-ai-assist/what-is-ai-assist-beta
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that you check the results.
If you analyze texts with critical content (violence, hate speech, bullying, etc.), summaries may
not be created.
Usually, you will receive the same or very similar summary for the same segments. However,
it may happen that a summary is different from previous ones because the generative
language model used provides dynamic results and because AI Assist is continuously
optimized.

AI Summary: Coded Segment
Please note: To use this feature, you need the AI Assist add-on.

Using AI Assist, you can automatically summarize the contents of a coded text segment. The
summary is saved in the comment of the coded segment.

Summarizing a coded segment in the Document Browser

Calling the function in the “Document Browser”

To create a summary of a coded segment in the “Document Browser:”

Right-click the vertical coding stripe or the code name next to the stripe and select AI Assist:1.
Summarize Segment (into Comment) in the context menu.
In the dialog that appears, specify the desired language for the summary. AI Assist2.
automatically detects the language of the coded segment and translates the contents into the
desired language of the summary, if necessary.
In the dialog, you can also choose the type of summary:3.
Sentences – generates short concise statements.
Topic list – lists the topics occurring in the segment’s text. Usually, the topics are separated
by commas, but sometimes bullet points are presented.

After clicking OK, the summary is automatically created and recorded in the comment of the coded

https://www.maxqda.com/products/ai-assist
https://www.maxqda.com/products/ai-assist
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segment. In the comment window, you can adjust the summary as needed. Comments created with
AI Assist start with the abbreviation “AI:.” You can remove this prefix from the comment at any time.

Please note:

If a comment already exists for the coded segment, you will be asked whether you want to
overwrite the existing comment.
AI Assist summaries to be saved in comments are limited to 255 characters. AI Assist tries to
create a summary that does not exceed this limit, but it can happen, especially with very long
coded segments, that the results are truncated. In this case, the automatically created
summary ends with three dots “...” to indicate the truncation.
It is not possible to summarize coded segments shorter than 20 and longer than 5,000
characters.

Calling the function at other places in MAXQDA

The AI Assist: Summarize Segment function is not only available in the “Document Browser,” but
also at locations in MAXQDA where coded segments are listed:

In the tabular Overview of Coded Segments, start the function by right-clicking on an
individual row.
In the “Retrieved Segments” window, start the function by right-clicking on the coding stripe.
In the Segment Matrix, start the function by right-clicking on a displayed segment; the same
applies to the Compare Codes function.
In the Smart Coding Tool, start the function by right-clicking on one or more selected
segments. In the ribbon bar of the Smart Coding tool, you will also find the function AI Assist
> Summarize Listed Text Segments (into Comments).

Please note:

AI Assist provides very good results for very many use cases. Nevertheless, it is important
that you check the results.
If you analyze texts with critical content (violence, hate speech, bullying, etc.), summaries may
not be created.
Usually, you will receive the same or very similar summary for the same segments. However,
it may happen that a summary is different from previous ones because the generative
language model used provides dynamic results and because AI Assist is continuously
optimized.

AI Summary: Code Summary
Please note: To use this feature, you need the AI Assist add-on.

In MAXQDA’s Code Memos there is a “Code Summary” area where you can write a summary for the
segments that were coded with the respective code. This provides a perfect location where you can
aggregate key content captured by a code.

https://www.maxqda.com/help-mx24/segment-retrieval/overview-of-coded-segments
https://www.maxqda.com/help-mx24/segment-retrieval/the-retrieved-segments-window
https://www.maxqda.com/help-mx24/mixed-methods/segment-matrix
https://www.maxqda.com/help-mx24/analyze-coded-segments/compare-codes
https://www.maxqda.com/help-mx24/work-with-coded-segments/smart-coding-tool
https://www.maxqda.com/products/ai-assist
https://www.maxqda.com/help-mx24/27-ai-assist/what-is-ai-assist-beta
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Using AI Assist, you can create a Code Summary for the coded segments automatically and then
edit the summary if necessary.

With AI Assist you can automatically create a Code Summary in the code memo window

Calling the function in the “Code System” window

To create an automatic summary for the segments coded with a selected code:

Right-click a code in the “Code System” window and select AI Assist > Summarize1.
Coded Segments from the context menu.
In the dialog that appears, select the length, type, and language in which the summary should2.
be written. AI Assist automatically detects the language of the coded segments. The
segments’ languages can differ from the summary language and the segments can also
differ in their languages.
By selecting the Only activated documents option, you can limit the coded segments to3.
be summarized.
If you select the Include subcodes option, not only the segments of the selected parent code,4.
but also the segments of all its subcodes will be summarized.

After clicking OK, the summary will be created automatically and presented in the code memo. This
may take a few moments depending on the number and length of the segments. 

Calling the function at other places in MAXQDA

The AI Assist: Summarize Coded Segments function is not only available in the “Code System”
window, but also at locations in MAXQDA where codes are presented, for example:

In the Segment Matrix, start the function by right-clicking on a displayed segment; the same
applies to the Compare Codes function.

https://www.maxqda.com/help-mx24/mixed-methods/segment-matrix
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In the Smart Coding Tool, you can start the function by right-clicking on a code in the code
tree. In this case, all coded segments, optionally only from activated documents, are
summarized. In the main ribbon bar of the Smart Coding Tool, AI Assist > Summarize Listed
Text Segments (into Code Summary) is also available. This function summarizes only the
currently listed segments.

Notes:

AI Assist provides very good results for very many use cases. Nevertheless, it is important
that you check the results.
The summary always considers all segments coded with the selected code but not the
segments of its subcodes.
If you analyze texts with critical content (violence, hate speech, bullying, etc.), summaries may
not be created.
Usually, you will receive the same summary for the same segments, but since AI Assist is
always being optimized, you may receive a slightly different version when calling the function
again at a later date.

AI Summary: Summary Grid
Please note: To use this feature, you need the AI Assist add-on.

In MAXQDA’s Summary-Grid, for each document, you can write summaries for the segments of a
code. In this way, you can, for example, record the key statements of interviewed persons per topic.

Using AI Assist, you can automatically create a summary of coded segments,and then edit it.

Create a summary with AI Assist in the Summary Grid

How to create an automatic summary for already coded segments:

Call Analysis > Summary Grid in the main menu.1.
Click a blue square in the left area of the Summary Grid window to view the associated coded2.
segments for the document and code in the right area.

https://www.maxqda.com/help-mx24/work-with-coded-segments/smart-coding-tool
https://www.maxqda.com/products/ai-assist
https://www.maxqda.com/help-mx24/27-ai-assist/what-is-ai-assist-beta
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Start AI Assist by clicking on the corresponding icon as shown in the figure above.3.
In the dialog that appears, select the language in which the summary should be written. AI4.
Assist automatically detects the language of the coded segments. The segments’ languages
can differ from the summary language and the segments can also differ in their languages.

After clicking OK, the summary is created automatically. This may take a few moments depending
on the number and length of the segments. If a summary already exists, the new one will be added
at the end.

Please notes:

AI Assist provide reliable results in most cases. Nevertheless, it is still important to check the
output.
If you analyze texts with critical content (violence, hate speech, bullying, etc.), summaries may
not be created.
Usually, you will receive the same summary for the same segments, but since AI Assist is
always being optimized, you may receive a slightly different version when calling the function
again at a later date.

AI Paraphrase
Please note: To use this feature, you need the AI Assist add-on.

Using AI Assist, you can automatically paraphrase a selected text passage in the Document
Browser. The generated paraphrase is saved in MAXQDA like a regular paraphrase, which means
that all MAXQDA paraphrase functions apply to the AI Assist generated ones.

Paraphrase a selected segment with AI Assist

https://www.maxqda.com/products/ai-assist
https://www.maxqda.com/help-mx24/27-ai-assist/what-is-ai-assist-beta
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How to paraphrase using AI Assist

Selevt and right-click the text you'd like to paraphrase in the Document Browser and select AI1.
Assist > Paraphrase Selected Text from the context menu.
In the dialog that appears, select the desired language for the paraphrase. This may differ2.
from the selected text passage's lanaguage. After clicking OK, the paraphrase is
automatically created and presented:

Automatically created paraphrase

You can modify the paraphrase in the dialog as you prefer. Once you click OK, the paraphrase will be
saved and shown in the sidebar on the right side to the text.

Tip: If you have enabled the paraphrase mode, you can request the automatic creation of a
paraphrase directly after marking a text passage in the paraphrase window by clicking the AI
Assist button.

Keep in mind that paraphrased text segments must not overlap in a document.

Please note:

AI Assist provides very good results for very many use cases. Nevertheless, it is important
that you check the results.
If you analyze texts with critical content (violence, hate speech, bullying, etc.), no paraphrase
may not be created.
Usually, you will receive the same or very similar paraphrases for the same segment.
However, it may happen that a paraphrase differs from previous ones, because the generative
language model used provides dynamic results and because AI Assist is continuously
optimized.
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AI Subcodes Suggestions
Please note: To use this feature, you need the AI Assist add-on.

With AI Assist, you can generate suggestions into which subcodes a code could be further
subdivided. AI Assist analyzes the text passages assigned to a code and writes suggestions into the
code memo. Optionally, examples from the coded segments can be added to each subcode
suggestion to establish references to the underlying data. You can check the usefulness of the
suggestions for your analysis questions and purposes, and then apply the suggestions manually,
that is, create appropriate subcodes and assign the coded segments. You can run the function
multiple times to generate alternative suggestions.

Starting AI Assist in the context menu of a code to get suggestions of subcodes

Calling the function in the “Code System” window

To get suggestions for subcodes: 

Right-click a code in the code system to which you have already assigned text passages and1.
select AI Assist > Suggest Subcodes in the context menu. 
In the dialog that appears, specify the desired language for the suggestions. The language2.
selected for the suggestions may be different from the language of the coded segments; the
coded segments may also vary in language.
By selecting the option Add bullet list with examples for each subcode, the suggested3.
subcodes will be supplemented with concrete examples from the analyzed coded segments.
by selecting the option Only activated documents you can limit the coded segments to be4.
considered.

After clicking OK, AI Assist analyzes the coded segments and presents suitable subcodes in the
code memo that opens automatically for this purpose. The new suggestions are added at the
bottom of the existing memo text, so you may have to scroll to the end of the memo text.

https://www.maxqda.com/products/ai-assist
https://www.maxqda.com/help-mx24/27-ai-assist/what-is-ai-assist-beta
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Starting AI Assist in the context menu of a code to get suggestions of subcodes

Calling the function at other places in MAXQDA

The AI Assist: Suggest Subcodes function is not only available in the “Code System” window, but
also at locations in MAXQDA where codes are presented, for example:

In the Segment Matrix, start the function by right-clicking on a displayed segment.
In the Smart Coding Tool, you can start the function by right-clicking on a code in the code
tree. In this case, all coded segments, optionally only from activated documents,
are considered for the suggestions. In the main ribbon bar of the Smart Coding Tool, AI Assist
> Suggest Subcodes Based on Listed Text Segments is also available. This
function considers only the currently listed segments.

Generate diverse subcode suggestions

The creation of subcodes for a given code is a data-driven and creative process, without a single
right solution. Multiple subcode proposals can be equally valid. Please assess the suitability of a
proposal for your specific application, considering the purpose of your analysis. To obtain alternative
subcode suggestions, simply restart the function. The new suggestions will be inserted at the
bottom of the code memo. Keep in mind that the probability of different suggestions increases when
there are more segments with the code in question, and when the contents of those segments are
more diverse.

It is usually worthwhile to call the function several times to generate different alternatives, as these

https://www.maxqda.com/help-mx24/mixed-methods/segment-matrix
https://www.maxqda.com/help-mx24/work-with-coded-segments/smart-coding-tool
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may have different emphases and the number of suggested subcodes may vary. Please consider AI
Assist's suggestions as a source of inspiration for the manual formation of subcodes, where
different suggestions can also be combined.

Considerations to keep in mind

If the coded segments contain a lot of text, only a selection of the segments is considered for the
creation of the subcode suggestions. In this case, AI Assist displays a note in the code memo below
the suggestions about how many segments from how many documents were considered.

If AI Assist suggests very many subcodes with long explanatory examples, the text limit for the
suggestions may be exceeded. In this very rare case, not all suggestions are output and there is a
corresponding note at the end of the suggestions. Restart the function to get an alternative
suggestion.

The subcodes suggested by AI Assist are all at the same hierarchical level, meaning no sub-subcode
levels are provided. The explanatory examples are often presented in a condensed form, and only
occasionally as quotes extracted from the original material.

Please note:

AI Assist provides very good results for very many use cases. Nevertheless, it is important
that you check the results.
If you analyze texts with critical content (violence, hate speech, bullying, etc.), suggestions
may not be created.

AI New Codes Suggestions
Please note: To use this feature, you need the AI Assist add-on.

Using AI Assist, you can automatically create an inspiring list of possible new codes for a
highlighted section of text. You can assess if the suggestions are useful for your analysis tasks,
choose appropriate codes, and then MAXDQA will apply them to the text section.

https://www.maxqda.com/products/ai-assist
https://www.maxqda.com/help-mx24/27-ai-assist/what-is-ai-assist-beta
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Get new code suggestions from the context menu

Calling the function

To get suggestions for new codes: 

Select a text passage in the “Document Browser” and right-click on the selection.1.
In the context menu, select AI Assist > Suggest New Codes for Text Selection. 2.
In the dialog that appears, specify the desired language for the suggestions and confirm3.
with OK. The language selected for the suggestions may be different from the language of the
coded segments; the coded segments may also vary in language.
MAXQDA will present a list of possible new codes. Select all suitable codes and confirm4.
again with OK.
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New code suggestions

MAXQDA creates all selected codes at the top of the code system and assigns them to the selected
text passage. The explanations are saved in the respective code memos. Please note that in some
cases there is no explanation; then no code memo is created.

Typically, MAXQDA will present three separate sets of suggestions: the first two sets contain
thematic codes, where the codes in the second tend to be more general. The third set contains
codes that usually express more interpretation. You’re free to pick as many codes as you want from
any of these groups.

Already existing codes are not considered for creating the suggestions. In this chapter you’ll find
information on how you can easily merge similar codes in the code system.

Please note:

AI Assist provides very good results for very many use cases. Nevertheless, it is important
that you check the results.
If you analyze texts with critical content (violence, hate speech, bullying, etc.), suggestions
may not be created.
Usually, you will receive the same or very similar suggestions for the same segment.
However, it may happen that suggestions are different from previous ones, because the

https://www.maxqda.com/help-mx24/codes-2/moving-and-sorting-codes-in-the-code-system
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generative language model used provides dynamic results and because AI Assist is
continuously optimized.

AI Explain This
Please note: To use this feature, you need the AI Assist add-on.

AI Assist’s Explain This function allows you to define terms or simply elaborate concepts without
exiting MAXQDA.

An example of an AI-generated explanation

How to: Explain This

When you come across a term or phrase you’d like to explain while viewing a document in
MAXQDA’s Document Browser, you must first select it by highlighting it with the cursor.

After you select the text segment, you can:

Right-click to access the context menu. Then, navigate to AI Assist and choose Explain Text
Selection or,

https://www.maxqda.com/products/ai-assist
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Explain selected text via its context menu

Click on the AI-Assist icon in the Document Browser’s toolbar and select Explain Text
Selection from the dropdown menu.

Explain selected text via the AI Assist icon found in the Document Browser's toolbar

A dialog box will appear, allowing you to select the explanation’s language, and once you’re ready, hit
OK.

Each generated explanation is saved as a new in-document memo, directly attached to the explained
text. This means that if you request an explanation for the same text passage more than once,
MAXQDA will save it each time as a new memo. Pre-existing memos are not affected.

Please note:

AI Assist provides reliable results in most cases. Nevertheless, it is still essential to check the
output.
AI Assist may not generate content if you request explanations for critical content (violence,
hate speech, bullying, etc.).
You may get slightly varying results if you run the function for the same text more than once.

https://www.maxqda.com/help-mx24/memos/memos-attached-to-document-segments
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Technical Data and Information

Accessibility
Accessibility of a software is an important factor for its usability and user experience. Accessibility
features ensure that all users, regardless of any disability or impairment, are able to access and use
a software product. This chapter explains the accessibility features that are included in MAXQDA.

Keyboard Accessibility

Keyboard accessibility in MAXQDA allows users to interact with MAXQDA using only their keyboard.
Please reference the "Keyboard Shortcuts" to learn about MAXQDA's main shortcuts

Screen Reader Compatibility

Screen readers can assist users with visual impairments to access and use MAXQDA by reading out
the text on the screen. Third-party screen reader software, such as NVDA or JAWS, can be adjusted
to read out the menu functions and the texts analyzed. Please refer to your screen reader’s
documentation for further instructions.

Color Contrast

MAXQDA offers a high color contrast dark mode to improve readability of the interface for users
with visual impairments.

Navigation

On a Windows computer, you can use the Alt key to access the main menu ribbon. Within the menu
ribbon you can navigate with your keyboard.

On a Mac computer, you can use Ctrl+F2 to access the menu bar. Within the menu ribbon you can
navigate with your keyboard.

General

For more information on your operating system accessibility features, please refer to your operating
systems accessibility documentation:

Windows: https://www.microsoft.com/en-us/windows/accessibility-features?r=1
macOS: https://support.apple.com/accessibility/mac

 

In case of questions, please contact accessibility@maxqda.com

https://www.maxqda.com/help-mx24/technical-data-and-information/keyboard-shortcuts
https://www.microsoft.com/en-us/windows/accessibility-features?r=1
https://support.apple.com/accessibility/mac
mailto:accessibility@maxqda.com
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Checking for Updates
Each time you start the program, MAXQDA will check the MAXQDA website to see if an updated
version is available. If an update is available, it is recommended that you download it in order to
benefit from interesting new features and enhancements.

Under Preferences, that you can open from the settings icon in the top right corner of the MAXQDA
window, you have the options to decide if MAXQDA should Search for updates automatically or not.

If you have opted to skip an update, you can later request it manually: Click on the question mark in
the top right of the MAXQDA main window and select the option Search for Updates.

Please note:

You need admin rights to install the update on your computer.
If you are using a MAXQDA network license, it may be possible that your network admin has
deactivated the automatic search for updates. In this case MAXQDA will not check for an
update each time you start the program and you will also not find the option in the help menu.

Keyboard Shortcuts
The following keyboard shortcuts are available in MAXQDA.

General

Windows macOS

F1 ⌘ (cmd) + ⇧ + ? Opens the MAXQDA help system.

Ctrl + N ⌘ (cmd) + N Creates a new project.

ctrl + O ⌘ (cmd) + O Opens an existing project.

ctrl + A ⌘ (cmd) + A Highlights the entire text.

ctrl + C ⌘ (cmd) + C copies the selected segment to the clipboard.

ctrl + X ⌘ (cmd) + X cuts out the selected segment and puts it in the
clipboard.

ctrl + V ⌘ (cmd) + V Pastes the selection from the clipboard.

Alt + 1 option ⌥ + 1 Opens/closes the window "document system".

Alt + 2 option ⌥ + 2 Opens/closes the window "code system".

Alt + 3 option ⌥ + 3 Opens/closes the window "document browser".

Alt + 4 option ⌥ + 4 Opens/closes the window "retrieved segments".

ctrl + Alt + B ⌘ (cmd) + option ⌥ +
B

Opens the logbook.
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ctrl + Alt + M ⌘ (cmd) + option ⌥ +
M

Opens the Code Matrix Browser.

ctrl + Alt + R ⌘ (cmd) + option ⌥ +
R

Opens the Code Relations Browser.

ctrl + F ⌘ (cmd) + F Opens the search toolbar for the current
window or the table overview.

ctrl + ⇧ + F ⌘ (cmd) + ⇧ + F Opens the text search.

ctrl + P ⌘ (cmd) + P Prints the focused window or view.

Alt + Double-click option ⌥ + double-
click

Inserts a MAXQDA object (e.g. a document or
code) into MAXMaps, if MAXMaps is open.

ctrl + R ⌘ (cmd) + R Resets activations in the "Document System"
and "Code System".

"Document System“

Windows macOS

Double-click Double-click Opens a document.

⇧ + double-click ⇧ + double-click Opens a document in a new tab.

ctrl + click ⌘ (cmd) + click Activates or deactivates a document.

F2 Enter Renames a document.

Del ⌘ (cmd) + BackspacE Deletes a document.

Alt + ⇧
Alt + ⇩

option ⌥ + ⇧
option ⌥ + ⇩

Moves a document or document group up and
down in the “Document System“.

ctrl + Drag & Drop option ⌥ + Drag &
Drop

creates a copy of the document without coded
segments (start dragging and then hold
ctrl/option)

ctrl + T ⌘ (cmd) + T creates a new document and opens it for
editing in the “Document Browser“.

ctrl + D ⌘ (cmd) + D Opens the dialog window for importing
documents.

Alt + ⇧ + M option ⌥ + ⇧ + M creates a new memo or opens an existing
memo for a document.

"Code System“

Windows macOS

ctrl + click ⌘ (cmd) + click Activates or deactivates a code including the
subcodes.

ctrl + ⇧ + click ⌘ (cmd) + ⇧ + click Activates or deactivates a code without
subcodes.
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F2 Enter Renames a code.

Entf Backspace Deletes a code.

Alt + ⇧,
Alt + ⇩

option ⌥ + ⇧
option ⌥ + ⇩

Moves a code (possibly with subcodes) up and
down in the “Code System“.

Alt + RightArrow,
Alt + LeftArrow

option ⌥ +
RightArrow,
option ⌥ + LeftArrow

Increases and decreases the level of hierarchy
of a code.

Alt + Drag & Drop option ⌥ + Drag &
Drop

creates a copy of the code without coded
segments (start dragging and then hold
ctrl/option).

Alt + N ⌘ (cmd) + option ⌥ +
N

Inserts a new code on the chosen level.

"Document Browser“

Windows macOS

ctrl + E ⌘ (cmd) + option ⌥ +
E

starts and stops Edit Mode.

ctrl + ⇧ + P ⌘ (cmd) + ⇧ + P starts and stops Paraphrase Mode.

Alt + L ⌘ (cmd) + option ⌥ +
L

codes the selected segment with the most
recently used code.

Alt + W ⌘ (cmd) + option ⌥ +
W

opens the dialog window for creating a new
code, which will be used to code the selected
segment.

Alt + C ⌘ (cmd) + option ⌥ +
C

codes the selected segment with the code
shown in the Quick List.

Alt + I ⌘ (cmd) + option ⌥ +
I

codes the selected segment with a newly-
created code named after the first 63
characters of the selected segment (in-vivo-
coding).

ctrl + l ⌘ (cmd) + l Inserts an internal link at the location of the
selected segment. The location it is linked to is
set by highlighting another segment in that
document or another one in the project and
hitting Ctrl + L again.

F6 F6 Inserts a new timestamp into a transcript when
in transcription mode.

PgUp, PgDN PgUp, PgDN Moves to the next/previous page of a PDF
document.

Pos1, End Pos1, End Moves to the beginning or the end of a PDF
document.

ctrl + Plus,
ctrl + Minus

cmd + Plus,
cmd + Minus

Zooms in or out of the document.
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ctrl + Zero ⌘ (cmd) + Zero Zooms the view to 100 %.

Alt + Tab,
Alt + ⇧ + Tab

option ⌥ + Tab,
option ⌥ + ⇧ + Tab

Jumps to the next/previous tab.

ctrl + F4 ⌘ (cmd) + W closes the current tab or the current view.

“Multimedia Browser” toolbar

Windows macOS

F3 F3 Jumps to the next memo.

⇧ + F3 ⇧ + F3 Jumps to the previous memo.

F4 or
F5 or
2 x ⇧

F4 or
F5 or
2 x ctrl

Plays or pauses the media file.

F7 F7 Sets a clip start.

F8 F8 Sets a clip end.

F9 F9 Plays a clip.

F10 F10 cancels the clip mark.

F12 F12 Jump 5 seconds forward

⇧ + F12 ⇧ + F12 Jump 5 seconds back

ctrl + L ⌘ (cmd) + L Insert a link start to the selected clip. Use the
same keyboard combination to insert a link
goal.

Alt + ⇧ + M option ⌥ + ⇧ + M Insert a memo at the current position of the
media file.

Table overviews, e.g. Overview of Coded Segments

Windows macOS

ctrl + ⇧ + E ⌘ (cmd) + ⇧ + E Opens the table as Excel file in the standard
program.

ctrl + ⇧ + H ⌘ (cmd) + ⇧ + H Opens the table as HTML file in the standard
internet browser.

ctrl + E ⌘ (cmd) + E Opens the dialog window for exporting the table
or view.

Del ⌘ (cmd) + Backspace Deletes the chosen row/s.

MAXDictio Dictionary [only available in MAXQDA Plus and MAXQDA Analytics Pro]

Windows macOS

ctrl + ⇧ + N ⌘ (cmd) + ⇧ + N creates a new category.
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ctrl + Alt + N ⌘ (cmd) + option ⌥ +
N

creates a new search item.

ctrl + E ⌘ (cmd) + E Opens the dialog window for exporting a
dictionary.

Del ⌘ (cmd) + BackspacE Deletes the chosen category.

MAXDictio Stop list [only available in MAXQDA Plus and MAXQDA Analytics Pro]

Windows macOS

Alt + ⇧ + N ⌥ (option) + ⇧ + N creates a new word to be excluded.

ctrl + E ⌘ (cmd) + E Opens the dialog window for exporting the stop
list.

Del ⌘ (cmd) + Backspace Deletes the focused items.

File Management
MAXQDA works with the following file types:

.MX24 MAXQDA 24 project file for Windows and Mac

.MC24 MAXQDA 24 TeamCloud project file for Windows and Mac

.MX22 MAXQDA 2022 project file for Windows and Mac

.MX20 MAXQDA 2020 project file for Windows and Mac

.MX18 MAXQDA 2018 project file for Windows and Mac

.MX12 MAXQDA 12 project file for Windows and Mac

.MX11 MAXQDA 11 project file for Mac

.MX5 MAXQDA 11 project file for Windows

.MX4 MAXQDA 10 project file

.MX3 MAXQDA 2007 project file

.MX2 MAXQDA 2 project file

.M2K MAXQDA 1 project file

.LOA Saved formula files (activation by variables)

.SEA Saved search files (SEArch file)

.MTR Exported “Code System”

.MOD Exported MAXMAp

.MEX22 MAXQDA Exchange file (MAX EXchange)
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Limitations and Technical Information
MAXQDA sets very few limits. The following table informs about importable file formats and some
limits within MAXQDA.

Importable Text formats: RTF/D, DOC/X, ODT, PDF, TXT, HTML

Importable Table formats: XLS/X  

Importable Image formats: JPG, GIF, TIF, PNG

Supported Audio formats: Windows: MP3, WAV, WMA, AAC, M4A
Mac: MP3, WAV, AAC, CAF, M4A

Supported Video formats: MP4, MOV, MPG, AVI, M4V, 3GP, 3GGP
Windows: WMV recommended Codec: H.264/AVC

Twitter Import: Max. 10,000 tweets per import

Twitter Analysis: No set limit to number of tweets

YouTube Import: Max. 10,000 most current comments per video

Number of projects: No set limit

Number of document
groups:

No set limit
Groups of more than 1,000 are not recommended

Number of documents: No set limit. Dividing them into document with groups with max. 1,000
is recommended

Number of codes: No set limit

Number of coded segments: Above 200,000 coded segments the stability of MAXQDA cannot be
guaranteed (if your computer has less than 4 GB RAM this threshold
may be lower)

Code System levels: Max. 10

What data volumes can be processed with MAXQDA?

As the table overview above shows, there are very few technical limits to the data you can work with
in MAXQDA. However, it should be noted that several thousand documents, codes, and coded
segments in a project can affect the level of performance.

It is therefore important to note some qualitative answers to the question of how many documents,
codes, coded segments, etc. you can process with MAXQDA. General answers are only partially
helpful and may differ in individual cases, since the performance of MAXQDA of course also
depends on the hardware used. However, in practise, such issues only arise in very few instances, in
which very large amounts of data need to be analyzed. They are certainly not common for “standard”
projects in qualitative or mixed methods research.

The following factors may influence the performance of MAXQDA - sometimes in combination:

Number of documents in the "Document System"

As a rule, several thousand documents will pose no problem for MAXQDA if they are organized in
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several document groups. So, for example, answers to open questions from (online) surveys with
1,000 cases (= documents) can be analyzed in MAXQDA with ease.

Number of codes in the "Code System"

Again, there is no technical limit: Several thousand codes can be processed, but certainly it is not
easy to manage more than 1,500 codes from a research point of view.

Number of coded segments per document

Even 1,000 coded segments and more in a document rarely pose a problem. That being said, if the
length of the text is very large or the codes are spread over a few PDF pages or paragraphs, it is
recommended to hide individual coding stripes to allow for a greater display speed. To do this, click
on the gear drive symbol in the gray area in which the coding stripes are displayed in the “Document
Browser” and select, for example, which colors should be displayed and which should be hidden.

Length and contents of text documents

If a single text document is very long, e.g. with more than 300 pages, it may take a few moments
before the document is displayed. If such a document also contains a large number of codes (for
example, more than 500), this can cause further delays.

For text documents containing a large number of images (for example, more than 50) or very large
(for example, 30 mega pixels) images, it may be better to import the document as a PDF document
or split it into multiple documents. In this way, the performance speed can be increased when
opening and editing these documents.

Size of table documents

For table documents, the time it takes to open the document depends on the number of
rows/columns and the size of the cell contents. For 1,000 rows of 20 columns, it may take a few
seconds for the document to open. The time to open is also affected by how many codes there are
in the table. The coding and editing of cells in an open table document with 1,000 rows and 20
columns can then be completed without any delays.

Number of tweets analyzed simultaneously

The start of the Twitter analysis as well as the opening and filtering of tweets is still sufficiently fast
even with 200,000 tweets. Only the compilation of word frequencies requires one to two minutes of
computation time for this amount of data.




	Contents
	MAXQDA 24
	Welcome to the MAXQDA 24 Manual
	Switching From Older Versions to MAXQDA 24
	Getting Started: Go for it!
	The MAXQDA Account
	01 – The Workspace
	How to Start the Program
	Project File Backups
	The Main Menu and the Four Main Windows
	The
	The
	The
	The
	Managing Table Overviews
	General Preferences

	02 – Import Data
	Supported Data Types
	Import and Group your Data
	Text Documents
	Create New Text or Table Documents
	External Files
	PDF Documents
	Image Documents
	Table Documents
	Audio and Video
	Transcripts
	Focus Group Transcripts
	Survey Data from Excel
	Survey Data from SurveyMonkey
	Survey Data from SPSS
	YouTube Data
	Subtitle Data (SRT)
	Web Pages
	Bibliographic Data (Endnote, Zotero etc.)
	Structured Documents (Preprocessor)

	03 – View and Edit Data
	View Documents
	Edit Text Documents and Tables
	Line Numbers in Text Documents
	Assign a Color to a Document
	The Document Properties Window

	04 – Codes
	About Codes and the Code System
	Create a New Code
	Edit Code Properties
	Edit the Code System
	Delete Codes
	Create Code Sets
	The Overview of Codes
	Transfer the
	Import Codes and Code Memos from Excel

	05 – Coding
	How to code
	Display of Coded Segments in the
	Display of Coded Segments in the
	Further Ways of Coding
	Open Coding Mode
	Color Coding (Highlighting)
	Emoticode: Coding with Emojis and Symbols
	Comments for Coded Segments
	Weight Scores for Coded Segments
	Intercoder Agreement

	06 – Work with Coded Segments
	The Smart Coding Tool
	Remove Code Assignments
	Modify Coded Segments
	Move or Copy all Coded Segments of a Code

	07 – Analyze Coded Segments
	Compare Codes
	Code Frequencies
	Code Coverage
	Code Patterns
	The Code Explorer
	The Overview of Documents for a Code
	Frequency Tables and Charts for Top-Level Codes and Subcodes

	08 – Creative Coding
	The Idea behind Creative Coding
	Start Creative Coding and Select Codes
	Organize Codes
	Quit Creative Coding and Transfer Changes to Code System

	09 – Transcription
	Transcribe Automatically
	Transcribe Manually
	Link Transcript to Recording with Timestamps
	Play Transcript and Recording Synchronously
	The Overview of Timestamps

	10 – Memos
	About Memos
	Opening and Editing Memos
	Opening Multiple Memos at Once
	Memos in Documents
	Memos in the Document System Window
	Code Memos
	Free Memos
	The Memo Manager
	The Overview of Memos
	Search within Memos
	Linking Memo Content with Content in Documents
	Link Memos to Code(s) or Coded Segments
	Convert Memos into Documents
	The Logbook

	11 – Links
	Links in MAXQDA
	Internal Links
	External Links
	Web Links
	Geolinks
	The Overview of Links

	12 – Text Search
	Local Text Search
	Global Text Search
	Search Results
	Autocode Search Results
	Export Search Results
	Extended Text Search
	The Word Explorer

	13 – Segment Retrieval
	Activation: The Principle of Segment Retrieval
	The
	The Overview of Coded Segments
	Export and Print Retrieved Segments
	Code Retrieved Segments
	Simple Coding Query
	Complex Coding Query
	Complex Retrieval Functions
	Include Subcodes in Retrieval
	Use Weight Filter

	14 – Visual Tools
	Code Matrix Browser (Codes by Cases)
	Code Relations Browser (Code Co-occurrences)
	Code Map (Similarity of Codes)
	Document Map (Similarity of Documents)
	Document Comparison Chart (Sequence of Codings)
	Profile Comparison Chart (Code Frequencies and Variable Values)
	Word Trends (Frequencies of Words)
	Document Portrait (Sequence of Codings)
	Codeline (Score of Codings)
	Word Cloud (Frequencies of Words)
	Code Cloud (Frequencies of Codes)
	Code Trends (Frequencies of Codes)

	15 – Visual Tools (Concept Maps)
	What Does MAXMaps Do?
	The MAXMaps Interface
	Create a Map and Add Objects
	Customize Objects in MAXMaps
	Layers
	The Object Library
	Linking Objects
	Print, Export, and Organize Maps
	Synchronize Map With Project Data
	Model Templates in MAXMaps
	Options in MAXMaps

	16 – Paraphrasing
	About Paraphrasing in MAXQDA
	Paraphrase Text Passages and Image Segments
	Paraphrase Video and Audio Segments
	The “Paraphrased Segments” Code in Your “Code System”
	Categorize Paraphrases
	Paraphrases Matrix
	The Overview of Paraphrases
	The Overview of Paraphrased Segments

	17 – Summarizing
	Summary Grid (Create and Edit Summaries)
	Summary Tables (Compile and Present Summaries)
	Summary Explorer (Compare Summaries for Cases or Groups)
	Code and Document Summaries
	Overview of Summaries

	18 – Comparing Cases & Groups
	Qualitative Comparison (Coded Segments)
	Quantitative Comparison (Code Frequencies)

	19 – Variables
	Document and Code Variables in MAXQDA
	Create and Edit Variables
	The Data Editor
	Importing Data from Excel and SPSS
	Exporting Data to Excel and SPSS
	Displaying Document Variables for Documents and Coded Segments
	Frequency Tables and Charts for Variables

	20 – Mixed Methods
	About Mixed Methods in MAXQDA
	Activate Documents by Variables
	Crosstab
	Segment Matrix
	Typology Table
	Similarity Analysis for Documents
	Side-by-side Display of Results
	Qualitative Themes by Quantitative Groups
	Statistics by Qualitative Groups
	Transform a Code into a Document Variable (Quantitizing)
	Transform a Code into a Categorical Document Variable

	21 – Stats
	What Does MAXQDA Stats offer?
	Using MAXQDA Stats
	The Data Editor
	The Variable List
	The Output Viewer
	Analyze Variables and Codes from a MAXQDA Project - Start MAXQDA Stats
	Work with External Data in SPSS or Excel Format - Open SPSS data
	Transform Data
	Frequency Tables
	Analyze Multiple Responses
	Analyze Matrix Questions
	Descriptive Statistics
	Crosstabs
	t-Test and U-Test
	Scale
	Hierarchical Cluster Analysis
	One-Way Analysis of Variance
	Correlation
	Limits and Technical Notes

	22 – MAXDictio
	What Does MAXDictio Offer?
	Basic Terms
	Word Frequencies
	Lemmatization
	Stop Word Lists
	Go Word Lists
	Keyword-in-Context
	Word Combinations
	Word Tree
	Word Matrix Browser
	Managing Dictionaries
	Dictionary Based Content Analysis
	The Category Matrix Browser
	Category Trends
	Autocode Documents with Dictionary Categories
	Topic Modeling
	Analyzing Japanese texts
	Limits to MAXDictio

	23 – Questions - Themes -Theories (QTT)
	The Idea behind
	Create a Worksheet
	Add Elements to a QTT Worksheet
	Export Worksheet

	24 – Analyzing Videos
	Video Analysis with MAXQDA
	Import Videos
	The Multimedia Browser
	Code Videos
	Transcribe Video Clips
	Paraphrase Videos
	Add Memos and Links to Videos
	Export Video Clips
	Analyze Coded Videos

	25 – Analyzing Focus Group Data
	How Does MAXQDA Support Focus Group Data Analysis?
	Text Search in Speaker’s Contributions
	Coding Query for Coded Segments
	View Coded Segments per Speaker
	The Overview of Focus Group Speakers
	Crosstab for Focus Groups

	26 – Analyzing Surveys
	Categorize Survey Data
	Search and Autocode Survey Responses
	Autocode Survey Responses with a Dictionary
	Analyze Survey Data with MAXQDA Stats
	Analyze Sentiments in Survey Responses

	27 – Analyzing Tweets
	Analyze Tweets
	Autocode Tweets with Hashtags and Authors
	Analyze Sentiments of Tweets

	28 – Report & Export
	Smart Publisher for Coded Segments
	Codebook with Category Definitions
	Summaries with Coded Segments
	Project Information
	Document Profiles
	Export and Print Documents
	Export Adjacency Matrix for Network Analysis
	Exporting Project Components as Excel file
	Anonymize Projects
	Save Project in MAXQDA 2022 Format
	Export and Import REFI-QDA Projects
	Archiving for Data Reuse

	29 – Teamwork
	How Does MAXQDA Support Teamwork?
	Copy Codings, Memos, Variables, etc. Into Another Project
	Hand over a MAXQDA Project to Other Team Members
	Merge Two MAXQDA Projects
	User Access Management

	30 – TeamCloud
	What is MAXQDA TeamCloud?
	Requirements & License Management
	Log into TeamCloud from within MAXQDA
	Project Roles & Permissions
	The project cycle in detail
	TeamCloud Storage
	Best Practice – Things to know for optimal teamwork
	The TeamCloud website
	Backup
	Glossary
	Switching from MAXQDA 2022 to MAXQDA 24

	31 – AI Assist
	What is AI Assist?
	AI Summary: Document Summary
	AI Summary: Highlighted Text
	AI Summary: Coded Segment
	AI Summary: Code Summary
	AI Summary: Summary Grid
	AI Paraphrase
	AI Subcodes Suggestions
	AI New Codes Suggestions
	AI Explain This

	Technical Data and Information
	Accessibility
	Checking for Updates
	Keyboard Shortcuts
	File Management
	Limitations and Technical Information


